
 

ser Guide

   

nd Windows

 

™

U
for Macintosh® a



 

Trademarks

      

Credits

     

Cover artwork by Mark Jenkins. 
hapter openers by Aaron Begley, assisted by 
tassia McGehee, Mojdeh Marashi, 
ark Jenkins and Mark Siegel. 

ection divider illustrated by Aaron Begley 
nd Brian Moose.
Ray Dream Studio and Natural-Media are 
registered trademarks and Fractal Design 
Poser, Fractal Design Detailer, Image Hose and 
Quick Curve are trademarks of Fractal Design 
Corporation. QuickDraw and QuickTime are 
trademarks, and Apple, Macintosh and 
Power Macintosh are registered trademarks of 
Apple Computers, Inc. Windows is a registered 
trademark, and Video for Windows is a 
trademark of Microsoft Corporation. All other 
product and brand names mentioned in this 
user guide are trademarks or registered 
trademarks of their respective holders.

Copyright
This manual, as well as the software described 
in it is furnished under license and may only be 
used or copied in accordance with the terms of 
such license. Program copyright ©1990-1997 
MetaCreations Corporation, including the look 
and feel of the product. Ray Dream Studio User 
Guide copyright ©1997 MetaCreations 
Corporation. No part of this guide may be 
reproduced in any form or by any means 
without the prior written permission of 
MetaCreations Corporation.

Notice
Before using this software or reading this user 
guide, make sure you have read, understood 
and agreed to the license contained in the 
back of the Ray Dream Studio 5 User Guide.

Ray Dream Studio® was originally created by 
Pascal Belloncle, Pierre Berkaloff, 
Yann Corno, Eric Hautemont and 
John Stockholm.

Ray Dream Studio® 5 was created by 
Pascal Belloncle, Pierre Berkaloff, Eric Brayet, 
Yann Corno, Joël Derriennic, Eric Graham, 
Greg Mitchell, Thomas Ripoche, Logan Roots, 
Damien Saint-Macary, John Stockholm, 
Emil Valkov and Joshua Van Abrahams.

Product Management by Gray Norton and 
Stephanie Arvizu. 

Quality Assurance testing by Curt Hironaka, 
Randy Hollingsworth, Joe Grover, Steve Yatson 
and Jason Green; managed by 
Michael Cinque.

The Ray Dream Studio 5 User Guide was 
written by Erick Vera, assisted by 
Lionel Kirsher and Deborah Adair; edited by 
Erick Vera and Kim Ness ; project 
management by Erick Vera, 
Stephanie Workman, Mary Zimmer and 
Rafael Rodriguez ; art directed by John Derry, 
Stephanie Workman and Erick Vera; 
illustrated by Brent Houston, assisted by 
Aaron Begley, Brian Moose, Mojdeh Marashi, 
Stassia McGehee and Tony Alexander; 
information design by Michael Everitt; 
production by Erick Vera, Judy Severance and 
Kim Ness; prepress production by 
Rich O’Rielly and Mary Zimmer; review and 
validation by Curt Hironaka and Gray Norton.

C
S
M
S
a



                    

u complete the tutorial, open a new 
tart building your own scene. Take 

ge of Ray Dream Studio 5’s Scene 
nd the Modeling Wizard

 

™

 

. Use the 
izard as a quick way to set up your 
r outdoor scene with the 
iate lighting and background, and 
Modeling Wizard to build objects.

 also want to review Appendix C, 
cal Tips,” which provides answers 
 commonly asked questions.

er graphics and three-dimensional 
g use special terms that are usually 
d where they are introduced. In 
, Appendix B, “Glossary,” provides 
definitions of a number of terms.

               
Welcome to Ray Dream 
Studio 5

Welcome to Ray Dream Studio™ 5, the 
leading 3D program for desktop artists and 
animators, Web designers, and multimedia 
producers. Ray Dream Studio 5 is ideal for 
creating 3D graphics for magazines, ads, or 
virtually any illustration that would benefit 
from the powerful 3D impact of realistic 
perspective and shading.

Ray Dream Studio’s powerful animation 
features let you create professional quality 
animations for video and multimedia. With 
Ray Dream Studio’s key-event and timeline-

• A Fractal Design Software Registration 
Card

If you are missing any of these items, please 
contact your Ray Dream Studio 5 dealer or 
distributor, or contact Fractal Design 
Customer Service at (800) 846-0111.

About your User Guide

This manual provides all the information 
you need to get the most out of Ray Dream 
Studio 5. It will help you learn the 
application and serve as a reference as you 
attempt more sophisticated procedures 
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concise 
ntions
 Dream Studio 5 User Guide is for 
cintosh and Windows. By 
ion, Macintosh commands 
 Windows commands in the text. 
ple, Command/Ctrl+I, is 

nt to the Macintosh Command-I 
Windows Ctrl+I. For simplicity, the 
der refers to directories as well as 
Screenshots usually alternate 
 the Macintosh and Windows 
. The Ray Dream Studio 5 interface 
 platforms is identical, unless 
e specified.

e also several conventions used to 
based animation, you can produce 
anything from flying logos to character 
animations. 

Ray Dream Studio 5 can also be an 
invaluable tool for interactive multimedia. 
It support for low-polygon modeling and 
popular formats like GIF, JPEG, VRML and 
Real VR TM.

Your Ray Dream Studio 5, package 
includes:

• The Ray Dream Studio CD-ROM

• The Ray Dream Studio 5 User Guide

• The Ray Dream Studio Quick Reference 
Card

and effects.

This user guide assumes you are already 
familiar with basic Macintosh and Windows 
concepts—menus, dialogs, and mouse 
operations, such as clicking and dragging. If 
you need more information on these 
subjects, or on the Macintosh Finder or the 
Windows Desktop, refer to the Macintosh 
User’s Manual or the Microsoft Windows 
User’s Guide, respectively.

The best way to learn Ray Dream Studio 5 
is to read Chapter 4, “Ray Dream Studio 5 
Basics,”and then complete Chapter 5, 
“Tutorial.” The tutorial leads you through 
the process of creating illustrations and 
animations in Ray Dream Studio and also 
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paths to certain tools and controls. 
vention to a menu follows the rule 
enu name> menu item. The 
• Your Ray Dream Studio 5 serial number
explains some of the important concepts 
you’ll need to know to model and animate 
in 3D.

identify 
The con
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convention to a palette follows the rule of 

                       

Connecting to the Web Site

                     

Using Macintosh Help

 

 Ray Dream’s help on the 
tosh:

  

ose 

 

Help menu> Ray Dream 

io Help 

 

to display the help dialog.

  

the 

 

Contents

 

 button to view the table 
ntents, the first page of the file. Use 
nderlined hypertext to jump to a 

c. 

  

the 

 

Go Back

 

 button to retrace your 
s. Use the 

 

History

 

 button to return 
y previously-viewed screen.

   

Search

 

 button lets you search by 

                 
the palette name: subpalette name or 
palette item. The convention to a palette 
menu follows the rule of palette name: 
palette menu> menu item. 

Modifier Keys

When a modifier key differs between the 
Macintosh and Windows platform, the 
Macintosh modifier is listed first followed 
by a slash and the Windows modifier key. 
Option/Alt means Macintosh users press 
the Option key and Windows users press 
the Alt key.

Getting Help
Ray Dream Studio offers a few ways to get 
help. From within Ray Dream Studio 5, you 

To visit the Fractal Design Web site:

Click the Goto Fractal Online button on the 
Internet toolbar. 

If the toolbar is not visible choose View 
menu> Toolbars and enable the Internet 
option.

To visit a third-party Web site:

Click the appropriate button on the 
Internet toolbar. 

To use
Macin

1Cho
Stud

2Use 
of co
the u
topi

3Use 
step
to an

4The 

ord or topic.

 a sticky note from the pad onto a 
ific page. You can type your own 
 on the sticky note.

 Windows Help

 Ray Dream’s help in Windows:

ose Help men> Contents to 
lay the Ray Dream Studio Help 
ents.

the Contents tab to view the table of 
ents. Select a “book” icon and then 
 Open to see the topics available. To 
 a topic, select it and click Display. 
can access Ray Dream Studio’s on-line help. 
You may also connect to the Fractal Design 
Web site. 

If you’re connected to the internet via a 
dedicated line or modem connection, Ray 
Dream Studio’s Internet toolbar offers and 
easy way to access the Web sites of Fractal 
Design and selected third-party partners.

On the Fractal Web site, you’ll find 
technical support, software updates, the 
latest Ray Dream Studio news and 
information on Ray Dream Studio 
extensions.

You can also register your copy of Ray 
Dream Studio 5 online.

If the toolbar is not visible choose View 
menu> Toolbars and enable the Internet 
option.

On-Line Help 

Detailed on-line help can be accessed from 
within Ray Dream Studio, using the Help 
menu. The help file contains a wealth of 
information from the Ray Dream Studio 
User Guide. With the Ray Dream Studio 
Help system, you can do keyword searches, 
and set bookmarks.

keyw
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 With these new behaviors you can 
bullet out of gun or drop a ball 
flight of stairs.

 more about 

 

Physically-Based 
rs

 

 refer to “Physical Forces” on 
.

 

Form Modeler

 

 

 

Mesh Form

 

 modeler adds a new 
reating 3D objects to Ray Dream 
he new modeler lets you create 
h objects. Objects are created by 
g the position of vertices to change 
ct’s shape. This way of modeling 
r to creating an object out of clay 
 other malleable medium.

    
3Use the Help Topics button to return to 
the table of contents. Use the Back 
button to retrace your steps.

4The Index tab lets you search by 
keyword or topic.

Using Ray Dream Studio Tool 
Tips
On Windows, Tool Tips are displayed by 
default whenever you rest your cursor over 
an interface element. 

On the Macintosh, Tool Tips are provided 
by Balloon Help.

To turn off Tool Tips (Windows):

What’s New in Ray Dream 
Studio 5

The new Ray Dream Studio 5 has many new 
tools, features and improvements. For 
those upgrading, the following overview 
will provide a head start on locating, 
learning, and taking advantage of these 
additions.

Properties and Browser Palettes
One of the biggest changes in Ray Dream 
Studio 5 is the new compact user interface. 
The new Properties palette displays the 
controls and data for any object you select. 

friction.
shoot a 
down a 

To learn
Behavio
page 318

Mesh 
The new
way of c
Studio. T
polymes
adjustin
the obje
is simila
or some
rovides precise control over 
 details, for unprecedented 
g power.

 more about the Mesh Form 
, refer to “Mesh Form Modeling” on 
.

nmental Primitives
 environmental primitives let you 

create natural objects like clouds, 
and fountains.

 more about environmental 
es, refer to “Creating 
mental Primitives” on page 99.
1Choose File menu >Preferences.

2Choose General from the popup.

3Disable the Show Tooltips/Help Balloons 
option.

To turn off Tool Tips (Macintosh):

Choose Help menu> Show Balloons.

As you select different scene elements, the 
palette’s controls change.

To learn more about the Properties palette 
refer to “Properties Palette” on page 10.

The Browser palette acts like warehouse of 
all the items you can use to create a scene 
in Ray Dream. You can use the Browser 
palette to store Objects, Shaders, 
Deformers, Behaviors, Lights, Cameras and 
more.

To learn more about the Browser refer to 
“Using the Browser Palette” on page 28.

Physically-Based Behaviors
The new Physically-Based Behaviors let 
you create incredibly realistic animations. 

It also p
intricate
modelin

To learn
modeler
page 137

Enviro
The new
quickly 
fog, fire 

To learn
primitiv
Environ
Welcome xi
The behaviors automatically simulate 
natural forces like gravity, wind, and 



   

Render Filters

                

feature can be extremely useful when 

                      

To learn more about creating Formula 
s, refer to “Creating Formula 
s” on page 106.

ormula editing is such a technical 
s, the 

 

Formula Editor

 

 is covered 
tely. Refer to the “Using Formulas in 
eam Studio 5” PDF on the Ray Dream 
 5 CD.

 

More

 

ition to the new features listed here, 
eam Studio features dozens of user-
ted improvements, and a wide 
 of new content.
Ray Dream Studio now includes a series of 
render filters that let you add some 
spectacular lighting and camera effects to 
your scene. Some of the effects you can add 
are: Depth of Field, 3D Light Cones, Lens 
Flares, and Stars.

To learn more about the new render filters, 
refer to “Render Filters” on page 349.

New Deformers
There are several new Deformers included 
in Ray Dream Studio that you can apply to 
your objects. This new set of Deformers let 
you create amazing new effects. 

To learn more about the new Deformers, 

you’re trying to align objects directly in the 
Perspective window.

To learn more about Collision Detection, 
refer to “Collision Detection” on page 236.

Direct Manipulation Controls
The Direct Manipulation controls let you 
adjust the properties of many scene 
elements directly on screen. When you 
click an element that has Direct 
Manipulation controls, its control handles 
appear. As you drag these handles, you 
change the elements properties.

There are several scene elements that have 
direct manipulation controls:

object
Object

Since f
proces
separa
Ray Dr
Studio

And 
In add
Ray Dr
reques
variety
refer to “Deformers” on page 171.

Natural Media Renderer
The Natural Media renderer expands the 
stylistic range of Ray Dream Studio beyond 
photorealism. This new renderer lets you 
create 3D images in a number of hand-
drawn styles.

To learn more about the Natural Media 
renderer, refer to “The Natural-Media 
Renderer” on page 343.

Collision Detection
Collision Detection lets you turn all the 
objects in your scene into physical solids. 
When this feature is active, objects collide 

• For Light controls, refer to “Controlling a 
Spot Light Directly” on page 277. 

• For Camera controls, refer to “Controlling 
a Camera Directly” on page 288. 

• For Link controls, refer to “Controlling 
Links Directly” on page 264. 

• For Deformer controls refer to 
“Controlling a Deformer Directly” on 
page 172.

Formula Editor
The Formula Editor lets you use 
mathematical formulas to customize many 
of the features of Ray Dream Studio. You 
can create formula objects, deformers, 
xii Ray Dream Studio User Guide
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lementary Products

 

wing companies have contributed 
oftware package:

 

, Inc.

 

 with your Ray Dream Studio 5 
 are 3D models from Acuris, Inc. All 
ls are copyright Acuris. For more 

tion on the 3D models that Acuris 
ffer, contact Acuris at:

  

d Sterling Road 
ton Crossing, PA 18977

  

 (215) 493-4302

       
Getting Technical Support

You will find the answers to most of your 
questions within the pages of this User 
Guide. If you need further assistance, you 
may contact Fractal Design’s Technical 
Support in any of the following ways: 

Phone: 408 430-4200 between the 
hours of 8am and 5pm,
Pacific Standard Time

FAX: 408 438-9672

www: http://www.fractal.com
To automatically launch your 

Who is Fractal Design
Fractal Design is a major force in multi-
platform graphic software, developing and 
marketing next generation products that 
unite traditional art and design techniques 
with digital technology. Fractal Design 
products are engineered to facilitate and 
extend the range of creativity for all design 
professionals and graphic hobbyists 
working on desktop computers.

Fractal Design’s focus is maintained by 
three product values:

• Faithfully replicate Natural-Media® and 
real world looks in the digital medium.

• Facilitate and extend the range of 

Supp

The follo
to this s

Acuris
Included
software
3D mode
informa
has to o

1313 Lor
Washing

Phone: 
ts
 with your Ray Dream Studio 5 
 are textures from ArtBeats. All 
re copyright ArtBeats. For more 

tion, contact ArtBeats:

: (800) OK-ACRUS

http://www.acuris.com

709
reek, OR 97457

 (541) 863-4429

: (800) 444-9392
Web Browser and go to 
Fractal’s Web site, choose 
Windows menu> Goto 

Fractal Online or click the 
Goto Fractal Online button on 
the Internet toolbar.

Mail: Technical Support
c/o Fractal Design Corporation
P.O. Box 66959
Scotts Valley, CA 95067

creativity by allowing artists to do things 
they couldn’t do before.

• Capture human expression and allow the 
artist’s perspective and intent to show 
through.

For More Information 

For more information about Fractal 
Design products, see our World Wide 
Web site on the Internet:

www: http://www.fractal.com

ArtBea
Included
software
images a
informa

Toll-Free

www:

PO Box 
Myrtle C

Phone: 

Toll-Free
Welcome xiii

(541) 863-4547
Fax: 



Technologies, Inc. and Modern Medium Inc. 

point DataLabs
ed with your Ray Dream Studio 5 
re are models from Viewpoint 
bs International, Inc. All 3D Datasets 
yright Viewpoint DataLabs. For 

nformation on the over 1000 
asets that Viewpoint has to offer, 
t Viewpoint DataLabs: 

http://www.metatools.com

uth State St.
UT 84058

:  (801) 229-3000

 (801) 229-3300
Form and Function
Included with your Ray Dream Studio 5 
software are textures from Form and 
Function. All images are copyright Form 
and Function. For more information, 
contact Form and Function:

KETIV Technologies, Inc.
Included with your Ray Dream Studio 5 

www: http://www.artbeats.com

1595 17th Avenue
San Francisco, CA 94122

Phone:  (415) 664-4010

For more information contact KETIV 
Technologies, Inc.:

MetaTools
Included with your Ray Dream Studio 5 

KETIV Technologies, Inc.
6601 NE 78th Court, Suite A-8
Portland, OR 97218

Phone:  (503) 252-3230

Fax: (503) 252-3668

Toll-Free: (800) 458-0690

www: http://www.ketiv.com

View
Includ
softwa
DataLa
are cop
more i
3D Dat
contac

www:

625 So
Orem, 

Phone

Fax:
Disc
ed with Ray Dream Studio 5 is a 
 of professional images from 
isc, the Leader in Digital Stock 
raphy!

isc award winning Photos give you a 
ful edge for conveying your message. 
ages are part of the carefully edited 
isc collection of stock photographs 
d for advertising, creative design 
rporate communications. Each of 

ee: (800) DATASET (328-2738)

http://www.viewpoint.com
software are 50 textures from Just 
Textures™. You can use the textures 
royalty free in your rendering work. Just 
Textures is a library with 1,250 royalty free 
textures on CD-ROM for use in Ray Dream 
Studio 5. Over 900 textures are seamlessly 
tileable and repeat in all directions when 
wrapped onto 3D objects. 

The tileable textures include brick, carpets, 
clouds, fabric, fences, floor tiles, flower 
fields, food, granite, ground, laminates, 
marbles, metals, plants, rock, roof tiling, 
soil, stone, walls, wallpapers, water, wood 
and much more. The remaining 250 
textures show cut-out objects than can be 
rendered in any 3D scene. The object 
textures include animals, bush, cars, 

software are textures created with 
MetaTools TextureScape™. This Eddy-
award winning program allows you to 
create an infinite variety of textures for 
print, multimedia, and desktop video. 
TextureScape not only allows you to create 
your own textures, it also comes with a 
CD-ROM filled with over 800 textures for 
your use. 

MetaTools
6303 Carpinteria Ave.
Carpinteria, CA 93013

Phone:  (805) 566-6200

Fax: (805) 566-6367

Photo
Includ
sample
PhotoD
Photog

PhotoD
power
The im
PhotoD
selecte
and co

Toll-Fr

www:
otographs is carefully scanned with 
hest quality drum scanning 
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people, plants, rugs, trees, and much more. 
Just Textures is a product of KETIV Toll-Free: (800) 472-9025

the ph
the hig



technology, color-corrected and stored in 
full-color for dazzling impact. You are 
licensed to use the photographs for all of 
your design, advertising and multimedia 
needs, with no additional fees.

Royalty free and color correct for 
immediate use.

PhotoDisc Customer Service

Phone:  (206)-441-9355 (International)

Fax:  (206)-441-4961

Toll-Free: (800)-528-3472 (8am-6pm PST)

www: http://www.photodisc.com
Welcome xv
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Chapter 1 • Installation

 

1

 

1

 

Installation

 

Installing Ray Dream 

 

Studio

 

This chapter covers the installation and 
launching of Ray Dream Studio.

This section gives instructions for 
installing the Macintosh and Windows 
versions of Ray Dream Studio software. 
Follow the instructions appropriate for 
your system.



   

Macintosh Installation

               

To use your Ray Dream software with text, 

                      

you’ll use frequently and use the 
OM to access your models and 
ers.

u want to install any of the additional 
Dream extensions, choose the 

 

om

 

 installation option and select the 
nsions you want from the list. To use 
dd-on extension, you need to 
hase a serial number from Fractal 
gn. For more information, call 
tal Sales at (800) 846-011, or visit 
tal Design Online at 
://www.fractal.com

  

ose the Install Location for your Ray 
m folder and click 

 

Install

 

.

            
System Requirements

Ray Dream Studio works on any Power 
Macintosh with at least the following 
configuration:

• Power Macintosh or compatible model 
running system 7.0 or later.

• A minimum of 20MB of available 
application RAM (24+ MB is 
recommended). 

Ray Dream Studio can take advantage of 
more RAM, if you have it. Because of the 
variation in individual system 
configurations, our minimum RAM 
requirements are based on the amount 

you need either:

• TrueType™ fonts

• Type 1 PostScript™ fonts and Adobe 
Type Manager™.

Installation

To install your Ray Dream Software:

1Turn off any virus protection and 
compression programs and close any 
other applications currently open.

2Insert the Ray Dream Studio CD-ROM 
into your CD-ROM drive.

CD-R
shad

If yo
Ray 
Cust
exte
the a
purc
Desi
Frac
Frac
http

4Cho
Drea
r your Ray Dream software has 
hed installing, click Quit to quit the 
ller.

are Support for Macintosh

ay Dream Software can open and 
 files saved in the following formats:

file formats can be imported 
y into the Free Form modeler:

be Illustrator™ version 1.1, version 
r versions 3 and 5.

file formats can be used to import or 
 images or import files as texture 

be PhotoShop™ 
of memory available to run applications 
after the system is loaded. Choose Apple 
menu> About This Macintosh to 
verify the amount of available memory 
you have.

• A minimum of 20 MB of hard drive space 
reserved for program files, plus 20 MB 
free disk space.

See “Selecting the Scratch Disk” on 
page 23 for information on how Ray 
Dream Studio uses the hard disk. 

• CD-ROM player.

• Color display (24 bit recommended).

3Double-click the Installer icon from the 
CD-ROM and follow the instructions on 
the screen. 

The installer gives you the option of 
doing an Easy or Custom installation. 
Easy Install will install your software in a 
standard configuration appropriate for 
most users. 

Choose Custom if you want to select the 
individual files for installation. Choose 
your custom options carefully — your 
Ray Dream software includes large 
volumes of content that could take up 
valuable space on your hard disk. Your 
best strategy is to install the options that 

5Afte
finis
Insta

Softw

Your R
import

These 
directl

• Ado
88, o

These 
export
maps:

• Ado
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her application should be running 
 installation.

  

 the Ray Dream Studio CD-ROM 
our CD-ROM drive and click the 

 

l

 

 button.

ws locates the Ray Dream 
lation program on the CD-ROM. 

  

 the instructions on the screen. 
Next to confirm each option and 
 to the next screen.

ave the option of running a 

 

Typical

 

, 

 

act

 

 or 

 

Custom

 

 installation. 

 

Typical

 

 
stall your software in a standard 
uration appropriate for most 

      
• RIFF (Fractal Design Painter® and 
Detailer™)

• PICT

• GIF

• TIFF (RGB only)

• Corel Photo-Paint

• JPEG

• EPS (export only)

Movie formats:

• QuickTime

• Sequenced still images

These file formats can be used to import or 

• 486, Pentium or Pentium Pro-based PC 
computer with minimum of 16 MB RAM 
(24+ MB recommended).

• Microsoft Windows 95™ or Windows 
NT 4.0.

• 20 MB hard drive space reserved for 
program files, plus 20 MB free disk space.

For information on how your Ray Dream 
Studio software uses the hard disk, refer to 
“Selecting the Scratch Disk” on page 23.

• Color Display and Windows-compatible 
graphics card with minimum of 256 colors 
(16- or 24-bit accelerated graphics card 
recommended).

No ot
during

2Insert
into y
Instal

Windo
instal

3Follow
Click 
move

You h
Comp
will in
config
. Compact installs a minimum 
uration.

e Custom if you want to select the 
dual files for installation. Choose 
ustom options carefully — your 
ream software includes large 
es of content that could take up 
le space on your hard disk. Your 

trategy is to install the options that 
 use frequently and use your 
M to store your models and 
rs.

 want to install any of the additional 
ream extensions, choose the 
m installation option and select the 
export 3D objects:

• Ray Dream Designer 3 (Macintosh and 
Windows versions)

• Ray Dream Designer 4 (Windows 
versions)

• 3D DXF (3D faces only)

• 3DMF (Apple’s QuickDraw 3D format)

• VRML (export only)

Windows Installation

System Requirements

Ray Dream Studio works on any PC 
compatible computer with at least the 

• CD-ROM player.

To use your Ray Dream software with type, 
you need:

• TrueType™ fonts

Windows Installation

Your Ray Dream CD-ROM supports the 
Windows Autorun feature. When you insert 
the CDROM into any PC running Windows 
software, an Autorun window automatically 
appears. You can choose to install your 
Ray Dream software or to explore the other 
files on the CD-ROM.

To install your Ray Dream software:

users
config

Choos
indivi
your c
Ray D
volum
valuab
best s
you’ll
CD-RO
shade

If you
Ray D
Custo
Chapter 1 • Installation 3

sions you want from the list. To use 
d-on extension, you need to 
following configuration: 1Start Windows. exten
the ad



   

purchase a serial number from Fractal 

                                  

These file formats can be used to import or 

                                 

Installation 

 

bleshooting

 

nstallation was not successful, verify 
ur hard disk has sufficient storage 

for the installation. You may have to 
our disk for the recommended 
t of space and repeat the 
tion. If you have verified that your 

isk has enough free space and the 
m fails to install after a second 
t, please contact Fractal Design 

ical Support at (408) 430-4200.
Design. For more information, call 
Fractal Sales at (800) 846-011, or visit 
Fractal Design Online at: 
http://www.fractal.com

You will also be given options to choose 
your Destination Directory and 
Program Folder. 

4Once you’ve made these selections you’ll 
be able to confirm your installation 
settings. Then click Start to install.

5After your Ray Dream software has 
finished installing, click Finish.

Alternatively you can install your Ray 

export images or import files as texture 
maps:

• Corel Photo-Paint (*.CPT)

• GIF

• JPEG

• Photoshop (*.PSD) (RGB only)

• RIF (Fractal Design Painter/Detailer 
format)

• TIFF or Tag Image File Format (*.TIF) 
(RGB not CMYK)

• Targa (*.TGA)

• Windows Bitmap (*.BMP)

Trou

If the i
that yo
space 
clear y
amoun
installa
hard d
progra
attemp
Techn
Dream software without using Autorun 
from the CD. Choose Start menu> 
Control Panels. Then double-click 
Add/Remove Programs from the Control 
Panel and follow the directions given.

Software Support for Windows

Your Ray Dream software can open and 
import files saved in the following formats:

These file formats can be imported 
directly into the Free Form modeler:

• Adobe Illustrator™ (*.AI)

• Computer Graphics Metafile (vector-
based) (*.CGM)

• Windows Metafile (*.WMF)

• Windows PaintBrush (*.PCX)

Movie Formats:

• Video for Windows (*.AVI)

• Sequenced still images

These file formats can be used to import or 
export 3D objects:

• Ray Dream Designer 3 (Windows & 
Macintosh versions)

• Ray Dream Designer 4 (Windows & 
Macintosh versions)

• 3D DXF (3D faces only) (*.DXF)

• 3DMF (Apple QuickDraw 3D format)
4 Ray Dream Studio User Guide

• CorelDRAW® (*.CDR)
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Ray Dream 
Studio 5 
Overview

 

Introduction

 

This chapter introduces some of the major 
features and concepts of Ray Dream 
Studio 5.

With Ray Dream Studio 5 you can create 
dazzling 3D illustrations in five easy steps:

 

•

 

Build true three-dimensional objects with 
easy-to-use, intuitive modeling tools

 

•

 

Paint colors and textures on your objects, 
giving them realistic properties like 
transparency and reflection

 

•

 

Arrange your objects together in a scene

 

•

 

Light your scene to enhance realism 
and depth

 

CH02.rds5  Page 5  Wednesday, July 2, 1997  2:25 PM
Chapter 2 •



   

•

 

Render your scene with Ray Dream 

  

When your scene is completed, you can 

                  

Properties 
palette

ctive 
w
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Studio’s acclaimed ray-tracing engine to 
produce extraordinary, photorealistic 
illustrations or animations.

Ray Dream Studio 5 combines power with 
an easy-to-use, intuitive interface. It 
provides all the features necessary to 
create full-color 3D illustrations and 
animations. 

Ray Dream Studio’s modelers use many of 
the tools standard to 2D drawing programs 
and feature a variety time saving utilities 
and tools to make creating complex spline-
based and polymesh objects quick and 
easy.

Ray Dream Studio 5 features state-of the-art 

render it. Rendering is the process of 
capturing a two-dimensional image, like a 
photograph, from your three-dimensional 
scene. You can also render your key frames 
as an animation.

Ray Dream Studio’s rendered images are 
compatible with popular Macintosh and 
Windows 2D graphics and page-layout 
programs. You’ll have no trouble 
compositing renderings with other images 
or integrating text with your artwork. 

Application Overview

Perspe
windo
eam Studio 5’s main interface 
ts.

Line 
ow

Browser 
palette
shading technology, which lets you apply 
colors and surface textures to your 
objects.You can even paint directly on a 3D 
object with shaders that emulate wood 
grain or marble, or with effects like bump, 
transparency and reflection. 

The Ray Dream Studio workspace is like a 
photographer’s studio. You can position 
multiple light sources and cameras, and 
shift between cameras to gain different 
perspectives on your work. You can also 
use the Scene Wizard to guiding you 
through the process of creating 3D scenes.

When you’ve created all the objects in your 
scene, you can use the easy-to-use features 
of the Time Line window to create key 

What is a Scene?
A Ray Dream Studio 5 document is called a 
scene. A scene is the collection of objects, 
light sources, and cameras, saved together 
in a file. Each new scene has two 
windows—the Perspective window and the 
Time Line window. 

Ray Dream Studio 5 Windows
When the application opens for the first 
time, you see Ray Dream Studio’s four main 
interface elements: Perspective window, 
Time Line window, Browser palette, and 
the Properties palette. These are the 
primary work areas. The four elements are 
described here, but instructions for 

Ray Dr
elemen

Time 
wind
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frames for animations. working in them appear in subsequent 
chapters. 



                           

 hide or display the grids using the 

 

Plane

 

 tool. By default the 

 

Display 

 

ol appears on the left side of the 
eneath the main toolbar. Planes 

 visible in the 

 

Perspective

 

 window 
n in dark gray. Invisible planes are 

 

ng Windows

  

spective

 

 window is where you 
and view your scene. To create the 

           

isplay Plane tool to set which 
 Box planes are visible in the 
ive window.
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Perspective Window

The Perspective window shows a view of 
the 3D workspace, where objects, lights 
and cameras are arranged to create a 
scene. The workspace itself is called the 
universe. 

Working Box

The main area of the Perspective window is 
called the Working Box. The Working Box 
is represented by three intersecting planes. 
It provides a framework that helps you 
work in a three-dimensional universe with 
two-dimensional devices—the mouse and 
monitor. 

You can
Display 
Plane to
screen b
that are
are show
white. 

Modeli

The Per
arrange 

Use the D
Working
Perspect
that go into the scene you need to 
deler.

 modelers available in Ray Dream 
re the Mesh Form modeler and the 
m modeler. Each modeler has its 
dow with individual tools and 
mmands. 

u “Jump Into” an object by double-
it, the Perspective window “zooms 
e object (to the exclusion of other 
. The menus change to display the 
’s menu, and the Perspective 
changes to the Modeler toolbox.
The view of your scene shown in the 
Perspective window is taken through a 
camera. You can move this camera to see 
different views of your scene or you can 
add other cameras to get other viewpoints. 

The current zoom ratio (1:1, 2:1, etc.…) is 
shown in the lower left of the window. The 
status (Idle, Drawing, Shading, etc.) of the 
application is displayed in the status bar. 

Note: If you hide the status bar, using the 
View menu> Status Bar command, it 

The Perspective window displays a view of 
all the objects in your scene.

Each plane of the working box has a grid. 
Each grid represents an axis in three 
dimensional space: X, Y and Z. 

When you’re arranging objects you’ll need 
a specific plane to act as a reference. This 
plane is referred to as the active plane and 
is displayed in light green. The active plane 
is the plane of reference for many arranging 
operations, like moving and aligning. 

The Working Box is made up of three grids 
which represent the X, Y and Z axes.

objects 
use a mo

The two
Studio a
Free For
own win
menu co

When yo
clicking 
in” on th
objects)
modeler
toolbox 
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becomes part of the Perspective window, 
otherwise it remains a separate window.



                             

•

 

Preview (Fast)

                              

transition and length of your animation. 
ode gives you control the events in 
nimation. 

archy mode, the window displays all 

 

me Line window in Time Line mode. 
me Line mode is used to set the 
n of key frames in your animation.
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The modeling and Perspective windows 
look similar but there are a few ways you 
can tell which window you’re in:

• In the Perspective window all the objects 

The Free Form modeling window is used to 
create Free Form objects.

• Shaded Preview (Gouraud)

• Better Preview (Phong)

Better Preview mode shows details of the 
shape and color of your objects, but takes 
longer to calculate and draw. To increase 
application efficiency, you might want to 
work in Wireframe or Preview mode at the 
outset of a project, then switch to Better 
Preview mode as specific details become 
important.

You can also use View menu> Objects 
Invisible to make selected objects 
invisible. Invisible object(s) are still listed 
in the Time Line window where their 
names are italicized.

This m
your a

In Hier

The Ti
The Ti
positio
ments in your scene as icons. This 
rovides a graphic display of how 
ts are grouped and linked.

me Line window in Hierarchy mode. 
erarchy mode is used to see a 
al representation of the groups and 
 your scene.
in your scene are visible. In a modeler 
only the object you’re modeling is visisble

• In the modelers, the Done button appears 
at the bottom of the window.

• Many of the tools in the Perspective 
window, like the camera, lights and object 
creation tools are not visible in the 
modeling windows

Object Preview

The Perspective window has six modes for 
displaying your objects: 

• No Preview 

• Bounding Box

Time Line Window

The Time Line window shows a logical (as 
opposed to visual) representation of the 
scene. All objects, cameras, and lights that 
you bring into the universe are listed in the 
Objects panel of the Time Line. 

The Time Line window provides certain 
information on the scene’s construction 
that is not immediately apparent in the 
Perspective window; for example, how 
several elements may be grouped.

The Time Line window has two modes: 
Time Line and Hierarchy. When in Time 
Line mode, the window displays the events, 

the ele
mode p
elemen

The Ti
The Hi
graphic
links in
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 can display a multiple number of 
ies. You can use the 

 

Browser

 

 
ommands to add and remove 
ies from your hard disk. You can 
 some items from the 

 

Time Line 

 

 or the 

 

Properties

 

 palette by 
 them directly into the 

 

Browser 

 

 view 

 

Browser

 

 palette items by 
n, large icon, or text using the 

 

r palette

 

:

 

 View menu> 

 

ds.

licking a 

 

Shader

 

, 

 

Deformer

 

, 

 

Link

 

, 

 

r

 

 or 

 

Render Filter

 

 tab in the 

  

 palette opens the appropriate 
r the item. For example, double-
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The Perspective and Time Line windows 
are synchronized. As you add or remove 
objects from one, the display in the other 
updates automatically. 

As well, any object selected in the 
Hierarchy window is also selected in the 
Perspective window. When you’re working 
with complex scenes, you might find it 
easier to select small or hidden objects in 
the Time Line rather than in the 
Perspective window.

The Time Line window has 3 separate tabs: 
Objects, Masters, and Effects. Use the tabs 
at the top of the window to switch back and 
forth.

• The Objects tab displays all of the objects 

The Browser Palette

The Browser palette is a visual catalog of 
all the elements you can use to create a 
scene. The Browser palette has eight tabs, 
each for a different category of element:

• Shaders

• Objects

• Lights

• Cameras

• Deformers

• Behaviors

• Links

• Render Filters

Each tab
director
palette c
director
also add
window
dragging
palette.

You can
small ico
Browse

comman

Double-c
Behavio
Browser
editor fo
a Shader opens the Shader Editor.

 Lights and Cameras are stored in 
 Ray Dream (RDS) document files. 
u double-click them in the 
 palette, its document file is 
in the Perspective window.

n the using the Browser palette, refer to 
 Browser Palette” on page 28.
in your scene. 

• The Masters tab displays only Master 
objects. You use the Masters panel to 
manage multiple copies of a single object. 
When you duplicate a single object you 
create a class of objects that are linked to 
the Master object. To edit an individual 
copy, select it in the Objects tab. To make 
a change to all copies of the object, select 
the Master object in the Masters tab.

• The Effects tab shows any Render Effects 
that you’ve added to your scene.

For more information about the Master 
objects, refer to Chapter 13, “Building a 
Scene.”

You can retrieve any item by dragging it 
out of the Browser palette and into either 
the Time Line or Perspective windows.

The Browser palette, showing the Objects 
tab. The Browser palette is used to store a 
variety of scene elements.

clicking 

Objects,
standard
When yo
Browser
opened 

For more o
“Using the
Ray Dream Studio 5 Overview 9
Chapter 2 •



   

Properties Palette

                 

•

 

When you select a camera, the palette 

            

You can use the Toolbar dialog, available 
e View menu> Toolbars, to 
 which toolbars you want displayed. 

ols available in the Tools toolbar 
 as you switch between the 
ctive, Time Line, Mesh Form and 

orm windows.

rs can be docked along the top, 
, left, or right edge of the screen. 

an also be undocked as floating 
s. 

me Controller toolbar as floating 
. Use this toolbar to preview your 
ion.
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The Properties palette is a dynamic palette 
that displays the properties of any element 
selected in the Perspective or Time Line 
windows.

displays the camera’s name, position and 
camera type properties.

• When you select a point in the Free Form 
modeler, the palette displays the point’s 
position and angle.

• When you select an object in the Mesh 
Form modeler, the palette displays 
controls for adjusting its numerical 
position.

Many of the tools in the Mesh Form 
modeler also have a number of 
properties. When a tool has no 
properties, the palette is blank.

Toolbars

from th
choose

The to
change
Perspe
Free F

Toolba
bottom
They c
palette

The Ti
palette
animat
pace Preferences

 work, you can resize windows, 
hem around your screen and 
ize your workspace. When you quit, 

eam Studio 5 remembers your 
s and uses them the next time you 
 the application. 

ike, you can save different 
ace layouts in configuration 

s, which you can load at any time.

 information on saving workspace settings, 
“Setting up your Workspace” on page 25.
The controls available in the Properties 
palette change as you select different 
items:

• When you select an object in the 
Perspective window, the palette displays 
controls to change the object’s name, 
position, deformers, shading, behaviors, 
links and rendering settings.

• When you select a light, the palette 
displays the light’s properties and 
controls for changing the light type, color 

The Properties palette controls and data 
update for each scene item you select.

Ray Dream Studio’s toolbars provide quick 
access to many of Ray Dream Studio’s 
frequently used commands and functions. 

There are eight different toolbars available 
in Ray Dream Studio:

• Standard

• Zoom

• Rendering

• Time Controller

• Status

• Tools

• Planes

Works

As you
move t
custom
Ray Dr
setting
launch

If you l
worksp
profile

For more
refer to 
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 shade the different objects to 
 their surfaces. Shading involves 
 color but also textures, like gravel 
 floor, and surface properties, like 
s. 
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Starting to Think in 3D

Whether you’re used to working with 2D 
illustration applications, or using a 3D 
illustration application for the first time, 
there are several things you should 
consider when creating 3D illustrations. 
The scene you create and the objects you 
use to populate it are all in 3D, meaning 
that you need to consider how your scene 
will look in all three dimensions.

When you look at a real-world object. You 
may think it’s structurally complex. Its 
shapes curve, twist, join, and separate in 
ways that may seem impossible to recreate 

subassembly as a single object. Working in 
this way, there’s no limit to the complexity 
of objects you can build. Finish the mini-
sub, place it under water, add a terrain and 

You can disassemble a mini-sub engine into 
simple elements, which can be modeled 
separately.

You can
describe
not only
on a sea
shinines
nce realism and three-dimensional 
ou can add light sources to your 
 fact, lighting is necessary for the 

asons it’s required in 
aphy—nothing can be seen without 
different lighting, the underwater 
n change from a shallow algae-
e to the murky depths of the 

ter scene with shading applied.
in a computer art program but Ray Dream 
Studio 5 makes constructing such objects 
easy. You build them one piece at a time.

Before beginning a complex object, 
examine it for its components. Keeping in 
mind the way Studio’s modeling tools work, 
divide the object into simple elements. For 
example, you can “disassemble” a mini-sub 
engine into the engine housing, the blades, 
and motor.  

In Ray Dream Studio 5, it’s easy to model 
each of these components separately. 
Then, using the positioning and alignment 
tools in the Perspective window, you can 
assemble the pieces into the mini-sub. 

some ruins, and you’ve built an underwater 
scene. 

To enha
effects, y
scene. In
same re
photogr
it. With 
scene ca
filled lak
ocean.

Underwa
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When a subassembly is built, like the sub 
engine, you can group the components. 
Grouping lets you manipulate the 

Underwater scene created by assembling a 
mini-sub and adding terrain and ruins.



You can also view the scene from below, or 

al rendered image.
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Underwater scene with lights added.

show it from the view of a diver on the sea 
floor watching the mini-sub glide by. It’s 
the same scene, but what appears in the 
window depends entirely on the viewpoint 
you select.  

The fin
endering doesn’t turn out quite right, 
n always go back into your scene 
just the viewpoint, lighting, shading, 
n the shape of objects. Then, simply 
other rendering.
In the lake, the lighting is bright green and 
comes from overhead. The shadows are 
short, directly beneath the objects. In the 
murky depths, the light is fainter, and dark 
blue.The mini-sub’s spotlights create high 
contrast shadows on the ruins.

Because you’re working in three 
dimensions, you can view your scene from 
any angle and at any degree of 
magnification. In Ray Dream Studio, you 
can get different views by simply placing 
cameras at different positions in your 
three-dimensional workspace. 

For example, you can view your scene as if 
you were looking down from the surface.

After you decide on the best viewpoint, 
you’ll render the scene. Rendering is the 
culmination of a Ray Dream Studio 5 
project. Rendering is like taking a 
photograph. It reduces your three-
dimensional scene to a two-dimensional 
image. The rendered image, which can 
have a much higher resolution than can be 
seen on the screen, can be printed directly 
from Ray Dream Studio or opened in 
virtually any Macintosh or Windows 
graphics application. 

Diver’s view of scene.

If the r
you ca
and ad
or eve
take an
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Animation in Ray 
Dream Studio

 

Animation Overview

 

Animation with Ray Dream Studio 5 is a 
matter of adding a fourth dimension—
time—to your 3D illustrations

 

. 

 

To create an 
animation you arrange your scene at key 
points in time. Ray Dream Studio

 

 

 

then fills 
in the gaps to complete the animation.

You can animate almost everything in your 
scene:

 

•

 

the motion of objects, lights, and cameras

 

•

 

object size, shape, and shading attributes

 

•

 

object deformer settings

 

•

 

camera and light parameters

 

•

 

ambient lighting, background, backdrop, 
mospheric effects.
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The Animation Process

                    

Animation Tools

             

can be expanded to show their 
atable properties. This allows you to 
ate each property individually.

  

Time Line area to the right of the 
archy area displays a time track for 
 item (object, effect, or property) 
ently shown in the hierarchy area. 

  

y event marker on a particular time 
k indicates a key event that modifies 
ssociated object, effect, or property. 
event markers can be created, 
ed, deleted, or moved along the 
e Axis by dragging them
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Animation is like an extension to creating 
an illustration. To create a scene you need 
to set up scene properties. To create an 
animation, you change those properties 
over time. When you play the animation, 
the changing properties create action.

The steps to creating an animation are as 
follows:

• Create objects using the Primitive tools, 
the Mesh Form modeler and the Free 
Form modeler.

• Build the scene by arranging objects and 
setting lights and cameras. 

• Animate the scene by making changes to 

Ray Dream Studio has a number of tools for 
creating animations. 

Time Line Window

The Time Line window is the principal tool 
for creating animations. The window 
displays a graphical representation of your 
animation. 

Hierarchy Area Time Line Area

anim
anim

• The 
hier
each
curr

A ke
trac
the a
Key 
copi
Tim
Time Axis extends across the bottom 
e window. It’s a ruler, with marks 
ating time increments (minutes, 
nds, and frames). 

location of the Current Time Bar 
g the Time Axis indicates the current 
—the point in the animation that is 
ently being edited and displayed in 

y event marker on time line is shows 
ition of a key frame in an animation.

me Axis in time line shows the length 
 animation.
the properties of the elements in your 
scene at different points in time. Each 
time you change a property, you create a 
key event. Ray Dream Studio creates the 
illusion of motion by filling in the 
transitions between key events.

• Render the final animation. You can save 
your rendered animation as a QuickTime™ 
(Macintosh) or AVI (Windows) movie or 
as a series of sequential image files in a 
variety of Windows and Macintosh 
formats.

The Time Line window consists of three 
areas: 

• The Hierarchy area shows the scene’s 
hierarchical structure, including links and 
groups. Individual objects and effects in 
the Time Line window’s Hierarchy area 

The Time Line window is used to position 
key frames in your animation and add 
tweeners.

 Time Axis

Current Time BarCurrent Time

Key Event Marker
 Time Track

• The 
of th
indic
seco

The 
alon
time
curr

The ke
the pos

The Ti
of your
erspective window. 
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You can change the current time by 
dragging the Current Time bar along the 
Time Axis.

If you are working on an illustration project in Ray 
Dream Studio and prefer to work with an iconic 
Hierarchy mode rather than the Time Line mode, bring 
the Time Line window to the front and choose View 
menu> Vertical or Horizontal. This replaces 
the Time Line view with the Hierarchy view.

Time Controller Toolbar

The Time Controller’s VCR-like controls 
allow you to preview your animation in the 

Customizing your Workspace for 
Animation

You can optimize the layout of your Ray 
Dream Studio windows by choosing a 
workspace designed specifically for 
animation. Ray Dream Studio includes 
preset animation workspaces to fit most 
popular screen resolutions.

Generally, the preset animation 
workspaces widen the Time Line window 
and display it in the lower portion of your 
screen. The Browser palette moves to the 
upper right corner. The wider Time Line 
window allows you to view more of the 
time line without scrolling.

You can also create your own custom 

Speci
Featu

Ray Dre
features
quality a

• Tween

• Behav

• Anima

• Rotos

• Anima

Tween

am Studio uses formulas called 
 (from in-between) to calculate the 

each object between key events. By 
g which tweener to use for each 
n, you can control the rate of 
etween key events in your 
n.

am Studio includes four different 
 tweeners: linear (for a constant 
hange), Bezier (for smooth motion 
d greater control over acceleration 

eleration), discrete (for 
neous change), and oscillate (for 
ing back and forth between key 
 

Perspective window. You can also use the 
Time Controller to change the current 
time.

If the Time Controller toolbar is not visible, you can 
choose View menu> Toolbars and select it in 
the dialog that appears.

Use the Time Controller toolbar to preview 
your animation or change the current time.

workspace by arranging the windows in the 
position you want and then saving the 
configuration. For more information on 
configuring your workspace, refer to 
“Setting up your Workspace” on page 25.

You can customize the layout of the 

Ray Dre
tweeners
state of 
specifyin
transitio
change b
animatio

Ray Dre
types of
rate of c
paths an
and dec
instanta
alternat
events).
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workspace to look something like one shown 
when you’re working on an animation.



                 

Animating with the Modelers

            

Animating Deformers

 

eam Studio lets you animate the 
s of any deformer. This means you 
sily animate the shape of objects and 
 without having to edit them in a 

er. Deformers can also be used to 
e models you import from other 
tions. 

 

 information on the various deformers and 
tings, refer to “Using Deformers” on 
1. For more information on animating 
rs, refer to “Animating with Deformers” on 

 

2.
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For more information on tweeners, refer to “About 
Tweeners” on page 309.

Behaviors
Behaviors are a class of tools that help 
automate the animation process. Some 
behaviors, like Bounce and Spin, 
automatically animate common types of 
motion. Others, like Point At and Track, 
animate one object based on the position 
or orientation of a second object.

Inverse kinematics is a specialized 
behavior that ensures complex, jointed 
models move realistically when animated. 

You can animate the shape of any model 
you create using the Free Form or Mesh 
Form modelers by modifying its cross 
sections, sweep path and vertices over 
time. This lets you achieve fluid, Bezier-
based object metamorphosis, or precise 
animation of details like facial features.

For more information, refer to Chapter 16, “Animating 
Techniques.”

Rotoscoping
Rotoscoping lets you add live action or 

Ray Dr
setting
can ea
groups
model
animat
applica

For more
their set
page 17
deforme
page 33
aging your Project

boarding
re attempting anything other than a 

nimation, it’s a good idea to create a 
oard first. A storyboard is a series of 
 images showing the key actions in 

ation. The storyboard helps you 
 work out the animations viewpoint, 

g and composition. Because you’re 
etching, it’s easy to make changes 
her arrangements, Your work on the 
oard will give you an idea of the 
This is an invaluable tool for animating 
characters or mechanical models.

Physically-based behaviors are a special 
set of behaviors that let you simulate real-
world physical actions.

For more information, refer to “Behaviors” on 
page 314.

moving textures by incorporating existing 
animations or digitized videos (movies). 
You can use QuickTime or Microsoft Video 
(AVI) files as texture maps or paint shapes 
on objects, backgrounds, backdrops and 
light gels.

For more information, refer to “Rotoscoping” on 
page 334.

Man
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If you a
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storyb
drawn
an anim
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storyb
f objects you’ll need to model and 
 arrange the scene.
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r camera view remains unchanged 
 entire scene, consider rendering a 
age with just the scene’s 

round elements. Then use this 
 as a backdrop and animate only the 
ound elements. This technique 
es some planning to make sure that 
ws and transparent objects don’t 
e “trick” away.

 

ring without Compression

 

e not pressed for hard disk space, 
y makes sense to render your 
n without compression. This 

 that you’ll have a high quality copy 
imation to work with. 

 from your uncompressed original, 
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You can make sample storyboards by 
drawing a series of horizontal screen 
outlines on a sheet of paper, using a 4 to 3 
aspect ratio (ratio of width to height). Draw 
the screens as large as necessary, and 
leave a block of space for the narration or 
description. You can also purchase 
cartooning storyboards at art supply 
stores.

Simplifying your Scenes
In general, the 3D scenes you create for 
animation need not be as complex as a 
typical illustration scene. The viewer’s eye 
tends to be drawn toward motion and 
foreground elements. Static objects and 
background elements are scanned only 
casually.

By reducing unnecessary detail, you can 
reduce rendering times dramatically and 
keep the size of your scene files 
manageable. When preparing a scene for 
animation, keep the following guidelines in 
mind:

• Refine your animation. Keep the objects 
as simple as possible. Detail is usually lost 

• If you
for an
still im
backg
image
foregr
requir
shado
give th

Rende
If you ar
it usuall
animatio
ensures
of the an

Working

 save copies, experimenting with 
compression settings until you are 
 with both the image quality and 
k rate.

ation compressed multiple times 
s significantly, so you should 
ender without compression if you 
 do any postprocessing in another 

ion.
You can use a storyboard to help you layout 
the action in your animation. 

in an animation.

• Use fewer objects, and limit the number of 
reflective and transparent objects.

• Use the minimum number of lights 
required to achieve an effect. Additional 
light adds significantly to the rendering 
time.

• Limit texture map size, and use 8-bit 
texture maps instead of 24-bit.

• If a complex model remains in the 
background for the duration of the 
animation, try substituting a simpler 
version.

• Avoid using a modeled background. Use a 

you can
various 
satisfied
playbac
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degrade
always r
intend to
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rotoscoped image or procedural 
background instead.



   

Motion and Timing 

      

You can accomplish squash and stretch in 

        

Inverse Kinematics behavior can be used to 
ment with poses that convey this 
f motion. 

aving back and forth is another 

          

stic turn is created by moving the head 
keleton first, followed by the 
ers and then the hips.
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Principles

As an animator, the most important skill 
you can master is the ability to portray 
motion convincingly, whether it is intended 
to be realistic or exaggerated and 
cartoonish. No matter how good a 3D 
modeler you are, the timing of the events in 
your animation are of paramount 
importance. 

Many of the principles of timing and motion 
developed by cel animators apply to 3D 
animation with Ray Dream Studio as well. 
Many of these principles apply especially 

Ray Dream Studio by animating an object’s 
shape using either the Mesh Form or Free 
Form modeler and the Stretch deformer.

experi
type o

A flag w

A reali
of the s
should
le of lag and overlap. It lags at one 
the arc and overlaps when moving in 
posite direction. You can use Ray 
 Studio 5’s Free Form modeler to 
 lagging and overlapping effects.

rsus Straight Line Movement

ter motion appears more realistic if 
ws an arc or curved path instead of a 
t line. Most objects affected by 
 also follow curved, rather than 
t trajectories. 

eam Studio’s Bezier tweener is 
zed for arc type movements. Try 
menting with its Tighten In and 
n Out settings to produce narrower 
er arcs.
to character animation, but most are useful 
for any subject matter. For more 
information, you can refer to one of the 
many excellent books on cartoon 
animation.

Squash and Stretch

Squash and stretch are animator’s terms 
for the exaggerated re-distribution of an 
object’s mass as it moves or shifts 
positions. Squash and stretch portray the 
qualities of elasticity and weight in a 
character or an object. 

Think of a bouncing rubber ball. As it falls it 
stretches; as soon as it hits the ground it is 
squashed. If the ball failed to change shape, 
the audience would interpret it as a solid, 

Lag and Overlap

When an object moves from one point to 
another, not everything has to move at 
once. For true-to-life movement, action that 
is secondary to the main activity can lag 
and overlap. For example, when you 
animate a character in pursuit of a bus, 
different parts of the body move at 
different speeds. The character’s head may 

This ball’s bouncing motion is exaggerated 
by deforming its shape so that it stretches as 
its descending and squashes when it hit the 
surface.
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rigid mass. lead, followed by his torso, and finally by 
his arms and legs. In Ray Dream Studio, the 



            

ing. Test your animation 
ly by previewing it in the 

 

tive

 

 window or by dragging the 
Time bar back and forth between 
ts. Adjust the event’s position until 

atisfied with the timing.
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Secondary Motion

Secondary motion adds realism and 
credibility to a scene. A character turning 
his head to stare at something in disbelief 
shouldn’t just turn his head; his jaw should 
drop and his eyes should blink as well. The 
viewer focuses on the main action, but 
registers the secondary motion as 
supporting it. Ray Dream Studio’s time line 
gives you enough control to manage even 
the finest details of your animation, so you 
can add this kind of secondary detail.

Anticipation and Follow-through

In anticipation of a major action, an 
animated character often makes a small 
preliminary action in the opposite 

hitting the ball; rather, it continues along 
its arc of motion. Anticipation and follow-
through make actions more believable. 

Exaggeration

Exaggerating an action emphasizes it 
making it more prominent. For example, if 
intrigue is called for, have a character 
sneak instead of walk. 

If you want your animation to resemble 
footage from a hand-held camera, give your 
camera an exaggerated bobbing motion. 
Virtually any type of action can be 
exaggerated to get an idea across.

Timing

Timing is as important in animation as it is 

your tim
frequent
Perspec
Current 
key even
you’re s
direction. For example, a character about 
to move screen right might first make a 
slight movement screen left, then strike a 
pose before moving screen right.

Follow-through is the continuance of 

Before moving screen right, the skeleton 
moves slightly to the left.

in any dramatic form. Consider the 
difference between an abrupt stop and a 
gradual slowdown. Each conveys a 
completely different impression. In general, 
a motion that continues at the same pace 
lacks interest and seems unreal. 

If you are trying to animate realistic 
character action, act out the sequence 
yourself, timing how long each pose is held 
and how long each action takes with a 
stopwatch. 

Timing is one of the most difficult aspects 
of animation to master. The key events you 
define at different points on the time line 
need to be synchronized with those that 
imation in Ray Dream Studio 19
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motion after a major action is completed. A 
baseball bat does not stop moving after 

came before and those that follow. 
Fortunately, you can use the interactive 
nature of computer animation to fine-tune 
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Ray Dream 
Studio 5 Basics

 

Overview

 

This chapter describes how to setup Ray 
Dream Studio and some of the basic 
operations you’ll need to know when 
creating 3D illustrations and animations.
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Learning about Ray Dream 

                     

Setting Up Ray Dream 

      

Windows Setup options or your video 
r control panel to set your display to 
hest color depth possible.

 

ating Memory on a 
ntosh

 

ault, the Macintosh version of Ray 
 Studio 5 is allocated a specific 
t of RAM appropriate for most 
s. If you have more memory 
le, you should increase Ray Dream 

’s memory allocation. Application 
mance will improve when you 
e more RAM to Ray Dream Studio. 
ck how much RAM you have 
le, choose 

 

Apple menu> About 

acintosh

 

 in the Finder.
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Studio 5 Files

Everything in Ray Dream Studio can be 
saved as a file. You can save entire scenes 
as filename.RDS files, which store all the 
information in the scene including objects, 
lights cameras and render settings. You 
can also save the individual components of 
a scene as separate files.

Objects, Shaders, Deformers, Links, 
Behaviors and Render Filters can all be 
saved as individual files (.BRW) that only 
the Browser palette can open. Once loaded 
into the palette, they can be dragged into 

Studio 5

Launching Ray Dream Studio
The first time you launch the application, a 
dialog appears requesting your name, 
organization and Ray Dream Studio 5 serial 
number. In your Ray Dream Studio 
package, you’ll find a peel-off sheet 
containing several copies of your serial 
number. Be sure to place one of the serial 
number labels on your Registration Card 
and return it to Fractal Design. Place the 
remaining labels where you’ll be able to 
find them easily for later reference. For 

adapte
the hig

Alloc
Maci
By def
Dream
amoun
system
availab
Studio
perfor
allocat
To che
availab
This M
cate memory to Ray Dream 

 Get Info dialog to allocate memory to 
eam Studio on a Macintosh. 
your scene. You can also store file sets in 
different folders to create libraries of 
components like, Shader and Object 
libraries. The Browser palette commands 
let you save, add and remove different 
folders, or families, from the Browser 
palette. Refer to “Using the Browser 
Palette” on page 28 for more on using 
Browser palette commands.

Lights and cameras can be saved either as 
part of scene or as separate scene files, 
which you can store in the Browser palette. 
In this way you can create libraries of 
lighting and camera setups the same way 
you would Shader libraries.

example, on the cover of the manual and on 
the CD case.

Once Ray Dream Studio 5 has been 
personalized, the startup screen appears, 
followed by the Ray Dream Studio 5 
windows. 

The last five digits of your serial number are replaced 
by an x on the opening screen to discourage piracy 
(You will need the entire number when you call 
Technical Support.)

Ray Dream Studio 5 is a color application. 
For the best preview display, use the 

To allo

Use the
Ray Dr
 (Macintosh):

e sure the application is not running.
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Macintosh Monitors control panel, the 
Studio

1Mak



                                   

Choose 

 

Apple menu> About 

ons 

 

(Macintosh) or 

 

Window s 

enu> About Extensions

 

.

 

Plug-Ins with Ray Dream 

 

ilters let you apply image editing 
 your rendered images. Ray Dream 
upports Adobe Photoshop-
ible Plug-ins. By default, Ray Dream 
earches for plug-ins in the Plug-ins 
owever you can set a new folder 
e 

 

Preferences

 

 dialog.

 

e any of these folders from this location or 
 element from them, you may lose access to 
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2Click the Ray Dream Studio 5 program 
icon on your system. 

3Choose File menu> Get Info. The 
Studio Information dialog appears.

4Increase the Preferred Size to a level 
appropriate for your system.

Selecting the Scratch Disk
Ray Dream Studio 5 uses free space on your 
hard drive to store portions of the scene 
you are working on. The program 
periodically reads and writes to this disk 
space as you zoom in or make changes in 
your scene. The disk space used by Ray 
Dream Studio 5 for this purpose is called 

3Select the scratch disk you wish to use.

4Click OK.

Using Extensions with Ray 
Dream Studio 5 
Ray Dream Studio 5 has an extensible, open 
architecture. Application developers can 
create extensions to integrate with Ray 
Dream Studio. Extensions might include a 
new modeler (a tool set for shaping 
objects), procedural shaders, new types of 
lights, cameras, or even an alternative 
rendering engine. 

There are currently several extensions 
packages available for purchase. You can 
install extension from the Installer on you 

system. 
Extensi

Help m

Using 
Studio
Plug-in f
filters to
Studio s
Compat
Studio s
folder. H
using th

If you mov
remove an
e program’s features.

 default plug-in folder:

e File menu> Preferences.

e Imaging, Scratch Disk from the 
p.

Set Directory. A dialog appears 
 lets you choose a folder on your 
.

e the folder you want to use. 
the “scratch disk.”

Ray Dream Studio 5 works more efficiently 
when the selected scratch disk is fast and 
has plenty of free space. If scratch disk 
space and memory are limited, zooming is 
limited. You may want to use a disk utility 
to keep your scratch disk optimized.

By default, Ray Dream Studio 5 chooses the 
disk where the application is installed as 
the scratch disk. However, you can select 
any of your hard disks as the scratch disk. 

To select the scratch disk: 

1Choose File menu> Preferences.

Ray Dream Studio CD, or download them 
from the Fractal Design web site. To 
“unlock” extensions and add their 
functions to Ray Dream Studio, you need to 
purchase a serial number from Fractal 
Design. For more information, contact 
Fractal Design sales at 1-800-846-0111.

The complete Extensions Toolkit and API 
for creating Ray Dream Studio extensions is 
available on the Ray Dream Studio CD. 
Refer to the Extensions Portfolio User 
Guide on the Ray Dream Studio CD for 
more information on developing 
extensions.

At any time when the program is running, 

some of th

To set a

1Choos

2Choos
pop-u

3Click 
which
system

4Choos
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2Choose Imaging, Scratch Disk from the 
pop-up. 

you can get information on the Ray Dream 
Studio 5 extensions installed in your 

5Click 



   

Setting Application Preferences

                                              

Ray Dream Studio also lets you set some 
s to optimize between performance 
) and quality. You’ll want to set 
ptions based on your preference for 
g and the capabilities of your 
. You’ll probably want to 

ment with different settings to find 
 right for you.

 

aw 3D (Macintosh) and Direct3D (Windows) 
nsions to the system architectures that 
 the drawing of 3D objects onscreen. This 
tures enable software and hardware 
ers to create 3D acceleration tools that work 

 

.
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Ray Dream Studio’s Preferences let you 
customize many of the application’s default 
settings. You can also set preferences for 
the colors of the many of the interface 
elements. 

This section only describes the preferences 
that affect the entire application. Other 
specific preferences such as Mesh Form 
modeler, 3D Paint and others are covered 
in the related sections of this manual. You 
can find a specific preference by referring 
to the related chapter. For example, Mesh 
Form preferences are described in “Setting 
Preferences for the Mesh Form Modeler” 
on page 141.

To set interface element colors:

1Choose File menu> Preferences.

2Choose Color from the pop-up.

3Click the color chip next to the element 
whose color you want to change.

4Select a color from the color picker that 
appears.

5Enable Custom color in the Motion Path 
controls if you want to pick a custom 
color for motion paths. 

6Enable Custom Color in the Bounding 
Boxes controls if you want to pick a 

option
(speed
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workin
system
experi
what’s

QuickDr
are exte
improve
architec
develop
together
 Shaded Preview options:

ose File menu> Preferences.

ose Shaded Preview from the 
-up.

 the Renderer pop-up and choose 
enderer you want to use:

Dream Z Buffer This is the default 
erer. It is not accelerated.

E Software This renderer uses 
kDraw 3D software acceleration.
To set the default unit of measure:

1Choose File menu> Preferences.

2Choose General from the pop-up.

3Choose a measure system from the 
Default 3D pop-up. Your selection 
becomes the default unit of measure for 
all 3D objects.

4Choose a measure system from the 
Default Image Size pop-up. Your 
selection becomes the default unit of 
measure when setting the size of 
rendered images.

custom color for object and group 
bounding boxes.

7Click Ok.

Shaded Preview Preferences

The Shaded Preview display mode in Ray 
Dream Studio lets you see a an almost 
rendered preview of your image. This type 
of high quality preview can dramatically 
slow down redraw speed. However, if you 
have QuickDraw 3DTM or Direct3DTM 
acceleration on your system, you can 
optimize the Shaded Preview mode. This is 
the only mode that supports 3D 
acceleration, and you must “turn it on” to 

To set

1Cho
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3Click
the r
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 a number of preset configurations 
 especially suited for specific 
sizes. 

 sample workspace configuration for 
am Studio.
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RAVE Hardware This renderer uses 
QuickDraw 3D hardware acceleration. 
You must have specialized hardware to 
take advantage of this renderer.

Direct3D Software This renderer uses 
Direct3D software acceleration.

Direct3D Hardware This renderer uses 
Direct3D hardware acceleration. You 
must have specialized hardware to take 
advantage of this renderer.

Note: The onscreen results will vary 
slightly between the different renderers.

Note: Each feature you use increases 
screen rendering time. If you’re not 
satisfied with the updating responsiveness 
when you move and rotate objects, disable 
some of these features.

5If you want light cones to move 
interactively when you adjust a light, 
enable the Follow light moves option. 

Light Cones and Colors must be enabled 
for this feature to be valid.

6Select the Texture resolution you want: 
Low, Medium or High.

Lower resolution improves performance, 
but shows less detail. Texture Mapping 

also has
that are
display 

This is a
Ray Dre
e best workspace for your 
:

Windows menu> Workspace> 

ct one of the workspaces that 
onds to your display resolution 
9, 800x600, etc.). 

 also choose Large Font setting for 
rkspaces. Large font settings take 

ount the extra room needed when 
your operating system’s Large Font 
.

ork you’ll probably arrange Ray 
tudio’s windows and palettes to 
ommodate your work style for 
 tasks. You may have different 
The RAVE and Direct3D software renderers require the 
associated software installed in your system. This 
software is installed during the Ray Dream Studio 
standard installation. If you do a custom install and 
choose not to load these items, you won’t be able to 
use the accelerated renderers.

4In the Preview Quality entry box, enable 
the features you want and disable those 
you don’t want: 

• Texture Mapping

• Diffuse Light

• Specular Light

must be enabled for this feature to be 
valid.

7When you’re finished setting options, 
click OK to close the Preferences dialog.

Remember, these preferences only apply 
when you’re using the Shaded Preview 
display mode in the Perspective window.

Setting up your Workspace

Your Ray Dream Studio workspace refers 
to the layout of windows, palettes and 
toolbars. Most of Ray Dream Studio’s 

To set th
display

Choose 
and sele
corresp
(1024x76

You can
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you use 
settings

As you w
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best acc
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• Light Cones and Colors windows and toolbars can be customized 
to suit the way you work. Ray Dream Studio 



layouts for animating and modeling. Ray 2Choose Perspective from the pop-up

play/hide grid planes:

 plane in the Display Planes button. 
 planes have dark colored previews 
 button. 

mizing Toolbars
n also customize Ray Dream Studio’s 
rs. By default, Ray Dream Studio 
s a limited set of toolbars, which 

es tools for working in the 
ctive and modeling windows, 
s for setting rendering options, 
wing animations and preforming 
ile operations. 

are several other toolbars you can 
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Dream Studio lets you save these 
workspace layouts for later use. 

To save a workspace configuration:

1Choose Windows menu> Workspace> 

Save Current. The Save Workspace 
dialog appears.

2Enter a name for your workspace and 
click OK.

Saved workspaces appear at the bottom 
of the Windows menu> Workspace 

menu.

3Enter a value in the Size box. This value 
sets the initial size of the working box. 

Setting up the Grid
The grid in Ray Dream Studio can be an 
invaluable tool for placing objects in 3D 
space. 

To set up the default grid properties:

1Choose File menu> Preferences.

2Choose Perspective from the pop-up.

3Enter a value in the Space box. This value 
sets the initial space between grid lines. 

To dis

Click a
Visible
on the

Custo
You ca
toolba
display
includ
Perspe
button
previe
basic f

There 

Ray Dream Studio which contain 
or zooming and accessing Internet 
tes.

play or hide toolbars:

ose View menu> Toolbars. The 
bars dialog appears.

 the name of the toolbar you want to 
lay. A toolbar is displayed when a 
kmark appears next to its name.

le the Lock Toolbars checkbox, if 
want all the toolbars to remain 
ed to the main window.
To hide/display windows and palettes:

Choose Windows menu> and the name 
of the window or palette you want to hide/
display.

A checkmark beside the window’s name 
indicates that it’s displayed.

Setting up the Working box
The working box is a three-dimensional 
reference tool for positioning and arranging 
objects.

To set the default size of the working 
box:

For example a value of 4 would mean that 
there is 4 inches between grid lines.

4Enter a value into the Draw a line every 
box. This value determines whether a 
line is drawn for every grid increment, or 
less frequently. 

In the example above, a value of 1 would 
draw a line every 4 inches.

Displaying Grid Planes

The working box in Ray Dream Studio 
exists in 3D. The three visible grid planes of 
the working box represent the XY, ZX and 
ZY planes. You can choose which planes to 

use in 
tools f
Web si

To dis

1Cho
Tool

2Click
disp
chec

3Enab
you 
lock
le Reset to default to display only 
efault toolbars.
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1Choose File menu> Preferences.
display.

4Enab
the d



egories. Once you’ve created the 
ou can edit it, just as if you’d 
it from scratch.

emplate Scene Wizards to create a 
ing preset scene elements.
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Toolbars can remain part of the main 
window, or you can have them float as 
separate palettes.

To undock a toolbar:

Click one of the edges of a tool and drag it 
towards the center of the window. 

A palette containing all the tools in the 
toolbar appears.

To dock toolbars:

Drag the toolbar to the edge of the window. 
When the palette’s outline switches to a 
toolbar layout, release the mouse button.

To create an empty scene:

1Choose File menu> New. The New 
dialog appears.

2Click Create Empty Scene. An empty 
Perspective window appears.

Using the Scene Wizard
The Scene Wizard is a picture-based 
assistant that guides you through the steps 
of creating scenes. There are two ways to 
create scenes with the Scene Wizard, by 
using templates or by picking various 
components of your scene, step-by-step.

There are three different categories of 

their cat
scene, y
created 

Use the T
scene us
e two categories of step-by-step 
: Photo Studio and Indoor Step by 

tegories create scenes by stepping 
ugh several screens to select 

components. The Photo Studio lets 
ose lighting effects, backdrops, and 
Creating a New Scene

Before you can create a new 3D illustration, 
you have to create a new document. A new 
document can be a blank scene or a 
predesigned scene you add using the Scene 
Wizard.

Creating an Empty Scene
When you create an empty scene in Ray 
Dream Studio, the Perspective window 
opens using your default workspace setup. 
Your scene contains only one default light 

Scene Templates: Logo Templates, Indoor 
Templates and Outdoor Templates. Each of 
these contains completed scenes in each of 

There ar
wizards
Step. 

These ca
you thro
various 
you cho
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and a default camera. 



props. The Indoor step-by-step lets you Opening an Existing File
n open any file you created in 
s 3 or 4 of Ray Dream Studio or 

er.

n an existing file:

ose File menu> New. The New 
g appears.

 Open Existing File.

ose File menu> Open. The Open 
g appears.

te the file using the dialog controls 
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choose wall and floor combinations, and 
lighting effects.

Use the Photo Studio Scene Wizards to set 
lighting effects and backgrounds for your 
scene.

To create a new scene using the Scene 
Wizard:

1Choose File menu> New. The New 
dialog appears.

2Click Use Scene Wizard.

The New dialog appears when you click the 
New button.

You ca
version
Design

To ope

1Cho
dialo

2Click

or 

Cho
dialo

3Loca

click Open.

ing Objects in your 
e

 the Browser Palette
owser palette helps you store and 
tems and features you’ve created or 
ized. 
The Scene Wizard can create new scenes 
or you can apply the Scene Wizard settings 
to an existing file.

You can have the Scene Wizard 
automatically appear whenever you 
launch Ray Dream Studio. 

To have the Scene Wizard automatically 
launch:

1Choose File menu> Preferences.

2Choose General from the pop-up.

3Enable the Use Scene Wizard on New to 
have the wizard appear whenever you 

3Follow the on-screen instructions.

4Click Done when you’ve reached the final 
screen.

To use the Scene Wizard to add to an 
existing file:

1Choose File menu> Apply Scene 
Wizard. 

2Follow the instructions provided by the 
wizard. The selections you make in the 
Scene Wizard are applied to the current 
file.

and 

Plac
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The Br
reuse i
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use the New command. 



e Auto Load Selected Shader In the 
r Editor to automatically update 
ader Editor whenever you click on 
er in the Browser palette.

Ok.

to the Browser Palette

an object, camera or light to the 
r palette:

y the appropriate tab in the 
er palette.

 Time Line window, click the name 
 object, camera or light you want to 
 the Browser.
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The Browser palette has eight tabs—
Shaders, Objects, Lights, Cameras, 
Deformers, Behaviors, Links and Render 
Filters. Each tab category lets you organize 
items you save into directories.

The Browser palette is a visual catalog of all 
the items you can use to create 3D scenes.

You may need to widen the window or 
click the tab scroll arrows to show the 
tab category you want.

The Browser palette offers three view 
modes for its contents—Text, Small Icon 
and Large Icon.

To change Browser palette view:

Choose Browser palette: View menu 
and select the display you want.

To change column width:

Drag the column divider to set the new 
column width.

4Enabl
Shade
the Sh
a Shad

5Click 

Saving 

To add 
Browse

1Displa
Brows

2In the
of the
add to
he item’s name from the Time Line 
w to the Browser palette. You 

drop it under one of the named 
ory columns.

u can also add a group of items. To 
entire scene, drag the Universe 
m the Time Line window to the 
.

ream Studio opens a dialog so that 
an name the saved item. 

a name and click OK.

ream Studio adds the item to the 
When you’ve customized an item in one of 
these tab categories, you can save it to the 
Browser palette, where it will be easy to 
retrieve and use again later. Most 
operations with the Browser palette are the 
same in all categories.

Note: Objects, light sets and cameras are 
saved as normal Ray Dream Studio 
documents (.RDS files). Items in other 
Browser palette categories are saved as 
special Browser palette documents (.BRW 
files).

To display the Browser palette:

1Choose Windows menu> Browser. 

When the number of columns exceeds the 
window width, use the scroll bar on the 
bottom to bring more items into view.

To set Browser palette preferences:

1Choose File menu> Preferences.

2Choose Browser from the pop-up.

3Enable Drop as Master Group if you want 
any camera, light or object dragged from 
the Browser palette to be dropped into 
the Perspective window as a Master 
Group.

3Drag t
windo
must 
direct

Note: Yo
add the 
name fro
Browser

Ray D
you c

4Enter 

Ray D
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er palette in the directory column 
 you dropped it.
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The Browser palette appears.

2Click the tab for the category you want.

Refer to “Working with Master Objects” 
on page 266 for more information on 
master groups.

Brows
where



 a list of behaviors or render 
 to the Browser palette:

lay the Properties palette: 
aviors tab or the Scene Settings 
tte: Filters tab.

-click to select each behavior or 
 you want to include. 

 the last item into the Browser 
tte. You must drop it under one of 
amed directory columns.

Dream Studio opens a dialog so that 
can name the list. 

r a name and click OK.
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To save a scene to the Browser: Object 
tab:

1Make sure the scene you want to save is 
open in the Perspective window.

2Choose Edit menu> Save As. 

3Click Options.

4Enable the Save icon preview option.

You might want to disable the Save 
cameras and lights option.

5Click Ok.

6Use the directory tools in the Save dialog 

To add a shader, behavior, deformer, 
link or render filter to the Browser 
palette:

1Display the appropriate tab in the 
Browser palette.

2Drag the item you want to add into the 
Browser palette. You must drop it under 
one of the named folder columns.

• If the item you want to add is in the 
Properties palette, you may drag it 
from there.

• If the item you want to add is in a 
Browser document window, you may 
drag it from there.

To add
filters

1Disp
Beh

pale

2Shift
filter

3Drag
pale
the n

Ray 
you 

4Ente
Dream Studio adds the item to the 
ser palette in the directory column 

re you dropped it.

ving from the Browser Palette

 an object, camera or light from 
owser palette:

lay the appropriate tab in the 
ser palette.

 the item you want from the Browser 
tte into your scene. You can drag it 
 the Perspective window or into the 
e Line window.
to locate and open a folder that’s loaded 
into the Browser palette: Objects 
tab. 

For example, the models that are loaded 
by default are stored in the Ray Dream 
Studio:3dclip folder.

7Click Save. 

8Click the Browser palette: Objects 
tab.

9Select the column name for the folder 
where you saved your scene. 

10Choose Browser palette: Update 

• You may also drag the preview from 
the Shader Editor.

Ray Dream Studio opens a dialog so that 
you can name the item. 

3Enter a name and click OK.

Ray Dream Studio adds the item to the 
Browser palette in the directory column 
where you dropped it.

Behaviors and render filters are 
cumulative—you can apply several of 
them. You might create a list of behaviors 
or filters that you’d like to save and apply 
collectively. The Browser palette helps you 

Ray 
Brow
whe

Retrie

To use
the Br

1Disp
Brow

2Drag
pale
into
Tim
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Selected Folder. do this. 



e-click the item you want to edit.

 an object, camera or light, Ray 
am Studio opens it in a scene.

 Dream Studio opens all other items 
 document window, which contains 
 tools appropriate to its type.

ample, double-clicking a shader 
 a Current Shader Editor window.

te a new Browser palette 
nt:

y the appropriate tab in the 
er palette.
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If you drag an object into the TIme Line 
window, it appears at the origin (X=0, 
Y=0, Z=0). If you drag it into the 
Perspective window, it appears at the 
point where you release the mouse 
button.

Note: If you double-click an object, camera 
or light listing in the Browser palette, Ray 
Dream Studio displays the saved Browser 
palette scene.

When you introduce objects from the Browser palette 
into a new scene, the objects carry all of their shading 
and arrangement characteristics with them.

To use a render filter (or list) from the 
Browser palette:

Drag the render filter you want to use from 
the Browser palette into the Perspective 
window, or into the Scene Settings 
palette: Filter tab.

Editing Browser Documents

Any item that appears in the Browser 
palette is saved as a separate document. All 
Browser palette items may be opened, 
edited and saved. 

To get information on a Browser palette 
item:

2Doubl

• For
Dre

• Ray
in a
the

For ex
opens

To crea
docume

1Displa
Brows
e Browser palette: File 
> New Document. Ray Dream 
 opens a document window of the 
ou selected.

icate a Browser palette item:

y the appropriate tab in the 
er palette.

 the item you want to duplicate.

e Browser palette: File 
> Duplicate File.

ream Studio creates a duplicate of 
To use a shader, behavior (or list), 
deformer or link from the Browser 
palette:

Drag the item you want to use from the 
Browser palette onto the object where you 
want to apply it. You can drag onto the 
object preview in the Perspective window 
or onto its listing in the Time Line window. 

You can also drop the onto the appropriate 
tab on the Properties palette.

Note: You can also select the object, select 
the item in the Browser palette, then click 
Apply at the bottom of the Browser palette.

1Display the appropriate tab in the 
Browser palette.

2Select the item you want to find out 
about.

3Choose Browser palette: File menu> 
Get Info. A dialog appears providing 
information on the selected item.

You can use the Name entry box to 
change the name. Or add a comment as a 
reminder of how to use this particular 
item.

2Choos
menu

Studio
type y

To dupl

1Displa
Brows

2Select

3Choos
menu

4Ray D
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lected item and places it in the 
folder.
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To edit a Browser palette item:

1Display the appropriate tab in the 
Browser palette.

the se
same 



5You can now open the duplicate for Ray Dream Studio removes the folder groups and scene elements as icons. This 
as two views: Vertical and 
ntal.

play the Vertical/Horizontal 

ine window can be displayed in 
l Hierarchy mode (above) or 
ntal mode.
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editing. 

Managing the Browser Palette

To create a new folder in the Browser 
palette:

1Display the appropriate tab in the 
Browser palette.

2Choose Browser palette: File menu> 
Add Folder. Ray Dream Studio displays 
a dialog so you can create (or locate and 
open) a new folder. 

3Click New to create a new folder in the 
current location.

column from the Browser palette.

Removing a folder file does not delete files. 
It only removes them from display in the 
Browser palette.

If you change the contents of a Browser 
palette folder, you may need to force Ray 
Dream Studio to build a new list of the 
contents. 

To update listings in a folder:

1Display the appropriate tab in the 
Browser palette.

2Click on the folder title you want to 

mode h
Horizo

To dis

Time L
Vertica
Horizo
of the Time Line:

 the Time Line window to make it 
e.

ose View menu> Horizontal or 
ical.

 “Changing your View of the Hierarchy” on 
4 for complete instructions on using the 
y.
4Name the folder and click OK.

The folder appears as a new column in 
the Browser tab you selected.

To remove a folder from the Browser 
palette: 

1Display the appropriate tab in the 
Browser palette.

2Click on the folder title you want to 
remove. Selected folders are highlighted.

3Choose Browser palette: File 
menu> Remove Selected Folder. 

update. It will be highlighted.

3Choose Browser palette: File menu> 
Update Selected Directory.

Using the Time Line Window
As you work you’ll find the Time Line 
window an invaluable tool for arranging 
and animating objects in your scene. 

The Time Line window can be customized 
to display information specific to the type 
of task you’re working on. 

When you’re modeling or arranging objects 
you’ll need to see information on grouping 
and linking. For this task you can use the 
Time Line window’s Hierarchy mode. The 

mode 

1Click
activ

2Cho
Vert

Refer to
page 25
hierarch
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Hierarchy mode displays all objects, 



 an area of the scene into the 
tive window:

e the Hand tool.

he in the direction you want to 
 the view of the scene.

an also temporarily select the 
 tool by holding down the 
bar. 

 in to an area of your scene:
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When you’re creating an animation you’ll 
need to see key events and tweeners. For 
this task you can use the Time Line mode of 
the window.

To display the Time Line view of the 

When the Time Line window is in Time Line 
mode you can see the key events and 
tweeners in your animation.

3Enable one of the display options.

Importing 3D Objects
You can import 3D objects from other 
applications directly into Ray Dream Studio 
using the Import command.

3D objects are not the only items you can 
import into Ray Dream Studio. You can also 
import shapes and images.

For complete instructions on importing and exporting, 
refer to Appendix A, “Using Ray Dream Studio with 
other Applications.”

To move
Perspec

1Choos

2Drag t
move

You c
Hand
Space

To zoom
e the Zoom tool.

n a point in your scene. to enlarge. 
cene is magnified. You can also 
 marquee around an area to 

ify it.

 out of an area:

e the Zoom tool.

own Option/Alt and click an area.
hierarchy:

1Click the Time Line window.

2Choose View menu> Time Line.

For complete instructions on using the Time Line 
window, refer to “The Time Line Window” on 
page 297.

To set the default display of the Time 
Line window:

1Choose File menu> Preferences.

Working in a Scene

Navigating your Scene
As you create your 3D illustration or 
animation, your scene can quickly become 
rather large. You may not be able to see the 
entire scene in the Perspective window, or 
you may want to enlarge areas to precisely 
edit objects. Ray Dream Studio provides 
several tools for moving around your 
scene.

1Choos

2Click o
The s
drag a
magn

To zoom

1Choos

2Hold d
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2Choose Hierarchy from the pop-up.
or 



Choose the Zoom Out tool. 3Click the Zoom To Actual Size tool. Viewing your Scene
fault view of your scene is through 
ault camera. The camera can be sent 
mber of default positions and 
d using the Camera tools. You can 
d additional cameras to the scene. 

ose a camera to view you scene:

ose Windows menu> Camera 

erties. The Camera Properties 
g appears.

ose the camera you want to use from 
amera pop-up.
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or

Click the zoom level pop-up at the 
bottom left corner of the Perspective 
window and choose a zoom level.

To zoom into a selection of objects:

1If the Zoom toolbar is not displayed 
choose View menu> Toolbars. The 
Toolbar dialog appears.

To view all objects:

1If the Zoom toolbar is not displayed 
choose View menu> Toolbars. The 
Toolbar dialog appears.

2Click Zoom and then click OK

3Click the Zoom To All Objects tool.

The de
the def
to a nu
oriente
also ad

To cho

1Cho
Prop

dialo

2Cho
the C

or
ose View menu> Camera and 
se the camera you want.

w your scene from a preset 
n:

e View menu> Preset Position> 
oose the position you want use.

 information, refer to “Changing your 
ive on the Scene” on page 289.
2Click Zoom and then click OK

3Select one or more objects.

4Click the Zoom to selected tool.

To view objects in actual size:

1If the Zoom toolbar is not displayed 
choose View menu> Toolbars. The 
Toolbar dialog appears.

2Click Zoom and then click OK

To zoom to the working box:

1If the Zoom toolbar is not displayed 
choose View menu> Toolbars. The 
Toolbar dialog appears.

2Click Zoom and then click OK

3Click the Zoom To Working Box tool.

Cho
choo

To vie
positio

Choos
and ch

For more
Perspect
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 Command-C/Ctrl+C. A copy of the 
s placed on the Clipboard.

n item in the Perspective 
:

 the object, light or camera.

e Edit menu> Cut 

 Command-X/Ctrl+X. The item is 
ed from the scene and placed on 
ipboard.
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Viewing your scene using two 
Perspective windows

When you have additional cameras you can 
view your scene from two different 
perspectives simultaneously.

To view your scene from two views 
simultaneously:

1Choose Windows menu> New 

Perspective. The New Perspective 
Window dialog appears.

2Enable Create New Camera to create a 
new default camera for this Perspective 
window.

Now, whenever you change anything in the 
first Perspective window, the second 
window automatically updates to show 
your changes. 

Note: Each window has to be updated 
separately, so you will dramatically 
increase the redraw time of your scene by 
adding more Perspective windows. Use this 

This is the same scene viewed using two 
perspective windows.

Press
item i

To cut a
window

1Select

2Choos

or

Press
remov
the Cl
e an item in the Perspective 
:

e Edit menu> Paste 

e Command-V/Ctrl+V. The object 
rs in the Perspective window. 

 have a an object selected when 
aste an object, the object from the 
ard will replace the selected 

t.

e items in the Perspective 
If you want to use the new Perspective window to 
view your scene from two views simultaneously, you 
must have at least two cameras.

3Enter name for the camera and set its 
properties using the controls.

4Choose View menu> Preset 
Position> and select the view you want 
use for this Perspective window.

You can also position the new camera 
manually. For more information, refer to 
Chapter 14, “Setting Lights & Cameras.” 

feature sparingly.

Editing your Scene’s Contents
Ray Dream Studio has several of the basic 
operations that you’re familiar with from 
other applications. You can cut, copy and 
paste any item in the Perspective window 
using the Edit commands. 

To copy an item in the Perspective 
window:

1Select the object, light or camera.

2Choose Edit menu> Copy 

To past
window

1Choos

or

Choos
appea

If you
you p
clipbo
objec

To delet
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:

 the item.
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or window

1Select



2Choose Edit menu> Delete. The object 3Enter a value in the Multiple Undo entry 2Choose a location for your file.

r a name for the file in File name 
y box.

ose a file type from the Format/Save 
pe pop-up and click Save.

e your file under a different name:

ose File menu> Save As.

ct a location for the file.

r a new name for the file in the File 
e entry box and click Save.

g your File
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is deleted from the scene.

Editing items in the Time Line window is far more 
complicated and, if not done properly, can create some 
unpredictable results. For detailed instructions, refer to 
“Arranging Objects” on page 223 and Chapter 15, 
“Animating.”

There are many other ways you can edit 
the contents of your scene. You can 
duplicate objects, move, rotate and resize 
objects. All these operations are covered in 
“Arranging Objects” on page 223.

box.

To undo operations:

1Choose Edit menu> Undo. Ray Dream 
Studio undoes the last operation.

2To undo the next operation, choose 
Undo again. 

There are some operations you cannot 
undo. In this case, the Undo command is 
replaced by Can’t Undo.

Redoing operations

You can repeat your last action using the 

3Ente
entr

4Cho
as ty

To sav

1Cho

2Sele

3Ente
nam

Closin
you’re done editing a scene file you 
se it.

se a file:

ose File menu> Close. 

u have any changes, click Yes to save 
 or No to discard them.
Undoing Operations
You can reverse the effects of your last 
action by using the Undo command. Ray 
Dream Studio has multiple undo levels so 
that you can undo a series of operations by 
choosing undo several times. The number 
of undo levels is determined by the value 
you set in the Ray Dream Studio 
Preferences dialog. The maximum number 
of undo levels is 64.

To set Undo levels:

1Choose File menu> Preferences.

2Choose General from the pop-up

Redo command. The command is only 
available after you undo an operation. You 
can redo multiple operations. 

To repeat an operation:

1Choose Edit menu> Redo. Ray Dream 
Studio repeats the last action.

Saving and Closing 

Saving your file

When 
can clo

To clo

1Cho

2If yo
them
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To save your scene:

1Choose File menu> Save.
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5

 

Tutorial

 

Welcome

 

Welcome to the Ray Dream Studio tutorial. 
This tutorial is designed to introduce all 
the major features and functions in Ray 
Dream Studio 5. The main goal of the 
tutorial is to teach you the techniques you 
need to know to create 3D illustrations. 

Each section of lessons is self-contained so 
you can start the tutorial at any point. For 
example, if you already know how to model 
an object but need assistance on shading, 
skip the lessons on modeling and start the 
tutorial at the shading section. 
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Lesson 1: Setting up your 

          

up toolbars:

  

ose 

 

View menu> Toolbars

 

. The 

 

bars

 

 dialog appears.

  

 the toolbars you want to view. 

olbar is displayed when a checkmark 
ars next to its name.

 

s available in the 

 

Tools

 

 toolbar change 

 

ng on the window displayed.

 

ou setup your toolbars you can set 
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To help you follow along the tutorial, every lesson 
contains a section called “The Story so Far”, which 
summarizes the procedures that have been covered in 
the tutorial up to that point. It also tells you where you 
can get pre-set files to complete the lesson. 

Getting Started

The first thing you need to do is start Ray 
Dream Studio and create an empty scene.

Workspace
When you first open Ray Dream Studio, the 
palettes and toolbars are displayed in their 
default positions. If you change these 
positions or hide elements, Ray Dream 
Studio saves the new positions and use the 
them the next time you open the 
application. 

The workspace configuration shown below 
was selected because it allows you to quick 
access to all the tools you’ll need during 
the course of the tutorial.

To set

1Cho
Tool

2Click

A to
appe

The tool
dependi

After y

w of the Time Line window. The 
ine window displays a textual 
entation of your scene. This window 
re you’ll arrange groups of objects 
t up the action in your animations. 
re on the Time Line window, refer to 
 the Time Line Window” on page 32.

up the Time Line window:

 the Time Line window to select it.

ose View menu> Horizontal.The 
e Line window changes to Hierarchy 
e.

rspective window is where you’ll be 
To open a blank scene in Ray Dream 
Studio:

1Launch Ray Dream Studio. The New 
dialog appears.

2Click the Create Empty Scene button.

A new document is created and four 
windows appear: the Perspective 
window, the Properties palette, the Time 
Line window and the Browser palette.

Before starting any project in Ray Dream 
Studio, you need to set up the program’s 
interface to help you work the most 
effectively. Ray Dream Studio’s interface is 
very flexible. You can setup menus, 

To setup the workspace:

Choose Windows menu> Workspace> 

800x640 (Macintosh) /800x600 (Windows).

For more detailed instructions on 

To begin, set up your workspace to look like 
this.

the vie
Time L
repres
is whe
and se
For mo
“Using

To set

1Click

2Cho
Tim
mod

The Pe

ing and positioning objects to create 
e. The window displays three grid 
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toolbars, and palettes.
workspace settings, refer to“Setting up 
your Workspace” on page 25.

arrang
a scen



                        

ging Objects in the 

  

stration is made up of a number of 
ts arranged in an order that is 
 to eye. 

u’re working in a three dimensional 
ur scene can be viewed form any 
ich can produce a wide variety of 
 illustrations. A good arrangement 
ts makes your scene look good 
 angle. 

ons in this section will help you 
me of the arranging skills you’ll 
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planes called the Working Box. The 
Working Box can help you orient objects in 
three dimensional space. The planes in the 
Working Box represent each of the three 
axises used to define 3D space, namely X, 
Y, and Z.

You will see the planes appear in the 
Perspective window.

When all the planes are visible, you’ll 
notice that one of the planes is light blue, 
while the other two are light grey. The 
colored plane is called the active plane. 
When you drag an object in the Perspective 
window, it moves parallel to the active 
plane by default. 

Displaying additional planes allows you to 
see the projections of all the objects in 

Click on the Display Plane tool icon to 
display each plane.

Arran
Scene

A 3D illu
3D objec
pleasing

Since yo
space yo
angle wh
different
of objec
from any

The less
learn so
create 3D illustrations.

ry so Far

tarting this lesson you should have 
rkspace set up to best display all 
ssary tools in the available video 

ou’ll Need

lete this lesson you’ll need some 
which you can arrange. The 
ng Objects folder contains all the 
you’ll need. To start the lesson you 
 to add this folder to the Browser 

am Studio’s Browser palette can be 
uable utility when arranging 
To display planes:

1Click the Perspective window to make it 
the active window.

2Click each of the planes on the Display 
Plane tool icon.

The Working Box has three grid planes for X, 
Y and Z.

your scene.

The Working Box and the active plane are 
important reference tools, there are several 
options you can set for there tools. For 
more information, refer to “The Working 
Box” on page 225.

need to 

The Sto

Before s
your wo
the nece
display.

What Y

To comp
objects 
Arrangi
objects 
will need
palette.

Ray Dre
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 The Browser palette lets you store 
meras Effects and Objects. For 
objects.
Light, Ca



   

more information on the 

 

Browser

 

 palette, 

                             

The folder contains a library with 

                 

n you drag an object into the 

 

Time 

                

e Sea Terrain object into the Time 
indow.
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refer to “Using the Browser Palette” on 
page 28.

To add folders to the Browser palette:

You can use the Browser palette to store 
scene items including object, Shaders, 
Deformers and Links.

pre-made objects you’ll use to create an 
underwater scene. 

Lesson 1: Adding Objects
The simplest way of creating an illustration 

Once you add Arranging Objects, its contents 
appears in the Browser palette’s Objects tab.

Whe

Drag th
Line w
 window, it appears at the origin of 
 scene (i.e. at coordinates X=0, Y=0, 

 the objects Shell and Angel Fish 
 the Time Line window.

 the object labeled School of Fish 
drag it into the Perspective window.
1If the Browser palette is not already 
visible, choose Windows menu> 

Browser.

2Click the Objects tab.

3Choose Browser palette: File 
menu> Add Directory/Folder.

4Locate the Tutorial folder on the Ray 
Dream Studio 5 CD. Open the Arranging 
Objects folder within the Tutorial folder 
and then click Select Current Directory.

is by adding existing objects from various 
sources and arranging them to create a 
scene. In fact, most complex scenes consist 
of a few original objects combined with 
stock images or library objects. 

To add objects from the Browser palette:

1Click the Objects tab.

2Make sure you have the Selection tool 
chosen.Click on the Sea Terrain object 
and drag it into the Time Line window.

Line
your
Z=0.

3Drag
into

4Click
and 
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e scene is viewed from the front 
jects can appear to be adjacent.
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Objects dragged directly into the 
Perspective window are positioned at 
the point where you release the mouse 
button.

2Choose View menu> Object 
Invisible.

When th
view, ob
you position objects in 3D space, 
have projections which indicate 
sition in each of the planes in the 
 Box.

 tell the exact position of an object 

e scene is viewed in Reference view, 
see that the same objects are at two 
 depths.
Now that all the necessary objects are in 
the Perspective window, you’ll need to 
position them to create a scene.

You’ll notice that the terrain takes up a lot 
of the scene. This will probably make 
positioning difficult. To make it easier to 
view the other objects you can make the 
terrain object invisible.

To make objects invisible:

1Click the Sea Terrain object in the Time 

Add the Shell, Angel Fish and School of Fish 
to your scene. Lesson 2: Positioning Objects

When you drag objects into the Time Line 
window, they appeared at the exact center 
of your scene, while objects dragged 
directly into the Perspective window 
appear wherever you released the mouse 
button. This can make it difficult to tell 
exactly where objects are in 3D space. For 
example, in the front view, two spheres can 
appear to be adjacent. However, when you 
switch to Reference view, it becomes clear 
that the two objects are at completely 
different depths.

Hide the Sea Terrain to make it easier to 
view the other objects.

To help 
objects 
their po
Working

You can

When th
you can 
different
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ene by locating at least two of the 
 projections. One projection 
Line window. in the sc
object’s



   

indicates the object’s vertical and 

                          

gh you can position objects using 
rojections, it’s not the most precise 

      

own Option/Alt as you drag the fish 
tion it vertically. 
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horizontal position and the other indicates 
its depth in the scene.

An object’s projections help you determine 
its position in 3D space. 3As you drag take notice of the object’s 

Click the Angel Fish’s projection on the 
ground plane and drag to position it in the 
scene. Althou

their p

Hold d
to posi
d. By entering exact values into the 
ties palette, you can precisely 
n an object anywhere in your scene. 

ition objects numerically:

 the School of Fish object in the 
e Line window.

ose Windows menu> Properties.

 the Transform tab.
To position objects manually:

1Click the object labeled Angel Fish in the 
Time Line window.

2In the Perspective window click the fish’s 
projection on the ground plane and drag 
it towards the left edge of the working 
box.

projections on the other two planes only 
move horizontally along the X or Y axis.

4Hold down Option/Alt and drag the fish 
upwards.

Option/Alt constrains movement to be 
perpendicular to the Active plane.

metho
Proper
positio

To pos

1Click
Tim

2Cho

3Click
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 Selection tool, click the Hot Point...
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4In the top row of Position controls, enter 
X=-30, Y=-16, and Z=31.

5If Auto is not enabled, click Apply.

Enter numerical Position controls in the 
Properties palette’s Transform tab.

Lesson 3: Rotating Objects
Often, positioning objects vertically and 
horizontally is not enough. To get objects 
in just the right position in your scene 
you’ll probably need to rotate them. Like 
positioning, you can rotate objects both 
manually, using the Rotation tools, or 
numerically, using the Properties palette.

Before you begin rotating, you should 
adjust the object’s Hot Point. When 
rotating, the Hot Point acts as the pivot 
point for the object, meaning that the 
object will rotate around the Hot Point. 

By moving the Angel Fish’s Hot Point you 
can rotate it around its nose. With the
t the Hot Point is in the correct 

ag it to the nose of the fish.
The School of Fish are positioned 
numerically.

To adjust the Hot Point:

1Using the Selection tool, click the Angel 
Fish object.

2Hold down the Shift key and drag the 
black dot in the center of the object to 
the nose of the fish.

Now tha

...and dr
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, you can rotate the object.
position



n objects:

 outside the Working Box to make 
 all the objects in the Perspective 
ow are deselected.

 the Shell object with the Selection 
.

 down the Shift key and click the 
 object.

ose Arrange menu> Align 
cts. The Alignment dialog appears.

e X axis panel, select the Contact 
o button. The Sides radio button is 
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To rotate an object using the Rotation 
tools:

1Press on the Rotation tool to pop-up and 
choose the 2D Rotation tool.

2Click the Angel Fish object’s projection 
on the ground plane.

Press to pop-up and choose the 2D Rotation 
tool. 

Lesson 4: Aligning Objects

Use the 2D Rotation tool to drag the fish’s 
projection and rotate it.

To alig

1Click
sure
wind

2Click
tool

3Hold
Fish

4Cho
Obje

5In th
radi
matically enabled.

 the extension button (key) at the 
om right of the palette to show the Y 
Z axis panels.

e Y axis panel, click the Align radio 
on. The Center radio button is 

e extension button (key) to expand 
ette.
3Hold down the Shift key and drag the 
projection to the left until it’s rotated 30 
degrees. Then release the mouse button.

Holding down the Shift key constraints 
the rotation to 30 degree increments.

Another way of positioning objects is to 
align them to certain parts of your scene or 
to other object. In Ray Dream Studio, you 
can use the Alignment palette to align 
objects along each of the three axises (X, Y, 
and Z). The Alignment palette gives you 
several different methods of aligning. For 
more detailed information on the methods 
available, refer to “Aligning Duplicating 
Objects” on page 244.

In the scene you’ll use the Contact Sides 
align option to align the Angel Fish to the 
Shell. 

auto

6Click
bott
and 

7In th
butt

Click th
the pal
led by default.
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the Anemone object in the Time 

e new position values are applied to 
one, it moves to the edge of the 
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8In the Z axis panel, enable None.

9Click Apply.

The Fish moves closer to the Shell.

ºClick the Close box to close the 
Alignment dialog.

easier by combining a number of 
duplicates into a single group. A group can 
let you position and edit a number of 
objects all at the same time.

In the scene you’re creating, you can add a 
bed of sea anemones by duplicating a 
simple object and grouping it.

To duplicate objects:

1Click the SeaTerrain in the Time Line 
window and choose View menu> 
Object Visible.

2Drag the object labeled Anemone out of 
the Browser palette and into the Time 
Line window. 6Click 

When th
the anem
terrain.
indow.

e Edit menu> Duplicate.

 Position controls, enter X= 42.75, 
.25, Z= -1.5 and in the Orientation 
ls enter Yaw= 6.5, Pitch= -8.85, 

85.

uplicate object is now offset and 
ly rotated.
Lesson 5: Duplicating and 
Grouping
Duplicating is a quick way of creating a 
complex object from a simple one. For 
example by duplicating a blade of grass you 
can create an entire field. Duplicating 
creates exact copies of an object. 

Although duplicating can be a great way of 
creating large objects, arranging many 

Once you click Apply, the Fish and Shell are 
aligned. 

3Choose Windows menu> Properties. 
The Properties palette appears.

4Click the Transform tab.

5In the Position controls, enter X=46, 
Y=-10 and Z=-1.5. 

The Position controls in the Properties 
palette let you numerically position objects.

Line w

7Choos

8In the
Y= -13
contro
Roll= 

The d
slight
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duplicates in a scene can quickly become a 
complex task. You can make arranging 



. Now that you have a series of anemones, Moving On

cene is now complete. If you’re 
 with the way your scene looks, 
 File menu> Save and save it as 
_TUT.

n now adjust the position of lights 
meras, then render your scene. If 
nt to learn how to setup your scene 
dering skip ahead to “Lesson 2: 
ning Lights” on page 70. 

ant to learn how the objects in the 
you just arranged were created, 
n to the next section. 

ing is an essential part of modeling 
 may want to refer to “Arranging 
s” on page 232 for more detailed 
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9Duplicate the object again and enter 
X=46.85, Y= -15.75, Z= -1.5 and Yaw= -6.5, 

By entering values in the Properties palette 
you can offset and rotate the duplicate. 

you can group them and create a bed of 
anemones.

To group objects:

1In the Time Line window, hold down the 
Shift key and select all the objects 
labeled Anemones.

2Choose Arrange menu> Group. A new 
group object is created.

3Click the group’s title and type Anemone 
Bed.

Your s
happy
choose
ARRNG

You ca
and ca
you wa
for ren
Positio

If you w
scene 
move o

Arrang
so you
Object
ation.
Pitch= 8.85, Roll= 95 into the Properties 
palette.

Duplicate the object again and change its 

You can use the minus/arrow icon to open 
or collapse the group. When the group is 
collapsed you can only edit the group, 
when it’s open you can edit the individual 
objects.

The Anemone bed appears as a new group in 
the Time Line window.

inform
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position to create a series of anemones in 
your scene.



te an oval cross section:

the Free Form tool and drag it into 
me Line window.

ree Form modeling window 
atically opens. 

a name for your object and 
K.

e View menu> Preset 

 Free Form tool into the Time Line 
to open the Free Form modeler.
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Modeling Objects

Modeling refers to the process of creating 
three dimensional objects in Ray Dream 
Studio. A 3D model can be anything from a 
basic cube to a complex sea monster.

The lessons in this section will lead you 
through the different types of 3D modeling 
you can do in Ray Dream Studio.

The Story so Far

At the start of this section you should 
already know the basics of arranging 
objects in your scene. If you’re not clear on 
how to align, rotate or numerically position 

Lesson 1: Free Form Modeling
The Free Form modeler lets you create 3D 
objects by drawing cross section shapes 
and extruding them along a sweep path.

The cross sections determine the basic 
outline of the object, while the sweep path 
determines its depth.

The modeler has three drawing planes 
which you can use to create and extrude 
cross sections: the cross section plane and 
two sweep path planes. The active plane is 
shown in color while inactive planes are 
displayed in gray. Like the Perspective 
window, you can use the Zoom tools to 
magnify areas of your object.

To crea

1Click 
the Ti

The F
autom

2Enter 
click O

3Choos

Drag the
window 
ion> Drawing Plane.

hanges the view of the modeling 
w to display only the active plane.

e View menu> No Preview.

urns off all shading, making it 
 to see what you’re drawing.

e Geometry menu> Extrusion 
od> Pipeline.

ranslation method lets you create a 
tubular shape. For more on 
ation methods, refer to 
slation vs. Pipeline” on page 131.
objects, review “Arranging Objects in the 
Scene” on page 39, or Chapter 12, 
“Arranging Objects.”

What You’ll Need

In these next lessons you’ll be creating 
objects from scratch so you don’t need any 
other components. However, we have 
included completed versions of all the 
objects described in the lessons. If you 
have trouble, open the completed object 
and see how it was made. Completed 
objects are located in the Tutorial: 
Modeling Objects folder.

So as not to clutter the workspace, start 
each lesson with a blank scene.

Refer to “Free Form Modeling” on page 109 
for more on the Free Form modeler.

In this lesson you’ll use the Free Form 
modeler to create some seaweed.

Use the Free Form modeler to create new 3D 
objects. 

Cross 
Section 
plane

sweep path 
plane

Posit

This c
windo

4Choos

This t
easier

5Choos
Meth

This t
more 
transl
“Tran
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the Zoom tool and enlarge an area 
 Modeling window. 
6Click 
of the



7Press on the Square tool to pop-up and 3Choose Edit menu> Paste. ¡Hold down Option/Alt and click the 
er of the scene to zoom out.
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choose the Oval tool

8Click a point on the cross section plane 
and drag diagonally. Try to create more 
of a flat oval shape than a circle, this will 
be the cross section of the seaweed.

The Oval tool creates oval cross sections. 

4Deselect all shapes.

5Hold down the Shift key and drag the 
oval to the right. The two ovals should 
be just touching as shown below.

6Choose Edit menu> Select All to 
select both shapes.

Move the pasted oval to the right so that the 
two ovals are touching slightly.

cent
at you have the outline of the object 
eed to adjust the sweep path and 

ion envelope to give it a more 
c look.

 you can adjust the shape, you will 
ore points on the sweep path.

 points to the sweep path:

 the ground plane to make it active.

ose View menu> No Preview.

ou zoom out in Reference view you 
 you new cross section in the Free 
odeling window.
9Press Command-Shift-C/Ctrl+Shift+C to 
center the cross section.

To use multiple shapes in a cross 
sections:

1Choose the Selection tool and click the 
oval.

Use the Oval tool to create oval shapes as a 
cross section for the seaweed.

7Choose Arrange menu> Combine as 
Compound.

8Press Command-Shift-C/Ctrl+Shift+C to 
center the compound cross section.

9Choose View menu> Preset 
Position> Reference.

ºClick the Zoom tool.

The Zoom tool lets you magnify your view of 
the scene. 

Now th
you’ll n
extrus
organi

Before
need m

To add

1Click

2Cho

When y
can see
Form m
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2Choose Edit menu> Copy.



t you’ve added points, you can 

u’re done adding points, your sweep 
uld look like this. 
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3Hold down the Shift key and click the 
sweep path, then extend it to the edge of 
the Modeling window.

The sweep path is displayed in red.

Every time you click the tool on the 
toolbar, a new tool appears. You can 
cycle through all the tools by clicking on 
it repeatedly.

6Click the sweep path. A new point is 
added. 

Each time you click the path a new point 
is added. You’ll need the new points to 
create additional cross sections. Every 
point on the sweep path represents a 

The Add Point tool lets you add control 
points to path. 

Now tha

When yo
path sho
em to reshape the sweep path.

 points:

e the Selection tool.

the second point and drag it to the 
4Choose Geometry menu> Extrusion 
Envelope> Symmetrical to add an 
extrusion envelope.

5Double-click the Convert Point tool to 
choose the Add Point tool.

Extend the sweep path all the way to the 
edge of the Free Form modeling window.

point where you can place a cross 
section.

7Add two more points to the sweep path.

move th

To move

1Choos

2Click 
left. 
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Make sure you’re selecting a point on the 4Click the next point and drag it to Your sweep path should now look like 
ve.

ou use the convert points to smooth 
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sweep path (the red line) not on the 
envelope (the blue lines).

the left.

After adjusting the points along your sweep 
path, it should look like this. 

a wa

After y
ose View menu> Preset 
tion> Right.

 the Zoom tool and zoom in on the 
p path.

ep path it should look like a wave. 
Make sure all the points are deselected 
before going on.

3Click the next point and drag it to 
the right.

Add a second point on your sweep path and 
drag to the left.

5Press on the Add Point tool to pop-up 
and choose the Convert Point tool.

6Click each point on the sweep path and 
drag up.

Choose the Convert Point tool. 

7Cho
Posi

8Click
swee

the swe
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Done.

pleted seaweed should look 
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9Click the second point on the sweep path 
with the Selection tool and move 
it down.

You’ll need to deselect all the points 
before selecting the next point.

Use the Selection tool to move the second 
point on sweep path down.

To adjust the extrusion envelope:

1Click the final point on one of the 
envelope line and drag it towards the 
center.

Envelope definition lines are shown 
in blue.

3Click 

Your com
like this.
weed stalk is now complete. You 
t to save it in a convenient 

. Once the object is in the 
tive window, you can position and 
e it to create a seaweed bed. For 
ormation, refer to “Lesson 5: 
ing and Grouping” on page 45.
ºClick the next point and move it up. 

¡Click the next point and move it down.

Your seaweed now waves both side to side 
and up and down. Next you’ll adjust the 
extrusion envelope to add the final touches 

When you’re done adjusting the points, your 
sweep path should look like a wave.

2Choose View menu> Preset 
Position> Reference.

Drag the final point to the center to “pinch 
off” the extrusion envelope creating the tip of 
the seaweed.

Your sea
may wan
location
Perspec
duplicat
more inf
Duplicat
Chapter 5 • Tutorial 51
to your seaweed.



. 2Press to pop-up and select the Draw 5Choose View menu> Preset 
tion> Reference.

ose the Add Point tool.

 the sweep path on the ground 

 Add Point tool to add new control 
to a path.
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You can arrange and duplicate the seaweed 
in the scene.

Oval tool.

3Hold down the Shift key and draw a 
circle about five grid squares in 
diameter.

Select the Draw Oval tool to draw oval cross 
sections.

Posi

6Cho

7Click

Use the
points 
e and add a point about two grid 
res from the first point. 

 Add Point tool to add a point on the 
Lesson 2: Complex Free Form 
Modeling
Now that you know how to create simple 
objects using the Free Form modeler, you 
can use the skills you learned to create 
much more complex objects. Many objects 
have more detail than can be extruded 
using only a simple cross section and 
sweep path. In the next chapter you’ll learn 
how to use multiple cross sections and 
shape numbering to create a sea anemone.

To create multiple cross sections:

1Open the Free Form modeler.

4Press Command-Shift-C/Ctrl+Shift+C to 

Use the Draw Oval tool to create the first 
cross section. 

plan
squa

Use the

path two grid squares from first.
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center the cross section.
sweep 



st shape numbers:

the last cross section on the sweep 
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8Choose Sections menu> Create.

9Choose the Selection tool.

ºClick the new cross section and choose 
View menu> Preset Position> 

Drawing Plane.

¡Choose View menu> No Preview.

™Choose Sections menu> Next. If Next 
is not available you are already on the 
correct section.

£Choose the Oval tool.

¢Hold down the Shift key and draw six 
smaller circles inside the larger circle.

§Choose the Selection tool.

¶On the ground plane, click the last point 
on the sweep path.

•Hold down the Shift key and drag it to 
the end of the Working Box. 

To adju

1Click 
path. 
u select the last cross section on the 
 cross section becomes the active 
 plane.
You may need to move the circles to get 
them inside the larger circle.

Add six smaller circles inside the larger circle 
with the Oval tool.

ªChoose Sections menu> Create. A 
new cross section is added to the end of 
the path.

To ensure that shapes with multiple 
cross sections are extruded properly, 
you can assign numbers to shapes. Ray 
Dream Studio uses corresponding 

Extend the sweep path to the end of the Free 
Form modeling box.

When yo
path, the
Drawing
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∞Choose View menu> Preset 
Position> Reference.

numbers to determine how to extrude 
cross sections. 



2Choose Sections menu> Show 7Change the number of the cross sections ºChange the shape numbers to match the 
ram shown below.

ou delete a shape, the number all 
 so you need to adjust the remaining 
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Shape Numbers.

You can use the cross sections shape 
numbers to control how multiple sections are 
extruded.

to match those shown below.

When you’re done adjusting the shape 
numbers on your cross section, they should 
match these shown. 

diag

After y
change
k shape #2 with the Selection tool.

ose Windows menu> Properties.

e Position controls, enter 
th=0.25, Hieght=0.25. Be sure the 
 Proportions box is enabled.

k Apply.

rs to match those shown. 
3Choose Sections menu> Previous. 

4Choose Sections menu> Previous 
again. You should be on the first cross 
section.

If Previous is not available you’re already 
on the first cross section.

5Choose Sections menu> Next. 

6Click a cross section number. The Shape 
Number dialog appears.This dialog lets 
you change the shape’s number.

8Choose Sections menu> Next.

9Select shape #1 and delete it. All the 
numbers change.

¡Clic

™Cho

£In th
Wid
Keep

¢Clic

numbe
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e View menu> Preset 
ion> Drawing Plane.

e Sections menu> Show> 
nt.

he circles away from the center as 
 below.
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∞Repeat steps 11 to 14 for each of the 
remaining shapes.

When you’re done resizing the cross sections, 
your cross sections should look like these.

3Add a point between the second and last 
cross sections.

The new point determines where the cross 

6Choos
Posit

7Choos
Curre

8Drag t
shown
e View menu> Preset 
ion> Reference. 

the Shaded Preview Quality 
n.

u’re done repositioning shapes, your 
tion should look something like this.

haded Preview Quality button to see 
w of your object with shading.
Now that the numbers are correct, you can 
add more sections.

To add more sections:

1Click the ground plane to make it active.

2Choose the Add Point tool.

4Choose Sections menu> Create. 

5Click the new cross section.

section will be placed.

9Choos
Posit

ºClick 
butto

When yo
cross sec

Use the S
a previe
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The new cross section has the same number 
of shapes as the previous section.



¡Choose Sections menu> Show> All. 3Add a point on the envelope as shown. 6Choose the Convert Point tool.

oth the points as shown.

 Convert Point tool to convert lines to 
.
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Now that you have all the necessary cross 

Your object should look like this in Shaded 
Preview.

4Choose the Selection tool.

Use the Add Point tool to create a new point 
on the object’s envelope.

7Smo

Use the
curves
ou adjust the points on the envelope, 
ject should look like this.
sections, you can add a extrusion envelope 
to reshape the anemone.

To adjust the object’s envelope:

1Choose Geometry menu> Extrusion 
Envelope> Symmetrical.

2Choose the Add Point tool.

5Drag the new point down and to the left 
as shown.

Use the Selection tool to adjust the position 
of the new point. 

After y
your ob
56 Ray Dream Studio User Guide



 indicator will help you tell which 
u’re working in.  

ne has a different color. The X axis 
en, the Y axis in blue and the Z axis 

 “Mesh Form Modeling” on 
 for more on the Mesh Form 
.

ext lesson you’ll create a fish using 
itive and the Sphere of Attraction 

h Form modeler axis indicator helps 
e the plane you’re working in.
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8Click Done.

This is how your completed anemone 
appears in the Perspective window.

Lesson 3: Mesh Form Modeling
The Mesh Form modeler lets you create 3D 
objects by adjusting the position of 
vertices, or points, mapped onto a shape or 
outline. 

The Mesh Form modeler is a very organic 
way of modeling. You can think of the 
objects you create in the modeler as being 
made out of a malleable medium, like clay, 
that can be reshaped by pulling or pushing 
it’s surface.

The axis
plane yo

Each pla
is in gre
is red.

Refer to
page 137
modeler

In this n
a 3D prim

The Mes
determin
 the Mesh Form modeler:

he Mesh Form tool into the 
ective window.

esh Form modeler opens.

a name for your new object and 
K.

 Mesh Form tool into the Perspective 
to open the Mesh Form modeler.
Your sea anemone is complete. You may 
want to save it in a convenient location. In 
the Perspective window you can duplicate 
the anemone to create a sea anemone bed.

Like the Free Form modeler, the Mesh 
Form modeler has three drawing planes 
representing the X, Y, and Z axises. 
However, since you’re not working with a 
sweep path there are no projections to 
work with. All your modeling is done 

The Mesh Form modeler lets you create 
objects using vertices and polymeshes.

tool.

To open

1Drag t
Persp

The M

2Enter 
click O

Drag the
window 
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Duplicate the anemone to form a bed.

directly in 3D.



4Click the top right point of the sphere’s 3Drag to select the back half of the 
re.

ose Selection menu> Subdivide.

 will double the number of points in 
elected area. The more points you 
, the more control you have over the 

 Marquee tool to selected the vertices 
back half of the object. 
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To create a 3D primitive

1Choose the Create Sphere tool.

2Drag the tool in the Mesh Form modeling 
window. Using the grid squares, make 

Drag with the Create Sphere tool to make a 
3D sphere. 

bounding box and drag to flatten and 
stretch the sphere as shown.

The flattened sphere should be about 
two grid squares wide.

sphe

4Cho

This
the s
have

Use the
on the 
e of the object.

 the Sphere of Attraction tool.

ose Windows menu> Properties. 
Properties palette appears.

 the Tool Options tab.

ct the Spiky radio button.

 Sphere of Attraction tool to move a 
f vertices. 
your object approximately 4 x 4.

3Choose the Selection tool.

Your 3D sphere should be about four grid 
boxes wide and four grid boxes long. 

Now that you have the basic shape, you 
can move its points (also called vertices) to 
reshape the sphere’s outline

To edit an object’s mesh:

1Choose View menu> Preset 
Position> Left.

2Choose the Marquee tool.

Drag the sphere’s bounding box to stretch 
and flattened it.

shap

5Click

6Cho
The 

7Click

8Sele

Use the
group o
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Use the Marquee tool to select a group of 
vertices. 



he point up and towards the left as 
.

the second point from the left on 

’re finished moving the vertex your 
ould look like this. 
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9Set the Radius of Sphere to 4.00. Stop dragging when your shape looks 
like the one shown below.

To create the fish’s tail:

1Click the Zoom tool.

2Zoom in on the extended section.

x

Your object should look like the one shown 
after you drag the vertex. 

4Drag t
shown

5Click 

After you
object sh
ttom edge of the tail.

 point shown and drag it down and 
ft. 
ºClick outside the sphere to deselect it.

¡Select the left-most point on the sphere 
and drag it left.

Use the Sphere of Attraction options to set 
the radius and shape of the tool.

x

The left-most point on the sphere is 
approximately in the position shown. You 
may need to zoom in on the object.

3Click the second point from the left on 
the top edge of the tail. 

You may need to click a few time to find 
the right point. Refer to the diagram 
below for more precise positioning.

Tip: If you accidentally click on a segment 
(a line with two points), click outside the 
object to deselect it.

the bo

Click the
to the le
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Click the vertex shown above and drag it to 
the left. 



6Drag the point down and to the left. To create the school you’ll need to 
ate and group the fish. For more 
ation, refer to “Lesson 5: Duplicating 
ouping” on page 45.

our fish is complete you can duplicate 
up it to create a school of fish. 
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7Choose the Sphere of Attraction tool. 

8In the Properties palette: Tool 
Options tab, enable the Spiky radio 

The tail should look like this when you’re 
finished adjusting the vertex. 

To smooth object edges:

1Choose the Marquee tool and select the 
entire object.

2Choose Poly Mesh menu> Smooth 

Edges.

3Click Done.

duplic
inform
and Gr

When y
and gro
n 4: Deformers
ers are a special set of tools that let 

shape objects or groups of objects. 
eformers you can easily create 

 that would require a large amount of 
tioning and editing. For example, you 
plode an object by just applying a 
er instead of breaking the object 
anually and repositioning all the 

. For more on Deformers, refer to 
mers” on page 171.

 lesson you’ll apply the Wave 
er to a fish object. The Wave 
er will give the fish object a fluid 
button and set the Radius of Sphere to 
0.5. 

9Click a point on the top edge of the 
object and drag it up and to the left. 

The basic shape of your fish is now 
complete. To finish it off you’ll need to 

Your dorsal fin should look like this when 
you’re finished adjusting it with the Sphere of 
Attraction tool. 

The fish is now complete. You may want to 
save it in a convenient location. The fish 
object you just completed was used to 
create the School of Fish object in the first 
section. 

Your completed fish should look like this. Lesso
Deform
you re
Using d
effects
reposi
can ex
deform
apart m
pieces
“Defor

In this
deform
deform
look. 
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adjust the smoothness of the fish shape.



the Direct Manipulation button.

 manipulation lets you adjust the 
er’s settings interactively in the 

ective window. 

the center point and drag it to the 
he center points adjust the phase.

 Direct Manipulation button to 
he Deformer’s control handles.
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Although this tutorial instructs you to use 
the fish from the Browser palette, feel free 
to use the fish object you created in the 
Mesh Form modeler.

To apply a deformer:

1If you haven’t done so already, add the 
Modeling Objects folder in the Tutorial 
folder to the Browser palette: 
Objects tab.

2Drag the Mesh Form Fish object from the 
Browser palette to the Perspective 
window.

5Choose Wave from the Defomers pop-up.

Use the Wave Deformer controls to set the 

¡Click 

Direct
deform
Persp

™Click 
left. T

Click the
display t
 the dialog.

 should now look like its swimming 
ater. Deformers can also be 

to groups of objects. For example if 

ct Manipulation controls let you 
e Wave deformer’s attributes in the 
ive window. 
3Choose Windows menu> Properties.

4Click the Deformers tab.

When you add the Modeling Objects folder to 
the Browser, you should see the Mesh 
Form Fish.

6If it is not already enabled, enable the 
Auto button at the bottom of the dialog.

When this button is enabled, any settings 
you change are automatically applied to 
the object. 

7Set Phase to 0.

8Orientation to X Axis.

9Set Number of Wave cycles=1.5.

ºSet Height of waves =08%.

phase and shape of the wave.

£Close

The fish
though w
applied 

The Dire
adjust th
Perspect
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te a school of fish from the single 
ct you can apply the Wave 
you crea
fish obje



deformer to the entire school. All the fish Shading Objects
 lesson files to the Browser 

e:

 the Objects tab and choose 
ser palette: File menu> Add 
ctory/Folder. 

te and open the Tutorial folder on 
ay Dream Studio 5 CD-ROM. Open 
utorial folder, then open the 
ing Objects folder.

 Select Current Directory. 

 the Shaders tab and choose 
ser palette: File menu> Add 
ctory/Folder.
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will then appear to be swimming in the 
same direction.

Moving On

After completing the lessons in this section 
you should be familiar with the different 
types of objects you can create with Ray 
Dream Studio. The objects you created are 
just the beginning. You can create some 
incredibly complex objects just by 
combining the skills outlined in these 
lessons. For example, the same techniques 
used in Lesson 1, can be used to create 
leaves or plants. The techniques in 
Lesson 2 can be used to create an octopus 
or any number of tentacled creatures.

Shaders are used to apply surface 
properties to objects. The Shader 
determines whether the object is shiny or 
dull, rough or smooth, transparent or 
opaque. By combining several different 
surface properties you can make even the 
simplest objects come alive. 

A Shader can be saved as a file in the 
Browser palette which allows you to apply 
the same surface properties to several 
different objects. 

The lessons in this section will teach you 
how to create, save and apply shaders.

To add
palett

1Click
Brow

Dire

2Loca
the R
the T
Shad

3Click

4Click
Brow

Dire
te the Tutorial folder on the Ray 
m Studio 5 CD-ROM. Open the 
rial folder, then open the Shading 
cts: Tutorial Shaders folder.

 Select Current Directory.

re instructions on opening folders in 
owser palette, refer to “Arranging 
s in the Scene” on page 39.

n 1: Creating Shaders
s are a collection of surface 
ties that are saved in a special file 
a shader file. You can create new 
 files and edit existing ones using the 
t Shader Editor palette.
A good way to expand your modeling skill 
is to jump into some of the objects in the 
Browser palette. You can examine their 
sweep paths and cross sections to see how 
you might go about creating your own 
objects.

The next section of the tutorial will lead 
you through the process of creating and 
applying shaders to objects.

The Story so Far

In the previous sections, you learned how 
to create and arrange objects. The type of 
shader you create will largely depend on 
the shape of your object, so you should be 
familiar with modeling concepts and 
procedures. For more details of modeling, 
refer to “Free Form Modeling” on page 109 
and “Mesh Form Modeling” on page 137.

What You’ll Need

In the next lessons you’ll be creating 
shaders. To see the effects of the Shaders 
you’ll need to apply them to some objects. 

5Loca
Drea
Tuto
Obje

6Click

For mo
the Br
Object

Lesso
Shader
proper
called 
shader
Curren
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e the file Tutorial: Shading 
ts: SHELL_TEXTURE on the Ray 
 Studio 5 CD-ROM. 

exture map controls appear.

import this image to use as Texture 
your object.
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In this lesson you’ll use the Current Shader 
Editor to create a new shader and save it in 
the Browser palette.

Since you’ll be applying shaders to your 
objects in this lesson you should adjust 
your preview mode to better see the affects 
of the shaders.

To change the preview mode:

Click the Shaded Preview Mode button.

Use the Shaded Preview Mode button to see 
the effects of shaders on an object. 

The Current Shader Editor palette 
appears. When you create a new object, 
Ray Dream Studio places a default 
shader on it. The default shader has all 
the shader’s channels set to 50. Each 
shader has eight channels which store a 
different surface property. 

6Locat
Objec
Dream

The T

You can 
map on 
the Highlight tab.

e value to 50.

the Shininess tab and set the value 

ture Map controls let you specify the 
and orientation of the texture map. 
In this preview mode, you will be able to 
see any texture maps you apply to objects.

To create new shader:

1Drag the Shell object from the Browser 
palette to the Perspective window.

2Choose the Eyedropper tool.

3Click the Shell.

Use the Eyedropper tool to pick up the 
selected object’s shader and display it in the 
Current Shader Editor palette. 

4Click the Color tab.

5Choose Shader Editor: Insert 
menu> Texture Map. 

The Current Shader Editor lets you edit the 
shader’s eight property channels. 

7Click 

8Set th

9Click 
to 50.

The Tex
tile size 
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the Bump tab.
ºClick 



¡Choose Shader Editor: Insert menu> 3Enter a name for the shader.

n 2: Applying Shaders
eam Studio lets you apply shaders in 
er of different ways. You can apply 
der uniformly, or use the 3D Paint 

o apply shaders to specific areas of 
ct.

 lesson you’ll use Paint shapes to 
tripes to a fish and then use the 3D 

rush to fade them.

ly a shader uniformly:

 the object labeled Angel Fish from 
rowser palette to the Time Line 
ow.
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Texture Map. 

™Locate the file Tutorial: Shading 
Objects: SHELL_BUMP on the Ray Dream 
Studio 5 CD-ROM

£Set Brightness to 30%.

You can also import a different image in the 
Bump channel to use as a Bump map.

To save a shader in the Browser palette:

1Click the Browser palette: Shader 

When you click Apply, Ray Dream Studio 
applies al the attributes in all the Shader 
channels to the Shell. 

Lesso
Ray Dr
a numb
the sha
tools t
an obje

In this
apply s
Paintb

To app

1Drag
the B
wind
 the Shaders tab.
Bump channel effects can only be seen in 
the final rendered image.

¢Click Apply.

Your shader is now complete. If you want 
to apply the shader to other objects, you 
need to save it in the Browser palette.

tab.

2In the Current Shader Editor, click the 
shader preview image and drag it to the 
Browser palette.

2Click
64 Ray Dream Studio User Guide

You can drag your Shader to any shader 
family in the Browser palette.



aint Shape tools let you place 
 maps directly onto the surface of 
ject.

e View menu> Preset 
ion> Left.

 large square over the body of the 
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3Locate the drag the Angel Fish Skin 
shader from the Browser palette onto 
the Angel Fish object.

The fish’s skin was created by applying the You can see how the Fish stripes shader was 

The P
image
an ob

3Choos
Posit

4Drag a
fish.
tripes appear when you release the 
e button.

 Paint Shape tool on the object’s 
o size the paint shape.
The Fish Skin shader is designed to be 

used as a base shader, meaning that the 
properties set for this shader will be 
carried over to any other shader you 
apply on top of it.

Once the fish’s base color is set you can 
add the stripes.

To a place a paint shape on an object:

1Click the Angel Fish Stripes shader in the 
Browser palette.

The Angel Fish Stripes shader was 

base shader Angel Fish Skin.

2Choose the Rectangular Paint Shape 
tool.

created by opening it in the Current Shader 
Editor. 

Use the Rectangular Paint Shape tool to 

The s
mous

Drag the
surface t
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created using a single image map of 
stripes. All the other channels in the 
shader are empty.

create a rectangular paint shapes on objects.



If the stripes are not in the right place, 5Set the following:

city to 95%

ance to 0%

ness to 0%

le to 0 degrees.

ose View menu> Preset 
tion> Right.

 the brush over the top and bottom 
s of the fish.
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Choose the Paint Shape Selection tool 
and drag it to a different location.

5Choose View menu> Preset 
Position> Right.

When you release the mouse button the 
stripes appear.

To apply a shader using the 3D 
Paintbrush:

1In the Browser palette, click the Fish 
Skin shader.

2Choose the 3D Paintbrush tool.

The Brushes palette appears.

Use the 3D Paintbrush tool to paint brush 
strokes onto your object. 

Opa

Adv

Hard

Ang

6Cho
Posi

7Drag
edge
ose View menu> Preset 
tion> Left.

ush you created will fade fish’s stripes 
ou paint over them. 
6Draw a large square on this side as well.

Now that you have the stripes on the fish. 
You can make them appear to fade as they 
reach the fish’s edges.

Since the fish’s stripes are in a shader, you 
apply them again to the other side of the fish.

3Set the Size value to 99.

4If the palette is not extended, click the 
Extend icon to extend the palette.

Use the Brushes palette controls to set the 
size and Opacity of your 3D Paintbrush.

8Cho
Posi

The br
when y
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Use the extend icon to view more 3D 
Paintbrush controls.



g up Lights

l appearance of your scene 
 greatly on how you light it. In fact, 

 the effects you applied to objects 
aders can only be seen if the they 
operly. For example, you can’t see 
iness of an object’s surface unless 
e a light onto it.

ream Studio, you can apply the 
hting techniques used in real 
aphy. By adjusting the position and 
s of lights you can produce a large 

 of different scenes using the same 
jects. 
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9Paint over the edges of the fish on this 
side as well. You don’t have to worry 
about matching to the two sides as the 
fade will look more natural the more 
uneven your strokes.

Use the 3D Paintbrush to fade the other side 
of the fish as well.

The fish is now complete. If you want to see 
the rendered shader use the Render 
Preview tool or skip ahead to “Rendering” 
on page 92.

Moving On

The lessons in this section covered most of 
the basics of working with Shaders, but 
that doesn’t mean that’s all there is to 
learn. Shaders can give you an almost 
infinite variety of textures and colors. 
There are many more complex ways of 
creating shaders. Refer to “Creating 
Shaders” on page 197 for details on all the 
features you can use to create complex 
shaders. 

As with modeling objects, a good way to 

Settin

The fina
depends
many of
using sh
are lit pr
the shin
you shin

In Ray D
same lig
photogr
attribute
number
set of ob
ons in this section will take you 
 adding lights using the Browser 
nd position them using the Direct 
ation controls.

ry So Far

orial has lead you through the 
cessary to create, arrange and 
bjects. If you’re unclear on any of 
ncepts refer to earlier sections of 
rial or see the relevant chapters. 

ou’ll need

he affects of the lights you’ll need a 
ou can use the scene you arranged 
st section of the tutorial, or use the 
T_TUTOR_1.
ºChoose View menu> Reference.

When you’re done painting on the fish, 
switch to Reference view to the see the 

learn more about shaders is to take a look 
at how other shaders are made. Try 
opening some of the pre-made Shaders in 
the Current Shader Editor.

The next section of the tutorial will lead 
you through the process of adding lights to 
your scene.

The less
through
palette a
Manipul

The Sto

This tut
steps ne
shade o
these co
this tuto

What Y

To see t
scene. Y
in the fir
file LIGH
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results of your changes.



The Render Area tool lets you check your scene to highlight object outlines (Back 
and one to create shadows (Fill 
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To begin setting up lights:

1Open the scene file Tutorial: Setting Up 
Lights: LIGHT_TUTOR _1 on the Ray 
Dream Studio 5 CD-ROM.

2Click the Lights tab.

3Choose Browser palette: File 
menu> Add Directory/Folder. 

4Locate Tutorial: Setting Up Lights folder 
and click Select Current Directory.

Like shaders, some of the lighting effects 
cannot be seen until you render your 
scene. Ray Dream Studio offers you two 

lighting by rendering a small area of your 
scene. 

To render an area of a scene:

1Choose the Render Area tool.

2Drag the tool over the area you want to 
render.

Lesson 1: Adding Lights
There are two different types of lights you 

Use the Render Area tool to render areas of 
your scene. 

Light) 
Light).
Dream Studio this basic setup can be 
d using a Spot light as a Key Light, 
ce light as a Back Light and Ambient 
 a Fill Light.

nt light settings depend on the 
nment you want to create. For an 

ater scene, the ambient light should 
fairly low to create murky 
here.

 ambient light:

ose Windows menu> Scene 

ings. The Scene Settings dialog 

sic lighting setup can be used to 
ely light most scenes. 
tools for see light effects without having to 
render your scene: Shaded Preview Mode, 
and the Render Area tool. 

To switch to Shaded Preview mode:

Click the Shaded Preview button.

Shaded Preview slows the redraw time 
dramatically so its a good idea to work in 
Preview mode while you’re setting up lights 
and then switch to Shaded Preview only 
when you’re finished.

Use the Shaded Preview button to see the 
effects of lights on your objects.

can add to your scene: ambient and 
specific. Ambient light acts like daylight. It 
has no origin and doesn’t cast shadows. 
Specific lights like, spot lights or bulb 
lights, have an origin which can be 
positioned in your scene.

When deciding how many lights to add, you 
should consider the contents of your scene 
and your systems memory limitations. The 
more lights you add, the longer the 
rendering time. 

In most cases you can adequately light 
your scene using only three specific lights. 
One light in front of the object to illuminate 
the scene (Key Light), one behind the 

In Ray 
create
Distan
light as

Ambie
enviro
underw
be set 
atmosp

To set

1Cho
Sett

This ba
effectiv
ars.
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oints appear on the bulb light 
d control handles) in the 
ective window. You can adjust the 
 properties by dragging its control 
es.
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2Click the Effects tab.

3Display the Ambient Light controls.

4Click the color chip and choose a dark 

Use the Effects tab of Render Effects palette 
to set the color and brightness of your 
ambient light.

2Choose Windows menu> Properties. 
The Properties palette appears.

3Click Auto.

4Choose Bulb Light from the pop-up.

Two p
(calle
Persp
light’s
handl
ight’s Direct Manipulation controls 
 properties in the Perspective 
blue color from the palette.

5Set Brightness to 30%.

6Close the palette.

Now that you’ve set the ambient light you 
can add specific lights to the scene. You 
can begin by adding a bulb light.

To add a light:

1Drag the Create Light tool into the Time 
Line window.

5Disable the Shadows checkbox to save 
on rendering time.

6Click the Direct Manipulations button.

Use the Light tab of Properties dialog to 
choose a light type and color.

Use the Direct Manipulations button to 
display the light’s control handles.

Use the l
to set its
window.
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Drag the Create Light tool into the 
Perspective window to create a new light.



7Click the control handle that extends 4Set Position values to X=0, Y=65, and 
.

 Apply. 

ht moves to the upper left corner of 
rking Box.
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from the light and drag it away from the 
light. This adjusts the Brightness value in 
the Properties palette.

As you drag the Bulb brightness control, the 

To add lights from the Browser palette:

1Choose Browser palette: Lights tab.

2Drag the light labeled Light Tutor to 
Time Line window.

Your new lights appear at preset positions. 
You now have all the lights you’ll need to 
create a good lighting effect, but you still 
need to properly position the lights.

Click the Light tab on the Browser palette to 
view any saved lights.

Z=80

5Click

The lig
the Wo
maining light can be positioned 
by applying the Point At behavior. 
int At behavior forces the light to 
 point at the object no matter what 
n it is in. Wherever you move the 

, the lights will follow.

 the Point At behavior to a light:

e Time Line window, click the light 
led Key light.

ose Windows menu> Properties if 
roperties palette is not already 

n enter values in the Properties 
’s Transform tab to numerically 
ion the bulb light.
You can use the Direct Manipulation 
controls to adjust the properties any type 
of light. Spot lights have many more control 
points than bulb lights. For more details on 
interactive controls, refer to “Controlling a 
Spot Light Directly” on page 277.

You can also add lights by dragging them 
out of the Browser palette.

Brightness value in the Properties palette 
changes.

Lesson 2: Positioning Lights
There are several ways of positioning 
lights. Like other objects you can position 
lights numerically or manually. As well, you 
can also assign special behaviors to lights 
which will automatically position them.

To position lights using Transform 
controls:

1Click the Bulb light in the Time Line 
window.

2Choose Windows menu> Properties. 
The Properties palette appears.

3Click the Transform tab.

The re
easily 
The Po
always
positio
object

To add

1In th
labe

2Cho
the P

You ca
palette
reposit
le.
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a gel:

the light labeled Key light in the 
Line window.

e Windows menu> Properties. 
roperties palette appears.

the Gel tab. 
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3Click the Behaviors tab.

4Click the Add Component button.

5Choose Point At from the list and 
click OK.

Click the Add Component button to see a list 
of available components.

8Click Apply.

9To see the results of the pointed light, 
enable the Shaded Preview button.

To add 

1Click 
Time 

2Choos
The P

3Click 
e Map from the pop-up.

the disk icon and choose Open.

e the file: Tutorial: Setting Up 
: WATER on the Ray Dream 
 5 CD-ROM and click Open.

Apply.

el tab in the Properties palette to 
ge maps as gels.
6Type the name Conch Shell in the Point 
At box. 

This forces the light to point at the 
Conch at all times.

Use the Behaviors tab to add or delete 
behaviors for an object.

Now that your lights are all in the correct 
position you can refine individual light 
properties to create special effects.

Lesson 3: Lighting Effects
Just like in a real studio, a light doesn’t 
have to be just a simple spot light. You can 
adjust the light’s properties to create 
subtle effects, or you can add gels to lights 
to create a special lighting effect.

Gels are images that act as transparency 
masks when you place them in front of a 

In Shaded Preview you can see the results of 
your light settings. 

4Choos

5Click 

6Locat
Lights
Studio

7Click 

Use the G
load ima
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7Make sure the Enabled checkbox is 
checked.

light. 



Your lighting setup is now complete. If you Setting up Cameras
in setting up cameras:

n the file Tutorial: Setting Up 
eras: CAMERA TUTOR on the Ray 
m Studio 5 CD-ROM.

 can also use the scene you arranged 
e first section of the tutorial.

ose Browser palette: Cameras 

ose Browser palette: File menu> 
 Directory/folder.

te the Tutorial: Setting Up Cameras 
r and click Select Current 
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want to see the lighting effect, drag the 
Render Preview tool over the entire scene.

Just like in a real photo studio, the 
appearance of your scene can vary 
depending on where you view it from. That 
is why you strategically place cameras at 
specific positions. Since all your objects in 
Ray Dream Studio exist in a 3D space, you 
can position cameras to view your scene 
from any angle. 

When you’re rendering an image or 
animation, the view you see through a 
camera is used to produce the final image.

The lessons in this section will teach you 
how to add cameras using the Browser 

To beg

1Ope
Cam
Drea

You
in th

2Cho
tab.

3Cho
Add

4Loca
folde
ctory.

n 1: Adding Cameras
ault, your scene already has one 
a. The preset positions available 

e View menu are based on the 
 camera. You can add other cameras 
 your scene from different 
ctives. You can also add cameras to 

ommonly used camera angles.

plest way of adding a camera is to 
ne out of the Browser palette.

 cameras from the Browser 
e:

e Browser palette is not visible, 
Moving On

The lighting setup can be quickly adapted 
to any scene by just changing the Point At 
object.

Many other lighting setups are available 
through the Scene Wizard. The Scene 
Wizard will lead you through he process of 
creating a lighting setup by answering a few 
questions. For more on the Scene Wizard, 
refer “Using the Scene Wizard” on page 27.

The next section of the tutorial will show 
you how to set up cameras.

When you render your image you can see the 
effects the gel on your objects.

palette and position them using the Direct 
Manipulation controls.

The Story so Far

You’ve learned how to create, arrange, 
shade and light objects in your scene. Since 
lighting can be essential to deciding where 
you place cameras, you should be familiar 
with lighting concepts and procedures.

For more information, refer to “Lesson 1: 
Adding Lights” on page 68, or“Setting 
Lights” on page 271.

What You’ll Need

To get a feel for how different camera 
perspectives can be used in a scene, you’ll 
need a sample scene. 

Dire

Lesso
By def
camer
from th
default
to view
perspe
save c

The sim
drag o

To add
palett

1If th

se Windows menu> Browser.
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sition of the camera in the scene. 
iangle that extends out in front of 
mera controls the zoom level.
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2Choose the Cameras tab.

3Drag the Camera Set camera from the 
Browser palette into the Time Line 
window.

The new camera appears at its preset 

The Camera tab in the Browser palette 
contains sets of camera settings.

2Choose Windows menu> Properties. 
The Properties palette appears.

3Click the Camera tab.

4Choose Conical from the pop-up.

5Enable the Normal radio button.

Use the Camera tab in the Properties palette 
to set camera type and zoom level.

the po
The tr
the ca
he zoom controls (the triangle 
ding in front of the camera) 
ds the camera. 

amera’s direct manipulation 
to adjust its attributes in the 
ive window.
position.

You can also create new cameras and 
customize their attributes.

To add cameras using the Create 
Camera tool:

1Choose the Create Camera tool and drag 
it into the Time Line window.

Drag the Create Camera tool into the Time 
Line window to add a new camera to your 
scene.

6Enable the Auto box.

7Click the Direct Manipulation button.

The camera’s control handles appear in 
the Perspective window. You can set the 
camera’s attributes by dragging these 
control handles.

The control handle that extends in front 
of the camera controls the viewpoint, the 
control that extends behind it controls 

Use the Direct Manipulation button to display 
the camera’s control handles.

8Drag t
exten
towar

Use the c
controls 
Perspect
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A new camera appears at the origin. By 
default, the camera is named Camera 2.



If you find it difficult to move the zoom When you release the mouse button, the Your new camera setup is complete.

n 2: Viewing your Scene 
 Different Cameras
at you have more than one camera 

n choose which camera you want to 
view your scene.

tch between cameras:

ose Windows menu> Camera 

erties. The Camera Properties 
tte appears.
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control, try adjusting the zoom control 
on one of he camera’s projections.

Drag the camera’s zoom controls to adjust 

camera changes position.

ºOn the right plane, click the control 
handle that extends out in front of the 

Drag the camera position control handle to 
move the camera to a new position.

Lesso
from
Now th
you ca
use to 

To swi

1Cho
Prop

pale
ose Camera 2 from the Camera 
-up.

 Camera Properties palette to switch 
n cameras.
When you release the mouse button, the 
zoom value in the Properties palette 
should read about 45.

9Drag the control handle that extends 
from behind the camera to front of the 
workspace. 

the zoom level. camera and drag it over the center of the 
scene.

The camera is now pointing at the center 
of the scene.

Drag the viewpoint control out to the object 

2Cho
pop

Use the
betwee
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ion a camera manually:

e Windows menu> Camera 

rties. The Camera Properties 
e appears.

e Cameras menu> Camera 
. 

e Position menu> Reference. 

the Shell object in the Perspective 
w.

e the Dolly tool from the toolbar.
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The view of the scene changes.

When you change the camera in the Camera 
Properties palette the view of your scene 
changes.

Lesson 3: Positioning Cameras
There are several ways of positioning 
cameras in Ray Dream Studio besides using 
the Direct Manipulation controls. You can 
send the camera to a specific position 
using the transform commands, or using 
the Camera Dolly, Camera Pan, or Camera 
Track tools.

To numerically position a camera:

1Select Camera Set in the Time Line 
window.

2Choose Properties palette: 
Transform tab. If the Properties 
palette is not visible, choose Windows 

To posit

1Choos
Prope

palett

2Choos
Tutor

3Choos

4Click 
windo

5Choos
olly tool to interactively adjust the 
 of the camera.
3Choose Reference from the Position 
pop-up. The view changes to the 
Reference view for Camera 2.

4Choose Camera 1 from the Camera 
pop-up. The view changes to the 
Reference view from the default camera.

You can use the Camera Properties 
palette to switch between different 
cameras and to save your most 
commonly used positions. For more on 
cameras, refer to “Setting up Cameras” 
on page 72.

Now that you’ve added some cameras you 

menu> Properties.

3In the Position Controls enter X=23, Y=50 
and Z=40.

4Click Apply.

The camera moves to a new position.

You can also use the camera tools to 

Use the Position controls in the Properties 
palette to numerically position cameras.

Use the D
position
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need to position them to get the best views 
of your scene.

position your cameras.



The production frame appears and the 2Choose View menu> Production “Using the Browser Palette” on page 28 for 
tions on saving to the Browser 
.

eam Studio comes with a number of 
 cameras which can be accessed 
h the Scene Wizard. The Scene 
 will set up cameras and lighting 
on your answers to a few questions. 
re information, refer to “Using the 

Wizard” on page 27.

xt section of the tutorial will lead 
rough the process of animating the 
s in your scene.

ating Objects
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pointer changes to a camera. The 
production frame defines the area of 
your scene that appears in the final 
artwork when you render the scene.

Frame. A green frame appears around 
your scene.

3Shift-drag one of the points on the 
production frame towards the center. 
The frame shrinks proportionately. 

If you drag a point without holding down 
the Shift key, a dialog appears warning 
you that you’re about to change the 
frame’s aspect ratio.

To move the production frame:

Click the production frame and drag it to a 
new location.

instruc
palette

Ray Dr
preset
throug
Wizard
based 
For mo
Scene 

The ne
you th
object

Anim
eam Studio uses a process known as 
me animation to animate objects. In 
ocess, each point in time where an 
 begins, ends or changes is know as a 
me. All the frames in between the 
mes, or action, are filled in Ray 
 Studio. 

mple, if you wanted to animate a 
ing ball, you would set up a key 
showing the ball in its starting 
n, a frame showing it bouncing off 
und and a frame showing its final 
n. When the animation is rendered, 
eam Studio creates all the frames in 
n, showing the ball moving towards 
6Drag the pointer down and to the left. 
The view of the scene rotates around the 
selected object. 

You can also use the other Camera tools to 
adjust the position. The production frame 
for each camera can also be adjusted 
separately. 

To adjust the Production Frame:

1Select the Camera Tutor camera in the 

The production frame defines the area of 
your scene that is used to produce a rendered 
image or animation.

Your camera setup is now complete. Using 
the cameras you set up in this lesson you 
can produce a number of different 3D 
illustrations using the same scene. If you 
want to see how your scene will look 
rendered from a particular angle, drag the 
Render Preview tool over the scene.

Moving On

The cameras you created in this section 
can be used in a wide variety of scenes. If 
you like the custom camera you created, 

Use the Render Preview tool to see how your 
scene will look when it’s rendered.

Ray Dr
key fra
this pr
action
key fra
key fra
Dream

For exa
bounc
frame 
positio
the gro
positio
Ray Dr
betwee
or and then away from the floor.
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Perspective window.
save it in the Browser palette. Refer to 

the flo



imation will now last for three 
. 

u’re animating, you’ll probably 
quickly move between frames. Ray 
tudio’s Time Controller tools let 
p from the beginning of an 
n, to the end, or anywhere in 
.

lay the Time Controller:

e View menu> Toolbars. The 
ars dialog appears.

e Time Controller. A toolbar is 
 when a checkmark appears next 

me.
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The lessons in this section will show you 
how to create key frames and apply 
Tweeners and Behaviors to them to create 
simple animations.

The Story So Far

In this tutorial you’ve learned how to 
create, arrange, and light objects and how 
to add cameras. In the next section you’ll 
learn how to animate objects. Before you 
can animate an object you should know 
how to create one. For more information on 
modeling, refer to “Free Form Modeling” on 
page 109 and “Mesh Form Modeling” on 
page 137. Key frame animation relies 
heavily on changes in position and angle so 
it’s essential that you also understand how 

2Choose Browser palette: Objects tab.

3Choose Browser palette: File menu> 
Add Directory/Folder. 

4Locate the folder Tutorial: Animating 
Objects and choose Select Current 
Directory.

The first step in any animation is to set the 
its time limit.

To set animation time limit:

1Make sure the Time Line window is 
visible. If it’s not, choose Windows 

menu> Time Line of Animate 

Your an
seconds

When yo
need to 
Dream S
you jum
animatio
between

To disp

1Choos
Toolb

2Enabl
visible
its na
 1: Creating Key Frames
ame animation you need to create a 
e anywhere you want action to 
p or change. In this lesson you’ll 

ing a simple animation with only 
on so you’ll only need to create two 
es one to tell Ray Dream Studio 

ou want the action to begin and 
 to define where you want the 

e Controller toolbar contains all the 
’ll need to preview your animation 
rspective window.
to position objects. For more information, 
refer to “Arranging Objects in the Scene” on 
page 39 or “Arranging Objects” on 
page 223.

What You’ll Need

In order to animate objects, you’ll need a 
few sample objects. Since animation takes 
up a large amount of memory, it is 
recommended that you use only a few 
objects in you scene.The file ANIMATE 
TUTOR in the Tutorial folder on the CD-
ROM has been designed especially for this 
animation section.

To begin animating objects:

Tutor.

2Click the Time Axis at 00:02:00 and drag 
it to 00:03:00.

The Time Line window displays all the key 
event markers in the animation and its 
current length.

Lesson
In key fr
key fram
start, sto
be creat
one acti
key fram
where y
another

The Tim
tools you
in the Pe
Chapter 5 • Tutorial 77

 stop.

1Open the file Tutorial:Animating 

Objects: ANIMATE TUTOR on the Ray 
Dream Studio CD-ROM.

Drag the end of the Time Axis to 00:03:00 to 
extend the length of your animation.

action to



2Click the Last Frame button on the Time 7Click the First Frame button.

 the Perspective window to make it 
ctive window.

 the Interactivity button. This 
on should be active whenever you 
iew animations in the Perspective 
ow.

k the Play button to preview your 
ation.

he Interactivity button is active you 
 your objects moving between key 

.
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To create a key frame:

1Make sure you’re at the first frame of 
your animation. If you’re not, click the 
First Frame button.

By default, Ray Dream Studio creates key 
frames for all the objects in the scene at 
the start of the time line. So, you already 
have the starting key frame of your 
animation. All you have to do now is 
create a key frame for the end of the 

Click the First Frame button to jump to the 
first frame in your animation.

Controller.

The Current Time indicator jumps to the 
end of the animation.

3Click the Angel Fish object in the Time 
Line window.

4Click Command-T/Ctrl+T to display the 
Object Properties palette.

5Click the Transform tab.

Click the Last Frame button to jump to the 
last frame in your animation.

8Click
the a

9Click
butt
prev
wind

ºClic
anim

When t
can see
frames
fish appear to move towards the 
l. 

n 2: Applying Tweeners
animation you created in Lesson 1 
obably noticed how quickly the fish 
ched the shell. In reality, the fish 
probably slow down as it gets closer 
shell. This type of behavior can be 
lled using Tweeners. A tweener lets 
ntrol how Ray Dream Studio fills in 
nsitions between key frames.

e Play button to run your animation.
animation.

By default Ray Dream Studio creates the first 

6Enter the Position values X=34, Y= -16, 
Z=20 and Yaw= 45, Pitch= -5 and Roll= -5 
click Apply.

The 
shel

Lesso
In the 
you pr
approa
would 
to the 
contro
you co
the tra

Click th
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key frame in your animation when you open 
a scene.

When you adjust the position of objects, Ray 
Dream Studio creates a new key frame.



sson you’ll apply a special set of 
rs called physically-based 
rs.

lly-based behaviors let you set up a 
on of real world physical action like 
r velocity. 

p a simulation you must first define 
bjects are to be included in the 
on and then apply some kind of 
 move those objects. 

ple, to simulate a collision, you 
reate two physical objects, then 
rectional force to one of them. 
ndered, one object would appear 
 into another and then rebound 
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If you apply a Bézier tweener to the Angel 
fish, the fish will slow down as it 
approaches the shell.

To apply a Tweener:

1In the Time Line window, double-click 
the time track between the first and last 
key frames for the Angel Fish object. 

The tweener icon appears in the space 
between frames when you apply a tweener to 
your animation.

The Bézier tweener lets you control the 
acceleration of an object and its 
trajectory. For more on tweeners, refer 
to “Using Tweeners” on page 309.

3Set the Ease-in /out values to 40% and 
40%. 

These values control the speed of the 
object.

4Set the Tighten-in /out values to 50% and 
50%.

These values control the trajectory of 
the object.

5Click the First Frame button then click 

In this le
behavio
behavio

Physica
simulati
gravity o

To set u
which o
simulati
force to

For exam
would c
apply di
When re
to crash
off it.
sson you’ll apply the Flow Force 
r to a school of fish and then watch 
swim away in every direction
The Transition Options dialog appears

2Choose Bézier from the pop-up.

Play to preview the new animation.

The fish now appears to slow down as it 
approaches the Conch shell. If you’re 
happy with this animation, save it to a 
convenient location.

Lesson 3: Applying Behaviors
Using a combination of key frames and 
tweeners you can create some very 
realistic looking animations. However, by 
applying Behaviors to objects you can 
create realistic animations that would be 
very complicated to create using only key 
frames.

A behavior gives an object a specific set of 

In this le
behavio
as they 
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Use the Transitions Options dialog to select a 
Tweener type and set its attributes.

instructions that determine or modify their 
actions during an animation.



4Click the Behaviors tab. If the tab is not 6Select Apply Physical Effects and 
 OK.

ou select a behavior from the 
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To apply physically-based behaviors:

1Drag the Mesh Form Fish object out of 
the Browser palette and into the 
Perspective window. 

This is what the Mesh Form Fish looks like in 
the Perspective window

visible, click the arrow buttons to scroll 
the tabs.

5Click the Add button. The Add dialog 
appears.

Use the scroll buttons to view Properties tabs 
that are not visible. 

click

When y
ly Physical Effects is the base 
vior for all physical simulation. you 

t apply this behavior to any object 
want to be included in the 
lation. 

e the behavior is applied, the other 
cts in the simulation will interact 
 it as if it were a real object.

le the Movable by impact checkbox.

 the Add button again.

ties palette’s Behaviors tab, controls 
t behavior are displayed.
2Choose Windows menu> Properties. 

The Properties palette appears.

3Enable the Auto checkbox.

When Auto is enabled, any change you 
make to the behavior’s values are 
automatically applied to the object.

Use the Add button to display a list of 
available behaviors.

App
beha
mus
you 
simu

Onc
obje
with

7Enab

8Click

Proper
for tha
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 Time Line window, drag the end of 
imation in the Time Axis from 
00 to 00:10:00.

the First Frame button and then 
lay. Make sure the Interactivity 

n is enabled.

ool of fish appears to break apart 
 away in all directions. 

ot happy with the speed of the 
ou can use the techniques you 
in the previous lesson to apply 
rs to the fish.

t an animation you’re satisfied 
e it to a convenient location.
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9Choose Flow Force from the list and click 
OK. The Flow Force controls are added 
to the Behaviors tab.

Flow Force simulates the force of water 
currents on an object.

ºSet the Turn Density to 70%.

¡Enable the Rotate with flow checkbox.

The behavior setup is now complete. If you 
ran the simulation at this point the little 
fish would appear to swim through the 
scene towards the camera. However, you 
can create a much more interesting effect 
by creating an entire school of fish.

4Continue duplicating and repositioning 
the fish until you have enough to look 
like a school.

As you duplicate fish, each duplicate will 

2In the
the an
00:03:

3Click 
click P
butto

The sch
an swim

If your n
action, y
learned 
Tweene

If you ge
with, sav
 On

ations you created in this section 
the beginning. Try experimenting 
erent objects to create key frames 
 different tweener settings.

sically-based behaviors you added 
ction are one example of the kinds 

ations you can create. These new 
rs open up a whole new world of 
ities in animation. Experimenting 
erent simulations can produce 
tounding results. For a full 
ions of the Behaviors available in 
am Studio, refer to “Behaviors” on 
.

To duplicate objects:

1Select the School Fish in the Perspective 
window and press Command-D/Ctrl+D. 

2Drag School Fish up and to the left.

3Press Command-D/Ctrl+D again. A new 
fish appears.

You may need to move the fish around to 
get the right positions for the school.

In order to see the full affect of the 
behaviors in your scene, you’ll need to 
activate Interactivity and extend the time 
limit of the animation.

To preview behaviors:

1Click the Interactivity button.

have the same behaviors applied to it.

When the Interactivity button is active you 
can see your objects move during the 
animation.

Moving

The anim
are just 
with diff
or apply

The Phy
in this se
of simul
behavio
possibil
with diff
some as
descript
Ray Dre
page 314
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t section of the tutorial will lead 
ugh the process of animating 

by altering their shape.
The nex
you thro
objects 



Animating Shapes
in animating shapes:

e sure the Browser palette is visible. 
 not, choose Windows menu> 

ser.

 the Objects tab.

ose Browser palette: File menu> 
 Directory/Folder. 

te the folder Tutorial: Animating 
es and click Select Current 
ctory.

n 1: Animating the 
sion Path
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In Ray Dream Studio there are several ways 
of animating objects. The previous section 
showed you how to animate objects by 
changing their position. You can also 
animate objects by altering their shape 
using either the Free Form or Mesh Form 
modelers or by applying a Deformer.

In this section you’ll alter the shape of 
several objects across several key frames 
to produce moving objects.

The Story So Far

In this tutorial you’ve learned how to 
create, arrange, light and animate objects 

To beg

1Mak
If it’s
Brow

2Click

3Cho
Add

4Loca
Shap
Dire

Lesso
Extru
n animate the shape of a Free Form 
 by altering the shape of its sweep 
 different key frames.

mate an object using the sweep 

 the Seaweed object from the 
ser palette into the Perspective 
ow.

 the Last Frame button.

e Last Frame button to jump to the 
me in your animation.
When you play the animation, Ray Dream 
Studio plays the physically-based simulation.

in a scene. Since you’ll be using the object 
modelers and deformers to alter object 
shapes in this section it is essential that 
you understand the concepts involved in 
modeling objects. It would be a good idea 
to review the “Modeling Objects” on 
page 47 before beginning this section.

What You’ll Need

This section of the tutorial deals with 
altering object shapes so you’ll need some 
shapes to start with. If you’ve been 
following the tutorial, you can use the 
objects you created in the Modeling 
Objects section, or you can use the 
Animating Shapes folder in the Browser 
palette. This folder contains the models 

You ca
object
path in

To ani
path:

1Drag
Brow
wind

2Click

Click th
last fra
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used as examples in this section. 



the fourth point and repeat step 7.

ep path should look like this after 
sition the third point.
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3Double-click the seaweed in the 
Perspective window to open the Free 
Form modeler.

4Select the Zoom tool and zoom in on the 
sweep path on the ground plane.

Make sure that you’re not selecting a 
point on the extrusion envelope (blue 
lines).

8Click 

Your swe
you repo
u’re done repositioning the fourth 
ur sweep path should look like the 
n.
5Choose the Selection tool.

6Click the second point on the sweep path 
and drag it to the right as shown. 

The sweep path looks like this at the 
beginning of your animation.

7Click the third point and drag it to the 
opposite side of the sweep path.

This is what you sweep path should look like 
after you reposition the second point.

When yo
point, yo
one show
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e View menu> Preset 
ion> Left.
9Choos
Posit



ºZoom in on the horizontal sweep path. £Click the fourth point and drag it up.

ly the Oscillate tweener:

ble-click between the first and last 
e of the Seaweed object in the 

eLine window. The Transition 
ons dialog appears.

ose Oscillate from the Tweener 

-click the space between frames to 
 the Transition Options dialog.
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¡Click on the second point on the sweep 
path and drag it up.

This is what you sweep path should look like 
after you reposition the second point.

When you play this animation the 
seaweed will appear to sway, but the 
motion will be somewhat stiff. To smooth 

When you’re done repositioning the fourth 
point, your sweep path should look like this.

To app

1Dou
fram
Tim
Opti

2Cho

Double
display
-up.

ntrols available in the Transition 
s dialog change depending on the 
™Click the third point and drag it down.

Your sweep path should look like this after 
you reposition the third point.

out the motion, you can apply the 
Oscillate tweener.

pop

The co
Option
r you select.
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tweene



ate an object by repositioning its 
:

sure the Objects tab is selected on 
owser palette, and drag the Mesh 
Fish from the Browser palette to 
rspective window.

the First Frame button. If the 
n is not available, you’re already on 
st frame. 

 First Frame button to jump to the 
e of your animation.
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3Set the Nbr Oscillation slider to 2 and 
click OK.

4Click the First Frame button on the Time 
Controller.

If the Time Controller is not displayed, 
choose View menu> Toolbars and 
then enable Time Controller.

5Click Play.

Click the First Frame button to jump to the 
first frame in your animation.

The seaweed appears to sway in the 
current. To anim

vertices

1Make 
the Br
Form 
the Pe

2Click 
butto
the fir

Click the
first fram
e-click the fish to open the Mesh 
modeler.

e the Zoom tool.

oom tool to enlarge an area of your 
If you’re satisfied with this animation, save 
it to a folder on your hard drive.

Lesson 2: Animating the Mesh 
Form Modeler
You can animate an object’s shape in the 
Mesh Form modeler the same way you 
would in the Free From modeler, by 

When you run your animation, the seaweed 
will appear to sway.

3Doubl
Form 

4Choos

Use the Z
scene.
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altering the object’s shape over several key 
frames.



5Zoom in on the fish’s tail. ºEnable Spiky.

the Radius of Sphere to 30.

k the center point of the three 
cted points and drag it to the left.
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6Choose the Marquee tool.

Use the Zoom tool to zoom in on the back 
end of the Mesh Form Fish’s tail

8Choose the Sphere of Attraction tool. 

9Choose Windows menu> Properties 

Use the Marquee tool to select the points 
shown.

¡Set 

™Clic
sele
k the Last Frame button.

the center point in the tail and drag it 
eft.
7Select the rear of the tail.

Use the Marquee tool to select a group of 
vertices.

and then click the Tool Options tab in the 
Properties palette.

Use the Sphere of Attraction tool options to 

£Clic

Select 
to the l
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set the tool’s size and shape attributes.



 3: Animating Deformers
rs you applied to objects to alter 
pe can also be animated. By 

g the parameters of the Deformer 
ent key frames, you can have the 
appear to change over time. In this 
ou’ll learn another way of making 
 swim--by animating the Wave 
r.

ate a deformer:

sure you’re on the first key frame 
r animation. If you’re not sure, 
he First Frame button on the Time 
oller.
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¢Drag the center point to the right.

Select the same center point again and drag 
it to the right

¶Click the First Frame button on the Time 
Controller and then click Play.

If the Time Controller is not displayed, 
choose View menu> Toolbars and 
then enable Time Controller.

Your fish now appears to swim. To 
create a school of fish, duplicate the 
Mesh Form Fish object.

Click the First Frame button to jump to the 
first frame of your animation.

Lesson
Deforme
their sha
adjustin
in differ
objects 
lesson y
your fish
deforme

To anim

1Make 
of you
click t
Contr
utton is grayed out, you’re already 
 first frame.

he Mesh Form Fish object from the 
er palette into the Perspective 
w. 

e Windows menu> Properties. 
roperties palette appears.

the Deformer tab. 

 First Frame button to jump to the 
e of your animation.
When you play this animation the tail of 
your fish will appear to swing from left to 
right. However, the movement will 
appear somewhat rigid. To smooth out 
the motion you can apply an Oscillate 
tweener. 

∞In the Time Line window, double-click 
the time line between the first and last 
frames of the Mesh Form Fish and apply 
the Oscillate tweener.

For more detailed instructions on 
applying the Oscillate tweener, refer to 
“To apply the Oscillate tweener:” on 
page 84. 

If you’re happy with the animation as it is, 
save it to your hard drive.

When you run the animation, the fish’s tail 
appears to move from left to right.

If the b
on the

2Drag t
Brows
windo

3Choos
The P

4Click 

Click the
first fram
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§Click Done.



The Wave deformer controls appear. If 9Click the First Frame button and then 

 the First Frame button and then 
 Play to preview your animation.

hool of fish appears to swim.

ou duplicate the fish, each duplicate 
ve the Deformer applied to it. 
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you want to learn how the Wave 
deformer was applied to the object refer 
to “Lesson 4: Deformers” on page 60.

click Play to preview you animation. 
Make sure the Interactivity button is 
enabled.

The little fish appear to swim. You can 
now duplicate the fish to create a school 
of swimming fish.

To duplicate the deformed fish:

1Click the First Frame button.

2Click the Mesh Form Fish in the 
Perspective window.

3Press Command-D/Ctrl+D to duplicate 

7Click
click

The sc

When y
will ha
ou run the animation the fish appear 
e swimming in the same direction.
5Enable the Auto checkbox.

6Make sure the Phase slider is set to 0%

7Click the Last Frame button. The current 
time indicator jumps to the last key 
frame.

Use the Wave deformer controls to control 
the phase and shape of the wave applied to 
your object.

Click the Last Frame button to jump to the 
last frame of your animation.

the fish. 

4Drag the Mesh Form Fish up and to the 
left.

5Click the duplicate fish and press 
Command-D/Ctrl+D again.

6Continue moving and duplicating fish 
until you have a good sized school.

When y
to all b
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8Set the Phase slider to 100%



 animating effects:

e the Tutorial: Animating Effects 
 and open the file ROTOSCOPING 
RIAL.

e Browser palette: Shaders 

e Browser palette: File 
> Add Directory/Folder.

e the folder Tutorial: Animating 
s and click Select Current 
tory.

 1: Rotoscoping

CH05.rds5  Page 89  Wednesday, July 2, 1997  2:46 PM
Moving On

The techniques you just learned can be 
combined with tweeners to fine tune the 
animation. 

You may want to try these animation 
techniques with some of the more complex 
objects in the Browser palette. You’ll 
quickly find out how easy it is to create 
some very complex effects by just 
adjusting a few parameters.

The techniques you learned in this tutorial 
are just a few of the ways you can use the 
modelers in animations. For more 
information, refer to “Free Form Modeler” 
on page 328 and “Mesh Form Modeler” on 
page 329.

Animating Effects

After you’ve created the main action of 
your animation you may feel that 
something is still missing. Perhaps your 
environment needs a little added realism, 
or do you want your object to change 
color? Using key frame animation, you can 
animate almost any object parameter to 
create subtle effects to enhance your 
animations. 

In this section you’ll learn how to add 
Rotoscoping to your animations and how 
to animate Shader settings.

The Story So Far

To begin

1Locat
folder
TUTO

2Choos
tab.

3Choos
menu

4Locat
Effect
Direc

Lesson

ping lets you add a movie to your 
n. You can use movies as animated 
 on your objects or apply them to 
 gels. 

y rotoscoping to a light:

the Key Light in the Time Line 
w to select it.

the First Frame button to move to 
st key frame in your animation.

ssary choose Windows menu> 

rties to display the light’s 
rties.
The next section of the tutorial will show 
you how to add special effects to your 
animations.

You’ve learned how to create, shade, light 
and animate objects. In this lesson you’ll be 
animating Shaders and adding Rotoscoping 
to lights, so you should be familiar with 
shading and lighting concepts. You may 
want to review “Shading Objects” on 
page 62 and “Setting up Lights” on page 67, 
or refer to “Applying Shaders” on page 181 
and “Setting Lights & Cameras” on page 269 
for a detailed explanation of these 
concepts.

What You’ll Need

To create the effects shown in this section, 
you’ll need some lights and a shader. The 
file ANI_EFF has all the models and lights 
you’ll ned to complete the lessons in this 

Rotosco
animatio
textures
lights as

To appl

1Click 
windo

2Click 
the fir

3If nece
Prope

prope
Chapter 5 • Tutorial 89

the Gel tab.
section. 4Click 



5Enable the Auto button. 9In the Time Line window drag the key 

view a rendered animation:

e Render menu> Best 
tion Preview.

cene now has a realistic underwater 
 it.
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6Choose Movie from the Gels pop-up.

Use the Movie controls in Properties palette 
to load a movie as a gel.

frame indicator from 00:01:46 to 
00:02:00.

ºIn the Properties palette, enable Tile.

You can use the Movie controls to play the 
movie you loaded. 

To pre

Choos
Anima

Your s
look to
n 2: Animating Shaders
usting shader parameters, you can 
e a change in color, or texture on the 
 of objects.

mate a shader:

 the First Frame button to move to 

ou render your animation in Best 
tion Preview you’ll be able to see the 
of the movie as a gel.
7Click the disk icon.

8Use the dialog to locate the file 
Tutorial:Animation:Effects:H20.MOV or 
H20.AVI and click Open.

When you add the movie, Ray Dream 
Studio automatically creates a key frame 
at the end point of the movie’s. Since the 
movie is only 1.46 seconds long, a new 
key frame appears at 1.46 in the time line.

¡Move the Horizontal slider to 3 times.

To view the rotoscoping effect you need 
to preview the rendered animation.

Use the Tile Controls to tile the movie 
3 times.

Lesso
By adj
animat
surface

To ani

1Click

When y
Anima
effects 
eginning of your animation.
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chool of fish will appear to change 
ilvery red to silvery green.
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2Drag the Shaded Fish from the Browser 
palette to the Perspective window.

3Choose the Eyedropper tool.

4Click the Shaded Fish in the Perspective 
window. The Current Shader Editor 
appears.

7Click the Color palette button.

8Select a green color, then click OK.

9Double-click the right color chip, then 
click the Color palette button.

ºChoose a light gray color, then click OK.

¡Click Apply.

™Choose Render menu> Best 
Animation Preview. to create a 

Click the Color palette button to display your 
system’s color picker.

The s
from s
 On

ation effects you learned in this 
are only two of the many types of 
ou can add to your animation. By 
g the properties of objects across 
 key frames you can create a wide 
f effects. For example, you could 

n object’s size across key frames 
object would appear to grow. For 
tails on creating animation effects, 
Chapter 15, “Animating.”

t section of the tutorial will show 
fundamentals of rendering your 

u play the preview of your 
n you can see the shader change 

er time.
5Click the Last Frame button to move to 
the end of your animation.

6In the Current Shader Editor, double-
click the left color chip.

When you click the fish with the Eyedropper 
tool, its shader appears in the Current Shader 
Editor.

preview of your animation.

Moving

The anim
section 
effects y
changin
different
variety o
adjust a
and the 
more de
refer to 

The nex
you the 

When yo
animatio
color ov
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Rendering tutorial from the beginning, you’ll need the In this lesson you’ll be using the RDI Ray 
 since it’s one of the renderers that 
 reflections and refractions.

ose a renderer:

ose Render menu> Current 
e Settings. The Scene Settings 

tte appears.
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Rendering is the process of creating a two-
dimensional image or movie from a three-
dimensional scene. The settings you 
choose for your rendering can have a large 
impact on the final appearance of your 
image. Ray Dream Studio offers you several 
different types of renders that you can use 
to achieve different effects. For detailed 
information on the different types of 
renderers available, refer to “Renderers” 
on page 342.

The lessons in this section will teach you 
how to set up a rendering session for an 
image and for an animation. 

scene you arranged in “Arranging Objects 
in the Scene” on page 39, the lighting setup 
from “Setting up Lights” on page 67, and 
the camera setup from “Setting up 
Cameras” on page 72.

If you’ve skipped ahead to this section you 
can complete the lessons using the preset 
files provided.

To open preset files for the rendering 
lessons:

1Locate the folder Tutorial: Rendering 
and open the file RENDERING 
TUTORIAL.

Tracer
handle

To cho

1Cho
Scen

pale
 the Renderer tab.

ose RDI Ray Tracer from the pop-up.

e sure that all the rendering options 
nabled. 

u want to speed up the rendering, 
ble the options you won’t be using in 
 scene. For example, since there are 

ransparent objects in your scene, 
can disable the Light through 
sparency option.

 Render Settings dialog to choose a 
er and set its attributes.
The Story so Far

The previous sections have shown you 
how to create and arrange objects, how to 
set up lights and camera, how to animate 
objects and now finally you will learn how 
to turn your scene into an image or an 
animation. Before you begin this section 
you should understand how to set up a 
scene using the arranging features as well 
as understanding how to set up cameras 
and the production frame. You may want to 
review “Setting up Cameras” on page 72 or 
“Setting Lights & Cameras” on page 269.

What You’ll Need

The materials you need for this section 

2Choose Browser palette: Cameras 
tab and add the folder Tutorial: Setting 
Up Cameras.

3Choose Browser palette: Lights tab 
and add the folder Tutorial: Setting Up 
Lights.

4Drag the objects Camera Tutor and Light 
Tutor from the Browser to the 
Perspective window.

Lesson 1: Rendering an Image
The first thing you need to do to set up a 
rendering is to choose a renderer. A 
renderer converts your scene into a bitmap 
or movie. 

2Click

3Cho

4Mak
are e

If yo
disa
your
no t
you 
tran

Use the
render
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depend on how you’ve been using this 
tutorial. If you have been following the 



the plus/arrow icon next to 
ra. The Camera options appear.

e Render Camera from the 
ring Camera pop-up.

the File Format plus/arrow icon. 
ormat options appear.

amera options to select a camera to 
our rendering.
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After you’ve selected a renderer, you 
need to set the atmosphere for your 
scene. 

To set the atmosphere:

1Choose Scene Settings palette: 
Effects tab.

2Choose Distance Fog from the 
Atmosphere pop-up.

Distance Fog makes objects appear to 
fade the further they move away from 
the camera.

3Click the plus/arrow icon next to the 

5Choose a light blue color and then 
click OK.

6Enter Fog starts= 120

7Enter Visibility = 300

The Distance Fog will add realistic depth to 
your image. If you want to add a more 
detailed realism, you can add a background 
to the scene. Now that your scene has an 
environment, you can set the output file 
options.

To set Output options:

1Choose Scene Settings palette: 

5Click 
Came

6Choos
Rende

7Click 
The F

Use the C
use for y
e BMP (RD) from the pop-up.

the Save button to save your 
ring setup.

dering setup is now complete. 
 can use these saved settings to 
our scene.

 a rendering:

ile Format options to set the output 
r your rendered image.
Atmosphere title to display its controls.

The Distance Fog controls appear.

4Double-click the Fog Color chip.

Use the Plus icon to display more controls.

The Distance Fog controls let you set the 
color and range of the fog.

Output File tab.

2Click the plus/arrow icon next to Image 
Size. The Image size options appear.

Use the Image Size options to set the height, 
width and resolution of your rendered image.

8Choos

9Click 
rende

Your ren
Now you
render y

To start

Use the F
format fo
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Render menu> Use Current 

.

3Set Width=300 and Height=400.

4Set the Resolution to 72 dpi.

Choose 
Settings



Ray Dream Studio starts rendering your 5Expand the Atmosphere controls by When the rendering is complete you can 
 the file for use in other applications. 

g On

ndering settings you choose can 
 large affect on the final artwork you 
e. You should make sure that you’re 
he best settings for your scene. If 
d that the rendering is taking too 
u or you run out of memory you 

ant to reduce the complexity of your 
 One area you should watch out for 
ction and refraction. These effects 
long time to render and require a 
eal of memory. If you’re having 
y problems you may want to use 
ect sparingly.
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image. Depending on the complexity of 
your image, rendering can be a time 
consuming process, so it’s a good idea to 
only render when you’re happy with your 
scene.

The rendering options you just set can be 
used in any number of rendering sessions. 
So you can adjust the cameras and lights in 
your scene and then render multiple views 
of your scene using the same settings.

Lesson 2: Rendering an 
Animation
The only difference between rendering a 
movie and an image is the file output type. 
Instead of selecting an image format as the 

clicking the plus/arrow icon.

6Click the Fog Color chip and choose a 
blue color.

7Enter Fog starts=300, Visibility=200.

8Click the Output tab.

9Choose QuickTime/AVI from the pop-up.

ºSet the frame rate to 6fps (frames per 
second).

Leave the time limits as they are. By 
default the time limits in the Scene 
Settings palette are the same as those 

save

Movin

The re
have a
produc
using t
you fin
long yo
may w
image.
is refle
take a 
great d
memor
this eff
mplete descriptions of how to 
 the right renderer for your image, 
 Chapter 17, “Rendering.”

ping Up
at you’ve completed the tutorial you 
 asking yourself where do I go from 
ell the best way to learn Ray Dream 

 is to experiment. The techniques 
d in this tutorial are only the 
ing. You can apply the skills you’ve 
d to any project you have in mind. 

ant to learn more about modeling, 
ome of the models in the Browser 
 and see how they were made. Even 

most complex models you’ll be able 
output format, you select an animation 
format.

To render a movie:

1Choose Render menu> Current 
Scene Settings.

2Click the Renderer tab and choose a 
renderer from the pop-up. 

If you’re creating a preview of your 
animation, choose Draft Z-Buffer, 
otherwise choose RDI Raytracer.

3Click the Effects tab.

shown in the Time Line window.

¡Click Save to save your settings.

™Choose Render menu> Use Current 
Settings. The rendering preview window 
appears.

For co
choose
refer to

Wrap
Now th
may be
here? W
Studio
outline
beginn
learne

If you w
open s
palette
in the 
the basic techniques described in 
torial. Another great modeling 
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4Choose Distance Fog from the 
Atmosphere pop-up.

Ray Dream Studio displays a preview 
window as it renders your animation.

to see 
this tu
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resource is the Modeling Wizard. The 
Modeling Wizard is a picture-based 
assistant that guides you through the 
process of creating many types of objects, 
teaching you valuable modeling principles 
along the way. For instructions on 
accessing the Modeling Wizard, refer to 
“Free Form Modeling” on page 109.

If you want to learn more about arranging 
scenes, try using the Scene Wizard. This 
wizard leads you through the process of 
setting up lights and backgrounds. Refer to 
“Using the Scene Wizard” on page 27.

Some of the files you created in this tutorial 
can be the basis for your own 3D 
illustration cookbook. The shader you 

want to brush up on a certain aspect of Ray 
Dream Studio, jump into the tutorial lesson 
that deals with the topics you want to 
review. 
created can be the start of your own 
Shader library. The Shell shader can be 
applied to other underwater creatures 
such as snails and hermit crabs. Trying 
saving the shader in a personal shader 
folder and then add more shaders as you 
create other objects.

The lighting setup you created can be used 
to light almost any scene effectively. It’s a 
great starting point for even the most 
complex lighting setups. The cameras you 
set up can also be used in other scenes. 

You’re now ready to explore Ray Dream 
Studio in more detail. The remaining 
chapters in this User Guide will explain in 
detail all the features and functions of Ray 
Chapter 5 • Tutorial 95
Dream Studio 5. Remember, you can use 
this tutorial as a reference source. If you 
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6

 

Creating Objects

 

Modeling vs. Primitives

 

There are two ways of creating objects in 
Ray Dream Studio. You can create objects 
by combining a number of basic 3D shapes, 

 

called 

 

primitives

 

, or you can model unique 
shapes using the Ray Dream Studio’s 

 

Free 
Form

 

 and 

 

Mesh Form

 

 modelers. The 
method you use will depend on the type of 
object you want to create. 

The first thing you need to do when 
creating an object, is decide how you’re 
going to build it in 3D space. The easiest 
way of doing this is to break the object 
down to it’s basic components. If those 
components turn out to be all geometric 
shapes, you use primitives to create it. If 
the object’s basic components are shapes 

’t be created using primitives, you 
 modelers. 
C

that can
use the



   

For example, when a sub is reduced to 

  

Following the same example, if you reduce 

         

page 109. The 

 

Mesh Form

 

 modeler is 
d in “Mesh Form Modeling” on 
37.

 

 are 3D Primitives?

 

ves are the most basic type of 3D 
 you can create in Ray Dream Studio. 

are two types of 3D primitives: 

 

tric

 

 and 

 

Environmental

 

. Geometric 
ves are 3D geometric shapes such as 
 squares or cylinders. Environmental 
ves are primitive volumetric objects 
uds or fire.

 

ing Geometric Primitives

 

tric Primitive objects are the 
g blocks of 3D objects. When you 

 

basic components, you can see that it’s 
made up of cylinders, cones and cubes. 
Therefore you would use 3D primitives to 
create the object. 

A complex object...

a jellyfish to its basic components you’ll 
end up with objects that are not geometric 
shapes. In this case you’d have to use a 
modeler to create this object. 

A complex object...

covere
page 1

What
Primiti
object

There 
Geome
primiti
cones,
Primiti
like clo

Creat
Geome
buildin
 examine any complex 3D object 
otice that it can be reduced to 

 primitive geometric shapes. In fact, 
iest way of creating an object is by 

ning a number of primitives. 

les of geometric primitives.
...and the primitives used to make it.

This chapter covers the different types of 
primitives you can create using Ray Dream 
Studio, as well as introducing the Text and 
Formula modelers. The Free Form modeler 

...and the shapes used to make it.

closely
you’ll n
simple
the eas
combi

Examp
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is covered in “Free Form Modeling” on 



                                 

the fire object wider results in a 
ea of fire based on the parameters 

e set.

  

u must use either the Adaptive or 
cer renderer to render 

 

Cloud

 

, 

 

Fire

 

 

  

 primitives.

vironmental Primitive has its own 
ch are located on a pop-up tool.

 

in Primitive

  

ntain

 

 primitive is a particle 

              

nvironmental Primitive tools can be 
 from the same pop-up.
When you create a Geometric Primitive 
object, it simply appears in your scene 
where you can move and resize it as 
necessary. Each type of object you can 
create has its own tool. The Geometric 
Primitive tools are located on a single 
pop-up tool. 

To create a Geometric Primitive object: 

1Choose a Geometric Primitive tool from 
the toolbar.

All the Geometric Primitive tools can be 
accessed from a single pop-up.

Objects dropped into the Perspective window are 
placed on the active plane of the Working Box, at the 
point where you release the mouse. Objects dropped 
into the Time Line window are placed at the center 
of the Universe.

or

Choose Insert menu> type of object.

The object is created at a default size 
and placed in the center of the Universe.

Creating Environmental 

Making 
larger ar
you hav

Note: Yo
Ray Tra
and Fog

Each En
tool whi

Founta

The Fou

All the E
accessed
e you can use to create objects like 
or tornadoes. The Fountain’s 
s let you change the density of its 
 and rate of animation. 

te a Fountain object:

e the Fountain tool and drag it into 
rspective or Hierarchy window.

e Edit menu> Insert> Fountain.
2In the Perspective window, click a point 
in the Working Box to create an object of 
default size, or drag to create an object 
of a custom size.

or

Drag an object creation tool from the 
toolbar into the Time Line window to 
create an object of default size.

Primitives
Like Geometric Primitives, Environmental 
Primitives can be the building blocks of 
scenes. They can be used to quickly add an 
environment to any scene.

The Cloud, Fog and Fire primitives are 
volumetric. They behave slightly differently 
than other Ray Dream Studio objects when 
you change the size of the object. With 
other objects, changing the size causes the 
object itself to change scale. Changing the 
size of a volumetric object changes the size 
of the container of the object but the 
contents stay at the same scale. For 
example, a small cloud made larger results 
in a larger area of cloud, but the swirls 

primitiv
geysers 
attribute
particles

To crea

1Choos
the Pe

or 

Choos
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Ch

within the cloud stay the same size. A fire 
object made taller results in higher flames. 



   

2

 

Double-click the new object. The 

                

This slider controls the angle of the 

              

This slider controls the number of 
icles in your fountain.

  

st the value of the 

 

Particle Size

 

 
r.

 slider controls the size of the 
icles in your fountain.

  

ble or disable the 

 

Use particle life for 
ping

 

 check box.

 setting determines how the shader 
apped to the fountain primitive. 
n it’s enabled, the shader is mapped 
 the entire fountain, with the 
icles near the bottom of the fountain 
aring different from those nearer 

    
Fountain primitive controls appear.

3Adjust the value of the Completion of 
Fountain slider.

Use the Fountain primitive controls to set fog 
attributes.

spray from the fountain. When the slider 
is set to 0 degrees the spray goes straight 
up, at 180 degrees it goes out in a radius 
all the way around the fountain. 

The example above illustrates the Maximum 
Angle From Up control set at 0 and 180.

part

9Adju
slide

This
part

ºEna
map

This
is m
Whe
over
part
appe
op (depending on the shader 
ent). 

n its disabled, all the particles are 
ped individually, so they all appear 
tical.

 Primitive

oud primitive creates a three 
sional, or volumetric, cloud. You can 
s primitive to quickly add a sky to 
ene.

is no on-screen preview of the cloud 
 its bounding box that indicates the 
 size and location. You won’t be able 

the cloud until it’s rendered.
This slider controls the fountain’s 
animation. Set the slider to 0% at the 
beginning of the animation and 100% at 
the end.

4Adjust the value of the Start Speed 
slider.

This slider controls the force of the 
fountain. A low setting creates a fast 
spouting fountain while a high setting 
creates a slow spouting fountain.

5Adjust the value of the Maximum Angle 
From Up slider.

6Adjust the value of the Gravity slider.

This slider controls the amount of 
gravity applied to the fountain. When the 
setting is low, gravity has little effect on 
the fountain. When the setting is high, 
gravity pulls the particles down quickly.

7Adjust the value of the Maximum Swirl 
Angle slider.

This slider controls how much the 
particles rotate parallel to the ground 
plane as they fall. A low setting causes 
very little rotation while a high setting 
causes a particle to rotate a great 
distance as it falls.

the t
cont

Whe
map
iden

Cloud

The Cl
dimen
use thi
any sc

There 
except
cloud’s
to see 
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8Adjust the value of the Number of 
Particles slider.



                                             

ontainer determines the general 
 of the cloud

  

t the value of the 

 

Edge Falloff Size

 

 
.

lider controls the appearance of 
ges of the clouds. A low setting 

               

d primitive in Box and Sphere 
rs.
You can place objects inside the cloud or 
partially within the cloud. Cloud attributes 
can also be animated.

Note: Changing the size of the cloud by 
dragging a larger or smaller bounding box 
does not change the scale of the clouds. It 
only changes the area that is covered with 
clouds.

To create a Cloud object:

1Choose the Cloud tool and drag it into 
the Perspective or Hierarchy window.

or

4Adjust the value of the Quantity of 
Clouds slider.

This slider controls the number of 
clouds that are included in the bounding 
box.

5Adjust the value of the Cloud Size slider.

This slider controls the size of clouds 
that are included in the bounding box.

6Adjust the value of the Density slider.

This slider controls the density of 
clouds.A low setting creates almost 
transparent clouds while a high setting 
creates almost opaque clouds.

The c
shape

9Adjus
slider

This s
the ed

The clou
containe
s in a sudden change or little falloff 
a high setting results in gradual 
e or longer falloff. 

uffle button to shuffle between different 
erns with the same attributes. 

mitive

 primitive creates a three 
onal, or volumetric fog. The Fog 
e is best for creating distinct local 
 fog, while the fog available through 
osphere controls in the Scene 
 dialog are best for applying fog to 
Choose Edit menu> Insert> Cloud. 

2Double-click the new object. The Cloud 
primitive controls appear.

3Click the Color color chip and choose a 

Use the Cloud primitive controls to set cloud 
attributes.

7Adjust the value of the Density slider.

This slider controls the quality of the 
clouds as they are rendered. The higher 
the Quality, the longer the render time.

8Click the Container pop-up and choose a 
container for your cloud.

result
while 
chang

Use the Sh
cloud patt

Fog Pri

The Fog
dimensi
primitiv
areas of
the Atm
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le image.
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color for the cloud. the who



   

There is no on-screen preview of the fog 

              

2

 

Double-click the new object. The 

 

Fog

 

 

                  

The 

 

Density

 

 slider controls the amount 
ht that penetrates the fog.

  

st the value of the Quality slider.

 slider controls the quality of the fog 
 is rendered.

st the value of the Edge Falloff Size 
r.

 slider controls the appearance of 
dges of the fog. A low setting results 

sudden change or little falloff while a 
 setting results in gradual change or 
er falloff.

st the value of the Upward Speed 
except its bounding box that indicates the 
fog's size and location. You won’t be able to 
see the fog until it’s rendered.

You can place objects inside the fog or 
partially within the fog. You’ll probably 
want your fog object to be fairly large so 
you can place a portion of your scene 
inside it. Fog attributes can also be 
animated.

Note: Changing the size of the fog by 
dragging a larger or smaller bounding box 
does not change its scale. It only changes 
the area that it covers.

To create a Fog object:

primitive controls appear.

Use the Fog primitive controls to create fog.

of lig

7Adju

This
as it

8Adju
slide

This
the e
in a 
high
long

9Adju

r.

Upward Speed slider controls the 
 at which the fog rises during an 
ation. Use a higher setting for longer 
ations.

k the Container pop-up and choose a 
ainer for your fog.

container determines the general 
e of the fog

st the value of the Completion of 
ard Effect slider.
1Choose the Fog tool and drag it into the 
Perspective or Hierarchy window.

or 

Choose Edit menu> Insert> Fog.

3Click the Color color chip and choose a 
color for the fog.

4Adjust the value of the Patchiness slider.

This slider controls the regularity of the 
fog throughout the bounding box. A low 
setting creates a blanket of fog. A high 
setting creates patches of fog.

5Adjust the value of the Quantity of 
Patches slider.

This slider controls how many patches of 
fog are contained in the bounding box.

6Adjust the value of the Density slider.

slide

The 
rate
anim
anim

ºClic
cont

The 
shap

¡Adju
Upw
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e-click the new object. The Fire 
ive controls appear. 

ire primitive controls to create a 3D 
etric fire.
The Completion of Upward Effect slider 
controls the animation of the fog. Set this 
value to 0% at the start of your animation 
and 100% at the end.

™Adjust the value of the Swirls slider.

This slider controls how the fog swirls or 
rotates as it rises.

£Adjust the value of the Swirl Size slider.

The Swirl Size slider controls the size of 
the swirls.

¢Adjust the value of the Chaos slider.

This slider controls the uniformity of the 

Fire Primitive

The Fire primitive creates a three 
dimensional or volumetric fire. You use 
this primitive to set your scene on fire.

There is no on screen preview of the fire 
except its bounding box that indicates the 
fire's size and location. You won’t be able 
to see the fire until it’s rendered.

You can place objects inside the fire or 
partially within it. Fire attributes can also 
be animated.

Note: Changing the size of the fire by 
dragging a larger or smaller bounding box 
does not change its scale. It only changes 
the area that it covers.

2Doubl
primit

Use the F
or volum
the Tip Color color chip and 
e a color for the tips of the flame.

the Base Color color chip and 
e a color for the base of the flame.

t the value of the Quantity of 
s slider.

lider controls the quantity of 
s that appear in your Fire object.

t the value of the Pointiness of 
s slider.

ointiness slider controls the 
fog. A low setting creates uniform fog 
while a high settings create random fog. 

Use the Shuffle button to shuffle between different 
fog patterns with the same attributes. 

Use the Chaos slider to control the uniformity 
of the fog. This example uses the low (left) 
and high (right) settings.

To create a Fire object:

1Choose the Fire tool and drag it into the 
Perspective or Hierarchy window.

or 

Choose Edit menu> Insert> Fire.

3Click 
choos

4Click 
choos

5Adjus
Flame

This s
flame

6Adjus
Flame
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ntage of your Fire primitive that is 
 or tips of flames. A low setting 
Cha

perce
points



results in fewer, less tapered points The container determines the general Creating Infinite Planes
nite Plane is a flat primitive whose 
xtend out to infinity in all directions. 
pe of primitive is used to create a 
 for your scene such as a sky, ocean 
nd. 

ate an Infinite Plane:

he Infinite Plane tool and drag it into 
e Line or Perspective windows.

gh the plane appears finite in the 

 Infinite Plane tool to create an 
 plane.
while a high setting results in many more 
tapered points. 

7Adjust the value of the Detail slider.

This slider controls the degree of detail 
in the Fire primitive. 

8Adjust the value of the Density slider.

This slider controls the density of the 
fire. A low setting creates fire that is 
almost transparent. A high setting 
creates fire that is almost opaque.

9Adjust the value of the Quality slider.

shape of the fire.

™Adjust the value of the Completion of 
Burning Fire slider.

The container determines the shape of the 
fire. This example uses the Box and Sphere 
containers.

An Infi
sides e
This ty
surface
or grou

To cre

Click t
the Tim

Althou

Use the
Infinite
ctive window, it will extend out to 
 in the final rendering.

ng an Infinite Plane

shaders to an Infinite plane can be 
since the texture or color you apply 
tend out to infinity. This can be a 
ally tricky when using texture maps 
ients. The plane’s tiling controls can 
u adjust how shaders are tiled on 
ne.
This slider controls the detail of the fire 
as it is rendered.

ºAdjust the value of the Edge Falloff Size 
slider.

This slider controls the appearance of 
the edges of the fire. A low setting results 
in a sudden change or little fall off. A high 
setting results in gradual change or 
longer fall-off

¡Click the Container pop-up and choose a 
container shape for your fire. 

This slider controls the animation of 
your fire. Set this slider to 0% at the start 
of your animation, and at 100% at the 
end.

£Adjust the value of the Upward Speed 
slider.

The Upward Speed slider controls the 
speed at which the flames appear to 
shoot up during an animation.

Perspe
infinity

Shadi

Apply 
tricky 
will ex
especi
or grad
help yo
the pla
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te Text objects:

e the Text tool and then drag in the 
ective window. The Text Modeling 
 appears.
To adjust shader tiling:

1Double-click the Infinite Plane. 

2Enable the Tiling option if you want your 
shader to be tiled across the plane. 

If you don’t enable tiling, the shader will 
be stretched to cover the entire surface 

Use the Infinite plane tiling controls to set the 
attributes for tiling a shader across the plane.

Mirrored in X axis mirrors the tile in the 
X axis as it tiles it across the plane.

Mirrored in Y axis mirrors the tile in the 
Y axis as it tiles it across the plane.

Tile mirrored in X the axis.

To crea

1Choos
Persp
dialog
 region at the bottom of the dialog 
e it says “text...” in the figure 
), type the text you want.

e a font from the font pop-up.

pe and Type 1 fonts you have in your system 
le for creating Text objects.

e a font style from the style pop-

ext Modeling dialog to create text.
of the plane.

3Enable either the Mirrored in X axis or 
Mirrored in Y axis option.

These options let you control the 
continuity of the pattern created by tiling 
the shader. 

The X and Y refer to the plane’s own 
coordinate system, not the global 
coordinate system.

You can adjust the size of tiles by adjusting the size of 
the plane.

Creating Text Objects
When you create a Text object, Ray Dream 
Studio immediately opens it in the Text 
Modeling dialog, allowing you to enter the 

Tile mirrored in the Y axis.

2In the
(wher
above

3Choos

Any TrueTy
are availab

4Choos
up.
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text you want, specify its depth, and add 
bevels. 



5Enter a value in the Font Size entry box. Creating Formula Objects
la objects are 3D objects you create 

athematical equations. The 
la Editor lets you enter parameters, 
les and operators to create unique 
s. 

ate a Formula object:

 the Formula tool and drag it into 
r the Perspective or Time Line 
ows.

e Formula tool into the Perspective 
 to open the Formula controls
Font size is measured in points. You can 
also use the scroll arrows to set a value.

6Use the Depth controls to set the width 
of the text.

7Enable the Front Face checkbox to add a 
bevel on the front face of the text object.

8Enable the Back Face check box to add a 
bevel to the back of the Text object.

9Enter values in the Depth and Height 
fields to specify the slope or contour of 
the bevel on the text.

To edit a Text object: 

Double-click a Text object in the 
Perspective or Hierarchy window, or select 
a Text object and choose Edit menu> 
Jump In.

Ray Dream Studio opens the Text object in 
the Text Modeling dialog, where you can 
change its content, extrusion depth, bevels, 
or any of the type specifications.

The Size of Text Objects in the 
Universe

The size of a text object in the Universe 
depends on the font size you choose in the 
Text Modeling dialog. You can determine 
how large a Text object will be by 

Formu
using m
Formu
variab
object

To cre

1Click
eithe
wind

Drag th
window
ble-click the object. The Formula 
rols appear.

 Formula controls to create unique 
. 
ºClick on a bevel type in the Type 
controls at the top of the dialog.

¡Click Done. You can also choose Edit 
menu> Jump Out.

The Text dialog changes back to the 
Perspective window, and your text 
object is drawn. 

The Depth and Height settings control the 
contour of the bevel on the back of your text 
object.

Height

Depth

multiplying its font size by 0.333. This 
calculation gives you the approximate 
height (in inches) of a capital letter; 
lowercase letters are proportionally 
smaller, of course.

For example, if you created a Text object 
using 72-point type in the Text Modeling 
window, any capital letters in the text 
object would be approximately 23 inches 
tall in the Universe. Knowing the height of 
the letters in your object, you can set a 
value in the Extrusion Depth field to 
control the relationship between height 
and depth.

2Dou
cont

Use the
objects
r a formula into the editor. 
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ng Objects Using the 
ing Wizard
eling Wizard is a picture-based 

t that guides you through the basic 
 creating an object. After a few 
 with the Wizard you’ll better 

and the concepts of Free Form 
g.

e Modeling Wizard only creates 
m objects.

te an object using the Modeling 
:

he Modeling Wizard tool into the 
ective or Time Line window.
• You can load a formula by clicking the 
Load button.

• You can use the parameter sliders to 
increase/decrease the value of 
parameters.

• Click More to display the Formula 
Editor.

4When you’re finished editing the 
formula, click Done.

When you’re done creating your formula, 
Ray Dream creates an object and places it in 
the Perspective window.

Creati
Model
The Mod
assistan
steps of
sessions
underst
modelin

Note: Th
Free For

To crea
Wizard

1Drag t
Persp
odeling Wizard appears. 

 the instructions provided.
Creating objects using formulas is a highly technical 
endeavor. To find out more about creating Formula 
objects, refer to the Using Formulas in Ray Dream PDF 
on the CD-ROM.

The Formula Editor lets you see more of the 
parameter sliders and has controls for adding 
parameters and functions. 

When your formula object is finished you 
can edit it by adjusting the values of its 
parameters.

You can change the shape of your formula 
object by adjusting the values of its 
parameters.

The M

2Follow
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7

 

Free Form 
Modeling

 

Free Form Modeling

 

The 

 

Free Form

 

 modeler lets you create by 
converting 2D shapes into 3D objects. The 
modeler tools let you draw 2D shapes 
called 

 

cross sections

 

 and then convert them 
to 3D object by extruding them. Once 
you’ve created a 3D object, you can refine 
its shape using an extrusion envelope. 

This chapter covers the concepts involved 
in Free Form modeling and describes how 
to use the 

 

Free Form

 

 modeler.
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Chapte



   

Free Form Modeling Concepts

         

Lathing

n model many symmetrical objects 
 technique called lathing. Lathed 

s are created by extruding the lathe 
 around a sweep path. You can think 
lathe profile as the outline of the 
 when it’s cut in half. For more on 
, refer to “Lathing with the Extrusion 
pe” on page 135.

 objects are created by extruding a 

he profile sweep path 
(lathe axis)
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The Free Form modeler is based on a 
concept called extrusion. You create an 
object by drawing a 2D shape, then drawing 
a sweep path perpendicular to the shape. 
Ray Dream Studio sweeps the shape along 
the path to form a 3D object.

A 3D object is created by extruding a 2D 
shape along a sweep path.

2D Shape

sweep path

Extruded Object
Scaling

Scaling creates objects by changing the 
scale of the 2D shape as it’s extruded along 
the sweep path.

Object created using straight extrusion.

You ca
using a
object
profile
of the 
object
lathing
Envelo

Lathed

Lat
rofile around a sweep path.

re complex the lathe profile, the 
omplex the object.
Straight Extrusion

Straight extrusion is the most basic type of 
Free Form modeling. In a straight extrusion, 
a 2D shape is swept along a straight sweep 
path, creating a sort of “cookie cutter” 
effect. 

The 2D shape doesn’t have to be a single 
outline—it can consist of several distinct 
outlines. You can even extrude a 
compound path to create an object with a 
hole in it. For more on extrusions, refer to 
“Cross Sections and the sweep path” on 
page 131.

Simply changing the scale of a shape 
produces very basic shapes, but when 
combined with an extrusion or scaling 
envelope, you can create a much wider 
variety of objects. For more on scaling, 
refer to “Understanding the Envelope” on 
page 132.

More complex objects can be created by 
using different sized cross sections.

The same scale object can be modeled 

   

lathe p

The mo
more c
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further by using an extrusion envelope.



 Form modeler allows you to draw 
 sweep path, meaning that it can 

ted in X, Y and Z axes. You can also 
e sweep path, to create a 
us object like a chain link. Ray 

tudio also provides tools for 
ically creating complex sweep 
e spirals. For more on working 
 sweep path, refer to “Drawing the 
ath in 3D” on page 129.

create complex shapes like spirals 
eep path presets.
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Cross Sections

Cross sections are 2D shapes the act as the 
skeleton of your object. The Free Form 
modeler extrudes from each cross section 
to the next, basing the contours of the 
object’s surface on the shapes in the cross 
sections.

Ray Dream Studio creates an object by 

Cross sections

gets. The modeler’s shape numbering 
feature allows you to specify which shapes 
should be connected from one cross 
section to the next. If a particular shape has 
no corresponding shape in the next cross 
section, it is simply not extruded. For more 
on working with cross sections, refer to 
“Modeling with Multiple Cross Sections” on 
page 125.

Ray Dream Studio uses corresponding cross 
section numbers to determine how to extrude 

Cross sections

22

11

The Free
a true 3D
be adjus
close th
continuo
Dream S
automat
paths lik
with the
sweep p

You can 
using sw
do you Choose a 
ling Technique?

e Form modeler offers you a 
 of ways of creating Free Form 
 but you’ll need to decide which 
e is best suited for your object 

ou begin modeling.

 way of determining which 
e you’ll need is to take an 

ry knife and cut your object into 
slices. The types of slices you end 
      

This modeling technique is sometimes 
referred to as skinning—the 

 

Free Form

 

 
modeler stretches a “skin” over the various 
shapes in the cross sections.

 

extruding between cross sections.

A skinned object is created by stretching a 
“skin” over a series of cross sections.

  

Complex sweep paths

 

The sweep path controls the general 
direction of the extruded object. A straight 
sweep path creates a straight object while 
a more complex sweep path creates 
objects with bends and curves.

 

a shape.

A sweep path with curves will result in an 
object with bends and curves.

    

How 

 

Mode

 

The 

 

Fre

 
number

  objects,
techniqu
before y

An easy
techniqu
imagina
several 
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will tell you which technique you 
se.
Chapter

Each cross section can have any number of 
2D shapes. However, the more shapes you 
add, the more complicated your extrusion 

up with 
should u



cussion of the relationship between objects 
ter objects, refer to “Working with Master 
 on page 266.

g 

Modeling box
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If you get identical shapes, use straight 
extrusion. If you get identical shapes that 
only differ in size, use the scaling 
technique.

To determine which modeling technique you 
should use, slice an object with an imaginary 
knife. The size and shapes of the slices 
determine which modeling technique is the 
most appropriate. The Free Form Modeling 

Window

The Free Form modeler is where you 
create new Free Form objects. When the 

When you slice a glass you can see that the 
cross sections are symmetrical and vary in 
size so the lathe technique should be used.

For a dis
and Mas
Objects”

Drawin
tools
n also open the Free Form modeler 
ping into an existing free form 
. The Free Form modeler opens 
g you the components of the object.

p into an object: 

-click the object in the Perspective 
e Line window, 

the object and choose Edit menu> 
In.

ou’re creating a free form object, the 
rm modeling window replaces the 

ctive window.
   

If shapes vary dramatically in size and 
shape you may need to use a more complex 
modeling technique. Use 

 

Lathing

 

 if the 
shapes are symmetrical. If not, use the 
shape number and multiple cross sections 
technique.

 

When you slice a tree, you can see that all 
the cross sections are the same. However, 
they have different sizes. So the easiest way 
to create this object is to use the scaling 
method.

      

Free Form

 

 modeling window opens it 
temporarily replaces your scene’s 

 

Perspective

 

 window. New menus appear in 
the menu bar, and drawing tools appear in 
the toolbar. Your view of the scene is 
replaced with a close-up view of the object. 

As well, the 

 

Time Line

 

 window 
automatically switches to the 

 
Masters

 
 tab, 

since changes you make in the  Free Form  
modeler affect Master objects, not 
individual copies of objects.

    

You ca

  

by jum
object

  

showin

 

To jum

 

Double

  

or 

 

Tim

 

or 

Select 

  

Jump 

  

When y
Free Fo
Perspe
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eep Path

ep path, also known as the 
n path, is the path along which 
ction shapes are extruded. The 
efined by two red lines which 
n the bottom and side walls of the 

g Box.

 think of these description lines as 
al and vertical projections of the 
eep path. These two lines let you 
sweep path in both the XY plane 
lane.

 draw a sweep path of any shape or 
cluding curved, straight or closed 
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When you’re finished modeling, you can 
jump out of the object and return to the 
Reference view of your scene.

To jump out of an object: 

Click Done at the bottom of the Modeling 
window, 

or 

Choose Edit menu> Jump Out. 

Features of the Modeling 
Window

The Modeling Box

The Modeling Box is the primary feature of 

2D drawing application. You can use the 
Drawing tools to draw and edit shapes to 
create cross sections. 

Every time you create a cross section, you 
create a new Cross section plane. Since a 
cross section can contain any number of 2D 
shapes, you may have more than one shape 
per Cross section plane. 

By default, Cross section planes are 
oriented according to the shape of the 
sweep path. As the sweep path bends or 
twists, the cross sections reorient 
themselves to remain perpendicular to it. 

Cross section 
plane

The Sw

The swe
Extrusio
cross se
path is d
appear o
Modelin

You can
horizont
same sw
edit the 
and YZ p

You can
angle, in
paths. 
         

 sweep path exists in 3D it can be 
th horizontally and vertically using 

ctions.

 

 plane

Path 
description 
lines

 
              

the 

 

Modeling

 

 window. The box defines the 
drawing environment and provides you 
with planes for drawing sweep paths, cross 
sections and extrusion envelopes.

You can only work on a single plane at a 
time. The plane you’re currently working 
on is called the Drawing plane. By default, it 
is highlighted in green.

For a description of the Drawing plane 
environment and the Drawing tools, refer 
to “Working on the Drawing Plane” on 
page 116.

 

Cross Section Planes

The Cross section planes are the shapes 
you use to create the surface of your 

For more information, refer to “Working with Cross 
Sections” on page 125.

Each cross section has its own plane called a 
Cross section plane.

Cross sections

Since the
edited bo
its proje

Drawing
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object. These planes act like the paper in a 



 Information on moving between multiple 
ctions, refer to “Modeling with Multiple Cross 
” on page 125.

ing Your View of the Object

ou’re working with a 3D object, you 
w it from any angle. You can change 

iew of an object using either the 
enu commands or the Virtual 
all tool.

u change your view of the object, your view of 
eling Box changes as well. However, the 
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For more information, refer to “Working with the 
sweep path” on page 129.

The Extrusion Envelope

The Extrusion envelope lets you control 
the curvature in an object’s form. The 
envelope is not displayed when you first 
open the modeling window. You need to 
add it to an object using one of the 
Extrusion envelope commands in the 
Geometry menu.

The Extrusion envelope is represented by 
four blue Bezier curves, two on each sweep 
path plane. By editing these envelope 

For more information, refer to “Using the Extrusion 

Extrusion envelope lets you adjust an 
object’s shape.

Drawing 
plane Envelope 

description 
lines

For more
cross se
Sections

Chang

Since y
can vie
your v
View m
Trackb

When yo
the Mod
                             

aintains its spatial relationship to the 

 

g Box at all times.

 

ct a different view: 

 
e 

 

View menu> Preset Position> 

nce   (the default view),  Drawing    
 

 

Top

 
, 

 

Bottom

 
, 

 

Left

 
, 

 

Right

 
, 

 

Front

 
, or 

   

awing Plane

 

 view provides a direct 
f the selected Drawing plane. So you 
 probably use this view when you’re 
g detailed shapes. 

 

description lines, you can scale an object’s 
cross sections as they’re extruded along 
the sweep path. You can scale cross 
section shapes either symmetrically or 
asymmetrically.

Envelope” on page 132.

Working in the Modeling 
Window

Changing the Drawing Plane

The Drawing plane is the plane you’re 
currently working on. It is used as a 
reference for viewing objects, such as View 
menu> Drawing plane, and for 
positioning. 

To change the Drawing plane:

Click on different plane in the Modeling 

object m
Modelin

To sele

Choos
Refere

Plane,
Back.

The Dr
view o
should
drawin
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Box. The plane you click becomes the 
Drawing plane.



ge plane display: 

 the plane you want to hide or show 
isplay Plane tool. 

 Scale and Object Size

eling window opens at a scale 
nt with the proportions of objects 
ene. If you want to work with an 
t some other scale, you can reset 
eling Box’s size.
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To rotate the object: 

1Choose the Virtual Trackball tool from 
within the Free Form modeler.

2In the Free Form modeling window, drag 
the object in the direction you want to 
rotate it.

• Wireframe

• Preview 

• Shaded Preview 

• Better Preview

Higher preview modes take longer to 
redraw. So it’s a good idea to use 
Wireframe or Preview mode when you’re 
drawing.

To change the object preview:

Choose View menu> No Preview, 
Wireframe, Preview, Shaded Preview 
or Better Preview. 

To chan

Click on
on the D

Setting

The mod
consiste
in the sc
object a
the Mod
                        

odeling Box and object size:

e View menu> Modeling Box 

The Modeling Box Size dialog 
rs.

a dimension and select the units 

eling Box Size dialog lets you adjust 
of the Modeling Box in the Free Form 
.

An object’s orientation in the modeler has no 
connection to its orientation in the scene. You may 
rotate the object without worrying about its 
orientation in the scene.

Selecting an Object Preview Mode

There are four levels of object preview in 
the Free Form modeler. Listed from lowest 

You can rotate an object in 3D space using 
the Virtual Trackball.

The mode is enabled when a checkmark 
appears next to the command.

You can also click one of the preview buttons on the 
toolbar to change modes.

Selecting Modeling Box Display

By default, the Modeling Box appears 
displaying all three planes. If you find that 
the sweep path projections or cross 
section previews are too distracting, you 
hide their planes. You can hide or display 
the Modeling Box planes using the Display 
Plane tool.

To set M

1Choos
Size. 
appea

2Enter 

The Mod
the size 
modeler
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to highest they are: 

• No Preview 

you w



3Enable the Scale object with Modeling 

ion provides general instructions for working 
rawing plane. These instructions pertain to 
 cross section and sweep path planes. For 
information on cross sections and sweep paths 
 they relate, refer to “Working with Cross 
” on page 125 and “Working with the sweep 
n page 129.

shapes and paths you draw in Ray 
 Studio are Bezier curves. A Bezier 
s an interpolated curve whose shape 
rmined by the relative positions of 
tices and control points. Each 
nt of a Bezier curve connects two 
s. The control points (handles) 
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Box checkbox if you want to resize the 
object along with the Modeling Box.

4Click OK.

Setting Surface Fidelity

When Ray Dream Studio is rendering, it 
breaks each object down into hundreds of 
tiny polygons. This helps the renderer 
understand the contents of the scene. 

The number of polygons used for each 
object is based on the rendering resolution, 
the size of the object, and its distance from 
the camera. This calculation usually results 
in a smooth object. 

If a particular object does not render as 

To set surface fidelity:

1Choose Geometry menu> Surface 
Fidelity. The Surface Fidelity dialog 
appears.

2Drag the slider to increase or decrease 
the object’s surface fidelity. The default 
value is 100%.

3Click OK.

The surface fidelity value is resolution-independent. 
That is, if a particular value yields good results for a 
given object in a given scene at low resolution, it 
should yield good results at higher resolutions as well.

This sect
on the D
both the
specific 
and how
Sections
path” o

All 2D 
Dream
curve i
is dete
its ver
segme
vertice
ing from each vertex, determine the 
ure of the path segments.

eam Studio’s drawing tools are 
 to those found in traditional Bezier-
2D drawing applications. The 
g tools enable you to create curves 
apes, and to edit and modify those 
 point-by-point.

m Studio allows you to import shapes from 
pular 2D graphics programs. For more 
ion, refer to “Importing Shapes” on 
4.
smoothly as you’d like, however, you can 
force Ray Dream Studio to break it down 
into a greater number of polygons. Ray 
Dream allows you to set a value for each 
object’s surface fidelity.

If none of the objects in your scene renders as 
smoothly as you would like, you can increase the 
rendering Silhouette Quality instead. However this 
option uses more memory and increases rendering 
time. For more information, refer to “Renderers” on 
page 342.

Working on the Drawing 
Plane

To create an object, you will need to draw 
cross section shapes and Extrusion paths 
on the appropriate planes in the Free Form 
modeling window. Each plane in the 
modeling window is a separate 2D drawing 
environment with a grid. At any given time, 
you will work on a single plane. The 
currently selected plane is called the 

extend
curvat

Ray Dr
similar
based 
drawin
and sh
shapes

Ray Drea
many po
informat
page 12
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Drawing plane.



u drag, a pair of handles extends 
he vertex. By default, each pair of 
es is bound together creating a 
 point—the two handles remain 
el to one another.

d down the Shift key while dragging 
onstrain the angle of the handles to 
increments.

d down the Option/Alt key while 
gging to break apart a pair of 
dles creating a corner point. You 
 then move each handle 
ependently. Continue to hold the 
ion/Alt key down while dragging. If 
 release the key before releasing the 
use button, the handles snap back 
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Don’t confuse the Drawing tools with the 
3D Paint tools, which appear below the 
drawing tools in the toolbar. The 3D Paint 
tools are discussed in Chapter 11, 
“Creating Shaders.” 

Drawing Tools

Pen Tool

The Pen tool allows you to:

• Draw a new path.

• Add points to either end of an existing 
open path.

A corner point’s handles can be moved 
independently of one another, or retracted 
completely, allowing you to create abrupt 
changes in the direction of the path.

To add a corner point:

Corner points have no handles, curve points 
have controls handles extending from the 
point.

Corner point
(handles out)

Curve pointCorner point 
(handles in)

As yo
from t
handl
curve
parall

• Hol
to c
45° 

• Hol
dra
han
can
ind
Opt
you
mo
ether.

 a path:

e the Pen tool from within the Free 
modeler.

on the first point you added.

 a new path:

ect all paths and points by clicking 
empty area of the Drawing plane 
he Selection tool.

e the Pen tool.
Drawing with the Pen tool is like playing 
connect the dots. You draw a shape by 
adding one point at a time. As you add 
points, Ray Dream Studio connects them 
by drawing lines called segments.

Depending on the state of its handles, each 
point can be classified as a corner point or a 
curve point. A curve point’s handles are 
bound together, creating a straight tangent 
for the path and resulting in a smooth 
curve. 

1Choose the Pen tool from within the Free 
Form modeler.

2Click (do not drag) at a point on the 
Drawing plane.

Hold down the Shift key to constrain the 
position of a new point in relation to the 
previous point. The angle between the 
two points is constrained to increments 
of 45°.

To add a curve point:

1Choose the Pen tool from within the Free 
Form modeler.

tog

To close

1Choos
Form 

2Click 

To draw

1Desel
in an 
with t

2Choos
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2Drag the Pen tool at a point on the 
Drawing plane.



3Click anywhere on the Drawing plane to 

ct points:

ose the Selection tool from within 
ree Form modeler.

 on a point in the Free Form 
eling window to select it.

point color changes from white to 
k and its handles, if it has any, 
me visible.

ld down the Shift key and click on 
ditional points to increase your 
lection.

ld down the Option/Alt key and click 
 a path to select all of the points on 
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start the new path with a corner point. 

or

Drag to start with a curve point.

4Click or drag to add each subsequent 
point. As you add each point, the 
segments are drawn to connect the path.

To add points to either end of an open 
path:

1Select one of the endpoints of an open 
path with the Selection tool.

2Choose the Pen tool.

The Selection tool is also used for scaling shapes. For 
additional information, refer to “Scaling Shapes” on 
page 124.

To view points on a path:

1Choose the Selection tool from within 
the Free Form modeler.

2Click on a path in the Free Form 
modeling window.

To sele

1Cho
the F

2Click
mod

The 
blac
beco

• Ho
ad
se

• Ho
on
e path.

ld down the Shift key and click on a 
lected point to deselect it.

ick in an empty area of the Drawing 
ane to deselect all points.

ve points:

ose the Selection tool from within 
ree Form modeler.

 a selected point to a new location.

elected points move together. As 
drag, the path segments that are 
ted by the move are redrawn.
3Click or drag to add the next point. A 
segment is drawn to continue the path to 
the new point.

4Continue adding points until you’re 
satisfied with the path.

Selection Tool

In the Free Form modeling window, the 
Selection tool allows you to:

• View the points on the path.

• Select, deselect and move points.

• Drag handles.

All of the points on the curve become 
visible, but none are individually 
selected. A point appears white when it 
is deselected, and black when it is 
selected.

• Hold down the Shift key and click on 
additional paths to view the points on 
multiple paths.

• Hold down the Shift key and click on a 
path whose points are visible to make 
them invisible.

• Click in an empty area of the Drawing 
plane to make all points invisible.

th

• Ho
se

• Cl
pl

To mo

1Cho
the F

2Drag

All s
you 
affec
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 you click a curve handle, the 
es extending from the point will 
 independently.

Point Tool

ete Point tool allows you to:

 a point.

 a path segment.

e a point:

e the Delete Point tool from within 
ee Form modeler.
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• Hold down the Shift key while you drag 
to constrain the movement of the 
points in relation to their previous 
positions. Their movement is restricted 
to angles of 45° increments.

• Select all of the points on a path and 
drag them to move the entire path.

To adjust a curve:

1Choose the Selection tool from within 
the Free Form modeler.

2Drag the point’s handles.

As you drag, the curve is redrawn. When 
you move a curve point handle, the 

To convert a corner point to a curve 
point:

1Choose the Convert Point tool from 
within the Free Form modeler.

2Drag a point in the Free Form modeling 
window. As you drag, a pair of handles 
extend from the point.

or

Drag one of a corner point’s handles.

When
handl
move

Delete 

The Del

• Delete

• Delete

To delet

1Choos
the Fr
on a point in the Free Form 
ling window.

 you delete a point in the middle of 
, the points on either side of the 
d point become connected by a 
egment, changing the shape of the 

 you delete the endpoint of an open 
the last path segment simply 
pears, leaving a new endpoint.

te a point on the sweep path, any cross 
opposite handle moves to remain 
parallel to the one you are moving.

• Hold down the Shift key while you drag 
to constrain the angle of a handle’s 
motion to 45° increments.

• Hold down the Option/Alt key while 
you drag to break apart a pair of 
parallel handles. You can then move 
each handle independently.

Convert Point Tool

The Convert Point tool lets you:

• Convert a corner point to a curve point.

• Convert a curve point to a corner point.

When you click a corner point, the two 
handles extending from the point will 
move together.

To convert a curve point to a corner 
point:

1Choose the Convert Point tool from 
within the Free Form modeler.

2Click on a curve point in the Free Form 
modeling window. The point’s handles 
retract.

or

Drag one of a curve point’s handles.

2Click 
mode

When
a path
delete
new s
path. 

When
path, 
disap

If you dele
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sociated with that point is deleted as well.
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section as



Add Point Tool

mitive Tools

 Primitive tools allow you to easily 
 closed paths in a variety of shapes. 
tools work only on the cross section 
.

ating a shape with one of the 2D Primitive 
u will not immediately be able to edit its 
you will need to ungroup it first. For more 
ion, refer to“Grouping Shapes” on page 123.
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To delete a segment:

1Choose the Delete Point tool from within 
the Free Form modeler.

2Click on a path segment in the Free Form 
modeling window.

This feature applies to cross section shapes only—you 
cannot delete a segment from the sweep path or the 
Extrusion envelope.

Removing a path segment leaves 
adjacent path segments unchanged. 

The Add Point tool lets you add a new 
point between two existing points on the 
same path.

To add a point:

1Choose the Add Point tool from within 
the Free Form modeler.

2Click anywhere on an existing path in the 
Free Form modeling window.

Ray Dream Studio determines whether to 

2D Pri

The 2D
create
These 
planes

After cre
tools, yo
points—
informat
ngle Tool

w a rectangular cross section:

ose the Rectangle tool from within 
ree Form modeler.

e Free Form modeling window, drag 
 one corner of the rectangle to the 

osite corner. 

 down the Shift key while dragging 
eate a square. 
When you delete a path segment from a 
closed path, the path simply becomes an 
open path. 

When you delete a path segment from an 
open path, the path is split into two 
separate open paths.

add a corner point or a curve point, 
depending on the shape of the path. The 
new point is automatically selected so 
that it can be moved with the Selection 
tool.

When you add a point to the sweep path, you can 
simultaneously add a cross section at that point—just 
hold down the Option/Alt key as you click.

Recta

To dra

1Cho
the F

2In th
from
opp

Hold
to cr
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OK.

 Tool

Text tool allows you to create text 
ss section plane. 

 text on the cross section plane:

e the 2D Text tool from within the 
orm modeler.

in the Free Form modeling window 
ition the text. The Text dialog 
rs.
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Rounded Rectangle Tool

To draw a rounded rectangular cross 
section:

1Choose the Rounded Rectangle tool 
from within the Free Form modeler.

2In the Free Form modeling window, drag 
from one corner of the rectangle to the 
opposite corner. Release the mouse 
button when the rectangle is the desired 
size. 

Hold down the Shift key while dragging 

Ellipse Tool

To draw an ellipse cross section:

1Choose the Ellipse tool from within the 
Free Form modeler.

2Drag in the Free Form modeling window 
to draw an ellipse. 

Hold down the Shift key while dragging 
to create a circle. 

Polygon Tool

4Click 

2D Text

The 2D 
on a cro

To draw

1Choos
Free F

2Click 
to pos
appea
text and specify type settings.

OK.

ol when you want to extrude text along a 
th. Use the Text modeler when you want to 
xt along a straight path and add bevels. For 
mation on the Text modeler, refer to 
 Text Objects” on page 105.
to create a square with rounded corners. 
The Round Rectangle dialog appears.

3Set the curvature on the corners.

4Click OK.

Use the Rounded Rectangle dialog to round 
the corners of rectangles.

To draw a polygon cross section:

1Choose the Polygon tool from within the 
Free Form modeler.

2Drag the tool in the Free Form modeler 
Cross section plane. Release the mouse 
button when the polygon is the desired 
size. 

Hold down the Shift key while dragging 
to keep all angles equal. The Number of 
Sides dialog appears.

3Enter 

4Click 

Use this to
curved pa
extrude te
more infor
“Creating
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3Set the number of sides for the polygon.



Precision Editing 7Click OK. • No information is available for ungrouped 
es or multiple point selections.

ault, all values are shown in inches.

nge the properties of a cross 
n:

e Properties palette is not visible, 
se Windows menu> Properties.

ct a cross section group or point.

st the position values.

you selected a closed cross section, 
u can enable the Keep Proportions 
eckbox to maintain the shapes 
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The Drawing Plane Grid

You can use the Drawing Plane grid to help 
you precisely position lines and points as 
you draw. 

You can set the size of each grid increment, 
and specify whether a line should be drawn 
at every increment. As well as enabling the 
Snap To feature. When this feature is 
enabled any object you drag along the 
plane will “jump” to the nearest grid 
intersection.

To set up the grid:

1Choose View menu> Grid. The Grid 

The Properties Palette

The Properties palette displays the 
properties of the selected point, control 
handle, group or compound cross section.

shap

By def

To cha
sectio

1If th
choo

2Sele

3Adju

• If 
yo
ch
pect ratio as you scale it.

you selected a curve point, you can 
ick the Retract button to retract the 
int’s handles. You can also click the 
rner Point button to convert the 
rve point to a corner point.

ing Shapes

n use the 2D Rotation tool to rotate 
ss section freely, or the Rotate 
to rotate it numerically.

ou can only rotate cross sections, 
 sweep path. 

 rotate a cross section: 
dialog appears.

2Change the Spacing value to control the 
amount of spacing between grid lines in 
the box. You can also change the value 
using the scroll buttons.

3Choose a unit of measure from the 
pop-up.

4Change Draw a line every value to 
control how often grid lines are drawn.

5Enable Snap to if you want objects to 
“jump” to the nearest grid line as you 
drag them.

• When a point is selected, the X and Y 
coordinates are displayed. 

• When a curve point is selected, the X, and 
Y position of its handles are displayed. 
When these controls are active, you can 
retract a control handle using the Retract 
button.

• When a group or compound cross section 
is selected, its top, and left coordinates 

The Properties palette in the Free Form 
modeler shows the position of points and 
control handles.

as

• If 
cl
po
Co
cu

Rotat

You ca
the cro
dialog 

Note: Y
not the

To free
ct a shape on the cross section 
e.
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6Disable Show if you want to hide the grid 
lines.

are shown as well as the shape’s height 
and width.

1Sele
plan



ouping is allowed only on the 
ction planes.

p shapes:

 the shape(s) you want to group.

e Arrange menu> Group.

oup:

 the group you want to ungroup.

e Arrange menu> Ungroup.

unding Shapes
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2Choose the 2D Rotation tool from the 
Free Form modeler.

3Drag the shape in a circular path.

A shape rotated with the 2D Rotation tool 
always rotates around its center.

If the Properties palette is open, the cross 
section’s position values will update as you 
rotate it.

To numerically rotate a cross section:

1Select a shape, and choose Geometry 
menu> Rotate. The Rotate dialog 
appears.

Twisting An Object

When you rotate a cross section shape, you 
can specify that the rotation be applied to 
the surface of the object to give it a twisted 
appearance.

To twist an object: 

Hold down the Option/Alt key while 
rotating a cross section shape with the 2D 
Rotation tool.

You can twist an object by rotating its cross 
sections.

Note: Gr
Cross se

To grou

1Select

2Choos

To ungr

1Select

2Choos

Compo
nding shapes is like grouping 
ith one significant difference—any 
hich is completely enclosed by 
 shape in the same compound “cuts 
om the larger shape. When a 
nd is extruded, the inner shapes 
oles through the extrusion. 

mpound shapes are allowed only 
s section planes.

nd shape
2Select the rotation center—the shape’s 
center, or the Drawing plane’s center.

3Enter a value for degree of rotation and 
select clockwise (CW) or 
counterclockwise (CCW).

Use the Rotate dialog to numerically rotate 
an object.

For precise twisting, enable the Twist 
checkbox in the Rotation dialog. When 
Twist is enabled, Ray Dream Studio twists 
the surface the specified number of 
degrees.

Rotation values greater than 360° make sense when 
twisting the object’s surface—you can use them to 
specify multiple twists.

Grouping Shapes

You can group one or more shapes using 
the Group command. Grouping two or 

Compou
them, w
shape w
another
away” fr
compou
create h

Note: Co
on Cros

Compou
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ow log was created by extruding two 
d cross sections.
Chapter

4Click OK. more shapes lets you to manipulate them 
all at once. 

This holl
compoun



Importing Shapes

eam Studio lets you import cross 
 shapes, sweep paths, and 

pes from 2D drawing programs that 
rt Bezier curves, like Adobe 
tor or CorelDRAW!.

ort shapes to a cross section:

 the cross section you want to work 
. 

 can also create a blank cross section 
g Sections menu> Create.

ose File menu> Import. The 
ort dialog appears.
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To compound shapes:

1Select the shapes you want to 
compound.

2Choose Arrange menu> Combine as 
Compound.

To break apart a compound:

1Select the compound you want to 
release.

2Choose Arrange menu> Break Apart 
Compound.

Scaling Shapes

To scale shapes:

1Group the curves or shape you want to 
resize.

2Drag a corner of the shapes bounding 
box with the Selection tool to resize it. 
Drag towards the shape to reduce it’s 
scale, or away from it to increase its 
scale.

Hold down the Shift key to maintain 
proportions.

To scale shapes numerically:

1Select the shape you want to resize.

Ray Dr
section
envelo
suppo
Illustra

To imp

1Click
with

You
usin

2Cho
Imp
e dialog, select the file you want, 
 click Open.

Dream Studio places the artwork on 
rawing plane.

file may include one or several two-
nsional shapes. You should, 

ever, avoid unnecessary complexity. 
t characteristics, like stroke and fill 
gnored. Compound paths are 
erved. Text is automatically 
erted to outlines.

 OK.
You can scale a shape directly by dragging 
its bounding box, or numerically using the 
Scale dialog.

Note: Scaling is allowed only on cross 
section planes.

Scaling a cross section shape directly is not always 
necessary. The scaling envelope, described in “Using 
the Extrusion Envelope” on page 132, can often 
accomplish the same results more simply and 
powerfully. 

2Choose Geometry menu> Scale. The 
Scale dialog appears.

3Enter horizontal and vertical scale 
factors.

4Click OK.

Use the Scale dialog to numerically resize 
objects.

3In th
then

Ray 
the D

The 
dime
how
Pain
are i
pres
conv

4Click
124 Ray Dream Studio User Guide



ing with Multiple Cross 
ns
g with multiple cross sections lets 
ease your control over the shape of 
ject’s surface.

st use a few cross sections, Ray 
tudio automatically extrudes a 
between the cross sections 
 a flat surface. 

u only use a few cross sections to 
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To import a path as a sweep path or 
envelope:

1Choose Geometry menu> Extrusion 
Envelope to turn on the extrusion 
envelope.

Note: Importing a sweep path or envelope 
replaces the current sweep path and 
envelope.

2Click one of the path sweep path planes 
to make it the Drawing plane.

3Choose File menu> Import. The 
Import dialog appears.

Working with Cross 
Sections

A basic free form object, like a box, has one 
cross section at the start of the path. The 
shape on this first section is swept to the 
end of the Extrusion path. To create more 
complex forms, you can add any number of 
cross sections along the length of the path. 
Since each cross section, in turn, can 
contain any number of shapes, you will be 
able to model even very intricate objects.

The Free Form modeler automatically 
extrudes between each cross section and 
the next, basing the surface of the object on 

Model
Sectio
Modelin
you incr
your ob

If you ju
Dream S
surface 
creating

When yo
h section you add, you reduce the 
of surface areas that is 
ically calculated. You can add 
ariations in your object’s surface 
ng more sections with different 
n between cross sections. 

n object, Ray Dream creates a flat 
ver the entire object.

g more cross sections you can vary 
ce of your object.
4Select the file you want, then click Open.

If the file you choose contains more than one path, 
only the first path will be imported.

Another dialog appears, allowing you to 
specify whether the path should be used 
as the sweep path or the envelope.

5Specify sweep path or envelope, and 
click OK.

Ray Dream Studio imports the sweep path 
or envelope.

the shapes contained in the cross sections. 

As you begin to work with the Free Form modeler, 
you will find that the sweep path and cross sections 
are closely tied. Although separated here for the sake 
of clarity and organization, these concepts go hand in 
hand. Be sure to read “Working with the sweep path” 
on page 129.

With eac
amount 
automat
subtle v
by placi
shapes i

define a
surface o

By addin
the surfa
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Of course, the more cross sections you add 

erate intermediate cross sections:

 on a cross section plane.

ose Sections menu> Create 
tiple. The Create Multiple Cross-
ions dialog appears.

r the number of sections you want.

 OK.

Dream Studio creates the 
mediate cross sections, spacing 
 evenly between the current cross 

ion and the next one. A new point is 

CH07.rds5  Page 126  Wednesday, July 2, 1997  3:03 PM
the more complicated it becomes to work 
in the modeler. However, the Free Form 
modeler has a number of features to help 
you model with multiple cross sections. 
The modeler lets you:

• Add or delete cross sections.

• Move between cross sections. 

• Add shape numbering to sections to 
control the extrusion between section 
shapes.

• Control whether the surface is extruded 
from shape to shape or point to point.

Adding and Removing Cross Sections

You can add as many cross sections as you 

To create a new cross section: 

1If a sweep path point exists where you 
want the new cross section:

• Select the sweep path and choose 
Sections menu> Create.

2If there is no point:

• Choose the Add Point tool from within 
the Free Form modeler.

• Hold down the Option/Alt key and click 
on the sweep path at the point where 
you want to create the new cross 
section.

Ray Dream Studio adds a point to the 

To gen

.

1Click

2Cho
Mul

Sect

3Ente

4Click

Ray 
inter
them
sect
d to the sweep path for each cross 
ion created.

es on the new cross sections are interpolated 
 shapes on the existing cross sections. This 
is similar to blending between two shapes in a 
ration program—each shape on the new cross 
 is like one “step” in the blend.

ove a cross section:

 the cross section you want to 
ove, or select the corresponding 
like. Each cross section must correspond 
to a point on the sweep path. If you want to 
add a cross section where there is no point, 
you have to add one.

Although modeling with multiple cross sections 
enables you to achieve otherwise impossible effects, 
be careful not to add cross sections unnecessarily. 
Editing an object with too many cross sections can 
become difficult and tedious. Often, you can 
accomplish similar results using the scaling envelope. 
Refer to “Using the Extrusion Envelope” on page 132.

sweep path and creates a new cross 
section at that point. 

3If you’re working on a cross section 
plane:

• Choose Sections menu> Create.

Ray Dream Studio adds a new cross 
section at the next vertex. 

Generating Intermediate Cross 
Sections

You can have Ray Dream Studio create a 
specific number of cross sections between 
the current cross section and the next one

adde
sect

The shap
from the
process 
2D illust
sections

To rem

1Click
rem
t on the sweep path.
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numbered shape is swept to the 
ponding numbered shape in the 
ross section. 

on the number you want to change. 
hape Number dialog appears.

in the number for the 
ponding shape.

u enter the number of another 
pe in this plane, the program swaps 
 correspondence number with that 
pe.

u enter a unique number, make 
e that you assign the same number 
he appropriate shape in the 
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2Choose Sections menu> Remove.

To simultaneously remove a cross section and delete 
its corresponding sweep path vertex, use the Delete 
Point tool to delete the point from the path.

Moving the Drawing Plane Between 
Sections

If you have multiple cross sections, you can 
choose Next or Previous from the Sections 
menu to move the Drawing plane between 
adjacent cross sections. 

Correspondence and Shape 
Numbering

Normally, there is a direct correspondence 
between the number of shapes in adjacent 
cross sections. You can, however, use a 
different number of shapes in adjacent 
sections, or change which shape sweeps to 
which. You control multiple shape 
correspondence through shape numbering.

Cross sections

1

2

Cross sections

1

21 1
2 2

Each 
corres
next c

2Click 
The S

3Type 
corres

• If yo
sha
the
sha

• If yo
sur
to t
cent cross section(s).

OK.

 that has no correspondence (i.e., its 
es not match any shape number in an 

ection) is not extruded. 

ection Options

ss Section Options dialog lets you 
he following:

er the cross section should be 
.” 
To move between sections using the 
keyboard:

Hold down the Command/Ctrl key and 
press the right or left arrow key to move to 
the next or previous cross section, 
respectively.

To move to a specific section:

1Choose Sections menu> Go to. The 
Go To Cross Section dialog appears.

2Enter the number of the section you 
want to go to and click OK.

Cross sections are numbered from left to 

To control shape-to-shape 
correspondence:

1Choose Sections menu> Show 
Shapes Numbers.

Ray Dream Studio displays a number 
beside each shape in the Drawing plane. 
A group or compound is assigned a 
single shape number.

Cross section shape numbers let you control 
how sections are extruded along a sweep 
path.

adja

4Click 

Any shape
number do
adjacent s

Cross S

The Cro
specify t

• Wheth
“filled
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cross section should be connected 
 next cross section.
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right.
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• What type of “skinning” should be used 4Enable the Disconnect from next Cross the next cross section. This option is 
ul when you model an object which 
ires straight, sharp edges.

 OK.

ring a Cross Section

hen you’re creating cross sections, 
y end up with a number of off 

ses where you would use shape-to-
and point-to-point skinning.

ape-to-
 skinning

Use point-to-
point skinning
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between the cross section and the next 
cross section.

To set cross section options: 

1Click on a cross section.

2Choose Sections menu> Cross-
Section Options. The Cross Section 
Options dialog appears.

Section checkbox to turn off extrusion 
between this section and the next one. In 
this way, you could create an 
“intermittent” object.

5Enable a Skinning option:

Skin Shape-to-Shape is especially well 
suited for creating smooth, organic 

Object created using the Disconnect from 
next Cross Section option.

usef
requ

6Click

Cente

Often w
you ma

Two ca
shape 

Use sh
shape
ed sections which can lead to 
cted results when they’re extruded. 
ally a good idea to center sections 
ou’re finished drawing them.

ter a cross section on the sweep 

 the section you want to center.

se Sections menu> Center. The 
e(s) on the cross section will be 
ered around the sweep path.

u can also use Command -Shift-C/
ift+C.
3Enable the Fill Cross Section checkbox if 
you want to fill the section. For example, 
a cylinder with its first and last sections 
not filled would be a tube that you could 
look through. 

An object’s first and last cross sections 
are often referred to as endcaps—you 
can turn endcaps “on” by filling them, or 
“off” by leaving them unfilled.

Use the Cross Section Options dialog to fill or 
disconnect cross sections.

surfaces whose cross section shapes are 
significantly different from one another. 
In fact, if adjacent cross sections have 
different numbers of vertices, shape-to-
shape skinning is the only option 
available.

Skin Point-to-Point can be used when 
adjacent cross sections contain very 
similar shapes, and you want each vertex 
in one cross section to be connected 
directly to the corresponding vertex in 

center
unexpe
It’s usu
when y

To cen
path: 

1Click

2choo
shap
cent

Tip: Yo
Ctrl+Sh
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ng the sweep path in 3D
t way to start drawing a sweep path 
sider how you want your object to 
h from the side and from the top. 
t that has a lot of curves when 
n profile, but looks straight when 
rom the top, indicates that the 
ath will remain straight on the 
plane and curved on the right 
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Working with the sweep 
path

The key to working with the sweep path is 
understanding how the 2D path description 
lines define the 3D sweep path. There are 
two red path description lines, one on each 
sweep path plane. Although the path 
description lines appear to be two separate 
paths, they are actually just projections of 
the same path.

the side plane describes its vertical 
position. A sweep path that is curved on 
the side plane but straight on the ground 
plane would create an object whose’s 
shape curves up and down but not side to 
side.

Drawi
The bes
is to con
look bot
An objec
viewed i
viewed f
sweep p
ground 
plane.
ately few objects are this simple. 
jects have some variation from 
 top and the profile. You can easily 
his type of sweep path by adjusting 
t on the two sweep path 
ons.

t that has many curves when viewed 
 but appears straight when viewed 
ve.
Each point on one path description line 
corresponds to a point on the other path 
description line. In fact, each pair of points 
represents a single 3D point on the sweep 
path.

The sweep path projection on the ground 

You can tell the exact position of the sweep 
path by its path description lines.

Path
description lines

A path that curves on both planes would 
create an object whose shape curves in 3D.

A sweep path curving in 2D will create an 
object that only curves up and down.

A sweep path curving in 3D will create an 
object both up and down and side to side.

Unfortun
Most ob
both the
handle t
the poin
projecti

An objec
in profile
from abo
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plane describes the sweep path’s 
horizontal position while the projection on 



3Switch back to the side plane, and trace 
 over the path to add the other side 
e chair.

lly, working on the ground plane, 
e the path by drawing from the last 
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In some cases, simple adjustment may not 
be enough. You may want to draw the 
sweep path continuously from the first 
point to the last, switching back and forth 
between the two planes as you work. The 

You can create more realistic objects by 
making the sweep path curve in 3D.

To draw a sweep path in 3D:

1On the side plane, draw one side of the 
chair using the Pen tool As you draw, 
points are added on the ground plane, as 
well. 

back
of th

4Fina
clos
t to the original point.
chair frame shown below is modeled using 
this technique—the diagrams that follow 
illustrate the process. 2Switch to the ground plane and select 

the last point. Then continue drawing to 
add the chair’s horizontal bar as shown.

poin
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se an extrusion method: 

Geometry menu> Extrusion 

> Translation or Pipeline.

itch extrusion methods at any time, 
hanging methods may reset your sweep 
xtrusion envelope. In general, you should try 

ine which extrusion method is appropriate 
 start work on an object.

on Presets

am Studio provides three extrusion 
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Cross Sections and the sweep 
path
When you’re working with the sweep path 
it’s important to understand the 
relationship between cross sections and 
the sweep path. You can think of the sweep 
path as an object’s spine. Whenever you 
move a point on the sweep path, any cross 
section at that point will move as well.

The opposite is not true, however. When 
you move a cross section shape up or 
down, left or right along the cross section 
plane, the sweep path is not affected. 

This allows you to create cross sections 
that are not centered around the sweep 
path.

Translation vs. Pipeline
The Free Form modeler can extrude cross 
sections along the sweep path using one of 
two extrusion methods: the Translation 
method or the Pipeline method. 

With the Translation method, each cross 
section remains perpendicular to the 
ground plane of the Modeling Box, 
regardless of the sweep path’s curvature.

With the Pipeline method, the orientation 
of each cross section depends on the 
direction of the sweep path at the point 
where the cross section is located—all 
cross sections remain perpendicular to the 
sweep path, rather than to the ground 
plane.

To choo

Choose 
Method

You can sw
however, c
path and e
to determ
before you

Extrusi

Ray Dre

 which automatically generate 
types of sweep paths. When you 
 extrusion preset, the current 
ath and envelope are replaced with 
et path.

ghten the sweep path: 

Geometry menu> Extrusion 

 Straight. 

the points on the sweep path are 
d into a straight line. Cross section 
s are unaffected.

hen you use the Spiral extrusion 
nly the first cross section of your 

 object is kept—the remaining 
Cross sections don’t necessarily have to be 
centered around the sweep path. They can 
be off-center.

Translation vs. Pipeline.

Translation method

Pipeline method

presets,
specific 
apply an
sweep p
the pres

To strai

Choose 
Preset>

All of 
move
shape

Note: W
preset, o
existing
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ctions, sweep path, and envelope 
placed.
Chapter

cross se
are all re



6Enter a percentage in the Cross Section To create some complex objects you may 
at you‘ll need a finer degree of 
l than cross sections alone can 
e. The extrusion envelope lets you 
 how an object’s surface should 

from one cross section to the next, 
you precise control over the object’s 

est results, you should model the object as 
ely as possible using the sweep path and cross 
, then adjust the scaling envelope as a 
p.

rstanding the Envelope
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To make a spiral: 

1Draw a 2D shape in the cross section 
plane.

2Choose Geometry menu> Extrusion 
Preset> Spiral. The Spiral dialog 
appears.

3Enter the Number of turns you want—
one turn equals 360°. 

4Enter the Length of the spiral sweep 
path. The relationship between the 
number of turns and the length 
determines how “tightly” the coils of the 

Scaling entry box if you want to shrink or 
enlarge the cross section shape as it 
sweeps along the spiral path. Values less 
than 100% shrink the shape; values 
greater than 100% enlarge the shape.

7Enter a percentage in the Spiral Scaling 
entry box if you want to decrease or 
increase the distance to the axis as the 
cross section shape sweeps along the 
path. Values less than 100% taper the 
spiral; values greater than 100% widen it.

8Click OK to close the Spiral dialog. Ray 
Dream Studio creates the spiral sweep 
path you have specified, and 
automatically switches to Pipeline mode.

find th
contro
provid
specify
curve 
giving 
form.

For the b
complet
sections
final ste

Unde

ault, the extrusion envelope is not 
Ray Dream Studio stretches the 

’s surface over the cross sections as 
 as possible. When you turn the 
pe on, it appears as four blue 
pe description lines, two on each 
 path plane. (The red path on each 
 path plane is a path description 
efer to “Working with the sweep 
n page 129.) 
spiral are spaced.

5Enter a value in the Distance to axis 
entry box. This value determines the size 
of each coil by setting the distance 
between the cross section shape and the 

Relationship between length and distance.

Length

Distance to axis

The Torus Extrusion Preset

The Torus extrusion preset automatically 
creates a perfect circular sweep path. This 
feature is described in “Lathing” on 
page 134.

Using the Extrusion 
Envelope

To a large extent, the contours of a Free 
Form object are determined by the cross 
sections you place along the sweep path. 
Wherever you change the size or shape of a 

By def
used—
object
simply
envelo
Envelo
sweep
sweep
line—r
path” o
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spiral’s central axis. cross section, the object’s surface changes 
accordingly. 



e Envelope Relates to the 
path

elope and the sweep path are 
elated. In fact, each point on the 
n envelope corresponds to a point 
weep path.

an envelope point perpendicular to 
p path controls the scaling of the 

t that point on the path. When you 
 envelope point parallel to the 
ath, the corresponding point on 
p path moves as well—the points 
ed” together in the direction of the 
ath.
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Initially, the envelope conforms to the 
dimensions of the object’s cross sections, 
widening and narrowing only if the cross 
sections vary in size.

Envelope 
description 
lines

When you work with the Symmetrical 
envelope setting, all the envelope lines 
maintain symmetry. Symmetrical in Plane 
lets you edit the envelope description lines 
in pairs. Free lets you edit each line 
individually. This allows you to model 
asymmetrical objects.

How th
sweep 

The env
closely r
extrusio
on the s

Moving 
the swee
object a
move an
sweep p
the swee
are “lock
sweep p
 are using the Pipeline extrusion method, 
oints are constrained to move only 

ular to the sweep path.

tain the relationship between the 
ath and the envelope, when you 
int to the scaling envelope, a point 
dded to the sweep path. Likewise, 
u delete a point from the envelope, 
esponding point is deleted from the 
ath.

e Envelope Relates to Cross 
s

he Extrusion envelope may also 
The envelope description lines are Bezier 
curves. By editing these curves, you can 
alter an object’s contours. The envelope 
has three modes: Symmetrical, 
Symmetrical in Plane and Free.

Object with envelope.

Symmetrical in Plane.

Free Envelopes.

When you
envelope p
perpendic

To main
sweep p
add a po
is also a
when yo
the corr
sweep p

How th
Section

Editing t
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 object’s cross section shapes. If 
 the envelope at a point where 
no cross section, only the surface 
Chapter

Symmetrical envelope.

affect an
you edit
there is 



between cross sections is affected. 

et the extrusion envelope:

e Geometry menu> Reset 
pe.

e Geometry menu> Extrusion 
pe> None.

ing

g lets you create many types of 
trical objects by rotating a 2D 

 around a straight axis. Rotation can 
ular or angular, around 360º or less.
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However, if you edit the envelope at a point 
where a cross section exists, the shapes on 
the cross section are scaled accordingly. If 
you delete a point from the envelope, you 
will also delete any cross section located at 
that point.

When using the extrusion envelope in conjunction 
with multiple-shape cross sections, note that the 
scaling reference point is the sweep path—not the 
center of each shape. If you want a cross section’s 
individual shapes to scale around their respective 
center points, you should resize each shape 
individually on the cross section plane, rather than use 
the scaling envelope.

If the envelope was not already enabled, the four blue 
Envelope description lines appear on the sweep path 
planes.

Symmetrical uses the same curve for all 
four envelope description lines—when you 
edit one line, the others update 
automatically.

Symmetrical in Plane the two Envelope 
description lines in either plane use the 
same curve—when you edit one line, the 
other in its plane updates (as a mirror 
image) automatically.

To res

Choos
Envelo

or

Choos
Envelo

Lath

Lathin
symme
profile
be circ
e your lathe object is actually a Free 
bject, you can edit it in ways that 
nal lathing tools do not allow. For 

le, you can create a symmetrical 
bject, then deform it using the Free 
odeler’s other tools. 

ding on the specific object you want 
te, you can choose from two 
nt lathing methods: 

g the Extrusion envelope

g a circular sweep path.
Editing the Envelope

To enable the envelope or change its 
symmetry constraint:

Choose Geometry menu> Extrusion 
Envelope> and pull right to select a 
symmetry constraint setting: 
Symmetrical, Symmetrical in Plane or 
Free.

Free each line may have a unique curve.

To modify the extrusion envelope:

Use the drawing tools to edit the Envelope 
description lines. 

You can add and delete points, as well as 
adjust existing points and control handles. 
As you adjust one of the Envelope 
description lines, the other lines are 
updated in real time.

For instructions, refer to “Working on the Drawing 
Plane” on page 116.

Becaus
Form o
traditio
examp
lathe o
Form m

Depen
to crea
differe

• usin
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 the Pen tool, place the second 
of the lathe profile. You may need 
g the Pen tool to create a curve 
 

raw the top portion of the lathe 
he bottom portion automatically 

Click here first
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Lathing with the Extrusion 
Envelope
You can create nearly any lathe object by 
extruding a circle or a regular polygon and 
using the extrusion envelope to draw the 
object’s lathe profile. 

For more on the Extrusion envelope, refer 
to “Using the Extrusion Envelope” on 
page 132.

Cross section Envelope description 
line (lathe profile)

cross section. For example, the size of 
the first circular cross section 
determines the diameter of the glass’ 
base.

Hold down the Shift key to create circles 
or squares.

3Choose Sections menu> Center to 
center the cross section on the sweep 
path.

4Choose Geometry menu> Extrusion 
Method> Translation.

5Choose Geometry menu> 
Symmetrical> Extrusion Envelope. 

9Using
point 
to dra
point.

As you d
profile, t
sure you draw the lathe profile 
 the sweep path.

nue drawing the lathe profile, 
g additional points with the Pen 

.

To create a lathe object with the 
extrusion envelope:

1Click a cross section plane.

2Draw a cross section using the Ellipse, 
Rectangle, or Polygon tool. 

Draw your circle (or polygon) at an 

Lathed object using the extrusion envelope.

Do not worry about trying to edit the 
envelope’s description lines—they 
disappear when you start drawing your 
own lathe profile.

6Click one of the sweep path planes to 
make it the Drawing plane.

7Click an empty space on the plane, being 
careful not to select the sweep path or 
either of the Envelope description lines.

8Choose View menu> Preset 
Position> Drawing Plane. This allows 
you to draw in the plane of the screen.

Make 
above

ºConti
placin
tool. 

appears
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ed lathe profile.
Chapter

appropriate size for the object you are 
creating, since the initial diameter of 
your object depends on the size of the Complet



You can also use the Drawing tools to 2Choose Geometry menu> Extrusion 
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edit the points you have already placed. 
For the best results, be careful not to 
cross over the sweep path as you draw 
the lathe profile.

Lathing with a Circular sweep 
path
Some lathe objects are difficult to create 
with the scaling envelope. An object with a 
hole in the center can be particularly 
difficult. To create these type of objects, 
you can draw the lathe profile in the Cross 
section plane and sweep it around a 
circular sweep path. 

The Torus extrusion preset, available from 
the Geometry menu, creates a precise 

Preset> Torus. The Torus dialog 
appears.

3Enter a value in the Distance to axis 
entry box, and click OK. 

This value specifies the distance of the 
cross section from the torus’ central axis 
which is the radius of the object.
circular path.

To create a lathe object using a circular 
sweep path:

1Draw your lathe profile in the cross 
section plane. 

You may need to experiment with the radius of the 
torus to achieve the effect you want. Simply repeat 
steps 2 and 3, and enter a different dimension—Ray 
Dream Studio replaces the old Torus with the new one 
you have specified.

Lathed object using Torus preset.
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 Lathe profile in cross section plane.
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8

 

Mesh Form 
Modeling

 

Introducing the Mesh Form 

 

Modeler

 

The 

 

Mesh Form

 

 modeler lets you sculpt 
three-dimensional objects by directly 
manipulating their surfaces.

When you use the 

 

Mesh Form

 

 modeler, 
you’re not limited to creating objects that 
can only be modeled as extrusions, you can 
model objects by directly edit an object’s 
surface.

You can start with a predefined object, 
such as a sphere or cube, or use the 
Polymesh modeling tools to generate 
extrusions, sweeps, lathed objects, and 
lofted objects. Once you’ve created an 
object, you can reshape and refine it by 

the points that define its surface.

 

CH08.rds5  Page 137  Wednesday, July 2, 1997  3:12 PM
Chapter

editing 



   

Mesh Form Modeling 

              

Polymesh modeling is the process of 

            

rast, when a cross section is 

 

swept

 

 
 path, its orientation changes so 
e cross section of the sweep is 
 perpendicular to the path..

     

n object is extruded along a path, the 
ections remain parallel to the original 
ection.
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Concepts

Three-dimensional objects can be 
described as sets of vertices, edges and 
polygons. A vertex defines a position in 
three-dimensional space and an edge is the 
line that connects two vertices. For 
example, eight vertices and twelve edges 
describe a cube. Each face of the cube is a 
filled polygon.

Vertices

Edge

creating three-dimensional objects by 
directly manipulating vertices, edges and 
polygons. Instead of modeling all objects as 
extrusions, you can “sculpt” objects by 
changing the number and location of their 
vertices, edges and polygons.

By combining the modeling techniques 
used in the Free Form modeler with the 
ability to directly edit vertices and edges, 
the Mesh Form modeler makes it easy to 
create complex models. For example, you 
can use the Mesh Form modeler to create a 
complex cross section and extrusion path, 
extrude an object, and then directly edit 
the object’s vertices and edges to refine its 
appearance.

In cont
along a
that th
always

When a
cross s
cross s
e Mesh Form modeler, you can:

ude and sweep open and closed 
lines selected from existing polymesh 

n object is swept along a path, the 
ections remain perpendicular to the 
A polyline is a selected set of connected 
edges. A polyline that forms a closed loop 
is referred to as a closed polyline. A closed 
polyline is not equivalent to a polygon—a 
closed polyline might encompass several 
polygons. However, if you fill a closed 
polyline that doesn’t encompass any other 
edges or vertices, it becomes a polygon.

A collection of vertices, edges and the 
polygons that they form is called a 
polymesh. A polymesh can form a closed 
volume, such as a cube, or an open object 

A Mesh Form object’s surface is defined by its 
vertices.

The following sections explain how 
extruding, sweeping, lathing and lofting 
differ in the Mesh Form modeler. For an 
introduction to these modeling concepts, 
refer to“Free Form Modeling” on page 109.

Extruding and Sweeping
When a cross section is extruded along a 
path, its orientation does not change—at 
every point along the path, the extrusion’s 
cross section is parallel to the original 
cross section. 

With th

• Extr
poly

When a
cross s
path.
cts. 
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resembling a sheet of wire mesh.
obje



                                  

g

 

also known as skinning, is the 
 of stretching a surface over several 
ctions to construct a complex 
n the 

 

Mesh Form

 

 modeler, you can 

  

 3-dimensional cross sections.

  

en and closed polylines selected 
xisting polymesh objects as cross 
ns.

 

h Form

 

 modeler performs a 
 extrusion from one cross section 
xt. Unlike the 

 

Free Form

 

 modeler, 

 

h Form

 

 modeler only supports one 
r object for each cross section. For 
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• Extrude and sweep 3-dimensional cross 
sections.

• Specify complex 3D extrusion and sweep 
paths using polylines.

• Use selected edges of existing polymesh 
objects as sweep paths.

For more information about creating 
extrusions and sweeps with the Mesh Form 
modeler, see “Extruding and Sweeping 
Polygon and Polyline Cross Sections” on 
page 164. 

section; all lathed objects created with the 
Mesh Form modeler have circular cross 
sections. 

The Mesh Form modeler creates lathed 
objects by revolving the lathe profile 
around the specified lathe axis. 

The Mesh Form modeler enables you to:

• Define 3-dimensional lathe profiles.

Polyline lathe profile and resulting object.

Loftin
Lofting, 
process
cross se
object. I
easily:

• Create

• Use op
from e
sectio

The Mes
straight
to the ne
the Mes
shape o
ormation about lofting with the 
rm modeler, see “Modeling with 
 and Polyline Cross Sections” on 
. 

ject is created by stretching a skin 
ries of cross sections. 
Lathing
When you lathe an object with the Mesh 
Form modeler, you specify both the lathe 
profile and the lathe axis. Unlike the Free 

Extruded polygon cross section.

This extruded object was created with the 
Mesh Form modeler.

• Use closed polylines as lathe profiles.

• Use any edge in a polymesh object as the 
lathe axis.

For more information about lathing with 
the Mesh Form modeler, see “Lathing with 
Polygon and Polyline Profiles” on page 166.

more inf
Mesh Fo
Polygon
page 166

A Loft ob
over a se
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Form modeler, you do not specify a cross This object was created by rotating a lathe 
profile around a lathe axis.



                 

temporarily replaced by the 

 

Mesh Form

 

 

                

 the Mesh Form modeler to edit an 
ted model or a model created in a 
nt modeler:

  

ct the model you want to edit.

  

ose 

 

Edit menu> Jump In Another 

eler

 

. The 

 

Choose another Modeler

 

 
g appears.

  

ct 

 

Mesh Form modeler

 

 from the 

 

lable Modelers

 

 list.

  

ify the fidelity for the conversion 
g the 

 

Fidelity

 

 slider. 

default, 100% divides the object’s 
ace into the recommended number 
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The Mesh Form Modeling 
Window

You work in the Mesh Form modeling 
window whenever you edit a Polymesh 

This object was created by lofting several 
cross sections of different sizes and shapes. 

modeling window, which displays a 
close-up view of the objects in the model.

The Mesh Form modeling window is used to 
edit polymesh models. 

Drawing tools Modeling Box

To use
impor
differe

1Sele

2Cho
Mod

dialo

3Sele
Avai

4Spec
usin

The 
surf
lygons. A higher percentage 
rates more polygons, providing 

e points of control. A lower 
entage generates fewer polygons. 
rdless of the fidelity of the 
ersion, some data may be lost and 
odel altered.

 OK to convert the model and open 
the Mesh Form modeling window.

model is opened in a different modeler than 
it was created in, the model is converted. This 
on can alter the object’s appearance. 
model. You can also open imported models 
and models created with other modelers in 
the Mesh Form modeler.

When you create a new Mesh Form model 
by dragging the Mesh Form Modeling tool 
to the scene window, the Mesh Form 
modeling window opens automatically. 
Your scene’s Perspective window is 

To create a Mesh Form object:

Drag the Mesh Form tool into the 
Perspective or Time Line window.

To edit an existing mesh form model:

In the Scene window, double-click the 
model you want to edit.

The model is opened in the Mesh Form 
modeling window.

of po
gene
mor
perc
Rega
conv
the m

5Click
it in 

When a 
the one 
conversi
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or axis indicator is located in the 
f the Drawing plane when you open 

 

h Form

 

 modeling window. The X 
isplayed in pink, the Y axis is 
d in red, and the Z axis is displayed 

icator shows the orientation of the 
 X, Y and Z axes and identifies its 
ll X, Y, Z coordinates for the model 
ive to the origin of the axis 
r.

ove the Drawing plane and the 
in the model, the axis indicator 
u determine the orientation of the 
and your point of view. 

t confused about which way is up, 
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When the Mesh Form modeling window is 
open, special commands are enabled in the 
menus and a new set of modeling tools 
appears in the toolbar, replacing the object 
creation and camera manipulation tools. 

The Hierarchy window automatically 
switches to the Masters tab when the Mesh 
Form modeling window is open. Changes 
you make in the Mesh Form modeler affect 
Master objects, not individual copies of 
objects. For more information on Master 
objects, refer to “Working with Master 
Objects” on page 266.

By default, opening the Mesh Form 
modeling window also opens the 
Properties palette. The tabs in the 

clicking Done at the bottom of the Mesh 
Form modeling window. If you want to 
return to the Scene window without 
preserving your changes, click Restore.

Features of the Modeling 
Window
The Mesh Form modeling window contains 
the mesh form model you’re editing. The 
window displays the objects in the model, 
the Drawing plane, and a tri-color 
axis-indicator. 

A tri-col
center o
the Mes
axis is d
displaye
in blue. 

This ind
model’s
origin. A
are relat
indicato

As you m
objects 
helps yo
objects 

If you ge

 always return to the initial view by 
g View menu>  Preset 
n> Reference.

g Preferences for the 
Form Modeler
esh Form Modeler Preferences 
ou can set preferences for the 

of the Properties palette, the 
elding tolerance, and the grid.

lt, the Properties palette is always 
d when the Mesh Form modeler is 
d Ray Dream Studio automatically 
 to the appropriate tab for the 

operation. You should normally 
ese options enabled—the 
Properties palette provide direct access to 
both object and tool properties, as well as 
action attributes you can use to alter the 
effects of certain operations. For example, 
the Action Modifier tab allows you to 
change the number of sides in a newly 
created cylinder. 

The Properties palette is not automatically displayed 
if the Properties checkbox has been disabled in the 
Mesh Form Modeler Preferences dialog. See 
“Setting Preferences for the Mesh Form Modeler” on 
page 141 for more information.

The Drawing Plane
All drawing takes place on the two-
dimensional Drawing plane displayed in the 
Mesh Form modeling window. Like the Free 
Form modeling window, the planes of the 
modeling box can be displayed, but the 
objects’ profiles are not projected onto the 
planes. By default, only the Drawing plane 

Mesh Form Drawing plane in default position 
with orientation axes. 

you can
choosin
Positio

Settin
Mesh 
In the M
dialog, y
display 
default w

By defau
displaye
open an
switches
current 
leave th
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When you’re done editing your model, you 
can return to the Scene window by 
choosing File menu> Jump Out or 

is displayed. 



   

Properties

 

 palette is integral to the 

               

mode and the preview modes. The 

 

Mesh 

                             

If the selection is a group of vertices or a 
gon, Ray Dream Studio moves the 
ing plane to the plane shared by 

e vertices. If the vertices lie in 
rent planes, the Drawing plane is 
ed so that the selected points are as 
 to the Drawing plane as possible.

ve the Drawing plane so that you 
irectly at it from the current 
oint:

e View menu> Send Drawing 
To> Screen.

ve the Drawing plane to a 
ular position:

CH08.rds5  Page 142  Wednesday, July 2, 1997  3:12 PM
operation of many polymesh modeling 
features.

The default tolerance value is used when 
you weld vertices and when vertices are 
welded as part of a Boolean operation. 
Vertices are welded if the distance between 
them is less than or equal to the default 
tolerance.

By specifying grid settings in the Mesh 
Form Modeler Preferences dialog, you can 
set up the grid for the Mesh Form modeler 
without affecting the grid settings used for 
the Scene window and other modelers. For 
more information see “Setting up the Grid” 
on page 150.

Form modeler provides the same preview 
modes as the Free Form modeler.

Changing the Drawing Plane
When editing your model, you can easily 
move and orient the Drawing plane using 
the View menu and keyboard shortcuts.

To move the Drawing plane to a preset 
position:

Choose View menu> Send Drawing 
Plane To> and select the position you 
want: Left, Right, Top, Bottom, Front or 
Back. 

These positions are relative to the Drawing 

poly
Draw
thos
diffe
mov
near

To mo
look d
viewp

Choos
Plane 

To mo
partic
ose View menu> Send Drawing 
e To> Position. The Move 
ing Plane dialog appears.

ify the X, Y, Z coordinates to which 
want to move the center of the 
ing plane.

Dream Studio centers the Drawing 
e on that vertex without changing 
lane’s orientation. 

ate the Drawing plane:

e View menu> Rotate Drawing 
 and select the direction you want 
Working in the Mesh Form 
Modeling Window

The Mesh Form modeler lets you freely 
move the Drawing plane to any plane in the 
model. When you move the Drawing plane, 
you often need to change your viewpoint to 
get a better view of the objects you’re 
working with. 

You can use the preset viewing positions in 
the View menu to change your viewpoint, 
like you can in the Free Form modeler.

When you’re viewing and editing your 

plane’s reference position, the position it is 
in when the Mesh Form modeling window 
is opened.

To align the Drawing plane with a 
selection:

1Select the vertex, polygon, or group of 
vertices with which you want to align the 
Drawing plane.

2Choose View menu> Send Drawing 
Plane To> Selection. 

If the selection is a single vertex, Ray 
Dream Studio centers the Drawing plane 
on that vertex without changing the 

1Cho
Plan

Draw

2Spec
you 
Draw

Ray 
plan
the p

To rot

Choos
Plane>
te the Drawing plane: Left, Right, 
or Back.
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model, you’ll also frequently want to 
change between the wireframe editing 

plane’s orientation. to rota
Front 



ange your viewpoint so you’re 
at the Drawing plane. (It can be 
 draw and rotate objects if you’re 

directly at the Drawing plane.)

 changing your point of view to 
 an object from all sides, it can be 
to determine the object’s position 
to other objects in the model. 
u perform a Boolean operation 

subtraction, this is particularly 
nt—you need to be sure that the 
are actually overlapping for it to 

 directly at the Drawing plane:
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The direction of rotation is specified in 
relation to the current view of the Drawing 
plane.

To move the Drawing plane back to its 
original position:

Choose View menu> Reset Drawing 
Plane.

The Drawing plane is returned the position 
it’s in when the Mesh Form modeling 
window is opened. 

To move the Drawing plane to a polygon:

1Choose the Selection tool, Sphere of 
Attraction tool, Trackball Rotation tool 
or 2D Rotation tool.

2Command-click/Ctrl+click the polygon to 
which you want to move the Drawing 
plane.

This moves the Drawing plane to the 
plane that the polygon is on. If the 
polygon’s vertices aren’t all on the same 
plane, the Drawing plane is moved to the 
plane that best represents the polygon.

often ch
looking 
easier to
looking 

Without
examine
difficult 
relative 
When yo
such as 
importa
objects 
work.

To look
View menu> Preset Position> 

g Plane or press Command-5/

 your viewpoint back to where it 
en the Mesh Form modeling 
 was first opened:

View menu> Preset Position> 

ce or press Command-0/Ctrl+0. 

 your viewpoint to the Top, 
 Left, Right, Front or Back:

View menu> Preset Position> 
ct the position you want: Top, 
, Left, Right, Front or Back.
You can also move the Drawing plane by 
Command-clicking/Ctrl-clicking when the 
Selection tool or Sphere of Attraction tool 
is active. 

Drawing plane in different positions around 
an object.

To move the Drawing plane to a vertex:

1Choose the Selection tool, Sphere of 
Attraction tool, Trackball Rotation tool 
or 2D Rotation tool.

2Command-click/Ctrl+click the vertex to 
which you want to move the Drawing 
plane.

Ray Dream Studio centers the Drawing 
plane on that vertex without changing 
the plane’s orientation. The current 
selection is not affected.

Changing your Point of View
As you edit your model, you’ll frequently 

Choose 
Drawin

Ctrl+5.

To move
was wh
window

Choose 
Referen

To move
Bottom,

Choose 
and sele
Bottom
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 also move between these preset 
s using keyboard shortcuts:
Chapter 

change your point of view. For example, 
when you move the Drawing plane, you 

You can
position



Top: Command-8/Ctrl+8 Using the Window Controls This section describes the tools provided 
Mesh Form modeler. 

 Form Modeler Arranging 

ranging tools provided in the Mesh 
odeler are designed to make it easy 

ipulate your polymesh objects. In 
n to the arranging tools available in 
ne window, the Mesh Form modeler 
es a Marquee Selection tool.

ion Tool

e Selection tool to select and move 
s, edges, polygons and entire 

s. You can also use the Selection tool 
ct and resize objects. For more 
ation about the Selection tool, refer 
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Bottom: Command-2/Ctrl+2
Left: Command-4/Ctrl+4 
Right: Command-6/Ctrl+6
Front: Command-1/Ctrl+1 
Back: Command-3/Ctrl+3

To return your viewpoint to the previous 
position:

Choose View menu> Preset Position> 
Last. 

You can also change your viewpoint with the Camera 
Dolly tool. For more information, refer to “Camera 
Dolly Tool” on page 146. 

Three controls are provided at the bottom 
of the Mesh Form modeling window:

• Done returns to the scene window, 
updating the model with your changes.

• Restore returns to the scene window 
without preserving any modifications to 
the model.

• Zoom level indicates the zoom factor at 
which the window contents are currently 
displayed. To change the zoom level, 
choose a different scale factor from the 
pop-up.

Working on the Mesh Form 

in the 

Mesh
Tools
The ar
Form m
to man
additio
the Sce
provid

Select

Use th
vertice
object
to sele
inform
e Arranging Tools” on page 224.

d vertices and edges are highlighted 
 When you select an entire object, its 
ing box is displayed and all of its 
are highlighted.

ct a vertex or edge: 

ose the Selection tool from within 
esh Form modeler.
Selecting a Preview Mode
By default, the Mesh Form modeler 
displays a Wireframe view of the objects in 
the model. To view the effects of 
operations such as emptying a polygon or 
sharpening edges, you must view the 
object in one of the preview modes. 

To switch preview modes:

Choose View menu> and choose a 
different preview mode: Preview, Shaded 
Preview, Better Preview.

Drawing Plane

To create objects with the Mesh Form 
modeler, you use the Polyline tool and the 
Polymesh primitive tools to draw 
polymeshes, cross-sections, extrusion 
paths and lathe axes and profiles. 

Like the Free Form modeler, you always 
work on a single Drawing plane. However, 
you can freely move the Drawing plane to 
any location in the model.

In the Mesh Form modeler, all vertices are 
connected by straight lines. Unlike the Free 
Form modeler, you cannot draw Bézier 

to “Th

Selecte
in red.
bound
edges 

To sele

1Cho
the M
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curves.



he selection propagates until there 
 more adjoining edges that meet 
lection criteria.

t with all of the edges in a particular 
 selected.
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2Click the vertex or edge you want to 
select. 

An object with a selected vertex.

2Click in the middle of the polygon you 
want to select. 

To select an edge and all connected 

An object with a selected polygon. 

way, t
are no
the se

An objec
direction
t a group of objects, edges, and 
:

e the Selection tool from within 
esh Form modeler.

ntil the marquee encloses the 
ts you want to select. You must 
 the drag outside of the object—to 
 a group of edges and vertices 
 an object, use the Marquee 
ion tool.

tend a selection, hold down the 
ey before selecting additional 

ts. To remove an object from the 
ion, hold down the Shift key and 
ct the object.
To select a polygon:

1Choose the Selection tool from within 
the Mesh Form modeler.

An object with a selected edge.

edges in the same direction:

1Choose the Selection tool from within 
the Mesh Form modeler.

2Double-click an edge of the polygon. 

An adjoining edge is considered to lie in 
the same direction if the angle formed 
between the selected edge and the 
adjoining edge is equal to or less than 
the Angle of Selection Propagation 
specified in the Properties palette: 
Tool Options tab. If the adjoining edge 
lies in the same direction, it is selected 
and the angles formed between it and 
any adjoining edges are evaluated. In this 

To selec
vertices

1Choos
the M

2Drag u
objec
begin
select
within
Select

To ex
Shift k
objec
select
resele
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Camera Dolly Tool

e Camera Dolly tool to move your 
int around the model. This allows 

 determine the spatial relationships 
n objects in the model. 

CH08.rds5  Page 146  Wednesday, July 2, 1997  3:12 PM
To select an entire object:

1Choose the Selection tool from within 
the Mesh Form modeler.

2Double-click any vertex or polygon in the 
object or triple-click any edge.

To use the Marquee Selection tool to 
select a group of objects:

1Choose the Marquee Selection tool from 
within the Mesh Form modeler.

2Drag until the marquee surrounds the 
objects, edges and vertices you want to 
select. 

Use th
viewpo
you to
betwee
nge your view point:

ose the Camera Dolly tool from 
in the Mesh Form modeler.

 in the Mesh Form modeler until you 
 the desired view point.

s of views of an object in the Mesh 
odeling window from different 

ns set with the Camera Dolly tool.
Marquee Selection Tool

Use the Marquee Selection tool to select 
groups of objects, vertices or edges. You 
must use the Marquee Selection tool if you 
want to select a group of vertices or edges 
within an object.

 Double-click any vertex or polygon to select 
an entire object. 

To extend the selection, hold down the 
Shift key before selecting additional 
vertices. To remove an object from the 
selection, hold down the Option/Alt key 

A group of vertices & edges within an object 
selected.

To cha

1Cho
with

2Drag
have

A serie
Form m
positio
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and reselect the object.



Form models, 2D projections of the 
in the model are not displayed on 
le planes.

he Plane Display tool:

e the Plane Display tool from 
 the Mesh Form modeler.

on the representation of the plane 
ant to show or hide.

n-click/Alt+click on the 
sentation of a plane in the Plane 
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You can also dolly the camera with the 
numeric keypad: 8 and 2 dolly the 
viewpoint up and down, 4 and 2 dolly the 
viewpoint left and right, and 1 and 3 
rotate the viewpoint around the Drawing 
plane axis. In Windows, Numlock must 
be on to dolly the camera with the 
keypad. 

The View menu allows you to change 
your viewpoint to several preset 
positions. For more information, refer to 
“Changing the Drawing Plane” on 
page 142.

Hand Tool

Use the Hand tool to adjust your view of 

Zoom Tool

Use the Zoom tool to magnify or reduce the 
window’s view. You can also zoom in and 
out with Command- +/Ctrl+ + and 
Command- –/Ctrl+ –. To switch to a 
particular magnification level, use the 
Zoom level pop-up at the bottom of the 
Mesh Form modeling window.

To use the Zoom tool:

1Choose the Zoom tool from within the 
Mesh Form modeler.

of Mesh 
objects 
the visib

To use t

1Choos
within

2Click 
you w

Optio
repre
y tool to select it as the Drawing 
.

Form Modeler Drawing 

h Form modeler provides several 
t you can use to create and edit 

in the Mesh Form modeling 

ne tool

e of Attraction tool

ertex tool

 tool

esh Primitive tool
the window contents. The Hand tool lets 
you scroll your view up, down, left or right 
without using the scrollbars. Press the 
spacebar to temporarily invoke the Hand 
tool when another tool is active.

To use the Hand tool:

1Choose the Hand tool from within the 
Mesh Form modeler.

2Drag within the Mesh Form modeling 
window to move the window’s contents 
left, right, up, or down. 

2Click in the Mesh Form modeling window 
to zoom in.

Option-click/Alt+click in the Mesh Form 
modeling window to zoom out.

Drag with the Zoom tool to zoom in on a 
particular item.

Plane Display Tool

Use the Plane Display tool to change the 
plane display in the Mesh Form modeling 
window. 

When you drag an object in the Mesh Form 
modeling window, gray altitude lines show 
the object’s position relative to the visible 

Displa
plane

Mesh 
Tools
The Mes
tools tha
objects 
window:

• Polyli

• Spher

• Add V

• Delete

• Polym
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planes. Because of the potential complexity 
• Extru



• Sweep tool When drawing with the Polyline tool, you 

 Tool

e Delete tool to remove vertices and 
from an existing object. You can also 
 Delete tool to empty a polygon.

ing a vertex also removes any edges 
ted to the vertex.

ing an edge does not affect the 
s that it connected.

ing a polygon doesn’t affect the 
s or edges surrounding the polygon. 
ly converts the polygon to a closed 
e by removing the polygon face.
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• Lathe tool

• Loft tool

• Increase Action Modifier

• Decrease Action Modifier

Polyline Tool

Use the Polyline tool to draw two and 
three-dimensional polylines. The polylines 
can be open or closed. 

add one vertex at a time. Edges are 
automatically drawn between each vertex. 

The Polyline tool is not a Bézier drawing 
tool; points in a polyline or polygon are 
always connected by straight lines.

Sphere of Attraction Tool

Use the Sphere of Attraction tool to attract 
a group of vertices in an object. The Sphere 
of Attraction tool behaves like a magnet, 
pulling the vertices and edges within its 
sphere away from their original locations.

You can set properties for the Sphere of 

Delete

Use th
edges 
use the

Remov
connec

Remov
vertice

Empty
vertice
It simp
polylin
esh Primitive Tools

e Polymesh Primitive tools to 
 create standard objects of any size:

re tool—create a sphere.

e tool—create a cube

nder tool—create a cylinder.

h tool—create a 2D array of vertices.

angle tool—create a 2D rectangle.

se tool—create a 2D ellipse.
Polylines can be used as cross sections, 
extrusion and sweep paths, and lathe 
profiles. 

A polygon and a polyline drawn with the 
Polyline tool. 

Attraction tool on the Properties palette: 
Tool Options tab. The tool options allow 
you to control:

• The shape of the attraction curve.

• The radius of the sphere of attraction.

• Whether nearby edges and vertices are 
attracted or only the selected vertices 
and edges are attracted.

Add Vertex Tool

Use the Add Vertex tool to add vertices to 
existing edges. This is useful when you 

Polym

Use th
quickly

• Sphe

• Cub

• Cyli

• Mes

• Rect

• Ellip
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need more control over the object than is 
provided with the existing vertices. 



ol

Loft tool to stretch a skin over a 
f selected polylines. For more 
tion, refer to “Lofting” on page 139.

Modifier Tools

Action Modifier Increase and 
e tools to modify the result of the 
on. These tools provide a shortcut 
nctions provided by the 
ies palette: Action Modifier 

CH08.rds5  Page 149  Wednesday, July 2, 1997  3:12 PM
You can set properties for the Sphere, 
Mesh, Cylinder and Ellipse tools, on the 
Properties palette: Tool Options tab. 
These properties affect all subsequent 
objects created with the tool.

• Mesh tool options allows you to specify 
the number of vertices in new meshes. 
The number of vertices doesn’t affect the 
size of the mesh.

• Sphere tool options allows you to specify 
the number of polygons in new spheres. A 
greater number of polygons creates a 
smoother sphere.

• Cylinder tool options allows you to 
specify the number of sides in new 
cylinders. The more sides that a cylinder 

To change newly created objects, you can 
edit the options in the Action Modifiers 
tab.

Extrude Tool

Use the Extrude tool to create an extrusion 
from a profile and an extrusion path. For 
more information, refer to “Extruding and 
Sweeping” on page 138.

Sweep Tool

Use the Sweep tool to create a sweep 

Loft To

Use the 
group o
informa

Action 

Use the 
Decreas
last acti
to the fu
Propert
y have different effects depending 
 the last action was. The + and – 
e the same effect as the Action 
 tools.

 object is created with the Sphere, 
r, Mesh or Ellipse tool, the Action 
s can be used to smooth or 
 the object by increasing or 
ing the number of polygons, edges 
es defining the object. 

ple, when you create a cylinder, 
select the Increase Action Modifier 
dd more sides to the cylinder. 
, you can use the Decrease Action 
 tool to reduce the number of 

 in a newly created mesh. 
has, the smoother its surface.

• Ellipse tool options allows you to specify 
the number of edges in the ellipse. The 
more edges an ellipse has, the smoother 
its circumference.

The actual number of polygons or sides in an object 
might differ from the value you specify in the Tool 
Options or Action Modifiers tab. For example, if you 
specify 59 as the number of polygons in a sphere and 
create a sphere, that sphere might actually contain 60 
polygons. The Properties palette: 
Numerical tab displays the actual values for a 
particular object.

object from a profile and a sweep path. For 
more information, refer to “Extruding and 
Sweeping” on page 138.

Lathe Tool

Use the Lathe tool to create a lathed object 
from a lathe profile and a lathe axis. For 
more information, refer to “Lathing” on 
page 139.

tab. The
on what
keys hav
Modifier

When an
Cylinde
Modifier
sharpen
decreas
or vertic

For exam
you can 
tool to a
Similarly
Modifier
vertices
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When you create objects with the Extrude, When you return to the Perspective 5Change the Number of Steps to control 
ize of the grid.

size of the grid is the number of 
s multiplied by the spacing 
ement. For example, if you want to 
iply the grid frequency by 2, you 
 to double the number of steps and 
ce the spacing increment by half.

u want to hide the grid lines, disable 
 Grid.

grid doesn’t have to be displayed for 
 to Grid to work.

le Snap to Grid if you want objects 
ump” to the nearest grid increment 
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Sweep, and Lathe commands, the Action 
Modifiers can be used to change which 
object is used as the cross section or 
profile.

When you use the Boolean Operations 
command, the operation defaults to the 
previous operation type (Union, 
Intersection or Subtraction). You can use 
the Action Modifiers to change operation 
types.

The Action Modifiers can also be used in 
conjunction with the Sphere of Attraction 
tool: the Action Modifiers increase and 
decrease the radius of the sphere of 
attraction.

window, the grid settings revert to the 
settings last specified in the Grid dialog.

To make global changes to the grid 
settings, choose View menu> Grid. For 
more information, refer to “Changing Grid 
Options and Color” on page 226.

To set up the grid for the Mesh Form 
modeler:

1Choose File menu> Preferences or 
press Command-Shift-P/Ctrl+Shift+P. 
The Preferences dialog appears.

2Choose Mesh Form Modeler from the 
pop-up.

the s

The 
step
incr
mult
need
redu

6If yo
Show

The 
Snap

7Enab
to “j
n you drag them.

fying the Last Action
you’re creating new objects or 
ming complex actions such as 
n Operations, you might not get the 
 you want on the first try. To make it 
to modify the results, the Mesh Form 
er provides a special feature for 
ing the last action.

n use the Action Modifier tools to 
rough changes, or you can enter 

 directly in the Properties 
e: Action Modifiers tab. The 
 modifiers are not available for all 
ions, but do allow you to change:
For more information, refer to “Modifying 
the Last Action” on page 150. 

Setting up the Grid
You can use the grid to precisely position 
objects on the Drawing plane. When Snap 
To is enabled, objects are automatically 
snapped to the nearest grid intersection 
when they are dragged. By changing the 
grid, you can control where objects are 
snapped. 

You can control the grid used in the Mesh 
Form modeler independently of the grid 
used in the Perspective window and other 
modelers. To set up the grid for the Mesh 
Form modeler, you change the grid options 

3In the Grid Settings, specify the grid 
spacing increment and choose a unit 
from the pop-up.

The Spacing increment is also used for 
“nudging” (moving an object with an 
Arrow key).

4Change the Draw a Line Every value to 
control how many grid lines are drawn.

This value sets the number of 
increments between grid lines. When set 
to 1, there is one increment for every 
grid line and nudging an object moves it 
to the next grid line.

whe

Modi
When 
perfor
Boolea
results
easier 
model
modify

You ca
step th
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palett

action
operat
ly created spheres, cylinders and 
hes
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in the Mesh Form Modeler preferences. 
• New

mes



 are automatically drawn to 
ct the vertices. To constrain the 
ne to 45° angles, hold down the 
ey. 

the last vertex again to finish the 
ne.

 a closed polyline:

 the Polyline tool from within the 
Form modeler.

in the Mesh Form modeling window 
 each vertex in the polyline.

 the polyline by clicking again on 

CH08.rds5  Page 151  Wednesday, July 2, 1997  3:12 PM
• Newly created extrusions, sweeps, and 
lathed objects.

• Objects modified with the Sphere of 
Attraction tool.

• Objects created with the Boolean 
operations.

In most cases, the options that you can 
modify in the Action Modifier tab 
correspond to the Drawing tool’s options.

Creating Polymesh Objects

A polymesh object is any polymesh created 

Objects” on page 156 and “Transforming 
Polymesh Objects and Selections” on 
page 161.

To create more complex objects, you can 
generate extrusions, sweeps, lathed 
objects lofted objects in the Mesh Form 
modeler. For more information, refer to 
“Using Standard Modeling 
Techniques to Create Complex 
Polymesh Objects” on page 164. The Mesh 
Form modeler also allows you to generate 
complex objects by performing Boolean 
operations on existing objects. For more 
information. refer to “Using Boolean 
Operations to Create Complex Polymesh 
Objects” on page 167.

Edges
conne
polyli
Shift k

3Click 
polyli

To draw

1Select
Mesh 

2Click 
to add

3Close

st vertex. 

e polygons, you can fill closed 
s. For more information, refer to 
g and Filling Holes in an Object” on 
.

ng with the Polymesh 
ive Tools
 use the Polymesh Primitive tools 
e an object that you can “sculpt” 
 editing tools. The cube, sphere, or 
 is like a block of clay that you can 
 into a finished object.
in the Mesh Form modeler, or created with 
another modeler and opened in the Mesh 
Form modeler. 

Instead of just being able to manipulate an 
object’s profile or cross section, you can 
manipulate any part of a Polymesh object’s 
surface. You have complete control over all 
of the vertices and edges that describe the 
object.

This section describes how to create 
objects by drawing with the Polyline tool, 
using the Polymesh Primitive tools, and 
duplicating existing objects. For 
information about editing Polymesh 
objects, refer to “Working with Selections” 
on page 153, “Working with Vertices” on 

Drawing with the Polyline Tool
With the Polyline tool, you can draw open 
and closed polylines. The cursor changes 
to indicate when you have completed a 
polyline by closing it or clicking twice on its 
end point. 

To draw an open polyline:

1Choose the Polyline tool from within the 
Mesh Form modeler.

2Click in the Mesh Form modeling window 
to add each vertex in the polyline. 

Vertices are added to the current 

the fir

To creat
polyline
“Creatin
page 158

Drawi
Primit
You can
to creat
with the
cylinder
reshape
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page 154, “Working with Polymesh Drawing plane. Hold down the Option/
Alt key to draw vertices perpendicular to 
the Drawing plane.



For more information about Duplicate and 
ate with Symmetry, refer to 
cating Objects” on page 247.

fying Object Properties
operties palette: Numerical tab 
s the properties of the selected 

, vertices, edge or polygon. 

n use the Numerical tab to:

e selected vertices to particular X, Y, 
ordinates.

e selected objects to particular X, Y, Z 
dinates.

one vertex is selected, the Numerical 
plays the X, Y and Z coordinates of 
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To draw an object:

1Choose the Sphere, Cube, Mesh, 
Rectangle or Ellipse tool from within the 
Mesh Form modeler.

These tools all share the same space on 
the toolbar and are considered 
Polymesh Primitive tools.

2Click the Drawing plane to add the 
object. You can drag to create an object 
of a particular size.

Hold down the Shift key to constrain a 
new mesh or rectangle to a square, or to 
constrain a new ellipse to a circle.

To duplicate an object:

1Select the object you want to duplicate.

2Choose Edit menu> Duplicate or 
press Command-D/Ctrl+D.

To duplicate an object with symmetry:

1Adjust the Drawing plane so that when 
used as the mirror plane, it will reflect 
the appropriate image.

For example, if you have modeled the 
fuselage of an airplane and one wing, you 
can duplicate the wing and place it in the 
correct location if you move the drawing 

Duplic
“Dupli

Speci
The Pr
display
object

You ca

• Mov
Z co

• Mov
coor

When 
tab dis
tex.

two discontinuous vertices are 
d, the Numerical tab displays the 
e between the vertices and the 
s’ X, Y and Z coordinates.

an edge is selected, the Numerical 
plays the length of the edge and the 
d Z coordinates of the edge’s 
s. In addition, the tab displays a set 
o buttons that indicates the edge’s 
t smooth setting. Smooth indicates 
e Smooth command has been 
 to the edge, Automatic indicates 

e smooth setting is calculated from 
Duplicating Polymesh Objects
You can duplicate an object with the Edit 
menu commands Duplicate and Duplicate 
with Symmetry. 

When you choose Duplicate, a second copy 
of the object is created at the same location 
as the original. 

When you choose Duplicate with 
Symmetry, the copy created mirrors the 
original object. In the Mesh Form modeler, 
the Drawing plane is used as the mirror 
plane. This allows you to control where the 
mirrored object is placed by moving the 
Drawing plane in relationship to the object 
you’re duplicating.

place so that it bisects the fuselage 
vertically.

2Select the object you want to mirror.

3Choose Edit menu> Duplicate with 
Symmetry or press Command-Option-D/
Ctrl+Alt+D. 

the ver

When 
selecte
distanc
vertice

When 
tab dis
X, Y an
vertice
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curren
that th
applied
that th
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Objects can be duplicated with symmetry. 



 only have one saved selection at a 

 the current selection:

Selection menu> Save 

n.

re the saved selection:

Selection menu> Restore 

n.

ing the Current Selection
g the selection selects only those 
at are not part of the current 
n. 
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the crease angle, and Sharp indicates that 
the Sharpen command has been applied to 
the edge. 

To specify object properties in the 
Numerical Properties tab:

1Select the object whose properties you 
want to change.

2Choose Properties palette: 
Numerical tab.

3Directly edit the displayed values. 

By default, all values are specified in 
inches. To change units, select the units 
pop-up and choose ft, cm, m, mm, or pts.

4Click Apply.

You can
time.

To save

Choose 
Selectio

To resto

Choose 
Selectio

Invert
Invertin
items th
selectio
t the current selection:

Selection menu> Invert.

 Selections
u’re editing a complex object, you 

ant to hide parts of the object to 
easier to view and select the 
 and edges you want to work with.
When a polygon is selected, the Numerical 
tab displays the coordinates of the 
polygon’s center and the number of 
vertices in the polygon.

When one polymesh object is selected, the 
Numerical tab displays the number of 
vertices and edges in the object; the 
number of polygons or sides in the object, 
and the current crease angle.

When multiple objects are selected, the 
Numerical tab displays the number of 
selected vertices, edges, polygons and 
polymeshes.

Properties palette with Numerical tab visible 
and an edge selected.

If Auto is enabled, the changes are 
applied automatically.

Working with Selections

To make it easier to work with complex 
polymesh objects, the Mesh Form modeler 
allows you to save and restore , invert , and 
hide selections. 

Saving and Restoring Selections
When you’re working with complex 
objects, it’s often convenient to save 
selections of groups of objects so that you 
can easily reselect them.

To inver

Choose 

Hiding
When yo
might w
make it 
vertices
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 vertices hidden using the Hide 
 command.
Chapter 

Selected
Selection



Removing a vertex also removes any edges Selected vertices can be removed with the 
/Backspace key and the Edit menu> 
 command.

 also remove edges with the Remove Vertex 
leting an edge does not affect the vertices.The 
the same as selecting the edge and choosing 
ion menu> Unlink.

ng and Unlinking Vertices
n close or extend a polyline by 
 two vertices. Linking vertices 
s an edge between them. Unlinking 
s removes the edge that connects 
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To hide a selection:

1Select the vertices and edges you want to 
hide.

2Choose View menu> Hide Selection.

To reveal hidden vertices in an object:

1Select the object.

2Choose View menu> Reveal 
Vertices. 

Working with Vertices

connected to that vertex. 

To add a vertex:

1Select the Add Vertex tool from within 
the Mesh Form modeler.

Vertices removed using the Decimate 
command.

Delete
Delete

You can
tool. De
result is 
Select

Linki
You ca
linking
create
vertice
but does not affect the vertices 
lves.

a polyline does not turn it into a polygon. If 
t to create a polygon from a closed polyline, 
and choose Selection menu> Fill 
on.

 vertices:

ct the vertices you want to link.

ose Selection menu> Link.
The real power of the Mesh Form modeler 
lies in the fact that you can directly edit 
polymesh objects. By moving vertices and 
edges, adding vertices, removing selected 
vertices and edges, and joining separate 
objects, you can model just about anything 
you can imagine.

Adding and Removing Vertices
Adding a vertex provides you with another 
point that you can manipulate to modify 
the object. 

You can add and remove individual 
vertices with the Add and Remove Vertex 
tools. You can also remove selected items, 

2Click an edge where you want to add the 
vertex. The new vertex is highlighted in 
red.

You can drag with the Add Vertex tool to 
add and immediately move a new vertex.

To remove a vertex:

1Select the Delete tool from within the 
Mesh Form modeler. 

2Click the vertex you want to remove. 
Removing a vertex also removes the 
edges that connected the vertex to other 

them, 
themse

Closing 
you wan
select it 
Polyg

To link

1Sele

2Cho
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including vertices, by pressing the Delete/
Backspace key.

vertices.



e Properties palette: 
rical tab.

y the X, Y, Z coordinate for the 
 and click Apply.

 is enabled in the Properties 
e, the changes are automatically 
d.

 Vertices with the Sphere of 
ion Tool

 selectively move vertices in an 
ith the Sphere of Attraction tool. 
l behaves like a magnet, attracting 
ices within its sphere of influence.

perties palette: Tool Options 
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An edge is created to connect the 
vertices. If the two vertices are part of 
the same polygon, the polygon is divided 
into two smaller polygons.

To unlink vertices:

1Select the vertices you want to unlink.

2Choose Selection menu> Unlink.

The edge connecting the two vertices is 
removed. You can also unlink two 
vertices by clicking the edge with the 
Delete tool.

Moving Vertices and Edges

Repositioning Vertices

In the Mesh Form modeler, you can 
precisely reposition vertices by:

• Offsetting a vertex from its current 
location with the Move command.

• Changing the coordinates of a vertex with 
the Properties palette: Numerical 
tab.

To move vertices numerically:

1Select the vertex or vertices you want to 
move.

2Choose Selection menu> Move. The 
Move dialog appears. 

2Choos
Nume

3Specif
vertex

If Auto
palett
applie

Moving
Attract

You can
object w
This too
the vert

The Pro

s you to change the shape of the 

n curve, adjust the radius of the 
here of influence, and specify an 
n mode.

 set the attraction curve to one of 
files: Cubic spline, Linear, Spiky or 

e two attraction modes:

selection, attract other vertices. 
ed vertices are moved like they 
 be with the Selection tool, other 
es within the sphere of attraction 
oved towards the location of the 
ed vertices.
The power of polymesh modeling lies in the 
ability to change an object by directly 
positioning its vertices and edges. 

You can use the Object Selection tool to 
drag any selection to a new location. For 
example, you can move a polygon by 
clicking in its center and dragging it. 

When you drag a selection in the Mesh 
Form modeling window, the selection is 
moved in relationship to the current 
Drawing plane. Gray altitude lines show the 
object’s position relative to the visible 
planes. 

3Enter the amounts you want to move the 
vertices in the X, Y and Z directions and 
click OK.

Use the Move dialog to move vertices 
numerically.

tab allow
attractio
tool’s sp
attractio

You can
four pro
Bumpy. 

There ar

• Move 
Select
would
vertic
are m
select
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To move a vertex to an exact location:

1Select the vertex you want to move.



• Attract only selected vertices. Selected 3Indicate how close the vertices must be 
e welded and click OK.

Default Tolerance welds the vertices 
e distance between them is within 

efault tolerance specified in the 
h Form Modeler preferences.

Custom Tolerance allows you to 
ify the maximum distance vertices 
be from each other and still be 
ed. 

 every selected vertex welds the 
cted vertices no matter how far apart 
 are. 

ed vertices are joined into a single 
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vertices are attracted with the Sphere of 
Attraction tool, other vertices are not 
affected.

To move a group of vertices:

1Choose the Sphere of Attraction tool 
from within the Mesh Form modeler.

2In the Properties palette: Tool 
Options tab, select an attraction curve: 
Cubic spline, Linear, Spiky or Bumpy. 

3Specify the radius of the sphere of 
attraction.

4Select an attraction mode by enabling 

Welding Vertices

You can join separate objects by welding 
the vertices where they meet. 

Normally, if two vertices are within a 
specified distance from each other, they 
are welded when you use the Weld 
command. However, if welding the vertices 
would cause a single edge to be shared by 

Deforming an object with the sphere of 
attraction tool.

to b

Use 
if th
the d
Mes

Use 
spec
can 
weld

Weld
sele
they

Weld

ex.

king with Polymesh 
cts

esh Form modeler provides a 
r of ways to manipulate an object’s 
 without directly editing individual 
s and edges. This section describes 
u can:

st the position of vertices, edges, and 
gons to align two objects.

 depth to an object’s surface to give it 
Move selection, attract other vertices or 
Attract only selected vertices.

5With the Sphere of Attraction tool, select 
the vertices you want to move or attract.

6Drag the Sphere of Attraction tool in the 
direction you want to move the vertices.

To constrain the move operation to the 
direction perpendicular to the Drawing 
plane, hold down the Option/Alt key. 

more than two polygons, the vertices are 
not joined. 

To weld vertices:

1Select the vertices to be welded.

Two objects to join by welding vertices.

vert

Wor
Obje

The M
numbe
surface
vertice
how yo

• Adju
poly

• Add

ible shell.

te and fill holes in an object’s surface.
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2Choose Selection menu> Weld. The 
Weld dialog appears.

a vis

• Crea



e blue Anchor arrows to specify 
 polygon is the anchor, the one 
hould remain in its current 
on. 

 Mesh Form modeling window, the 
on highlighted in blue is the 
r. To select the other polygon as 
chor, click one of the blue anchor 
s.

 you’ve selected the anchor, click 
 align the polygons.

olygon specified as the anchor isn’t 
d. The other polygon is centered 
he anchor polygon.
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• Smooth or sharpen an object’s surface.

• Increase the number of polygons that 
describe an object’s surface, giving you 
more control over its shape and 
appearance.

Aligning Polymesh Objects
You can adjust the alignment of two 
objects by aligning part of one object with 
part of another. Using the Adjust command, 
you can align vertices, edges, or polygons. 
For example, you could use Adjust to snap 
a lid on a can by selecting one vertex on the 
lid and the corresponding vertex on the 
can.

To align an edge in one object with the 
edge in another:

1Select the two edges you want to align.

2Choose Polymesh menu> Adjust. The 
Adjust dialog appears.

3Use the blue Anchor arrows to specify 
which edge is the anchor, the one that 
should remain in its current position. 

In the Mesh Form modeling window, the 
edge highlighted in blue is the anchor. 
To select the other edge as the anchor, 
click one of the blue anchor arrows.

3Use th
which
that s
positi

In the
polyg
ancho
the an
arrow

4When
OK to

The p
move
with t
g Thickness to an Object
hickness to an object, you can 
 a straight extrusion on all or part 
rface. To make this easy, the Mesh 
odeler provides an Add Thickness 
d. 

u use this command, a straight 
n with the specified depth is 
ed on each polygon in the 
n.
To align a vertex in one object with the 
vertex in another:

1Select the two vertices you want to align.

2Choose Polymesh menu> Adjust. The 
Adjust dialog appears.

3Specify which vertex is the anchor, the 
one that should remain in its current 
position.

In the Mesh Form modeling window, the 
vertex highlighted in blue is the anchor. 
Click one of the blue anchor arrows in 
the Adjust dialog to select the other 
vertex as the anchor.

4When you’ve selected the anchor, click 
OK to align the edges.

The edge specified as the anchor isn’t 
moved. The other edge is aligned and 
centered along the anchor edge.

To align a polygon in one object with the 
polygon in another:

1Select the two polygons you want to 
align.

2Choose Polymesh menu> Adjust. The 
Adjust dialog appears.

Addin
To add t
perform
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Form m
comman
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selectio
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4When you’ve selected the anchor, click 
OK to align the vertices.



Creating and Filling Holes in an 

d empty polygons appear the same in the 
me view. To view the hole, switch to one of 
iew modes: Preview, Preview Shaded, or 
review.

a hole in an object:

ct the closed polyline that you want 
ll.

ose Selection menu> Fill 
gon.

thing and Sharpening 
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To add thickness to an object:

1Select the part of the object to which you 
want to add thickness.

2Choose Selection menu> Add 
Thickness. The Add Thickness dialog 

Object with added thickness.

Object
Polymesh objects do not have to be 
completely solid. You can cut holes in an 
object by emptying polygons on the 
object’s surface. 

You can also cut away parts of an object by 
using the Boolean Subtraction operation. 
For more information see “Using Boolean 
Operations to Create Complex Polymesh 
Objects” on page 167. 

Filled an
Wirefra
the prev
Better P

To fill 

1Sele
to fi

2Cho
Poly

Smoo

s in an Object
an object such as a sphere is 
ed, the individual polygons are 
 to appear smooth. In some cases, 
 not want smooth shading from one 
n to the next—the edge shared by 
lygons might represent a crease in 
ject’s surface. 
appears.

3Specify how thick you want the surface 
to be and then click OK.

To create a hole in an object:

1Select the polygons you want to remove 
to create the hole.

2Choose Selection menu> Empty 
Polygon.

You can also empty polygons with the 
Delete tool.

Emptying a polygon to create a hole in an 
object.

Edge
When 
render
shaded
you do
polygo
the po
the ob
ned and smoothed edges of an object.
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Sharpe



lling the Number of 
es and Edges Used to 
be an Object
h Form modeler provides three 
ds that allow you to change the 

 of vertices and edges used to 
 an object: Triangulate, Subdivide, 
imate.

polygon is triangulated, edges are 
 divide the polygon into smaller, 

ar polygons.Triangulating a 
 doesn’t affect the number of 
 in the polygon. When a polygon is 
ed, it’s triangulated and then 

 are added to divide each triangle 
 smaller triangles. Triangulating a 
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The Mesh Form modeler provides two 
different ways to smooth or sharpen edges 
on an object’s surface:

• Smoothing or sharpening selected parts 
of an object with the Smooth and Sharpen 
commands.

• Smoothing or sharpening an entire object 
by increasing or decreasing its crease 
angle. 

Setting the crease angle allows you to 
control smoothing and sharpening for an 
entire object. Polygons on the object’s 
surface that meet at an angle less than the 
crease angle, are shaded smoothly. Edges 
where polygons meet at an angle greater 
than the crease angle, are rendered as 

You can view the results in one of the 
preview modes.

To smooth edges in an object:

1Select the edges you want to smooth.

2Choose Polymesh menu> Smooth 
Edges.

You can view the results in one of the 
preview modes.

To sharpen edges in an object:

1Select the edges you want to sharpen.

Contro
Vertic
Descri
The Mes
comman
number
describe
and Dec

When a 
added to
triangul
polygon
vertices
subdivid
vertices
into four
ed polygon has no effect, but you 
divide a triangle. 

ing an object reduces the number 
es and edges in the object. 

 triangulate, subdivide, or decimate 
 object or just selected portions of 

ct. 

t with added vertices using the 
creases in the object’s surface. 

To adjust the crease angle:

1Select the object.

2Choose Polymesh menu> Set Crease 
Angle. The Crease Angle dialog appears.

3Enter a value in degrees for the crease 
Angle.

4Enable the Override edge settings 
checkbox to override the effects of the 
Smooth Edges and Sharpen Edges 
commands.

2Choose Polymesh menu> Sharpen 
Edges.

You can view the results in one of the 
preview modes.

To determine an edge’s smooth state:

Select the edge and check the Properties 
palette: Numerical tab.

three-sid
can sub

Decimat
of vertic

You can
an entire
the obje

An objec
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5Click OK to set the crease angle.
Subdivid



Triangulating an Object Subdividing an Object 2Select Selection menu> Decimate. 
Decimate dialog appears.

 Decimate dialog to decrease the 
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When you edit an object, you might create 
some large, odd-shaped polygons. When 
rendered, these polygons can make the 
object look blocky. To create more natural 
looking transitions across the surface of 
the object, you can use triangulate to add 
edges that you can adjust to create a 
smoother shape.

Triangulate can also be used in 
conjunction with the Decimate command 
to produce more satisfactory results. 

Subdividing an object adds vertices and 
edges to give you finer-grain control over 
an object’s surface.

To subdivide selected polygons:

1Select the polygons you want to 
subdivide. 

2Choose Selection menu> Subdivide. 

Decimating an Object

Decimating an object is an easy way to 
simplify imported models that contain 
more detail than you need. In some 
situations, though, decimating an object is 

The 

Use the
st the Threshold slider to specify 
ercentage of vertices to be 

oved. 

higher the threshold, the more 
ices will be removed.

ct the decimate technique to be used 
nabling either Vertex count or 
mate. 

ex count removes the percentage of 
ices specified in the Threshold 
r. 

r of vertices in your object.
To triangulate selected polygons:

1Select the polygons you want to 
triangulate. 

2Choose Selection menu> Triangulate 
Polygon.

An odd-shaped polygon triangulated. 

counter-productive—you often want more 
control over an object’s surface, not less.

To get the best results when you’re 
decimating an object, you might want to 
alternate decimating the object and 
triangulating the object. For information 
about triangulating, refer to “Triangulating 
an Object” on page 160.

To decimate an object:

1Select the object or portion of an object 
that you want to decimate.

3Adju
the p
rem

The 
vert

4Sele
by e
Deci
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vert
slide

numbe
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e Selection menu> Move. The 
 dialog appears. 

y the amounts you want to move 
ject in the X, Y and Z directions 

lick OK.

ove dialog to move an object or 
to a specific position in the 
g window.
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Decimate removes the vertices that meet 
the decimate criteria, up to the threshold 
percentage. 

5Select the decimate criteria by enabling 
either Distance or Angle.

Distance causes vertices to be removed 
based on their distance from the planes 
shared by their neighbors. 

Angle causes vertices to be removed 
based on the angles formed by the 
polygons connecting the vertices to their 
neighbors.

6Click OK when you’ve finished specifying 
the Decimate options.

For 3-dimensional objects, you can specify 
exact dimensions using the Resize 
command. Similarly, you can specify the 
exact location of a vertex by editing its 
coordinates on the Properties palette: 
Numerical tab. 

Moving an Object or Selection
You can move any selection simply by 
dragging it to a new location. For more 
precise positioning, use the Move 
command or the Properties palette: 
Numerical tab. 

You can also use the Arrow keys to nudge 
objects. 

If you hold down the Option/Alt key, the 

2Choos
Move

3Specif
the ob
and c

Use the M
sections 
Modelin
ve values increase the selection’s 
ce from the origin; negative values 

 the selection closer to its origin. 
xis indicator identifies the origin 

e model.)

fault, the values are specified in 
s. Use the units pop-up to select a 
nt unit of measure. 

t the surface of an object:

 the polygons that you want to 
 from the object.

e Selection menu> Offset. The 
Transforming Polymesh 
Objects and Selections

The Mesh Form modeler provides a 
number of ways to move, scale and rotate 
polymesh objects or parts of polymesh 
objects.

You can transform them interactively using 
the Selection , Trackball Rotation or 2D 
Rotation tools. You can also transform 
them numerically using Selection 
menu>Rotate, Resize, or Move. 

object moves perpendicular to the Drawing 
plane when it’s dragged or nudged. For 
more information, refer to “Positioning 
Objects” on page 234.

The Mesh Form modeler also allows you to 
offset selected polygons from an object’s 
surface. 

To move an object or selection 
numerically:

1Select the object or portion of an object 
that you want to move.

Positi
distan
move
(The a
for th

By de
inche
differe

To offse

1Select
offset

2Choos
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 dialog appears.
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Offset



3Specify the amount you want to move the 2Choose Selection menu> Move to constrain the scale operation to a 
ction perpendicular to the Drawing 
e hold down the Option/Alt key. 

 an object by dragging a corner of its 
ng box.
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selected polygons. 

The surface is expanded like a balloon. 
Each selected polygon is moved 
outward, perpendicular to the plane 
defined by the polygon.

Flattening Selections

In some cases, you might want to move the 
vertices in a polygon, edge, or other 
selection to the same plane. This is called 
flattening the selection. The plane that the 
vertices are flattened to depends on the 
locations of the selected vertices. 

To flatten a group of vertices, edges and 

Drawing Plane.

Scaling an Object or Selection
You can drag the corner of an object’s 
bounding box to scale it, scale the current 
selection by specifying X,Y,Z scale factors 
with the Resize command, or change an 
object’s size by specifying new X,Y,Z 

Selected vertices sent to the Drawing plane.

dire
plan

Scaling
boundi
le an object or selection 
ically:

ct the object or portion of an object 
 you want to scale.

ose Selection menu> Resize. The 
ze dialog appears. 
polygons:

1Select the objects you want to flatten.

2Choose Selection menu> Flatten. 

Moving Selections to the Drawing 
Plane

Instead of flattening selected vertices to an 
arbitrary plane, you might want to move 
them to all to the Drawing plane.

To move a group of vertices, edges or 
polygons to the Drawing plane:

1Select the objects you want to move to 
the Drawing plane.

dimensions with the Set Size command.

To scale an object:

1Select the polymesh you want to scale.

2With the Selection tool, drag one of the 
object’s bounding box corners. Drag 
away from the object’s center to enlarge 
it; drag towards the object’s center to 
reduce it. 

To scale the object around its center, 
hold down the Command/Ctrl key. To 
constrain the scale operation to equal 
proportions, hold down the Shift key. To 

To sca
numer

1Sele
that

2Cho
Resi
 Resize dialog to scale an object or 
n numerically.
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rotate an object relative to the 
g plane:

e View menu> Preset 
ion> Drawing Plane. 

ts are rotated with respect to the 
t Drawing plane. It is easier to 

ve the effect of the rotation if you 
oking directly at the Drawing plane.

e the 2D Rotation tool from within 
esh Form modeler.

o rotate the object to a new 
ation.
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3Enter the X, Y and Z scale factors and 
click OK.

The scale factors are specified in 
percentages. For example, to reduce an 
object to half its original size in all 
dimensions, specify X, Y and Z scale 
factors of 50%.

To set the size of an object:

1Select the object whose size you want to 
set. 

You can only set the size of 
3-dimensional objects. To resize objects 
whose vertices all lie on the same plane, 

Rotating an Object or Selection
You can rotate an object freely in three 
dimensions, or in relationship to the 
Drawing plane. With the Rotate command, 
you can rotate an object a specific amount 
around the X, Y, or Z axis.

To free rotate an object in three 
dimensions:

1Choose the Trackball Rotation tool from 
within the Mesh Form modeler.

2Drag to rotate the object to a new 
orientation.

The cursor must be over the object you 

To free 
Drawin

1Choos
Posit

Objec
curren
obser
are lo

2Choos
the M

3Drag t
orient
ursor must be over the object you 
to rotate when you begin dragging. 
an Shift-click other objects to 
 them at the same time. To 
rain the rotation to 45° increments, 
own the Shift key while you drag. 

te an object or selection 
ally:

 the object or portion of an object 
ou want to rotate.

e Selection menu> Rotate. The 
 Selection dialog appears.

 the axis of rotation. 
use the Resize command.

2Choose Polymesh menu> Set Size. 
The Set Polymesh Size dialog appears.

3Enter the new X, Y, and Z dimensions for 
the object and click OK.

The object is resized so that its bounding 
box matches the dimensions you specify.

want to rotate when you begin dragging. 
You can Shift-click other objects to 
rotate them at the same time. 

Rotating an object with the Trackball 
Rotation tool.

The c
want 
You c
rotate
const
hold d

To rota
numeric

1Select
that y

2Choos
Rotate

3Select
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The rotation is constrained to one axis of Using Standard Modeling For more information about editing Free 
odels in the Mesh Form modeler, 
 “Working in the Mesh Form 

ing Window” on page 142.

ction describes how to use the Mesh 
odeler to create extrusions, 

s, lathed objects and lofted objects.

not extrude, sweep, loft, or lathe polygons 
 Mesh Form modeler. If you want to use a 
 in an existing polymesh object as a cross 
convert the polygon to a closed polyline by 
g it.
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rotation. 

4Specify the angle of rotation and click 
OK.

Use the Rotate dialog to rotate an object or 
selection rotate using a specific axis and 
angle.

Techniques to Create 
Complex Polymesh Objects

You can use the standard modeling 
techniques introduced with the Free Form 
modeler to create complex objects in the 
Mesh Form modeler. The Mesh Form 
modeler supports:

• Extrusions

• Sweeps

• Lathed objects

• Lofted objects

Form m
refer to
Model

This se
Form m
sweep

You can
with the
polygon
section, 
emptyin
ding and Sweeping 
on and Polyline Cross 

ons
ing or sweeping a polygon creates an 
 similar to that created with the Free 

odeler. You can use an open or 
 polyline to define the cross section 
xtrusion or sweep. Using an open 
e as a cross section creates a shell 
e shape of the polyline. 

oss section can be a separate 
e object, or a set of selected edges in 
r object.

trusion or sweep path is also defined 
lyline. The vertices of the extrusion 

o not need to lie in the same plane, 
The angle of rotation is specified in 
degrees. Positive values rotate the object 
clockwise around the axis of rotation 
(looking away from the origin), negative 
values rotate the object 
counterclockwise. 

For general information about these 
techniques, refer to “Free Form Modeling” 
on page 109.

You should use the Mesh Form modeler to 
create these types of objects when you 
want to:

• Edit the surface of the resulting object.

• Create extrusions or sweeps with 
3-dimensional cross sections or sweep 
paths.

• Use the resulting object to perform 
Boolean operations.

If the object you are modeling is easier to 
describe using Bézier curves, you can 

Extru
Polyg
Secti
Extrud
object
Form m
closed
of an e
polylin
with th

The cr
polylin
a large

The ex
by a po
path d
g you to easily define complex, 
imensional extrusion paths. 
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create the object in the Free Form modeler 
and then edit it in the Mesh Form modeler. 

allowin
three-d



 the extrusion path is set, click 
 to generate the extrusion.

 is enabled in the Properties 
e, the changes are automatically 
d.

te a sweep:

 a cross section using the Polyline 
r select an existing polyline or 
on to use as the cross section.

the sweep path with the Polyline 
r select an existing polyline to use 
 path.
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Like cross sections, the extrusion path can 
be defined by a separate polyline object or 
a set of selected edges in a larger object.

When a cross section is extruded, the orientation of 
the cross section remains constant along the extrusion 
path. When a cross section is swept along a path, the 
orientation of the cross section changes so that it 
always remains perpendicular to the path. 

3Specify the depth of the straight 
extrusion and click OK.

To create a complex extrusion:

1Create a cross section using the Polyline 
tool or select an existing polyline to use 
as the cross section.

2Draw the extrusion path with the 
Polyline tool or select an existing 
polyline to use as the path.

3Select the cross section and extrusion 
path.

4Choose Selection menu> Extrude.

6When
Apply

If Auto
palett
applie

To crea

1Create
tool o
polyg

2Draw 
tool o
as the
 the polygon and the polyline.

e Selection menu> Sweep.

e blue arrows in the Properties 
te: Action Modifier tab to set 
trusion path. 

 Mesh Form modeling window, the 
t selected as the sweep path is 
ghted in blue and the cross section 
lighted in red. The starting vertex 

 sweep path is also highlighted in 

ange the object selected as the 
 path, click one of the double 
To create a straight extrusion:

1Create a cross section using the Polyline 
tool or select an existing polyline to use 
as the cross section.

2With the cross section selected, choose 
Selection menu> Extrude. The 
Extrude Options dialog appears.

The same cross section extruded and swept.

5Use the blue arrows in the Properties 
palette: Action Modifier tab to 
change which selection is used as the 
extrusion path. 

In the Mesh Form modeling window, the 
object selected as the extrusion path is 
highlighted in blue and the cross section 
is highlighted in red. The starting vertex 
in the extrusion path is also highlighted 
in blue. 

To change the object selected as the 
extrusion path, click one of the double 
arrows. To change the starting point on 
the selected extrusion path, use the 

3Select

4Choos

5Use th
palet

the ex

In the
objec
highli
is high
in the
blue. 

To ch
sweep
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s. To change the starting point on 
lected path, use the single arrows. 
Chapter 

single arrows. arrow
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6When the sweep path is set, click Apply 

e an object:

te the lathe profile with the Polyline 
, or select a set of connected edges 
se as the lathe profile.

ine lathe profile and the object that 
from Lathing.
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to generate the extrusion.

If Auto is enabled in the Properties 
palette, changes are automatically 
applied.

Modeling with Polygon and 
Polyline Cross Sections 
Lofting enables you to stretch a surface 
over a series of cross sections. In the Mesh 
Form modeler, these cross sections can be 
defined by open or closed polylines. 

Like the cross sections used for extrusions 
and sweeps, these cross sections can be 
separate polyline objects or selected edges 
in a larger object.

To loft an object:

1Create the cross sections with the 
Polyline tool or choose existing 
polylines to use as cross sections.

2Select the cross sections.

Two polylines and the object that results 
when they’re lofted.

To lath

1Crea
tool
to u

A polyl
results 
te a lathe axis with the Polyline tool 
lect an existing edge to use as the 

. 

lathe axis must be a line defined by 
vertices. 

ct the lathe profile and the lathe axis.

u do not select a lathe axis, Ray 
m Studio revolves the selected lathe 
ile around the axis formed by 
ing a line from the first vertex in the 

ile to the last vertex in the profile. In 
case, the lathe profile must be an 
 polyline.

ose Selection menu> Lathe.
You can define as many cross sections as 
you need, but all of the cross sections for a 
single lofted object must be either open 
polylines or closed polylines, you cannot 
mix them. To be lofted, the cross sections 
must lie on different planes.

In certain situations, not all of the cross 
sections you define are used. This might 
happen if two of the cross sections lie very 
close to the same plane—one of them is 
used and the other ignored.

3Choose Selection menu> Loft.

Lathing with Polygon and 
Polyline Profiles
When you lathe objects in the Mesh Form 
modeler, you control both the lathe profile 
and the lathe axis. The lathed object is 
created by revolving the profile around the 
specified axis. The lathe profile is always 
rotated a full 360 degrees around the axis.

Both polylines and polygons can be used as 
lathe profiles. The lathe axis can by defined 
by any edge.

2Crea
or se
axis

The 
two 

3Sele

If yo
Drea
prof
draw
prof
this 
open

4Cho
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u subtract object B from object A, 
s of object A that are encompassed 
t B are removed. For example, if 

e two overlapping spheres and 

 two objects joined using Boolean 
ion.
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5Use the blue arrows in the Properties 
palette: Action Modifier tab to set 
the lathe axis.

In the Mesh Form modeling window, the 
object selected as the lathe axis is 
highlighted in blue, and the lathe profile 
is highlighted in red.

To change the object selected as the 
lathe axis, click one of the blue arrows in 
the Properties palette: Action 
Modifiers tab. 

6Specify the number of steps for the 
lathed object. 

A greater number of steps produces a 

performed on two overlapping volumes. 
Both volumes should be closed—holes in 
the surface of a volume can prevent 
Boolean operations from producing the 
desired results.

The union of two objects is an object whose 
surface encompasses the visible surfaces 
of both objects. For example, if you spray-
paint two overlapping spheres, the painted 
surface represents the union of the two 
spheres.  

When yo
the part
by objec
you hav

Result of
Intersect
 one from the other, the resulting 
esembles a sphere with a large 
smoother object.

7Click Apply to generate the extrusion.

If Auto is enabled in the Properties 
palette, changes are automatically 
applied.

Using Boolean Operations 
to Create Complex 
Polymesh Objects

The Boolean operations; Union, 
Subtraction and Intersection are used to 

If you take the intersection of two objects, 
the resulting object is the volume shared 
by both objects. For example, if you take 
the intersection of two overlapping 
spheres, the resulting object resembles a 
flying saucer.

Two objects joined using the Boolean Union. 

subtract
object r
crater. 
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produce a complex object from two 
simpler objects. Boolean operations are 



Using normal modeling techniques, this might also want to check the Properties 
e: Numerical tab to verify the 
n of particular vertices in an object.

bjects that appear to adjacent when 
 from reference....
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Boolean subtraction is similar to the concept of 
compounding shapes in the Free Form modeler. 
However, compounding shapes only enables you to 
create holes through extruded objects. Boolean 
subtraction enables you to work directly with 3D 
objects and remove overlapping volumes.  

would be nearly impossible, but with 
Boolean subtraction it’s easy. You could:

1Extrude a circle along a path defined by a 
polyline to form an object that looks like 
a bent pipe. 

2Align the sphere and the cylinder object.

3Subtract the cylinder object from the 
sphere.

palett

locatio

Some o
viewed
you use the Boolean Operation 
nd, Ray Dream Studio automatically 

ms the last selected Boolean 
ion on the selected objects. You use 

not be adjacent when viewed from 
r perspective.
Note: When you perform a Boolean 
operation, you lose the UV coordinates of 
the original objects and surface shading 
can become much more complex. 

Using Boolean operations enables you to 
quickly produce certain types of complex 
models. For example, suppose that you 
want to create a cylindrical hole through a 
sphere that originates on the top of the 
sphere and exits to the sphere’s left side. 

Results of two objects joined using Boolean 
Subtraction.

Before performing a Boolean operation, it 
is important to verify that the objects are 
aligned the way that you want them. You 
should look at the objects from a variety of 
viewpoints to verify that their alignment 
will produce the intended results. You 

The object that results when you Boolean 
Subtract a bent pipe from a sphere.

When 
comma
perfor
operat

...may 
anothe
operties palette: Action 
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ing Polymesh Objects

 situations, you need to specify the 
 mode for a model to get the 
ou want. The Mesh Form modeler 

s additional control by allowing you 
fy how shaders are mapped to 
al objects in a model. 

ying an Object’s Mapping 

on to the three projection mapping 
upported at the scene level, the 
rm modeler supports a custom 
at allows you to specify UV 
ates for particular vertices. For 
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Modifiers tab to switch between the 
Union, Intersection, and Subtraction 
operations. 

If you enable Auto in the Properties palette, 
you’ll be able to see the results 
immediately when you switch between 
operations. 

To join two objects:

1Align and select the objects you want to 
join.

2Choose Polymesh menu> Boolean 
Operation.

Ray Dream Studio automatically 

Ray Dream Studio automatically 
performs the last selected Boolean 
operation.

3On the Properties palette: Action 
Modifiers tab, enable Intersection.

4If Auto is not enabled in the Properties 
palette, click Apply to perform the 
intersection.

To subtract one object from another:

1Align and select the objects.

2Choose Polymesh menu> Boolean 
Operations.

Shad

In some
mapping
results y
provide
to speci
individu

Specif
Mode
In additi
modes s
Mesh Fo
mode th
coordin
ormation about mapping modes, 
“Advanced 3D Paint Topics” on 
.

ify mapping modes for individual objects in 
 Form modeler, and then specify a projection 

ode for the entire model at the scene level, 
 you specified in the Mesh Form modeler 
den. To use the settings specified in the 
m modeler, use the Parametric Mapping 
e scene level.
performs the last selected Boolean 
operation.

3On the Properties palette: Action 
Modifiers tab, enable Union.

4If Auto is not enabled in the Properties 
palette, click Apply to perform the union.

To create an object that is the 
intersection of two objects:

1Align and select the objects.

2Choose Polymesh menu> Boolean 
Operations.

Ray Dream Studio automatically 
performs the last selected Boolean 
operation.

3Enable Auto at the bottom of the 
Properties palette.

When Auto is enabled, you can 
immediately view the difference between 
the two subtraction operations. 

4On the Properties palette: Action 
Modifiers tab, enable Subtract A from 
B or Subtract B from A.

more inf
refer to 
page 191

If you spec
the Mesh
mapping m
the modes
are overrid
Mesh For
mode at th
8 • Mesh Form Modeling 169
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• Interpolate sets the U or V value for the 
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To change an object’s mapping mode:

1Select the object.

2Choose Properties palette: 
Mapping mode tab.

3Choose a mapping mode from the tab 
pop-up: Custom, Box/Face, Cylindrical, 
or Spherical.

Custom specify the technique to be used 
to map the UV coordinates to the 
selected vertex or vertices. For more 
information, refer to “Defining a Custom 
Mapping Mode for an Object” on 
page 170.

selected vertex or vertices using the UV 
values for the nearest vertices that are 
specified.

• Keep Current Value locks the current 
specified U or V value.

When you enable Wrap, the shader is 
wrapped around the object from the 
specified U or V coordinate.

To view the UV coordinates that are set 
for a particular vertex:

1Select the vertex and choose Polymesh 
menu> Shader Mapping.

2In the Properties palette: Mapping 
Box/Face choose the face you want to 
map onto.

Cylindrical or Spherical choose the 
orientation of the mapping primitive.

Defining a Custom Mapping 
Mode for an Object
When you choose Custom mapping mode 
in the Properties palette: Mapping 

mode tab you can specify how UV 
coordinates from the shader should be 
applied to the selected vertex or group of 
vertices. 

There are two options for applying uv 
coordinates to the selection:

mode tab, select Custom.

The current U and V values are displayed 
in the Specify fields. 
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Deformers

 

Using Deformers

 

Deformers are a special set of tools that let 
you easily manipulate objects in ways that 
would normally require a large number of 
arranging and remodeling operations.

For example, using the Explode deformer, 
you can make an object appear to explode 
by setting only a few parameters. Without 
the Deformer, you would have to remodel 
the object several times to achieve the 
same effect. 

Deformers can also be animated. So you 
can create complicated animation effects 
like morphing and dissolves by simply 
applying different Deformers to your 
objects. 
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Applying Deformers

                                                        

4

 

Click the 

 

Direct Manipulation

 

 button. 
Deformers control handles appear in 

 

erspective

 

 window. 

  

ot all Deformers have 

 

Direct 
ulation

 

 controls.

 

 the Atomize Deformer

  

omize

 

 deformer replaces the surface 
selected object with small balls 
are then slightly scrambled or 
d.

             

CH09.rds5  Page 172  Wednesday, July 2, 1997  3:29 PM
You can access all the Deformer available 
in Ray Dream from the Deformers tab on 
the Properties palette. Each Deformer has 
its own settings but they’re all applied in 
the same way.

To apply a Deformer:

1Select the object or group you want to 
deform.

2Open the Properties palette by choosing 
Windows men> Properties.

3Click the Deformers tab. If the tab is not 
visible, use the scroll buttons at the top 

To apply multiple Deformers:

1Apply the first Deformer. 

2Put the object in a group by itself using 
the Group button. 

3Apply the second Deformer to the new 
group.

Controlling a Deformer Directly

The Direct Manipulation controls let you 

Use the Group button to group the selected 
object.

The 
the P

Note: N
Manip

Using
The At
of the 
which 
wiggle
 Atomize deformer attributes:

he Properties 
tte:Deformers tab, adjust the 
e of the Completion of Wiggle Effect 
r.

Completion of Wiggle Effect slider 
rols the amount of movement the 
 display as they move. When 
ating this Deformer, you would set 

ou apply the Atomize deformer to an 
its surface is replaced with small balls.
of the palette.

4Select the Deformer you wish to apply 
from the pop-up.

5Select the Deformer’s properties 
parameters by adjusting the value of its 
sliders and enabling the relevant 
options.

6Click Apply. The Deformer is applied to 
the object.

Only one Deformer can be selected at any 
given time, so if you want to combine the 
effects of multiple Deformers (a Stretch and 
a Twist for instance) to an object, you need 
to stack them up using artificial group 

adjust the Deformers attributes directly on 
the object. Direct manipulation controls 
appear as a set of wires with “handles” at 
certain points. The handles represent 
attributes you can change by dragging.

To display the Direct Manipulation 
controls on a Deformer:

1Select an object.

2Display the Properties palette> 
Deformers tab and apply a Deformer to 
the object.

3Click Auto.

To set

1On t
Pale

valu
slide

The 
cont
balls
anim

When y
object 
alue of this slider to 0% at the first 
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e 

 

Twist

 

 axis, drag one of the corner 
 clockwise, or counter-clockwise 

st the object.

  

e twist axis, drag one of the middle 
up or down to bend the object.

 

the Black Hole Deformer

  

k Hole

 

 deformer creates a vortex 
milar to the way water swirls as it 
sucked down a drain. In an 
n the 

 

Black Hole

 

 deformer creates 
g, circular motion that tends to 

avity or vacuum at the center of its 
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frame and 100% at the final frame. A 
setting of 600% may result in the same 
position as a setting of 0%.

2Adjust the value of the Particle Density 
slider.

This slider controls the number of balls 
created to cover the surface of the 
object.

3Adjust the value of the Particle Size 
slider.

This slider controls the size of the balls 
on the object’s surface.

Using the Bend and Twist 

The bend and bend axis respectively 
control the amount and direction of the 
bend, while the twist, twist start and twist 
size define the amount of twist and portion 
of the object on which the twist is applied.

To directly control the Bend and Twist 
deformer:

1Click the Direct Manipulation button on 
the Properties palette:Deformer 
tab. A bounding box with twelve points 
appears around the object.

3On th
points
to twi

4On th
point 

Using 
The Blac
effect, si
is being 
animatio
a whirlin
form a c
action.
lack Hole attributes:

e Properties 
te:Deformers tab, adjust the 
of the Completion of Hole 
nce slider.

k Hole deformer creates a vortex 
Deformer
The Bend and Twist deformer bends and/
or twists the surface of an object. This 
Deformer is particularly useful for fine 
tuning complex models such as bent 
compound shapes that are otherwise tricky 
or impossible to achieve.

2Enable a Twist axis button. These 
buttons let you select the axis to which 
the twist will be applied. 

When you select an axis the bend and 
twist controls on the object’s bounding 
box move to the selected axis.

Use the Bend and Twist deformer’ s direct 
manipulation controls to set the Deformer’s 
attributes in the Perspective window.

To set B

1On th
Palet

value 
Entra

The Blac
effect.
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You can add bends and curves to an object 
by applying the Bend and Twist deformer.



   

The 

 

Completion of Hole Entrance

 

 slider 

                                 

Using the Explode Deformer 

  

plode

 

 deformer causes the object to 
part.

 

 Explode attributes:

             

 Explode deformer to break an object 
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controls the state of the vortex. Set this 
value to 0% at the beginning of an 
animation, and 100% at the end.

2Adjust the value of the Winding slider.

This slider controls the rotation as the 
Black Hole deforms. A negative setting 
creates a counterclockwise rotation.

3Adjust the value of the Spin Speed slider.

The Spin Speed slider controls how fast 
the object turns as it goes down the 
vortex

4Adjust the value of the Suck Down Point 

To set Dissolve attributes:

1On the Properties 
Palette:Deformers tab, adjust the 
value of the Completion slider.

Use the Dissolve deformer to convert an 
object’s surface to triangles and polygons 
that fade.

The Ex
burst a

To set

Use the
apart.
he Properties 
tte:Deformers tab, adjust the 
e of the Completion of Explosion 
r.

 slider controls how much the object 
exploded. In an animation, set this 
e to 0% in the first frame and 100% in 
ast. If you apply gravity, the pieces 
ually fall to the ground as the 
osion progresses.

st the positions of the controls in 
ize of Pieces slider.

 slider controls the range of sizes for 
ieces created by the explosion. The 
Below Object slider.

This slider controls how far below the 
object the center of gravity is placed. A 
low setting results in little gravity pull 
while a high setting results in a stronger 
pull.

Using the Dissolve Deformer
The Dissolve deformer reduces the object 
to triangles or polygons then diminishes 
the object so that it gradually fades away or 
disintegrates. You can use this Deformer to 
create interesting sci-fi effects such as a 
transporter or a mummy dissolving before 
your face in a horror movie.

This slider controls how much the object 
has dissolved. In an animation, set this 
value to 0% in the first frame and 100% in 
the last.

2Adjust the value of the Size of Pieces 
slider.

This slider controls the size of the piece 
the object dissolves into.

1On t
Pale

valu
slide

This
has 
valu
the l
grad
expl

2Adju
the S

This
the p
r contains two controls. The right 
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Formula Deformers
mula deformers uses mathematical 
s to deform the selected object. 

 use the Formula Editor to input 
s, operators and parameters. 
 deforming is a very technical 
, for more information on using 
s refer to the “Using Formulas in 
am Studio 5” PDF on the Ray Dream 
 CD.

the Punch Deformer
ch deformer punches a dent into 
t or bulge it outward.
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control sets the size of the largest pieces 
while the left control sets the size of the 
smallest pieces.

With the left control set to the far left 
(0%) and the right control set to the far 
right (100%) you will have the greatest 
variety of sizes for the pieces. With the 
two controls set close together the 
difference between the largest and 
smallest pieces will be less dramatic.

Use the Size of Pieces slider to set the size of 
the exploded pieces.

The Gravity slider controls how much 
gravity is applied to the pieces. The 
higher the setting, the faster the pieces 
fall downward.

5Adjust the value of the Slow Down at End 
slider.

This slider controls the rate at which the 
pieces slow down as they get farther 
from the center of explosion.

6Adjust the positions of the controls in 
the Rotational Speed slider.

The Rotational Speed controls the speed 
at which the pieces rotate as they move 
away from the original position of the 

Using 
The For
equation
You can
variable
Formula
process
formula
Ray Dre
Studio 5

Using 
The Pun
an objec
unch deformer to dent or bulge an 
3Adjust the positions of the controls in 
the Speed slider.

The Speed slider controls the speed of 
the pieces as they move away from the 
original position of the object. The slider 
contains two controls. The left control 
sets the speed for the slowest moving 
particles while the right control sets the 
speed for the fastest moving particles

With the left control set to the far left 
(0%) and the right control set to the far 
right (100%) you will have the greatest 
variety of speed.

object. The slider contains two controls. 
The left control sets the speed for the 
slowest moving pieces while the right 
control sets the speed for the fastest 
moving pieces

7Enable the Large Pieces Move Slower 
checkbox if you want larger pieces move 
more slowly during the explosion.

8Enable the Pieces Stop At Bottom 
checkbox if you want all the pieces stop 
falling when they reach the bottom of the 
original object’s bounding box.

9Enable the Explode from Top Down 
checkbox if you want the object to 

Use the P
object.
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4Adjust the value of the Gravity slider.
explode starting from the top then 
working down to the bottom.



5Drag one of the corner handles away 

ectly control the Shatter deformer:

 the Direct Manipulation button. A 
ding box with eight points appears 
nd the object.
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To directly control the Punch deformer:

1Click the Direct Manipulation button. A 
square with five points appears in front 
of the object.

Use the Punch deformer’s direct 

from the center of the square to increase 
the Punch Radius, or towards the center 
to decrease the radius.

Using the Shatter Deformer
Shatter is a very simple, facet based 
Deformer you can use to simulate object 
explosions. Since the Deformer only works 
at the facet/patch level, it will work best on 
non patch based objects (for example, 
imported objects or objects created in the 
Mesh Form modeler). When applied to 
objects made with Ray Dreams’s Free Form 
modeler, the shatter will only separate the 
patches that make up the surface of the 
object from each other. This results in a 
coarse grained shatter effect.

To dir

1Click
boun
arou
 a point on the box away from the 
ct to increase the scale of the 
ter, or drag towards the object to 
ease the shatter scale.

 Shatter deformer’s direct 
lation controls to set the Deformer’s 

tes in the Perspective window.

2If necessary, click the Orientation menu 

and choose an axis. 

The punch controls move to the selected 
axis.

3If necessary, enable the Punch Other 
Side checkbox to place the dent on the 
other side of the object.

4Drag the center point on the square 
towards the object to increase the 
strength of the Punch, or away from it to 
decrease the strength. Dragging away 

manipulation controls to set its attributes in 
the Perspective window.

The Shattered deformer separates the 
patches that make up an object’s surface.

2Drag
obje
shat
decr

Use the
manipu
attribu
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from the object creates a bulge instead of 
a dent.



lider lets you set the radius of the 
.

t the value of the Messiness slider.

essiness slider controls how wavy 
ikes appear. A low setting results 
ly straight spikes while a high 
g results in very wavy spikes.

t the value of the Flow slider.

low slider works with Messiness 
ontrols the wiggles of the spikes 
 animations. The higher the value, 

ore the spikes will appear to move.

t the value of the Gravity slider.
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Using the Spherical Morph 
Deformer
The Spherical Morph deformer turns the 
selected object into a sphere. 

The Spherical Morph turns any selected 
object into a sphere.

Using the Spike Deformer
The Spike deformer adds needle-like 
pointed spikes to the selected object. Use 
the Spike deformer to add stubble to a 
character’s chin or create a field of grass, 
blowing in the wind. 

This s
spikes

4Adjus

The M
the sp
in fair
settin

5Adjus

The F
and c
during
the m

6Adjus
ravity slider controls the strength 
vity on the spikes.The higher the 
 the more the spike will bend 
ward.

e the Keep Original Object 
box if you want to keep the original 
t while adding the spikes around it. 
le it to replace the object with 
.

To set Spherical Morph attributes:

1On the Properties 
Palette:Deformers tab, adjust the 
value of the Completion slider.

This slider controls the morphing of the 
object into a sphere. In an animation, set 
this value to 0% in the first frame and 
100% in the last frame.

To set Spike attributes:

1On the Properties 
Palette:Deformers tab, adjust the 
value of the Spike Density slider.

This slider sets the number of spikes 
applied to an object.

2Adjust the value of the Length slider.

The Length slider controls the length of 
the spikes.

The Spikes deformer creates needle point 
shapes over the surface of an object.

The G
of gra
value,
down

7Enabl
check
objec
Disab
spikes
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3Adjust the value of the Radius slider.



Using the Stretch Deformer Note: The Warp deformer has no effect on 
s because all the surface points are 
e distance from the center.

ou apply the Warped deformer the 
is distorted by reversing its surface 
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The Stretch deformer is particularly 
suitable for simulating the exaggerated, 
cartoon-style effects of squash and stretch 
motions. A squashed object will seem to 
bulge; a stretched one will elongate itself 
while thinning in its middle, almost like 
chewing-gum!

To directly control the Stretch deformer:

1Click the Direct Manipulation button. A 
bounding box with eight points appears 
around the object.

Use the Stretch deformer’s direct 

sphere
the sam

When y
object 
points.
 Warp attributes:

he Properties 
tte:Deformers tab, adjust the 
e of the Warp Strength slider.

Warp Strength slider controls the 
unt of distortion. A negative setting 
es surface points near the center 
y from the center and surface points 
rom the center in toward the center. 
sitive setting moves surface points 
om the center farther away from the 
er and points near the center closer 
e center.
The stretch axis indicates the axis along 
which the stretch/squash will occur. Any 
percentage value lower than 100% will 
cause the object to be compressed and 
bulge; any value greater than 100% will 
elongate and thin the object or group 
selected.

Use the Stretched deformer to elongate an 
object.

2Select an axis to stretch along.

3Drag a point on the box away from the 
object to stretch it, or drag towards the 
object to squash it.

Using the Warp Deformer 
The Warp deformer takes the object’s 
surface points that are farthest from the 
center of the object and moves them out 
farther. At the same time, surface points 
that are nearest the center of the object 
move in closer to the center.

manipulation controls to set the Deformer’s 
attributes in the Perspective window.

To set
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l: Wave moves from center point 
rd.

rical: Wave moves around the 
e of the object as if it were in a 
er.

t deformed using a Radial wave.
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Using the Wave Deformer
The Wave deformer distorts the object by 
pulling it along an imaginary wavy sweep 
path. Use this Deformer to simulate air or 
water currents.

Apply the Waves deformer to distort an 
object along a wavy sweep path.

2Click the Properties palette> 
Deformer tab> Orientation menu 
and choose an axis. 

The height and phase controls move to 
the selected axis.

3Adjust the value of the Number of Wave 
Cycles slider to set the number of waves 
applied to the object.

4Click the Properties palette> 
Deformer tab> Shape menu and 
choose a shape for your wave. 

Planar A: Wave moves along the plane A.

Radia
outwa

Cylind
outsid
cylind

An objec
irection in which the wave is 
d depends on the setting in the 
tation box. 

ne of the corner handles to adjust 
ight of the wave. Dragging away 
he object increases the wave’s 

t.

ding on the type wave you 

t deformed using Cylindrical waves.
To directly control the Wave deformer:

1Click the Direct Manipulation button. A 
bounding box with a number of control 
handles appears around the object.

Planar B: Wave moves along the plane B.

An object deformed using Planar A wave. The d
applie
Orien

5Drag o
the he
from t
heigh

6Depen

An objec
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ed you can adjust the Phase of the 
 in a number of ways:
Use the Wave deformer’ s direct 
manipulation controls to set the Deformer’s 
properties in the Perspective window.

An object deformed using a Planar B wave.
select
waves



For Planar A and B waves move the 
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center handles left or right to adjust the 
phase.

For Radial waves you can move the 
handles towards or away from the 
objects center. As you move towards the 
middle of the object, its center appears 
to sink, as you move away, its center 
bulges up.

For Conical waves you can move the 
center handles up or down to adjust the 
phase.
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10

 

Shading Objects

 

Applying Shaders

 

This chapter explains shading, the process 
of assigning surface properties to your 
objects. By designing and applying 
shaders, you can precisely control the 
color, texture, and finish on your objects.

Ray Dream Studio’s drag and drop interface 
for applying shaders makes shading easy. 
You’ll keep a collection of shaders in the 

 

Browser

 

 palette’s 

 

Shaders

 

 tab and simply 
drop them onto your objects in the 

 

Perspective

 

, 

 

Free Form

 

, or 

 

Mesh Form

 

 
modeling window.
Cha



   

Shading Overview

   

Shading allows you to describe which 

                       

3D Paint

 

eal-world objects have non-uniform 
s. Variations on an object’s surface 

be as simple as a painted-on logo, or 
plex as an intricate inlaid wood 
.

ieve effects such as these, you can 
y Dream Studio 5’s 

 

3D Paint

 

 tools.

 

D Paint

 

 tools allow you to apply 
nt shaders to various regions on the 
 of an object. These regions, called 
hapes, may take the form of 

     

n use the 3D Paint tools to place paint 
 on objects.
Using a process called shading, you can 
assign a variety of surface characteristics 
to each object in your scene. When Ray 
Dream Studio renders your final artwork, 
these characteristics determine whether an 
object appears rough or smooth, shiny or 
dull, transparent or opaque.

objects are glass and which are wood, 
metal, stone, skin, painted or otherwise.

Shaders
A shader is a set of surface characteristics. 
Each shader may contain settings for one 
or more of the following attributes: Color, 
Highlight, Shininess, Bump, Reflection, 
Transparency, Refraction, and Glow.

Each shader is saved as a document. Ray 
Dream Studio includes dozens of pre-
defined shaders, which are ready to use 
right out of the box. In time, you’ll build 
your own collection by editing existing 
shaders and creating new ones from 
scratch. 

Many r
surface
might 
as com
design

To ach
use Ra

 The 3
differe
surface
paint s

You ca
shapes
tric shapes, or of freely brushed 
s. Once created, paint shapes can be 
d, moved along the surface of the 

, modified (in shape, size, or shader 
t), layered, or deleted.

Paint tools are discussed in “3D Paint Tools” 
 186.
Using shaders you can create surfaces that 
are rough, smooth, shiny or transparent.

By adjusting the properties of a shader you 
can create any number of surfaces. For 
instance you can change the surface from 

Note: As you learn how to build your own 
shaders, you’ll find the pre-defined shaders 
to be invaluable. Examine them closely, for 
they demonstrate techniques you might 
not immediately discover through 
experimentation or reading these chapters.

The Primer

Every object has a base shader called the 
primer, which covers the entire object. By 
applying a shader to an object’s primer, 
you give the complete object its surface 
characteristics. The default shader used for 
new objects is a simple red color.

geome
design
selecte
object
conten

The 3D 
on page
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review mode accurately depicts 
ts, bumps, glow, shading (but not 
s), and color variations over the 

     

ndard preview mode, you can only 
asic color of the object. When you’re 

 on shader properties you’ll need to 
r Preview mode.
The Browser Palette
As you create shaders you want to keep, 
you’ll save them in the Browser palette: 
Shaders tab. You can select a shader in 
the Browser palette and apply it to an 
object. You’ll also use the Browser palette 
to create, open and edit shader documents.

Use the Browser palette to store your Shaders 

Each shader channel is on a different tab in 
the editor. The preview shows you how 
your shader will appear on the surface of 
an object and provides you with immediate 
feedback when you change shading 
parameters.

The Shader Editor is thoroughly discussed in “Building 
and Editing Shaders” on page 217.

Previewing Shading

Once you have created or edited a shader, 
you’ll want to see how it looks when 
applied to a particular object. 

Better P
highligh
shadow

In the sta
see the b
working
use Bette
of an object. Transparency, 
s, and reflection can be previewed 
h the Render Preview tool, which 
ou to ray trace a specific area of 
pective window at screen 
n.
The Current Shader Editor
The Shader Editor gives you complete 
control over the appearance of your 
shaders. You can use the Shader Editor to 
edit shaders stored in the Shaders Browser 
or shaders you’ve applied to objects in 
your scene.

in your personal folders.

Preview

The level of detail you’re able to see in the 
Perspective window depends on the 
preview mode you have selected. The Box 
and Wireframe modes provide no preview 
of the shaders in your scene. The standard 
Preview mode displays only the average 
color of an object across its entire surface. 
Shaded Preview shows a low resolution 
approximation of the shaders on your 
objects. To see your shaders in detail, you 
must switch to Better Preview mode or use 
the Render Preview tool.

surface 
shadow
only wit
allows y
the Pers
resolutio
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 Preview display mode, most shader 
s are visible in the Perspective 
Chap

The Shader Editor, expanded.

Channel tabs In Better
propertie
window.



                                    

ly a shader to an object’s primer 
 button):

  

ct one or more objects in the 

 

pective

 

 or 

 

Hierarchy

 

 window.

  

ct a shader in the 

 

Browser palette

 

:

 

 

ers tab

 

, or use the 

 

Eyedropper

 

 
 to “grab” the shader from an object 
e 

 

Perspective

 

 window.

  

 

 

Apply

 

 in the 

 

Browser

 

 palette.

 

ing Non-Empty Channels vs. 
ing All Channels

 

To use the Render Preview tool:

1Choose the Render Preview tool.

2In the Perspective or Modeling window, 
drag a marquee across the area to be 
previewed. Ray Dream Studio ray traces 
the area you have selected.

To work efficiently, keep the size of your render 
previews small. Larger areas take longer to ray trace, 
and require more memory. If you want to ray trace 
more than a small portion of your scene, you might as 
well do a low resolution rendering. Refer to 
Chapter 17, “Rendering.”

Shading an Entire Object
When you create a new object, Ray Dream 
Studio assigns it a default primer. To shade 
an entire object, you simply apply a shader 
to the object’s primer. You can use the 
drag and drop technique or click Apply in 
the Browser palette.

To app
{Apply

1Sele
Pers

2Sele
Shad

tool
in th

3Click

Apply
Apply
ect’s primer always contains settings 
ight shader channels. Although you 
lace some or all of these settings by 
g a shader, you can never 

etely remove settings from a primer 
l. 

er in the Shaders Browser, however, 
ve one or more empty channels. By 
, Ray Dream Studio ignores these 
The Render Preview tool renders areas of 
your object. When rendered, you can see all 
the shader’s attributes including transparency 
and shadows.

You can also edit an object’s existing shader—for 
instructions, refer to “Building and Editing Shaders” 
on page 217.

To apply a shader to an object’s primer 
(drag and drop):

Drag a shader from the Browser palette: 
Shaders tab onto an object in the 
Perspective window, or onto an object’s 
icon in the Hierarchy window.

An obj
in all e
can rep
applyin
compl
channe

A shad
may ha
default
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ce an object’s primer (apply all 
ls):

  

 one or more objects in the 

 

ective

 

 or 

 

Hierarchy

 

 window.

  

 a shader in the 

 

Browser palette

 

:

 

 

 

rs tab

 

.

ay also use the 

 

Eyedropper

 

 tool to 
” the shader from an object in the 

 

ective

 

 window.

  

p the 

 

Apply

 

 button in the 

 

Browser

 

 
e and choose 

 

Apply All Channels

 

.

            
empty channels when you apply a shader 
to an object’s primer. It applies only 
channels that contain settings.

applying all channels, using the same 
shader and primer used in the previous 
example.

To repla
channe

1Select
Persp

2Select
Shade

You m
“grab
Persp

3Pop-u
palett
d also applies to the Apply button on the 
ader Editor. If you prefer, you can change 
lt Apply Mode so that the Shader Editor 
 channels by default, instead of non-empty 
nly. Choose File menu> 
nces. Choose Current Shader Editor 
op-up in the Preferences dialog. Set your 

 the Default Apply Mode.
Applying only non-empty channels allows 
you to selectively change certain shading 
attributes, while leaving others intact. 

Note: You might keep a catalog of 
frequently used colors or bump settings in 
the Shaders Browser, and apply them to 
objects via the drag and drop technique.

Sometimes, however, you’d rather 
completely replace an object’s primer with 
the shader you’re applying. In this case, 
you’ll need to apply all channels, rather 

When you apply a shader with empty 
channels, the primer values replace those in 
the empty channels.

Since you wanted to replace the primer 
completely, applying only non-empty 
channels would have left unwanted settings 
in the Bump, Reflection, and Refraction 
channels. Applying all channels removes 
these unwanted settings and replaces them 
with the default settings.

For a thorough discussion of shader channels and 
settings, refer to “Shader Structure and Content” on 
page 198.

When you apply all channels it overrides all 
the settings in the primer.

This metho
Current Sh
the Defau
applies all
channels o
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than just those that contain settings. The 
diagram below demonstrates the effects of 



   

3D Paint

                                

outlines of your paint shapes, not the 
s they contain. The 

 

Brush

 

 tool 
only in 

 

Better Preview

 

 mode.

 

 a 3D Paint tool:

  

ct the shader you want to use. 

 on a shader in the 

 

Browser

 

 palette, 
se the 

 

Eyedropper

 

 tool to “grab” the 
er from another object.

  

ose a 

 

3D Paint

 

 tool. The behavior of 
 tool is described below.

  

t on the surface of an object in the 

 

pective

 

 or 

 

Modeling

 

 window. 

      
When you want to apply a shader to a 
limited region on the surface of an object, 
you’ll use Ray Dream Studio’s 3D Paint 
tools. The 3D Paint tools allow you to 
create paint shapes directly on the surface 
of an object in the Perspective or Modeling 
window. A paint shape may be rectangular, 
elliptical, polygonal, or freely brushed.

Because the 3D Paint tools work with the 
shaders in the Browser palette: Shaders 
tab, you’re not limited to painting with 
color. You can load your brush with gold, 
marble, or concrete and apply not only 
color, but bump, reflection, transparency, 

3D Paint Tools
Ray Dream Studio’s 3D Paint tools allow 

Using the 3D Paint Brush you can use a 
shader like a paint color and paint shader 
properties onto objects like brush strokes.

Paint Shape

shader
works 

To use

1Sele

Click
or u
shad

2Cho
each

3Pain
Pers
ot necessary to select the object.

ngle Tool

 create a rectangle. As you drag, a 
r band” preview is drawn in real 
 show you the boundaries of the 

gle. If you’re working in Shaded 
w or Better Preview mode, the paint 
is shaded when you release the 
 button. 
and the other shading attributes as well. 

Once you’ve created paint shapes, you can 
move them, resize them, layer them, and 
delete them. You may create any number of 
paint shapes on the surface of an object.

This section introduces the 3D Paint tools 
and explains how to use them. It also 
explains how layered paint shapes relate to 
each other and to the object’s primer. 
Finally, it discusses advanced topics such 
as mapping modes, and the Master and 
Object shading layers.

you to paint directly on your 3D objects. 
Each tool provides visual feedback as you 
paint to show you how your paint shape 
appears on the surface of your object.

The 3D Paint tools work best on objects created in 
Ray Dream Studio. You can paint on an object 
imported from another application, but you may need 
to change the object’s mapping mode to achieve 
satisfactory results. For more information, refer to 
“Advanced 3D Paint Topics” on page 191.

With the exception of the Brush tool, all of 
the 3D Paint tools work in Preview, Shaded 

It’s n

Recta

Drag to
“rubbe
time to
rectan
Previe
shape 
mouse
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Preview and Better Preview display modes. 
In Preview mode, you’ll see only the 



               

ptions

u choose the Brush tool, Ray 
tudio opens the Brush palette, 
ou can choose a brush and set its 
 

Ellipse Tool

Drag to create an ellipse. As you drag, a 
“rubber band” preview is drawn in real 
time to show you the perimeter of the 
ellipse.

When you draw with the Rectangle or Ellipse tool, 
your first mouse click positions one corner of your 
paint shape’s bounding rectangle, then you drag to 
position the opposite corner. Ray Dream Studio 
normally uses the shortest path to connect these 
opposite corners—that is, the paint shape will not 
wrap all the way around the object. If you want the 

Brush Tool

The Brush tool has several features and 
options. The next section explains them in 
detail.

The Brush Tool
The Brush tool is the most versatile 3D 
Paint tool. It allows you to paint free form 
designs on the surface of an object. Paint 
shapes you create with the Brush tool are 
called “brushed shapes.”

Like other paint shapes, a brushed shape 
may contain only one shader. If you choose 

Brush O

When yo
Dream S
where y
options.
t Brush tool has three brush types 
ted by icons at the top of the 

aint Brush allows you to paint new 
ed shapes and add to existing 
ed shapes.

raser modifies an existing brushed 
 by “cutting away” from it.

rush Options dialog to set the 3D 
ol’s size, opacity and other 
s.
shape to wrap “the other way” around your object, 
hold down the Option/Alt key as you drag. 

Polygon Tool

Click once to position each vertex of your 
polygonal paint shape. As you position 
vertices, the line segments connecting the 
vertices are drawn. Double-click at the last 
vertex to automatically close the shape.

Although you can later resize or “stretch” a 
polygonal paint shape, you won’t be able to 

a new shader while painting with the Brush 
tool, Ray Dream Studio automatically 
creates a new brushed shape. You can 
create any number of brushed shapes on 
an object.

The Pain
represen
palette:

• The P
brush
brush

• The E
shape

Use the B
Brush to
attribute
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re-edit its vertices. Refer to “Working with 
Paint Shapes” on page 190.



• The Imported Shape Brush lets you 5Drag the Flatness slider to adjust the To start painting, drag the brush across the 
. As you drag, the path of your stroke 
iewed in real time. In a couple of 
s, Ray Dream Studio draws the fully 
 brush stroke. 

n use the 3D Brush tool to apply a 
 to only areas of your object. The spots 
 crab were created using the Brush 
import a 2D image to use as a brushed 
shape. This brush is described in a 
separate section below.

To set brush options (Paint Brush or 
Eraser):

1Click the icon for the brush type you 
want: Paint Brush or Eraser. 

2Drag the Size slider to make the brush 
smaller or larger.

3Adjust the Advance slider to set the 

width of the brush.

Low Flatness produces a round brush. 
High Flatness produces a narrow brush.

6Drag the Angle slider to adjust the angle 
of the brush.

Use Angle and Flatness together to create a 
calligraphic effect.

Painting with the Brush Tool

Like the other 3D Paint tools, the Brush 

object
is prev
second
shaded

You ca
shader
on this
tool.
 3D objects can be rendered at any resolution, 
ly need to concern yourself with the resolution 
nal output until it’s time to render your image. 
 brushed shapes are pixel-based, however, 
 of a fixed resolution. You can think of the 
f your object as a blank image whose greater 
n (which may be either its height or its width) 
fault resolution of 1,024 pixels. The resolution 
ividual brushed shape depends on how much 

bject’s surface it covers. If you plan to render 
l image at high resolution, you may wish to 
 the default paint shape size. You can set this 
the 3D Paint section of the Preferences 
frequency at which the brush shape is 
drawn along the path of the moving 
mouse. 

A low Advance setting produces a 
continuous brush stroke. A high 
Advance setting produces a 
discontinuous brush stroke, giving the 
impression that the brush has “skipped” 
across the surface being painted. 

4Drag the Hardness slider to adjust the 
edge of the brush stroke.

The hardest setting shades at 100% 
opacity all the way to the edge of the 
brush. Lighter settings fade out the 

tool provides real time feedback as you 
work on the surface of an object. When you 
position the Brush tool cursor over an 
object in the Perspective or Modeling 
window, a preview outline of the size, angle 
and shape of the brush appears on the 
object.

Because
you rare
of your fi
Because
they are
surface o
dimensio
has a de
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your fina
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value in 
dialog.
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shader effect toward the edge of the 
brush.



te) and 8-bit grayscale images are 
ted for use as imported brushed 

age you import is a bitmap, the 
gions enable (turn on) the shader, 
white regions disable it. A bitmap 
 an easy way to create intricately 
d, irregular, or non-contiguous 
apes.

e an 8-bit image, the brightness of 
el determines how the shader in 
hed shape blends with the primer 
ader of the paint shape below. For 
ck pixel in the image, the paint 
shader is applied at 100% opacity 
rresponding point on the object. 
To paint with the Brush tool:

1Select the shader you want to use.

2Choose the Brush tool from the toolbar. 
The Brush palette appears.

3Choose a brush and set the brush 
options (see above).

4Drag the brush cursor over the surface of 
an object to apply a brush stroke. Drag 
again to apply additional brush strokes. 
A brushed shape may contain any 
number of brush strokes, but only one 
shader.

4Continue in this fashion to add brush 
strokes.

To erase part of a brushed shape:

1Use the Paint Shape Selection tool to 
select a brushed shape.

2Choose the Brush tool from the toolbar. 
The Brush palette appears.

3Select the Eraser icon.

4Drag the eraser across the portions of 
the brushed shape you wish to remove.

and whi
best sui
shapes.

If the im
black re
and the 
image is
patterne
paint sh

If you us
each pix
the brus
or the sh
each bla
shape’s 
to the co
 white pixel in the image, the 
s not applied at all. Intermediate 
f gray blend the paint shape’s 
ith the shader below. 

rt a brushed shape:

 a 2D art program, prepare the 
 you want to import. Save it in a 
nient folder in one of the formats 
ream Studio supports.

 a shader from the Browser 
te: Shaders tab.

e the Brush tool from the toolbar. 
rush palette appears.
You can also add to or subtract from an 
existing paint shape.

To add to a brushed shape:

1Using the Paint Shape Selection tool, 
choose a brushed shape.

2Using the Eyedropper tool, grab the 
shader from the selected brush shape, or 
select the same shader from the 
Browser palette> Shaders tab. 

When you add to a brushed shape, you 
must use the same shader.

3Start your first stroke within the 

You can convert any other paint shape to a brushed 
shape, which you may then edit with the Brush tool. 
Refer to “Advanced 3D Paint Topics” on page 191 for 
more information.

Importing a Brushed Shape

The Imported Shape brush allows you to 
import a a 2D image file and use it as a 
brushed shape. The image you import 
creates a brushed shape region that’s then 
filled with the current shader.

When you import a brushed shape from a 
2D image file, Ray Dream Studio ignores 
any color information in the file—only the 

For each
shader i
shades o
shader w

To impo

1Using
image
conve
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2Select
palet
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boundary of the selected brushed shape. brightness of each pixel is used to describe 
the shape. Therefore, bitmap (1 bit black 



4Select the Imported Shape Brush icon.

ize a paint shape: 

e Paint Shape Selection tool, drag 
the corner handles on the shape’s 
ing rectangle. 

ward the center of the shape to 
 it. Drag outward to stretch it.

ou may also use the Properties 
e: Shaders tab to resize a paint 
 Refer to “Editing Shading in the 
ties Palette” on page 191.

p a paint shape: 

e Paint Shape tool, drag a corner 
olding down the Command/Ctrl key.
5Drag a marquee across the surface of 
your object to define the limits of your 
imported brushed shape.

Ray Dream Studio displays a dialog so 
you can select your 2D image file.

6Use the file system tools to select and 
open your image.

Ray Dream Studio closes the dialog and 
maps the image onto the object as a 
paint shape. Its proportions are 

To select a paint shape: 

1Choose the Paint Shape Selection tool.

2Click on the paint shape you want to edit.

Ray Dream Studio show the paint shape 
within a bounding rectangle. The 
rectangle has four handles, one at each 
corner.

To move a paint shape: 

With the Paint Shape Selection tool, drag 

To res

With th
one of 
bound

Drag to
shrink

Note: Y
palett

shape.
Proper

To cro

With th
while h
ing: How Primer and Paint 
es Interact
you create a paint shape on the 
 of an object, the paint shape’s 
 overrides the shading 
teristics of the object’s primer. 
se, when several paint shapes 
p, the topmost paint shape’s shader 
es those below. 

is one important corollary to this 
owever. When a paint shape’s shader 
e or more empty channels, it inherits 
tings for these channels from the 
hape immediately below it (or from 
mer, if there is no paint shape 
determined by the marquee you have 
drawn. Ray Dream Studio fills the shape 
with the current shader.

If you’re not happy with the proportions of your 
brushed shape, you can resize it to the proportions you 
desire—see the next section.

Working with Paint Shapes

Once you’ve created paint shapes, you can 

the shape along the surface of the object.

Note: You may also use the Properties 
palette: Shaders tab to reposition a paint 
shape. Refer to “Editing Shading in the 
Properties Palette” on page 191.

To delete a paint shape: 

1Select the shape. 

2Choose Edit menu> Clear or press the 
Delete/Backspace key. 

Note: You may also use the Properties 
palette: Shaders tab to delete a paint 
shape. Refer to “Editing Shading in the 
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move, resize, layer and delete them. Properties Palette” on page 191. below)



ay need to advance through the 
sing the arrow buttons at the top 
 palette to display the Shading tab.
For example, if you paint on an object with 
a bumpy primer, any paint shape you 
create will also be bumpy unless the 
shader you’re painting with specifies 
different bump settings. To create a 
smooth paint shape on a bumpy object, 
you would use a shader with a constant 
value in the Bump channel.

The Properties palette: Shading tab 
allows you to control the opacity of an object’s paint 
shapes. Unlike a shader’s Transparency setting, paint 
shape opacity does not affect an object’s translucence; 
rather it controls how paint shapes interact. If a paint 
shape’s opacity is less than 100%, its shader does not 
fully override the shaders of the primer and paint 

Advanced 3D Paint Topics

Editing Shading in the 
Properties Palette
The Shading tab of the Properties palette 
allows you to edit the position and size of 
an object’s 3D Paint shapes with numerical 
precision. You can also add and delete 
paint shapes, change layering, specify a 
paint shape’s opacity, convert a paint 
shape from one type to another, remove an 
object’s primer, and change an object’s 
mapping mode. For more information, refer 
to “Mapping Modes” on page 193.

You m
tabs u
of the
ding tab displays the primer and 
plied paint shape (“element”).

ve an object’s primer: 

move from within the Properties 
: Shading tab.

ou have not changed an object’s 

hading tab on the Properties palette 
e attributes of the paint shapes on 
t.
shapes below; rather, the shaders effects are mixed. 
Refer to “Advanced 3D Paint Topics” on page 191. 

To change the layering order of paint 
shapes: 

1Select one of the shapes you want to re-
order.

2Choose Arrange menu> Paint Shape 
Order> and select To Front or To 
Back.

Note: You may also use the Properties 
palette: Shading tab to change layering. 

To display the Shading tab in the 
Properties palette:

1Select an object.

2Choose Windows menu> Properties. 

3Click the Shading tab.
The Sha
each ap

To remo

Click Re
palette

Note: If y

Use the S
to edit th
an objec
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ince you created the object, this 
 not available.
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This is covered in the next section.
primer s
option is



The numbers just to the right describe 
ange of possible values

u want, you can change the paint 
e to a different type. Choose the 
 you want from the Shape pop-up.

 Apply. 

int Preferences

eferences dialog includes a panel for 
nt options. Most of these let you 
 between “higher quality” and 
 efficiency.”

 3D Paint preferences:

ose File menu > Preferences.
When you apply a primer to an object in the 
Perspective window, it is applied over the primer of 
the corresponding Master object. Removing an 
object’s primer simply reveals the Master object’s 
primer. For more information, refer to “Master and 
Object Shading Layers” on page 194.

To change the layering order of an 
object’s paint shapes:

Drag the element listings into the order you 
want from within the Properties palette: 
Shading tab.

To set paint shape options:

1Click the triangle (Macintosh) or plus 
sign (Windows) to display the controls 
for the paint shape element you wish 
to edit.

2Adjust the Opacity slider to set a value 
between zero and 100%.

The opacity of a paint shape is not related to the 
transparency value you set in the Shader Editor. 
Whereas a shader’s transparency setting determines 
the degree to which light passes through a surface, the 
opacity setting simply determines the extent to which 

the r

5If yo
shap
type

6Click

3D Pa

The Pr
3D Pai
choose
“better

To set

1Cho
 the popup menu and choose 3D 
t.

le a Shape/Stroke Redraw option:

ait for end of stroke to refresh

fresh as stroke is drawn.

le the Show Transparency/
ection option if you want this 
mation as you paint. (Not 
mmended on slower systems.)

st the Paint Brush Shape resolution 
r for the number of pixels used in a 
h shape. 
In a moment, the object preview updates to 
your changes.

To create a new paint shape: 

Click the Plus icon from within the 
Properties palette: Shading tab. 

Ray Dream Studio creates a new paint 
shape on the surface of the object. The new 
shape has the default size, position, and 
shader—all of which you can change.

To delete a paint shape:

1Select an element on the Shading tab. 

a particular paint shape hides or shows the paint 
shapes below it.

3Edit the Position (h and v) values to 
move the shape on the object surface.

The Position values determine the 
position of the paint shape’s upper left 
corner on the surface of the object.

The numbers just to the right describe 
the range of possible values

4Edit the Size (Height and Width) values 
to alter the size of the shape.

2Click
Pain

3Enab

• W

• Re

4Enab
Refl
infor
reco

5Adju
slide
brus
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2Click the Minus icon. The Size values determine the size of the 
paint shape’s bounding rectangle.



am Studio’s default mapping mode 
 parametric mapping. Parametric 
 is like applying a decal to an 

 surface—each pixel in your image 
rectly to a specific point on the 
of your object. This straightforward 
h minimizes distortion and loss of 
uality. You’ll want to use 
ric mapping for most objects you 
 Ray Dream Studio.

 objects imported from other 
ions contain limited information, 
ric mapping generally cannot be 
 these objects. When you shade an 
d object, you’ll need to choose one 
ream Studio’s projection mapping 
Box/Face Mapping, Spherical 
Higher values offer better quality, but are 
more demanding on the system.

6Enable the Beep on creation option if you 
want Ray Dream Studio to alert you when 
you create a new brush shape. 

This might be important if you had 
intended to extend an existing shape, not 
create a new one.

7In the Advice box, enable the alert 
dialogs that you want to skip:

Preview mode Ray Dream Studio 
presents this alert when you try to use 
the 3D Paint Brush in any mode other 
than Better Preview. 

8Adjust the Rubber Band Fidelity slider. 
Higher settings create smoother edges 
on oval paint shapes. 

Mapping Modes
Most shader content is two-dimensional. 
Texture maps, for example, are nothing 
more than 2D images. Many procedural 
shader functions—including Ray Dream 
Studio’s checkers and wires—also produce 
two-dimensional image data. Ray Dream 
Studio uses a process called mapping to 
apply this 2D shading information to the 
surface of a 3D object.

Ray Dream Studio’s 3D Paint interface 
allows you to shade objects without 

Ray Dre
is called
mapping
object’s
maps di
surface 
approac
image q
paramet
create in

Because
applicat
paramet
used on
importe
of Ray D
modes: 
, or Cylindrical mapping.

rious projection mapping modes, 
am Studio maps the image onto an 
 primitive—a box, a sphere, or a 
 which encloses the object. The 
 then projected from the primitive 
 object itself.

est results, you should choose the 
e which best resembles the object 
mapping. For example, spherical 
 would be appropriate for a 

all, and cylindrical mapping would 
 for a soup can. 

u choose box mapping, you can 
hich face of the box primitive you 
When you “skip” this alert, Ray Dream 
Studio switches to Better Preview 
automatically.

Wrong Layer Ray Dream Studio will 
beep the first and second time you 
attempt to manipulate a master layer 
paint shape while working on an object 
instance. The third time, Ray Dream 
Studio presents this alert, informing you 
why your attempt fails.

When you “skip” this alert, Ray Dream 
Studio beeps each time you attempt to 
manipulate a master layer paint shape 
while working on an object instance.

worrying about the internal “nuts and 
bolts” of mapping. Most of the time, you 
can simply paint on objects with the 3D 
Paint tools and let Ray Dream Studio take 
care of the details. Occasionally, however, 
you may find that changing an object’s 
mapping mode makes it easier for you to 
achieve the results you want.

When you change an object’s mapping 
mode, Ray Dream Studio changes the 
method it uses to map 2D shapes and 
images to the object’s surface. As a result, 
the 3D Paint tools behave differently on the 
object. Depending on the shape of your 
object and the mapping mode you choose, 
the difference may be subtle or quite 
dramatic.

Mapping

In the va
Ray Dre
invisible
cylinder
image is
onto the

For the b
primitiv
you are 
mapping
basketb
be right
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cylindrical or spherical mapping, you can 2Choose Cylindrical or Spherical from the 
-up.

 the icon to choose the alignment 
want—X, Y or Z axis. You may also 
gn your own orientation:

ick the Custom icon.

ter values in the Yaw, Pitch, Roll 
lds to change the orientation of the 
age.

 Apply.

r and Object Shading Layers

 scene contains several objects 
on the same Master object, you can 
 Master object to specify a set of 
specify the orientation of the primitive in 
relation to the object.

To change an object’s mapping mode:

1Select an object.

2Display the Properties palette 
(Windows menu> Properties). 

3Choose the Mapping Mode tab.

To set Box/Face options:

1Display the Properties palette: 
Mapping Mode tab.

2Choose Box/Face from the pop-up.

3Click the icon for the mapping you 
want—Full Box or one of the Single 
Faces.

• Full Box wraps the 2D image onto a box 
much like you’d wrap a package.

• The Single Face mappings project the 
image on one side of the object. The 
projection continues through to the 
other side of the object.

pop

3Click
you 
desi

• Cl

• En
fie
im

4Click

Maste

If your
based 
use the
g characteristics to be shared 
n all of these objects. You can also 

 specific shading characteristics to 
dividual object.

mple, you might create a bottle and 
it with a green glass shader in the 
ing window. You could then 
ate the bottle so that three copies 
 in the scene, and use the 3D Paint 

o apply a unique label to each copy. 
se you decided later that you wanted 
, rather than glass bottles—you 
eopen the Master object in the Free 
odeling window and apply a marble 

, affecting all three bottles while 
 the individual labels intact.
4Use the pop-up to choose a mapping 
mode—Parametric, Box/Face, 
Cylindrical or Spherical.

Ray Dream Studio displays the options 
appropriate for the selected mode. 
(Parametric mapping has no options.)

5Set your options (described below).

6Apply your changes.

Use the Mapping Mode tab lets you select a 
mapping mode option for a selected object.

By default, the image is aligned with the 
object’s bounding box axes. If you need 
to, you can change the orientation of the 
image on the object.

4To change the orientation, select 
Custom.

5Enter values in the Yaw, Pitch, Roll fields 
to change the orientation of the image.

6Click Apply.

To set Cylindrical or Spherical options:

1Display the Properties palette: 

shadin
betwee
assign
each in

For exa
shade 
Model
duplic
appear
tools t
Suppo
marble
could r
Form m
shader
leaving
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Mapping Mode tab.



ging your Shaders

ticular shaders used on your 
are saved with the scene file. These 
 will not necessarily appear in the 
 palette. The Browser palette 
 only shaders that you’ve saved 

erload the Browser palette with 
. Each shader thumbnail requires 
emory. Too many shaders loaded 
 Browser palette may impact your 
ance. It’s a good idea to limit the 
ies listed at any given time.

ht want to organize your shader 
When you create multiple copies of an 
object, each copy has two distinct shading 
layers: the Master layer and the object 
layer. Any shading you apply to the Master 
layer affects all copies of the object in the 
scene. The shading on the object layer, 
however, is unique to each copy. The two 
shading layers may each contain both a 
primer and paint shapes, and the two 
layers need not share the same mapping 
mode.

Because the object layer is on top of the Master layer, 
paint shapes on the object layer always appear to be 
in front of paint shapes on the Master layer. Moreover, 
if you apply a primer to the object layer, it obscures the 

2Double-click the icon for the Master 
object you want to shade. The object is 
opened for editing in the Modeling 
window.

3Shade the Master object in the Modeling 
window. You can edit the primer and/or 
work with the 3D Paint tools there.

4Click Done to return to the Perspective 
window. The shading you have applied 
appears on all copies of the Master 
object.

To edit the Master shading layer in the 
Properties palette:

Mana

The par
objects 
shaders
Browser
displays
there. 

Don’t ov
shaders
some m
into the
perform
director

You mig

ies as logical categories. For 
, a list of directories might read 
ocks, Plastic, Glass, Marble. 

mation on adding, moving and 
g items and folders in the Browser 
refer to “Using the Browser 
 on page 28.

use the Browser palette to organize 
e your personal shader library.
entire Master layer (both primer and paint shapes).

When you shade an object in the 
Perspective window, you’re working on its 
object layer. To work on the Master layer, 
you simply shade the Master object in the 
Modeling window.

For more information on the relationship 
between objects and Master objects, refer 
to “Working with Master Objects” on 
page 266.

To work on the Master shading layer:

1Click the Masters tab in the Hierarchy 

1Click the Masters tab in the Hierarchy 
window. A list of all the Master objects in 
the scene appears in the window.

2Select the Master object whose shading 
you want to edit.

3Display the Properties palette: 
Shading tab.

The Shading tab controls now let you 
work with the master object shading.

director
example
Wood, R

For infor
removin
palette, 
Palette”

You can 
and stor
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window. A list of all the Master objects in 
the scene appears in the window.



A Note on External Texture 

Maps
If any of the shaders in your shader files 
contain Texture Map components that 
reference external image files, you need to 
maintain the relative path from the shader 
files to the image files. 

If either the shader files or the image files 
are moved to a different folder, Ray Dream 
Studio prompts you to locate the missing 
image files when it loads the shader files 
into the Browser palette.
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11

 

Creating Shaders

 

Why Create a Shader?

 

Shaders are a powerful way of bringing 
your 3D objects to life. You can use Ray 
Dream Studio’s extensive libraries of 
shaders to add life to your objects, but 
since there is no limit to the types of 
objects you can create, you may need to 
build a unique shader to suit each object 
you create. 

Ray Dream Studio’s shader structure 
makes it possible to create your own 
custom shaders. Much like mixing your 
own colors for painting on an artist’s 
palette, you’ll use the Shader Tree to create 
an infinite number of different textures, 
colors and surfaces.

apters explains the Shader Tree and 
you through the process of creating 
n shaders.
Chap

This ch
guides 
your ow



   

Shader Structure and 

                                  

Understanding Shader Components

 

are three types of components: basic 
nents, operators, and functions.

 

Components

 

omponents are the fundamental 
g blocks of shaders. Colors, values, 

xture maps are examples of basic 
nents. The diagram below shows a 
 tree built entirely with basic 
nents. Notice the structural 
ity of the tree—no branching occurs 

the level of the channels.

   
Content

This section and the two that follow—
“Shader Components” on page 201 and 
“Shader Channels” on page 213—explain 
the central concepts of defining shaders. 
After reading these three sections, you 
should understand how to define a shader 
by building a shader tree from Ray Dream 
Studio’s various shader components.

When you’re ready to start designing your 
own shaders, read the step-by-step 
instructions for using the Shader Editor in 
“Building and Editing Shaders” on page 217.

The shader tree contains the eight surface 
properties, called shader channels, that 
define an object’s surface in Ray Dream 
Studio. 

There 
compo

Basic 

Basic c
buildin
and te
compo
shader
compo
simplic
below 
 information on specific basic components, 
“Basic Components” on page 201.

n adjust the contents of a shader’s 
ls by placing different components in 

hannel. 
What is a Shader Tree
A shader is a set of surface properties that 
you can assign to an object or to a paint 
shape on the surface of an object. Ray 
Dream Studio features a modular structure 
for defining shaders: the shader tree. The 
shader tree’s modular nature allows for 
great flexibility in shader content.

Understanding Shader Channels

A shader tree contains all of the settings for 
a single shader. The shader itself is at the 
root of the tree. Immediately beneath the 
root, the tree has eight branches, one for 
each of the shader channels: Color, 
Highlight, Shininess, Bump, Reflection, 

To specify shader settings, you add 
components to the shader tree in one or 
more of the channels. The components 
beneath a particular channel represent that 
channel’s settings. 

Depending on the components you use, the 
settings in each channel may be simple or 
complex. The Color channel might specify 
either a plain color or a multi-color pattern. 
Likewise, the Reflection channel might 
specify uniform or varying levels of 
reflectiveness across the surface of an 
object.

A shader need not contain settings in all 
eight channels. If you don’t want to define a 
particular shading attribute, you can 

For more
refer to 

You ca
channe
each c
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Transparency, Refraction, and Glow.
simply leave that channel empty.



                               

component such as the Mix 

   

d grain applied to this object was 
y using the Mix operator with two 
d a wood grain function.
Operator Components

To create more complex and varied 
shading effects, you can use operators to 
combine the effects of two basic 
components within a shader channel. The 
arithmetic operators (Add, Subtract, and 
Multiply) combine components 
mathematically. An additional operator, 
the versatile Mix operator, uses functions 
to combine components in a variety of 
ways. 

For more information on specific operators, refer to 
“Operators” on page 206.

The diagram below demonstrates the use 
of an operator. In this particular example, 
the Mix operator is used in conjunction 
with the Wood function to mix two colors 
in a wood grain pattern. Notice that placing 
an operator in the shader tree causes the 
tree to branch.

When a 

The woo
created b
colors an
r has branches extending below it, 
ponent and all of the branches 
e referred to as a subshader. 
ers allow you to create truly 
 effects—anywhere you can place 
nent on the shader tree, you can 
ubshader instead.

der in the example below uses the 
rator with the checkers function to 
 complex checkerboard pattern in 
r channel. Half of the squares in 
kerboard are spotted—the spot 

is produced by a second Mix 
r, nested as a subshader within the 
e appearance of the remaining 
 is determined by a texture map, 
nto Ray Dream Studio from a 2D 
Function Components

By choosing which function to use, you 
control how the Mix operator combines a 
pair of components. Ray Dream Studio 
ships with several functions, including 
Cellular, Checkers, Wires, Wood, Spots, 
Gradient, Psychedelic and Marble. You can 
also define your own function with a 
formula. 

For more information on specific functions, refer to 
“Functions” on page 207.

Placing the Mix operator in the shader tree 
creates three branches. One for the mixing 
function and one for each of the components 
you’re mixing.

operato
the com
below ar
Subshad
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a compo
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The sha
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the chec
pattern 
operato
first. Th
squares
loaded i
er 11 • Creating Shaders 199
Chapt



   

image file. This image file might contain a 

          

mponent placed under the Global Mix 
 all the shader channels.
multi-color gradient or fractal pattern, for 
example.

Any co
affects
ecker pattern applied to this object 
ernating squares of gold and granite. It 
ated using the Global Mix shader.
Composite Shaders vs. Global 
Mix Shaders
The shaders in all of the preceding 
examples are called Composite shaders, 
because they are simply collections of 
individual channel settings. The settings 
within the different channels combine to 
determine the shader’s overall appearance, 
but settings in one channel have no effect 
on the settings in the other channels.

In the last example, the Mix operator was 
used to create a complex pattern in a 

Using two mix operators in the shader tree 
lets you create a subshader.

attributes in all of the shader channels at 
once. For example, you might want to 
create a checkerboard pattern with 
alternating squares of shiny, reflective gold 
and rough granite. To accomplish this with 
a Composite shader, you would need to 
apply the same mix function to each 
channel. Fortunately, Ray Dream Studio 
provides another type of tree structure, the 
Global Mix, which makes it easier to 
achieve effects like this. The diagram below 
illustrates how a Global Mix shader works.

The checkerboard pattern applied to this 
object contains a second mix operator which 
produces spots in one half of the squares in 
the checker pattern.

The ch
has alt
was cre
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shader’s Color channel. Suppose you 
wanted to create a shader which mixed 



                               

 Bump channel, the Color 
onent produces no effect because it 
a constant value across the surface 
bject. To create the illusion of 

iness, the Bump channel requires 
ion across an object’s surface.

 

ugh discussion of the Bump channel, refer 

 

” on page 214.

  

n-color channel—Shininess or 
tion—colors are converted to 
. Dark colors convert to low values, 
olors to high values.

              
The top level of a Global Mix shader tree 
has only one branch, which affects all eight 
shader channels. The Global Mix operator 
always appears on that branch. The Global 
Mix operator functions identically to the 
Mix operator, except that it mixes complete 
shaders rather than individual shader 
components. These complete shaders may 
be Composite shaders, as in the example 
above, or other Global Mix shaders. You 
can achieve some very complex shading 
effects by nesting Global Mix shaders.

Instructions for creating and editing both Composite 
and Global Mix shaders appear in “Building and 
Editing Shaders” on page 217.

“Building and Editing Shaders” on page 217 explains 
how to use the Shader Editor to place shader 
components on the shader tree.

You may have received other shader components, in 
addition to those described here. Ray Dream Studio’s 
open architecture allows developers to program their 
own shader components in the form of plug-ins. These 
third-party extensions join seamlessly with Ray Dream 
Studio’s built-in shading tools.

• In the
comp
gives 
of an o
bump
variat

For a thoro
to “Bump

• In a no
Refrac
values
light c
u place the Color component on 
er tree, it appears as a color chip.

 color:

 Current Shader Editor, click a 
el tab.

e Insert menu >Color.

an open the editor by clicking an 
t with the Eyedropper tool.

ader tree, a Color component 
 as a Color chip.
Shader Components

This section describes Ray Dream Studio’s 
various shader components. It explains 
what each component does, and how to set 
each component’s unique parameters. 
Within this section, the components are 
divided by type into three groups: basic 
components, operators, and functions.

Basic Components

Color

The Color component allows you to specify 
any color. Although you can place the 
Color component anywhere on the shader 
tree, it’s best suited for use in the Color, 
Highlight, Reflection, Transparency, and 
Glow channels, which are designed for 
color input.

For a description of how colors affect the each 
channel, refer to “Shader Channels” on page 213.
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4

 

You can switch between the 

 

RGB

 

 and 

                

1

 

In the Ray Dream Studio color editor, 

                  

 a value:

 

e pointer along the 

 

Value

 

 slider. The 
 side of the slider represents zero, 
 right 100. The number to the right of 
er displays the current value.

 

re Map

  

xture Map

 

 component allows you to 
D image, such as a scanned 
raph or paint-type illustration, in 
ader. Used effectively, texture maps 
d your shaders unparalleled 
. Many complex real-world surfaces 
rly impossible to simulate through 
eans.

    
CMYK color models using the Model 
pop-up. 

5Drag the RGB or CMYK sliders to set the 
color you want. 

You can also enter specific values into 
the text boxes. The valid range for RGB 

The Ray Dream Studio color editor. 

click the color wheel in the upper right 
corner of the RBB/CMYK color picker.

Note: You can use the system color picker 
as the default. Choose File menu> 
Preferences. Choose Shader Editor from 
the pop-up. Enable the Use system color 
picker option.

Value

The Value component allows you to set a 
value between zero and 100%. You’ll use 
the Value component frequently in every 
channel but the Color channel.

• If you use it by itself, it specifies a 
constant level for a particular attribute 

To set

Drag th
far left
the far
the slid

Textu

The Te
use a 2
photog
your sh
can len
realism
are nea
other m
 you in creating texture maps, Fractal Design 
loped Detailer—a dedicated program for 
g texture map images. Detailer and Ray 
tudio work together and help you achieve 
 results.

 Color Images as Texture Maps

e maps using color images are 
ely useful in the Color channel. You 

import an actual product logo as a 
 map and apply it like a decal to a 3D 
e model. Or to mimic an extremely 
d natural surface, you could import 
values is from zero to 255. The valid 
range for CMYK values is from zero 
to 100%.

Your choice of a color model is for your convenience 
only—it has no effect on the content of your final 
rendered image. Like other rendering applications, Ray 
Dream Studio always renders RGB images. You can use 
an image processing application to convert rendered 
images to CMYK for separation.

To use the system color picker:

You might prefer to use the system color 

across the surface of an object or paint 
shape.

For example, a 30% value in the 
Transparency channel means that the 
shader will make an object 30% 
transparent.

• If you place it beneath the Color channel, 
its value is converted to a shade of gray. 
Zero converts to black, 100 to white.

When you place the Value component on 
the shader tree, it appears as a slider.

In the shader tree, a Value component 
appears as a slider.
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a small photographic sample of the surface 
and tile it—duplicate it a specified number 
of times—to cover your entire object. You can use an image of any color depth as a texture 

map. In most cases, an 8-bit (256 color) image with a 
custom color palette provides excellent results, while 
requiring substantially less memory and disk space 
than a 32-bit image. Ray Dream Studio cannot use 
CMYK images as texture maps. If you want to use a 
CMYK image, you must convert it to RGB before 
importing it.

Black & White and Grayscale Images as 
Texture Maps

You can use a black and white or grayscale 
texture map in any channel (besides Color) 
to specify varying levels of a particular 
lso use a black and white or grayscale 
p with the Mix operator, in place of a 
or more information, refer to “Using Other 
ts as Functions” on page 213.

 Maps Internally vs. Externally

lt, Ray Dream Studio saves copies 
ture maps internally. You can also 

 in on this object was created by 
exture map in the Transparency 
Color texture maps are also appropriate in 
the Highlight, Reflection, Transparency 
and Glow channels. 

If you use a color image in a non-color channel, Ray 
Dream Studio internally converts it to grayscale.

The conch shell surface of this object was 
created by placing a texture map in the color 
channel.

shading attribute. The shade of each pixel 
in the image determines the level of the 
attribute for the corresponding point on 
the object or paint shape.

If you use a black and white image, each 
black pixel turns the attribute on—sets it to 
100%—while each white pixel turns the 
attribute off. An 8-bit grayscale image 
allows subtler effects, with 256 possible 
shades for each pixel. For example, a 
grayscale blend from white to black in the 
Transparency channel would make an 
object or paint shape fade smoothly from 
opaque to transparent.
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There are advantages and disadvantages to 

             

2

 

To specify whether you want a copy of 

                               

bnail preview of the image appears 
upper right corner of the Texture 

          

n use an image as a component in 
 tree using the Shader Editor’s texture 
ntrols.
each option. Storing maps internally avoids 
organizational hassles, since you don’t 
need to keep track of any external files. 
However, internally saved maps greatly 
increase the size of a file, which can result 
in slower loading and saving. With an 
external map, you can modify it with 
another program, and you don’t need to 
reload the map.

In general, you can store maps internally 
unless your file contains particularly large 
texture maps (or many smaller maps).

If you move an externally referenced image on your 
hard drive, Ray Dream Studio prompts you to locate 

the image saved within your Ray Dream 
Studio file, click the Options button in 
the Open dialog. The Texture Map 
Options dialog appears. 

3Select Internal or External.

4Click OK to close the Options dialog.

5Click the Open button in the Open 
dialog, or press Return/Enter. The 
texture map controls appear, displaying 
the image you have chosen.

Depending on the current display setting in the Shader 
A thum
in the 

You ca
shader
map co
ntrols. Immediately to the left of the 
w, Ray Dream Studio displays the 
s dimensions in pixels, and its color 

 or rotate the image:

he appropriate button to the left of 
view.

 the image: 

 the Tile check box to turn tiling on. 
Dream Studio enables the tiling 
rs.

the sliders to set the number of 
the image file the next time you open your scene file or 
shader Browser document.

Choosing an Image

When you place a Texture Map component 
on the shader tree, Ray Dream Studio 
displays the standard Open dialog, 
prompting you to choose an image.

To choose an image:

1Select an image file from the file list in 
the Open dialog.

Editor and the location of your Texture map 
component on the shader tree, you may not be 
prompted immediately to choose an image—in this 
case, a preview sphere appears in place of the texture 
map controls. To open the controls and choose an 
image, simply double-click on the preview sphere. A 
discussion of the Shader Editor’s display options and 
instructions for navigating the shader tree appear in 
“Building and Editing Shaders” on page 217. 

map co
previe
image’
depth.

To flip

Click t
the pre

To tile

1Click
Ray 
slide

2Use 

titions in each direction.
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ehaves just as a texture map, 
hat the image differs in each frame 
ndered animation.

e information on using movies as 
omponents, refer to “Rotoscoping” 

 334.

t a movie in the shader 
ent:

the disk icon. Studio displays the 
 dialog.

e and open a movie file.

 you’ve opened a movie, a preview 
 appears. This player lets you 
If you want Ray Dream Studio to rotate 
and flip neighboring tiles to maximize 
continuity, click the Seamlessly check 
box. If your image is specifically 
designed for seamless tiling, you don’t 
need to enable this option.

To filter the image:

1Click the disk icon in the Texture Map 
controls.

2Choose Filter from the pop-up which 
appears. A dialog listing available Adobe 

To replace the image:

Click the disk icon in the Texture Map 
controls, and choose Open from the 
pop-up. The Open dialog appears, allowing 
you to choose a different image.

or

Click the disk icon in the Texture Map 
controls, and choose Import from the 
pop-up. A dialog appears, allowing you to 
choose from any Adobe Photoshop-
compatible plug-ins you may have 
available. If you have the appropriate 
plug-in, you can acquire an image from a 
scanner or a PhotoCD, for example.

movie b
except t
of the re

For mor
shader c
on page

To selec
compon

1Click 
Open

2Locat

When
player
ronize the movie with your 
tion. Refer to “Rotoscoping” on 
34.

ontrols
Photoshop™-compatible filters appears.

3Select a filter and click OK.

If you have Adobe Photoshop-compatible filters on 
your hard drive, but none appear in the Filters dialog, 
you need to use the Preferences dialog to set the 
location of your third-party plug-ins. Step-by-step 
instructions for this procedure appears in “Advanced 
Filter Techniques” on page 376.

The White is invisible check box allows you to achieve a 
type of masking effect by instructing Ray Dream Studio 
to ignore any purely white pixels in the image. For 
example, you could use this option to place a logo 
with an irregular shape on the surface of an object. 
Simply create a map with a white background and 
place it in the Color channel; then apply it to an object 
using the 3D Paint Rectangle tool. Wherever there is a 
white pixel in the map, the paint shape or primer 
below shows through.

Movie

The Movie component allows you to use 

synch
anima
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any QuickTime (Macintosh) or AVI 
(Windows) movie within a shader. The 



3You can click the directional buttons to 

h point on an object or paint shape, 
ction generates a value between 
d 100. The Mix operator uses this 

o combine the components on the 

x operator mixes the other 
nents in the shader tree.
change the movie’s orientation.

4You can reduce the image’s brightness 
with the Brightness slider. 

5Enable the Better (but slower) sampling 
to view a more precise preview.

6Enable the Invert Color option if you 
want to invert the movie’s colors.

7If you want the frame to repeat, enable 
the Tile option. 

8Use the Horizontally and Vertically 
sliders to set the number of tiles in each 
direction.

¡Enable the White is Invisible option if 
you want white regions of the movie to 
render transparent.

Movie Time Selection dialog.

For eac
the fun
zero an
value t

The mi
compo
 right branches. When the value is 
to zero, more of the left component 
. When the value is closer to 100, 
f the right component is used.

unctions, like Checkers and Wires, 
te a value of zero or 100 for each 
These functions result in clear 
ns between the two components. 
functions, like Wood and Spots, 
te a range of values between zero 
0. These functions result in gradual 
 between the components.

us functions are described in “Functions” on 
7.
9Enable the Seamlessly option to smooth 
the transitions between tiles.

ºYou can get more information on this 
movie by clicking More. 

Studio opens a window that provides 
technical information and a movie 
preview player.

Operators
Operators allow you to create complex 
shading effects by combining two 
components or subshaders within a single 
shader channel.

Mix

The Mix operator is Ray Dream Studio’s 
most versatile shading tool. It can produce 
a wide variety of results, depending on 
which function you choose to mix the two 
components.

When you place a Mix operator on the 
shader tree, it appears as a node with three 
branches below it. The left and right 
branches are placeholders for the two 

left and
closer 
is used
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components you want to mix. The mixing 
function goes on the middle branch. 



ons
s are used almost exclusively with 

operator. They can, however, be 
 themselves. A function generates a 
tween zero and 100 for each point 
ject or paint shape.

u place a function on the middle 
f the Mix operator, the operator 

 values generated by the function 
e components on the left and right 
s. Where the value equals zero, the 
ponent is used; where the value 
00, the right component is used. 
diate values produce a blending of 
components.

u place a function in a channel by 
Add (+)

The Add operator sums the values of two 
components. When you place the Add 
operator on the shader tree, it appears as a 
node with two branches extending below. 

When you place the Add operator in the 
Shader Editor, it sums the values of the other 
components in the tree.

Multiply (*)

The Multiply operator multiplies the values 
of the left and right components. 

When you place the Subtract operator in the 
Shader Editor, it subtracts the value of the 
right component from the value of the left.

Functi
Function
the Mix 
used by
value be
on an ob

When yo
branch o
uses the
to mix th
branche
left com
equals 1
Interme
the two 

When yo

assigns a value directly to each 
 the object or paint shape. In a 
r channel, each value is used “as 
y of the channels designed for 
ut (Color, Highlight, Reflection, 

rency or Glow), each value is 
d to a shade of gray, with zero 
ng to white and 100 to black.

 3D Functions

ction creates a flat image that is 
ped around the shaded object. 

s and Wires are 2D functions.

ction creates a three-dimensional 
hat “shares space” with the object. 
ct’s visible shading depends on 
The two branches are placeholders for the 
components you want to combine. For 
each point on a paint shape or object, the 
Add operator sums the values of the two 
components.

Subtract (–)

The Subtract operator subtracts the value 
of the right component from the value of 
the left component. 

You can use the Subtract operator to invert 
the value of another component. Just place 
the component you want to invert in the 
right branch and a Value component set to 
100 in the left branch. Try this technique on 
a complex shader if you want to invert its 
colors.

The Multiply Operator can be used to tint a grayscale 
bitmap by multiplying the bitmap shader by a color 
shader.

When you place the Multiply operator in the 
Shader Editor, it multiplies the values of the 
other components in the tree.

itself, it 
point on
non-colo
is.” In an
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surfaces coincide with the 
s in the 3D shading volume. 

 Spots, Wood, Marble and 
Chapt

how its 
variation
Cellular,



Psychedelic are 3D functions. These 4Drag the markers on the Upper and 
er Limits slider to controls the range 
lues created by the function.

range determines the balance 
een the two (light and dark) 

ponents. The left marker controls 
ower limit. The right marker 
rols the upper limit. 

le the Fractal Version option to use 
als instead of more regular shapes 
he cells.

g the Fractal Version can 
ificantly increase the time required 
draw and to render your image.
functions give the appearance that the 
object has been carved from a solid block 
of material. 

You’ll recognize the importance of 3D 
shading when you consider a block of 
wood. If the grain runs along one surface, 
the perpendicular surface shows the ends 
of the grain.

Cellular

The Cellular function creates a surface that 
looks like a network of cells. Cellular is a 3D 
function. It can be used effectively in the 
Color and Bump channels. You can 
experiment with it in the other channels for 
other effects.

Low
of va

The 
betw
com
the l
cont

5Enab
fract
for t

Usin
sign
to re
To set Cellular options:

1Use the Shape menu to select the basic 
shape of the cells.

2Drag the Intensity slider to adjust the 
contrast between the two colors.

The slider ranges from -100% to 100%. 
Negative settings invert the image. 

3Drag the Scale slider to change the size 
of the cell shape. The slider ranges from 

You can create skin-like textures by using the 
Cellular function in the Shader Editor.
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1% to 200%.



ood options:

t the Global Scale slider to set the 
f the wood grain pattern in relation 
 object.

t the Vein count slider to set vein 
g. 

alues produce dense vein 
ns, while low values produce 

e vein patterns.

t the Perturbation slider to control 
ze of the “waves” in the veins.

t the Undulation slider to control 
Spots

The Spots function produces a random 
pattern of spots. The spots are irregular, 
more like leopard spots than polka dots. 
Spots is a 3D function.

When Blending is set to 50%, the 
function produces equal numbers of 
zero-value and100-value spots, with 
abrupt transitions.

3Click the Shuffle button to randomize 
the spot pattern. 

Wood

The Wood function produces a wood grain 
pattern. It assigns a value of 100 to the 

Use the Shuffle button to randomize the 
pattern of spots.

To set W

1Adjus
size o
to the

2Adjus
spacin

High v
patter
spars

3Adjus
the si

4Adjus

quency of the waves in the grain. 

t the Vein Blending slider to 
ine whether the transitions 

en veins and spaces are abrupt 
dual.

e Direction pop-up to set the 
ation of the wood grain pattern in 
n to the object.

e Center pop-up to set whether the 
 grain pattern is taken from the 
r of the tree, where the curvature of 
ins is quite pronounced or from a 
further from the center, where the 
ture is more gradual. There are 
To set Spots options:

1Adjust the Size slider to control the size 
of the spots.

2Adjust the Blending slider to control 
how the spots blend together.

When Blending is set to 0%, the function 
produces equal numbers of zero-value 
and 100-value spots, with gradual 

You can create a spot pattern using the Spots 
function in the Shader Editor.

veins and a value of zero to the spaces 
between the veins. Wood is a 3D function.

the fre

5Adjus
determ
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or gra

6Use th
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7Use th
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settings to choose from.
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blending. You can create a variety of wood grain 
textures by mixing different colors with the 
Wood function.

three 



8Click the Shuffle button to randomize 

shaded with 3D functions like Spots, Wood, 
ble appear to be carved or sculpted from solid 
f material, but this appearance is only 
p—like all of the objects you create in Ray 
tudio, these objects are still “hollow.” To 
 this point, if you make a marble object 
 transparent, you won’t see veins running 
 the inside of the object.

ers (and Stripes)

eckers function produces a 
rboard pattern. Every point is 

ed a value of exactly zero or 100, so 
ding occurs. Checkers is a 2D 
the wood grain pattern.

Marble

The Marble function produces a marble 
pattern. It assigns a value of 100 to the 
veins and a value of zero to the spaces 
between the veins. Like Spots and Wood, 

Use the Shuffle button to randomize the 
pattern of the wood grain.

To set Marble options:

1Adjust the Global Scale slider to set the 
size of the marble pattern in relation to 
the object.

2Adjust the Vein count slider to set vein 
spacing. 

High values produce dense vein 
patterns, while low values produce 
sparse vein patterns.

3Adjust the Perturbation slider to control 
the size of the “waves” in the veins.

4Adjust the Undulation slider to control 

Objects 
and Mar
blocks o
skin-dee
Dream S
illustrate
partially
through

Check

The Ch
checke
assign
no blen
n.
Marble is a 3D function. the frequency of the waves in the 
pattern. 

5Adjust the Vein Blending slider to 
determine whether the transitions 
between veins and spaces are abrupt or 
gradual.

6Use the Direction pop-up to set the 
orientation of the marble pattern in 
relation to the object.

7Click the Shuffle button to randomize 
the marble pattern.

functio
eckers function can be used to create 
kerboard pattern on an object.
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You can create marble surface by using the 
Marble function in the shader tree.

The Ch
a chec



he Vertical count slider to set the 
er of longitudinal wires.

he Width slider to set the size of 
ngitudinal wires. 

e the Gray Scale option if you want 
ooth the transitions between the 
s and the wires.

scale option smooths the transition 
 wires and spaces.
To set Checkers options:

1Drag the Squares horizontally slider to 
set the number of horizontal squares.

2Drag the Squares vertically slider to set 
the number of vertical squares.

By setting one of the sliders to zero, you 
get stripes—either horizontal or vertical, 
depending on which slider is at zero.

Use the sliders to set the number of 
horizontal and vertical squares.

You can create a lined pattern on the surface 
of an object using the Wires function.

3Drag t
numb

4Drag t
the lo

5Enabl
to sm
space

The gray
between
ption is especially useful in the 
 channel, where gradual transitions 
ce more striking results.
Wires

The Wires function produces a grid of lines. 
Like the Checkers function, Wires assigns a 
value of either zero or 100 to each point on 
an object or paint shape. Specifically, it 
assigns a value of 100 to the lines of the 
grid, and a value of zero to the spaces. 
Wires is a 2D function.

To set Wires options:

1Drag the Horizontal count slider to set 
the number of lateral wires.

2Drag the Height slider to set the size of 
the lateral wires.

The thickness of the horizontal/vertical wires is 
expressed as a percentage of the height/width of the 
entire object or paint shape. You can determine the 
thickness of a single wire by dividing the percentage 
by the number of wires. For example, if ten horizontal 
wires represent 50% of a paint shape’s height, the 
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er 11 • Creating Shaders 211
Chapt

thickness of each wire is 5% of the height.



Psychedelic interference on that plane. Using all The Phase slider ranges from 0.00 to 
. The two extreme settings display 
ycle at the same point.

the flat preview to see how the 
er changes when you adjust 
hase.

hase settings are particularly useful 
ations. Set key events to animate 

ase from zero to one using the 
te: Saw/Loop tweener.

ent

adient function produces a gradual 
from one color to another. Gradient 
ul in the Color and Transparency 
ls. Gradient is a 2D function.
The Psychedelic shader function creates 
unusual textures, including swirls of color 
reminiscent of the psychedelic Pop Art of 
the 1960s. Psychedelic is a 3D function.

three planes you can create more 
interesting design elements.

2Enable the Use Global Coordinates 
check box to use the Global Coordinates 
for the Psychedelic function.

By default the function uses the 
individual Object's coordinate system. 
The shading is constant as you move and 
rotate the object.

When Use Global Coordinates is 
enabled, the shading remains static in 
global space when the object moves. The 
object behaves as a “window” on the 
shading. This is like moving your hand 

1.00
the c

Use 
shad
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The Gr
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To set Psychedelic options:

1Adjust the three Interference sliders to 
control the amount of interference 
applied to each plane.

The sliders range from -1.00 to 1.00. Each 
slider controls the stripes applied on the 

Use the Psychedelic function to create 
colorful swirls on an object.

through the dappled shadows under a 
tree. Instead of shadows, though, the 
psychedelic shading passes across the 
moving object.

3Drag the Scaling slider to control the size 
of the design elements. 

4Adjust the Number of Stripes slider to 
control the number of stripes in each 
element. 

5Adjust the Density slider to control the 
density of the pattern. 

6Adjust the Phase slider to set the current 
position in the psychedelic cycle. 
 Gradient function to blend two colors 
hader.
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specific plane. A setting of 0 results in no Use the
in the s



 that your single-color objects look 
, try using the Mix operator with the Spots 
 create minute color variations. Simply mix 

ly different hues in a pattern of tiny spots, 
ing set to zero for smooth blends. When 
m a distance, these subtle color variations 
n object a more realistic appearance.

ult content of the Color channel is 
component, set to a shade of red. 
am Studio assigns the default 
of each channel, as part of the 
rimer, to each new object you 
he default content is also used to 
To set Gradient options:

1Choose Direction menu> Horizontal 
or Vertical to set the direction of 
the blend.

2Adjust the Turbulence slider to mix up 
the colors as they change. 

A low setting results in a uniform blend. 
A high setting increases irregularity in 
the blend.

Formula

The Formula function lets you design a 
mixing function with a mathematical 
formula.

• You can use a Value component to blend 
the components on the left and right 
branches of the Mix operator in a given 
ratio. A value of 50 blends the two 
components evenly. Lower values favor 
the left component, while higher values 
favor the right component.

• You can use a black and white or 
grayscale texture map to mix the left and 
right components in a custom pattern. 
For each white pixel in the image, the Mix 
operator uses the left component. For 
each black pixel, the Mix operator uses 
the right component. Intermediate shades 
produce a blending of the two 
components.

If you find
unrealistic
function to
two slight
with Blend
viewed fro
can give a

The defa
a Color 
Ray Dre
content 
default p
create. T
e the preview of a shader in the 
ditor, when a particular channel is 

ght and Shininess
jects in the real world show 
ts when illuminated. These bright 
 streaks are direct reflections of 
rces, like the sun glinting off a 
bumper. 

 objects have small, bright 
ts. Plastics have dim, but large 
ts. And stones usually have no 
ts, unless polished. 

 control the color, intensity and 
n object’s highlights by placing 
For more information, refer to the PDF file 
“Using Formulas” contained on the Ray 
Dream Studio 5 CD.

Using Other Components as Functions

You can actually use any component as a 
function in the Mix operator. This allows 
you to mix components in ways not 
supported by Ray Dream Studio’s basic 
functions.

When you use a component as a function, 
Ray Dream Studio automatically converts 
its output to values so that the Mix 
operator can use it to mix the components 
on the left and right branches.

Shader Channels

Color
No shader channel has a more obvious 
effect on the appearance of an object or 
paint shape than the Color channel. 
Depending on the components you place 
beneath the Color channel, you can specify 
anything from a plain color to a complex, 
multi-color pattern.

• To specify a plain color, simply place a 
Color component.

calculat
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omponents beneath the Highlight 
iness channels.
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Value and Texture map components are 
especially useful in place of functions.

• To specify a multi-color pattern, use a 
Texture Map component or combine 
colors with the Mix operator.

shader c
and Shin



The Highlight channel controls highlight Bump

apping does not change the actual 
phy of an object—no points are displaced. 
t changes the angle at which light rays reflect 
urface at certain points. This technique tricks 
nto perceiving texture. Because the bumpiness 
 illusion created by the renderer, the edge of 

ct remains smooth. In most cases, this is not a 
. However, if you require true surface 
s to appear on the silhouette of your object, 
ed to create them in the modeler.

ulate bumps, the components you 
eneath the Bump channel must 
 some variation in the colors or 

 of adjacent pixels. Consequently, 
intensity. A high value produces bright 
highlights, while a low value produces dim 
highlights.

The Shininess channel controls highlight 
size. A high value produces small 
highlights, while a low value produces large 
highlights.

Note: Typically, highlights that are 
extremely bright are very small, while 
those that are softer spread larger.

By default, highlights are white. You can 
specify color highlights by placing a Color 
component (or any component that 
produces color information) in the 
Highlight channel. Color has no effect on 

Bumpy and rough surfaces are difficult to 
model geometrically. Imagine modeling the 
irregularities of the skin of an orange, point 
after point—the task would quickly become 
a nightmare. Fortunately, Ray Dream Studio 
allows you to use a shader to simulate 
variations on the surface of an object. 

By placing shader components in the Bump 
channel, you can “perturb” a smooth 
surface to produce irregularities. This 
technique is known as bump mapping. 
Bump mapping can produce subtle effects 
like the bumps and pits on the surface of an 
orange, or more pronounced effects like 
the seams on a baseball.

Bump m
topogra
Rather, i
off the s
the eye i
is just an
the obje
problem
variation
you’ll ne

To sim
place b
specify
values
 a simple color or value in the Bump 
l does not produce bumping.

e maps and functions produce the 
sults in the bump channel. Like the 
on-color channels, the Bump 
l always converts color information 
scale.

you use a grayscale image in the 
channel, lighter areas appear to be 
 while darker areas appear to be 
d. When you use a function that 
es values, areas with higher values 
 to be raised, while areas with lower 
 appear to be lowered.
the Shininess channel; any color 
information in the Shininess channel is 
internally converted to values.

The default content of both the Highlight 
channel and the Shininess channel is a 
Value component, set to a value of 50.

If you want varying levels of highlight or 
shininess across the surface of an object or 
paint shape, you can use a texture map or a 
function.

The indents on the snorkel were created by 
placing a texture map in the Bump channel

placing
channe
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best re
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 values in the Reflection channel 
ces the same effect as using shades 
y. Only the amount of reflection is 
d.

e, if you want varying levels and 
eflection across the surface of an 
r paint shape, you can use a texture 
 function.

ult content of the Reflection 
 is a Value component, set to a 
 zero.

arency
ht strikes an opaque surface, it 
ounces off. When it strikes a 
sparent surface, some light 
• For the most convincing results, you 
should create a smooth blend between 
extreme values like black and white or 
zero and 100.

If a grayscale image with hard edges between black 
and white does not produce a satisfactory bump 
effect, try applying a blur effect to the image in an 
image-editing application.

• The relative height or “steepness” of the 
bumps depends on how rapidly you blend 
between extreme values. A blend that 
occurs over the range of many pixels 

3Use the Render Preview tool to check the 
results on the object. 

Reflection 
Many real-world surfaces are at least 
somewhat reflective. Most types of metal 
and glass are partially reflective. A mirror 
is so reflective that it takes nearly all of its 
color from the environment around it.

Ray Dream Studio allows you to specify 
reflectiveness by placing shader 
components beneath the Reflection 
channel.

Although a Value component works fine in 
the Reflection channel, both subtler and 
more fantastic effects can be achieved by 

• Using
produ
of gra
affecte

Of cours
tints of r
object o
map or a

The defa
channel
value of

Transp
When lig
simply b
semitran
 off, but some passes through. As a 
ou can see through a 
sparent object. Glass, water and 
stic are examples of 
sparent materials.

 specify transparency by placing 
omponents beneath the 
rency channel.

Value component is perfectly 
iate in the Transparency channel, a 
mponent provides a much broader 
 possible effects. Objects made of 
glass tend to look more realistic if 
 a similar color in both the Color 
nsparency channels (if the object’s 
bright, you may want to use a 
produces shallow, gradual bumping. A 
blend that occurs over the range of a few 
pixels produces steeper, more sudden 
bumping.

The default content of the Bump channel is 
a Value component, set to a value of zero. 
This produces no bumping, since there is 
no variation from pixel to pixel.

To change the amount of bump:

1In the Bump channel tab, adjust the 
Amount slider.

The Amount slider lets you strengthen or 
weaken the Bump effect.

using a Color component instead. To make 
a highly reflective object appear more vivid 
(less washed out), use a variation of the 
same color you have in the Color channel 
(if the object’s color is particularly bright, 
you may want to use a darker tint of the 
same color). To give reflections an unusual 
tint, try using a color that is markedly 
different from the one in the Color channel.

• When you use color data (a Color 
component, a Texture Map component, 
or a complex subshader) in the Reflection 
channel, its hue affects the tint of the 
reflection and its brightness determines 
the amount of reflection. Darker colors 
produce less reflection; brighter colors 
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2Apply your changes to the object.
produce more.

darker t



Try using a function or a black and white Refraction

 simulating glass should have Refraction 
round 20. Shaders simulating water or ice 
ave values that are somewhat lower. Try 

enting with different values until you achieve 
t you want.

r has no effect on the Refraction 
nel. Any color information in the 

action channel is internally converted 
lues.

fault content of the Refraction 
l is a Value component, set to a 
f zero.
texture map in the Transparency channel 
to create a shader which makes 
transparent “holes” in an object. For 
example, placing the Wires function in the 
Transparency channel creates a wireframe 
effect.

• When you use color data (a Color 
component, a Texture Map component, 
or a complex subshader) in the 
Transparency channel, its hue affects the 
appearance of colors viewed through the 
transparent shader. Its brightness 
determines how transparent the shader 
is. Darker colors produce less 
transparency; brighter colors produce 
more.

When light rays pass through a semi-
transparent object, their trajectories are 
deflected. This phenomenon is known as 
refraction. Glass, fluids, and other 
translucent materials refract light to some 
degree. This results in a distorted view of 
objects behind the refractive surface. 

A simple refraction experiment: Stand a pencil in a 

The distorted view of the snorkel hose was 
created by using refraction on the mask.

Shaders
values a
should h
experim
the effec

• Colo
chan
Refr
to va

The de
channe
value o
ttings in a shader’s Glow channel 
ine the shader’s luminance. An 

 whose shader has a high degree of 
nce will appear bright, even if it is 
by ambient light or external light 
s.

g shaders can be used to simulate 
like neon tubing, lit windows in a 
pe at night, or the LED display of a 

 clock. They can also be used for the 
 purpose of brightening a particular 

 in a dimly lit scene. This allows you 
hasize an object without affecting 
ting and mood of your entire scene.
• Using values in the Transparency channel 
produces the same effect as using shades 
of gray. Only the amount of transparency 
is affected.

• A 100% transparent surface may not be 
completely invisible—depending on the 
settings in the other channels, it may still 
refract and show highlights.

The default content of the Transparency 
channel is a Value component, set to a 
value of zero.

glass of water. Refraction “bends” the pencil where it 
enters the water.

A single Value component is generally all 
you’ll need to place in the Refraction 
channel. 

Note: The setting in the Refraction channel 
only affects a shader with some degree of 
transparency. Light must pass through in 
order to be refracted.
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view in the upper left corner of the 
ditor shows you what the shader 

editing looks like. Each time you 
he shader tree, Ray Dream Studio 
 the preview to show how your 
ffects the shader.

am Studio’s Shader Editor palette 
 a preview of your shader.

Status Area
Objects with glowing shaders do not cast light on 
other objects in the scene.

Although a Value component can be used 
in the Glow channel, a Color or Texture 
Map component is more appropriate. For 
realistic results, try using similar colors in 
the Color and Glow channels. 

To create unusual effects, you can place 
markedly different colors in these two 
channels. For example, you might create a 
shader which appears green when well lit, 
but glows red when covered in shadow.

Building and Editing 
Shaders

Most of the work in building and modifying 
a shader takes place in the Current Shader 
Editor. The Browser palette: Shaders 
tab and shader document windows are 
also useful.

The Current Shader Editor
The Current Shader Editor palette 
provides all of the tools for customizing a 
shader.

You can use the Current Shader Editor to 
design a new shader, modify a shader 

The pre
Shader E
you are 
change t
updates
change a

Ray Dre
provides

Preview
 choose a spherical preview, which 
ou how your shader will look on 
ce of an object, or a flat preview, 

ives you an undistorted view of 2D 
ata like texture maps. 

choose between a spherical shader 
..
• When you use color data (a Color 
component, a Texture Map, or a complex 
subshader) in the Glow channel, its hue 
determines the color of the glow, and its 
brightness determines the intensity.

For a related glow technique, refer to “Aura” on 
page 359.

you’ve stored in the Browser, or edit a 
shader you’ve applied to an object or paint 
shape.

To display the Current Shader Editor:

Choose Windows menu> Current 

Shader Editor.

The contents of the Shader Editor depend 
on what type of shader you’re editing: a 
Composite shader or a Global Mix shader.

Because a Composite shader’s tree can be 
quite complex, the Shader Editor does not 
display the entire tree at once. At any given 
time, you’ll work with only the portion of 

You can
shows y
the surfa
which g
image d

You can 
preview.
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at shader preview.
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the tree beneath a single shader channel. 
You can use the eight channel tabs to move 
from one channel to another. ... or a fl



• You may also open a shader document 
m the Browser and drag its 
mponents or subshaders into the 
ader Editor.

f you drop a shader or subshader 
 place holder where its type is 
opriate, Ray Dream Studio alerts 
r example, you can’t put a Global 

ader where a simple component is 
d.

n you’re finished designing, either 
y your new shader to an object or 
it to the Browser.

 the current shader to the 
To switch between spherical and flat 
preview: 

Choose Current Shader Editor palette: 
View menu> Sphere Preview or Flat 
Preview.

Note: This change affects only the preview 
of the shader you are currently editing.

To switch between shader channels: 

Click the channel tab for the channel you 
want to edit. 

The Shader Editor displays the branch of 
the tree beneath the channel you have 
chosen.

To design a new shader:

The Shader Editor.

Global Mix Shader

Composite Shader

Channel 
Tabs fro

co
Sh

Note: I
onto a
inappr
you. Fo
Mix sh
require

3Whe
appl
add 

To add

er:

 the shader preview from the 
ent Shader Editor to the Browser 
tte.

ou must drop the shader under a 
ry column.

Dream Studio prompts you to name 
ew shader.

r a name and click OK.
Note: The top level of a Global Mix shader’s 
tree is fixed—it always contains a Global 
Mix component with three branches. The 
middle branch contains the mixing 
function, and the left and right branches 
contain the subshaders being mixed. 
Because all eight channels of the 
subshaders are mixed with the same 
function, no channel tabs appear in the 
Shader Editor when you are editing the top 
level of a Global Mix shader.

1Choose Windows menu> Current 

Shader Editor.

2Use the Shader Editor tools and features 
to design the shader.

• Choose a tab, select a place holder, and 
add a component from the Insert 
menu.

Note: Refer to the earlier portions of this 
chapter for information on the shader 
components. Instructions for navigating 
and editing the shader tree appear below.

• You may also drag a shader from the 
browser into an appropriate place 
holder in the Shader Editor, where it 

Brows

1Drag
Curr
pale

Note: Y
directo

Ray 
the n

2Ente
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an object’s primer or a paint 
 shader:

e the Paint Shape Selection tool.

y the Current Shader Editor 
e.

an object to edit its primer—make 
ou click an area where there are no 
shapes. 

on a paint shape to edit its shader.
To open/edit a shader from the Browser:

1Double-click on the shader you want to 
edit. 

Note: In the Browser, shaders are saved as 
documents.

Ray Dream Studio opens it in a shader 
document window. 

You may also drag and drop components 
or subshaders from the Current Shader 
Editor or other open shader documents.

You may add or change components 
using the Insert menu on the main menu 
bar. This menu holds the same items as 
the Insert menu on the Current Shader 
Editor palette.

3Click Apply to apply the modified shader 
to a selected object.

4Click Use to move the contents of the 
document to the Current Shader editor.

5You can save the modifications to the 
shader:

To edit 
shape’s

1Choos

2Displa
palett

3Click 
sure y
paint 

4Click 
he Current Shader Editor isn’t 
open, double-click an object or 
ape to open the shader in the 

e shader tree by adding, 
ing, and modifying shader 

onents. 

ctions for navigating and editing 
ader tree appear below.

 you are satisfied with the changes 
e made, click the Apply button in 
ader Editor.

ting the Shader Tree
Note: If you don’t see the shader document 
window right away, it might be hidden 
under one of the floating palettes—the 
Current Shader Editor or Browser palette.

2Edit the shader by adjusting sliders and 
other settings. 

Double-click on the shader to display the 
shader document window. 

• Make sure the shader document is the 
active window.

• Choose File menu> Save. 

Ray Dream Studio saves the changes into 
the Browser document file.

6If you want to save the shader under a 
different name:

• Drag the preview into the Browser. 

• Enter a new name.

7Close the shader document window 
when you’re done.

Note: If t
already 
paint sh
editor.

5Edit th
remov
comp

Instru
the sh

6When
you’v
the Sh
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ex shader tree has many levels. 
e the tree branches, a new level is 
hen you are working with a 
Chapt
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Composite shader, you can choose to view 

u jump into the left or right subshader of a 
ix shader, the channel tabs appear, giving you 

o the settings in each of the subshader’s 
s.

p into a subshader:

are two ways to jump into a 
der.

ble-click the preview of the 
hader.

 on the preview to select it, then 
se Current Shader Editor 
just one level at a time, or you can expand 
the tree to show all of the levels beneath a 
particular channel. 

Viewing all levels requires more space on 
your screen, but eliminates the need to 
jump from one level to another to edit 
components.

To choose a display mode: 

Choose Current Shader Editor palette: 
View menu> One level or All levels. 

The All levels display option does not apply to Global 
Mix shaders. If you want to edit the subshaders on the 

Jumping into this subshader...
Subshader

When yo
Global M
access t
channel

To jum

There 
subsha

• Dou
subs

• Click
choo
tte: View menu> Next Level.

p out of a subshader:

are two ways to jump out of a 
der.

ose Current Shader Editor 
tte: View menu> Previous 
l.

tiny arrow in the lower right corner of 
hader Editor’s main preview 
ates a pop-up. Press on it and select 

higher level.
left and right branches, you need to “jump into” 
them—see below.

In the following examples, the Shader 
Editor is set to display only one level at a 
time. The screen shot on the left shows the 
highest level of a Composite shader’s Color 
channel. The screen shot on the right 
shows a subshader on the level 
immediately below.

In the screen shot on the left, notice that 
one branch of the Mix operator contains a 
preview sphere, rather than a set of 
controls. This indicates that the branch 

level. To edit the subshader, you would 
need to “jump into” it—that is, jump down 
to the next level of the shader tree. After 
you finished viewing and editing the 
components in the subshader, you could 
then “jump out,” back to the level above.

...allows you to edit its components.

pale

To jum

There 
subsha

• Cho
pale

Leve

• The 
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contains a subshader and that the tree 
continues to branch below the current 



 components by dragging:

ubshaders or component onto the 
f the shader tree where you 

an drag a shader from the Browser.

an drag a component or subshader 
n open shader Browser document. 
as the advantage of bringing all of 
ameters with it.

ream Studio copies the component 
shader you drag onto the branch 
 you drop it, replacing any 

nts that may have been there 
.

Editing the Shader Tree

You’ll build a shader by placing 
components and subshaders on the 
branches of the shader tree. To edit a 
shader tree, you simply add, remove, and 
replace shader components.

Ray Dream Studio’s drag and drop interface 
pertains not only to applying shaders, but 
also to building them. You can drag a 
component or subshader from one branch 
of the shader tree to another. You can also 
drop a shader from the Shaders Browser 
onto a branch of the shader tree, or drag a 
subshader from the tree into the Browser 
for storage.

To place a shader component or 
subshader on the shader tree:

1Display the shader channel tab where 
you want to work.

2Click on the branch (component or place 
holder) you want to select. Ray Dream 
Studio outlines the selected branch in 
gray.

Note: The root of the channel is 
automatically selected.

If the component you select is the root of 
a subshader, the entire subshader is 
selected.

To move

Drag a s
branch o
want it.

• You c

• You c
from a
This h
its par

Ray D
or sub
where
conte
before
u drop a shader onto any branch 
posite shader, only the contents of 
icable channel are placed on the 
If the shader you’re dropping has 
onents in the applicable channel, 

am Studio notifies you, and nothing 
 to the branch.

hen you drop a shader onto the left 
branch of a Global Mix shader, the 
ader you’re dropping (all eight 

s) is placed on the tree.
This section describes how to construct a shader tree 
from a collection of components. For detailed 
descriptions of the various shader components and a 
discussion of how they interact, refer to “Shader 
Structure and Content” on page 198.

To specify a shader type—Composite or 
Global Mix: 

Choose Shader Editor palette: Insert 
menu> Composite or Global Mix. 

This replaces the current contents of the 
Editor with an empty Composite or Global 

3Choose the component you want to add 
from the Current Shader Editor 
palette: Insert menu.

Note: If you’re working in a shader 
document, not the Editor, the Insert menu 
is on the main menu bar.

For complete information on the 
components, refer to “Shader 
Components” on page 201.

Note: When you add a simple component to 
the left or right subshader branch of a 
Global Mix shader, it is placed in the Color 
channel of the subshader. To edit its 
settings, you need to jump into the 

When yo
of a Com
the appl
branch. 
no comp
Ray Dre
is added

Note: W
or right 
entire sh
channel
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To remove the contents of a branch: 

1Select a component or subshader.

2Choose Edit menu> Clear, or press the 
Delete/Backspace key. 

If the component you remove is the root 
of a subshader, Ray Dream Studio 
removes the entire subshader.

To copy a component or subshader to 
another channel: 

Drag a component or subshader from its 
branch and drop it on a different channel 
tab.
Ray Dream Studio replaces the entire 
contents of the channel with the 
component or subshader you drop.

or

Drag a component or subshader from its 
branch and hold it over any channel tab. 
After a moment, that tab comes forward 
and you can drop the shader onto any 
branch in that channel. 

Ray Dream Studio replaces that component 
or subshader with what you drop.
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12

 

Arranging 
Objects

 

Overview

 

This chapter describes the 3D workspace 
displayed in the 

 

Perspective

 

 window 
(where you build your scene). It also 
covers the different ways of moving and 
arranging your objects.

All arrangement procedures take place in 
the 

 

Perspective

 

 window.
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The Workspace

                    

ion Tool (Shift-T) 

 

e 

 

Selection

 

 tool to select, move or 
3D objects, 2D projections and 
 of objects. 

-click on an object to open it in the 
ing window. Double-click on a group 
p into it.

 

l Trackball Tool (Shift-V) 

 

e 

 

Virtual Trackball

 

 tool to orient 
d objects in 3D space. 
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The Universe
Ray Dream Studio 5’s three-dimensional 
workspace is called the universe. The 
universe is where all objects are displayed, 
assembled and manipulated. By default, 
Ray Dream Studio opens new scenes with 
one light and one camera in the universe. 
This camera provides the view of the scene 
universe shown in the Perspective window.

Ray Dream Studio uses a coordinate 
system called the Cartesian coordinate 
system to reference positions in the 
universe. A triplet of unique coordinates (x, 

Arranging Tools

Shading tools

Display Plane tool

Light

Light’s 2D Projection

Working Box

Select

Use th
resize 
groups

Double
model
to jum

Virtua

Use th
selecte
ion Tool (Shift-Q) 

e Rotation tool to rotate an object in 
ng one of the working box planes.

iewing Tools
ewing tools let you change scale and 
te the display, which helps when 
ing objects.

 tool
y, z) is associated with each individual 
position in the universe. 

The maximum volume of the universe is a 
3.32 kilometer cube. On the other end of 
the scale, the minimum dimension of an 
object is 0.006 millimeters. You can specify 
your object sizes in the measurement unit 
of your choice as long as they stay within 
that range. In a practical sense, only the 
region of the universe where objects exist 
is part of your scene.

The grids displayed in the Perspective 
window describe faces of a cube called the 
working box. The working box is a visual 
reference of the global universe and a tool 
to help you manipulate objects. You’ll find 

The Arranging Tools
The Arranging tools let you perform every 
basic operation (alignment, orientation, 
positioning) by dragging in the Perspective 
window. These tools are located in the 
upper or left-most part of the toolbar. 

To select a tool, click its icon or use press 
its keyboard shortcut. 

The mouse pointer takes on a distinctive 
cursor shape that depends upon the tool 
chosen.

The Perspective window contains many 
features to allow you to display and view 
your images. 

Shape Creation tools

Rotat

Use th
2D alo

The V
The vi
naviga
arrang

Zoom
e Zoom tool to magnify the view in 
rspective window. 
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out more about the working box later in 
this chapter.

Use th
the Pe



                                            

lt, the working box is centered on 

 

king box consists of grids which can 
as a visual reference in the universe. 
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You can press Command-Spacebar/
Ctrl+Spacebar to temporarily choose the 
Zoom tool. When you release the keys, the 
previous tool returns.

Note: The Zoom tool and Zoom pop-up only 
enlarge the view displayed in the 
Perspective window. They do not move the 
camera that provides the view of the scene.

To zoom in and out:

Click once to magnify the window’s view by 
a factor of two. 

Hold down the Option/Alt key and click to 
zoom back out. 

Hand Tool

Use the Hand tool to pan around the 
window. Drag the area you want into view.

You can press the Spacebar to temporarily 
choose the Hand tool. When you release 
the Spacebar, the previous tool returns.

Alternatively, you may use the window 
scroll bars to pan the view. 

The Working Box
The working box appears in the 
Perspective window as three intersecting 
grids, like three sides of a box. These grids 

By defau

The wor
be used 
in (0, 0, 0 of the universe) and 
with the axes of the universe. The 
ere the grid planes meet show the 
 z dimensions of the universe. 

king box is moveable, though, so 
 set it at different angles and move 
rom the origin. A number of useful 
ns require you to move the 
 box into position first.

e, you can think of the working box 
e-dimensional ruler that helps you 
jects together more easily and 
ly.
To magnify a specific area of the scene:

Drag a marquee around it. Ray Dream 
Studio magnifies the selected area to the 
closest corresponding zoom level. 

To set a specific magnification:

Use the Zoom Level pop-up, located in the 
bottom left corner of the window, to 
choose a magnification level. 

are a visual reference for the dimensions of 
the universe. 

When you open a new scene, the “floor” 
might be the only plane visible. You can 
change display of the working box to show 
none, one, two or all three of its grid 
planes.

The working box planes show projections 
(like shadows) for the objects in the scene. 
These projections help you see which 
objects are “farther away,” “higher” or 
“tilted,” and help you move the objects into 
the positions and orientation you want. 

the orig
aligned 
lines wh
x, y and

The wor
you can
it away f
operatio
working

If you lik
as a thre
bring ob
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Changing Display of the Grid Planes

                            

Changing Grid Options and Color

 

rking box’s grid can be used for 
ting real world size, or positioning 
s.

 

 grid options: 

  

ose 

 

View menu> Grid

 

 or press 

 

mand-J

 

/

 

Ctrl+J

 

. The 

 

Grid Settings

 

 
g appears.
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By default, only one of the grid planes is 
visible when you first launch the program. 
You can customize the display of the 
working box to display any, all, or none of 
the grid planes for all sessions by setting 
the Plane Display button.

The Plane Display tool is the only tool in 
the Planes toolbar. It has four active areas: 
the three planes and the object preview. 

Use the Plane Display tool to toggle the grid 
planes on and off. 

The Active Plane

The active plane is the plane of reference 

Click on the grid plane to turn the sides of the 
working box on and off. 

Grid plane off

Grid off in 
Working Box

The wo
estima
object

To set

1Cho
Com
dialo
r a Spacing amount to set the grid 
ement. You can type in a value or 
 the increment/decrement buttons. 

 can also drag the increment button 
r drag the decrement button down 
ove quickly to a new value.

Spacing increment is used for 
ging” (moving an object with an 
w key). 

ose a unit from the pop-up. 

 Grid Settings dialog to set the grid 
ents.
To display or hide a working box plane: 

Click on the plane you want to show or hide 
to toggle it on or off. Shaded planes are 
displayed; white ones aren’t.

The object preview, represented by the 
cube at the center of the Plane Display 
button, allows you to toggle display of the 
object preview. 

used when dragging objects in the 
Perspective window and for other 
positioning operations. The working box 
shows the active plane in a different color 
from the other two. The Plane Display tool 
identifies the active plane by displaying it 
in blue. 

You can set the active plane to control your 
next series of operations.

To change the active plane:

Hold down the Option/Alt key and click on 
the plane you want active in the Plane 
Display tool.

2Ente
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click
You
up o
to m

The 
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3Cho

Use the
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ng the Position and Attitude of 
rking Box

 

sible to move and orient an object 
e in the universe without making 
stment to the working box. 
r, using the working box can 
 many types of arrangement 
ns.

 set the attitude of the working box 
ticular arrangement operation, or 
erations. For example, to make 

g objects on an angle easier, you 
t the angle of the working box, then 
n object down the slope of the 
lane. This is just one example. 
d a number of ways to take 

       

CH12.rds5  Page 227  Wednesday, July 2, 1997  3:47 PM
The unit you choose should make sense 
for the scene you are building. For 
example, if you’re creating a building, 
one foot or meter should provide enough 
accuracy for most operations.

4Change the Draw Line Every value to 
control how many grid lines are drawn.

The value sets the number of increments 
between grid lines. When the setting is 1, 
the increment and displayed grid 
correspond directly.

Set the Draw a Line Every option to a value >1 if you 
want fine control over the Snap to Grid function but do 

Working Box Properties

To change working box properties:

1Choose the Selection tool.

2Choose Windows menu> Properties. 
The the Properties palette appears.

3Hold down the Command/Ctrl key and 
click on the working box grid.

The Properties palette updates to show 
the working box properties.

• The General tab contains controls for 
the plane display colors and grid 
options.

Changi
the Wo

It is pos
anywher
any adju
Howeve
simplify
operatio

You can
for a par
set of op
orientin
can rese
“slide” a
active p
You’ll fin
ge of the working box.

ch operation, you’ll need to move 
ent the working box for the next 

 the Working Box

e several ways to orient the 
 box: Rotate it with the Virtual 
ll, send it to another coordinate 
r set its attitude numerically.

anging the working box does not 
ur existing objects. The orientation 
orking box applies only to 
ent arrangement operations.
not want many grid lines visible.

5If you want to hide the grid lines, disable 
Show Grid. 

When Show Grid is disabled, only the 
edges of the planes are shown.

Note: Even if the Show Grid option is not 
selected, object hot points will snap to the 
grid if Snap to Grid is selected.

6Enable Snap to Grid if you want objects 
to “jump” to the nearest grid increment 
when you drag them.

• The Transform tab contains controls 
for working box size, orientation, and 
position in the universe.

You can set your preference for the size and colors of 
the working box in new documents in the File 
menu> Preferences dialog: 
Perspective and Colors panels. 

advanta

After ea
or re-ori
task.

Moving

There ar
working
Trackba
system o

Note: Ch
affect yo
of the w
subsequ
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Note: The hot point of the object, not the 
edge of the projection, snaps to the grid. 



                                            

3Choose Windows menu> Properties. Ray Dream Studio sets the working box 
es parallel to the sides of the 
cted object or group bounding box. 
coordinate systems of the working 
and object (or group) are now 
ed.

nding box is the smallest box that encloses 
t or group of objects. Bounding boxes appear 
bjects that are selected. 

n the working box on gravity

 down the Command/Ctrl key and 
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To move the working box: 

1Choose the Selection tool.

2Hold down the Command/Ctrl key and 
drag the working box.

To resize the working box: 

1Choose the Selection tool.

2Hold down the Command/Ctrl key and 
drag a corner of one of the grid planes.

To orient the working box with the 

4Choose Properties palette: 
Transform tab.

The transform properties include 
Position, Orientation and Size controls.

5Choose the coordinate system you want 
from the System pop-up.

In most cases, you’ll move the working 
box in relation to the global universe. 

6Use the Position controls to set the 
Center x, y, z position values for the 
center of the working box.

plan
sele
The 
box 
align

The bou
an objec
around o

To alig

1Hold

 the working box to select it.

ose Arrange menu> Align> On 
ity. You’ll find a description of this 

mand in “Special Orientation 
ures” on page 243.

d the working box to a position:

n send the Working Box to a 
lar position. The position may be 
ined by the Global Universe or an 
/Group bounding box.

u want to send the working box to an 
ct or group, select that object or 
p.
Virtual Trackball:

1Choose the Virtual Trackball tool.

2Hold down the Command/Ctrl key and 
drag on the working box grid. 

The working box revolves about its 
center as you drag.

To position or orient the working box 
numerically:

1Choose the Selection tool.

2Hold down the Command/Ctrl key and 
click the working box to select it.

7Use the Orientation controls to set the 
yaw, pitch, and roll values to orient the 
working box.

8Use the Size (Scaling) controls to change 
the dimensions of the working box.

9Click Apply to make the changes.

To align the working box to an object or 
group:

1Select an object or group.

2Choose Arrange menu> Align 
Working Box.

click

2Cho
Grav

com
Feat

To sen

You ca
particu
determ
Object

1If yo
obje
grou
228 Ray Dream Studio User Guide

“Handles” appear at the working box 
corners when it is selected.



eview does not show the objects 
elves; however, their bounding 

rojections still appear on the 
ng box planes. 

ere is no toolbar icon for No 
.

ing Box displays only the 
ing boxes for the objects.
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2Choose Arrange menu> Send 
Working Box To> and select the 
position you want: Global Universe, 
Local Universe, or Selection—if you 
have one. 

Global Universe The Working Box 
moves to align its origin with the origin 
of the global universe.

Local Universe This option is available 
only when “Jumped Into” a group. The 
Working Box moves to align its origin 
with the center of the group bounding 
box.

Selection This option is available only 
The Perspective window displays projections 
of objects in the form of bounding boxes. 

2D 
Projections

 Working 
Box

Hot Point 
Projection

3D Object 
Preview in 
Bounding Box

2D Projection

Hot Point 
Projection

Object’s Hot 
Point 

Hot Point 
Projection

No Pr
thems
box p
worki

Note: Th
Preview

Bound
bound
g box preview example.
when an object or group is selected. The 
Working Box moves to align its origin 
with the center of the object or group 
bounding box.

In all cases, the working box is resized to 
a scale appropriate to the new position.

Objects in the Scene

Object Preview

Objects are shown in the Perspective 
window by a preview. The display is called 
a preview because the level of detail is 
below that of the final rendering.

In all preview modes, objects create 
projections on the working box planes. And 

To set the level of preview detail for all 
the objects in the Perspective window:

Choose View menu> and select the 
preview mode you want. You may also click 
on the standard toolbar icon for the 
preview quality you want. 

Click on one of the icons from the Rendering 
toolbar to change the quality of the objects in 

Bounding box
Wireframe

Preview Shaded Preview

Better Preview

Boundin
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selected objects display their bounding 
boxes.

the Perspective window. 



Wireframe displays objects as a mesh of Shaded Preview displays objects using 

tter Preview increases the time required to 
 and draw or redraw the Perspective window. 

 object displayed in the Better 
 mode.
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wires.

Preview displays objects with colored 

Sample object displayed in the Wireframe 
preview mode.

scene lighting to shade it and show its 3D 
shape. This display mode uses lower 
resolution textures and a faster shading 
method than Better preview. 

Sample object displayed in the Shaded 

Using Be
calculate

Sample
preview
ase the efficiency of the application, work in 
e, Preview or Bounding Box mode at the 

f a project, then switch to Better Preview mode 
pecific shading detail becomes more 
t. Use the Render Area tool whenever 

 instead of switching to Better Preview.

e an object: 

ct the object.

ose View menu> Object Visible/
ct Invisible.
surfaces. Only the outlines of painted 
shapes are shown. The lighting is 
arbitrary.

Sample object displayed in the Preview 
mode.

Note: Shaded Preview is the only display 
mode that uses QuickDraw 3D or Direct3D 
acceleration. For more information, refer to 
“Shaded Preview Preferences” on page 24.

Better Preview displays objects using 
ambient light and your specific light 
sources to show color, highlights, gel 
effects, and depth shading. Displays 
shading, texture maps, and paint regions, 
in detail. Provides better details of the 
shape and color of objects.

preview mode. To incre
Wirefram
outset o
only as s
importan
possible

To hid

1Sele

2Cho
Obje
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t objects with the Selection tool:

the Selection tool.

 Perspective window, click on the 
w or on one of the projections for 
ject you want to select.

own the Shift key and click other 
ts to add to the selection. Shift-click 
ject that’s already selected to 
ct it from the selection.

mber of objects overlap, position 
rsor over the object (preview or 
tion) and hold the mouse button 

. A pop-up appears, listing all of the 
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Bounding Boxes and Projections

The bounding box is the smallest box that 
encloses an object or group of objects. 
Bounding boxes appear around objects 
that are selected. 

The bounding boxes of all objects, 
including cameras and spot lights, cast 2D 
profiles, called projections, on the planes 
of the working box. These projections show 
the object’s position and orientation in 
relation to each of the three planes. You 
can drag the projection to manipulate the 
object with respect to that plane. 

Objects may be collected to form a group. All of the 

To change the name of an object or 
group:

1Select the object or group with the 
Selection tool. 

2Choose Windows menu> Properties. 
The Properties palette appears.

3Click the General tab.

4Enter a new, descriptive name.

Note: You may also select an object’s 
listing in the hierarchy and press Return/
Enter to change the name.

To selec

1Click 

2In the
previe
the ob

Hold d
objec
an ob
subtra

3If a nu
the cu
projec
down
ts beneath the cursor at that point. 
 the object you want. 

e the object name followed by XY, 
 YZ for a 2D projection or 3D, for a 
ject. To select the object’s Hot 
 choose the item containing the 
t’s name followed by HP.
positioning, scale and orientation features available 
for objects apply equally to groups. For more 
information on how to build groups, refer to “Building 
a Hierarchical Structure” on page 254.

Naming Objects

New objects are named by default Type n, 
where Type is the object description (Free 
Form, Sphere, Text, etc...) and n is the 
number of similar objects in the order 
created—Free Form 1, Free Form 2 and so 
forth. 

You can change the name of objects and 
groups. Giving objects and groups 
descriptive names can make them easier to 

Selecting Objects
You’ll select one or more objects before 
choosing a command. 

A selected object displays its bounding 
box, the 2D projections have handles at the 
corners, and its item in the hierarchy is 
highlighted.

Ray Dream Studio 5 provides several ways 
to select objects:

• By using the Selection tool in the 
Perspective window to click on the object 
preview or one of the projections.

• By clicking an item or dragging a marquee 
over one or several items in the 
hierarchy.

objec
Select

4Choos
ZX or
3D ob
Point,
objec
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locate and select. • With the Find command.



Arranging Objects

ing is the process of positioning and 
ng objects. The most significant part 
bject’s arrangement is its spatial 
nship to other objects. In most 
the absolute arrangement (in 
n to the Global Universe) is relevant 
 the extent of what seems “upright” 

. For example, you’d probably find it 
ing to work in an upside-down scene, 
lass of wine placed at any attitude 
han upright would seem to defy 
 if the wine did not spill. 

ike, you can create a tilted or upside 
orld simply by changing the 
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To select objects in the hierarchy:

Click the object’s icon in the hierarchy.

Hold down the mouse button on an object to 
display the Selection pop-up. 

To Find and select an object: 

1Choose Edit menu> Find. The Find 
dialog appears.

2Enter the name of the object to locate. 
You may enter a portion of the name.

3Click the radio button for the 

Use the Find dialog to locate a specific 
object. 

Arrang
orienti
of an o
relatio
cases, 
relatio
only to
to you
confus
and a g
other t
gravity

If you l
down w
e of your camera. This is far easier 
orking in a skewed universe.

ing one object in relation to another 
quire a series of positioning, 
tion, and alignment operations. 
f these commands operate under 

nstraints of the working box. Setting 
rking box appropriately before 
g an operation greatly simplifies the 
ure. 

e the relationship of objects to one 
r is the most important part of 
ement, resizing may also be 
ary.
You may also drag a marquee around the 
objects, if you want to select several.

Hold down the Shift key and click other 
objects (or drag another marquee) to add 
to the selection. Shift-drag over items that 
are already selected to subtract them from 
the selection.

You’ll find complete information on 
working with the hierarchy in Chapter 13, 
“Building a Scene.”

appropriate matching method—Is, 
Contains, Starts with, or Ends with.

4Click Find to begin the search. 

Ray Dream Studio selects the first object 
that matches the search criteria. 

5Click Find again to select the next object 
that matches the search criteria.

attitud
than w

Arrang
may re
orienta
Many o
the co
the wo
startin
proced

Becaus
anothe
arrang
necess
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 on Caps Lock and holding down Command/
dragging, you can drag an object by its hot 
ss a contoured surface. The object you drag 
 its distance from the surface across any 

matically center a hot point:

 the object or group in the 
ective window.

e the Arrange menu> Center 
oint or press Command-Option-H/
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Except where noted, all of the positioning, 
orienting, aligning, and resizing commands 
work with either simple or grouped 
objects.

For information on grouping objects, refer to “Building 
a Hierarchical Structure” on page 254.

The Hot Point
The hot point is the single point of an 
object or group that identifies its center of 
rotation. 

The hot point of selected objects and 

By default, an object or group’s hot point is 
at the center of its bounding box. You can 
move the hot point to any point in, on the 
surface, or some distance from the object.

Where you put the hot point depends on 
the type of arrangement operation you are 
planning. Different operations suggest 
different placements of the hot point. 

For example, with the hot point at the 
center of an object, a rotate command 
spins the object in place. However, with the 
hot point placed some distance away, the 
object will rotate around its hot point, like 
a planet orbiting around its sun.

By putting
Ctrl while 
point acro
maintains
contour.

To auto

1Select
Persp

2Choos
Hot P
lt+H. Ray Dream Studio moves the 
int to the center of the object or 

 bounding box.

ay also use the “Send to” arrow 
s up) on the Properties palette: 
form tab: Position controls to 
he hot point to the center.

end To button to send the hot point 
he center. 
groups appears in the Perspective window 
as a small 3D sphere, which also casts 2D 
projections.

Hot Point and projections. 

Hot Point

Hot Point Projection

Hot Point Projection

To move a hot point by dragging:

1Choose the Selection tool.

2Select the object or group whose hot 
point you want to move.

3Drag the hot point in 3D or drag one of its 
2D projections. 

Hold down Option/Alt to drag the hot 
point perpendicular to the active plane.

If you turn on Caps Lock on your 
keyboard, you can lock the object to its 
hot point. In this case, if you drag the hot 
point, the object moves with it.

Ctrl+A
hot po
group

You m
(point
Trans

send t

Use the S
back to t
r 12 • Arranging Objects 233
Chapte

If you drag in 3D with the Command/Ctrl 
key down, the hot point snaps to the 
surface of the object beneath it. 



Working Box lets you specify the hot 

ce the hot point back in the center 
object: 

ct the object or group.

lay the Properties palette: 
sform tab: Position controls.

 the “Send to” arrow (points up 
een Hot Point and Center) to send 
ot point to the center of the object 

roup bounding box.

tioning Objects
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To move a hot point numerically:

1Select the object or group.

2Choose Windows menu> Properties. 
The Properties palette appears.

3Choose the Transform tab.

The Properties palette: Transform 
tab: Position controls display the 
position of the hot point (x,y,z 
coordinates). 

point location in relation to the working 
box. This will be useful if you’ve moved 
the working box to a particular, 
significant location and attitude. 

Local lets you specify the hot point 
location with respect to the center of the 
object or group bounding box. This is 
useful if you want to move the hot point 
(out from the center) on a particular 
axis. 

Raw Data lets you use Studio’s internal 
transform data to control the object.

If you are using Global or Working Box 
and you want the object to move with its 

To pla
of the 

1Sele

2Disp
Tran

3Click
betw
the h
or g

Posi
position objects to move them to 
lar locations in your scene. 

t cases, the most important part of 
ct’s position is its location relative 
r objects. Often, to create the 
 relationships, you will use the 
ning tools in conjunction with the 
tion and alignment tools.

ning applies to objects and groups, 
 as lights and cameras. In this 
, the term “object” also refers to 

as and lights.
4Use the System pop-up to select the 
coordinate system you want to use.

The Transform tab in the Properties palette 
can be used to numerically set the hot point 
position. 

hot point, click the Lock icon.

The hot point is locked in relation to the 
object when the Lock icon “connects” 
the Center and Hot Point fields.

Click the Lock again to disconnect the 
references and allow them to move 
independently.

5Enter new position values for the hot 
point. 

6Click Apply to move the hot point to that 
location.

You can enable Auto (Apply) if you want 

You’ll 
particu

In mos
an obje
to othe
desired
positio
orienta

Positio
as well
section
camer
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Global lets you specify the hot point 
location in the universe.

the hot point to move to the positions 
you enter automatically.



 along active plane moves it 
to that plane.
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Remember that the appearance of your scene is 
determined not only by the position of objects, but by 
your point of view—the location of the camera you’re 
looking through. With two objects in your scene, you 
can switch their relative positions, left-to-right, by 
simply placing the camera on the other side of the 
scene. 

Note: Most artists build the scene around 
the center of the universe (0, 0, 0). This 
offers the advantage that an objects global 
position describes its position from the 
center of the scene.

Remember that the planes of the working box extend 
throughout the universe. The visible grid is merely a 
reference of the orientation of those planes and does 
not restrict you to the visible space.

To move an object parallel to the active 
plane: 

1Choose the Selection tool.

2Drag the object’s preview where you 
want it.

Hold down the Shift key to constrain the 

Dragging
parallel 
 an object perpendicular to the 
lane: 

e the Selection tool.

own the Option/Alt key and drag 
ject preview.

uing the above example: To raise 
er the object (move it in z), hold 

 Option/Alt when you drag it. In 
ase, the object moves in working 
 but the working box x and y do not 
e.
Ray Dream Studio 5 provides several ways 
to position objects: Dragging, Nudging, and 
Numerical Positioning.

Dragging Objects
The easiest way to move an object through 
space is to drag it with the Selection tool. 

These dragging operations use the working 
box planes as the dimensional reference. 
Remember that you can orient the working 
box to a particular attitude before dragging 
an object. For information on moving and 
orienting the working box, refer to 
“Changing the Position and Attitude of the 
Working Box” on page 227.

drag angle to an increment of 45°.

Note: For information on the active plane, 
refer to “The Active Plane” on page 226.

For example: The default active plane is 
the “floor” of the working box, which is 
defined by the x, y axes. Drag the object 
to move it anywhere in the working box x 
and y dimensions. The object maintains 
its height above the floor, so its position 
in the working box z dimension doesn’t 
change. 

To move
active p

1Choos

2Hold d
the ob

Contin
or low
down
this c
box z,
chang
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With Collision Detection disabled, you can Nudging Objects
g lets you move an object by 
g one of the Arrow keys on your 
rd.

g uses the working box active plane 
reference. The grid lines on the 
plane indicate the directions that the 
 keys move the object.

Up Right

Option/Alt-down

Option/Alt-up
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To move an object along a specific 

Hold down the Option/Alt key to drag an 
object perpendicular to active plane.

drag one object through another without 
resistance. Objects pass through each 
other without resistance.

Collision Detection is a great feature for 
bringing one object into contact with 
another—for example, putting plates and 
silverware on the dinner table. Collision 
Detection makes it easy to place the 
objects precisely on the table surface. 
Without Collision Detection, you might 
accidently leave a knife floating just above 
the table or embed it in the table itself.

To enable or disable Collision Detection:

1If necessary, display the Rendering 

Nudgin
pressin
keyboa

Nudgin
as the 
active 
Arrow
ber that you can orient the working 
 a particular attitude and change 
of the three is the active plane 
 nudging an object. For information 
nting the working box, refer to 
ing the Position and Attitude of the 
g Box” on page 227. For information 

 active plane, refer to “The Active 
 on page 226.

 Arrow keys on your keyboard to 
objects in the active plane. 

DownLeft

Active Plane
plane: 

1Choose the Selection tool.

2Drag the object’s projection in that 
plane. 

Hold down the Shift key to constrain the 
drag angle to an increment of 45°.

Collision Detection

Studio’s Collision Detection option 
instructs objects to “respect each other’s 
space.” With Collision Detection turned on, 
you can drag one object into another, and 
the object stops when its surface contacts 
the other object. If you continue to drag, 

toolbar.

2In the Rendering toolbar, click the 
Collision Detection button.

Collision Detection is on when the button 
is darkened.

The Collision Detection button.

Remem
box to
which 
before
on orie
“Chang
Workin
on the
Plane”

Use the
nudge 
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Studio releases the object and you can drag 
it right on through. 



d into a group and want to specify 
cation with respect to the center of 
oup’s bounding box (local origin). 

ata lets you use Studio’s internal 
orm data to control the object.

e the preferred units, if necessary.

 want to maintain the relationship 
en the object center and hot point, 
he Lock icon.

ot point is locked in relation to the 
t when the Lock icon “connects” 
nter and Hot Point fields.

ou want to move the object, but 
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To nudge an object: 

1Select one or more objects

2Press one of the Arrow keys.

The selected objects move parallel to the 
active plane one increment of the grid 
increment setting. For information on 
changing the grid increment, refer to 
“Changing Grid Options and Color” on 
page 226.

Hold down the Shift key when nudging to 
increase the nudge distance (grid 
increment) by a factor of 5.

Numerically Positioning Objects
Numerical positioning lets you enter x, y, z 
coordinate values to locate the object.

To position an object or group 
numerically:

1Select the object or group.

2Display the Properties palette: 
Transform tab: Position controls.

Use the position controls to numerically 

jumpe
the lo
the gr

Raw D
transf

4Choos

5If you
betwe
click t

The h
objec
the Ce

Note: If y

e hot point where it is: Disable the 
d use the Center fields to move the 

 the hot point and center are 
, you may use either the bounding 

enter or the Hot Point as the 
nce on the object or group.

x, y, z values position values for 
 the object Center or the Hot Point. 
an type in a value or use the scroll 
s.

Apply to move the object to that 
on.
To nudge perpendicular to the active 
plane: 

1Hold down the Option/Alt key and use 
the Up or Down Arrow key.

Hold down the Shift key when nudging to 
increase the nudge distance (grid 
increment) by a factor of 5.

3Use the System pop-up to select the 
coordinate system you want to use.

Global lets you specify the object 
location in the universe.

Working Box lets you specify the object 
location in relation to the working box. 
This will be useful if you’ve moved the 
working box to a particular, significant 
location and attitude. 

Local lets you specify the object location 
with respect to the center of the group 
bounding box. This is useful if you’ve 

position objects. leave th
Lock an
object.

When
locked
box C
refere

6Enter 
either
You c
arrow

7Click 
locati
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With two objects selected, Distance is Resizing Objects

you create an object, you model it at 
cular size. Once in the scene, you 
ale the object to new dimensions.

ost important aspect of an object’s 
its relationship to other objects. For 
le, if the cork is larger than the wine 
 one of them has the wrong scale.

e Ray Dream Studio allows you to 
ith real world units (inches feet, 
eters, meters, etc.), many artists 
bjects equivalent to their size in the 
rld. For example, a soft drink can is 

ches tall and 2.5 inches in diameter, 
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To send the object (center) to the hot 
point:

1Select the object or group.

2Display the Properties palette: 
Transform tab: Position controls.

3Click the Send to arrow (points down 
between Center and Hot Point) to move 
the center of the object or group 
bounding box to the hot point.

Measuring and Setting the 
Distance of Objects
Ray Dream Studio lets you measure the 
distance between any two objects. You 

the only tab available. The Distance field 
shows the distance between the object 
centers.

3Choose the units you’d like to use from 
the pop-up.

4From the Lock pop-up, choose which 
object you want to keep its position. The 
other object will move.

5Enter a new distance value. You can type 
in a value or use the scroll arrows.

6Click Apply to move the “unlocked” 
object to the specified distance from the 
other.

When 
a parti
can sc

The m
size is 
examp
bottle,

Becaus
work w
centim
scale o
real wo
4.75 in
akes sense to scale a can object to 
imensions. When you put a pencil 

 (0.62 inches in diameter and 7.4 
 long, unsharpened) next to the can, 
o objects have the correct size 
nship. 

eam Studio allows you to work with 
may enter a distance value to move one of 
the objects into position. 

This is particularly useful when the objects 
are aligned with one another and you want 
to move one of them closer to or farther 
from the other. 

To measure and set distance:

1Select two objects. This feature does not 
work if more than or less than two 
objects are selected.

2Choose Windows menu> Properties. 
The Properties palette appears.

Setting distance is particularly useful when positioning 
a camera. For example: The camera points directly at 
an object, but it’s just too far away and the object 
looks small. Select both the camera and the object. 
Lock the object, and set the distance lower to move 
the camera closer.

so it m
these d
object
inches
the tw
relatio

Ray Dr

rld units to maintain true size 

nships between objects.
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n/Alt: Resize only in the dimension 
ndicular to the active plane.

and/Ctrl: Resize using the hot 
as the reference. The hot point 
in place, and all eight corners of 
unding box move to resize the 

t.

hen using modifier keys, start 
, hold down the modifier key, 
he mouse, then release the key.

 you are satisfied with the object’s 
ize, release the mouse. 
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Note: Scaling in the scene does not change 
the size of the original (master) object. 

Ray Dream Studio allows you to resize an 
object or group in one of two ways: by 
dragging its bounding box or 2D projection 
handles (free resizing), or by using the 
Properties palette: Transform tab: 
Size & Scaling controls. In both cases, 
you can resize an object proportionally or 
disproportionally.

The size you create objects has little relationship to the 
size they appear in the final rendered image. The size 
of objects in the rendered image is determined not 
only by their dimensions, but more importantly by their 

Free Resizing
Free sizing lets you scale an object or 
group by dragging a corner of its bounding 
box or projection.

To resize an object or group:

1Select an object or group. 

You may select several objects, then resize one of them 
to apply the same scaling factor to all.

2With the Selection tool, drag one of the 
corners of the object’s bounding box. 

Optio
perpe

Comm
point 
stays 
the bo
objec

Note: W
dragging
release t

3When
new s
 bounding box and working box may not be 
 this case, the scaling dimensions are 
by the bounding box axes that are closest to 
llel with the active plane. Or with the 
 key down, the scaling axis is the box axis 
est to being perpendicular to the active 

ay change the relative positions of two 
r instance, a glass on a table, if enlarged, 
rough the table, and if shrunk, may seem to 
it. You can prevent this by using the plane at 
 of the glass as the reference for resizing—

dragging a corner at the top of the 
distance from the point of view. This is just like in the 
real world: a car right in front of you appears larger 
than when it’s parked down the block. In Ray Dream 
Studio 5, the point of view is the camera, so if you 
want to make objects appear larger in the rendering, 
either move the camera closer, or increase its focal 
length. For more information on moving the camera, 
refer to “Navigating the Current Camera” on 
page 290.

You may also drag the corner of a 
projection to scale in the dimensions of 
that plane.

With no keys down, you’ll scale the 
object disproportionally in the axes 
parallel to the active plane. The 
reference—which remains anchored in 
place—is the opposite corner (from the 
one you drag).

Note: Groups cannot be resized 
disproportionally. They are always scaled 
equally in all three dimensions.

The following modifier keys give you 
control resizing:

The object
aligned. In
described 
being para
Option/Alt
that’s clos
plane.

Resizing m
objects. Fo
may go th
float over 
the bottom
that is, by 
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box, not at its bottom.
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Shift: Maintain proportions. Resize 
equally in all three dimensions.

bounding 



Numerical Resizing The values in the Size fields give the 

e building a complex object, you will orient the 
 you assemble them. Then, group the complex 
 you can orient it as a single object. Of course, 
still “Jump Into the group” and change the 
orientations of the objects.

chnical terms that describe 
tion movements in an object’s own 

oordinate system or frame of 
ce are taken from aviation. Yaw 
xis) is the degree of rotation about 
right axis. Pitch (pink axis) is the 
 of front-to-back rotation. Roll (red 
 the degree of side-to-side rotation. 

imes the term attitude is used to 
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Numerical resizing allows you to enter size 
values or scaling percentages to resize the 
object in any or all dimensions.

To resize numerically:

1Select an object or group.

2Display the Properties palette: 
Transform tab: Size & Scaling 
controls.

dimensions (height, width, and depth) of 
the object’s bounding box. 

The Scaling fields give the scaling 
percentages in each dimension. When all 
three are at 100% the object is at the 
scale it was created.

Note: To return the object to its original 
size, enter 100 in each of the Scaling fields.

6Click Apply to move the object to that 
location.

Enable Auto (Apply) if you want the 
object to scale to the values you enter 
automatically.

If you ar
parts as
object so
you can 
relative 

The te
orienta
local c
referen
(blue a
the up
degree
axis) is
Somet
e the combined effect of yaw, pitch, 
ll.

eam Studio uses theory from aviation 
ntating objects.

Yaw

Pitch
3You can choose the units from the Units 
pop-up.

4Enabled the Keep Proportions option to 
maintain the ratio between an object’s 
height, width, and depth.

5Enter values in any Size or Scaling field 
to describe the size or relative scale in 
that dimension. You can type in a value 
or use the scroll arrows.

The Scaling Controls in the Properties 
palette’s Transform tab allow you to resize 
numerically. 

Orienting Objects

Most real-world objects have a logical 
“upright” and some have a logical “front.” 
For example, airplanes and automobiles 
have both. In simple terms, you can think of 
an object’s orientation as “the direction it 
faces.” 

Ray Dream Studio 5 determines the native 
upright and front of objects by the way 
they were modeled.

Orientation applies to objects and groups, 
as well as lights and cameras. In this 

describ
and ro

Ray Dr
for orie

Roll
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section, the term “object” also refers to 
cameras and lights.



hin the rings to roll the object in 
ensions. 
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Ray Dream Studio 5 allows you to change 
an object’s orientation in several ways: 
with the Virtual Trackball, with the Rotate 
tool and numerically.

Free Rotating
The Virtual Trackball allows you to orient 
an object by dragging its 3D preview. 

With the Virtual Trackball, the object 
rotates around its hot point. You might 
want to position the hot point before 
proceeding. For information on changing 
the default hot point position, refer to “The 
Hot Point” on page 233.

To orient an object with the Virtual 

A set of rings appears around the object 
hot point. The rings describe the axes of 
rotation. (If you have a multi-object 
selection, only one set of rings appears.) 

Once an object is selected, you can drag to 
change the orientation.

Drag wit
three dim
n the Shift key and drag one of the 
otate the object only on the 
nding axis. Hold down the Option/
hile you drag to constrain rotation 
ents of the Rotation Angle 
t. 
Trackball:

1Choose the Virtual Trackball tool.]

2Click the object or group you want to 
orient. 

You may select more than one object. 
Shift-click to add objects to the 
selection. Shift-click to remove selected 
objects.

3Drag in the perspective window to 
change the object orientation. The 
following descriptions will help you 
control the orientation change:

Hold dow
rings to r
correspo
Alt key w
to increm
constrain
r 12 • Arranging Objects 241
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Drag outside of the circle to rotate in relation 
to the monitor screen. 



Note: The point of rotation is at the hot 2Choose the 2D Rotation tool. The 2Display the Properties palette: 
sform tab: Orientation 
rols.

the System pop-up to select the 
dinate system you want to use.

al lets you specify the object 
ntation with respect to the universe.

 orientation controls with the 
ties palette’s Transform tab to change 
entation of the object. 
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point. If you have a multiple selection, each 
object rotates about its own hot point. To 
rotate several objects around a single 
point, you must first group them.

A group of objects rotated in 3D.

Rotation tool shares a space on the 
toolbar with the Virtual Trackball. You 
can “pop-up” the Virtual Trackball icon 
to choose the Rotation tool.]

3Drag inside one of the three projections 
to rotate the object parallel to that plane. 
Drag the projection in a circular path.

Hold down the Shift key while you drag 
to constrain rotation to increments of 
the Rotation Angle constraint. You can 
change the setting in File menu> 

Tran

cont

3Use 
coor

Glob
orie

Use the
Proper
the ori
king Box lets you specify the object 
ntation with respect to the working 
 This will be useful if you’ve moved 

orking box to a particular, 
ificant location and attitude. 

l lets you specify the object 
ntation with respect to its own 
dinate system. This is useful when, 
rdless of the object’s current 
tion, you want to rotate it a set 
ber of degrees. 

ocal Yaw, Pitch and Roll values 
to zero after you apply changes.

 Data lets you use Studio’s internal 
To constrain rotation to a given plane: 

1If necessary, orient the working box and 
position the object hot point. Setting 
these allows you to control the plane and 
axis of rotation. 

For information on changing the 
orientation of the working box, refer to 
“Changing the Position and Attitude of 
the Working Box” on page 227. For 
information on moving an object or 
group hot point, refer to “The Hot Point” 
on page 233.

Preferences: Perspective.

Numerical Orienting
The Properties palette lets you orient an 
object numerically. Numerical orientation 
uses the center of an object as the 
reference point.

To orient an object or group 
numerically:

1Select the object or group.

Wor
orie
box.
the w
sign

Loca
orie
coor
rega
rota
num

Note: L
revert 

Raw

sform data to control the object.
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 ssary, position the hot point to 
ibe the location you want for the 
r plane.

 Properties palette: Transform 
rientation controls, enable the 

r option. 

Apply to update your changes to 
lected object or group. 

l Orientation Features
 align objects with the working box, 
 universe, or with gravity. 

 working box is in its “home” orientation 
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4Enter new values in the Yaw, Pitch and 
Roll fields. You can type in a value or use 
the scroll arrows

5Click Apply to update your changes to 
the selected object or group. When Auto 
is enabled, the object’s orientation 
automatically updates when you click in 
another field.

Using the Axis Indicators

Ray Dream Studio offers a set of axis 
indicators for the object’s hot point. The 
indicators are a visual reminder of the 
object’s original x, y, z orientation.

The hot point axis colors match the yaw, 

3If nece
descr
mirro

4In the
tab: O
Mirro

5Click 
the se

Specia
You can
with the

When the

ith the universe), there is no difference 
ligning with the working box and with the 
erse.

 objects with the working box:

 one or more objects.

e Arrange menu> Align> On 
ing Box or press 
and-Shift-K/Ctrl+Shift+K.

ream Studio rotates the objects the 
um amount to put the sides of the 

t’s bounding box parallel to the 
To display the axis indicators:

1Choose File menu> Preferences. The 
Preferences dialog appears.

2Choose Perspective from the pop-up.

3Enable the Show Axis Information 
option.

The colors of the X (purple), Y (red) and 
Z (blue) axes match the colors of the 
Pitch, Roll and Yaw key in the 
Orientation controls.

Mirroring an Object’s 
Orientation
You can automatically “mirror” an object’s 
orientation across an imaginary plane. The 
mirror plane is parallel with the bottom 
plane of the working box and passes 
through the object’s hot point. 

To mirror an object or group’s 
orientation:

1Orient the working box to describe the 
angle you want for the mirror plane.

2Select an object or group.

pitch, roll axes in the Orientation controls. (aligned w
between a
Local Univ

To align

1Select

2Choos
Work

Comm

Ray D
minim
objec
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s of the working box. 
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plane



diagonally across the frame, Align with You may select multiple cameras and 
s, but only one object or group. If 
don’t select a camera or light, Ray 
m Studio 5 points the current 
era. 

ose Arrange menu> Point At or 
s Command-M/Ctrl+M.

light or camera points at the hot 
t of the selected object or group.

ning Duplicating 
cts
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To align an object with the universe:

1Select an object.

2Choose Arrange menu> Align> On 
Universe or press Command-Option-K/
Ctrl+Alt+K.

Ray Dream Studio places the object 
upright and sets its bounding box 
parallel to the axes of the universe. 

To align on gravity:

1Select an object.

2Choose Arrange menu> Align> On 

Gravity would adjust the roll of the 
camera to level the horizon.

To reset orientation:

1Select the object.

2Choose Arrange menu> Align> Reset 
Orientation or press Command-Option-
Shift-K/Ctrl+Alt+Shift+K

Ray Dream Studio returns the object to 
its native orientation in terms of the local 
universe.

Aiming Cameras and Lights

light
you 
Drea
cam

2Cho
pres

The 
poin

Alig
Obje
ing an Object Relative to 
her
eam Studio 5’s relative alignment 
 lets you arrange several objects 
spect to each other. This can be 
seful.

g works with respect to the Working 
r example, if you were building a 
 wheel, you would use relative 
Gravity or press Command-Shift-G/
Ctrl+Shift+G.

Ray Dream Studio sets the Roll of the 
selected object to zero without affecting 
its Pitch or Yaw. 

Gravity is absolute. It refers only to the Global 
Universe.

This feature is particularly useful for 
correcting the attitude of a camera. For 
example, if you were looking through a 
camera and the horizon slanted 

All of the positioning and orientation 
commands work on cameras and lights as 
well as simple objects. 

Note: Because the current camera is not 
visible as an object, manipulation by 
dragging isn’t possible.

The Point At command directs the light 
beam or camera view toward an object you 
specify. 

To point a camera or light at an object:

1Select the camera or light and the object 
you want to point at.

Align
Anot
Ray Dr
feature
with re
quite u

Alignin
Box. Fo
bicycle
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leaves the objects at their original 
on. along the axis of constraint.

d Axis of Constraint

None

Anchor 
Object
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alignment to arrange the axel, hub, spokes, 
rim, and tire to be concentric and co-
planar. 

2Select two or more objects. The first 
selected object becomes the anchor 
object.

3Choose Arrange menu> Align 
Objects or press Command-K/Ctrl+K. 
The Alignment dialog appears.

Use the Alignment palette to align your 
objects.

None 
positi

Selecte
sets the reference point of each 
t co-linear with the reference point 
 anchor object along the axis of 
raint.

 puts the specified distance 
en the reference points of each 

t along the axis of constraint. 

ace, enter a spacing value and use 
p-up to set the units.

bute places the reference point of 

ligned using None.
When aligning many objects, you might want to start 
by aligning only two of them. Once you have aligned 
the two objects, group them. Then align a third object 
to the group. Continue to group and align objects until 
all objects are aligned. 

To align objects relative to one another:

1Orient the Working Box to set the axes of 
constraint you want to use.

It is possible to align object in relation to 
other objects. 

You’ll align your objects in each 
dimension (x, y, and z) separately. The 
selected dimension is called the axis of 
constraint. 

4Choose the axis of constraint from the 
Axis pop-up.

If you’d prefer to see each axis of 
constraint at once, you may. Click the 
Key icon at the bottom of the Alignment 
palette to expand it.

5Select the alignment command you want 
for this axis: None, Align, Space, 
Distribute and Contact.

Align 
objec
of the
const

Space
betwe
objec

For Sp
the po

Distri

Objects a
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bject, evenly spaced between the 
nchor objects, along the axis of 
raint.
Chapte

Note: You’ll often use a different command 
on each axis. 

each o
two a
const



The reference objects do not move in BoxMin specifies the side or edge of each 

ith None as the reference.
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distribution. Therefore, Distribute 
requires a selection of at least three 
objects.

Contact brings the BoxMax of each 
object into contact with the BoxMin of 
the next object along the axis of 
constraint. 

6Using the red Anchor arrows, select the 
object to be used as the anchor. The 
anchor object keeps its current position. 
All of the other objects move in relation 
to this object. 

Alternatively, the Tab key advances the 
selection, and Shift-Tab retreats it. The 

object’s bounding box with the lower 
coordinate value along the axis of 
constraint.

Center specifies the center of each 
object’s bounding box.

BoxMax specifies the side or edge of 
each object’s bounding box with the 
higher coordinate value along the axis of 
constraint. 

Sides specifies the sides of the object’s 
bounding box. 

8Click Apply.

Align w
ith Hot Point as reference. 
2D projection of the selected anchor 
object is shown in red.

For the Distribute command, click the 
blue Arrow buttons to select the second 
anchor. Select two anchor objects. The 
2D projection of the second anchor 
object is shown in blue.

7Select the reference point on the objects.

Note: Object reference points that are 
grayed out are unavailable for that 
alignment command.

Hot point specifies each object’s hot 
point. 

Note: The Undo command restores the 
objects to their original orientation after 
the last alignment operation until you 
change the axis of constraint, or leave the 
Alignment window, deselect the objects, 
and attempt another operation.

9When you have achieved the alignment 
you want in one constraint axis, move on 
to the next one. (Return to step 3.)

Depending on your design for this set of 
objects, you may use relative alignment in 
one, two, or all three axes of constraint.

Align w
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ating Objects
ion is a handy method of 
ically repeating a series of 
, orientation, and resize operations 
licate object. Duplication is an 

 way of working and has a number 
ical applications.

ple, you could use this feature to 
piral staircase. Create the first 
 set its hot point to the axis of 

hen, duplicate the stair, raise the 
e to the level for the next step, and 
 an appropriate amount. Choose 
e again and again until you have 
 staircase.
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Contact with Sides as the reference. 

EqualEqual

Distribute with Center as the reference. 

Equal

Duplic
Duplicat
automat
position
on a dup
efficient
of pract

For exam
build a s
stair and
spiral. T
duplicat
rotate it
duplicat
built the
 objects are multiple instances of a single 
ject. For more information, refer to 
 with Master Objects” on page 266.
Space with BoxMax as the reference. Align with BoxMin as reference

Duplicated
master ob
“Working
r 12 • Arranging Objects 247
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licate an object:

ct one object.

ose Edit menu> Duplicate or press 

icate (repeats 1, 2) 
1. Select the object... 2. Duplicate and position the new object...

To dup

1Sele

2Cho

3. Repl
mand-D/Ctrl+D.
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e Edit menu> Duplicate with 
etry or press Command-Option-D/
lt+D.

ream Studio duplicates the object 
s the plane of symmetry.
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Note: When created, the duplicate occupies 
the same space as the original.

3Perform any number of position, 
orientation, and resize operations 
without deselecting the object.

4Choose Duplicate again.

Each time you duplicate, the new copy 
receives the same set of positioning, 
orientation, and resizing operations 
relative to the last duplicated object.

Changing the Object Symmetry
Many real-world objects exhibit symmetry. 
Airplanes, automobiles, and the human 
body are a few examples. To help you build 

• For example, if you want to flip the object 
in place, the center of the object should 
be at z=0. 

• For another example, you’re going to 
Duplicate with Symmetry and you want 
the mirrored duplicate to lie precisely 
alongside the original. Set the bottom 
plane of the working box parallel to that 
side of the object bounding box and move 
the working box to put the working box 
z=0 plane in contact with that side of the 
object bounding box.

To flip an object:

1Orient and position the working box to 

3Choos
Symm

Ctrl+A

Ray D
acros
Features

 Casting

lt, all objects that are not 
ent cast shadows. There might be 
here you don’t want a particular 
 cast shadows. Studio allows you 
hadow Casting on and off for 
al objects. 

ing an image with symmetry.
complex symmetrical objects, Ray Dream 
Studio 5 provides two commands—Flip 
and Duplicate with Symmetry.

The Symmetry Plane

Both symmetry commands use an 
imaginary plane parallel to the bottom 
plane, passing through the center of the left 
and right planes of the working box 
(working box z=0). This plane acts as a 
mirror across which the objects are 
reflected, or flipped. 

The attitude of the working box and the 
object’s z coordinate value (in the working 
box system) are important for a successful 
Flip or Duplicate with Symmetry operation. 

put the plane of symmetry where you 
want it.

2Select the object you want to flip.

3Choose Arrange menu> Flip.

Ray Dream Studio flips the object across 
the plane of symmetry.

To duplicate with symmetry:

1Orient and position the working box to 
put the plane of symmetry where you 
want it.

2Select the object.

Other 

Shadow

By defau
transpar
a case w
object to
to turn S
individu

Duplicat
r 12 • Arranging Objects 249
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To set shadow casting for one or more 
objects:

1Select one or more objects.

2Choose Arrange menu> No Shadow 
Casting to turn off shadow casting for 
the selected objects.

3Choose Arrange menu> Shadow 
Casting to turn on shadow casting for 
the selected objects.

Note: For a single object, you can set 
whether or not it casts shadows in the 
Properties palette: General tab. 

Using the Counter

To use the Counter:

1Choose Arrange menu> Counter.

2When you’re done viewing the 
information, click OK.

The counter keeps track of the number of 
objects in the scene and their complexity.
The counter is a utility that tracks the 
complexity of the geometry in the scene. 
The Counter maintains the following data:

• The number of objects in the scene

• The number of modeled patches

• The number of modeled facets

• The number of triangles that would be 
created in an exported version of this file.

This technical information may be useful to 
some artists who intend to export the 
scene for use in another program. The 
number of triangles has a direct correlation 
to file size in the exported document.
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13

 

Building a Scene

 

Overview

 

This chapter covers how you edit and 
manage the contents of your scene. You 
will learn how to add and remove objects 
and how to organize them in a hierarchical 
structure.
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Building your Scene’s 

                              

2

 

Choose 

 

Edit menu> Delete

 

 or press 

 

te

 

/

 

Backspace

 

.

 

u select a parent object within a group, you 
ically select all of its child objects. If you delete 
nt, the children or the group contents are 
as well. If you want to delete an object, but 
hildren, change the structure of the hierarchy 
 the child or contents at some other level 

 

roceeding.

 

cing Objects

 

you replace an object, the 
ement takes on the positioning, 
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Contents

The contents of a scene can be built by 
adding, deleting and replacing objects. You 
can also modify any object that you have 
created.

Adding and Deleting Objects
You can add existing objects to your scene 
(from other scenes or from clip art folders) 
in several ways: using the Objects Browser, 
by dragging between windows and with the 
Copy and Paste commands. You may even 
add an entire scene. In this case, the scene 
you add becomes a group in the new scene.

To add an object from another scene by 
dragging: 

1Open both scene files.

2Drag the icon representing the object 
you want from the source Hierarchy 
window to the destination Perspective or 
Hierarchy window.

When you drag into the hierarchy, you 
can drag directly onto a group or an 
object. If you drag an object onto 
another object, the hot points are 
aligned, and the object you dragged is 
linked to the other object.

Dele

When yo
automat
the pare
deleted 
not its c
to place
before p

Repla
When 
replac
ent and size characteristics of its 
essor. 

uctions on replacing all instances of an object 
fer to “Working with Master Objects” on 
6.

lace a single object or group:

ct the object you want to use.

ose Edit menu> Copy or press 
mand-C/Ctrl+C. 
The Ray Dream Studio 5 Scene Wizard is 
one special way you can add an entire 
scene to your existing one.

When you load an existing object, its 
shading, position, orientation and size 
characteristics are brought with it. You 
can, of course, change any of these to fit 
the new scene.

For more information on importing objects from other 
3D modeling applications, refer to“Using Ray Dream 
Studio with other Applications” on page 379

To delete an object: 

1Select the object in the Perspective or 

Drag the object’s icon to copy the object to 
another scene.

alignm
predec

For instr
class, re
page 26

To rep

1Sele

2Cho
Com
ct the object you want to replace.
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 into the object in a separate 
:

  

 the object.

  

e 

 

Edit menu> Jump In New 

ow

 

.

ay have to adjust the size and 
on of the windows so that both are 
 on your screen.

 

our modifications are updated to the object 
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4Choose Edit menu> Paste or press 
Command-V/Ctrl+V.

5If you are pasting an object (not a group), 
a dialog gives you a scaling option. Make 
your choice and click OK.

Fit in Box scales the replacement to fit 
within the same bounding box.

Keep Scaling keeps the replacement at 
its original scale. 

Jumping into Objects
At any time, you can select an object and 
“jump into” it. When you jump in, Ray 
Dream Studio opens the object in a 

Jumping into an Object

To jump into an object: 

1Select the object.

2Choose Edit menu> Jump In.

You can also double-click the object 
preview in the Perspective window or its 
listing in the hierarchy.

Note: If you try to jump into an instance of a 
class, Ray Dream Studio alerts you with a 
dialog. You may choose to modify the 
master for this class or create a new master 
object. For more information, refer to 
“Working with Master Objects” on 

Jumpin
Window

To jump
window

1Select

2Choos
Wind

You m
positi
visible

Because y

hen updated to the Perspective window, 
ce may lag slightly when you use Jump In 
ow. For this reason, Jump In New Window is 
mended for systems with limited RAM.

g into an Object in a Different 
r

y, jumping in opens the object in 
eler where it was created or the 
m modeler for primitives and 
d objects. You might prefer to open 
ct in a different modeler.

 with an object in a different 
 changes its type. This may limit 
modeler where you can modify it.

Note: Jumping into a group is covered in 
“Jumping into Objects” on page 253.

Jumping into an object allows you to modify 
an objects shape using a modeler.

Current Root

page 266.

When you jump into a Free Form object, 
Ray Dream Studio opens it in the Free Form 
modeler. 

When you jump into a Mesh Form object, 
Ray Dream Studio opens it in the Mesh 
Form modeler. 

When you jump into a volumetric primitive, 
like Fountain, Fire, Fog or clouds, Ray 
Dream Studio opens the appropriate 
control panel.

If it’s an imported or primitive object, like 
the cone or sphere, Ray Dream Studio 
opens it in the Minimum Modeler window. 

first, and t
performan
New Wind
not recom

Jumpin
Modele

Normall
the mod
Minimu
importe
the obje
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tions for future editing. For 
Chapt

You cannot modify the geometry of the 
object but you can apply shaders and paint 
shapes.

your op



   

example, you can’t edit a Free Form object 

                   

More facets creates smoother surfaces, 

          

Every object in your scene appears in the 
hy. The hierarchy is shown as a tree 
ents, each represented by a listing 
ed icon. The hierarchy of a scene 
s as you introduce objects, group 

and create links. 

ts may be objects, groups, cameras, 
t sources. The highest level of the 
hy is the root. It is represented by 
 entitled “Universe.” It encompasses 

ntire scene. Beneath the universe, 
y have any number of branches and 

anches.

 

ging your View of the 
rchy

 

n view the hierarchy in the 

 

Time 
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in the Mesh Form modeler, then take it 
back into the Free Form modeler.

To jump into the object in a different 
modeler:

1Select the object.

2Choose Edit menu> Jump In Another 
Modeler.

Ray Dream Studio opens a dialog that 
shows your modeler options.

3Select the modeler you want.

Note: Some modification options might not 

but increases the file size and memory 
required for the model.

5When you have set your options, 
click OK.

Ray Dream Studio opens the object in the 
selected modeler.

Building a Hierarchical 
Structure

The structure of a scene organizes the 
elements of a scene according to spatial or 

hierarc
of elem
or nam
change
them, 

Elemen
or ligh
hierarc
an icon
your e
you ma
sub-br

Chan
Hiera
You ca
indow, vertically or horizontally. 
ay choose the display that’s suitable 
r working style and screen space.
be available under other modelers.

Ray Dream Studio constructs 3D surfaces using facets 
and patches. Facets are triangular. Patches are 
polygons derived from Beziér curves. Some objects 
may be entirely facets, others may be a mixed set of 
facets and patches. When you open a primitive or Free 
Form modeler object in the Mesh Form modeler, all 
patches are converted to facets. 

4If you select the Vertex modeler, drag the 
slider or enter a value to set a fidelity 
level for creating facets from patches. 

logical relationships. Structure simplifies 
arrangement operations and can save you 
time and trouble.

Working primarily in the hierarchy, you can 
structure a scene by grouping and linking 
objects. 

The term “object” refers also to lights, cameras, and 
closed groups.

You’ll find it’s far easier to keep track of objects that 
you’ve specifically named than it is to manage 
generically named objects. 

Line w
You m
for you
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e root is the Universe. However, if you 
o” a group box, the hierarchy displays the 
 as the current root and the contents of that 

 

he only elements of the hierarchy.

 

icon appears to the left of every 

 

sh

 

This icon is a small arrow. 
e group is closed, the arrow faces 
ght. When the group is open, it 
wn. 
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Time Line view lists the contents of the 
hierarchy in outline form rather than with 
icons. This is especially useful for complex 
scenes or if you want to see as much of 
your hierarchy as possible. 

Open Group

Closed Group 

Single Level

Group with 
Link

Ray Dream Studio sets the display to 
your choice.

Navigating the Hierarchy
You can expand and collapse the items in 
the hierarchy to view more or fewer 
elements in your scene. You may need to 
open a series of groups to find a particular 
object deep in the hierarchy. 

Link Icon

Usually, th
“Jump Int
group box
group as t

A small 
group. 

Macinto
When th
to the ri
faces do
s The icon is a plus sign when the 
 closed and a minus sign when 

 or close a group

the arrow (Macintosh) or plus/

nd icon is a small arrow pointing to 
. The collapse icon is pointing down. 

and icon is a plus sign and the 
 icon is a minus sign. 
To change hierarchy display:

1Make sure the Time Line window is 
displayed. 

To display the window, choose 
Windows menu> Hierarchy of 
[filename] or Time Line of 
[filename]. 

2If necessary, click in the Time Line 
window to bring it to the front.

3Choose View menu> Vertical, 

The Time Line view of the object hierarchy.

To return to the outer view, close the group 
box at each level until only the main 

The Hierarchical view of the object 
hierarchy. 

Open Group 
Indicator

Closed Group 
Indicator

Open 
Group

Window
group is
opened.

To open

1Click 

The expa
the right

The exp
collapse
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 sign (Windows) beside the group.
Chapt

Horizontal or Time Line. 
branch, beneath the universe root, is 
displayed.

minus



   

Once a group is opened, the arrow faces 

       

You can drag objects individually or select 

      

various types of links you can “tie” them 
er so that moving the parent effects 
ild, but moving the child does not 
he parent.

 

ption to this is when applying the Inverse 
ics behavior to a child object in a linked chain. 
 information on Inverse Kinematics, refer to 

 

 Kinematics” on page 317.

 

ping Objects

 

 build up your scene, you’ll want to 
related objects. Grouping allows you 
trol a set of objects as a single unit.
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down and the plus sign becomes a minus 
sign.

To collapse the outline and close a 
group:

1Click on the arrow or minus sign.

If you are in the Time Line view, a second set of arrows 
(Macintosh) and plus/minus signs (Windows) appears 
next to groups and objects. These icons located closest 
to the object are used to expand the hierarchical 
structure of the animateable attributes. Use the icons 
to the left of these to expand and collapse the scene 
hierarchy.

several and drag them at once. To select 
multiple items, drag a marquee around 
them or hold down the Shift key and click 
on additional items. 

To remove a single object from a multiple 
selection, hold down the Shift key and 
click it. 

Drawing a marquee is an easy way to select 
a set of objects. However, you may not 
select a group exclusive of its contents or a 
parent exclusive of its children.

Selecting elements in the hierarchy applies 
not only to the selected object, but, in the 
case of a closed group box, to its contents, 
and in the case of a parent object, to its 

togeth
the ch
effect t

The exce
Kinemat
for more
“Inverse

Grou
As you
group 
to con
n arrange a group just as you do a 
object. During any positioning or 
tion operation, the objects in a 

retain their spatial relationship to 
other. 

u organize your groups is up to you. 
often create groups based on the 
 context of a set of objects—for 
le, the “hub, axel, spokes, rim and 
hen arranged properly and 
Changing the Structure
You can combine multiple elements of your 
hierarchy in two ways: grouping and 
linking. You can nest groups within other 
groups or create a chain with multiple 
links.

You can reorganize your groups and links 
by dragging them from one location in the 
hierarchy to another. Don’t worry about 
making a mistake in changing the 
hierarchy. You can drag an element to 
another level at any time.

children. 

Groups and Links
Groups and links are similar — both let you 
combine multiple objects in your scene so 
that you can manipulate them as a single 
unit, but their usage is quite different. 

Grouping is a way of creating collections of 
objects that make structuring and 
navigating through your scene more 
manageable. Groups are static, in that they 
don’t change the relationship between the 
objects in the groups, they only contain 
them. This is similar to the group function 
in 2D illustration and drawing programs. 

Links on the other hand, let you define an 

You ca
single 
orienta
group 
one an

How yo
You’ll 
logical
examp
tire.” W
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active relationship between the “parent” 
object and the “child” object. By applying 



       

ge the name of a group: 

on the name of the group in the 
rchy window. 

’re using the Time Line window, 
click, but hold down the mouse 
n for a second or two.

ream Studio opens the Edit Name 
.

the new name and click OK.

u may also change a group’s name 
operties palette: General tab.
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grouped, the set of objects becomes a 
single object you could name “bicycle 
wheel.”

You can group all objects into a single object 

You can nest one group within another to 
as many levels as you like. As you build a 
complex scene, you’ll find nesting groups 
helps manage the multitude of elements. 

Don’t worry about perfecting the shape of 
an object before putting it in a group. You 
can always open the group, then open the 
object for editing.

To create a new group: 

1Select the objects you want to group. 
You may select the objects in either the 
Perspective or Hierarchy window.

2Choose Arrange menu> Group. You 
may also click the Group/Ungroup icon 

To chan

1Click 
Hiera

If you
don’t 
butto

Ray D
dialog

2Enter 

Note: Yo
in the Pr
ave Ray Dream Studio automatically prompt 
e groups you create. Choose File 
Preferences: Hierarchy Tab 

e Ask for name.
You can also create groups based on the 
proximity of a set of objects—for example, 
“all objects on the bookshelf.”

which can then be named. in the Standard toolbar or press 
Command-G/Ctrl+G.

A box icon (or group listing, in Time Line 
window) appears in the Hierarchy 
window under the current root. 

By default, group boxes are named 
Group x, where x is a sequential number 
(1, 2, 3...). 

Click the Group icon to group the selected 
objects. 

You can h
you to nam
menu> 

and enabl
er 13 • Building a Scene 257
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You can also group objects based on their 
proximity to one another. 



Opening and Closing Groups Note: Ungrouping is different from opening 
p. Ungrouping gets rid of the group; 
ntents appear at that level of the 
hy. 

se a group: 

n the down-pointing arrow/minus 

ns of the group’s components 
e into the box, and the display 

s to the next higher level of the 
hy.

 Bounding Boxes

Perspective window, the elements of 
p are enclosed in a single bounding 
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To add objects to a group: 

Drag the icons of the objects you wish to 
add onto the group box icon.

You can open and close groups while you 
work. When the group is closed, you can 
manipulate the entire group as a single 
object. When a group is open, it maintains 
its structure in the hierarchy, but you can 
select and move each component object 
independently. 

This is a great time saver and gives you 
maximum flexibility. You can easily adjust 
the objects in your groups, but maintain 
their structure in the hierarchy.

To open a group: 

Click the right-facing arrow/plus/minus 
sign beside the group listing in the 

a grou
the co
hierarc

To clo

Click o
sign.

The ico
collaps
return
hierarc

Group

In the 
a grou
hich is visible when the group box is 
. When you create a group, the group 
ing box is set parallel to the planes of 
rking box. 

oup bounding box is defined as “the 
st box, with the same orientation as 
rking box, that encloses all bounding 
of the group’s contents.” If you add 
ove objects from the group, the 
sions of the group bounding box may 
Note: You can bring an object into the 
scene and immediately place it in a group. 
Drag the object from its source (Browser 
palette or other scene hierarchy) and drop 
it directly onto a group box icon.

To remove objects from a group: 

Simply drag the selected objects to another 
point in the hierarchy. For example, you 
can drag onto the universe icon. This 
places the objects on the main branch of 
the hierarchy.

Drag the object icons into the group box.
hierarchy.

A group box is the root of its contents. 
While the group box is open, indicated by 
the open box icon, its contents are 
displayed on a subbranch. .

On the Macintosh, click the left-facing arrow 
to open a group. Click the down arrow to 
close the group. 

In Windows, click the plus sign to open a 
group. Click the minus sign to close the 
group. 

box, w
closed
bound
the wo

The gr
smalle
the wo
boxes 
or rem
dimen
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u jump into a group, the Hierarchy 
 displays the group box as the 
root and its contents as the only 
s of the hierarchy. Simultaneously, 
pective window redraws to display 
 contents of this group.

 jump into a group, the working box is 
arallel with the group’s bounding box. This 
u to work in terms of the group’s Local Root 
f this is not what you want, you can align 
g box with the Global Universe.
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change. The orientation of the group 
bounding box, however, does not change 
as you add or remove elements.

Jumping In and Out

You can jump into a group to modify the 
relative positions and attitudes of the 
objects it contains. 

Within a group, a Local Universe, also called the 
Object/Group Universe, is used. This coordinate 
system’s axes are parallel with the walls of the group’s 
bounding box, with its origin at the center. 

The Local Universe maintains the relative positions of 
the objects when you move or rotate the group as a 
whole. That is, regardless of how you manipulate the 
group bounding box, the content objects have the 
same positions in terms of the Local Universe.

When yo
window
current 
element
the Pers
only the

When you
oriented p
enables yo
Universe. I
the workin
 out of a group: 

Edit menu> Jump Out. You can 
ble-click the group box icon in the 
y or click the Done button at the 

of the Perspective window.

u jump out, the Hierarchy and 
tive windows returns to displaying 
erse.

g Objects
creates a “physical connection” 
 objects. In a linked pair, one 
 the “parent” and the other is the 
When you change the position or 
ion of the parent, the child moves 
owever, you can still more or 
After reorienting a group, the group 
bounding box will no longer be parallel to 
the working box.

To re-calculate the group bounding box:

1Select the group you want to recalculate.

2Choose Arrange menu> Ungroup or 
press Command-U/Ctrl+U.

3Choose Arrange menu> Group or 
press Command-G/Ctrl+G.

Group bounding boxes are created parallel to 
the working box. 

To jump into a group: 

1Select the group.

2Choose Edit menu> Jump In.

You can also double-click the group box 
icon in the hierarchy to jump in right 
away.

Note: To open the group in a separate 
window (while keeping the Perspective 
window visible), use Edit menu> Jump 
In New Window.

To jump

Choose 
also dou
hierarch
bottom 

When yo
Perspec
the univ

Linkin
Linking 
between
object is
“child.” 
orientat
with it. H
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e child independently of the 
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rotate th
parent.



Linking is used to create articulated 

not link a child object to a simple group. To do 
 must first promote the group to a master 
hen you can link the object (child) to the 
arent). See “To use a group as a master 
 on page 267.

ing Link Properties

 objects have properties that 
ain the child’s movement relative to 
ent. An excellent real world example 

 is the human hand. The hand is 
to the forearm. Its range of motion 
e to the forearm) is limited—you 

end it forward or back more than 90° 
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structures, like an arm. The hand is linked 
to the forearm, which is linked to the upper 
arm, which is linked to the shoulder.

To link an object to another: 

1In the Hierarchy window, drag the object 
or group’s item (icon or listing) onto the 
item of the desired parent.

The link icon appears prior to the parent 
object.

Note: If you duplicate a parent object, you’ll 

To link an object, drag the object’s icon onto 
the parent. 

Link icon

You can
this, you
object. T
group (p
object:”

Apply

Linked
constr
the par
of this
linked 
(relativ
can’t b
-to-side more than 45°—anything 
ould break the wrist. These are just 

d of limits you can impose with link 
ties.
For information on how to constrain the child object’s 
movement with Link Properties, refer to“Applying Link 
Properties” on page 260.

Linking is used to create articulated 
structures, like an arm.

also be duplicating all of its child objects.

To attach an object to a parent that is off screen in the 
Hierarchy window, drag the new element with the 
Option/Alt key held down. This automatically scrolls 
the window’s contents to reveal additional elements.

To break a link: 

Select the child object’s item and drag it to 
another point in the hierarchy.

or side
more w
the kin
proper
ou have created a link, you can apply 
ties for setting limits.
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f Links

e eight link types available: None, 
e, Axis, Ball Joint, Custom, Shaft, 
d Slider. 

the default link property. You are 
osition the child object anywhere 
cene. 

e

Plane link restricts the movement 
bject to a specific plane. This 

relative to the child object’s axis, 
lobal universe. For example, if you 
e object, the plane that it moves 

ilt.
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Links become a more powerful tool for 
creating spatial relationships between 
objects when you apply a Link Property. 
This is especially true when setting up your 
scene for animation. Not only can you use 
links to constrain the movement of objects, 
but by applying the Inverse Kinematics 
behavior, you can create kinematic chains 
that allow you to manipulate the parent by 
moving the child.

To apply a link property:

1Position the child object where you want 
it in relation to the parent. 

2Position the child object’s hot point 
where you want it.

3Select the child object or group.

4Choose Windows menu> Properties. 
The Properties palette appears.

5Click the Links tab. 

6Choose the type of link you want to apply 
from the pop-up— None, 2D Plane, Axis, 

Types o

There ar
2D Plan
Lock an

None

None is 
free to p
in your s

2D Plan

The 2D 
of your o
plane is 
not the g
rotate th
on will t
adio button to select the plane you 
, ZY or ZX.

lane controls are used to control 
a specific plane. 
For more information on using Links and Inverse 
Kinematics in animations, refer to “Animating” on 
page 295.

Kinematic chains allow you to manipulate 
the parent by moving the child. 

Parent object

Ball Joint, Custom, Shaft, Lock and 
Slider. Each of these is described below.

7Choose your options for the specific Link 
Property. How to use the option controls 
is covered in “Setting Link Controls” on 
page 263.”

8When you are ready to apply your 
changes, click Apply at the bottom of the 
Properties palette. 

You may enable the Auto option to have 
your changes updated automatically.

Click a r
want: XY

The 2D P
links on 
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Axis link is not related to the parent object, visualize a firehouse pole. The firefighters 
de down the pole while also rotating 
 it.

e the main axis of rotation and set 
tation and slider controls. For 

ation on setting these controls, refer 

aft controls are used to rotate on one 
ile sliding up and down on the axis. 
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In the Axis link, a child object can be 
rotated around its hot point on one of the 
three axes. The rotation can be locked, 
limited, or free.

• If the rotation is locked, no movement 
occurs. 

• If the rotation is free, the rotation is an 
unlimited 360° on that axis.

• If the rotation is limited, you can 
constrain the rotation between two 
points. 

For more information on setting rotation controls, refer 
to “Setting Link Controls” on page 263.

except when moving the parent. There are 
no constraints on any axis.

There are no options for the Ball Joint.

Custom 

The Custom link allows you to build your 
own combination of constraints using 
sliders and axis rotation controls.

can sli
around

Choos
both ro
inform

The Sh
axis wh
ting Link Controls” on page 263. 

 link means that the child object is 
 to the parent object. You cannot 
the child object and move it, but it 
ve in relation to the parent when the 
 is moved.

are no options for the Lock property.

r link sets constraints for the child 
’s movement along its X, Y, and Z 

ovement on each axis can be 
, Limited, or Free. 

ed prevents any movement on that 
Ball Joint

The Ball Joint link allows you to rotate the 
child object 360 degrees around its own hot 

The Axis controls are used to control links on 
the axis.

Shaft 

In the Shaft link, the child object can both 
rotate around one of its axes, while it slides 
up and down the same axis. Perhaps the 
best way to think of a shaft link is to 

The Custom controls are used to create your 
own constrains. 

to “Set

Lock

A Lock
locked
select 
will mo
parent

There 

Slider

A Slide
object
axes. M
Locked

• Lock

 This is the default setting.
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point. Like the 2D Plane link, the Ball Joint axis.



xt field to the right displays the 
on of the currently selected 
r.

slider range is too large to give you 
e control, click the plus magnifying 

icon to the right. Click it as many 
 as necessary to decrease the slider 

slider range is not large enough to 
u set the constraint limit where you 
 click on the minus magnifying glass 
Click it as many times as necessary 
rease the slider scale.
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• Limited allows you to place limitations on 
movement in both directions. 

• Free lets the object move anywhere along 
that axis. 

Set your options using slider controls. For 
information on setting slider controls, refer 

Slider Controls. 

2Drag the slider markers to set position 
limits and a new position.

In Free mode, the slider has one marker. 
You can drag the marker to move the 
object along that axis. 

You can double-click the slider to set the 
current position numerically.

In Limited mode, the slider has three 
markers.

The Free mode allows you to set limits along 
an axis. 

The te
positi
marke

3If the 
precis
glass 
times
scale.

4If the 
let yo
want,
icon. 
to inc
xis rotation controls:

 Preferences palette: Link tab, 
e the type of constraint from the 
p—Locked, Limited or Free.

ream Studio displays the controls 
e chosen constraint.

 rotation controls are found in the. 
stom and Shaft link options.
to “Setting Link Controls” on page 263.

Setting Link Controls

All link properties use two primary types of 
controls— slider and axis rotation. 

To set a link slider control:

1In the Preferences palette: Link tab, 
choose the type of constraint from the 
pop-up—Locked, Limited or Free.

Ray Dream Studio displays the controls 
for the chosen constraint.

• The marker on the left sets the outer 
constraint in the negative direction 
away from the object’s hot point. Drag 
the marker to change the limit.

• The marker in the middle sets the 
current position of the object. Drag the 
marker to move the object along that 
axis between the limits.

• The marker on the right sets the outer 
constraint in the positive direction 
away from the object’s hot point. Drag 
it to set a new limit.

The Limited mode allows you to set negative 

To set a

1In the
choos
pop-u

Ray D
for th

The Axis
Axis, Cu
er 13 • Building a Scene 263

he markers to set position limits 
 new position.
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The link slider control are found in the 
Custom, Shaft and Slider link options.

and positive limits along the axis. 2Drag t
and a



In Free mode, your object can rotate 360° Controlling Links Directly The controls appear as a set of wires 
 “handles” at certain points. The 
arance of the wires depends on the 
 of link and type of constraint.

rect Manipulation controls appear at 
 points.
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around the chosen axis. Drag the marker 
to rotate the object.

In Limited mode, the angle ring displays 
three markers. 

• The top marker defines the outer 
constraints of the rotation on the 

The Free mode allows you to set limits on the 
chosen axis. 

The Direct Manipulation option for Link 
properties provides an onscreen 
description and control of the objects’s 
motion and rotation range. You can drag 
handles on the wires to control these 
properties.

To use the Direct Manipulation controls 
for link properties:

1Follow the previous instructions to apply 
a Link property to an object and set link 
controls on it.

2After you’ve chosen the constraint type, 
click the Direct Manipulation button to 

with
appe
type

The Di
certain
’t see the control wires when the constraint 
ocked.

ct Manipulation controls require Auto Apply 
.

er controls, you’ll see a straight 
hen the constraint is “Limited,” the 

s at the ends determine the limit for 
positive side of the axis. Drag the 
marker to change the limit.

• The middle marker sets the current 
position of the object. Drag the marker 
to rotate the object between the limits.

• The lower marker defines them for the 
negative side of the axis. Drag the 
marker to change the limit.

The Limited mode allows you to set limits for 

display the controls on the object. 

Click the Direct Manipulation button to 
display the object controls. 

You won
type is L

The Dire
enabled

For slid
wire. W
handle
 on that axis.
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nks Browser
wser palette: Links tab lets 
 link settings that you can later 

 your objects. 

hods for saving to the Browser 
nd using saved settings are 
 to the several browser categories. 
plete information on using the 
 palette, refer to “Using the 
 Palette” on page 28.
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Note: If you don’t see the wire, it’s probably 
inside the object. Use the slider in the 
Properties palette: Link tab to extend 
the range.

To set slider options directly:

• Drag the handle at the end of the wire to 
change the limit in that direction.]

• Drag the object to change its position 
along the wire. The object’s hot point 
slides along the wire until it reaches the 
end.

• Drag the handle on the line within the arc 
to rotate the object within the range.

Building Chains of Links

The parent-child link enables you to easily 
manipulate multiple objects from a number 
of reference points by creating chains of 
linked objects. This feature is useful in 
creating articulations, especially when 
used in conjunction with the Inverse 
Kinematics feature. 

For example, if you wanted to create a fully 
articulated arm— one that could bend at 
the shoulder, elbow, wrist, and each of the 
five finger joints—you should arrange the 
objects to construct the arm, then link 
them into a chain with the fingers at the 

The Li
The Bro
you save
apply to

The met
palette a
common
For com
Browser
Browser
For rotation controls, you’ll see a wire arc 
that describes the object’s angular rotation 
range. The line within the arc describes the 
current rotation. 

To set rotation controls:

• Drag the handle at the end of the arc to 

Drag the wire handles to change the range 
limits for motion on this axis. 

deepest level of the hierarchy and the 
shoulder at the root.

A chain of links allows you to create fully 
er 13 • Building a Scene 265
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change the rotation limit. articulate joints. 



Working with Master shelf, all having the same label. Working at 

erarchy window’s Objects tab can be 
 display all objects and instances of 
ect.

Object Instances of 
“Chair” pieces

Master Objects of 
“Chair” pieces
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Objects

Most scenes use one or more duplicates of 
some particular object. Each duplicate is 
not an independent object but an Instance 
of the original Master object. For example, 
if you create a chair using four duplicate 
chair legs, the four legs of a chair are object 
instances of a master object called, 
“chair leg.”

the master object level, you could change 
the labels on all twelve bottles in one 
operation. Working at the instance level, 
you could put a stain on one of the labels. 
Later, you could change all of the labels by 
modifying the master object without 
affecting the stain.

The following list describes the priority of 
shading layers. Items higher in the list 
cover those below.

• Instance Paint Shape

• Master Paint Shape

• Instance Primer

• Master Primer

The Hi
used to
the obj
 the Objects tab, the Masters and 
 tabs do not let you structure or 
objects.

play Master objects:

 the Master tab in the Hierarchy 
ow. 

 create a new master object each 

erarchy window’s Masters tab allows 
view your master objects. 
The position, orientation, size, hot point 
location, and shading of each object 
instance may be unique. The shape, 
however, must be common. 

Shading of instances may be unique or 

Using master objects allows you to create 
variations of an object, but yet maintain 
control of the object through the master 
object.

Objects and Masters Tabs in the 
Hierarchy
The Hierarchy window contains three tabs 
that change your view of the objects 
displayed in the hierarchy. The Objects tab 
displays all the objects and object 
instances in your scene. The Masters tab 
displays only the master objects. The 
Effects tab displays any Rendering effects 
you may have applied to your scene.

Unlike
Effects
group 

To dis

1Click
wind

You

The Hi
you to 
 you add a new object to the scene. 
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common. A good example of common 
shading would be a dozen bottles on a 

time



ce a master object:

 and copy the object that will 
e the existing master object.

 Time Line window: Masters tab, 
 the master object you want to 
e.

e Edit menu> Paste or press 
and-V/Ctrl+V.

u replace a master object, every 
 of the class is replaced by the new 
ach object instance of the 
ent uses the positioning, 

nt, scale, and symmetry 
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Jumping into an Instance

When you jump into an instance object, 
Ray Dream Studio displays a dialog alerting 
you. In the dialog, you may choose to 
modify the master object of this class or 
create a new master from this instance.

You may have multiple instances with the same name, 
but you may not have two master objects with the 
same name. When you create a new master object by 
modifying an object instance, Ray Dream Studio names 
the new class object by appending a number to the old 
name.

If you modify an instance when you had intended to 
modify the master object, you can easily get back on 

Master Object Operations
When you modify a master object, all 
object instances are automatically 
updated to the new form. Their individual 
position, orientation, scale, symmetry, and 
region shading remain unchanged.

To modify a master object:

1In the Time Line window, click on the 
Masters tab to display all master objects.

2Select the master object you wish to 
modify.

3Choose Edit menu> Jump In to open it 
for editing.

To repla

1Select
replac

2In the
select
replac

3Choos
Comm

When yo
instance
object. E
replacem
alignme
ristics of its predecessor.

 group as a master object: 

 the group in the hierarchy.

he group over the Masters tab, 
own to drop it where you want it.

ter group operates under the same 
as a master object. If you jump into 
stance of the master group and 
y its contents in any way — the 
er of elements, their relative 
ons or orientations — you separate 
roup instance from its master, thus 
ng a new master group.
track by replacing the master with your modified 
instance. Refer to “Master Object Operations” on 
page 267. 

You can create new instances of the master 
object by duplicating an existing instance, 
copying and pasting, or by dragging the 
object from the Master tab into the scene.

For information on special duplicating features, refer to 
“Duplicating Objects” on page 247.

You can Jump In New Window if you 
want to modify the object in one window 
while viewing the scene in another.

You may also double-click its listing in 
the Master tab to open it for editing

4Use the modeling or shader tools to 
modify the object.

5Click Done to jump out of the object and 
apply your changes.

characte

To use a

1Select

2Drag t
then d

A mas
rules 
one in
modif
numb
positi
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The Objects Browser
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The Browser palette: Object tab lets 
you save objects, groups and full scenes 
that you can use later.

The methods for saving to the Browser 
palette and using saved settings are 
common to the several Browser categories. 
For complete information on using the 
Browser palette, refer to “Using the 
Browser Palette” on page 28.
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14

 

Setting Lights & 
Cameras

 

Introduction

 

This chapter covers how to create and use 
lights and cameras. It includes descriptions 
of the different types of lighting and how 
you set the options for each. This chapter 
also describes the different camera types 
and settings and how to manipulate them 
to achieve dramatic camera angles. 
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Chapter 14 •



   

Lighting & Cameras

          

you’ll see the objects you manipulate 

            

reflections) appear. If ambient light is your 
urce of light, you won’t see the 

shading effect on objects. 

modeling in the 

 

Mesh Form

 

 or 

 

Free 

 

odeler view, the Shaded Preview 

 

e in Better Preview display mode. 
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Lighting
The appearance of objects in the Ray 
Dream Studio universe is determined 
greatly by the light in which they are 
viewed. 

A good set of lighting conditions is an 
important step toward creating high 
quality artwork. The same scene rendered 
under different light can provide strikingly 
different results. For example, rendering 
with all lighting at zero brightness is like 
taking a photograph—without a flash—in 
the bottom of a coal mine. Conversely, too 

clearly—even if you are working on a dark 
scene. This also helps make the Preview 
mode significantly faster than the Better 
Preview mode.

A scene in Preview Quality display mode.

only so
depth 

When 
Form m

A scen
tter Preview use an arbitrary, fixed 
urce. This allows you to see details 

object’s textures and geometry 
, regardless of the scene’s actual 
ttings.

you render your scene using the 
ve renderer or the Ray Tracer, that 
ing will show color, shading, and all 
complex lighting effects selected in 
derer. These may include visible 
d camera effects, reflection and 

ion, shadows and transparencies. 
much lighting washes out subtle effects. 

Ray Dream Studio also lets you create visible light 
spheres and cones. The visible light cone effect is like a 
searchlight cutting through the fog. These are 
rendering effects, for more information, refer to 
“Render Filters” on page 349.

Where Lighting Effects Are Visible

In the default Preview Quality display 
mode, lighting effects specific to your 
scene are not visible. Instead, the 
appearance of objects is determined by an 
arbitrary, fixed light source not visible in 

The Shaded Preview and Better Preview 
modes use ambient light and your scene’s 
specific light sources to show color, 
highlights, gel effects and depth shading. 
No other lighting effects (shadows or 

and Be
light so
of the 
clearly
light se

When 
Adapti
render
of the 
the ren
light an
refract
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the Perspective window. This ensures that 
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Effects

 

 tab.

                     

ffects tab to set the ambient light 
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Before launching the rendering process, 
use the Render Preview tool in the 
Standard toolbar to preview lighting and 
shading effects.

For more information on rendering features, settings 
and procedures, refer to “Rendering” on page 339.

Cameras

Use the Render Preview tool to preview 
lighting and shading effects. 

you’d expect from photography. For more 
information on this and other rendering 
effects, refer to “Render Effects” on 
page 344.

Setting Lights

Ray Dream Studio supports two categories 
of lighting—ambient and specific. There is 
one ambient light setting, but there are 
several types of specific light sources. 

The lighting you set up in your scene has a 
big effect on the look of your rendered 
illustration. All the different lighting 

2Click 

Use the E
the Ambient Light color swatch 
se the color picker to set the color 
e ambient light.

e Brightness slider to set the 
nt of ambient light.

w your changes, choose View 
> Better Preview or Shaded 
ew. 

u may also use the Render Preview 
he Standard toolbar.
Cameras provide viewpoints for the 
Perspective window and for renderings. As 
you build your scene, the cameras can be 
positioned to get the best view for working. 
You can place several cameras and switch 
among them to get alternate perspectives 
of your scene. You can even create a 
second Perspective window to view your 
scene from two different angles at once.

When you’re ready to render, you can 
select a camera as the viewpoint. The 
camera’s position and settings combined 
with the Production Frame position and 
rendering format to determine the scale 
and framing of the scene. 

Ray Dream Studio also lets you create 

controls combine to result in dramatically 
different effects. Experiment with different 
light settings to create the effects that you 
want in your 3D illustration.

Ambient Light
Ambient light is uniform through the scene. 
It has no specific origin and casts no 
shadows. It is the equivalent of daylight in a 
real world scene. It radiates in every 
direction, has no position and no origin 
point. 

To set ambient light:

1Choose Windows menu> Scene 

Settings. The Scene Settings window 

3Click 
and u
for th

4Use th
amou

5To vie
menu

Previ

Note: Yo
tool in t

controls.
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camera effects, like lens flare and depth of 
field. These effects help you achieve results 

appears.



                                   

palette

 

:

 

 Light tab

 

. You can use these 
ls at any time and adjust the settings 
lected light.

                    

 Light tab in the Properties palette to 
 light properties.
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For deeper shadows and high contrast with lit areas, 
use a lower ambient light setting. As you increase the 
brightness of ambient light, the intensity of shadows 
and other effects generated by your other lights 
decreases. This “flattens” the image. To rely exclusively 
on your other lights, set ambient light at zero. For 
example, to create the dramatic effect of a spotlight on 
a theatre stage, use no ambient light.

Creating a New Light Source
You may create several types of specific 
lights. The standard lights are distant, bulb, 
and spot. 

You may add as many lights as you like, but 

To create a new light source: 

Drag the Create Light tool from the Tools 
toolbar into the Perspective or Hierarchy 
window.

You can also choose Edit menu> Insert> 
Light to add a light at the center of the 
Universe (0,0,0).

If you want to create a light with the same 
settings as an existing light, you can select 

Drag the Create Light tool into the 
Perspective or Hierarchy window to create a 
new light. 

contro
of a se

Use the
set the
 a light’s properties:

ct the light.

lay the Properties palette: Light 

ose the type of light you want from 
op-up: Bulb Light, Distant Light or 

 Light.

stant Light is outside of the scene 
erse . The light rays from a distant 
ce are parallel as they enter your 
e. An example of this is the way the 
lights the earth.
as the number increases, so does the time 
it takes to render your final 3D illustration. 
Most scenes can be lit with one, two, or at 
most three well placed lights.

By default spot light and bulb light previews are 
displayed in red. If you want, you may change the 
color of light objects in the Perspective window. 
Choose File menu> Preferences: Color 
and set your preference.

the existing light then Copy and Paste, or 
use the Duplicate command. 

After creating a light, you can change its 
properties.

Setting Light Properties
Once you have created a new light, specify 
which type it is (distant, bulb, or spot) 
then, set its options on the Properties 

To set

1Sele

2Disp
tab.

3Cho
the p
Spot

A Di
univ
sour
scen
sun 
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ine the light from behind, click the 

  

radio button.

ront of the scene refers to the 
ion shown in the following figure 
the working box is in its initial 
on, the Reference view.

       

Front
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A Bulb Light radiates light in all 
directions.

A Spot Light casts light in a specific 
direction. The light rays of a spot light 
diverge based on parameters that you 
set, such as the Half Angle and Distance 
Fall Off.

When you change light type, the tab 
displays the parameters appropriate to 
that type.

Setting Common Light Characteristics

The characteristics of color, brightness, 
and shadow control are common to 
distant, bulb, and spot lights. You adjust 

Use the Render Preview tool or render the 
image to view the changes. Shadows 
appear only in renderings.

For more control over shadows, refer to 
“Shadow Options” on page 279.

Setting Distant Light Direction

The direction of a distant light source is set 
indirectly—by moving the highlight on the 
surface of the sphere in the distant light’s 
Properties palette: Light tab.

2To sh
Back 

The F
direct
when 
positi
bient light, you can use a distant light to 
 shadows cast by your other light source. 
 distant light above your scene, then 
t with light settings to diffuse the shadows 
other lights.

 Bulb Light Characteristics

ts appear in the Perspective 

ant Light uses this convention for 
e in the Perspective window.
these settings in the Properties palette: 
Light tab.

To set the color: 

Click the color chip and use the color 
picker to choose a color.

To set the brightness: 

Drag the slider to set the brightness. 

To control shadow strength: 

By default, all lights (except ambient) cast 
shadows. If you want to minimize the 

To set the direction of a distant light 
source:

To set the position of the light, imagine the 
distance light sphere as a glass ball 
surrounding your scene. The highlight 
shows where the distant light shines 
through the glass, toward the center of 
your scene.

Use the Distance Light controls to set the 
direction of the lights.

As with am
soften the
Position a
experimen
from your 

Setting

Bulb ligh

The Dist
referenc
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shadows from a particular light, drag the 
Shadows slider to a lower setting. 1Drag the highlight on the surface of the 

sphere to position the light source.

window
the 3D w



   

positioning features, including the 

              

The range is the distance from the light 

      

Setting Spot Light Characteristics

 

rightness, half angle and angular 
settings are previewed in real time in 
gram in the right side of the spot 
ntrols.
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Selection tool, Virtual Trackball, and 
Properties palette: Transform tab: 
Position controls. Because bulb lights 
shine equally in all directions, you do not 
need to aim them.

itself to the point where the light has no 
effect.

The bulb light range is the distance from the 
light to the point where the light has no 
effect. 

Range

End of range

Your b
fall-off 
the dia
light co
 the half angle of the light cone: 

e Half Angle slider.

ou may also use the Direct 
ulation controls to set this feature. 
o “Controlling a Spot Light Directly” 
e 277.

 Spot light controls to set the 
ess, half angle and angular fall off 
s.
To set the range of the light source: 

Enter a value. Use the pop-up to select your 
units.

Use the Bulb light controls to set the range of 
the light source. 

To set the distance fall-off: 

Drag the Distance Fall-off slider.

The distance fall-off setting determines 
how the brightness of the light diminishes 
toward the edge of its range. A fall off of 
10% means that the light has full intensity 
from the source through 90% of its range, 
then decreases linearly to the end of the 
range.

To set

Drag th

Note: Y
Manip
Refer t
on pag

Use the
brightn
setting
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ge is the distance from the light 
the point where the light has no 

     

e of the spotlight is distance 
 the light’s point of origin and the 
ere the light has no effect.

End of range
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The half angle is the angle of the radius of 
the cone. A narrow angle creates a beam 
like that of a spotlight. A wide angle creates 
a beam like that of a flood light. (See the 
following diagram.)

The spot light half-angle changes the 

Half 
Angle

has full intensity from the center to 90% of 
the radius of the light cone, then decreases 
linearly to the edge of the cone.

As you increase the fall-off percentage, you 

Fall-off at zero 50% Fall-off

50% Fall-off 10% Fall-off

Brightness decreases
100% Brightness

Brightness decreases
100% Brightness

The ran
itself to 
effect.

The rang
between
point wh

Range
e distance fall-off: 

 Distance Fall-off slider.

ance fall-off setting determines 
 brightness of the light diminishes 
he edge of its range. A fall off of 
ns that the light has full intensity 
 source through 90% of its range, 
reases linearly to the end of the 
To set the angular fall-off: 

Drag the Angular Fall-off slider.

Note: You may also use the Direct 
Manipulation controls to set this feature. 
Refer to “Controlling a Spot Light Directly” 
on page 277.

Fall-off is how the brightness of the light 
diminishes toward the edge of the light 
cone. A fall off of 10% means that the light 

diameter of the light cone.

To set the range of the light source: 

Enter a value. Use the pop-up to select your 
units.

decrease the area that is 100% bright.
To set th

Drag the

The dist
how the
toward t
10% mea
from the
then dec
range.
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You may select multiple lights, but only The Point At Behavior

int At behavior sets a light to aim at 
ct. If the object moves, the light 

atically reorients itself to point at the 
 in its new position. 

e a light follow an object:

ct the spot light you want to use.

lay the Properties palette: 
avior tab.

 the Plus sign icon.

ct Point At from the dialog and click 
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The spot light parameters interact with each other. For 
example, using a light colored light with a low 
brightness setting may generate a similar result as a 
darker colored light with a higher brightness setting. 
Experiment with various settings until you achieve the 
lighting you want.

Positioning and Aiming Spot 
Lights
Spot lights appear in the Perspective 
window. You can move them anywhere in 
the 3D workspace and change their 
direction with any of the positioning and 
orientation features, including the 

one object.

2Choose Arrange menu> Point At or 
press Command-M/Ctrl+M.

Ray Dream Studio reorients the light to 
point at the hot point of the selected 
object.

The Point At command does not link the 
light to the object selected. That is, if you 
move either element, the light no longer 
points at the object. If you want to maintain 
the relationship between a light and the 
object it points at, place them together in a 
group. For more information, refer to 
“Grouping Objects” on page 256. If you 

The Po
an obje
autom
object

To hav

1Sele

2Disp
Beh

3Click

4Sele
OK.
r the name of the target object—the 
you want the light to follow.

e the axis option as it is. The axis 
on sets which axis of the object 
ld point at the target. For a light, 

only want to use the axis that emits 
ight.

 Apply to send your changes to the 
.

 now on, whenever you move the 
et object, this light reorients to point 
.

Selection tool, Virtual Trackball, and the 
Properties palette: Transform tab 
controls.

Ray Dream Studio offers several other 
methods of aiming lights, including the 
Point At command, the Point At behavior, 
and the Direct Manipulation controls.

Pointing a Light at an Object

The Point At command lets you point a 
light directly at an object. 

To point a spot light at an object:

1Hold down Shift and select the light and 
the object you want to point it at.

want the light to follow the object, apply 
the Point At behavior, described below.

To direct a light to a particular area in your 
scene, you can create a temporary object 
for the light to point at, then delete the 
object. Remember that the light points at 
the hot point of the object selected.

You can check where the light is cast by actually 
viewing your scene through the light. Use the Position 
pop-up in the Camera Properties dialog to select the 
light source from which you will view the scene.

5Ente
one 

6Leav
opti
shou
you 
the l

7Click
light

From
targ
at it
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the light:

 control handle in front of the light 
e handle will move parallel to the 

lane. Hold down the Option/Alt key 
he handle perpendicular to the 

lane.

 Light Aim control to set the point 
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Controlling a Spot Light Directly

The Direct Manipulation controls for a light 
provide an on-screen description of the 
light’s aim and properties. You can drag a 
light’s control handles to change light 
properties.

To display the Direct Manipulation 
controls on a spotlight:

1Select a spot light. 

2Make sure this light is visible in the 
Perspective window. For best results, 
you’ll want all planes visible so you can 
work with the projections.

Note: The Direct Manipulation controls 
require Auto Apply enabled.

Brightness Control

Light Position Control

Half Angle 
Control

Angular Fall-Off 
Control

Light Cone 
Cross Section 
Control

Light Aim
Control

To aim 

Drag the
cone. Th
active p
to drag t
active p

Drag the
 drag the handle out, extending it 
ay to the point you want to aim at. 
 shows the angle of the light beam.

 also aim the light with respect to a 
ane by dragging the corresponding 
n one of the light’s projections.

t rotates to aim where you place 
le. 

e light aims at.
3Display the Properties palette: Light 
tab.

4Click the Direct Manipulation button to 
display the control handles on the 
selected light. 

The controls appear as a set of wires 
with “handles” at certain points. Each 
handle represents a control you can drag 
to set properties.

Drag the control handles to aim the spot light 
and set its properties. 

You can
all the w
The wire

You may
given pl
handle o

The ligh
the hand

where th
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Hold down the Command/Ctrl key when 
ag in (toward the center of the ring) 
 the Angular Fall Off and Half Angle 

er.

f you have the Properties 
e: Light tab displayed, you can see 
ect of your changes in the preview 

gle control to adjust the light’s half 
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To move the light:

Drag the handle behind the light cone. 

You may also move the light with respect 
to a given plane by dragging the 
corresponding handle on one of the light’s 

Drag the light’s position control to move the 
light along a given plane.

To check the light cone diameter at a 
given point:

Drag the handle that’s on the direction 
wire, centered in the ring.

Drag the Light cone cross section control to 
help you visualize the diameter of the light 
cone in the Perspective window.

you dr
to keep
togeth

Note: I
palett

the eff

Half an
angle.
ttings.
projections

The light moves to the new position and 
orients itself to point at the target.

The ring around the direction wire 
describes the cone diameter at that point. 
Notice that as you drag the handle closer to 
the target, the ring expands.

Note: The cross section control is to help 
you visualize the diameter of the light cone 
at different ranges. It does not change any 
of the light’s properties.

To change the cone half angle:

Drag the handle on the ring perimeter to 
change the light’s half angle.

and se
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hadow options for a light:

 the light you want to set.

y the Properties palette: 
ws tab.

e pop-up to choose the type of 
w you want for this light.

raced Shadows is the default. The 
 of the shadows end abruptly. The 
tion from complete shadow to full 
s immediate. Ray-traced shadows 
nsidered “hard shadows.”

TD Shadows let you create a 
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To change the angular fall-off:

1Drag in (toward the center of the ring) on 
the ring handle to separate the angular 
fall off ring from the half angle ring. (The 
fall off ring is always on the inside.) 

Drag the Angular fall-off control to set the 

To change the light’s brightness:

Drag the handle on the wire that extends 
from the light perpendicular to the 
direction wire. 

Drag the Brightness control to set the light’s 
brightness.

To set s

1Select

2Displa
Shado

3Use th
shado

Ray-T
edges
transi
light i
are co

Soft R

bra at the shadow edge. The 

w has a soft transition between 
lete shadow and full light. Soft 
w options are described below.

stant Lights are restricted to Hard 
s.

Soft RTD shadow options:

a value in the Diameter field to set 
ze of the light source. 
2Drag the fall-off ring handle to set the fall 
off you want. The gap between the two 
rings describes the fall-off.

Note: If you have the Properties 
palette: Light tab displayed, you can see 
the effect of your changes in the preview 
and settings.

light’s angular fall-off. 
Drag away from the light to increase the 
brightness, or towards the light to 
decrease brightness.

Note: If you have the Properties 
palette: Light tab displayed, you can see 
the effect of your changes in the preview 
and settings.

Note: On a bulb light, brightness is the only 
control available with Direct Manipulation.

Shadow Options
Objects block light and, therefore, cast 
shadows on other surfaces. For each light, 
you can choose between two shadow 
types—Ray Traced Shadows and Soft DRT 

penum
shado
comp
shado

Note: Di
shadow

Setting 

1Enter 
the si
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A larger light source creates a wider Note: Using the Optimize option may 
e erroneous results with a light 
 of large diameter and objects that 
all and relatively close to either the 
r the shadow surface.

 Gels
ay place an image as a mask or 
arency in front of a light to project 
ex patterns and images on your 
 The image you place in front of the 
 called a gel. 

el is a 1-bit image, it becomes a 
White regions of the mask transmit 
t and black regions block it. Bitmap 

n create intricate effects, such as the 
 of a chain-link fence, or the 
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penumbra.

Light 
Source

UmbraPenumbra

Object

Object’s Shadow

Each sample represents a point on the light source 
that is used as the origin for ray tracing rays. The points 
are spaced evenly around the perimeter and across the 
surface of the light.

3Enable the Optimize option if you want 
to speed up a rendering.

• When Optimize is disabled, the system 
will check every sample of the Quality 
setting.

• When Optimize is enabled, Ray Dream 
Studio checks the condition of the first 
seven samples. 

produc
source
are sm
light o

Using
You m
transp
compl
scene.
light is

If the g
mask. 
the ligh
gels ca
shadow
d shade under a tree. 

ale or color images create 
arencies when used as a gel. Their 
is projected into your scene, just as a 
rojector sends an image across the 
With a color image, you can achieve 
ffects, like sunlight filtering through 

ed glass window. An 8-bit gel will 
ly provide all the color you need.

ls types—Blinds and Gradient—are 
 gels. You may also load a texture 
 movie to use as a gel. 

 adjust the settings for these gels, a 
w displays to the right. Specific blend 
ls are described later in this chapter.
2Drag the Quality slider to set the number 
of samples. 

The range is from 16 to 128. Higher 
values improve shadow quality, but 
increase render time.

The penumbra width depends on the 
diameter of the light source and the 
proximity of the source, object and shadow 
surface. The behavior follows what you’ll 
experience in the real world, so you can 
experiment with a light source (lamp), object 
(your hand) and surface (wall or desk) to 
see the penumbra-umbra transition in action. 

If all seven samples are “in the umbra,” 
Ray Dream Studio assumes that the 
remainder (up to the Quality setting) are 
also and skips them. 

If all seven samples are “in full light,” the 
system assumes that the remainder (up 
to the Quality setting) are also and skips 
them to save time.

If the first seven samples have any 
combination of umbra and light, Ray 
Dream Studio recognizes that this pixel 
is in the penumbra and finishes checking 
all samples of the Quality setting to 
ensure shadow quality.

dapple

Graysc
transp
image 
slide p
room. 
many e
a stain
probab

Two ge
built-in
map or

As you
previe
contro
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he Vertical number slider to set 
mber of vertical slats.

he Vertical width slider to set the 
 of the vertical slats. The width is 
ssed as a percentage of the gel 
.

he Horizontal number slider to set 
mber of horizontal slats.

he Horizontal width slider to set 
idth of the horizontal slats. The 
 is expressed as a percentage of the 
me.

Apply to apply your selections. 
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To place a gel on a light:

1Select a light.

Gels are generally used on distant or 
spot lights. Your choice depends on the 
effect you want.

2Display the Properties palette: Gel 
tab.

3Choose the type of gel from the pop-up. 

None is the default. The light has no gel.

Blinds creates horizontal or vertical 
stripes—venetian blinds, prison bars, 

Blinds Controls

To set blinds options:

1Select a light.

Use the Blinds controls to create a gel that 
projects stripes onto an object.

4Drag t
the nu

5Drag t
width
expre
frame

6Drag t
the nu

7Drag t
the w
width
gel fra

8Click 
a Controls

t a formula for the gel:

 a light.

ormula controls to create a gel that 
a pattern onto an object.
etc. 

Gradient uses a blend of two colors as a 
gel. A gradient gel can be vertical or 
circular.

Map uses a bit-mapped image file as the 
gel. This is the best choice when you 
want specific imagery in the gel. 

Formula uses a mathematical formula to 
create colors and patterns in the gel. You 
can devise your own formula to create a 
new pattern. 

Movie uses a sequence of images in the 
gel. This option only makes sense when 

2Choose Windows menu> Properties 

palette: Gel tab.

3Choose Blinds from the pop-up.The blind 
controls appear in the Gel tab. 

Formul

To selec

1Select

Use the F
projects 
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you are creating an animation. Choose Blinds from the Gel tab pop-up to use 
Blinds. 2Choos

palet



3Choose Formula from the pop-up. The “Using Formulas in Ray Dream Studio 5 2Choose Windows menu> Properties 

tte: Gel tab.

ose Gradient from the pop-up.The 
ient controls appear in the Gel tab. 

 Gradient from the Gel tab pop-up to 
 gradient options. 
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formula controls appear in the Gel tab.

4If the current formula uses the 
Parameter sliders, you can adjust them 
to change the formula result.

The preview displays the result of the current 
formula. 

PDF” on the Ray Dream Studio 5 CD for 
details on using the Formula Editor.

Formula editing becomes technical 
quickly. You can learn a lot by loading 
the sample files. 

7When you’re done with the Formula 
Editor, click OK.

8To save a formula, click the Disk icon 
and choose Save As from the pop-up.

Use the Save dialog to name the file and 
select a disk location. 

9Click Apply to apply the selections. 

pale

3Cho
grad

Choose
set the
ct a Vertical or Circular gradient 
ern.

 the Start color chip and select a 
r from the color picker.

 the End color chip and select a 
r from the color picker.

 Apply to apply the selections. 
5To load a new formula, click the Disk 
icon and choose Open from the pop-up.

Use the Open dialog to locate and open 
an appropriate formula. Look in the Ray 
Dream Studio CD: Samples: Formulas 
directory for some samples to get you 
started.

6If you want to edit the formula or create 
your own, click More to open the 
Formula Editor.

Ray Dream Studio uses the Formula 
Editor in several places. Use of the editor 
is common, but the type of formula 
you’re creating determines the valid 
input and output variables. Refer to the 

Gradient Controls

To set gradient options:

Use the Gradient controls to create a gel that 
projects a pattern containing color 
transitions onto an object.

4Sele
patt

5Click
colo

6Click
colo

7Click
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ap controls:

the directional buttons next to the 
con to change the image’s 
ation.

he Brightness slider to adjust the 
’s brightness. 

e the Better (but slower) sampling 
 to view a more precise preview.

e the Invert Color option if you 
to invert the image’s colors.

 want the image to repeat, enable 
le option.
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Map Controls

The Map option lets you load an image to 
use as a gel.

Use the Map controls to create a gel that 
projects an image onto an object.

For a list of the image file types that Ray Dream Studio 
supports, see the section on software support for your 
system in Chapter 1, “Installation.”

To load the map image as a gel:

1Select a light.

2Choose Windows menu> Properties 

palette: Gel tab.

3Choose Map from the pop-up.The map 
controls appear in the Gel tab. 

To set m

1Click 
Disk i
orient

2Drag t
image

3Enabl
option

4Enabl
want 

5If you
the Ti
e Horizontally and Vertically 
s to set the number of tiles in each 
ion.

e the Seamlessly option to smooth 
ansitions between tiles.

Apply to apply the selections. 
To create a map image:

1Use any 2D art program to create an 
image for the gel.

You might scan a photograph and use 
filters to accentuate or nominalize some 
aspects of the image. 

The gel does not need to be high 
resolution. If you intend to use this gel on 
a bulb light, create the image at an 
aspect ratio of 2:1. If you are going to use 
this gel on a spot or distant light, use an 
aspect ratio of 1:1.

2Save the image file in a format that Ray 
Dream Studio supports and in a 

4Click the Disk icon and choose Open 
from the pop-up.

5Use the Open dialog to locate and open 
the map image you saved.

Choose Map from the Gel tab pop-up to set 
the map options. 

Use th
slider
direct

Enabl
the tr

6Click 
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Movie Controls 3Choose Movie from the pop-up.The ºIf you want the frame to repeat, enable 
ile option. The tiled movie appears 

e right preview.

the Horizontally and Vertically 
rs to set the number of tiles in each 

ction.

le the Seamlessly option to smooth 
ransitions between tiles.

 can get more information on this 
ie by clicking More. 

Dream Studio opens a window that 
ides technical information and a 
ie preview player.
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Movies create sophisticated gels for your 
animations. For example, you might 
capture some video of a tree blowing in the 
wind. With a little preparation, you can 
load it as a gel to create a moving shadows 

Use the Movie controls to create a gel that 
projects a movie image onto your object.

movie controls appear in the Gel tab. 

4Click the Disk icon. Ray Dream Studio 
displays the Open dialog.

5Locate and open a movie file.

Choose Movie from the Gel tab pop-up to set 
the movie options. 

the T
in th

Use 
slide
dire

Enab
the t

¡You
mov

Ray 
prov
mov
 More movie controls to get more 
d information about your movie.
in your scene.

A gel movie frame for a bulb light should have an 
aspect ratio of 2:1. A gel movie frame for a spot or 
distant light should have an aspect ratio of 1:1.

To select a movie for the gel:

1Select a light.

2Choose Windows menu> Properties 

palette: Gel tab.

When you’ve opened a movie, a preview 
player appears. This is the control that 
lets you synchronize the gel movie with 
the animation. See “Synchronizing Movie 
Frames with the Animation and Looping” 
on page 335 for more information.

6Click the directional buttons next to the 
Disk icon to change the movie’s 
orientation.

7Drag the Brightness slider to adjust the 
movie’s brightness. 

8Enable the Better (but slower) sampling 
option to view a more precise preview.

Use the
detaile
n you’re done with the Movie Time 
ction window, click OK.
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9Enable the Invert Color option if you 
want to invert the movie’s colors.

™Whe
Sele



mera’s Field of View
a’s settings and position determine 
of view. The field of view of the 
camera does not necessarily equal 
u see in the Perspective window. 
lay in the Perspective window is 

ermined by the size of the window 
evel of magnification. You can use 
ll bars or hand tool to adjust the 
f the field of view that the 
tive window currently displays.

era’s field of view is not affected by 
 (the Zoom tool) or panning (with 
d tool or the scroll bars). 

tion of the camera’s field of view 
sed for the rendering is identified 
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£Click Apply to apply the selections. 

To preview a movie in the Gel tab:

1Click Play at the bottom of the dialog.

2Click Stop when you want to stop the 
movie. 

You can also click Loop to have the 
movie play continuously.

Using Cameras

Just as a photographer strategically places 
cameras for different views, you will set up 
various cameras for viewing your scene. 
After the scene is finished, you can frame 
the view of your scene that you want to 
render. Framing a scene is similar to 
looking through a camera’s viewfinder.

The position and orientation of a camera is 
called a viewpoint. When you select a 
preset view, such as a top view of your 
scene, your active camera (the current 
camera) is moved directly to that 
viewpoint: over your scene and pointed 

The Ca
A camer
its field 
current 
what yo
The disp
also det
and its l
the scro
region o
Perspec

The cam
zooming
the Han

The por
that is u
roduction Frame. The Production 
 similar to a real-world camera’s 
er. By default, the production 
pears as a green rectangle on top 
erspective view. 

r, dashed line rectangle is called 
 Frame Margin. It’s an “out of 
warning” for objects that approach 
 of the frame. This reference can 

cularly useful for animators who 
loping for video output. Because 
s of the video frame are often cut 
afe Frame Margin can help in 

 objects fully within the visible area 
e animation is displayed on video.
downward in the case of a top view. 

You may create multiple cameras, 
positioned anywhere in your scene, and 
shift the view to any of them. Using 
multiple viewpoints can be quite useful.

What you see in the Perspective window is 
the projection of the scene through the 
lens of the current camera. At any given 
time, only one camera is selected as the 
viewpoint for the Perspective window. If 
you open more than one Perspective 
window, each has its own current camera.

by the P
Frame is
viewfind
frame ap
of your p

The inne
the Safe
bounds 
the edge
be parti
are deve
the edge
off, the S
keeping
when th
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You can adjust the margin by choosing About the New Camera In the Hierarchy, cameras are represented 
bered camera icons. You can, of 

, rename a camera just like any 
.

he current camera is not visible in 
rspective window. Because you are 
g the scene through it, it is not 
 within the scene. 

t up several cameras, you might want to name 
cording to their viewpoints. This makes it easy 
 the view you want.

g the Camera Lens
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File> Preferences: Perspective and 
adjusting the Safe Frame Margin 
percentage. You’ll probably need to 
experiment a few times to find the setting 
that’s right for your video output system.

For more information on the Production Frame and 
Render Settings, refer to“Rendering” on page 339.

Creating a New Camera

To create a new camera: 

Drag the Create Camera tool from the Tools 

The new camera appears in your scene as a 
blue 35 mm camera that faces downward. 
The camera is an object that has 
projections.

by num
course
object

Note: T
the Pe
viewin
visible

If you se
them ac
to select

Settin
n change the properties of the 
t camera using the controls on the 
a Properties palette. 

nge a camera’s lens:

ct the camera you want to change.
toolbar to the area of the Perspective 
window where you want it placed. You may 
also drag it into the Hierarchy window to 
add the camera at the center of the 
Universe.

You may also choose Edit menu> Insert> 
Camera to add the camera at the center of 
the Universe.

Note: If you choose Windows menu> 

New Perspective to create another view 
of your scene, Ray Dream Studio gives you 
the option of creating a new camera to 
provide that view.

You can move the camera as you would 
any other object. You’ll learn about special 
features for moving and orienting cameras 
later in “Positioning and Aiming Cameras 
in the Scene” on page 287.

If you want, you may change the color of camera 
objects in the Perspective window. Choose File 
menu> Preferences: Color and set your 
preference.

New cameras appear in your scene as a blue 
camera.

You ca
curren
Camer

To cha

1Sele
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t a camera at an object:

 want to aim the current camera, 
 the object you want to point at. 
 probably find it is easiest to select 
e Hierarchy window.

 want to aim a camera other than 
rrent one, select the camera and 
ject you want to aim it at.

u cannot point a camera at a light.

e Arrange menu> Point At. 

t At command does not link the 
to the object selected. That is, if 
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2Choose Windows menu> Camera 

Properties. The Camera Properties 
palette appears.

Note: For convenience, the camera lens 
controls are also provided on the 

Use the Camera Properties palette to change 
the characteristics of the selected camera.

The Isometric camera provides a view in 
which object size is not related to 
distance from the camera (that is, there 
is no vanishing point.) 

The Zoom slider adjusts the field of view.

Note: With an isometric camera, use a 
Backdrop not a Background.

The IVRM Spherical camera creates a 
spherical rendering to be used with a 
virtual reality viewer, like the RealSpace 
Traveler. For instructions on creating 
your scene, using the IVRM Spherical 
Camera and using the viewer, refer to 
“Using the RealSpace Spherical Camera” 
on page 292.

To poin

1If you
select
You’ll
it in th

If you
the cu
the ob

Note: Yo

2Choos

The Poin
camera 
e either element, the camera no 
oints at the object. 

t a camera to a particular area in 
ne, you can create a temporary 
r the camera to point at, then 
e object. Remember that the 

points at the hot point of the 

nt At Behavior

ant the camera to follow an object, 
e Point At behavior.

 a camera follow an object:

t At behavior sets a camera to aim 
Properties palette: Camera tab.

3Use the Type menu to select the camera 
you want: Conical, Isometric or IVRM 
Spherical. 

The Conical camera has four settings: 
Normal, Wide, Telephoto and Zoom. 

If you select Zoom, the slider lets you set 
a focal length between 6 and 500 mm.

The Ray Dream Studio perspective camera is patterned 
after the standard 35mm SLR camera.

Positioning and Aiming Cameras 
in the Scene
Cameras (other than the current camera) 
appear in the Perspective window as an 
object. 

You can move them anywhere in the 3D 
workspace and change their angle with any 
of the standard positioning and orientation 
features. 

Pointing a Camera at an Object

The Point At command is usually the 
easiest way to aim a camera in the general 
direction of an object. Then, you can make 
precise adjustments to the camera’s 

you mov
longer p

To direc
your sce
object fo
delete th
camera 
object. 

The Poi

If you w
apply th

To have

The Poin
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1Select the camera you want to use. Note: The Direct Manipulation controls 
 Auto Apply enabled.

e wireframe and projection “handles” 
the camera and set its properties. 

a Position 
l

Camera Aim 
Control

Zoom Level 
Control
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2Display the Properties palette: 
Behavior tab.

3Click the Plus sign icon.

4Select Point At from the dialog and click 
OK.

5Enter the name of the target object—the 
one you want the light to follow.

6Leave the axis option as it is. The axis 
option sets which axis of the object 
should point at the target. For a camera, 
you only want to use the axis with the 
viewing lens.

To display the Direct Manipulation 
controls on a camera:

1Select a camera. 

2Make sure this camera is visible in the 
Perspective window. For more control, 
you’ll want all working box planes visible 
so you can work with the projections.

3Display the Properties palette: 
Camera tab.

4Click the Direct Manipulation button to 
display the controls on the selected 
camera. 

require

Drag th
to aim 

Camer
Contro
 might want to aim the camera with the Direct 
ation controls while simultaneously seeing the 
 that camera’s view. You can do this by 
 a second Perspective window and arranging 
e-by-side.

 the camera:

e handle in front of the camera. The 
handle will move parallel to the 
plane. Hold down the Option/Alt key 
 the target perpendicular to the 

plane.
7Click Apply to send your changes to the 
camera.

From now on, whenever you move the 
target object, this camera reorients to 
point at it.

Controlling a Camera Directly

The Direct Manipulation controls for a 
camera provides an on-screen description 
of the camera’s aim. You can drag control 
handles to change the camera’s properties.

Note: These features are not available for 
the current camera. You must view the 
camera as an object to control it directly.

The controls appear as a set of wires 
with “handles” at certain points. Each 
handle represents a control you can drag 
to set properties.

Use the Direct Manipulation button to display 
controls for the selected camera. 

Tip: You
Manipul
result in
opening
them sid

To aim

Drag th
target 
active 
to drag
active 
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tangle in front of the camera 
ts the Production Frame.

u can change the zoom level for 
ical or Isometric cameras. 

 Zoom control to adjust the camera’s 
vel.
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You can drag it out, extending the wire all 
the way to the point you want to aim at. 
The wire shows the angle of the camera’s 
aim.

As you drag the Camera Aim control, the 
camera rotates around the Camera Position 
control.

You may also move the camera with 
respect to a given plane by dragging the 
corresponding handle on one of the 
camera’s projections.

As you drag the Camera Position control, the 
camera rotates around the Camera Aim 
control.

The Rec
represen

Note: Yo
the Con

Drag the
zoom le
ing your Perspective 
 Scene
 choose to work with one camera 

al. If you are working with one, you 
e it to another position whenever 
t a different viewpoint on your 

 working with several cameras, you 
ly switch the viewpoint of the 

tive window to a different camera 
ting from your available cameras 
e Camera Properties dialog.

 the Current Camera to a 
osition

 choose View menu> Preset to 
• You can also aim the camera with respect 
to a given plane by dragging the 
corresponding handle on one of the 
camera’s projections.

The camera rotates to aim where you place 
the handle. 

To move the camera:

Drag the handle behind the camera 
preview. 

The camera moves to the new position and 
orients itself to point at the target.

To change the zoom:

Drag a corner of the rectangle in front of 
the camera to change the zoom. Drag 
toward the target object to zoom in. 

Chang
on the
You may
or sever
can mov
you wan
scene. 

If you’re
can simp
Perspec
by selec
using th

Moving
Preset P

You can
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return to the original view of your Navigating the Current Camera sight, reduce your magnification level in 
rspective window to the standard 
tio.

ate around an object:

ct the object you want to rotate 
nd. If you deselect all objects, the 
ent camera will rotate around the 
in of the Universe.

 the Dolly tool. The Dolly tool 
es the camera while keeping it 
ted at the same spot in the scene.
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Perspective window, select the Reference 
position.

If you have saved your own position 
presets, they’re also available from this 
menu. See “Saving Position Presets” on 
page 292 for more information.

To choose a preset position: 

Choose View menu> Preset Position> 
and select the position you want.

You can also use the Camera Properties 
palette: Position pop-up.

Whenever the camera position and 
orientation is not at one of the presets, the 

Ray Dream Studio allows you to directly 
manipulate the current camera using the 
Dolly, Pan, and Track tools and with the 
Navigation panel on the Camera Properties 
palette.

Note: You may also select the current 
camera in the hierarchy and use the 
Properties palette: Transform tab: 
Position and Orientation controls to 
move and aim the camera numerically.

The navigation tool icons share a space on 
the Tools toolbar. Press on whichever one 
is visible to “pop-up” the others and 
choose the one you want.

the Pe
(1:1) ra

To rot

1Sele
arou
curr
orig

2Click
mov
poin
camera changes position and 
ntation.

 in the Perspective window to dolly 
amera. 

behavior is similar to the Virtual 
kball, except in this case, it’s the 
era that moves.

 the camera:

 the Pan tool. The Pan tool rotates 
amera on its own axis. 
Camera Properties palette: Position 
pop-up displays Custom.

When you Jump Into an object or group using any of 
the default preset positions, the camera goes with 
you—that is, it establishes the preset position and 
orientation relative to the local universe you’ve 
jumped into. A custom position, on the other hand, is 
kept “as is” when you Jump In. This could result in an 
empty window when you Jump Into a group. Choose a 
default preset or select an object and Point At it to see 
the contents of the group.

Whenever one of these navigation tools is 
selected, a green rectangle, the production 
frame, automatically appears in the 
Perspective window. 

The production frame acts as a viewfinder 
to help you frame your scene properly. It 
automatically disappears once you switch 
back to any non-navigation tool. If the 
production frame is not visible at first 

Use the camera navigation tools to 
interactively adjust the position of a camera.

The 
orie

3Drag
the c

The 
Trac
cam

To pan

1Click
the c
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ssary, click the Key icon to expand 
lette and show the Navigation 

.

the buttons to move or rotate the 
a incrementally.

llowing diagrams describe the 
on of each button. Refer to the tool 
iptions for more information on 
 pan and track.

 like, you can change the distance 
ation amount for each click.

the Scale icon to open the 
ents dialog. 
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2Drag in the Perspective window to pan 
the camera.

Hold down the Shift key to constrain 
panning to the vertical or horizontal.

The camera changes orientation only.

To visualize panning, imagine standing in 
place and looking through your camera’s 
viewfinder. Turn side-to-side and tilt up 
and down.

Note: If you pan the camera, then decide 
you want to level its view, you can use 
Arrange menu> Align on Gravity.

To track in or out:

• When using any of the three navigation 
tools, hold down the Command/Ctrl key 
and drag upward to move the camera 
forward.

• Hold down the Command/Ctrl key and 
drag downward to move the camera back 
from your subject. 

The camera changes position only.

Unlike zooming using the Magnifying glass, tracking in 
and out actually moves the camera toward or away 
from your subject, effectively changing your field of 

2If nece
the pa
panel

3Click 
camer

The fo
functi
descr
dolly,

4If you
or rot

5Click 
Increm
 dialog, set the amount and units 
sition controls. Set the degrees for 
on controls.

 Scale icon to edit the camera’s 

Pan Up

Pan
Right
To track the camera:

Click the Track tool. The Track tool 
moves the camera up, down, left, or right 
in the plane parallel to the monitor 
screen.

The camera changes position only.

The tracking directions are in relation to 
the camera’s current attitude—not to the 
axes of the Global Universe or working 
box

view and perspective if you are using a non- isometric 
camera.

Using the Navigational Panel

The Camera Properties palette: 
Navigation panel lets you click buttons 
to incrementally dolly, pan, and track the 
camera.

To use the Camera Properties palette’s 
Navigation panel:

1Choose Windows menu> Camera 

Properties. The Camera Properties 
palette appears.

6In the
for po
rotati

Click the
position

Rotate
CCW

Pan
Left
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Track Up 2Display the Camera Properties palette.

w your scene from two cameras at 

n a second Perspective window. 

ose Windows menu> New 

pective. The New Perspective 
dow dialog appears.

ct the camera you want or create a 
 one.

spective window you open increases demand 
computer, its RAM, and the hard disk—
ly when the level of display detail is high (that 
view, Shaded Preview or Better Preview 
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The Track controls. 

Track
Right

Pull BackTrack 
Down

Track 
Left

Track In
Right

Right

Dolly Left

Dolly Up Right

Dolly Right

3Choose Position pop-up> Save 
Position.

4Select whether to save just the Position 
and Orientation, the Type and 
Parameters or All aspects of this camera.

5Type a name for this camera position 
and click OK.

To remove a preset from the list: 

1Choose Position pop-up> Delete 
Position.

2Select the position you wish to remove, 

To vie
once:

1Ope

2Cho
Pers

Win

3Sele
new

Each Per
on your 
especial
is, in Pre
his might slow you down. For better efficiency, 
r windows or switch several of them to fast 

 modes (bounding box or wireframe).

 OK.

 the RealSpace Spherical 
ra

RM spherical camera produces a 
ing that includes every viewpoint 
ng from its position—a “spherical 
” The image is actually rectangular, 
pecial viewer program will wrap it 
e inside of a sphere, where you can 
 it and turn to see every angle of 
Saving Position Presets

If you set a camera position that you 
particularly like, you may add it to the 
presets. Your saved position will be 
available on the View menu> Preset 
Position sub-menu in all of your scene 
files.

To save a position as a preset:

1Select the camera with the position and 
orientation you like.

The Dolly controls.

Dolly Down

and click OK.

Working with Multiple Cameras

Multiple cameras can help you arrange 
your objects by providing different views of 
your scene that you can switch between or 
use simultaneously. When you are ready to 
create a rendering, you’ll select one of the 
cameras as the viewpoint to render from.

To switch the view between cameras: 

Choose View menu> Camera and select 
the camera you want to use.

mode). T
use fewe
preview

4Click

Using
Came
The IV
render
radiati
image.
but a s
onto th
look at
cene.
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the triangle next to Camera. The 
mera controls appear.

e the IVRM Spherical camera from 
t of cameras in the scene.

the triangle next to File Format. 
ile Format controls appear.

 the triangle/plus sign next to 
to display the options.
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The RealSpace Traveler viewer is provided 
with Ray Dream Studio, so you can create 
and view these virtual reality views of your 
Ray Dream Studio scenes.

To use the IVRM Spherical camera:

1Create a scene, centered at the origin of 

Scene viewed using the IVRM Camera.

To set output options IVRM spherical 
camera rendering:

1Choose Windows menu> Scene 

Settings. The Scene Settings window 
appears.

2Click the Output tab.

3Click the triangle next to Image Size. The 
image size controls appear.

5Click 
the ca

6Choos
the lis

7Click 
The F

Click on
Camera 
e JPEG as the file format from the 
p. 

the Options button and use the 
 to set your choice for JPEG 
ression quality.

the scene file and close the 
ent.

 the triangle/plus sign next to File 
o display the options.
the Universe. Don’t forget to account for 
lighting in all directions.

For best results, you should create 
objects on all sides, above and below.

2Drag the Create Camera tool into the 
Hierarchy window to add a camera at 
the origin (0, 0, 0) of the Universe. 

3Choose Windows menu> Camera 

Properties or press Command-E/
Ctrl+E. The Camera Properties palette 
appears.

4Choose Type pop-up> IVRM 

Spherical. 

4Define the aspect ratio. The aspect ratio 
of the rendering must be 2:1, but you 
may use whatever resolution you like—
for example, 1000 pixels wide by 500 
high. 

Although a higher resolution rendering may produce 
better results, it will also require more RAM to view 

Click on the triangle/plus sign next to Image 
Size to display the options. 

8Choos
pop-u

9Click 
dialog
comp

ºSave 
docum

Click on
Format t
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You’re now ready to set rendering 
options.

successfully.
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To render with the IVRM spherical 
camera:

1Choose Render menu> Batch Queue. 

Ray Dream Studio displays the Batch 
Queue window. For complete 
information on using the Batch Queue, 
refer to “Rendering” on page 339.

2Click Add.

3Use the dialog to locate and select the 
scene you want to render.

4Click Open to add it to the queue.

5Click Done to close the dialog.
6In the Batch Queue window, click 
Launch.

When Ray Dream Studio finishes 
rendering, you’ll find two new files in the 
folder with your scene: a JPEG file and a 
VRML file. Use the VRML file with the 
Traveler viewer.
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Animating

 

Key Event Animation

 

In Ray Dream Studio, you create an 
animation by moving to different points in 
time and making changes in the scene to 
define the state of the action at that 
moment. These changes are called 

 

key 
events

 

. Ray Dream Studio automatically fills 
in the 

 

transitions

 

 between key events to 
create the illusion of motion.

Most features in a Ray Dream Studio scene 
can be animated in this way:

 

•

 

The motion of objects, lights, and the 
camera

 

•

 

Object size, shape, and shading attributes

 

•

 

Object deformer and behavior settings

  

ra and light parameters
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• Came



   

•

 

Ambient lighting, background, backdrop, 

       

Animatable Properties

    

Properties in the Hierarchy

 

t you can keep track of all of a 
s animatable properties, the 
hy can be expanded to show all of 
perties you can animate. 

n also control the hierarchy to limit 
properties are displayed.

 

mplete discussion of the hierarchy area, refer 

 

Time Line Window” on page 297. 
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and atmospheric effects

There is one important exception to key 
event animation. The physical force 
behaviors define object motion based on a 
real-world physical behaviors. Objects that 
have physics applied may not be animated 
with position or orientation key events. For 
more information on the physical 
behaviors, refer to “Behaviors” on 
page 314.

Time-Based Animation

In Ray Dream Studio5, key events are tied 
to real-world time increments—minutes 
and seconds—rather than to individual 
animation frames. This means you can 

Each characteristic of an object or effect 
that can be animated is called a property. A 
typical object or effect has many 
animatable properties. Some properties, 
like those that define position and 
orientation, are common to all objects. 
Other properties are specific to certain 
types of objects.

Lights have special properties like 
brightness, fall off and sometimes gels.

Rendering Effects like backgrounds, 
backdrops and atmospheres have their 
own special properties.

The properties of an individual object 
depend on several factors, including what 

So tha
scene’
hierarc
the pro

You ca
which 

For a co
to “The 
nge animatable property display 
Time Line window:

g the Time Line window to the front. 
 can either click in it or choose 
dows menu> Time Line of 

name].

ose View menu> Preset Views> 
select the view option you want:

erarchy Expanded to Show some of an 
s Properties (Macintosh version).
create key events at specific points in time 
without worrying about the number of 
frames in your final rendered animation. 

You might work at a low frame rate (6 
frames per second is the default) to 
preview your animation on screen. Then 
increase the frame rate to render your final 
animation.

Once you have defined a key event, you can 
remove it, copy it, or move it along the time 
line to fine-tune the timing of your 
animation.

type of object it is, and what types of 
components are used in its shader.

Environmental primitives (like Fountain, 
Cloud and Fire) have special properties 
that determine their shape.

And when you apply a deformer or 
behavior to an object, you add the special 
animatable properties that define its effect.

This overview points out the differences in 
animatable properties for various objects. 
You can find out the specific properties of 
an object by expanding its listing in the 
hierarchy.

To cha
in the 

1Brin
You
Win

[file

2Cho
and 

The Hi
Object’
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ime Line Window

 

tion describes the 

 

Time Line

 

 
, the heart of the animation 
. The window provides tools for 

basic tasks: 

  

g the animation hierarchy

  

ing the current time

  

g the frame rate

  

ying the render range (the start and 
mes of your animation) 
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Hide still properties sets the hierarchy 
to display only animatable properties 
that have key events. (This exclude 
animatable properties that are constant 
throughout the animation.)

Hide non-transformation 
properties limits the hierarchy to 
display only transformation properties.

Hide non-existent properties sets the 
hierarchy to exclude animatable 
properties that have not been applied to 
the object.

Hide empty property groups sets the 
hierarchy to exclude properties that 

You can Cloak (hide) or Uncloak (show) an object at 
any point during the animation. This allows an object 
to “exit” or “enter” during the course of the 
animation without changing the hierarchy. For more 
information, refer to“Cloaking an Object” on 
page 334.

The values of the properties may change 
over time, but the properties themselves 
must be constant. For example, a spot light 
cannot become a distant light over time; a 
bitmap background cannot become a 
bi-gradient.

The T

This sec
window
interface
several 

• Viewin

• Chang

• Settin

• Specif
end ti
e Line window provides a visual 
tation of the key events that make 
imation. It allows you to 
ate key events and move then to 
 points in time. The Time Line 

 consists of three areas: 

e Line window allows you to control 
mations.

y Area Time Line Area
cannot be animated.

The Fixed Animation Hierarchy
Ray Dream Studio uses the hierarchy to 
manage an animation internally. For this 
reason, the hierarchy is fixed–it cannot 
change during the course of an animation. 
You cannot add or remove objects at 
specific points in time. Nor can you change 
groups or links.

Most of the effects you might hope to achieve by 
changing the hierarchy over time can be achieved 
using other techniques. See “Animating Techniques” 
on page 327 for some examples.

The Tim
represen
up an an
manipul
different
window

The Tim
your ani

Hierarch
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The 

 

Hierarchy area

 

 located on the left 

           

Objects, Masters, and Effects Tabs

             

•

 

Click the 

 

Effects

 

 tab to show a 
archical representation of the scene’s 
er effects. The general category 

 

der Effects

 

 is at the root.

 

ding and Collapsing the 
chy

 

ing and collapsing the hierarchy 
 you to control which time tracks 
 in the 

 

Time Line

 

 window. This is 
when you are editing key events on 
e line.

 

ding and Collapsing Property 
chies

 

n expand individual objects, master 
s, and effects to view their 
able properties. 
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side of the window displays the scene’s 
hierarchical structure.

The Time Line area to the right of the 
hierarchy area displays a time track for 
each item (object, effect, or property) 
currently shown in the hierarchy area. 
Key event markers on these tracks 
represent key events in the animation.

The Time Axis extending across the 
bottom of the window acts as a time 
ruler, with marks indicating time 
increments (minutes, seconds, and 
frames). 

Hierarchy Area

The contents of the hierarchy area (and 
therefore the tracks shown in the time line 
area) change depending on which tab is 
displayed. 

• Click the Objects tab to show a 
hierarchical outline representation of all 
of the objects, lights, and cameras in the 
scene, with the Universe at the root. 

The three tabs in the hierarchy area of the 
Time Line window s store hierarchies of the 
objects, master objects and render effects 
used in your scene.

hier
rend
Ren

Expan
Hierar

Expand
allows
appear
useful 
the tim

Expan
Hierar

You ca
object
animat
w the animatable properties of an 

 the Time Line window.

 the green arrow (Macintosh) or 
n plus/minus sign (Windows) 
ediately to the left of its name.

e track appears for each property. 
 allows you to edit the key events 
ifying individual properties. By 
nding and collapsing the hierarchy, 
can work with as little or as much 
il as you like in the Time Line 
ow.
All of the grouping, linking and organization 
tools of the Hierarchy are the same for 
producing a 3D illustration or an animation. 
Refer to “Building a Hierarchical Structure” 
on page 254 for more information on these 
features of the Hierarchy area.

For a discussion of organizing objects hierarchically, 
refer to“Building a Scene” on page 251.

• Click the Masters tab to show a list of the 
scene’s master objects. Refer to “Working 
with Master Objects” on page 266 for 
information on working with master 
objects.

Because the modelers operate on master 
objects, key events modifying a an 
object’s shape appear on the time track 
of the corresponding master object. The 
Masters tab is useful for viewing these 

To vie
item:

1Click

2Click
gree
imm

A tim
This
mod
expa
you 
deta
wind
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ll the hierarchy area:

  

the 

 

Time Line

 

 window.

  

e horizontal scroll bar to scroll the 
f the hierarchy area.

 

ge the size of the hierarchy area 
ion to the time line area: 

  

on the cursor over the dividing line 
en the hierarchy area and the time 
ea. The cursor changes to indicate 
ou are over the divider. 

  

he divider to widen or shrink the 
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Within the property hierarchy, related 
properties are grouped logically into 

The Hierarchy area of the Time Line window 
allows you to collapse and expand individual 
objects. This is the WIndows version.

Collapsed 
Property 
Hierarchy

Expanded 
Property 
Hierarchy

green squares rather than arrows or 
plus/minus signs, indicating that they 
cannot be expanded any further.

Green squares in the Hierarchy area of the 
Time Line window indicate that the object 

Expanded 
Group

Property

Missing 
Property

Collapsed 
Category

To scro

1Click 

2Use th
view o

To chan
in relat

1Positi
betwe
line ar
that y

2Drag t

chy area. Release the mouse 

n when the size is right.

ine Area
 Line area of the Time Line 

 displays a time track for each 
 (group, object, effect, property 
, or individual property) currently 

n the hierarchy.

ation’s key events are represented 
vent markers on the tracks of the 
. A marker may represent a single 
t or several coincident key events, 

ating to different properties of the 
categories, some of which may also 
include sub-categories. For example, 
Transformation is a category of 
properties which includes the sub-
category Position and the individual 
properties Hot Point, Scaling and 
Orientation. The Position sub-category 
has three individual properties: X, Y, 
and Z, which together define the object’s 
position in 3D space.

You can expand and collapse the 
categories and sub-categories within the 
property hierarchy by clicking their 
respective arrows (Macintosh) or plus/
minus signs (Windows). Individual 
properties are represented by small 

Some items in the property hierarchy 
have no iconic representation, and no 
associated time track. This indicates that 
the item is not a property of the parent 
object or effect. In the figure above, the 
Cube has no Link property because no 
link has been assigned to it.

Scrolling and Resizing the Hierarchy 
Area

When you expand the hierarchy to show 
several levels, there may not be enough 
space horizontally to display all of the 
names. You can either scroll the view or 

cannot be expanded any further (Macintosh 
version).

hierar
butto

Time L
The time
window
element
category
shown i

An anim
by key e
time line
key even
each rel
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same object. For more information, refer to 

      

To illustrate, consider the specific example 

  

One level further down, a key event marker 
s on the Position track (c). 

, we see that key event markers 
 on the X and Y tracks under the 

 

ey event marker appears on the 
n track.
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“Key Event Markers on Collapsed Time Line 
Tracks” on page 300.

The key event marker appears on the track 
for the object or effect it relates to. The 
location of a key event marker along its 

The Key Event marker in the Time Line Area 
indicates the position of a key frame in the 
animation time line.

TrackKey Event 
Marker

of an object that has been moved to a new 
position along the XY plane. A key event 
marker appears on its time track (a).

(a) A key event marker appears on its time 
track.

appear

Finally
appear

(c) A k
Positio
n category (d). These markers 
ent two simultaneous key events: a 
 to the object’s X coordinate, and a 
 to its Y coordinate.

e key event markers appear on the X 
tracks.
track indicates the time at which the key 
event occurs.

Key Event Markers on Collapsed Time 
Line Tracks

The term key event refers to the 
modification of a single property. Key event 
markers higher in the hierarchy—on the 
tracks of groups, objects, effects, and 
property categories—actually represent 
key events that modify the individual 
properties at the bottom of the hierarchy.

Expanding the object’s property hierarchy 
shows a key event marker on the 
Transformation track (b). 

(b) Expand the objects hierarchy to display 
the event marker.

Positio
repres
change
change

(d) Th
and Y 
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r Range

 

 (the white area of the 
Axis) indicates the beginning and 
f the animation for the purposes of 
wing and rendering.

 

Scale 

 

button allows you to change 
mation’s frame rate and the size of 
e increments on the Time Axis.

 

nt Time Bar

 

 and the 

 

Time Edit 
oller

 

 indicate the 

 

current time

 

—the 
in the animation currently 
yed and edited in the 

 

Perspective

 

 
w.

 

ale and Frame Rate

 

 scale describes the amount of 
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Whenever two or more coincident key 
events modify properties of the same 
object or effect, they are represented on 
higher levels by a single key event marker. 
So, when you move, copy, or delete a key 
event marker that represents several 
coincident key events, all of the key events 
beneath it are affected.

To manipulate the key events separately 
you need to expand the hierarchy to the 
individual property level, where the two 
key events are represented by different key 
event markers on separate tracks.

Step-by-step instructions for editing key events appear 

on the top key event changes to a plus sign, 
indicating that there are two or more 
closely spaced key event markers present.

Zooming in usually makes it easier to 
distinguish between overlapping key 
events. You can zoom in with the 
Magnifying Glass tool, or click the Time 
Scale button and change the settings in the 
Set Time Axis dialog. For instructions, refer 
to “Time Scale and Frame Rate” on 
page 301.

This is what two overlapping key event 
markers look like on the time line. 

Rende
Time 
end o
previe

Time 
an ani
the tim

Curre
Contr
point 
displa
windo

Time Sc

The time

ween each mark on the Time Axis. 
 change the scale of the axis to see 
e in a shorter distance, or less 
 longer distance. 

e rate describes the number of 
isplayed in each second. This 

to previews and renderings.

e frame rate also determines the 
 of tics between major time 
s on the Time Axis. 

 set both these options in the Set 
is dialog.
in “Editing the Time Line” on page 306.

Overlapping Key Event Markers

Sometimes two or more key event markers 
appear on the same time track at nearly, 
but not exactly the same time (they may 
represent key events modifying the same 
property, or key events modifying different 
properties of the same object or effect).

Depending on the current time scale (how 
closely you have zoomed in on the view of 
the time line area), these markers may 
overlap. In this case, the tiny vertical mark 

Time Axis
The Time Axis extends across the bottom 
of the Time Line window. It serves as a time 
ruler, with marks indicating time 
increments (minutes, seconds and frames).

The Time Axis and its related interface 
items—the Current Time Bar, Time Edit 
Controller, Render Range, and Time Scale 
button—serve several important purposes:

Time Axis provides a temporal reference 
for the key event markers in the time line 
area.

The Time Axis shows the time increments 
used to measure your animation.

time bet
You can
more tim
time in a

The fram
frames d
applies 

Note: Th
number
division

You can
Time Ax
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The options range between 1 and 60 The content of the Perspective window 
s the state of the scene at the current 
he title bar of the Perspective 
 also indicates the current time.

lt, when you drag the Current Time Bar it 
 each tick (frame boundary) along the Time 
s allows you to set the current time precisely. 

rrent Time Bar in the Time Line 
 indicates the current time in the 
xis.
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To change the time unit divisions (scale) 
on the Time Axis:

1Click the Time Scale button at the 
bottom of the Time Line window. 

The Set Time Axis dialog appears.

Use the Set Time Axis dialog to change the 
unit divisions on the Time Axis in the Time 

frames per second (fps). Typical frame 
rates are 15 or 18 fps for multimedia (CD-
ROM), 24 fps for film, and 30 fps for NTSC 
video. You’ll probably want to use a 
lower frame rate for previewing, then 
increase the rate for final rendering.

Note: The Frame Rate pop-up in the Set 
Axis dialog is synchronized with the frame 
rate menus in the Time Controller toolbar 
and the Render Settings dialog.

With snapping is turned on, the Current 
Time bar and key event markers will snap 
to individual frame boundaries when you 
drag them. 

reflect
time. T
window

By defau
snaps to
Axis. Thi

The Cu
window
Time A
 turn snapping off by clicking the Time Scale 
nd disabling the Snap option in the Set Time 
log. Refer to “Time Scale and Frame Rate” on 
1.

nge the current time with the time 

e Time Line window, drag the 
ent Time bar to a different point 
g the Time Axis. 

 can also click a point on the Time 
. 
2Choose a time scale from the Division 
pop-up.

Time scales range from 1/3 second to 2 
minutes.

To set the Frame Rate for the animation 
(using the Set Time Axis dialog): 

1Click the Time Scale button at the 
bottom of the Time Line window.

2Choose one of the frame rates from the 
Frame Rate pop-up.

Line window.
To control snapping to frame 
boundaries: 

1Click the Time Scale button at the 
bottom of the Time Line window.

2Enable the Snap option. 

The Current Time Bar

The Current Time bar is a vertical red 
slider with an arrow that points to the 
current time on the Time Axis. 

You can
button a
Axis dia
page 30

To cha
bar: 

1In th
Curr
alon

You
Axis
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ge the Render Range start and 
es: 

the Time Line window.

he right edge of the Render Range 
 the end time. 

he left edge of the render range to 
e start time of the animation. 

ime Controller 
ar
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If you drag the Current Time bar slowly, 
the contents of the Perspective Window 
updates interactively as you drag.

The Time Edit Controller

The Time Edit Controller, located to the 
left of the Time Axis and beneath the 
hierarchy area, displays the current time 
numerically in minutes, seconds, and 
frames (mm:ss:ff). For example, a reading 
of 00:08:23 refers to the moment that is 
eight seconds, 23 frames into the 
animation.

Note: The Time Edit Controller is 
synchronized with the Current Time Bar 
and the Time Controller toolbar (described 

The Render Range

The Render Range describes which time 
segment will be previewed or rendered. 
The Render Range is shown in white on the 
Time Axis. 

Note: The Render Range is synchronized 
with the Scene Settings window: 
Output tab: File Format: Movie 

controls. For more information, refer to 
“File Format” on page 362.

Render Range on the Time Axis indicates the 
length of your animation.

Render Range

To chan
end tim

1Click 

2Drag t
to set

3Drag t
set th

The T
Toolb
e Controller toolbar contains 
 buttons for previewing and 
through your animation within the 
tive window, moving forward or 
e frame, and moving to the 
g or end of the render range.

r range is the white area of the Time Axis, 
ermines the starting and ending points for 
 or rendering an animation. Instructions for 
 render range appear in “The Time Line 
on page 297.
“The Time Controller Toolbar” on page 303.

To change the current time (using the 
Time Controller toolbar): 

1Make sure the Time Controller toolbar is 
displayed.

2Type a new value, or use the arrows to 
scroll buttons to change the current time 
value.

Use the current time fields in the Time 
Controller toolbar to adjust the position of 
the Current Time Bar.

The Render Range must extend past all key 
events if you want to preview or render the 
entire animation. The animation stops at 
the right boundary of the render range. If 
your animation does not preview or render 
to the end, verify that the render range 
extends beyond the last key event.

In theory, the maximum render range is one frame 
short of one hour (the entire length of the Time Axis). 
In practice, an animation that long would exceed the 
capacity of most hardware configurations. Lengthy 
animations should be produced in several short clips, 
which can then be edited together in a video-editing 
application.

The Tim
VCR-like
moving 
Perspec
back on
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The rende
which det
previewing
setting the
Window” 
Chapter 15 • Animating 303

ime Controller toolbar to controls 
iew your animation.
Use the T
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The Time Controller can also be used to 

 cases, you may want to render a low-
n animation for preview purposes, rather than 

 the animation in the Perspective window. 
 information, refer to “Renderers” on 
2.

nge the frame rate using the Time 
ller:

e sure the Time Controller toolbar is 
layed. If it’s not choose View 
u > Toolbars and enable Time 
troller.
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To display the Time Controller toolbar:

1Choose View menu> Toolbars. The 
Toolbars dialog appears.

2Click the Time Controller item to enable 
its display. 

When the item has a check beside it, Ray 
Dream Studio displays that toolbar.

Note: Like all of Ray Dream Studio’s 
toolbars, you can use the Time Controller 
as a floating palette or dock it on any side 
of the screen.

Previewing an Animation

change the current time. You can advance 
or back up one frame, or move to the 
beginning or end of the render range. You 
can also change the frame rate.

Play Click to preview 
the animation 
forward from the 
current time.

Reverse 
Play

Click to preview 
the animation 
backward from the 
current time.

Stop Click to halt play.

Loop Click to loop 

In some
resolutio
preview
For more
page 34

To cha
Contro

1Mak
disp
men

Con
ose a frame rate from the Frame Rate 
-up. Values range from 1 to 60 frames 
second.

ou can also set the frame rate using 
 Time Axis dialog or the Scene 
gs window: Output tab: File 
t controls. 

e working with limited screen space, you can 
 Time Line window and use the Time 
ler toolbar to change the current time as you 
ey events. However, you won’t be able to see 
f animatable properties, manipulate key event 
 or apply tweeners with the Time Line 
 closed.
You can use the Time Controller toolbar to 
preview your animation at any time. The 
animation will play in the Perspective 
window at the current display quality. 
Better Preview quality is not recommended 
for previewing animations.

When you preview an animation in a 
Perspective window, Ray Dream Studio 
won’t skip any frames. If it can’t draw 
frames fast enough to maintain the current 
frame rate, the preview will take longer to 
play.

Reducing the frame rate will produce 
choppier motion, but the preview will play 
closer to “real time.” Lowering the current 
display quality to wireframe or box will 

when you play. 
Click again to 
disable looping.

Rewind

Click to jump 
directly to the first 
frame of the 
render range.

Fast 
Forward

Click to jump 
directly to the last 
frame of the 
render range.

Previous 
Frame

Click to step back 
one frame.

2Cho
pop
per 

Note: Y
the Set
Settin

Forma

If you ar
close the
Control
define k
the list o
markers,
window
304 Ray Dream Studio User Guide

speed up the preview without sacrificing 
smoothness of motion.

Next 
Frame

Click to advance 
one frame.



 or hide an object’s motion path:

 the object whose path you want to 
or hide.

the View Motion Path icon on the 
Controller toolbar.

ream Studio toggles display of the 
t’s motion path.

member that motion paths are 
e for objects individually. You must 
 object before clicking the icon to 
ts motion path display state.
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Interactive Mode

Ray Dream Studio’s Interactive Mode lets 
you see the objects move when you 
preview animations using Shaded or Better 
preview. When Interactive Mode is off, only 
projections (and bounding boxes for 
selected objects) move when you preview 
animations in Preview, Shaded Preview or 
Better Preview Quality.

To enable or disable Interactive Mode:

1If necessary, display the Rendering 
toolbar, by choosing View menu > 
Toolbars and enabling the Rendering 
option.

where an object is located throughout the 
animation. Motion paths are 3D and cast 
projections.

Motion path let you see the path of your 
object in an animation.

Motion Path

To show

1Select
show 

2Click 
Time 

3Ray D
objec

Note: Re
availabl
select an
change i
otion Path preferences:

e File menu> Preferences.

e Motion Paths from the pop-up.

e the Display Frames option if you 
the path to show marks that 
te the object’s position along the 
tion.

e a Fidelity level (Low, Medium or 
 to set how precisely Ray Dream 
 should calculate and display the 

. 
2In the Rendering toolbar, click the 
Interactive Mode button.

Interactive Mode is on when the button 
is darkened.

Viewing Motion Paths
To help you visualize the movements of 
your animated objects, Ray Dream Studio 
can display motion paths. A motion path is 

Enable the Interactive Mode button if you 
want to see your objects move in the 
Perspective window when you play an 
animation.

The marks on the path describe the speed 
of the object through the animation. Where 
the marks are closer together, the object 
moves more slowly.

Note: The motion path is a visualization 
tool. You cannot change an object’s 
trajectory by editing the path directly.

Motion paths apply to objects individually, 
so you can show or hide them for any 
particular object. The control for viewing 
motion paths is on the Time Controller 
toolbar. 

Use the View Motion Path button to see the 

To set M

1Choos

2Choos

3Enabl
want 
indica
anima

4Choos
High)
Studio
paths
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a line curving through space that describes motion paths of your objects in the 
Perspective window.



Defining Key Events Note: Notice that every element has a key 
n frame one. That’s because 
hing must have an initial state.

ing the Time Line

ou’ve created several key events, 
y want to change the timing of your 

animation, or synchronize 
ual events within the animation. 

n edit the time line to adjust the 
 and content of your animation. You 
d key event markers, delete them, or 
hem along the Time Axis. You can 
py and paste events between time 
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Key events are changes to the properties of 
objects and effects in your scene at specific 
points in time. You’ll define key events to 
set the changes that create your animation. 
Ray Dream Studio automatically calculates 
the transitional states between key events.

After creating key events, you may want to 
modify the rule (tweener) Ray Dream 
Studio uses to calculate the transitional 
states between keys. For more information, see 
“Applying the Tweener” on page 310.

To define key events:

1Click the Time Line window.

2Set the current time to a time where you 
want to add one or more key events. 

You can drag the Current Time Bar, click 
a point on the Time Axis, or enter a time 
in the Time Edit Controller to set the 
time.

3Use the standard Ray Dream Studio 
tools, editors, palettes, and dialogs to 
modify the properties of any object or 
effect you want animated.

event i
everyt

Edit

After y
you ma
entire 
individ

You ca
timing
can ad
move t
also co
ing Key Event Markers

ct a key event marker:

ose the Selection tool.

 on the key event marker you want 
lect.

ld down the Shift key and click 
ditional markers you want to select.

u may also drag a marquee around 
e or several markers to select them.
The physical force behaviors have special 
considerations. Their physical behaviors 
take precedence over arbitrary settings. 
Therefore, you cannot set key events for 
position or orientation on any object that 
has physics applied except on the first 
frame of the animation. See “Physical 
Forces” on page 318 for complete 
information on working with the physical 
forces.

Typically, you’ll create a key event at the 
beginning and end of a particular action.

Ray Dream Studio places a key event 
marker on the appropriate track in the 
time line. 

4Continue creating key events for the 
several elements at various points along 
the Time Axis.

You can also add a key event directly to a time track in 
the Time Line window, using the Add Key Event tool. 
This doesn’t change the existing action. It adds a key 
event at that point which you can then edit to change 
the timing of the animation. See Editing the Time Line, 
below.

tracks.

Select

To sele

1Cho

2Click
to se

• Ho
ad

• Yo
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icate key events while dragging:

Time Line window.

own the Option/Alt key, and drag 
r more key event markers along 
ime track(s).

e selected key event markers: 

the Time Line window.

 one or more key event markers on 
e line.

 the left or right arrow key to move 
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Adding Key Events

To add a key event:

1Click the Time Line window.

2Choose the Add Key Event tool from the 
toolbar.

3In the Time Line window, click on the 
time track at the point where you want to 
add the event. 

You can select the new key event marker 

Changing the Timing of Key Events

To change the timing of key events, you 
simply move key event markers 
horizontally along the time tracks to 
different points along the Time Axis.

To move one or more selected key events:

1Drag the key event marker along the 
Time Axis to the point where you want it. 

If you’ve selected several markers, drag 
one of them and they all will move. The 
time intervals between the selected key 
events remain the same.

To dupl

1Click 

2Hold d
one o
their t

To nudg

1Click 

2Select
the tim

3Press

arker one screen pixel to the left or 

he Shift key down and press the 
 keys to move one frame at a time.

 duplicate an object (Command-D/Ctrl+D), 
d Paste an object, you duplicate all of its 

e properties. Likewise, when you copy and 
cts into other scenes, they carry their key 
and move it to change the timing. 

Note: The transitions before and after the 
new key event use the tweener options for 
the previous key event.

Removing Key Events

To remove key events:

1Click the Time Line window. 

2Select one or more key event markers.

3Press the Delete/Backspace key.

You may also choose Edit menu> 
Delete.

Ray Dream Studio lets you to move a key event marker 
past neighboring key event markers on the same time 
track. If you want to restrict a key event marker to stay 
between the previous and next key event markers, 
hold down the Shift key as you drag the key event 
marker.

Duplicating Key Events while 
Dragging

You can duplicate a key event to another 
location on the same time track by holding 
down a modifier key while you drag a key 
event marker. This is useful when you want 
to return an object or effect to the same 

the m
right. 

Hold t
arrow

When you
or Copy an
animatabl
paste obje
events.
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state at several points during an animation.



Stretching a Series of Key Events over When you paste key events, they keep both You’ll need to set the mode you want to use 
 translating the object to create key 
.

ose the XYZ Key Event Mode:

e Arrange menu> XYZ Key Event 
 and select the mode you want—
XYZ Together or Only Mark 

ed. 

XYZ Together

 mode, Ray Dream Studio creates a 
ent on each of the separate X, Y, Z 
n tracks—even if you’ve changed 
sition in only one dimension. For 
le, if you raise the object (change Z 
n), Ray Dream Studio places a key 

CH15.rds5  Page 308  Wednesday, July 2, 1997  4:07 PM
Time

You can stretch a series of key events over 
time, while maintaining the proportional 
timing between the events. This is useful 
when you’re satisfied with the relative 
animation of a particular sequence, but you 
want the entire sequence to be sped up or 
slowed down.

To compress or expand the timing 
between a series of key events: 

1Click the Time Line window.

2Select three or more key event markers.

3Hold down the Command/Ctrl key and 

the timing and the property state.

To copy key events: 

1[Click the Time Line window.

2Select one or more key event markers.

3Choose Edit menu> Copy.

To paste key events:

1In the Hierarchy area of the Time Line 
window, select the name of the object, 
group, effect, or property whose time 
track you want to paste onto. 

before
events

To cho

Choos
Mode>

Mark 

Chang

Mark 

In this
key ev
positio
the po
examp
positio
arker on the object’s 
ormation: Position: X, Y and Z time 

YZ Together is the default mode.

k XYZ Together mode any change in 
drag one of the selected key event 
markers.

The entire series of key events will be 
stretched or compressed, retaining the 
proportional timing between the key 
events.

Copying and Pasting Key Events

You can copy key events from one time 
track to another. The key events you are 
copying must modify properties that 
pertain to the destination track. For 
example, you can paste key events 
modifying an object’s position to another 
object’s track, but not to a render effect’s 

2Choose Edit menu> Paste.

The key events (from the clipboard) are 
added to the destination track. If some of 
the key events copied do not pertain to 
the destination track, they cannot be 
pasted.

XYZ Key Event Mode

Ray Dream Studio offers two “recording” 
modes for when you create a key event by 
translating an object (change its position):

• Mark XYZ Together.

• Only Mark Changed.

event m
Transf
tracks.

Mark X

In Mar

n creates a key event on all position 
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track—render effects don’t have positions. The two modes produce different results 
when you create and play the animation. positio

tracks.



to time adjusts the positioning of 
lected events so that they coincide 
he start of the next frame

 Tweeners

rs make it easy to create more 

uence was mirrored. [more 
ve]
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Only Mark Changed

In this mode, Ray Dream Studio creates a 
key event only on the necessary X, Y, Z 
position tracks. For example, if you raise 
the object, Ray Dream Studio places a key 
event marker on the object’s 
Transformation: Position: Z time track. 
Because you didn’t change X or Y, there’s 
no event on these tracks.

To use a Key Event Action:

1Choose the Selection tool.

2In the Time Line window, adjust the 
display to show the sequence of key 
events you want to work with.

You may need to change the time scale 
or expand the properties of an object.

3Select each marker in the sequence. You 
may drag a marquee or Shift-click.

Snap 
the se
with t

Using

Tweene

This seq
descripti
ng and subtle changes in the 
ns between key events. Tweeners 
 you time by automatically 
 movements and changes that 
e extremely difficult with key 
lone. Tweeners make your 
n motions and other changes more 
nd sophisticated. 

 Tweeners
 period between any two key 

s considered a transition. In the 
e, you’ll see the transition as the 
tween key event markers. Ray 
tudio uses a formula (the 
r”) to create the transitional states 
he object or effect changes 
Key Event Actions

Ray Dream Studio provides some special 
features for duplicating and modifying a 
series of key events. You can reverse, 
repeat or mirror a key event sequence. You 
can also adjust the positioning of the 
events so that they coincide with the start 
of the next frame.

In Only Mark Changed mode, a key frame is 
only added to the position track where 
change occurs. 4Choose Arrange menu> Key Event 

Action> and select the action you want:

Reverse flips the order of the events so 
that the last becomes first and vice 
versa.

Repeat Sequence duplicates the 
sequence and places the duplicate 
immediately after the selected sequence.

Mirror Sequence duplicates the 
sequence, reverses the duplicate, and 

Select a sequence of key events.

interesti
transitio
will save
creating
would b
events a
animatio
natural a

About
The time
events i
Time Lin
“gap” be
Dream S
“tweene
so that t
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y between the two key events. 

places it immediately after the selected 
sequence.

smoothl



You won’t always want a smooth, linear 3Double-click the time track segment Note: Notice the small graphic on each 
nt of the time track. This graphic 
es the kind of tweener that is 
.

 Tweener

near tweener creates gradual, direct 
ions between actions.

the graph line is straight, from the 
 left to the top right corner, the 

here’s a tweener applied to a time 
he Tweener indicator appears. 
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transition. Sometimes you’ll want an abrupt 
change of state. Other times you’ll want a 
transition that starts slowly and 
accelerates to finish in a rush. You might 
even want a transition that quickly 
alternates between the before and after 
states, like a florescent light flickering on. 

All of these transitions are possible by 
setting your options for the tweener used 
between each pair of key frames. 

A tweener requires a beginning and an 
ending key event, although you can place 
the ending key event far out in time.

Note: The term tweener is derived from “in-
between.”

between the two key event markers. The 
Transition Options dialog appears.

Use the Transition Options dialog to select a 

segme
indicat
applied

Linear

The Li
transit

When 
bottom

When t
track, t
ion proceeds at an even rate from 
 finish. This is the default, but you 

ange it.

 Linear tweener options:

 the Time Line window.

ble-click the time track segment 
een the two key event markers. The 
sition Options dialog appears.

ct a Linear from the pop-up.

st the two handles on the Ease-In/
-Out slider on the Linear tweener to 
ify the rate of change at the 
Applying the Tweener
Every “gap” between key events on the 
time track must have a tweener. The 
default tweener is Linear, which produces 
an even rate of change between the two 
states. You can achieve a different sort of 
transition by applying a different tweener.

To apply a Tweener:

1Click the Time Line window.

2Set up beginning and ending key events. 

4Select a tweener type from the pop-up.

5Set the appropriate controls for the 
tweener. The controls for each type of 
tweener are described in the sections 
that follow.

As you move the handles on a slider, the 
graph reflects the new settings. 

6Click OK to close the dialog.

type of tweener to apply to your animation.
transit
start to
can ch

To set

1Click

2Dou
betw
Tran

3Sele

4Adju
Ease
mod
nning and end of the transition.
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begi



t the Threshold slider to specify 
act point during the transition 
 you want the change to occur. 

reshold value is a percentage of 
ansition’s entire duration. For 
le, if you want the discrete change 
ur halfway between the key events, 
e threshold to 50%. If you want the 
e to occur at the time of the first or 
y event, set the threshold to 0% or 

 respectively. 

weener

ier tweener is designed especially 
ting smooth motion paths. For best 
use it on an object’s transformation 
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• Drag the left handle to the right to start 
slowly.

• Drag the right handle to the left to 
finish slowly. 

2 seconds1 second

Discrete Tweener

The Discrete tweener maintains the values 
from the key event that begins the 
transition until a specific time in the 
transition is reached. Then the values 
abruptly change to those of the key event 
that ends the transition. Use the Discrete 
tweener when you want a property to 
change immediately, like switching on a 
light.

To set discrete tweener options:

1Click the Time Line window.

2Double-click the time track segment 
between the two key event markers. The 

4Adjus
the ex
where

The th
the tr
examp
to occ
set th
chang
last ke
100%,

Bézier T

The Béz
for crea
results, 
ier tweener has two controls that 
 adjust—Ease-In/Out and Tighten-

ézier tweener options:

the Time Line window.

e-click the time track segment 
en the two key event markers. The 
ition Options dialog appears.

 a Bezier from the pop-up.
You can see how different Ease-In and Ease-
Out settings affect your animation. Some 
objects move faster at the beginning of the 
animation while others move faster at the 
end of the animation.

4 seconds3 seconds

5 seconds

Transition Options dialog appears.

3Select a Discrete from the pop-up.

track.

The Béz
you can
In/Out. 

To set B

1Click 

2Doubl
betwe
Trans

3Select
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Use the Discrete Tweener options dialog to 
set the tweeners options.



The Bezier tweener controls appear. The 7Drag the right handle to change the 3Select a Oscillate from the pop-up.

 one of the Wave Shape radio 
ons to choose the wave shape you 
t. 

graph of the wave shape shows how 
witch occurs between up and down 
es.

e Sine wave uses a sine curve to 
ternate the before and after values. 

e Square wave alternates back and 
rth between the first and last key 
ents with no interpolation. 
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two handles on the Ease-In/Ease-Out 
slider on the Linear tweener to modify 
the rate of change at the beginning and 
end of the transition.

finishing trajectory.

Values near the extremes (0% and 100%) 
result in tighter trajectories (closer to 
linear). Values near 50% result in looser 
(less direct) trajectories. The default 
settings (33% in and 67% out) are 
optimized for natural, smooth motion.

0%
100%

33%
67%

50%

4Click
butt
wan

The 
the s
phas

• Th
al

• Th
fo
ev
 Oscillate Tweener options dialog to 
 shape of the oscillate wave and other 
tes.
4Drag the left handle to the right to start 
slowly.

5Drag the right handle to the left to finish 
slowly. 

The Tighten In/Out slider allows you to 
adjust the trajectory of the transition—
the “path” the values take as they change 
from one key event to the next.

6Drag the left handle to change the initial 
trajectory.

Use the Bezier Tweener options dialog to 
adjust the curve of the tweener.

Oscillate Tweener

The Oscillate tweener switches back and 
forth between the start and end values 
several times during the transition You can 
choose between several wave forms to 
describe the alternation. 

To set Oscillate tweener options:

1Click the Time Line window.

2Double-click the time track segment 

Extreme Tighten In/Out settings result in 
tighter trajectories. Values closer to 50% 
result in smoother trajectories. 

Use the
set the
attribu
312 Ray Dream Studio User Guide

between the two key event markers. The 
Transition Options dialog appears.



a Tweener

 creates a transition curve or 
from a formula. You can devise 
n formula to create a custom 
.

 formula for the tweener:

the Time Line window.

e-click the time track segment 
en the two key event markers. The 
ition Options dialog appears.

 a Formula from the pop-up. The 
la controls appear.]
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One way to make a light blink at one second intervals 
is to turn the light on and off by setting key events 
every second on the light’s time track. A more efficient 
way is to turn a light on at Event A and then turn it off, 
perhaps ten seconds later, at Event B. Afterwards, 
apply the Oscillate tweener, and specify ten 
oscillations (using the Square wave so that the 
switches are abrupt). The Oscillate tweener switches 
the light on and off ten times during the ten-second 
interval, using only two key events and a single 
tweener.

• The Saw/Loop wave interpolates 
linearly from its beginning value to its 

• The Triangular wave shape causes the 
transition to alternate back and forth 
abruptly.

• The Bounce wave shape causes the 
transition to alternate, with abrupt 
change in and out of the second 
position and gradual change in and out 
of the first position. This works well 
when the first position is a ball at 
height, and the second position is the 
ball on the floor.

5Adjust the Nbr Oscillation slider to set 
the number of times the values should 
alternate.

6Adjust the Damping slider to 

Formul

Formula
pattern 
your ow
tweener

To use a

1Click 

2Doubl
betwe
Trans

3Select
Formu
current formula uses the 

iew displays the result of the current 
ending value, then snaps back abruptly 
to the beginning value in each 
oscillation. 

You can use this option to replicate an 
action, such as hitting a gong. The 
character’s arm is first placed in a 
drawn back position, moves to strike 
the gong, and then snaps back. You can 
also use Saw/Loop to play a movie from 
start to end in a loop. 

This is what the Saw/Loop Wave Shape 

progressively diminish the amplitude of 
the oscillations. 

After each oscillation, the amplitude 
diminishes by the damping factor 
percentage.

7Adjust the Up Phase slider to control 
how much of each oscillation is 
dedicated to the “up phase.”

For example, if you set the Up Phase 
value to 90%, the object spends 90% of 
the oscillation changing from A to B and 
only 10% changing from B to A.

4If the 

The prev
formula.
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eter sliders, you can adjust them 
nge the formula result.
looks like when you apply Damping
Param
to cha



The graph describes the result. Behaviors assign the Point At behavior to an object 
o give the object Spin—these 
ors would produce contradictory 
. 

u apply a behavior, it remains in the object’s 
r list for the duration of the animation. 
r, most behaviors can be turned on an off at 
 points along the time line. 
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5To load a new formula, click the disk 
icon.

Use the Open dialog to locate and open 
an appropriate formula. Sample formulas 
can be found in the Samples: Formulas 
folder on your Ray Dream Studio CD.

6If you want to edit the formula or create 
your own, click More to open the 
Formula Editor.

Ray Dream Studio uses the Formula 
Editor in several places. Use of the editor 
is common, but the type of formula 
you’re creating determines the valid 

Behaviors allow you to give objects sets of 
instructions that give them an “activity” 
during the animation. Behaviors reduce the 
number of key events you need to create 
and allow you to create actions that are not 
otherwise possible.

Some behaviors, such as Bounce and Spin, 
automatically assign complex actions to an 
object. greatly reducing the number of key 
events you need to create. Others, such as 
Point At and Track, define or modify the 
motion of one object based on the location 
or motion of another object.

and als
behavi
results

When yo
behavio
Howeve
different
ly a behavior:

ct an object.

lay the Properties palette: 
aviors tab.

 the Plus icon. A dialog appears with 

 Behaviors tab in Properties palette to 
 delete behaviors from an object.
input and output variables. Refer to the 
“Using Formulas in Ray Dream Studio 5 
PDF” for details on using the Formula 
Editor.

Formula editing becomes technical 
quickly. You can learn a lot by loading 
the sample files. 

7When you’re done with the Formula 
Editor, click OK.

8To save a formula, click the disk icon and 
choose Save As from the pop-up.

Use the Save dialog to name the file and 
choose a disk location. 

Inverse kinematics is a specialized 
behavior that ensures that complex, linked 
models move realistically. 

The physical force behaviors allow objects 
to move and interact as though they 
obeyed the laws of physics. The physical 
forces have special characteristics. See 
“Physical Forces” on page 318 for complete 
information.

Applying Behaviors
You can apply multiple behaviors to an 
object or group; however, some may 
override the others.

For example, you can apply both a bounce 
and a spin to an object. However, some 

To app

1Sele

2Disp
Beh

3Click

Use the
add or
t of the available behaviors.
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behaviors are exclusive—they cannot be 
used together. It wouldn’t make sense to 

a lis



 menu> Point At differs from the 
ehavior in two respects. First, Arrange 
Point At only operates on cameras and 

ond, it only makes the change “right now,” 
an animation tool. 
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4Choose the behavior you want to apply. 
Click OK. 

5Set other options for the behavior. 

The options for Spin, Bounce, Point At, 
Track and Inverse Kinematics are 
described below. The options and use of 
the physical forces—Apply Physical 
Effects, Initial Velocity, Directional 
Force, Point Force, Rotational Force, 
Flow Force and Damping Force—are 
covered separately. Refer to “Physical 
Forces” on page 318.

6Click Apply to send your changes to the 
object.

3On the tab, click the title of the behavior 
you want to remove to select it. 

4Click the Minus icon in the Behaviors 
tab.

Click the Behavior’s name on the Behavior’s 
tab to select it.

Arrange

Point At b
menu> 

lights. Sec
so it’s not 
oint at options: 

 the Point At behavior to an object. 
oint At controls appear on the 
rties palette: Behaviors tab.

o apply a behavior:” on page 314 
tructions on applying behaviors.

the name of the object to be 
d at in the text box. Type the name 
y as it appears in the Hierarchy 
(The text box is case sensitive). 

oint At Tab to select an object to 
The basic behaviors (excluding the 
physical forces) are applied in the order 
that they appear in the list. Where two or 
more applied behaviors conflict, those 
further down the list override those above. 
After you add behaviors, you can drag 
them up or down to change the order.

To remove a behavior from the list:

1Select the object or group that carries 
the behavior. 

2Display the Properties palette: 
Behaviors tab.

Point At

The Point At behavior instructs an object 
to orient itself “toward” another object (hot 
point) through all or part of the animation.

You can use the Point At behavior to get a 
camera or light to follow a particular object 
or group. You can also use it to animate an 
object that always faces or points at 
another, such as a satellite dish as it tracks 
a satellite, or a sunflower as it follows the 
path of the sun.

To set p

1Apply
The P
Prope

See “T
for ins

2Type 
pointe
exactl
area. 

Use the P
point at.
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3Use the radio buttons in the Axis area to 5Remember to click Apply to update your 

 bounce options: 

ly the Bounce behavior to an object. 
Bounce controls appear on the 
erties palette: Behaviors tab.

“To apply a behavior:” on page 314 
nstructions on applying behaviors.

e Floor entry box, enter the lower 
 of the bounce. The value describes 
istance from the global universe Z=0 

e that is the lower limit of bouncing.

e Height entry box, enter the height 
e bounce. The value describes the 
nce above the floor level that is the 
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select which face of the object should 
point at the target object. 

For objects other than camera or light, 
you’ll need to specify which face of the 
object should be oriented toward the 
target. For example, if you’re working 
with a “pointing finger” object, select the 
axis that describes the direction the 
finger points.

This step is not necessary with a camera 
or light. By default, the face with the light 
beam or the camera lens is selected. Any 
other setting would point the light beam 
or camera lens at 90° or 180° to the 
target.

changes to the object. 

Bounce

The Bounce behavior instructs an object to 

The Point At behavior was applied to the 
rocket so that it continues to point at the 
dinosaur no matter where it moves.

To set

1App
The 
Prop

See 
for i

2In th
limit
the d
plan

3In th
of th
dista
er limit of bouncing.

e Bounces per Second entry box, 
r the number of bounces per second.

r values in the Start Time and End 
e entry box to limit the bounce to a 
icular range in time.

ember to click Apply to update your 
ges to the object.
You can display the Properties palette: 
Transform tab: Position controls to 
show the axes. For a reference on the object itself, 
enable the File menu: Preferences 
dialog: Perspective: Hot Point: Show 
Axis Information option.

4You can use the Enable checkbox to turn 
the behavior on and off at specific points 
in the animation. 

A key event is created each time you turn 
the behavior on or off.

bounce up and down along the global z-
axis. You can set the upper and lower limits 
for the bounce, and specify the number of 
bounces per second. 

Note: The bounce behavior does not 
control an object’s lateral movement 
(along the x and y planes). 

The Bounce behavior is useful when you have a very 
specific effect in mind and wish to specify Bounce 
parameters (like height and frequency) by hand. 
However, natural bouncing is much easier to create 
using the physical forces. See “Physical Forces” on 
page 318. 

upp

4In th
ente

5Ente
Tim
part

6Rem
chan
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e Kinematics
Kinematics is a specialized 
r that is applied to linked objects. 
Kinematics provides the versatility 
to-parent control. It reduces the 
akes to create realistic animations.

y, movement is transmitted 
rd from parent to child in the 
y. When you link a child to a 
bject and apply inverse 
ics, movement can also propagate 
ierarchy—from the child to the 
his means that when you move a 

ject, the parent follows. Motion 
ropagate from a linked child to its 
ithout Inverse Kinematics.
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Spin

The Spin behavior instructs an object to 
rotate on one of its axes. You can set the 
number of cycles of the spin per second.

You can also spin an object using the physical forces. 
see “Physical Forces” on page 318. 

To set spin options: 

1Apply the Spin behavior to an object. 
The Spin controls appear on the 
Properties palette: Behaviors tab.

Track

The Track behavior instructs an object to 
“shadow” another as its moves through the 
universe.

To set track options: 

1Apply the Track behavior to an object. 
The Track controls appear on the 
Properties palette: Behaviors tab.

See “To apply a behavior:” on page 314 
for instructions on applying behaviors.

2Type the name of the object to be 
tracked in the text box. Type the name 
exactly as it appears in the Hierarchy 

Invers
Inverse 
behavio
Inverse 
of child-
time it t

Normall
downwa
hierarch
parent o
kinemat
up the h
parent. T
child ob
cannot p
parent w
ent is affected by the type of link property 
raint you apply, for example, a Lock, Slider, 
 can constrain the movement of the child 
elation to the parent. Refer to “Linking 
n page 259 for information on link 
 and constraints.

e an arm as an example, linking the 
that make up the arm in a 
ical structure and placing the hot 
t the joints, you can rotate the arm 
See “To apply a behavior:” on page 314 
for instructions on applying behaviors.

2Select the axis of rotation.

3In the Cycles per second entry box, enter 
the number of cycles per second for the 
spin. (A cycle is one complete 360° 
rotation.)

4Enter values in the Start Time and End 
Time entry boxes to limit the spin to a 
particular range in time.

5Remember to click Apply to update your 
changes to the object.

area. (The text box is case sensitive.)

3Enable the checkboxes for each axis you 
want to track in. 

4Enable Track Rotation if you wan the 
object to track the rotation as well as 
position.

5Use the Enable checkbox to toggle the 
behavior on and off at specific points in 
the animation.

6A key event is created each time you turn 
the behavior on or off.

7Remember to click Apply to update your 

The movem
and const
or 2D link
object in r
Objects” o
properties

If you us
objects 
hierarch
points a
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changes to the object.



at the shoulder or elbow, and everything Refer to “Linking Objects” on page 259 for Physical Forces
ysical forces are a special form of 
or. These forces allow your objects 
lerate, move and interact in ways 

tent with the laws of physics. 

physical force behaviors enable you 
te realistic animations that would be 
ly impossible with key framing. You 
t objects to slide down a slope, bump 
ch other and bounce away, and 
seful motions. 
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below that joint (toward the hand) moves 
accordingly. 

You can easily animate the natural motion of 

information on linking one object to 
another. Refer to “Applying Link 
Properties” on page 260 for information on 
setting link properties and constraints. 

The ph
behavi
to acce
consis

These 
to crea
virtual
can ge
into ea
other u
e physical forces do an excellent job of 
ng many physical events, it is not a complete 
ome types of interaction are not supported. 
clude true momentum exchange, perfect 
nd some types of tumbling. This means you’ll 
uble shooting billiard balls into pockets, 
 over bowling pins and tumbling dominoes 

r the other.

nnon ball was animated using the 
Velocity behavior
With Inverse Kinematics, you can move the 
hand, which in turn forces the forearm and 
upper arm to rotate and move to 
accommodate. 

Before applying the Inverse Kinematics 
behavior to an articulated object, you must 
link the objects that make up the model 
and define properties and constraints for 
the movement of each child in relation to 
its parent. These constraints should 
describe the desired range of motion for 
each part. 

an arm using Inverse Kinematics 

You must apply Inverse Kinematics to the last child 
object in the link chain. You may also apply it to other 
children higher up the link chain. Then if you start a 
movement farther up the chain, objects higher up the 
chain can move as well.

This is what the Arm with links looks like in 
hierarchy mode. 

While th
simulati
model. S
These in
rolling, a
have tro
knocking
one afte

This ca
Initial 
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hysics

y physical effects:

d your animation to frame 1.

 the object you want to apply 
cs to.

y the Properties palette: 
iors tab.

the Plus icon.

 dialog, choose Apply Physical 
s.

ream Studio loads the basic 
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The physics behaviors are as follows: 
Apply Physical Effects, Initial Velocity, 
Directional Force, Point Force, Rotational 
Force, Flow Force and Damping Force. 
Each of these is described in detail later in 
this section.

Note: You can learn a lot about the physical 
forces and how to use them be viewing the 
sample animations and demonstration files 
in the Ray Dream Studio 5 CD: Samples: 
Sample Physics folder.

The physical forces are exclusive of most 
other behaviors, and they may not work 
with some of the link property constraints 
and deformers.

frame 1) that would arbitrarily set position 
or orientation on the object. Its other 
properties, like scale and shading, remain 
animatable with key frames.

You can’t set position or orientation key 
events for objects that use physics. You 
can, however, set key events for the 
property values in the physical forces 
themselves. For example, you can 
accelerate an object, then apply damping 
to stop it, then accelerate it in a different 
direction. You’ll learn more about this later 
in this section.

Note: Initial Velocity describes the object’s 
inertia in frame 1. Therefore, this force 
cannot be changed with a key event.

Using P

To appl

1Rewin

2Select
physi

3Displa
Behav

4Click 

5In the
Effect

Ray D

gs that tell this object to obey 
cs. For complete information on 
 Physical Effects, see below.

an click the Plus icon again and 
ne of the specific physical forces, 

ibed below. You can apply any 
er of forces. The order you add 
doesn’t matter.

t the settings for the forces you’ve 
d.

Apply.

w the animation to see how the 
 influence object motion. You 
Tip: You cannot use physics on an object for a while, 
then turn it off to allow some other type of event. 
What you can do is create a second copy of the object 
that does not use physics. Then cloak and de-cloak the 
objects to switch between them at the right moments.

Physics and Key Events

Physical forces preclude arbitrary settings 
in key events. For example, if you apply 
directional force to get an object to fall, you 
can’t also set it’s position above the floor. 
The object must either obey physics (and 
fall) or be “above the floor.”

You might want an object to respect 
physics, but still be animated with key 
events. The primary application of this is to 
create an object that can move with key 
events while having objects responding to 
physical forces will bounce off of it. 

You can create this type of action by using 
the Properties palette: 
Miscellaneous tab to add the Physical 
Effects Solid property to the object you 
want to animate using key events.

Another possibility is to develop the 
animation using physical effects, then 
translate the result into key events with the 
Record Behaviors command. This feature 

settin
physi
Apply

6You c
load o
descr
numb
them 

7Adjus
loade

8Click 

9Previe
forces
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 want to extend the Render Range 
 more action. 
When you apply a physical force to an 
object, Ray Dream Studio removes all key 
events (not including the starting key in 

is described in “Record Behaviors” on 
page 326.

might
to see



Refer to “Previewing an Animation” on Note: You can get an object to respect For example, a rubber ball will rebound 
er than a stone, so you should set 

ebound slider to describe the 
ct’s material.

cts don’t have actual mass, but you 
simulate relative mass by giving 
ding objects different rebound 
ngths.

st the Rotational Rebound slider to 
rol this object’s tendency to rotate 
n it rebounds.

direction of rotation depends on the 
e of incident.

st the Friction slider to control this 
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page 304 for complete information on 
using the animation preview controls. 
Refer to “The Time Line Window” on 
page 297 for on using the time line.

Important: After previewing, remember to 
rewind to frame 1. If you make changes 
without rewinding, you’ll be setting a key 
event at this later moment of the 
animation. 

Note: Ray Dream Studio allows you to 
disable physical effects. Disabling the 
physics prevents Ray Dream Studio from 
recalculating the effect when you make 
changes. This is more efficient if your 
changes don’t directly relate to the 

physics for collisions by going to its 
Properties palette: Miscellaneous tab 
and adding the Physical Effects Solid 
property.

Apply Physical Effects is required for any 
object that uses one of the physical forces.

To set Apply Physical Effects options:

1Apply the Apply Physical Effects 
behavior.

See “To apply physical effects:” on 
page 319 for instructions on applying 
behaviors. The Apply Physical Effects 
controls appear on the Behaviors tab.

bett
the R
obje

Obje
can 
colli
stre

4Adju
cont
whe

The 
angl

5Adju

ct’s resistance to sliding along a 
ace.

example, if you want an object to 
 down a slope, set its Friction very 

ll and give it downward (-Z) 
ctional Force (see below).

 Apply to send your changes to the 
ct.
physical effects. For more information, 
refer to “Physical Effects Preferences” on 
page 325.

Apply Physical Effects

Apply Physical Effects is required for all 
objects that take part in physics. It tells the 
object to obey physics and to interact with 
other objects that obey physics.

If you use physics to accelerate one object 
into another, the resulting collision 
depends on whether the target object 
respects physics. If it does not, the missile 
object will simply pass through the target 
and continue on its way. If the target does 
respect physics, the two objects will 
bounce apart.

2Disable the Moveable by impact option if 
you want the object to stay in one place. 

For example, if you drop a ball onto a 
table, you want the ball to bounce and 
the table to stay where it is. If both 
objects are “Moveable by impact”, the 
collision will send them in opposing 
directions. Disable the Moveable by 
impact option for the table to keep it 
stationary.

3Adjust the Rebound slider to control this 
object’s tendency to rebound.

obje
surf

For 
slide
sma
Dire

6Click
obje
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ream Studio activates the Direct 
ulation Controls icon.

the Direct Manipulation Controls 

 Perspective window, Ray Dream 
 displays a wire reference that 
 the Initial Velocity vector. 
onal velocity is not shown.

he handle at the end of the wire (or 
f the projections) to change the 
r and velocity. Increasing the 
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Initial Velocity 

Initial Velocity applies directional or 
rotational motion to an object in frame 1. If 
no other force influences the object, it will 
maintain its initial velocity indefinitely.

To set Initial Velocity options:

1Apply the Initial Velocity behavior.

See “To apply physical effects:” on 
page 319 for instructions on applying 
behaviors The Initial Velocity controls 
appear on the Behaviors tab.

2Enter values for velocity in the X, Y and Z 
dimensions.

4Click Apply to send your changes to the 
object. 

The Initial Velocity behavior’s Direct 

Initial Velocity takes care of the lateral 
movement on this rocket.

Ray D
Manip

3Click 
icon. 

In the
Studio
shows
Rotati

4Drag t
one o
vecto
 of the wire increases the initial 
ty. 

ream Studio updates the Initial 
ity X, Y, Z values as you drag.
Use a negative value to set velocity 
opposite to the arrow in the xyz axis 
graphic.

3Enter values for rotational velocity in 
terms of Yaw, Pitch and Roll.

Use a negative value to set rotation 
counter to the arrow in the xyz/yaw 
pitch roll graphic.

Manipulation Control lets you see a wire 
reference of the Initial Velocity directional 
vector. You can drag the handle on the wire 
to change the vector and velocity. 

To use the Direct Manipulation Controls 
with Initial Velocity:

1Apply the Initial Velocity behavior to an 
object.

See “To apply physical effects:” on 
page 319 for instructions on applying 
behaviors 

2In the Properties palette: Behaviors 
tab, click once in the Initial Velocity 

length
veloci

Ray D
Veloc
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panel (or on its title) to select it.



Directional Force Note: Units of force are arbitrary. 2In the Properties palette: Behaviors 
 click once in the Directional Force 
l (or on its title) to select it.

Dream Studio activates the Direct 
ipulation Controls icon.

 the Direct Manipulation Controls 
.

e Perspective window, Ray Dream 
io puts a wire reference that shows 
irectional Force vector. Rotational 

city is not shown.

 the handle at the end of the wire (or 
of the projections) to change the 
or and force amount. Increasing the 
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Directional force accelerates an object in 
one direction. 

You can use directional force to produce 
the effect of gravity—falling objects. 

Without direction force, the ball would 
continue along its original trajectory 
indefinitely.

Initial Velocity

Directional Force

3Click Apply to send your changes to the 
object. 

This ballistic trajectory is accomplished with 
an initial velocity and a -Z directional force.

tab,
pane

Ray 
Man

3Click
icon

In th
Stud
the D
velo

4Drag
one 
vect
th of the wire increases the amount 
rce. 

Dream Studio updates the 
ctional Force X, Y and Z values as 
drag.
To set directional force options:

1Apply the Directional Force behavior.

See “To apply physical effects:” on 
page 319 for instructions on applying 
behaviors The Directional Force 
controls appear on the Behaviors tab.

2Enter values to describe the force in the 
X, Y and Z dimensions. (These are in 
terms of the Universe.)

Use a negative value to apply force 
opposite to the arrow in the xyz axis 

Note: Directional force applies a force to an 
object. It does not set velocity.

The Directional Force behavior’s Direct 
Manipulation Control lets you see a wire 
reference of the Directional Force vector. 
You can drag the handle on the wire to 
change the vector and amount of force. 

To use the Direct Manipulation Controls 
with Directional Force:

1Apply the Directional Force behavior to 
an object.

See “To apply physical effects:” on 
page 319 for instructions on applying 
behaviors 

leng
of fo

Ray 
Dire
you 
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otational Force options:

 the Rotational Force behavior.

o apply physical effects:” on 
19 for instructions on applying 
iors The Rotational Force controls 
r on the Behaviors tab.

values for rotational force in terms 
, Pitch and Roll.

negative value to set rotation 
er to the arrow in the xyz/yaw 
roll graphic.

Apply to send your changes to the 
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Point Force 

Point Force accelerates an object toward 
another object. You can use point force to 
“shoot” one object at another. You may 
also invert the force to repulse one object 
from another. 

Initial 
Velocity

Strength relates to the maximum 
acceleration.

4Use the Field Decay Rate slider to 
describe the range (between the objects) 
where the attraction field begins to 
decay. 

At a low setting, the object accelerates 
toward the target slowly. At a high 
setting, the object accelerates quickly.

5Enable the Repulse option if you want 
the object to move away from the target 
instead of toward it.

6Click Apply to send your changes to the 
object.

To set R

1Apply

See “T
page 3
behav
appea

2Enter 
of Yaw

Use a 
count
pitch 

3Click 

t.

rce

rce creates randomized directional 
. You can use Flow Force to create 
ibrations or to give motion to 
 leaves swept up by the wind. 
To set Point Force options:

1Apply the Point Force behavior.

See “To apply physical effects:” on 
page 319 for instructions on applying 
behaviors The Point Force controls 
appear on the Behaviors tab.

2Click in the Point to object named field 
and type the name of the object you want 
as the target.

When you use Initial velocity with Point 
Force you can create an object that orbits 
another.

Point Force

Rotational Force

Rotational Force accelerates an object to 
rotate around its hot point. You can use 

You can use Point Force to place an object in 
orbit around another.

objec

Flow Fo

Flow Fo
motions
engine v
Autumn
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use Flow Force to shoot a fleet of 
ut in every direction.
3Use the Strength slider to describe the 

amount of attraction (or repulsion).

Rotational Force to spin an object. You can 
rockets o



Damping Force Damping is not immediate. It’s like 
ying the brakes in a car. Even at 
imum braking, the car takes a few 
to slow down and stop.

ou apply Damping Force to a 
um in your scene, it slowly brings it to 

CH15.rds5  Page 324  Wednesday, July 2, 1997  4:07 PM
To set Flow Force options:

1Apply the Flow Force behavior.

See “To apply physical effects:” on 
page 319 for instructions on applying 
behaviors The Flow Force controls 
appear on the Behaviors tab.

2Enter values for the amount of Flow 
Force in the X, Y and Z dimensions.

For certain effects, you might want to set 
the force in one dimension to zero. This 
will constrain the action of the force to 
the plane defined by the other two 
dimensions.

Damping Force counters any other forces 
working on the object. Regardless of what 
inertia an object has or what force is 
applied, damping “slows it down.” 

Directional Force

Damping Force

appl
max
feet 

When y
pendul
rest.
 Key Events in Physical Forces

n change the physical force settings 
te key events. Before you try this, 
ed to understand that the forces 
e acceleration, not velocity. (Initial 

y does set velocity, but it is only the 
state. It cannot be used for a key 

mple, you can start an object 
g with a Directional Force that’s 

 couple of seconds into the 
ion, you change the Directional 
alues so that X=0 to create a key 
3Use the Turn Density slider to set the 
frequency of direction changes.

4If you want the object to rotate with the 
flow, enable the Rotate with flow option.

To set Damping Force options:

1Apply the Damping Force behavior.

See “To apply physical effects:” on 
page 319 for instructions on applying 
behaviors The Damping Force controls 
appear on the Behaviors tab.

2Drag the slider to set the amount of 
damping.

Damping Force counters any force applied to 
an object.

About

You ca
to crea
you ne
describ
Velocit
initial 
event.)

For exa
movin
X=10. A
animat
Force v
event. 
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l Effects Preferences

jects that use physics collide, they 
away and spin. You can set a 
ce for how accurately Ray Dream 
alculates the result from such 
ion.

 also disable physical effects 
ely. You might want to do this 
u’re working, and you don’t want 
am Studio to recalculate the effect 
e you make changes.

hysics accuracy:

y the Scene Settings window: 
 Data tab.
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When you play the animation, the object 
will not stop at the moment of the key 
event. It will continue moving in X until it 
encounters a physical object (and 
rebounds) or some other force acts on it.

This follows the behavior of a rocket in 
space because Ray Dream Studio doesn’t 
take into account friction or gravity. 
Applying Directional Force is equivalent to 
an engine burn. Shut off the engines and 
the rocket coasts along on its trajectory. 
Without friction to slow it down or gravity 
to pull it aside, the rocket continues on this 
vector at this velocity indefinitely.

Directional Force 
applied in first frame

secondary, perpendicular acceleration. 
The new velocity is the product of the old 
velocity and the new force (acceleration).

When the direction is changed in the third 
frame, trajectory changes, but velocity 

Directional Force 
applied in first 
frame

Old trajectory

New Directional 
Force applied

New trajectory

Directional Force

Physica

When ob
bounce 
preferen
Studio c
interact

You can
complet
while yo
Ray Dre
each tim

To set p

1Displa
Misc.
the radio button for the physics 
ation accuracy you want.

s better than medium only when 
ts interact at an exceedingly rapid 

ble/enable physical effects:

y the Scene Settings window: 
 Data tab.

e the Enable Physical Effects 
box. 

 the box is empty, physics is turned 
Next, the rocket rotates 90° and does 
another engine burn (this is the same as 
adding a new perpendicular Directional 
Force). The new trajectory is the combined 
effect of the initial acceleration and the 

In the first frame Directional Force was set at 
X=10. In the second frame Directional Force 
is set to X=0. Since no change in direction 
occurs, velocity and trajectory remain 
unchanged.

Trajectory
Directional Force

Note: If you want to exert more control 
over transitions, you can use a Discrete 
tweener or use Damping Force in key 
events just prior to a change of 
acceleration.

For more information, refer to “Defining 
Key Events” on page 306.

remains constant.
2Click 

simul

High i
objec
rate.

To disa

1Displa
Misc.
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Record Behaviors 3Set the render range to extend as far as 
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When you apply a behavior, Ray Dream 
Studio automatically calculates the 
position and orientation of objects over the 
course of the animation. The objects move 
to positions and orientations not explicitly 
defined by key events. 

This is particularly noticeable with the 
Physical Force behaviors, which can create 
a complete animation segment without a 
single key event (excluding the initial state 
in frame 1).

You might decide that you want to control 
the position or orientation that’s 
determined by a behavior. Ray Dream 
Studio lets you do this by converting the 

necessary for this segment.

Ray Dream Studio creates key event 
markers through the end of the render 
range, so it’s important that the range 
extend to the end of this object’s 
behavior.

4Select the object whose behavior you 
want to convert.

5Choose Arrange menu> Record 
Behavior.
behavior action to a series of key events. 
After creating the key events, you can 
adjust them individually.

To convert behaviors to key events:

1Set up the behavior to animate the 
object. See “To apply physical effects:” 
on page 319 for instructions on applying 
behaviors 

2Choose the frame rate you want for this 
project. 

Ray Dream Studio creates a key event 
marker for each frame, so it’s important 
to set the frame rate first.

This is what the Flow Force behavior looks 
like when it’s converted to key frames. 
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Animating 
Techniques

 

Animation Techniques

 

Ray Dream Studio has a number of features 
for developing animations. Most of them 
can be used in more than one way. This 
chapter covers some techniques that will 
save you time and trouble and help you 
develop more interesting, natural and 
dynamic animations.

In this chapter you’ll learn about animating 
object shapes using the modelers. You’ll 
learn about animating with Deformers, how 
to get smooth motion paths, and use 
cloaking to hide and show an object at 
different points. You’ll also learn about the 
many uses of rotoscoping and how to 
animate in shaders.
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Animating Object Shape

       

You 

 

cannot

 

 add or delete cross sections or 

             

3

 

In the 

 

Masters

 

 tab, double-click the name 
e object whose shape you are 
ating.

 may also select it, then choose 

 

Edit 

u> Jump In

 

.

  

e 

 

Free Form

 

 modeler, adjust the 
ts and curves of any cross section, 
usion path or envelope line.
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You can change the shape of an object over 
time. This is as easy as jumping into the 
object and changing its shape to create a 
key event. Ray Dream Studio creates the 
transitions necessary to “tween” the 
original into the modified shape.

The type of object determines which 
modeler you’ll use when you jump in and, 
therefore, what modifications you can 
make. For example, with the Free Form 
modeler, you can edit the cross sections, 
sweep path and scaling envelope. But with 
the volumetric primitives, like Fire and 
Cloud, you’ll use sliders to change the 

points, or change the basic structure of the 
object. For instructions on modeling with 
extrusion paths and cross sections, refer to 
“Cross Sections and the sweep path” on 
page 131.

To create free form models whose 
shapes you want to animate:

1Create all of the control points for the 
extrusion path.

You cannot add or delete points during 
the animation, so you must create all 
you’ll need at the outset.

2Create all of the cross sections, with all 

of th
anim

You
men

4In th
poin
extr
ate a free form object’s shape, first 
a an object in the Free Form modeler 
ross sections and a sweep path...
character of the object. 

Animating a Deformer is another way to 
change an object’s appearance over time. 
Refer to “Animating with Deformers” on 
page 332.

Free Form Modeler
Ray Dream Studio 5 allows you to change 
the shape of a free form object during 
animation using the Free Form modeler. 

There are some limitations in the kinds of 
changes you can make in your models, but 
generally you can edit all existing cross 
sections and points on an extrusion path or 
scaling envelope. 

of the control points.

Start with the most complex shape your 
object will have during the entire 
animation. You can pull the control 
points close together at first, and then 
pull them apart as the object changes 
shape.

To animate the free form shape:

1Set the current time bar to the point 
where you want the key event to occur.

2Display the Hierarchy Masters tab. 

To anim
create 
using c
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.

   

Form Modeler

 

ream Studio 5 you can change the 
f a mesh form object during 
n using the 

 

Mesh Form

 

 modeler. 

u’re using the 

 

Mesh Form

 

 modeler 
te, you’re only animating 
nt and position. You cannot 
 any operations on an object that 
, or remove vertices. Since 
ds like 

 

Loft

 

, 

 

Extrude

 

 and 

 

Sweep

 

 all 
ices, you cannot use any of them 
n animation.

uctions on modeling with vertices 
meshes, refer to “Creating 
h Objects” on page 151.
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You may not add or delete points or add 
a cross section shape.

...then adjust the shapes in a different frame.
When you run the animation, Ray Dream 
Studio fills in the action between the two 
shapes to show the change of shape or 
movement.

Mesh 
In Ray D
shape o
animatio

When yo
to anima
moveme
preform
will add
comman
add vert
during a

For instr
and poly
Polymes
te mesh form models whose 
you want to animate:

 all of the vertices for the object.

annot add or delete vertices during 
imation, so you must create all 

 need at the outset.

 the object into the desired form 
any of the modelers features.

you can adjust the position of 
es during the animation, the object 
reate at the onset doesn’t have to 
 final form. You can move vertices 
orm the object over time.
5When you are finished changing the 
object shape, click Done. You may also 
choose Edit menu> Jump Out.

Ray Dream Studio adds a key event 
marker to the free form object’s time 
track in the Masters tab of the hierarchy.

You can now change the tweener between 
the two event marker s and set the 
transition method

A new key frame appears on the Master time 
track to indicate the change of shape.

To crea
shapes 

1Create

You c
the an
you’ll

2Shape
using 

Since 
vertic
you c
be the
to def
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You may not add or delete vertices.

            

Particle and Volumetric 
tives

 

in is a particle-based primitive. The 
etric primitives include Fire, Clouds, 
g. Each of these primitives has its 
odeling dialog, but the technique for 
ing them is the same.

  

nimations of Fountain or the 
etric primitives won’t be visible 
reviewing. You’ll need to do a test 
 to see the results.

 

mate the volumetric primitive 
:

  

te the volumetric primitive and 
st its attributes at the start of the 
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To animate the mesh form shape:

1Set the current time bar to the point 
where you want the key event to occur.

2Click the Masters tab in the Time Line 
window. 

3In the Masters tab, double-click the name 
of the object whose shape you’re 
animating.

You can also select it, then choose Edit 
menu> Jump In.

4In the Mesh Form modeler, adjust the 
position of the object’s vertices.

5When you’re finished changing the 
object shape, click Done. You can also 
choose Edit menu> Jump Out.

Ray Dream Studio adds a key event 
marker to the mesh form object’s time 
track in the Masters tab of the Time Line 
window.

Primi
Founta
volum
and Fo
own m
animat

Note: A
volum
when p
render

To ani
shape

1Crea
adju
ation.

Completion of ________ slider sets 
urrent moment of the animation. In 

t cases, the slider should be at zero 
e start of the animation.

og rises, Fire burns and the Fountain 
. The Cloud, however, is static. 
ore, the Cloud modeling dialog does 
ve a Completion slider.

mpletion fountain sets the current 
ent of the primitive.
To begin an animation, first create a an 
object in the Mesh Form modeler using 
vertices...

...then adjust the position on the vertices in a 

You can now change the tweener between 
the two event markers and set the 
transition method.

When you run the animation, Ray Dream 
Studio adds key frames to simulate 
movement.

anim

The 
the c
mos
at th

Note: F
spews
Theref
not ha

The co
movem
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 you are finished changing the 
t shape, click 

 

Done

 

. You may also 
e 

 

Edit menu> Jump Out

 

.

ream Studio adds a key event 
r to the free form object’s time 
in the 

 

Masters

 

 tab of the hierarchy.

 now change the tweener between 
nt marker and the previous one to 
ransition method. For example, to 
ering flames, you can use the 
 tweener.
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For descriptions of the attributes for 
each environmental primitive, refer to 
“Creating Environmental Primitives” on 
page 99. 

2When you’re finished setting the 
attributes, click Done to close the 
volume modeler.

3Set the current time bar to the point 
where you want the key event to occur.

4Display the hierarchy Masters tab. 

5In the Masters tab, double-click the name 
of the object.

You may also select it, then choose Edit 

For example, you might want the Fire to 
change the quantity of flames or its 
upward speed.

Fountain primitive with completion at 0%.

8When
objec
choos

Ray D
marke
track 

You can
this eve
set the t
get flick
Oscillate
menu> Jump In.

6In the Attribute dialog, adjust the 
Completion of ________ slider to the 
percentage that describes how much of 
the object’s animation should be 
accomplished at this point.

Assuming that this is the end of the 
animation, set it to 100%.

The completion fountain sets the current 
movement of the primitive.

Fountain primitive with completion as 50%.

Fountain primitive with completion as 100%.
• Animating Techniques 331
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7You can adjust other attributes to 
change the characteristics of the object. 



   

Animating with Deformers

         

2

 

Set the 

 

Deformer

 

 options you want in 
e 1.

complete descriptions of the 
rmers and their options, refer to 
ter 9, “Deformers.”.

rmers that apply a dynamic effect, 

 

Explode

 

 or 

 

Dissolve

 

, have a 

 

pletion

 

 slider which sets the current 
ent of the animation. In most cases, 
lider should be at zero at the start of 
nimation.

  

he current time bar to the point 
re you want the deformation to peak 
nish.
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Deformers allow you to dynamically alter 
the shape of an object. Deformers like 
Stretch, Bend and Twist, Explode, Dissolve 
and Shatter produce interesting animated 
effects that cannot be achieved by other 
means.

Deformers are especially useful in 
animation because they can be used to 
animate the shape of entire groups, which 
cannot be edited directly in a modeler.

Only one deformer can be applied to a single object or 
group. Since the deformer you apply becomes part of 
the object’s property hierarchy (which remains fixed 
throughout the animation), it cannot be replaced with 
another deformer during the animation. These 
limitations prevent you from applying two or more 
Deformer (either simultaneously or sequentially) to the 
same object during an animation.

You can overcome this limitation by nesting objects 
hierarchically within groups and applying a deformer 
to each group as well as to the object itself. This allows 
you to apply multiple Deformer to the same object—
either simultaneously or successively.

fram

For 
Defo
Chap

Defo
like 
Com
mom
the s
the a

3Set t
whe
or fi
the options in the Properties 
tte: Deformer tab to change the 
 of deformation at that point.

e Deformer has a Completion slider, 
t to the percentage that describes 
 much of the deformation should be 
mplished at this point.

emember to apply your changes.

n now change the tweener between 
ent marker and the previous one to 
 transition method. 
A group animated with Bend and Twist 
deformer.

To animate with a Deformer:

1Apply the Deformer to the object. For 
instructions on applying a Deformer, 

Bend and Twist, and Stretch Deformers 
applied to a text object.

4Use 
pale

state

5If th
set i
how
acco

Note: R

You ca
this ev
set the
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refer to “Applying Deformers” on 
page 172.



           

e numerical coordinates of the 
object at the second key event 
pied exactly to the duplicate 
he two objects end up in the same 
.

blem can be avoided by nesting 
inal object within a group before 
ing. When an object is animated 
 group, its position is animated 
to the group, not relative to the 
oordinate system. Therefore, when 
p is duplicated and offset, the 
d object in the duplicate group 
long its own motion path, within 
p.
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Animating Motion

Translate versus Rotate
Complex motion is generally animated by 
moving (translating) an object to various 
positions along the desired motion path 
and creating key events at each position.

The Bézier tweener can then be applied to 
smooth the motion. When animating along 
simple, curved paths, however, it is often 
easier to offset an object’s hot point and 
animate its motion using rotation rather 
than translation.

An object always rotates around its hot 

Duplicating Relative Motion 
with Groups
Duplicating an object or effect also 
duplicates its animation data (its key 
events and tweeners).

When key events are duplicated in this 
fashion, the values of the original object’s 
properties are copied exactly to the 
duplicate. In the case of motion, this does 
not always produce the desired results.

Suppose you have animated an object, and 
you decide you want to create a flock of 
identical objects, all moving in the same 
way. Figure 9-2 illustrates what happens 
when you duplicate your object and offset 
the duplicate from the original.

Since th
original 
were co
object, t
location

This pro
the orig
duplicat
within a
relative 
global c
the grou
animate
moves a
the grou
containing an animated object, 
d and offset.
point. By default, an object or group’s hot 
point is at the center of its bounding box; 
however, you can move the hot point 
anywhere, even some distance from the 
object.

For example, you can point a camera at an 
object and move the camera’s hot point to 
the center of the object. You could then 
rotate the camera around its own hot point 
to animate a “fly-around” of the object. This 
approach generally requires fewer key 
events than creating a similar motion path 
in the usual way, and produces equal or 
better results.

For instructions on working with hot 
points, refer to “The Hot Point” on 

An animated object, duplicated and offset.

A group 
duplicate
• Animating Techniques 333
Chapter 16

page 233.



   

Cloaking an Object

                   

Rotoscoping
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When you want to have an object enter or 
exit (appear or disappear) during the 
course of your animation, you’ll use a 
technique called cloaking.

Cloaked objects are visible and can be 
manipulated in the Perspective window; 
they simply are not included in the 
rendering of your animation.

You can take advantage of cloaking to 
switch one version of an object for another 
version of the same object. This is 
advantageous when the two versions have 
contradictory properties, which you need 
at different times of the animation. As long 
as the two objects look the same, occupy 

Rotoscoping is a general term that 
describes using video selectively inside 
another movie. You can add live action or 
moving textures to your scene by 
rotoscoping with animations or digitized 
videos (movies) in your animation. 
Rotoscoping adds realism and visual 
excitement to your animations.

You can use any QuickTime (Macintosh) or 
Microsoft Video (AVI) file for rotoscoping. 
You can use movies in any of the following 
places:

• Texture map or paint shape on an 
otoscoping, you can create a scene 
both the background and the objects 
the same space, and cloak and uncloak in 
the same frame, the exchange from the one 
to the other will be seamless.

To cloak or uncloak an object at a 
specific point in time:

1Select the object.

2Display the Properties palette: 
General tab.

3Enable or disable the Cloak checkbox.

object—including in non-color channels, 
like Bump. 

• Background or backdrop.

• Light gel.

Using r
where 
move.
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 the Saw/Loop Wave Shape.

e Up Phase slider to 100%. This 
ds the movie instantly after each 

t the Number of Oscillations slider 
 the number of times the movie 
d repeat. 

up slope in the graph represents 
me playing the movie.

 the Transition Options dialog.

 work, you’ll want to calculate the correct 
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A movie is saved as a separate file. Its pathname is 
relative to the animation file it’s used in. When you 
move a file with rotoscoping, be sure to maintain the 
relative path to the movie file. 

Rotoscoping is visible on objects in Better 
Preview mode, but is not displayed on 
backgrounds, backdrops and in gels until 
you render the animation. 

Synchronizing Movie Frames with the 
Animation and Looping

When you apply a movie, Ray Dream Studio 
creates two key events—one at the start 

2Select the object or light that has the 
movie rotoscoped onto it. (This isn’t 
necessary for a background or 
backdrop.)

3Display the tab or window containing the 
rotoscope movie controls.

• For a texture map, display the Current 
Shader Editor.

• For a light, display the Properties 
palette: Gel tab.

• For the background or backdrop, 
display the Scene Settings window: 
Effects tab: Background or 
Backdrop controls. 

5Select

6Set th
rewin
cycle.

7Adjus
to set
shoul

Each 
one ti

8Close

For precise

 oscillations based on the number of frames 
ie and the duration of the animation. You 
 the end-of-movie marker, if necessary.

ating Shaders

tion assumes that you have read 
ters on shading and that you have 

rstanding of the Current Shader 
nd its various components. For 
und information and step-by-step 
ions on using the Current Shader 
efer to Chapter 10, “Shading 
and one at the end of the movie. You’ll see 
the markers on the time track.

The ending event marker is placed 
according to the duration of the movie—
not the number of frames it has. This 
means that the frame rate of the movie 
should be compatible with the rate of the 
animation.

It isn’t necessary that the movie begin at 
frame 1. You can start at a later frame by 
synchronizing the movie to the animation.

To synchronize a movie with the 
animation:

1Set the current time bar to the moment 

4Use the preview controls to advance to 
the movie frame you want synchronized 
with the current frame of the animation.

5Apply the change.

To loop a movie:

1Apply the movie at the start of the 
animation.

2Drag the end-of-movie key event marker 
out as far as you want the movie to 
continue.

3Double-click the track between the two 

number of
in the mov
can adjust

Anim

This sec
the chap
an unde
Editor a
backgro
instruct
Editor, r
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 and Chapter 11, “Creating 
.”
Chapter 16

(frame) where you want to synchronize 
the animation.

movie key event markers.

4Choose the Oscillate tweener.

Objects”
Shaders



Animating shaders opens a wide range of Animating Shaders with the channels at once, so the individual 
nel tabs disappear when Global Mix 
lected.

original wood and marble shaders 
 dropped into the left and right 
ches of the tree, respectively.

lue component was placed in the 
r branch, to be used as the mix 
tion.

lue set in this Value component 
ines the contribution of each 
l shader to the mix. When the value 
, the wood shader contributes 100%. 
the value is 100, the marble shader 
utes 100%. When the value is 50, the 

aders are mixed equally. 
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possibilities. You can animate virtually any 
type of change to a shader that you can 
imagine, from a simple color change to a 
shifting geometric pattern. You can even 
make an object appear to change from 
bricks to glass, or from marble to metal.

The only limitation is that you cannot 
replace one shader component with 
another during the course of an animation. 
You cannot, for example, replace a Wood 
function with a Spots function at a 
particular point along the time line. Thanks 
to the flexible, modular nature of the 
Shader Editor, this turns out to be only a 
minor limitation. “Animating Shaders with 
the Global Mix and Mix Components” on 

Global Mix and Mix 
Components
The Global Mix option in the Shader Editor 
allows you to animate more drastic 
changes to an object’s shader. In the 
following example, a Global Mix is used to 
create a shader which animates gradually 
from wood to marble.

To build this animatable shader, a wood 
shader and a marble shader were first 
created separately and stored in the 
Browser palette: Shaders tab. A new 
shader was then created.

chan
is se

• The 
were
bran

• A Va
lowe
func

The va
determ
origina
is zero
When 
contrib
two sh
he Global Mix is set 100% the marble 
 contributes 100% of the surface 
ties.
page 336.

Animating simple changes to shaders is 
straightforward. You just use the Shader 
Editor to adjust the parameters of 
individual shader components at specific 
points along the time line. Examples of 
parameters you can adjust include:

• Colors

• Values for attributes like transparency, 
shininess, etc.

• Procedural function parameters, like the 
number of squares in a checker pattern, 
or the undulation of the veins in a wood 
pattern

• The Global Mix option was chosen from 
the Current Shader Editor: Insert 
menu. A Global Mix mixes all shader 

When the Global Mix is set to 0% the wood 
shader contributes 100% of the surface 
properties to the shader.

When t
shader
proper
336 Ray Dream Studio User Guide
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To animate this shader, only the value 
component needs to be altered over time. 
To animate gradually from wood to glass, 
you would set the value to zero at one key 
event and to 100 at the next.

The same technique can be used to 
animate between different types of 
components within a single shader 
channel, except that you would use a Mix 
component instead of a Global Mix. This 
technique also allows you to animate a 
cross-fade between two bitmap images or 
movies. Just put the two bitmaps or movies 
in the left and right branches of the Mix.

Rotoscoping in Non-Color 
Shader Channels
e corresponding frames from that 
re shown in the left column. The 
gion in each frame represents the 
of the sphere that is transparent. 
k region represents the portion 
paque.

ation using rotoscoping in the 
rency channel.
Using the Global Mix you can adjust the 
values of two subshaders and have the 
texture of an object completely change over 
time.

The most common use of rotoscoping is in 
a shader’s Color channel, where it allows a 
movie to be played on the surface of an 
object. However, rotoscoping can also be 
used in other shader channels to create 
stunning visual effects. 

The example below illustrates the use of a 
movie in an object’s Transparency channel.

The three animation frames in the right 
column show a sphere materializing from 
the floor up. This effect was achieved by 
playing an 8-bit grayscale movie in the 
sphere’s Transparency channel.

The thre
movie a
white re
portion 
The blac
that is o

An anim
Transpa
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Rendering

 

About Rendering

 

Rendering is the process of capturing a 
view of your three-dimensional scene and 
saving it as a 2D image. An image has to be 
rendered before you can print it or open it 
in an image editing or page-layout program.

Ray Dream’s rendering process can create 
photo-realistic images because it considers 
all of the objects in a scene simultaneously 
and calculates not just forms, color, and 
texture, but the interaction of lights and 
surfaces within the scene.

Since your scene exists in three 
dimensional space you can take any 
number of renderings of it—from different 
angles and even with different lighting 

ons. If you created an object in a 2D 
 program and wanted to look at it 
other side, you would have to 
conditi
drawing
from an



   

redraw the object. In Ray Dream Studio 5, 

 

The Rendering Procedure

        

Then, after correcting anything that didn’t 
t as expected, you can generate the 

igh resolution rendering.

 

verview

 

 you produce a rendered image, 
eed to complete the following steps:

  

nge the objects in the scene. Refer to 
anging Objects” on page 223 and 
lding a Scene” on page 251 for 
tional information. Apply shaders to 
 the objects interesting surfaces. 
r to “Shading Objects” on page 181 
ore on shading.

  

e 

 

Perspective

 

 window, add lights to 
inate the scene. Refer to “Setting 

        
you simply move the camera to another 
view and re-render the scene.

A rendering is a separate file and is stored 
on disk in a different format. Ray Dream 
Studio lets you save renderings in many 
popular image formats: PICT and EPS 
(Macintosh only), Windows Bitmap (BMP), 
TIFF, Adobe PhotoShop, and others. You 
can print your renderings, open them in an 
image-editing program, or place them into 
virtually any application. 

The G-Buffer is a special feature of Ray 
Dream Studio 5 that allows you to include 
special information in data channels that 
are saved with the rendered image. These 
channels can be manipulated in an image 

When you’ve built a scene, set lights, and 
chosen a viewpoint, you are ready for 
rendering. You’ll probably render your 
scene several times—the first couple of 
renderings will be low resolution proofs, so 
you can check your work. 

You can also use the Render Preview tool 
to marquee an area of your scene and ray 
trace it directly in the Perspective window. 

turn ou
final, h

An O
Before
you’ll n

1Arra
“Arr
“Bui
addi
give
Refe
for m

2In th
illum
ts” on page 271.

our rendering options using the tabs 
ene Settings window. Options 
de a choice of renderers, rendered 
e size, file format, and post-render 
s for special effects. These features 
escribed later in this chapter.

lay the production frame and adjust 
osition and settings of the camera 

ame the view of the scene you want 
ered. Refer to “Framing Your Scene” 
age 361.

st Ambient Light, Background, and 
ospheric settings. See “Ambient 
editing program to create special effects. 

At each proof stage, you may want to 
change your Rendering Settings, depending 
on the image aspects you want to check. 
For example, if you just want to look at the 
objects, you might use the Draft Z-Buffer. 
Or if you’re concerned only with shading 
and shadows, you might turn off the other 
ray-tracing options, like reflections and 
transparency, which add to rendering time. 

Use the Render Area tool to see how areas of 
object will appear rendered.

Ligh

3Set y
in Sc
inclu
imag
filter
are d

4Disp
the p
to fr
rend
on p

5Adju
Atm
t” on page 271 for setting ambient 
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 object does refract, set the 

 

ction Feature controls: Maximum 
 valu

 

e

 

 to limit the number of 
tions.

tiple refractive objects align, the 
ould bend from one to the next, 

gh all objects. This would take an 
dingly long time to render and 
n’t contribute to image quality. 
aximum depth value sets the 
er of refractions before the 
rer stops.

 

r Preferences

 

 select certain rendering options as 
 so they will be set in every new 

                 
light. See “Backgrounds and Backdrops” 
on page 345 for background and 
atmosphere.

Note: These options do not apply to the 
Natural Media renderer.

6Once you have verified that all settings 
are correct, you can start the rendering 
with one of the Render commands.

Setting up to Render 

Ray Dream Studio offers a number of 
options and settings for controlling 

Rendering Preferences for 
Individual Objects
Each object has two preferences that 
instruct the ray tracer (and Adaptive 
renderer) how to deal with it. These 
preferences concern reflection and 
refraction, and you’ll only need to change 
them if you want the renderer to deal with 
a particular object differently.

To set an object’s rendering preferences:

1Select an object.

2Display the Properties palette: 
Rendering tab.

6If this
Refra
depth
refrac

If mul
rays w
throu
excee
would
The M
numb
rende

Rende
You can
defaults
endering default preferences:

e File menu> Preferences.

e Render Features from the main 
p.

e pop-ups to choose default 
gs for Shadows, Reflections and 
parency.
rendering. To get the rendering results you 
want, you’ll need to make several choices 
and adjustments.

Your choices will be based on your 
expectations—whether you’re creating a 
draft rendering to check the objects, 
rendering final artwork, or rendering an 
animation.

3Use the Reflection Feature pop-up to set 
whether or not this object is reflective—
No Reflections or Ray-traced Reflections.

4If this object does show reflections, set 
the Reflection Feature controls: 
Maximum depth value to limit the 
number of ray reflections.

If two reflective surfaces face each other, 
the rays would bounce back and forth 
between them indefinitely. The 
Maximum depth value sets the number 
of bounces before the renderer stops.

5Use the Refraction Feature pop-up to set 
whether or not this object is refractive—

scene. 

To set r

1Choos

2Choos
pop-u

3Use th
settin
Trans
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No Refractions or Ray-traced 
Refractions.



   

Scene Settings

                                             

tracing shows most of the “real world” 

                    

The reflected color appears in all areas 
 would show reflections in ray 
ing.

  

 on the 

 

Transparent

 

 

 

color

 

 chip to 
ct a transparency color.

Transparent color appears in all 

              

 Draft Z Buffer to create fast 
ings of your scene.
The Scene Settings window provides four 
tabs for controlling rendering: Renderer, 
Effects, Filters and Output.

After you have made all of your selections 
in this dialog, click OK to save these 
settings with your scene. 

To display the Scene settings window: 

Choose Windows menu> Scene 

Settings for filename. Where filename is 
the name of your scene.

The following sections describe the 

lighting effects, including transparency, 
shadow, reflection, and bump maps.

• The Adaptive renderer adapts the 
rendering method for different regions of 
the scene. It uses ray tracing where it’s 
required for bump maps, reflections, 
shadows, etc. And it switches to an 
accelerated A-Buffer renderer for other 
regions. The Adaptive renderer produces 
anti-aliased edges on objects.

• The Natural-Media renderer, based on 
technology licensed from ThinkFish 
Productions Inc., produces interesting, 
stylistic renderings of the scene. In 
general, the renderings produced by the 
Natural Media renderer have a more 

that
trac

2Click
sele

The 

Use the
render
s that would show transparency in 
racing.

le the No shaders option if you want 
e the objects without their applied 
ers. A solid-colored approximation 
e object is used instead, which 
tly reduces rendering time.

 Adaptive renderer options: 

le the Shadows option to render 
ows.

le the Reflections option to render 
ctions on reflective surfaces. 
features of the Renderer, Effects, Filters 
and Output tabs.

Renderers
Ray Dream Studio offers four rendering 
engines to choose from: Adaptive, Draft Z-
Buffer, Ray Tracer and Natural Media. Each 
has an advantage when you’re looking for a 
particular result.

• The Draft Z-Buffer is an excellent choice 
for fast proofing. The quality it produces 
is similar to that of Better Preview mode 
in the Perspective window.

• The Ray Tracer calculates the effects of 
light rays from your light sources as they 
encounter the objects in your scene. Ray 

hand-drawn style than typical 3D images.

To choose the renderer you want to use: 

1Display the Scene Settings window: 
Renderer tab.

2Choose the renderer you want from the 
pop-up.

The panel updates to show the options 
for this rendering engine.

To set Draft Z-Buffer options: 

1Click on the Reflected color chip to 

area
ray t

3Enab
to se
shad
of th
grea

To set

1Enab
shad

2Enab
refle
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ive oversampling renders at a 
r resolution, then resamples the 
e to produce a smoother, anti-
d image. 

t the Silhouette Quality slider to 
e accuracy for the edges of objects. 

reasing Silhouette Quality 
s rendering time and RAM 
ents.

t the Maximum Ray Depth slider to 
imit on the number of interactions 
d for rays that reflect or refract. 

u can limit ray depth for individual 
 For details, refer to “Rendering 
3Enable the Bump option to render bump 
effects on objects.

4Enable the Transparency option to 
render transparent objects.

5Enable the Refracted transparency 
option to render refraction effects 
through transparent objects.

6Enable the Light through transparency 
option to render lighting effects through 
transparent objects. 

7Click a radio button to choose the level 
of Anti-aliasing you want—None, Edges 
or Better. Edges anti-aliases the edges of 
objects only. Better anti-aliases the 

To set Ray Tracer options: 

1Enable the Shadows option to render 
shadows.

2Enable the Reflections option to render 
reflections on reflective surfaces. 

3Enable the Bump option to render bump 
effects on objects.

4Enable the Transparency option to 
render transparent objects.

5Enable the Refracted transparency 
option to render refraction effects 
through transparent objects.

Adapt
highe
pictur
aliase

8Adjus
set th

Note: Inc
increase
requirem

9Adjus
set a l
allowe

Note: Yo
objects.
ces for Individual Objects” on 
.

ural-Media Renderer

ural-Media renderer uses the 
es technology from ThinkFish 
ions Inc. Ray Dream includes 
LiveStyles for you to choose from. 
 find out more about LiveStyles and 
e additional LiveStyles from 
h at http:\\www.thinkfish.com

atural Media renderer options:

e pop-up to choose the rendering 
ou want.
entire image.

8Adjust the Silhouette Quality slider to 
set the accuracy for the edges of objects. 

Note: Increasing Silhouette Quality 
increases RAM requirements.

9Adjust the Maximum Ray Depth slider to 
set a limit on the number of interactions 
allowed for rays that reflect or refract. 

Note: You can limit ray depth for individual 
objects. For details, refer to “Rendering 
Preferences for Individual Objects” on 
page 341.

Reflectiveness, transparency, refraction and bump are 
shader characteristics. You’ll apply shaders to develop 
these effects on particular objects. refer to 
Appendix 10, “Shading Objects”.

6Enable the Light through transparency 
option to render lighting effects through 
transparent objects. 

7Click a radio button to choose the level 
of Adaptive Oversampling you want—
None, Fast or Better.

Preferen
page 341

The Nat

The Nat
LiveStyl
Product
several 
You can
purchas
ThinkFis

To set N

1Use th
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t the sliders and set your other 
s to control the effect.
2Adjus
option



3When you’ve changed object position or Render Effects
 the Distance Fog:

lay the Scene Settings window. 
ose Windows menu> Scene 

ings for filename.

lay the Scene Settings: Effects 

n use the Distance Fog to add depth to 
ndered scene.
geometry in the scene, click the Update 
Geometry button.

Ray Dream Studio rebuilds the preview 
with the new scene data.

Miscellaneous Renderer Settings

The Scene Settings window: 
Renderer tab: Miscellaneous control 
has two advanced options.

• Enable the Enable SMP option if you have 
a multi-processor computer and you want 
to use multi-processing for rendering.

If your computer has only one processor, 
this option is not available.

Ray Dream Studio 5 provides some 
environment options to help complete the 
appearance of your scene in renderings. 
These options include Ambient Light, 
Atmospheres, Backgrounds and 
Backdrops.

For setting ambient light, refer to “Ambient Light” on 
page 271.

Atmosphere

Ray Dream Studio 5 offers two types of fog 
effects: Distance Fog and Cloudy Fog.

To use

1Disp
Cho
Sett

2Disp

You ca
your re
ose Atmosphere pop-up: 
ance Fog. 

Dream Studio displays the Distance 
controls.

 the Fog Color chip to set its color. 
Dream Studio opens the system 
r picker so you can choose a color.

r the Fog Starts distance. 
• Enable the Enable Field Rendering 
option if you are rendering an animation 
for video and you want to render the 
interlaced fields separately. 

Note: If you use field rendering, you should 
choose 60 fps (NTSC) for the rendering 
frame rate.

• Distance Fog produces an effect like a 
haze, which is more apparent across 
greater distances. This fog has uniform 
density. 

• Cloudy Fog produces an effect that 
simulates the irregular “clumping” of 
clouds.

Atmospheric effects are only visible in the final 
rendered image.

tab.

3Cho
Dist

Ray 
Fog 

4Click
Ray 
colo

5Ente
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that altitude Z=0 runs through the 
r of the Working Box when the 
ng Box is in its default position.

e Density slider. 

ty determines fog thickness.

e Lumpiness slider.

iness determines how much the fog 
s together.

e Global Scale slider. 

l Scale determines the spacing 
en the wisps of fog.
This is the distance from the camera 
where the fog begins.

Distance fog range is set in relation to the 
position of the camera.

Visibility
(Visibility through fog becomes 0%)

Fog starts
(Fog effect 
begins)

Camera

To use Cloudy Fog:

1Display the Scene Settings window. 

Use Cloudy Fog to create clumps of clouds in 
your scene.

mind 
cente
Worki

6Set th

Densi

7Set th

Lump
clump

8Set th

Globa
betwe
lts of these settings will be visible 
al rendering or when you render 

with the Render Preview tool. You 
rn to these settings, make changes, 
er again.

unds and Backdrops

u render your scene, regions 
ere are no objects are considered 

und areas. By default, these areas 
hite in the renderings. Ray Dream 

ffers two features for filling in the 
tween objects—background and 
p.

und

kground gives you control over the 
6Enter the visibility distance. 

This is the distance beyond the start of 
the fog where it becomes so thick that 
visibility becomes zero.

The results of these settings will be visible 
in the final rendering. You may return to 
these settings, make changes, and render 
again.

Choose Windows menu> Scene 

Settings for filename. Where filename is 
the name of your scene.

2Display the Scene Settings: Effects 
tab.

3Choose Atmosphere pop-up: Cloudy 
Fog.

4Click the Fog Color chip to set its color. 
Ray Dream Studio opens the system 
color picker so you can choose a color.

5Enter values for Top and Bottom. 

These values define the vertical range 
(along the Z axis), where fog appears. 

The resu
in the fin
an area 
can retu
and rend

Backgro

When yo
where th
backgro
appear w
Studio o
space be
backdro

Backgro

The bac
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vironment. The background is 
es called an environment map.
When you’re setting this option keep in 
scene en
sometim



During rendering, the background is None creates no background in the Backdrop

ckdrop is a 2D image placed behind 
cene. The backdrop appears in 
s of the rendering where there are no 
s. 

ckdrop does not appear in 
ions or interact with the lighting.

ight want to use both a backdrop and 
ground. In this case, Ray Dream 
 uses the background for the 
ion environment and places the 
op behind the objects. 

 a backdrop: 

lay the Scene Settings window. 
projected on the inside surface of a giant 
sphere that surrounds your scene. Any 
region of a rendering not occupied by an 
object will show the background. The 
background is also the environment 
reflected by reflective objects. 

Note: See the next section on the backdrop 
for another method of filling areas not 
occupied by objects.

You may choose the type of background 
you want: Image, movie, color, or bi-
gradient. The background is only visible in 
your final image.

scene. The background areas appear 
white in the final rendered image.

Bi-gradient creates a paired gradation for 
the background. This is an easy way to 
create a sky and horizon. Bi-gradient 
controls are covered in “Bi-Gradient 
Controls” on page 347.

Map uses a bit-mapped image file as the 
background. This is the best choice 
when you want specific imagery in 
reflections. How to load an image as a 
map and map controls are covered in 
“Map Controls” on page 348.

Color sets a solid color as the 

The ba
your s
region
object

The ba
reflect

You m
a back
Studio
reflect
backdr

To use

1Disp

ose Windows menu> Scene 

ings for filename.

lay the Scene Settings: Effects 

ose the type of backdrop you want 
 the Backdrop pop-up. 

e creates no backdrop in the scene.

radient creates a paired gradation 
he backdrop. Bi-Gradient controls 
overed later in this chapter.

uses a bit-mapped image file as the 
drop. This is the best choice when 
want specific imagery behind your 
An isometric camera cannot record a Background. If 
you are using an isometric camera for your final 
rendering, you must use a Backdrop instead.

To use a Reflected Background:

1Display the Scene Settings window. 
Choose Windows menu> Scene 

Settings for filename. Where filename is 
the name of your scene.

2Display the Scene Settings: Effects 
tab.

3Choose the type of background you want 

background. Open the controls and click 
the color chip to choose a color. 

Formula creates a color pattern from a 
formula. You can devise your own 
formula to create a new pattern. For 
more information on Formula controls, 
refer to “Formula Controls” on page 347.

Movie uses a sequence of images in the 
background. This option only makes 
sense when you are creating an 
animation. How to load a movie and 
movie controls are covered in “Movie 
Controls” on page 349.

Cho
Sett

2Disp
tab.

3Cho
from

Non

Bi-G
for t
are c

Map
back
you 
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from the Background pop-up. 



a Controls

t a formula for the background 
drop:

e Formula from the pop-up where 
ant to use it—Background or 
rop.

the plus/arrow icon to display the 
la controls.
objects. How to load an image as a map 
and map controls are covered later in 
this chapter.

Color sets a solid color as the backdrop. 
Open the controls and click the color 
chip to choose a color. 

Formula creates a color pattern from a 
formula. You can devise your own 
formula to create a new pattern. For 
more information on Formula controls, 
refer to “Formula Controls” on page 347.

Movie uses a sequence of images in the 
Backdrop. This option only makes sense 
when you are creating an animation. How 

Bi-Gradient Controls

To use a bi-gradient for the background 
or backdrop:

1Choose Bi-Gradient from the pop-up 
where you want to use it—Background 
or Backdrop.

2Click the plus/arrow icon to display the 
Bi-Gradient controls. 

Formul

To selec
or back

1Choos
you w
Backd

2Click 
Formu
current formula uses the 
eter sliders, you can adjust them 
nge the formula result.

d a new formula, click the disk 

e Open dialog to locate and open 
propriate formula. You can find 
e formulas in the Ray Dream 

ula controls let you create a 
p mathematically.
to load a movie and movie controls are 
covered later in this chapter.

3Select colors for the Top (“Sky”) and 
Bottom (“Sea/Ground”) Start and End 
colors.

Click the color chip and use the system 
color picker to select a color. 

4Adjust the Limit between top and bottom 
slider to control the height of the 

Use the Bi-Gradient controls to set up a 
simple two color backdrop.

3If the 
Param
to cha

4To loa
icon.

Use th
an ap
sampl

The Form
backdro
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 CD: Samples: Formulas folder.
horizon. Studio



Ideally, images for the background should When you’ve opened an image, a preview 
ars in the left panel.

 can click the directional buttons to 
ge the image’s orientation.

p controls let you use an imported 
as backdrop.
The formulas for a Background or Backdrop differ. 
Remember the Background is projected onto a sphere, 
so it uses a 3D system. The Backdrop is rectangular, so 
it uses a 2D system.

5If you want to edit the formula or create 
your own, click More to open the 
Formula Editor.

Ray Dream Studio uses the Formula 
Editor in several places. Use of the editor 
is common, but the type of formula 
you’re creating determines the valid 
input and output variables. Refer to the 
Using Formulas in Ray Dream Studio 5 

have an aspect ratio of 2:1 (twice as wide as 
they are tall).

Images for the backdrop should have the 
same aspect ratio as the final rendering and 
be equal or greater in resolution. You can 
set the final rendering image size in the 
Scene Settings window: Output tab: 
Image Size control.

To select a map for the background or 
backdrop:

1Choose Map from the pop-up where you 
want to use it—Background or 
Backdrop.

appe

5You
chan

The Ma
image 
 can reduce the image’s brightness 
 the Brightness slider. 

le the Better (but slower) sampling 
on to get cleaner results in your 
ering.

le the Invert Color option if you 
t to invert the image’s colors.

u want the image to repeat, enable 
ile option. The tiled image appears 

e right preview.

 the Horizontally and Vertically 
rs to set the number of tiles in each 

ction.
PDF for details on using the Formula 
Editor.

Formula editing becomes technical 
quickly. You can learn a lot by loading 
the sample files. 

6When you’re done with the Formula 
Editor, click OK.

7To save a formula, press on the disk icon 
and choose Save As from the pop-up.

8Use the Save dialog to name the file and 
select a disk location. 

Map Controls

2Click the plus/arrow icon to display the 
Map controls.

3Click the disk icon. Ray Dream Studio 
displays the Open dialog.

4Locate and open a bitmapped image file.

6You
with

7Enab
opti
rend

8Enab
wan

9If yo
the T
in th

ºUse
slide
dire
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The tools and methods for using a map are 
the same for the background or backdrop.



e the Seamlessly option tile the 
 without visible seams between 
ay Dream flips adjacent tiles 

ally and/or horizontally as 
sary to avoid seams.

an get more information on this 
 by clicking More. 

ream Studio opens a window that 
es technical information and a 

 movie preview player.
¡Enable the Seamlessly option to tile the 
image without visible seams between 
tiles. Ray Dream flips adjacent tiles 
vertically and/or horizontally as 
necessary to avoid seams.

You can apply a filter to the map. For more 
information, refer to Chapter 18, “Post Production.”

Movie Controls

To select a movie for the background or 
backdrop:

When you’ve opened a movie, a preview 
appears in the left panel, and a preview 
player appears in the right.

5You can click the directional buttons to 

Use the Movie Controls to import a movie as 
a backdrop.

¡Enabl
image
tiles. R
vertic
neces

™You c
movie

Ray D
provid
larger
 Filters

der filters create special effects in 
e after it has been rendered. 
, they’re post-render filters. 

rs include lens effects that simulate 

ovie Time Selection dialog to 
dditional information about your 
1Choose Movie from the pop-up where 
you want to use it—Background or 
Backdrop.

2Click the plus/arrow icon to display the 
Movie controls.

3Click the disk icon. Ray Dream Studio 
displays the Open dialog.

4Locate and open a movie file.

change the movie’s orientation.

6You can reduce the image’s brightness 
with the Brightness slider. 

7Enable the Better (but slower) sampling 
option to get cleaner results in your 
rendering.

8Enable the Invert color option if you 
want to invert the movie’s colors.

9If you want the movie to be tiled, enable 
the Tile option. The tiled movie appears 
in the right preview.

ºUse the Horizontally and Vertically 
sliders to set the number of tiles in each 

Render

The ren
the imag
Actually

The filte

Use the M
review a
movie.
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lts obtained from photographic 
 and special lighting effects.
direction. the resu
cameras



2Click the Plus button. foreground, then gradually move its focus 
ckground object over the course of 
imation.

this, you need to set the Depth of 
cus (on the foreground) in the first 

 then move later in time and set the 
of Field focus (on the background) to 
 a key event. You can change the 
r to modify the focus transition—
 accelerate, for example. 

he effects can be animated in this 
ost of them have several settings 
n animate.

 of Field

pth Of Field filter simulates the lens 
al life camera. The Depth Of Field 
To apply a render filter:

1Display the Windows menu> Scene 

Settings window: Filters tab.

2Click the Plus button. 

Ray Dream Studio displays a dialog with 
a list of the available post-render filters.

3Select the filter you want to apply. 
Click OK. 

4In the Filters tab, set the options for the 

Ray Dream Studio displays a dialog with 
a list of the available post-render filters.

3Select either VL LIght Control or PLP 
Light Control and click OK. 

• Use VL Light Control enable/disable 
the Visible Light render filters: LIght 
Cone and Light Sphere.

• Use PLP Light Control to enable/
disable the Lens Effect render filters: 
Depth of Field, Lens Flare, CrossScreen, 

to a ba
the an

To do 
Field fo
frame,
Depth 
create
tweene
have it

All of t
way. M
you ca

Depth

The De
of a re
ost-process-es the rendered picture 
rring the objects according to their 
e from the rendering camera. 

of Field filter simulates the type blur 
filter. 

The options for each filter are described 
in the next section.

The Visible Light and Lens Effect filters can 
be enabled or disabled on a light-by-light 
basis. So you can turn the filters on/off for 
specific lights.

To apply a render filter on a light-by-light 
basis:

1Display the Windows menu> 

Properties palette: Miscellaneous 

tab.

Glow, Nebula, Pulsator, Stars, 
VariCross.

4In the Miscellaneous tab, use the popup 
to enable or disable the effect. 

Note: Although you can enable/disable 
filters on a light-by-light basis, the settings 
you specify for the render filter are global 
for any given scene. All lights for which a 
given filter is enabled will use the same 
settings.

Animating Filters

All of the filters have settings that you can 
change to create key events. The results of 
animating filters can be dramatic. For 
example, by animating the Depth of Field 

filter p
by blu
distanc

Depth 

ee on objects that are not in focus.
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filter, you can have the camera focus on the you’d s



ream Studio puts a green cross on 
int where you click, sets this 
ce as the plane of 50% out-of-focus, 

pdates the Depth Of Field curve.

the blue cross button to select the 
r setting the background out-of-
plane.

in the preview on the background 
t that you want to be 50% out-of-
 

u cannot select a background 
at is in front of the in-focus object.

ream Studio puts a blue cross on 
int where you click, and sets this 
Depth of Field is a post-render filter. It does 
not change the rendering camera itself. 

Note: Normally, every object appears in 
focus regardless of its distance from the 
camera. 

You can also select or design your own lens 
to change the depth of field range from 
macrophoto to telephoto.

To set Depth of Field options:

1Click one of the radio buttons to chose 
the preview quality:

x1 high quality (slower)

This takes a few moments.

3Click the red cross button to select the 
tool for setting the plane of focus.

4Click in the preview on the object that 
you want to be in focus. 

Ray Dream Studio puts a red cross on the 
point where you click and sets this 
distance as the plane of focus.

5Set the range for the depth of field. You 
have three options to do this:

• By using the blue and green crosses 
and clicking in the preview

Ray D
the po
distan
and u

3Click 
tool fo
focus 

4Click 
objec
focus.

Note: Yo
object th

Ray D
the po
ce as the plane of 50% out-of-focus, 
pdates the Depth Of Field curve.

he Distance sliders:

u must set the plane of focus with 
cross when using the sliders.

he blue slider on the Distance bar 
 the distance of the 50% out-of-
background plane.

 want background objects to stay in 
 move the blue slider all the way to 
ht.
x2 normal quality

x4 low quality (faster)

Use the Depth of Field controls to set the 
focus object and the range of the effect.

• By dragging sliders on the blue and 
green Distance sliders on the graph

• By choosing a preset

To use the click tools:

1Click the green cross button to select the 
tool for setting the foreground out-of-
focus plane.

2Click in the preview on the foreground 
object that you want to be 50% out-of-
focus. 

Note: You cannot select a foreground 
object that is behind the in-focus object.

distan
and u

To use t

Note: Yo
the red 

1Drag t
to set
focus 

If you
focus,
the rig
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he green slider on the Distance bar 
 the distance of the 50% out-of-
foreground plane.
2Click Preview to generate a preview of 
your scene. 

2Drag t
to set
focus 



If you want foreground objects to stay in Note: To achieve realistic results use 72 
r the opposite effect (to render very 
 images) increase the dpi while 
ining image size.

ou can get a stronger depth of field 
y increasing the dpi and decreasing 
ture size by the same amount. For 
le, if you want an effect that is twice 
urrent effect, halve the picture width 
ight and double the dpi.

lare

ares are reflections of a strong light 
 on the various components of the 
lare color and size depend on the 
 glass and shape of each lens 
nent.
focus, move the green slider all the way 
to the left.

To use a Depth of Field preset:

You must set the plane of focus with the 
red cross when using a preset curve.

1On the right side of the panel, click the 
graph describing the Depth of Field you 
want.

2Use the scroll bar to view more choices.

Dots Per Inch (DPI) and Depth Of Field

In natural photography, depth of field is 
closely connected to film resolution and 

Example:

1Render a preview at 216 x 144 pixels and 
72 dpi with the Depth of Field filter 
applied.

2When you are satisfied with the preview, 
render your final image at full resolution 
(for example: 600 x 400). You have two 
options:

Option 1:
In the Image Size control of the Scene 
Settings window: Output tab, change 
the render size directly by typing 600 
and 400. 

dpi. Fo
blurry
mainta

Note: Y
effect b
the pic
examp
your c
and he

Lens F

Lens fl
source
lens. F
kind of
compo
ns Flare filter lets you add lens flares 
 or more light source in your final 
ed image, according to their 

are simulates the reflections produced 
ry strong light source.
size. The smaller the film the more the out-
of-focus objects are blurred. The Depth Of 
Field filter works the same way: if you 
increase the size of the rendered picture 
the depth of field effect will appear weaker. 
Keep this in mind when working with your 
small previews.

To give you control over the strength of the 
effect, the Depth Of Field filter uses the DPI 
settings as the film resolution. When 
increasing DPI the picture size and film 
resolution are increased, hence the depth 
of field effect remains the same.

The image is now 600 x 400 at 72 dpi. The 
Depth Of Field filter renders the image as 
if you have increased the size of your 
film and you get a weaker blur.

Option 2:
In the Image Size control of the Scene 
Settings window: Output tab, change 
the dpi to 200. The picture is also at 600 x 
400, but this time at a resolution of 200 
dpi. 

The Depth Of Field filter renders the 
image as if you have increased the 
resolution of your film. The result is the 
same blur in your final image that you 
saw in the preview.

The Le
to one
render

Lens Fl
by a ve
tive positions, colors and intensities. 
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s Flare effect uses three 
ers to render the effect: Light 
olor, Light source intensity and 
re intensity.

righter Lens Flares use brighter 
rces. It also helps to lower the 
 light and use darker backdrops.

ulates a photographic filter by 
 glow around every visible light 
The effect of the glow depends on 
’s position, color and intensity. 

t source must be visible from the 
to produce a glow. It must be 
e production frame and not 
To get a lens flare effect, a light source 
must be visible to the rendering camera 
The light source must be within the 
production frame and not hidden behind or 
inside another object––even if it is a 
transparent object. A spot light must be 
aiming toward the rendering camera to 
produce a lens flare. (The camera must be 
within the light cone.)

To set Lens Flare options:

1Apply the Lens Flare filter.

See “To apply a render filter:” on 
page 350 for instructions on applying 
filters. The Lens Flare controls appear on 

Note: If you’re rendering with a white 
background, you won’t see the result of the 
lens fare effect. Select a dark color for the 
background.

Use the Lens Flare Controls to set the light 
source attributes.

The Len
paramet
source c
Lens Fla

To get b
light sou
ambient

Glow

Glow sim
adding a
source. 
the light

The ligh
camera 
within th
ehind or inside an object.

ated a visible glow around light 
the Scene Settings window: Filters 
tab.

2You have two options for previewing the 
lens flare effect. To switch between 
preview modes, click the radio button for 
the mode you want.

Display selected lens flare shows an 
arbitrary light source on a black 
background to create the lens flare. 

You can drag in the preview to change 
the relationship between the light source 
and lens. This doesn’t effect your final 
lens flare effect.

3If you want to generate a preview of your 
scene, click one of the radio buttons to 
chose the preview quality: x1 (high 
quality (slower)), x2 (normal quality) or 
x4 (low quality (faster)).

• Click the Preview button to generate a 
preview of your scene. 

This takes a few moments.

4On the right side of the panel, click the 
image describing the lens flare you want.

5Drag the Intensity slider to change lens 
flare strength.

hidden b

Glow cre
sources.
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low options:

 the Glow filter.
Show preview uses a rendered preview 
of your scene. You must first generate a 
preview to use this option.

To set G

1Apply



See “To apply a render filter:” on Pulsator

r adds dotted streaks around every 
 light source.
page 350 for instructions on applying 
filters. The Glow controls appear on the 
Scene Settings window: Filters tab.

2Adjust the Glow Size slider to change the 
diameter of the glow.

3Adjust the Glow Intensity slider to 
change the strength of the glow.

Nebula

The Nebula filter adds multicolored streaks 
around every visible light source.

The light source must be visible from the 
camera to produce a nebula effect. It must 
be within the production frame and not 

To set Nebula options:

1Apply the Nebula filter.

See “To apply a render filter:” on 
page 350 for instructions on applying 
filters. The Nebula controls appear on 
the Scene Settings window: Filters 
tab.

2Drag the 1st radius to set the streak’s 
starting radius.

3Drag the 2nd radius to set the streak’s 
ending radius.

4Drag the Angle slider to rotate the 

Pulsato
visible
ht source must be visible from the 
a to produce a pulsator effect. It 
e within the production frame and 
den behind or inside an object.

 Pulsator options:

ly the Pulsator filter.

“To apply a render filter:” on 
 350 for instructions on applying 
s. The Pulsator controls appear on 
cene Settings window: Filters 

 Pulsator filter to simulate the dotted 
 of light produced by a flashing light.
hidden behind or inside an object.

Use the Nebula filter to simulate the light 
streaks produced by a bright light pointed at 
the camera.

streaks around the light source center.

5Use the Branch number pop-up to 
choose the number of streaks.

6Enable the Thick option to makes the 
streaks thicker.

7Drag the Intensity slider to set the streak 
intensity.

Note: You’ll need to render on a dark 
background to see the effect.

The lig
camer
must b
not hid

To set

1App

See 
page
filter
the S
tab.

Use the
streaks
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ss

iCross filter adds two streaks 
every visible light source.

ariCross filter to simulate the light 
roduced by distant bright lights.
2Drag the Thickness slider to set the 
streak thicker.

3Drag the Size slider to set the streak 
radius.

4Drag the Angle slider to rotate the 
streaks around the light source center.

5Drag the Intensity slider to set the streak 
intensity.

Note: You’ll need to render on a dark 
background to see the effect.

Stars

Stars adds a star around every visible light 
source.

To set Stars options:

1Apply the Stars filter.

See “To apply a render filter:” on 
page 350 for instructions on applying 
filters. The Stars controls appear on the 
Scene Settings window: Filters tab.

2Drag the Thickness slider to set the star 
thicker.

3Drag the Size slider to set the star radius.

4Drag the Angle slider to rotate the stars 
around the light source center.

VariCro

The Var
around 

Use the V
streaks p
t source must be visible from the 
to produce a varicross effect. It 
 within the production frame and 
en behind or inside an object.

ariCross options:

 the VariCross filter.

o apply a render filter:” on 
50 for instructions on applying 

. The VariCross controls appear on 
ene Settings window: Filters 

he Thickness slider to set the 
The light source must be visible from the 
camera to produce a stars effect. It must be 
within the production frame and not 

Use the star filter to add starry streaks 
around objects.

5Use the Branch number pop-up to 
choose the number of rays.

6Enable the Diffraction option to split the 
stars into rainbow colors.

7Drag the Intensity slider to set the star 
intensity.

Note: You’ll need to render on a dark 
background to see the effect.

The ligh
camera 
must be
not hidd

To set V

1Apply

See “T
page 3
filters
the Sc
tab.

2Drag t
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 thicker.

hidden behind or inside an object.

streak



3Drag the Size slider to set the streak The light source must be visible from the 3D Light Cone

 Light Cone simulates the 
tion between light from a Spot light 
oke, fog, and dust. 

 Light Cone effect post-processes 
dered picture to adding visible light 

 from Spot lights. The visible light 
 accurately describe the half angle of 
pot light in the scene.
radius.

4Drag the 1st Angle slider to rotate the 
first streak around the light source 
center.

5Drag the 2nd Angle slider to rotate the 
second streak around the light source 
center.

6Enable the Diffraction option to split the 
streaks into rainbow colors.

7Drag the Intensity slider to set the streak 
intensity.

Note: You’ll need to render on a dark 

camera to produce an effect. It must be 
within the production frame and not 
hidden behind or inside an object.

To set CrossScreen options:

1Apply the CrossScreen filter.

See “To apply a render filter:” on 
page 350 for instructions on applying 
filters. The CrossScreen controls appear 
on the Scene Settings window: 
Filters tab.

2Adjust the Glow Size slider to change the 
diameter of the glow.

The 3D
interac
and sm

The 3D
the ren
beams
beams
each S
n the natural world, light rays are 
 when the atmosphere contains 
articles of dust or vapor which 
 light. 

 3D Light Cone filter to produce 
 cones of light in your scene.
background to see the effect.

CrossScreen

The CrossScreen filter adds a glow and 
large branches to every visible light source.

3Drag the Star Size slider to set the star 
radius.

4Drag the Angle slider to rotate the stars 
around the light source center.

5Drag the Branch number slider to set the 
number of rays.

6Drag the Intensity slider to set the effect 
intensity.

Note: I
visible
small p
diffuse

Use the
visible
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Use the CrossScreen filter to simulate the 
light effect produced by stars.



he Turbulence size slider to set the 
 size, in inches, of the wreath of 
. This slider ranges from 0.01 

s to 489 inches. 

he Turbulence lumpiness slider to 
e contrast level in the wreath of 
. 

the Turbulence sampling slider to 
e number of samples per pixel. 

pical value is 10. Don’t change this 
unless you are working on high 
tion pictures (over 1024 x 1024). 
ampling values significantly slow 

 the rendering. 
About the Warnings

Some of the 3D Light Cone options lead 
require more memory and extend 
rendering time. 

The warning box at the bottom left of the 
panel tells you when the current settings 
demand a large amount of memory and 
require more rendering time. 

The bottom right box indicates the amount 
of RAM required to render the scene with 
the current settings.

To set 3D Light Cone options:

1Apply the 3D Light Cone filter.

3Drag the Intensity slider to change the 
strength of the light cone effect. The 
range is from 25% to 200%.

4Enter a value in the Range entry box to 
set the length of the light cones. 

The Range describes the number of 
inches before the light cone fades out.

5Enable the Use gel option if you want to 
use any gel on the lights in the light cone 
effect. 

Use this option only if you’ve applied 
gels to your Spot lights.

6Drag the Gel Buffer Size slider to set the 

8Drag t
mean
smoke
inche

9Drag t
set th
smoke

ºDrag 
set th

The ty
value 
resolu
High s
down
e the Animated option if you want 
g medium to move (change over 
 

ption slows down the rendering. 
 only when doing animations.

e the 3D Shadow option if you 
objects in the light cone to cast 
ws in the fog.

the Shadow Buffer Size slider to 
e quality of the 3D shadow effect in 
ht cone.

: 3D Shadows is a powerful but 
ffect. The filter must pre-process 
See “To apply a render filter:” on 
page 350 for instructions on applying 
filters. The 3D Light Cone controls 
appear on the Scene Settings 
window: Filters tab.

2To change the color of the fog, click on 
the color chip at the left of the Fog panel.

Ray Dream Studio opens the system 
color picker so you can choose a color.

Note: The color of the visible light cone 
results from the interaction of the light’s 
color and the fog color. Yellow light in a 
white fog produces a yellowish light cone. 
In a blue fog, yellow light produces a green 

quality of the gel effect in the light cone.

Move the slider to the right to increase 
quality of the gel in the light cone.

Caution: To render textured light rays, 
the filter pre-processes and stores 
buffers for each Spot light in your scene. 
High buffer values produce better 
results, but can be costly in rendering 
time and memory requirements. Don’t 
try values higher than 200 unless you 
have a powerful computer and are 
working on high resolution pictures. 
Always start with a small value. 

7Enable the Add Turbulence option if you 
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rendering time and memory requirements. About the Warnings 3Drag the Intensity slider to change the 
ngth of the light sphere effect. The 
e is from 25% to 200%.

r a value in the Range entry box to 
he radius of the light sphere. 

Range describes the number of 
es before the light sphere fades out.

le the Add Turbulence option if you 
t swirls in the fog medium.

 the Turbulence size slider to set the 
n size, in inches, of the wreath of 
ke. This slider ranges from 0.01 
es to 489 inches. 
Do not try values higher than 200 unless 
you have a powerful computer and you are 
working on high resolution pictures. 
Always start with a small value.

Note: You’ll need to render on a dark 
background to see the visible light cones.

3D Light Sphere

The 3D Light Sphere simulates the 
interaction between light from a Bulb light 
and smoke, fog, and dust. 

3D Light Sphere filter post-processes the 
rendered picture by adding a light sphere 
around each Bulb light.

Some of the 3D Light Sphere options lead 
require more memory and extend 
rendering time. 

The warning box at the bottom left of the 
panel tells you when the current settings 
demand a large amount of memory and 
require more rendering time. 

The bottom right box indicates the amount 
of RAM required to render the scene with 
the current settings.

To set 3D Light Sphere options:

1Apply the 3D Light Sphere filter.

stre
rang

4Ente
set t

The 
inch

5Enab
wan

6Drag
mea
smo
inch
 the Turbulence lumpiness slider to 
he contrast level in the wreath of 
ke. 

 the Turbulence sampling slider to 
he number of samples per pixel. 

typical value is 10. Don’t change this 
e unless you are working on high 
lution pictures (over 1024 x 1024). 
 sampling values significantly slow 
n the rendering. 

le the Animated option if you want 
og medium to move (change over 
). 
Use the 3D light Sphere to add a ball of light 
in your scene.

See “To apply a render filter:” on 
page 350 for instructions on applying 
filters. The 3D Light Sphere controls 
appear on the Scene Settings 
window: Filters tab.

2To change the color of the fog, click on 
the color chip at the left of the Fog panel.

Ray Dream Studio opens the system 
color picker so you can choose a color.

Note: The color of the visible light sphere 
results from the interaction of the light’s 
color and the fog color. Yellow light in a 
white fog produces a yellowish light 
sphere. In a blue fog, yellow light produces 
a green sphere.

7Drag
set t
smo

8Drag
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 option slows down the rendering. 
it only when doing animations.
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reground sphere. With Test Z on, 
ra filter knows which object is in 

 and the foreground sphere will 
tly obscure the background aura.

he Intensity slider to change the 
th of the aura effect. 

he Range slider to set the radius of 
ra. 

ange describes the number of 
s before the aura fades out.

e the Add Turbulence option if you 
swirls in the aura medium (smoke 
hs).
Aura

Aura let you render true glowing objects 
with an outside aura. The light emitted 
from the glowing objects can interact with 
fog or turbulent smoke.

Use the Aura filter to create glowing objects.

3Set the glow color. 

Higher luminance values result in a 
brighter glow and, therefore, a stronger 
aura.

4Repeat steps 1 through 3 for each object 
that should have an aura.

To set Aura options:

1To change the color of the aura, click on 
the color chip at the left of the Aura 
panel.

Ray Dream Studio opens the system 
color picker so you can choose a color.

the fo
the Au
front,
correc

3Drag t
streng

4Drag t
the au

The R
inche

5Enabl
want 
wreat
he Turbulence size slider to set the 
 size, in inches, of the wreath of 
. This slider ranges from 0.01 

s to 489 inches. 

he Turbulence lumpiness slider to 
e contrast level in the wreath of 
. 

he Turbulence sampling slider to 
e number of samples per pixel. 

 this value at the default unless you 
orking on high resolution pictures 
1024 x 1024). High sampling values 
cantly slow down the rendering. 
Aura automatically detects which objects 
have a glow shader, letting you create 
impressive effects like laser beams, neon 
signs and LEDs.

Aura uses the shader glow channel to know 
which object are glowing and which are 
not. Only objects that have some degree of 
luminance in the glow channel receive an 
aura.

To identify which objects should have an 
aura:

1Select an object that should have an 
aura.

Note: The color of the final aura effect 
results from the interaction of the object’s 
glow color and the aura color. 

2Enable the Test Z option if you want Ray 
Dream Studio to check the depth of the 
different objects in the scene before 
applying the aura effect.

When Test Z is off, the Aura might 
produce an unexpected result when the 
aura object is partially obscured by a 
non-aura object.

For example, you set up two spheres—
one in the foreground without glow and 
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e the Animated option if you want 
edium to move (change over time). 
2Display the Current Shader Editor 

palette: Glow tab.

the second with glow behind the first. 
With Test Z off, the Aura around the 
background sphere may cover a part of 

9Enabl
the m



This option slows down the rendering. Set the size according to your final 
ut. You can use the pop-ups to the 

t to choose the units.

e Resolution entry box, enter the 
lution (dots per inch) of the 
cted output device.

h square image at 600 dpi may occupy as 
 100 MB on disk! (The size varies depending 
rmat and image content.) 

le the Keep Proportions option if 
want to keep the same aspect ratio 
o of width-to-height) when you 
Use it only when doing animations.

Output
The Scene Settings window: Output 
tab provides a set of controls for the 
images the renderer creates.

Image Size Controls

The Image Size controls lets you describe 
the dimensions and resolution of the image 
to be rendered.

The resolution of a device, such as a monitor, printer, 
scanner, or image setter, is described as the number of 
pixels it can create for each inch of image area: pixels 
(or dots) per inch (ppi or dpi). 

For example, the screen of an Apple color monitor has 
72 dots per inch (dpi). Each dot is a pixel, so an image 
that is 72 x 72 pixels would be one inch square on the 
screen of that monitor. VGA monitors have slightly 
higher resolutions. Many color printers are capable of 
300 dpi, and some image setters can produce more 
than 2500 dpi.

This discrepancy in device resolution creates a slight 
problem—pixels are different sizes on different 
devices, so an image displays or prints at a different 

outp
righ

2In th
reso
expe

A six-inc
much as
on file fo

3Enab
you 
(rati
ge either the width or height.

ck how long this rendering will 

mage dimensions and resolution as 
ribed above.

 Estimate.

moment, the Render time display 
s approximately how long 

ering will take at the current 
ngs. 
The image size controls let you specify the 
size and resolution of the final rendered 
image.

size on devices of different resolution. For example, the 
72 x 72 image that appears one inch square on the 
screen would be less than one-quarter inch when 
printed on a 300 dpi printer. (72 pixels drawn at 300 
dots per inch: 72/300=0.24 inches.) 

The solution is to set the rendering parameters 
according to the size of the image you want from a 
particular output device.

To set the image size and resolution: 

1In the Width and Height entry boxes of 
the Rendering Settings dialog, enter the 
dimensions you want for the picture.

chan

To che
take: 

1Set i
desc

2Click

In a 
show
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setti
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 the Production Frame: 

e the Selection tool.

on the outer rectangle to select it.

 notice “handles” appear on each 
r and side.

 the cursor inside the frame and 
t where you want it.

 change the viewpoint of your 
ou’ll need to work with the camera. 
mation om moving the camera, 

Chapter 14, “Setting Lights & 
.”
To limit rendering time: 

If time is more important than quality, you 
can give Ray Dream Studio a time limit and 
ask for the best rendering in that time 
frame. This would be a good choice, for 
example, if you wanted the rendering done 
by the time you got back from lunch.

1In the Render Time entry boxes, enter 
the amount of time you want Ray Dream 
Studio to work on the rendering. 

2Click Estimate.

In a moment, the Resolution (and 
number of pixels in each dimension) 

To display the Production Frame: 

Choose View menu> Production 
Frame.

The production frame appears as a colored 
rectangle (green, by default) in the 
Perspective window. 

The rectangle’s dimensions are determined 
by the width and height settings in the 
Image Size panel. 

The area of the scene the frame encloses 
represents the area of your rendering. You 
can think of the rectangle as “defining the 
print area” of your scene. 

To move

1Choos

2Click 

You’ll
corne

3Move
drag i

Note: To
scene, y
For infor
refer to 
Cameras
e the Production Frame: 

e the Selection tool.

on the outer rectangle to select it.

 notice “handles” appear on each 
r and side.

 corner handle to resize in two 
sions. Hold down the Shift key 
you drag to constrain proportions 
tain the aspect ratio).

 side handle to resize in one 
sion.
changes to the best resolution possible 
in the time allotted settings. You can now 
start the rendering to get this result.

Framing Your Scene

The image dimensions are closely related 
to the production frame, which specifies 
the area of the scene (as seen by the 
camera) that’s rendered in the final 
artwork. You can think of the production 
frame as the camera’s view finder.

After setting the image size in the Image 
Size panel of the Render Settings dialog, 
turn on the Production Frame display and 
check the framing of your scene. 

The Production Frame defines the area of the 
Perspective window will be used to produce 
the rendered image.

Production Frame

To resiz

1Choos

2Click 

You’ll
corne

3Drag a
dimen
while 
(main

4Drag a
dimen
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When you resize the production frame, 4When you’ve finished with the dialog, 
 Save.

Dream Studio displays the disk 
tion and name to the right of the Set 
on.

 file name controls to choose between 
Ray Dream Studio updates the height 
and width values in the Scene Settings 
window: Image Size controls. The 
resolution (dpi) stays the same.

Note: The camera position does not change 
when you move or adjust the Production 
Frame. What you are doing is cropping the 
camera’s view.

The Zoom tool and the scroll bars change the display 
in the Perspective window—not the camera view. If 
you can’t see all of the production frame, use the scroll 
bars and/or Zoom tool (to zoom out) until you do.

To select the camera to render from: 

1Display the Scene Settings window: 
Output tab: Camera controls.

2Use the Rendering Camera pop-up to 
choose the camera you want to render 
from. The pop-up lists all cameras in 
your scene.

3Save your scene.

Note: If you want to render one scene 
several times from different cameras, use 
the Batch Queue. This feature is described 
in “Using the Batch Queue” on page 368.

File Name

click

Ray 
loca
butt

Use the
rmat

le Format controls let you choose 
e of file saved to disk and set 
s for it. The File Format controls also 
 specify the frame range and rate for 
ing animations. 

 file format options for rendering 
rrent frame:

lay the Scene Settings window: 
ut tab: File Format controls.

cessary, click the radio button for 
ent Frame (still image).

lt file name and a specific name.

Camera

If you use one of the Render commands, by 
default you’ll be rendering from the current 
camera. 

To render from some other camera or if 
you are going to use the Batch Queue, you 
can identify which camera to use.

The Camera controls let you specify a 
camera to use for the rendering.

The File Name controls let you set the 
name and disk location for rendered files.

To set a file name for rendering this 
scene:

1Display the Scene Settings window: 
Output tab: File Name controls.

2Click the In Named File radio button.

3Click Set.

Ray Dream Studio displays a dialog that 
lets you enter a name for renderings 
from this scene and choose a disk 

File Fo

The Fi
the typ
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let you
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g Compression Settings

ng animation requires significant 
of hard disk space. If you have disk 

itations, you will want to 
s the movie that you render. If you 
nty of disk space, you may want to 
ithout compression. This way you 

vest rendering time only to find out 
 used too much compression. You 
 re-open the movie file in Ray 
tudio and save it with 
sion.

ware compression and 
ression algorithms (called codecs) 
 can select in the Compression 
 dialog are provided with 
Movies have additional settings and 
considerations. See the next section For 
information on choosing movie file 
formats, refer to “Choosing Compression 
Settings” on page 363.

3Choose the file format you want from the 
pop-up.

Windows Bitmap, PICT (Macintosh), 
TIFF, EPSF (Macintosh), GIF, JPEG, 
Painter RIFF, Targa (Windows), Corel 
Photo Paint, and Adobe PhotoShop. 

You may have other formats added as 
PhotoShop compatible plug-ins.

4Click Options.

To choose a movie file format:

1Click the radio button for Movie 
(animation).

2Choose the movie file format you want 
from the pop-up.

Movie formats include QuickTime Movie 
(Macintosh), AVI Movie (Windows), and 
a variety of sequenced image formats.

The “Movie” formats (QuickTime and 
AVI) generate a single file that includes 
all of the frames. 

The “sequenced” formats generate a 

Choosin

Renderi
amount 
space lim
compres
have ple
render w
won’t in
that you
can then
Dream S
compres

The soft
decomp
that you
Settings
me (Macintosh) or AVI (Windows). 
compress data when you render an 
n and decompress the data when 
 the movie. Any Macintosh or 
s system with QuickTime or AVI 
 can play back a compressed 

using hardware for MPEG compression, see 
tions that accompanied your board for a 
 of available compression options.
Ray Dream Studio displays a dialog that 
lets you set features for this file format.

5When you’re finished setting options, 
close the options dialog.

Use the File Format controls to select a 

single file for each frame. The files are 
numbered 000, 001, 002, and so forth, to 
keep them in sequence. Sequenced files 
are often used for transferring the 
animation to other programs, such as 
Adobe Premiere™

3Set the start and end points of the render 
range. For more information on the 
render range, “The Render Range” on 
page 303.

4Choose a frame rate from the Rate 
pop-up.

5Click Options.

QuickTi
Codecs 
animatio
you play
Window
software
movie. 

If you are 
the instruc
description
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specific format for the final rendered image. Ray Dream Studio displays a dialog that 
lets you set features for this file format.



Note: Your actual compression may vary, • Cinepak. This is a cross-platform codec 
uickTime and AVI movies that is best 
d for video and CD-ROM playback. 
ies take a long time to compress, but 
 decompress quickly at playback. 
pak is best for 16- and 24-bit 
ations. Cinepak has better 

pression ratio, image quality, and 
r playback than Apple’s Video codec. 

ponent Video. This is best suited for 
rchival or interim storage of digitized 

o compression. At a compression 
 of 2 to 1, Component Video requires 
of disk space. Use this codec when 
e quality is more import than 
pression ratio or real-time playback. 

phic. This is recommended for 8-bit 
To select a movie compression option: 

1Click Options n the Scene Settings 
window: Output tab: File Format 
controls. The Compression Settings 
dialog appears.

depending on the version of QuickTime or 
Video for Windows you have installed. For 
additional information refer to your Apple 
or Microsoft documentation.

Macintosh Compression Options 

• None. This is a lossless form of 
compression with a 2 to 1 (or less) 
compression ratio. This codec converts 
an image’s pixel depth from 32-bit to 24-
bit image format with no loss in quality by 
combining the alpha channel byte. None 
is a good option for raw animation if you 
have plenty of hard disk space. You may 
want to use this as an intermediate step if 
you plan to edit your animation in Adobe 
Premiere because Premiere re-

for Q
suite
Mov
they
Cine
anim
com
faste

• Com
the a
vide
ratio
lots 
imag
com

• Gra

images. Useful for compressing pre-
ered animations in which 
mpression performance is not as 
rtant as the compression ratio. 

to-JPEG. This is recommended for 
pression of still images with 
inuous tones such as photographs. It 
s too slowly for animation, and 

ards some data (it’s a lossy 
pression method). Photo-JPEG is 
mmended for archiving 16- and 24-bit 
ce clips. This codec saves the image 
EG format, which results in high 
ity images with a high amount of 
pression. 
2Select one of the compressor options 

On Macintosh you can set compression 
options for Quicktime movies. 

In Windows you set compression options for 
AVI movies.

compresses the movie (you should avoid 
compressing twice). None is better for 
reachieving when the highest image 
quality is important.

• Animation. This codec works best for 8-
bit animation and computer-generated 
screen images (as opposed to videotape 
images). It’s often used for 3D animation. 
The image quality (especially at higher 
quality settings) is acceptable for informal 
movies. With this codec, you can create 
movies up to full-screen at any color 
depth. The Animation codec saves the 
first image and then saves only changes 
from one frame to the next. It also cuts 
out the alpha channel, resulting in 

still 
dith
deco
impo

• Pho
com
cont
work
disc
com
reco
sour
in JP
qual
com
ou may have other JPEG options 
le.
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from the Compressor pop-up.
increased speed and smaller files. Note: Y

availab



ey frame is used in temporal 
ression methods. Each key frame is 
 in its entirety. The next set of 

s—up to the next key—are saved 
s changes.

codec that supports the feature, 
an use the Limit Data Rate option. 

llows you to set a maximum size 
y frame. QuickTime automatically 
s the compression quality to 
ain this rate. This feature is 
ble for only a few codecs.

r

am Studio 5 can calculate and save 
• Video. Video is Apple’s QuickTime video 
compressor. It is best for high-quality 
video clips that play in real time on faster 
Macintosh machines. Its only option is 
color. Video is appropriate for 
rotoscoping. This codec can play back 
regular animations, but the image quality 
not as high as when the Animator 
compressor is used. 

AVI Compression Options

• Microsoft Video 1. This codec 
compresses each frame of a clip (and is 
used for analog video (8 and 16-bit). Some 
data is discarded (the codec is lossy).

• Full Frames (Uncompressed). This 
option is best for capturing full frames of 

• Microsoft RLE. Use this option for 
compressing animation and computer-
synthesized 8-bit images.

• Intel Indeo Video Raw. Use this 
compression method for capturing 
uncompressed video. You will obtain 
superior image quality because no 
compression is applied.

Compression tip: For optimal compression, use the 
right frame size: 160 x 120 for Apple Video compressor 
and 240 x 180 for Cinepak. When using Cinepak, 
frame dimensions need to be multiples of four for best 
performance. 

The k
comp
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G-Buffe

Ray Dre

an a dozen separate channels of 
ic and lighting information in 
 to your full color rendered image. 

dditional channels appear as 
e images, where the gray values 
t information. The data in each of 
annels describes the point in your 

e that each pixel in the image 
ts. For example, if the scene shows 
g glass on a wooden table, each 
he rendered image corresponds to 
on the glass or on the table—in 

 scene.

le formats are capable of storing all 
annels possible. Because Painter 5 
 Adobe Photoshop 2.5 and higher 
analog video. No compression is applied, 
so use of this codec requires lots of disk 
space.

• Cinepak Codec (Radius™). This is a 
cross-platform codec for QuickTime and 
AVI. Movies take a long time to compress, 
but decompress quickly at playback. 
Cinepak is optimized for 16- and 24-bit 
animations. Cinepak has a better 
compression ratio, image quality, and 
playback than the Microsoft Video 1 
codec.

• Intel Indeo Video R3.2. This codec uses 
higher compression ratios, and results in 
better image quality and faster playback 
than Microsoft Video 1.

To set compressor options for the 
QuickTime format:

1Choose a color depth from the Color 
pop-up. The depths available depend on 
the selected codec.

2Use the Quality slider to set the level of 
compression.

The compression ratio is inversely 
proportional to image quality. The 
Quality slider allows you to set an 
optimum between the amount of 
compression and image quality.
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3For a codec that uses key framing, enter 
a Key Frame rate.



support multiple channels, rendered image-editing program. Pasting a with the Magic Wand, regardless of 
r. This works as long as the objects 
ot overlap.

al vector The normal vector 
tes three channels describing the 
ction that each surface of the object 
s. This information can be used after 
ering to simulate additional light 
ces. For example, it’s possible to add 
ctional lighting or glows in 
toshop by loading the normal 
nel to select all the surfaces that 

 in a given direction, complete with 
mation about how those facings fall 

tion The position describes the 
images saved in these format can contain 
all G-Buffer channels. 

There are many versions of the TIFF 
format. The TIFF format used in the 
Windows version of Ray Dream Studio 5 
can also contain all G-Buffer channels.

To select G-Buffer channels: 

1Display the Scene Settings window: 
Output tab: G-Buffer controls.

2Enable the checkbox or each feature you 
want.

Do not enable channels that you don’t 

foreground image onto a background is 
called compositing.

Refer to your image-editing application’s 
documentation for instructions on selections, masks 
and compositing. 

Ray Dream Studio 5 puts the mask data in channel #4, 
the Alpha channel, which is where masks are usually 
kept in applications like Painter and Adobe Photoshop.

colo
do n

Norm
crea
dire
face
rend
sour
dire
Pho
chan
face
infor
off.

Posi

dinate of each point in the image. 3D 
tion uses three channels, one for the 
lue, one for the y value, and one for z. 
xample of how you could use this 
mation is to position low hanging 
ds, making use of the Z, or height, 
nel.

ace coordinate The surface 
dinate describes the location of the 
t on the object in relation to the 
ct’s surface coordinate system. This 
o-dimensional information which 
s adding, replacing, or 

sitioning texture maps on 3D objects 
 image editing program.
need. Each channel adds to the file size 
considerably. 

Pixel color The pixel color is 
determined by shading and lighting 
effects. For example, looking through a 
drinking glass, you can see the wooden 
table behind. The color of a specific pixel 
in the glass appears as the color of the 
wood after it has filtered through the 
translucent glass. Pixel color occupies 
channels #1, #2 and #3 for red, green and 
blue.

Mask A mask is a “shadow” image of 
your scene. It describes where objects 
are, versus where they are not. The mask 

Distance The distance channel 
describes the distance of each point 
from the camera, or viewpoint. Lighter 
pixels are closest to the camera, while 
dark colors represent areas of the 
rendering that are farthest from the 
camera. You can use the distance 
channel information in Painter 5 with the 
Effects menu > Focus menu> Depth 

of Field effect to blur areas that are 
farther from the camera.

Object index The object index relates 
each pixel in the image to the object its 
corresponding point belongs to. With an 
object index loaded in Adobe Photoshop, 

coor
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is used as a selection of your image when 
you paste onto a background in an 

you can easily select individual objects 



ve preset render settings:

e Render menu> Remove 
gs. 

emove Render Settings dialog 
rs.
Preset Render Settings
Ray Dream Studio 5 allows you to save 
frequently used render settings. Your 
saved settings will appear as presets on the 
Render menu, where you can use them 
directly

To create a new render preset:

1Set all rendering options to your liking. 
The presets include the controls in the 
Scene Settings: Render tab and 
Output tab.

2Choose Render menu> Save 
Current Settings.

5Enable Save Punch In and Punch Out if 
you want to include the rendering range.

6Enable Save Effects, Filters, and Misc 

You can save a specific set of render settings 
using the Save Render Settings dialog

To remo

1Choos
Settin

The R
appea
 the render setting to be removed 
 left window.

OK.

remove a saved settings from the list 
s by using the Remove Render 

dialog
3Ray Dream Studio displays a dialog that 
lets you name the preset, add a comment 
and set three other options.

4Enable the Save Camera option if you 
wan to include the choice of rendering 
camera.

data if you want these features to be 
included with the saved settings.

7Click OK to close the dialog and create 
the preset on the Render menu. 2Select

in the

3Click 

You can 
of setting
Settings 
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Starting a Rendering Job Using the Batch Queue

eam Studio 5 allows you to batch 
l rendering jobs in a queue for 
d, unsupervised processing. By 
, batched files are rendered using 
der settings saved in the file. 
er, batch queue rendering 
eters can be set to use specific 
s for the entire batch or to use 
lar settings for each file in the batch 

 rendering, Ray Dream Studio 5 
s and processes all scenes one at a 
ou can add to or remove files from 

tch queue at any time.
When you have set your options and 
framed your scene, you can start a 
rendering. 

To start rendering using the current 
settings: 

Choose Render menu> Using Current 
Settings.

You may also use the key shortcut 
Command-R/Ctrl+R.

An Image window opens and rendering 
begins. The progress bar advances as 

To render with a preset:

Choose Render menu> Preset Name. 

For example Render menu> Fast 
Animation Preview starts a draft movie 
rendering. 

Rendering is computationally intensive, 
and depending on the render settings, jobs 
may take several hours to complete. 
Rendering can run in the background. You 
can go on working with Ray Dream Studio 
and even launch other applications—if 
memory permits. 

Because rendering is time consuming, Ray 
Dream Studio provides a feature that helps 

Ray Dr
severa
deferre
default
the ren
Howev
param
setting
particu
queue.

During
display
time. Y
the ba
 files to the batch queue: 

p each scene you wish to include in 
atch:

member to set the render settings, 
e production format, the framing, and 
e default camera.

ve and close these files.

ose Render menu> Batch Queue.

 Add. 

Dream Studio displays a dialog so 
can locate and add one or more 
rendering proceeds.

When you start a rendering, Ray Dream 
Studio displays a window showing the 
rendering’s progress

you fit heavy rendering jobs into your 
schedule: the batch queue.

When using applications such as word processors or 
2D drawing programs, the CPU is not using maximum 
capability and spends a lot of time idling. Ray Dream 
Studio 5 takes advantage of this by taking control of 
the CPU and performing its calculations in the 
background. The computational load between Ray 
Dream Studio’s ray tracer and other programs has 
been set up so that you can type in your favorite word 
processor without perceptible slowdown.

To add

1Set u
the b

• Re
th
th

• Sa

2Cho

3Click

Ray 
you 
e files. 
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k Save to add the current settings 
he presets. For more information, 
r to “Preset Render Settings” on 
e 367.

anging the settings for a file in the 
eue only affects this batch 

. The settings saved in the file itself 
anged.

 you’re finished with the Render 
gs dialog, click OK.

 the batch process:

 batch processing, click Launch. 

 the batch is running, you can click 
Readable files (scenes) in the current 
folder are on the left. Files you’re adding 
appear on the right.

4Select a file, then click Add. You may also 
double-click a file to add it.

You can renderer a number of scenes at a 
later time using a Batch Queue.

List. Ray Dream Studio displays a dialog 
so you can name the list and choose a 
disk location. Later, when you want 
these same files in the batch queue 
again, click Load List. Use the dialog to 
locate and open the saved batch queue 
list.

To change settings on a file in the queue:

1In the Batch Queue list, select the file or 
set of files you wish to change.

2Click Settings.

The Render Settings dialog appears, 
where you can view and change the 

• Clic
to t
refe
pag

Note: Ch
batch qu
process
are unch

3When
Settin

To start

To start

• While

 to stop it.

ause to temporarily halt the 
ss. Click Resume to start the 
ss again.

e Rendering Progress and Scene 
ics items in the top panel to get 
ation on the scene currently being 

red or on a scene you select in the 
 panel. Use the Information pop-up 
ose which.

 want to save the information, click 
ext. Use the dialog to name the file 
oose a disk location.
To include all files in the current folder, 
click Add All. 

If you want to remove a file from the 
queue, select it and click Delete/
Backspace.

5Repeat step 4 until you’ve added all files 
you want in this batch. 

6Click Close/Done.

At this point, you can launch the batch 
process or check and change the settings 
for any particular file.

If you think you’ll want to use this same 

image size, file format and other options. 

• Page to the different tabs and change 
settings individually.

Use the Render Settings dialog to view the 
scene’s rendering options.

Abort

• Click P
proce
proce

• Use th
Statist
inform
rende
lower
to cho

• If you
Save T
and ch
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list of files in the batch queue at a later 
date, you can save the list. Click Save 

• Click Load to select one of the saved 
presets.



Cameras aren’t the only thing you can If an object is distant from the camera, 
 in the Free Form modeler and lower 

face fidelity to the minimum. This 
 in the minimum amount of RAM 
sed for its geometry.

an object leaves the frame, and isn’t 
ed in any surface that you can see in 
dering, activate its Cloak property. 
on’t save memory, but it does save 
ing time. Objects that pass behind 
bjects can be cloaked to save time, 
 careful that you do not lose a cast 
 where one is needed.

n speed up rendering by applying 
echniques:

the Draft Z-Buffer to preview your 
To render a scene more than once from 
different cameras:

1Choose Render menu> Batch Queue.

2Click Add to add the scene to the Batch 
Queue.

3Without exiting the Batch Queue dialog, 
click Add again. Keep clicking as many 
times as you need.

A duplicate of your scene will appear in 
the Batch Queue list.

4Click Close/Done.

5In the Batch Queue dialog, select an 

change. You can change any scene 
setting.

9When your done adjusting the render 
settings click Ok.

ºRepeat steps 6-9 for each copy of the file 
in the list.

¡Click Launch to start the batch queue.

Speeding up Rendering
There are several techniques that you can 
use to reduce your rendering time. These 
techniques are especially useful when 
rendering animations that may have 
hundreds, or even thousands, of individual 

open it
its sur
results
being u

When 
reflect
the ren
This w
render
solid o
too. Be
shadow

You ca
these t

• Use 

ct positions and movement. 

k with smaller image (frame) sizes. 
standard for CD-ROM-based 
kTime movies is half-screen size, or 

by 240 pixels, although satisfying 
lts can be achieved at 240 by 180. 
 can then scale up to full-screen size 
HS output, although pixilation may 

pparent when you scale up.)

t the number of frames per second to 
hich is adequate for QuickTime 

ies. (Video uses 30 fps and film 24 

lify objects and reduce the number 
jects in the animation.
instance of your scene in the list, then 
click Settings. 

The Render Settings dialog appears.

6Click the Output tab.

7Expand the File Name controls, and 
choose a new filename for your scene.

Note: If you don’t choose a different name 
for when you render this scene, it will 
overwrite the original scene.

8Expand the Camera controls, and choose 
a new render camera.

images to be rendered.

Use an image editing program to reduce 
your texture maps to 8-bit depth. Very few 
images actually use millions of colors, and 
many image editing programs discard 
insignificant information while maintaining 
the quality of the image. (Some textures 
even look good in 4-bit depth, or 16 colors.)

Reduce all texture maps to be used in non-
color channels like the bump channel to 8-
bit and grayscale before importing them. 
The color file wastes space and time while 
Ray Dream Studio converts it to gray. 

obje

• Wor
The 
Quic
320 
resu
(You
for V
be a

• Limi
15, w
mov
fps.)

• Simp
of ob
t the number of lights. 
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ing Rendered Images

u render using Render menu 
ds, the image is displayed in a 

 when rendering is done. If you 
keep this rendering, you should 
 file.

ngs generated from the Batch 
re automatically saved to disk. You 
n these files in Ray Dream Studio 5 
le-clicking on the file icon. Or, you 
n and view them in another 
 application.

 Dream Studio 5 Image 
• For the Ray Tracer or Adaptive renderer, 
disable the Reflection, Transparency and 
Refraction options.

• Keep objects near the background simple. 
(A complex bitmapped background does 
not affect rendering speed.)

• Limit the size of texture maps. 

• Use 8-bit texture maps instead of 24 bit.

• Limit the number of reflective and 
transparent objects.

• Divide animations into smaller files and 
eliminate objects that won’t be seen on-
screen.

• Turn off anti-aliasing when previewing 

system’s virtual memory as well, 
performance can be very poor. In this case, 
adding RAM can improve speed, although 
this makes the computer run more 
efficiently, not any faster. 

The fastest rendering takes place on a fast 
processor with plenty of RAM. Systems 
used in professional animation may 128 MB 
RAM or more.

Because all rendering involves some 
spooling to disk, you need a large hard disk 
with plenty of free space.

To keep your hard disk running efficiently, 
use disk utilities to scan for disk errors, and 
defragment your hard disk prior to starting 
a project or even a long rendering session.

View

When yo
comman
window
want to 
save the

Renderi
Queue a
can ope
by doub
can ope
graphics

The Ray
u open a rendered image, it’s 
d in the window shown below. 

y Dream Studio is finished 
g, it displays the final image in the 
rendered animation.

Computer System Optimization

Ray Dream Studio 5’s performance is 
affected by available RAM and disk space. 
You can never have a fast enough 
computer, enough RAM or disk space, a 
large enough monitor, or a fast enough 
computer. With that in mind, here are some 
things you can do to get the best 
performance out of your system.

If you have a scene that uses more RAM 
than you have, Ray Dream Studio uses its 
own virtual memory system to keep things 
running, spooling data back and forth to 
the hard disk. The greater the disparity 

Don’t run other programs in the 
background. Some screen savers use as 
much CPU time as Ray Dream Studio 5.

Window

When yo
displaye

When Ra
renderin
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indow
between RAM needs and what is available, 
the more speed it costs you. If the scene 
ends up dipping into the operating 

Image w



The Ray Dream Studio 5 Movie 
The program tries to load the image into RAM. If there 
is not enough available RAM, Ray Dream Studio spools 
the image from the scratch disk. For example, Ray 
Dream Studio 5’s spooling enables you to display a 
20MB image on your system with only 16MB of RAM. 
The penalty of spooling is slower access time. Each 
time you adjust the image, the computer must read/
write to the disk.

The zoom ratio (scaling) appears in the top 
left. The ratio is “screen pixels-to-image 
pixels.” When the ratio is 1:1, one screen 
dot represents one image pixel. When the 
ratio is 1:2, one screen dot represents two 
image pixels. The ratio changes as you 

Window

When you open a rendered animation 
that’s saved as a QuickTime or AVI movie, 
Ray Dream Studio displays it in the movie 
window, shown below.
zoom in or out with the Zoom tool.

The image resolution, color depth, and size 
of the image (in “K,” for kilobytes, or “MB,” 
for Megabytes) appear at the top.

Note: Images produced by Ray Dream 
Studio using Render menu> Use 
Current Settings and Render menu> 
High Resolution are rendered and stored 
on disk in 24-bit (millions of colors) format.

The Movie window adds the duration and 
frame rate to the other statistics at the top 
of the window.

• Click Play to play the movie. During play, 
click Pause to stop. 

• Click Frame Forward or Frame Back to 
step through one frame at a time.

• Click Loop to enable looping. Then click 
Play.

• Drag the slider to “scrub” through the 
movie.

When Ray Dream Studio is finished 
rendering an animation, it displays the final 
movie in the Movie window
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18

 

Post Production

 

Overview

 

Rendering produces a 2D, bitmapped image 
of your scene. Anything you do with that 
image is considered post production. Post 
production might include compositing, 
filtering, cropping, and retouching the 
image in an image-editing application. 

Rendering an animation produces a 
movie—either a single file that contains all 
frames (QuickTime or AVI) or a sequence 
of files. Post production on a movie might 
include any of the still-image operations, 
like compositing and filtering. It might also 
include more advanced work, like editing 
clips together and adding sound effects.
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Post-Production 

    

when you request a rendering.) This 

   

ou can set the background color or 
y in the 

 

Scene Settings window

 

:

 

 

        

al underwater scene was created by 
siting a the objects created in Ray 
 Studio with an ocean texture us 
 Design Painter.
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Applications

Ray Dream Studio 5 is a 3D illustration and 
animation tool. It does not provide 
comprehensive post-production features. 
You may use an image editing or paint 
application such as Fractal Design 
Painter®, Micrografx Picture Publisher®, 
Corel Photo-Paint®, or Adobe Photoshop 
for the best in post-production results. In 
some cases, you might want to use your 
imaging application to adjust colors or 
contrast, apply an effect or image filter, or 
paint directly onto the image.

ensures precise outlines on the objects you 
paste.

In Ray Dream Studio you can create the basic 
objects in your scene and then use another Note: Y

imager

This fin
compo
Dream
Fractal
s tab: Background or Backdrop 
ls. 

in photographs have their own perspective. If 
eled object you composite does not match the 
ive of the background, it will seem unnatural 
of place. After rendering, you can’t change the 
ive of the objects you create. Before 
g, however, it’s easy.

t to set the perspective and the direction of 
to match the background image before 
g. 
Ray Dream Studio saves renderings in file 
formats that are compatible with virtually 
any pre-press or layout application.

Compositing
Compositing is the process of pasting one 
image onto another. For example, if you 
built a sub in Ray Dream Studio 5, you 
could paste it onto a scanned photo of an 
ocean. If you’re careful, the sub can appear 
as though it was under the ocean when the 
original photograph was taken.

Usually, the foreground image (what you 
paste) is not a rectangle, but an irregularly 
shaped selection of the rendered objects. 
This selection should be created from an 
auto-generated mask. (The mask is created 

application to add a different background or 
other effects. 

In an image editing application, like Painter, 
you can use the mask created by the 
rendering process to add a background to 
your illustration.

Effect

contro

Objects 
the mod
perspect
and out 
perspect
renderin

You wan
lighting 
renderin
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e 

 

Edit menu> Copy

 

.

e now done with this file.

  

the background image. (The image 
re pasting onto.)

  

e 

 

Edit menu> Paste

 

.

asted selection comes into the 
 as an image floater.

  

he floater where you want it.

 

e documentation that came with your 
ting application for additional information 
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To set up a scene to render with a mask:

1When you’re ready to render your scene, 
display the Scene Settings window: 
Output tab: File Format controls.

Use the file format controls to select a format 

• For the Ray Tracer renderer, enable 
Adaptive Oversampling option at Fast or 
Best quality.

• For the Adaptive renderer, enable the 
Antialiasing option with Edges or Best 
setting.

To composite using Fractal Design 
Painter:

This procedure uses Painter as the post-
production application. The steps in Adobe 
Photoshop would be nearly identical.

1Render the scene—either directly or 
through the Batch Queue.

6Choos

You’r

7Open 
you a

8Choos

The p
image

9Drag t

Refer to th
image-edi
king with masks and channels.

ng Images
 have image filters for Adobe 
op, either from Adobe Systems or 
hird-party. You may use these 
rectly from Ray Dream Studio 5.

-in filters are compatible with Ray Dream 
owever, filters that specifically require 

otoshop are not.
2Make sure the selected file format 
supports saving multiple channels. 

Painter (RIF), Adobe Photoshop, and 
TIFF are good choices.

3Display the Scene Settings window: 
Output tab: G-Buffer controls.

4Enable the Mask checkbox.

5For best results, render with Adaptive 
Oversampling/Antialiasing.

• Display the Scene Settings window: 

that supports multiple channels. 2If you rendered directly, save the image 
to a convenient location. Verify the file 
format before saving. 

3Open the rendered image in Fractal 
Design Painter (or another image-editing 
application).

The mask generated during the 
rendering appears in the Mask List 
palette.

4Choose Select menu> Load 
Selection.

5In the dialog, make sure the mask is 
selected in the pop-up. Click OK.

about wor

Filteri
You may
Photosh
from a t
filters di

Most plug
Studio 5; h
Adobe Ph
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ilters you must first identify the 
ntaining your plug-in modules 

 If you plan to share plug-ins 
Chap

Renderer tab. 
Painter selects the objects of your 
rendering.

To use f
folder co
(filters).



   

between applications, make sure you move 

                                              

3

 

Pop-up the disk icon and choose 

 

Filter

 

 
 the menu. 

Dream Studio displays the list of 
lable filters appears.

  

ct one of the filters.

 

ced Filter Techniques

 

n use the G-Buffer data as a control 
m for certain types of image filters 
ects.

mple, the Distance G-Buffer data 
be useful for developing an image 
des or blurs in the distance.

 little imagination, you’ll discover 
nteresting ways to use G-Buffer data 
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all your plug-ins into a single folder so that 
Ray Dream Studio 5 can find all of them.

To identify the folder containing your 
plug-in modules (filters):

1Choose File menu> Preferences.

2Choose Imaging, Scratch Disk from the 
pop-up.

If you add additional filters to your plug-in folder, you 
will need to re-identify the folder before you can use 
the filters.

When you have identified the plug-ins for 
Ray Dream Studio 5, you can use them on 
an image in the Image window, in the 
Shader Editor on texture maps, in render 
effects or on backgrounds and backdrops. 

To use filters on the background or 
backdrop (before rendering):

1Display the Scene Settings window: 

from

Ray 
avai

4Sele

Advan

You ca
mediu
and eff

For exa
might 
that fa

With a
other i
age-editing application, like Painter 
be Photoshop.
3Click Set Directory.

4Use the dialog to locate and select the 
folder containing the plug-in modules.

Use the plug-in controls to locate and load 
plug-in filters.

Effects tab: Background or Backdrop 
controls.

2Pop-up the disk icon and choose Filter 
from the menu. 

Ray Dream Studio displays the list of 
available filters appears.

3Select one of the filters.

To use a filter in the Shader Editor:

1Display the Current Shader Editor.

2Select the channel containing the texture 
map you want to filter.

in an im
or Ado
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Load Selection

 

.

an replace the current selection.

hould have marching ants roughly 
ibing the G-Buffer data. The 
ing ants follow a line, but the 
ion data is 8-bit.

  

e current color to black and fill the 
ion.

ives you a grayscale image derived 
he G-Buffer data.

 

tion Post Production

 

e post-production work on 
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In Painter, G-Buffer data appears in the 
mask channels. Many effects let you choose 
from these masks on the Using pop-up.

When you render an image, you can 

In some cases, you’ll want to load the mask 
as a selection to control an effect.

You can adjust the brightness, contrast of the 
mask to create depth in a flat image.

4Click 

You c

You s
descr
march
select

5Set th
select

This g
from t

Anima
For som
ns, you’ll want to use Fractal 
ainter. Painter opens either movie 
equenced files, so you may render 

y Dream Studio animation to either 
For the best quality, use 
ressed, sequenced files.

an use Painter to composite 
tions with background stills, video 
er animations. To do this, you’ll 
o make sure to include a mask when 
nder the animation. 

an apply image effects to an 
tion and add special effects with 
rs. 

an paint directly onto an animation 
any of Painter’s fabulous brushes.
generate Distance G-Buffer data which can 
then be used in Painter to make your image 
appear to fade.

Some G-Buffer data may be difficult to use 
from a mask, and you’ll want to move it 
onto the Canvas image layer. 

To convert a mask channel to an image 
in Painter:

1Remove the rendered RGB image.

2You can choose Select menu> Select 
All then Edit menu> Cut. (If you prefer, 
you can float the image, then hide the 
floater.)

The canvas should be white.

animatio
Design P
files or s
your Ra
format. 
uncomp

• You c
anima
or oth
want t
you re

• You c
anima
floate

• You c
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Chap

In Painter, the Distance G-Buffer data 
appears as a mask.

3In the Mask List, select the mask for the 
G-Buffer channel you want to use. 



   

•

 

You can use cloning to convert the 
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imagery to a Natural-Media style—
watercolors, for example.

You’ll find detailed instructions for these 
and other techniques in your Fractal 
Design Painter User Guide.

You might want to use Adobe After Effects 
for some animation post-production tasks. 
You’ll need a movie-editing application, like 
Adobe Premiere, to edit animation clips 
together and synchronize sound effects.

Printing Images
You can print your rendered images 
directly from Ray Dream Studio 5. If you 
require color separations, you’ll have to 
work with your image in a pre-press 
application.

To print an image from Ray Dream 
Studio 5: 

With the Image window active, choose File 
menu> Print.

Ray Dream Studio displays the standard 
Print dialog. Refer to your system 
documentation for more information.
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A

 

Using Ray Dream 
Studio with 
other 
Applications

 

Introduction to the Work 

 

Flow

 

In many cases, you’ll use files from other 
programs when you develop your Ray 
Dream Studio scene. These files may be 
images used in shaders or a backdrop. 
They might also be models created in 
another program.

And when you finish your scene, you’ll 
generate some kind of output—a rendering 
or animation that you’ll do post production 
on; or maybe you’ll export 3D data for use 
in another program.

This chapter discusses importing and 
exporting 2D artwork and 3D models. It 
suggest methods of working with other 

ions that will help you get the most 
y Dream Studio. 
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Appendix A • Using Ray Dream Stu

applicat
out of Ra



   

Working with 2D Programs

             

Importing Images

                                 

Exporting Images 

 

eam Studio saves rendered images 
riety of popular formats. In addition, 
g Adobe Photoshop-compatible 

 plug-ins, you could output rendered 
 with an export plug-in. 

 

ort image files using an Adobe 
hop-compatible export plug-in:

  

e the 

 

Export Plug-ins

 

 in your plug-ins 
r and identify the plug-ins folder to 

Dream Studio. Refer to “Using Plug-
ith Ray Dream Studio” on page 23.

  

e sure that the 

 

Image

 

 window 
aining the image that you wish to 
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Importing Shapes from a 2D Art 
Program
You can import line art for cross sections, 
extrusion paths, and envelopes into the 
Free Form modeler. 

Ray Dream Studio can import the following 
formats:

• Macintosh Adobe Illustrator 1, 88, 3, 5, 
5.5.

• Windows Adobe Illustrator 1, 88, 3, 4; 
Corel DRAW 3, 4; WMF; and CGM.

Ray Dream Studio can open image files in a 
wide range of popular formats. 
Additionally, Ray Dream Studio supports 
Adobe Photoshop-compatible plug-ins for 
importing, filtering, and exporting image 
files. 

For example, with an appropriate plug-in, 
you could scan an image directly onto an 
object as a texture map. 

To import image files using an Adobe 
Photoshop-compatible acquire plug-in:

1Place the Acquire Plug-ins in your plug-
ins folder and identify the plug-ins folder 
to Ray Dream Studio. For instructions, 

Ray Dr
in a va
by usin
export
images

To exp
Photos

1Plac
folde
Ray 
Ins w

2Mak
cont
rt is active.

ose File menu> Export.

ct the Export Plug-in from the list.

ing with Painter
l Design Painter is a full featured 
g and image-editing application. 

n use Painter for developing texture 
gels, backgrounds, backdrops and 
eatures that use 2D bitmap images 
ies.

 can also use Painter’s Shapes tools 
sign cross sections, extrusion paths, 

envelopes for the Free Form modeler. 
You can use any program that exports 
artwork in Adobe Illustrator format. Fractal 
Design Expression and Fractal Design 
Painter both export in this format, and you 
may have other applications that support 
it.

After you’ve created the artwork and 
exported it in Adobe Illustrator format, you 
can import the file into Ray Dream Studio.

For instructions on importing paths, refer to 
“Importing Shapes” on page 124.

refer to “Filtering Images” on page 375.

2Display the map controls where you will 
be using the image—Scene Settings: 
Effects tab: Background/Backdrop, 
Current Shader Editor, (Light) 
Properties: Gel tab.

3Pop-up the disk icon and choose Import 
from the menu.

4Select your Acquire plug-in and use it to 
import the image.

Note: You might prefer to scan images into 
your image-editing program, where you can 
take advantage of cropping and retouching 

expo

3Cho

4Sele

Work
Fracta
paintin

You ca
maps, 
other f
or mov

• You
to de
and 
ose File menu> Export> Adobe 
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setting your options, click 

 

OK

 

.

ream Studio adds the object or 
l to the scene.

 

r Files

 

esign Detailer’s native file format 
ietary to Detailer. You’ll use this 
nly when working with Detailer.

 

iles

 

 a 3D file format, developed by 
nd supported by many 
ions. 3DMF includes UV 
ates (from most applications), so 
 use Parametric mapping on the 
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Illustrator File to create a file you can 
import into Ray Dream Studio for its 
Bézier curves.

• You can use Painter for post-production 
work, like image effects, retouching, or 
compositing a rendered scene with other 
material—either a single frame or in a 
movie. 

Painter’s native file format is RIFF. Ray 
Dream Studio supports this format, so 
you’ll have no trouble moving images 
between programs. You may also use any 
of the other formats supported by both 
programs.

Painter can open either a sequenced file set 
(numbered frames) or movie file animation. 

information with your rendered image. You 
can then use this data when working in 
your 2D program.

For more information, refer to “G-Buffer” on 
page 365.

Working with 3D Programs

Importing Objects
Ray Dream Studio can open Detailer native 

4After 

Ray D
mode

Detaile

Fractal D
is propr
format o

3DMF F

3DMF is
Apple, a
applicat
coordin
you can
objects.
xture maps are not imported.

DMF options:

e scaling units and conversion 

F Options dialog can be used to set 
hen youimport a 3DMF object.
If you are going to use Painter to do post 
production on an animation, you should 
use sequenced files, not a (compressed) 
movie format. You’ll want to retain as much 
image quality as possible. Painter converts 
the animation to a frame stack. 

When you export the animation (Save As) 
from Painter, you can choose either a 
movie file format or numbered frames.

G-Buffer Channels

Fractal Design Painter and Adobe 
Photoshop both support multiple channels 
of data. Using Ray Dream Studio’s G-Buffer, 
you can include alpha channels and other 
channels of geometric or distance 

format, 3DMF, DXF and files created in 
previous versions of Ray Dream Studio or 
Designer.

To import an object/model file: 

1Choose File menu> Import. Ray Dream 
Studio displays an Open dialog which 
you can use to select the file.

2If you want to narrow the list to a certain 
format, use the pop-up to switch from All 
Readable Files to the format you want to 
search for.

3When you have located the file, click 
Open. Ray Dream Studio displays the 

Note: Te

To set 3

1Set th

The 3DM
options w
dio with other Applications 381
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options dialog, which depends on the file 
type. The options are described below.

factor



   

Appropriate values will depend on the 

         

with separate objects in separate layers. 
 in separate layers are assumed to 
 to different objects. 

his may not always be the case, 
r feature is provided: 3D facets with 
nt colors are assumed to belong to 
nt objects. Objects in the same layer 
de of different colors will be 
ed as separate objects. 

porting creates a rather flat 
hy. Objects found in a single layer 
uped.

 

 DXF options:
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object and application that created it. 
Use trial and error to determine a good 
setting.

2Enable Ungroup as much as possible to 
reduce the levels of grouping.

This is a good idea if you want to shade 
or animate individual pieces of the model 
separately.

DXF Files

DXF is a public export text file format used 
by Autodesk and other CAD vendors. 
Because it is widely supported by 
animation, 3D modeling and rendering, and 
CAD programs, DXF may be used for 

It’s important to realize that a perspective drawing is 
still a flat 2D drawing. In other words, an object drawn 
in perspective does not contain any 3D data. As such, 
the object cannot be observed from a different 
perspective without being redrawn from scratch. On 
the other hand, 3D models can be viewed from any 
direction.

Ray Dream Studio can import both 2D and 
3D DXF data. However, since Ray Dream 
deals exclusively with 3D data, 2D DXF data 
is automatically extruded to generate 3D 
objects. 

AutoCAD® and several other CAD software 

Facets
belong

Since t
anothe
differe
differe
but ma
import

DXF im
hierarc
are gro

To set
le the Import and extrude 2D 
cts option to extrude 2D DXF files. 

 is useful to automatically build the 
ls” of a floor map done in 
isCAD™, Vellum™ or AutoCAD, and 
rted as a DXF file. 

F Options dialog can be used toset 
 whne you import DXF onjects.
importing and exporting objects between 
Ray Dream Studio and other applications. 

When it was first created, DXF was only a 
2D format. Later, it was improved to 
include 3D information. As a result, a DXF 
file can now simultaneously contain both 
2D and 3D data. DXF is pure geometry. It 
carries no shading, lights or cameras.

applications use layering to separate 
groups of objects. Unfortunately, layering 
is the only way for DXF to support separate 
groups of objects. Imagine a glass and a 
bottle grouped in the same layer. When 
writing the DXF file, AutoCAD and other 
CAD products will simply combine the 3D 
facets of both objects into one unit of 
information. In other words, once the file is 
saved, there is no way to tell the difference 
between the facets belonging to the glass 
and the facets belonging to the bottle. This 
is because the DXF file format does not 
support the higher level notion of an 
“object.”

To work around this, models and scenes 

1Enab
obje

This
“wal
Clar
expo

The DX
options
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created in DXF-compatible packages 
should, whenever possible, be designed 



                               

lly when importing a DXF file, you will see 
cts in Ray Dream Studio. If that happens, go 
e original program and select the 
e options to save the data as 3DFace 

  

g Imported Objects

 

ric mapping is the standard 
of mapping shaders and paint 
nto objects created in Ray Dream 
arametric mapping requires 

information on an object’s 
e. For this reason, parametric 
 is sometimes not available for 
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• Set an extrusion value. The units are 
based on the system that was used in the 
original file.

2Enable the Smooth Surfaces option to 
have smooth shading on surfaces. 

• Set a minimum smoothing angle. For 
example, with a 30 degree smooth angle, 
the surface at the junction of any two 
facets with less than 30 degrees of 
difference will be smoothed. 

3Enable the Group all 3DFACE in a single 
object option to group all imported 3D 
faces (3DFACE is a 3D face with 4 
vertices) in one single object.

If you are not familiar with AutoCAD and/
or do not want to worry about this 
option, leave the WORLD system 
selected. WORLD stands for the WCS 
(World Coordinate System), and 
CURRENT for the UCS (User Coordinate 
System) used when the DXF file was 
saved.

Not all CAD software uses both UCS and 
WCS. Many use only WCS. If this is the 
case, simply leave the WORLD 
coordinate system selected.

5Use the Scaling Conversion Factor to 
relate the scale of the original DXF 
drawing to a real value.

Occasiona
many obje
back to th
appropriat
entities.

Shadin

Paramet
method 
shapes o
Studio. P
precise 
structur
mapping
imported from other applications. 
ects do not support parametric 
.

etric mapping isn’t available, you 
e the imported object using one of 

ojection mapping modes: Box/
herical or Cylindrical.

ation on selecting a projection mapping 
r to “Mapping Modes” on page 193.
This is useful when importing 3D type, a 
logo or a CAD object that benefits from 
being treated as a single object.

4Enable the Separate 3DFACE by Layers 
and Color option if objects need to be 
separated by layers and colors. 

When this option is selected, 3D faces 
that are in the same layer and of the 
same color will be treated as a single 
object. 

Import only 3DFACE entities Enable this 
option to exclude other information, like 
lines or 2D layout drawings.

Coordinate System to use Any AutoCAD 

Select the appropriate units, then enter a 
value in the 1 DXF unit equals____ field.

If your DXF files do not import correctly into Ray 
Dream Studio, verify that the DXF file contains only 3D 
faces, meshes, or extruded poly-lines. DXF files 
containing points, lines, and arcs are not supported by 
Ray Dream Studio. Check the documentation of the 
software application that created the DXF object for 
information about saving DXF files so that they do not 
contain lines, arcs, or points.

objects 
DXF obj
mapping

If param
can shad
three pr
Face, Sp
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coordinate system stored in the DXF file 
imported can be used. 



   

Exporting 3D Files

                                         

5

 

Enter a file name, select the destination, 4Use the Colormap UV resolution fields to 
he map’s resolution (pixels) in each 
nsion.

hen writing 3DMF files, objects are 
 as primitives whenever possible.

l Reality Modeling Language 
)

is the language used to create 3D 
 on the World Wide Web. When you 
site created with VRML, you have the 
 to interact with that site in 3D.

eam Studio’s allows you to design 
wn 3D web site and then export it 
y to the VRML format.

s and other entities in VRML are 
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To export the scene:

1Open the scene you want to export.

2Choose File menu> Save As. The Save 
As dialog appears.

3In the dialog, use the menu to select the 
export file format.

4Click Options and set options for the 
exported data. The options are 
described below. 

5When you’re done with the Options 
dialog, click OK to close it.

and click Save.

Detailer Format Options

The Detailer format is exclusively for 
working with Fractal Design Detailer. Refer 
to Appendix B in your Detailer Users Guide 
for complete information.

DXF Options

DXF has no options. 

When exporting in DXF mode, each object 
is put in a separate layer, and the facets are 
stored as 3DFACE entities.

3DMF Options

3DMF is part of Apple’s QuickDraw 3D 

set t
dime

Note: W
written

Virtua
(VRML

VRML 
spaces
visit a 
ability

Ray Dr
your o
directl

Object

d to as “nodes.” The VRML format 
s several types of nodes.

eam Studio's VRML export filter 
rts the following nodes:

 Nodes

e (primitive)

e (primitive)

der (primitive)

re (primitive)

xed Face Sets is used for Free Form 
cts, Mesh Form objects, Text objects, 
cosahedra primitive, and any 
itive objects that have been 
6Enter a file name, select the destination, 
and click Save.

To export objects:

1Select the object or group you want to 
export.

2Choose File menu> Export. The 
Export dialog appears.

3Use the pop-up to select the export file 
format.

4Click Options to set options specific to 
this format. The options are described 

Metafile format. Support of this format 
allows better exchange of objects between 
applications and platforms.

1Enable Force Béziers to Polygons if you 
want to use polygons to approximate 
Bézier curves.

2Click a radio button to select the degree 
of tessellation you want.

The High setting creates the most 
polygons, which produces more 3D 
detail.

3Enable Export UV Colormap if you want 
to export a surface map of the object’s 
shading color. 

referre
feature

Ray Dr
suppo

Shape

• Con

• Cub

• Cylin

• Sphe

• Inde
obje
the I
prim
rmed
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RML export options:

e Maximum resolution field to set 
aximum dimension of texture 

 size or distance threshold (see 
s specified, the texture maps for 
jects may be at a lower resolution.

e the External option if you want 
xture maps saved as separate files. 
checkbox is not set, the image data 
ed within the VRML file.

indows, external texture map files 
 named Image###.jpg, where ### 
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With this node, you have some control 
over polygon count to specify the 
smoothness of surfaces.

• Coordinate3 is used in conjunction with 
Indexed Face Set node to store 
geometrical information.

Shaders & Textures

• Texture 2 represents the effects of 
shaders.

• TextureCoordinate2 controls the way 
that textures are used to approximate 
procedural shaders.

Cameras & Lights

• LOD represents an object with a precision 

• WWWAnchor links the VRML scene to 
another scene.

• WWWInline includes a VRML object that 
exists elsewhere on the World Wide Web.

To set URL properties:

1Select an object.

2Display the Properties palette: URL 
tab.

3Type in a URL.

4Select either Anchor or Inline.

• If an object is an anchor, then it can be a 

To set V

1Use th
the m
maps.

Note: If a
below) i
some ob

2Enabl
the te
If the 
is stor

On W
will be
cimal number starting at 000. 

her systems the files are named 
###.jpg, where Base is the name 

 VRML file. 

e of that name exists, it will be 
ed, so it is a good idea to save a 
 file to its own folder.

 are saving texture maps externally, 
the URL prefix appropriate to 
ng the files.

nformation will be necessary for 
ML to locate (and load) the 

s.
that depends upon the distance to the 
camera. This is important in order to 
maintain browser speeds in complex 
online worlds.

• Orthographic Camera represents an 
isometric camera.

• Perspective Camera represents a conical 
camera.

• Point Light represents bulb lights.

• Spot Light represents spot lights.

• Directional Light represents distant 
lights.

Miscellaneous

• Separator groups other nodes into a 

link to another URL, an HTML function, an 
animation, etc. 

• If your object is defined as an inline 
object, it links back to another VRML file 
where the object itself is stored. 

Essentially, an inline VRML object is a 
place holder creating a link back to a 
different file. With this arrangement, you 
can update an object in a Virtual World 
without rebuilding an entire page—you 
simply replace the inline object.

Note: VRML does not support all features 
available in Ray Dream Studio. Therefore, 
some information may be discarded when 
you export in VRML.

is a de

On ot
BaseIm
of the

If a fil
replac
VRML
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enter 
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single entity.
Note: Some VRML browsers do not support 
all features of VRML.



4Click a radio button to select the degree Set the Levels of detail to describe the 8Enable the Remove white space option if 
want the VRML file stripped of 
aneous spaces.

oving the spaces lowers the file size 
tly.

paces are used in the VRML file to 
he hierarchical structure. This 
 the file easier to read and edit in a 
itor.

n you’re finished setting VRML 
ons, click OK.

 Texture Mapping in VRML

2.0 specifies that a texture map is 
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of tessellation you want for non-
primitives.

The High setting creates the most 
polygons, which produces more 3D 
detail. The size and distance thresholds 
(see below) also effect the degree of 
tessellation.

VRML supports Cones, Cubes, Cylinders 
and Spheres as primitive objects. All 
other shapes are created by a collection 
of polygonal facets.

5Set a Size threshold if you want smaller 
objects to use a smaller texture map or a 
lower degree of tessellation. 

number of reduced resolution levels 
beyond the Distance threshold.

The ranges are centered on the object, 
and each range is double the distance of 
the inner range. 

For example, if the distance threshold is 
12 inches and there are four levels of 
detail, the four ranges are as follows:

Range 1 0 to 12 inches (full resolution)

Range 2 12 to 24 inches (reduced 
resolution)

Range 3 24 to 48 inches (resolution 

you 
extr

Rem
sligh

Note: S
show t
makes
text ed

9Whe
opti

About

Cube

VRML 

 individually to each face of a cube. 

eam Studio applies the texture that 
ned to the ‘Front’ face of a Ray 

 Studio cube to each of the faces of a 
cube. 

etric mapping in Ray Dream 
left) and what happens in VRML 

.

ay Dream in VRML
Any objects smaller than the threshold 
will be represented by a coarser 
approximation. The coarseness is 
determined by the ratio of the object’s 
size to the threshold value. For example, 
if the threshold is 12 inches, an object 6 
inches across is likely to be represented 
at half the normal resolution. However, 
the relationship is not exact.

6Set a Distance threshold if you want 
objects farther from the camera to have 
a lower resolution. 

Objects within the threshold have full 
resolution. Objects beyond the threshold 

reduced further)

Range 4 48 inches and beyond 
(resolution reduced even further)

Note: If a VRML browser is capable of using 
Levels of Detail, the overall performance is 
likely to be better.

7Enable the Tessellate option for any of 
the primitives you want better control of 
for texture mapping. See below for 
details.

If the checkboxes Cones, Cylinders, 
Cubes or Spheres are enabled, the object 
is exported as a set of tessellated facets, 
rather than as a primitive. 

applied

Ray Dr
is assig
Dream
VRML 

Param
Studio(
(right)

in R
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have reduced resolution.



ream Studio’s parametric texture 
ing can be directly converted to 
 2.0.

 Ray Dream Studio 
Detailer

esign Detailer is a graphics 
 dedicated to developing surface 
 your objects. Detailer offers 
eled art tools and features that will 
 create extraordinary maps for 
mp, highlight, reflection and glow. 
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Only the portion of the image denoted by 
“Front” is used (on each face) by the VRML 
mapping on a cube primitive. 

You can override this by enabling the 
Tessellate: Cubes option (step 7). 

Right

Back

Top

Left Front

The VRML exporter ensures that the Ray 
Dream texture mapping on the sides of 
the cylinder matches that of the VRML 
object. However the texture of the top 
and bottom faces will be different.

You can override this by enabling the 
Tessellate: Cylinders option (step 7).

Cone

VRML 2.0 specifies that the image texture 
is wrapped around the curved sides of 
the cone. The texture applied to the 
bottom of the cone is taken from the 
same image that is applied to the curved 
sides of the cone.

Sphere

Ray D
mapp
VRML

Using
with 

Fractal D
product
maps on
unparall
help you
color, bu
am Studio supports the Detailer file 
 so you can take your Ray Dream 
bjects into Detailer and bring your 
 surface maps into Ray Dream 

ific instructions on using Ray 
tudio and Detailer together, see 
ix A of the Detailer User Guide. 

am Studio now supports the RIFF 
at, used by both Painter and 
. (The Detailer 1.0 User Guide says 
 Dream Studio 4.1 doesn’t.)
Cylinder

VRML 2.0 specifies that the image texture is 
wrapped around the curved sides of the 
cylinder. The texture applied to the ends of 
the cylinder is taken from the same image 
that is applied to the curved sides of the 
cylinder.

This is different from what Ray Dream 
Studio normally does. Ray Dream Studio 
applies the central portion of the image 
to the curved sides of the cylinder and 

The image layout for parametric mapping on 
a cube in Ray Dream.

Bottom This is different from what Ray Dream 
Studio normally does. Ray Dream Studio 
applies the upper portion of the image to 
the curved sides of the cone and uses the 
lower portion of the image on the 
bottom.

The VRML exporter ensures that the Ray 
Dream Studio texture mapping on the 
sides of the cone matches that of the 
VRML object. However the texture of the 
bottom face will be different.

You can override this by enabling the 
Tessellate: Cones option (step 7).

Ray Dre
formats,
Studio o
Detailer
Studio.

For spec
Dream S
Append

Ray Dre
file form
Detailer
that Ray
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uses the upper portion of the image on to 
the top and the lower portion on the 
bottom of the cylinder.



Using Ray Dream Studio Importing a Poser Figure
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with Poser

Exporting Poser Figures for Ray Dream 
Studio

You can export a Poser figure in 3DMF 
format, then import this file into Ray Dream 
Studio.

When you export the figure, Poser gives 
you the option of exporting groups for each 
body part. 

• If you want to keep the pose, don’t enable 
this option. In this case, you’ll be able to 
use one texture map to cover the entire 

In the 3DMF import options dialog, set 1 
3DMF unit to equal 8 feet. This should give 
a reasonable size to the imported figure. 
You can, of course, scale the object after 
it’s imported.

When the figure comes into Ray Dream 
Studio, it will be lying on its back. To stand 
it up, set its Properties palette: 
Transform tab: Orientation: Roll to 
90.

Adjust Properties palette: Transform 
tab: Orientation: Yaw to change the 
direction the figure faces.

Texture Maps on Poser Figures
figure.

• If you want to work with each body part 
separately, enable this option. 

You’ll need to move each part’s hot point 
to the joint and establish links and limits 
to get any sense of articulation. To do 
this on the entire figure would be 
tedious, and the results would not match 
what you get in Poser.

You can use Parametric Mapping as the 
mapping type on Poser figures that were 
imported from a 3DMF file. This mapping 
will offer the best results.

You can use one of Poser’s default texture 
maps or create your own map, using one of 
the default maps as a template.
388 Ray Dream Studio User Guide
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Glossary

 

Introduction

 

This Glossary provides an alphabetical 
listing of the special terms used in 
describing 3D modeling and animating.
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A

                   

Axis

 

A hypothetical linear path. The X, Y, 

         

image provides over 16 million colors: 8 
e used for red, 8 are for blue, and 8 
en. 

  

A pixel-based image. 

 

n

 

An object created by combining 
jects using mathematical operators 
ans). The two objects may be 
cted one from another, merged or 
cted to form the Boolean object.

 

ing Box

 

A hypothetical box drawn 
 an object or group of objects. A 

ing box is the smallest rectangular 
which the object (or group of 
s) fits completely. The bounding box 
llel to the axes of the object. The 
ing box is shown (around the 
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Alignment, relative Setting two or more 
objects to some meaningful spatial 
relationship, such as centering them or 
distributing them evenly along a line. 

Alignment, text Text alignment affects 
text objects of more than one line. The 
lines of text may be aligned to their left 
edge, their center, or to their right edge. 

Alpha Channel The top byte of a 32-bit 
pixel that is used for data other than color. 
The channel may hold mask or 
transparency data.

Ambient Light That light responsible for 
the overall, diffuse lighting of a 3D scene. 

and Z axes (width, height, and depth, 
respectively) define the directions of the 
3D universe. The axis along which an object 
is rotated is the axis of rotation. An object’s 
axes are parallel to its bounding box.

B
Backdrop A picture that is automatically 
composited behind a 3D scene. The matte 
paintings used in traditional movie making 
are a good example of backdrops. 

Background, reflected Reflected 
backgrounds are 2D images that show up 
on reflective surfaces (metal, glass, etc.). 

bits ar
for gre

Bitmap

Boolea
two ob
(Boole
subtra
interse

Bound
around
bound
box in 
object
is para
bound
w of selected objects and groups) in 
rspective window, and it is the 
ing box—not the object itself—that 
 the projections onto the working 

id. 

An object linked to another object 
rent) in the hierarchy. When the 
 is moved, the child and all 
children” go with it. The parent-child 
used to enable articulation of 
ex objects. 

ar Two or more objects that are in 
Similar to daylight in the real world.

Anti-aliasing Intermediate colors (or 
shades of gray) in the pixels between 
contrasting colored regions. Anti-aliasing 
improves the appearance of objects in 
renderings by removing jagged, “stair-step” 
edges. 

Aspect Ratio The ratio of the width of an 
image to its height (x:y). For example, the 
aspect ratio of an image 640 x 480 pixels is 
4:3. 

Atmospheric Effects Atmospheric 
conditions or phenomena that affect the 
clarity or mood of a scene. Fog and smoke 
are good examples of atmospheric effects. 

Reflected backgrounds increase the 
realism of such surfaces. Reflected 
backgrounds are also knows as 
environment maps.

Bézier Curve A path defined by the 
position of four control points (at the ends 
of the tangents of the vertices). The length 
and angle of the tangents describe the 
deviation from a linear path that the curve 
follows between vertices. 

Bit Depth The number of bits used to 
define the shade or color of each pixel in an 
image. A 1-bit image is black and white. An 
8-bit grayscale image provides 256 shades 
of gray (2 to the 8th power is 256). An 8-bit 
color image provides 256 colors. A 24-bit 

previe
the Pe
bound
“casts”
box gr

C
Child
(its pa
parent
“grand
link is 
compl

Coline

e line.
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Attitude See Orientation. the sam



                               

 much like a movie camera can 
n a tripod to follow a moving 
inally, Track moves the camera in 

perpendicular to the direction in 
e camera is pointing.

  

 standard 3D file format originally 
ed by Autodesk, makers of 
, for the purpose of exchanging 

a between various 3D software 
ions. Widely used as a poor man’s 
e file format, DXF only offers 
 for basic geometric information 
ures). 
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Color, CMYK The subtractive color 
model, used in printing. Colors are created 
by assembling different densities of cyan, 
magenta, yellow, and black pigments on a 
surface. When white light strikes the 
surface, only specific bandwidths are 
reflected—depending on the density of the 
specific pigments. The reflected 
bandwidths create the perceived color. 
The CMYK model is called the subtractive 
model because the pigments subtract (by 
absorption) the bandwidths of white light 
that do not contribute to the specified 
color. 

Color Depth See Bit Depth. 

Color, RGB The additive color model, 

Control Points The “knobs” at the ends of 
Bezier tangents used to adjust a Bezier 
curve. 

Co-planar Occurring in the same plane. 

Cross Section One of the planes on which 
two-dimensional shapes are drawn in the 
Free Form modeler to create a three-
dimensional object. Objects have two or 
more cross sections. 

D
Deformers Properties that can be applied 
to any object (or group of objects) to 
deform its geometry. Asymmetric scaling, 

a scene,
rotate o
object. F
a plane 
which th

DXF A
develop
AutoCAD
CAD dat
applicat
exchang
support
(no text

E

n The method of creating a 3D 
y moving a 2D cross section along a 
e sweep path). The Free Form 
 uses this method.

he back (first cross section shape) 
(last shape) of an extruded object. 

A mathematical expression that, 
ut, returns a meaningful set of 
ormulas may be used to create 

 define a tweener curve, or create a 
ttern in a shader, gel, background 
used in computer monitors. Colors are 
created by adding varying degrees of red, 
green, and blue light. For information on 
the “varying degrees,” refer to Bit Depth. 

Complex Object An object constructed of 
several simple objects that are linked or 
grouped. For example, a telephone—
comprised of the grouped, simple objects: 
cord, handset, and cradle—would be 
considered a complex object. 

Component, shader An elementary 
building block of a shader tree. 

Concentric Having the same center. 

Constrain To restrict object movement to 
a particular plane, axis, or angle. The 

bend, twist and shatter operations are 
examples of deformers available in Ray 
Dream Studio 5.

Dithering The process of approximating 
pixel colors when reducing the color depth 
of an image or mapping to a different 
palette. Dithering can improve transitions 
between colors when reducing a 24-bit 
image to 8-bit format. 

Dolly, Pan and Track The computer 
equivalents of the real world camera 
movement commands. With Dolly, the 
camera moves around in 3D space as if 
gliding on the surface of a sphere that has 
the object of interest as its center. 
Inversely, using Pan, the camera acts as the 

Extrusio
object b
path (th
modeler

F
Face T
or front 

Formula
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rop.

working box is the primary tool for 
constraining an object. 

“center of the sphere” and rotates at a fixed 
position in space to track an object or view 

or backd



   

Free Form modeler

 

A modeler that uses 

              

H

                

Key Event

 

A moment in the animation 
an object’s characteristics change. 
ents are marked on the time track 
h animatable property.

  

g

 

Leading determines the vertical 
between lines of text. The default 
 value is 120% of the font’s point 

ecreasing the percentage makes 
l spacing more compact, while 

sing the percentage expands it. 

 

Spacing

 

Letter Spacing adjusts the 
ntal spacing between characters in 
re word, line, or text block. A 
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cross sections, sweep paths and scaling 
envelopes to create 3D objects. 

G
G-Buffer (Geometry Buffer) A type of 
information carried on optional channels of 
a rendered image. The G-Buffer carries an 
aspect of three dimensionality with the 2D 
rendering. This can assist 2D filters and 
paint tools during retouching.

Global Mixer A shader component that 
mixing all channels of its two component 
shaders. 

Hierarchy The tree structure in the Time 
Line window that lists the objects in the 
scene and shows their logical relationships 
(links and groups). The hierarchy also 
includes listings for the animatable 
properties of each object.

Highlights Regions on an object where 
light reflects directly into the viewpoint. 
Highlights appear as bright spots on 
smooth/shiny objects and are almost 
nonexistent on rough/dull objects. 

Hot Point A special, active point inside, 
on the surface of, or near an object or 
group. The hot point is used as the 
reference for rotation and for some 

where 
Key ev
for eac

L
Leadin
space 
leading
size. D
vertica
increa

Letter 
horizo
an enti
e value decreases spacing, while a 
e value increases it.

A variety of child/parent 
nships and constraints on relative 
 to simulate traditional, real world 
nical links. Shafts, axis, and ball 
re examples of links.

The mask is a grayscale image, 
 in channel 4 of a rendering, that 
es where objects are versus where 
e not. In a 2D image-editing program, 
sk is used to generate a selection, 
Global Universe The Global Universe is a 
Cartesian coordinate system with the 
origin of the X, Y, and Z axes (0, 0, 0) at the 
center of the universe. The Global Universe 
is fixed and is not affected by changes 
made to the working box. 

Glow Channel A shading channel that 
holds data describing an object’s 
luminescence or “glow.” 

Grayscale An image in which the pixels 
are defined with 8 bits, which provides 256 
levels of gray. 

Group A set of collected objects. 
Grouping enables a set of objects to behave 
as one. 

positioning and alignment operations. In 
the Perspective window, the hot point 
appears as a small circle that is, by default, 
at the center of the object or group.

I-J-K
Icon A pictorial representation of a tool, 
object, file, or other program item. An item 
is selected by clicking once, or sometimes 
double-clicking, on its icon. 

Jaggies The appearance of “stair-step,” 
jagged edges in a pixmap image. Jaggies 
can be reduced with anti-aliasing. 

negativ
positiv

Links
relatio
motion
mecha
joints a

M
Mask
stored
describ
they ar
the ma
helps you composite your rendered 
with other background imagery. 
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 invisible paper that stretches 
 in two dimensions. In Ray Dream 
lanes are used to constrain the 

n of translation of an object. The 
 box shows the angle at which the 
nt planes are set. By default, the 
f the working box are set parallel to 
 of the current local universe. 

  

s a unit of measure, a point is 1/72 
h. Point also refers to Bézier vertex 
trol points. 

 

 View (also viewpoint)

 

The 
 and angle from which you view a 
he point of view (POV) is always 
 a camera. You may add several 
, positioned and angled differently, 
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Master Objects  A master object is the 
“mold” from which object instances are 
created. If a master object is modified, all of 
the objects derived from it are modified 
similarly. 

Motion Path A curve, visible in the 
Perspective Window, that shows where an 
object will move during the course of an 
animation.

N-O
Normal Vector A ray perpendicular to an 
object’s surface at a given point.

Object Any 3D volume or other item that 

orientation is its relation to other objects. 
An object’s relation to the viewpoint can be 
changed by moving the current camera. 

Oversampling Rendering at a higher 
resolution, then bringing the resolution 
back down to minimize artifacts like 
aliasing.

P
Pan See Dolly, Pan, and Track.

Penumbra The region of partial shadow 
at the edge of the full shadow. In Ray 
Dream Studio, you can achieve nice 
penumbras with the Soft DRT Shadows 

sheet of
infinitely
Studio, p
directio
working
constrai
planes o
the axes

Point A
of an inc
and con

Point of
position
scene. T
through
cameras
ch the Universe window POV 
 them. When you render an image, 
ose the POV from which the image 
e taken. 

, absolute The X, Y, Z coordinates 
ject’s hot point in the Global 
. 

, relative The placement of an 
 relation to another object. For 
, a book might be on top of a table.

The display of an object in the 
tive or Modeling window or the 
ip of a shader in the Browser. Also 
 a rendering with a low resolution 
appears in the universe, including cameras 
and lights. When objects are grouped, their 
group is also described as an object. 

Object/Group Coordinate System Groups 
and individual objects have their own local 
coordinate systems. The origin of a group 
or object’s coordinate system is at the 
center of its bounding box. The axes are 
parallel to the sides of the bounding box. 

Operator An operator is a shader shell 
that combines other shaders to form a sub-
shader. 

Orientation  The direction an object 
“faces” as defined by the compound effect 
of the object’s pitch, yaw, and roll. Usually, 

option for lights.

Pipeline An extrusion in which the cross 
section is always perpendicular to the 
sweep path.

Pitch The aspect of an object’s attitude 
that describes its angular deviation along 
its vertical (top-to-bottom) axis. 

Pixel (picture element) One dot in a 2D 
image. Computer images are created as an 
array of such dots, each having a specific 
color. See also Resolution and Bit Depth. 

Pixmap An image formed as an array of 
pixels. 

Plane A hypothetical, two-dimensional 

and swit
between
you cho
should b

Position
of an ob
Universe

Position
object in
example

Preview
Perspec
color ch
refers to
setting.
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the most important aspect of an object’s construct that may exist at any attitude in 
space. A plane can be envisioned as a flat 



   

Primitive

 

An object created by definition, 

            

Reference

 

A fixed point or plane used as 

                

Scaling, text

 

Scaling changes the width of 
ters without affecting their height. A 
elow 100% results in characters that 
rower than usual, while a value 
100% results in characters wider 
sual. 

  

A 2D path that may be open (a line) 
ed, such as an oval or a polygon. 
 are used in cross sections when 

ing. In shading, paint shapes are used 
ify regions for shading.

 

 Path

 

The curve or line along which 
 are extruded when modeling. Called 
eep or extrusion path, the path is 
 by one line on the bottom plane 

e line on the back plane in the 

 

ing

 

 window. The compound 
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rather than modeling. A primitive object 
cannot be “dismantled” into components. 
The Sphere, Cube, Cylinder, Cone and 
Icosahedra are the basic primitives in Ray 
Dream Studio. The environmental 
primitives include Fountain, Fog, Cloud and 
Fire.

Production Frame The computer 
equivalent of the viewfinder in a regular 
camera. The production frame can be 
thought off as describing the area of the 3D 
scene that will be rendered into an image.

Projection The silhouette of an object’s 
bounding box on one of the three visible 
planes of the grid. The hot point of the 
selected object or group also casts a 

the starting point for some operation. The 
hot point, the center of the bounding box, 
and the corners of the bounding box are 
common reference points. 

Reflection The phenomenon of light 
“bouncing off” objects. 

Refraction The phenomenon of light 
deflecting as it passes through a 
translucent object, like glass or fluid. 

Render The process of capturing a 2D 
image from a 3D scene. 

Resolution For an image, resolution is 
given as the number of pixels in each 
dimension. For devices, like a printer or the 
monitor screen, resolution is given in dots 

charac
value b
are nar
above 
than u

Shape
or clos
Shapes
model
to spec

Sweep
shapes
the sw
defined
and on
Model
ure of these two lines defines the 
self. 

e Map A 2D image used as a 
. 

ee-dimensional) An object or 
e that exists in the dimensions of 
 height and depth. 

agged Image File Format) An 
file format often used for transfer 
n applications or platforms. Ray 

 Studio 5 opens TIFF images in RGB 
projection. Projections are used for 
translation and rotation.

Properties The collection of 
characteristics applied to (or available for) 
an object. Properties for the selected 
object appear in the Properties palette. 

R
Ray Tracing A procedure for generating a 
rendering. The ray tracer sends 
hypothetical rays of light from the sources 
in the scene and calculates the visual 
effects, for each pixel in the rendering, as 
the rays encounter and reflect from the 

per inch (dpi) or dots per centimeter. 

Roll The aspect of an object’s attitude 
that describes its angular deviation along 
its lateral (side-to-side) axis. 

Root The root describes the highest level 
of the hierarchy, the universe. When you 
are “Jumped Into” a group, the group box is 
the highest level of the hierarchy, and 
therefore, the local root. 

S
Scaling, object The percentage an object 
is resized. Each object instance may be 

curvat
path it

T
Textur
shader

3D (thr
volum
width,

TIFF (T
image 
betwee
Dream
, but not in CMYK format. 
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objects in the scene. scaled from the dimension of its master, 
which has a scaling of 1. 

format



                                             

he aspect of an object’s attitude 
cribes its angular deviation along 
r (front-to-back) axis. 

  

A rendering technique that uses 
) information in sorting object 
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Tiling The technique of repeating a small 
image across a larger surface to cover it. 

Track See Dolly, Pan, and Track.

Translation Any manipulation of the 
position or attitude of an object. Also, an 
extrusion in which the cross section 
remains at one angle, regardless of the 
curvature of the sweep path.

Translucence The characteristic of an 
object that allows light to pass through it. 

2D (two-dimensional) An image, shape, 
path, or plane that exists in the dimensions 
of width and height only. 

Tweener A formula used to control the 

Vertex A control point on a path. Paths 
begin, change angle, and end at vertices. 

Viewpoint See Point of View. 

W
Wizards, modeling and scene Visual step-
by-step pictorials used to simplify a 
typically complex multi-stage process. The 
Modeling Wizard speeds the creation of 3D 
objects. The Scene Wizards facilitates 
setting up a scene with lighting and props. 
Wizards are great learn-by-example 
resources.

Word Spacing  Word Spacing adjusts the 

Y-Z
Yaw T
that des
its linea

Z-Buffer
z (depth
facets.
transition between two key events. 

U-V
Universe The 3D workspace, shown in the 
Perspective window. The Universe is where 
you place and position objects. It is the 
root of the hierarchy, and its coordinate 
system is absolute (doesn’t move or 
rotate). 

URL Uniform Resource Locator is the 
“address” of an item on the internet.

UV A 3D coordinate mapping system. UV 
coordinates are used in parametric 
mapping to align points on the shader with 

horizontal spacing between words. A 
negative value decreases spacing, while a 
positive value increases it.

Working Box The three visible grid 
planes in the Perspective window. Called 
the working box because you’ll move it as 
you work to constrain operations to certain 
planes. 

Working Box System The working box 
has its own coordinate system. The 
attitude of its axes and the position of its 
origin (at the center of the working box) 
change as you move and re-orient the 
working box. 
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C

 

Technical Tips

 

Introduction

 

Fractal Design, Inc. has thoroughly tested 
Ray Dream Studio 5 to ensure that it runs 
correctly with most Macintosh and 
Windows software and hardware. If you 
experience a problem with Ray Dream 
Studio 5, first complete the steps given in 
“Before You Call Technical Support” on 
page 398. Then refer to the list of 
commonly asked questions and their 
answers. If you cannot resolve the 
problem, please refer to “Fractal Design 
Ray Dream Studio Troubleshooting 
Worksheet” on page 423 for information on 
how to contact Technical Support.
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Before You Call Technical 

                     

7

 

Do you get an error message? If so, what 

                      

4

 

If the problem goes away when you start 
omputer with Extensions off, you 
 that the culprit is an item in the 

 

nsion

 

 folder or 

 

Control Panel

 

. Once 
tified, it is usually just a matter of 
ng the most current version of the 
uct to solve the problem 
anently.

 

ntify the item that causes the 
t:

  

em 7.5

 

Choose 

 

Apple menu> 

trol Panels> Extensions 

ager

 

. If you need more instructions 
 what appears in this control panel, 

your System 7.5 documentation. 
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Support

When you first experience a problem with a 
software program you might be able to find 
the solution yourself without calling 
Technical Support. If you do call Fractal 
Design Technical Support, please have the 
following information available. Please fill 
out the Troubleshooting Worksheet 
included at the back of this manual.

1Which Fractal Design product are you 
using? 

2Which version? 

message? 

8Is there anything unusual about your 
computer set up? Do you have a special 
video card or accelerator, for example.

9Do you have a CD-ROM player? When 
was it last used?

10Are you running virus protection or 
disk compression software, and if so, 
what products are you using?

Once you have answers to the above ques-
tions, call Fractal Design Technical Support 
at (408) 430-4200. To investigate the prob-
lem yourself, look below for instructions 

the c
know
Exte
iden
getti
prod
perm

To ide
conflic

1Syst
Con

Man

than
see 
r turning off one half of your 
nsions, go to Step 2.

System 7.5 Create a new folder and 
e it Extensions Off. Open the 
nsion folder and drag half of the 
s into the new folder. 

art your computer in the usual way. 
if the problem still occurs. 

e problem still occurs you know the 
rit is still active. 

System 7.5 If the problem goes 
y, you know the culprit is in the 
nsions Off folder. Whichever folder 
ains the culprit, cut that group in 
Macintosh: Look under the Apple menu if 
the program is running or highlight the 
application icon and choose File 
menu> Get Info.

Windows: Look under the Help menu.

3What is your serial number (see the label 
attached on the back inside cover of this 
manual)?

4What kind of computer are you using? 

5How much RAM does your computer 
have?

6What kind of problem are you having? 

based on your computer platform.

Macintosh
The most common cause of problems when 
running Macintosh software is a conflict 
with Extensions. 

To find out if an Extension conflict is 
causing a problem:

1Restart the computer while holding 
down the Shift key.

2When you see the message Welcome to 
Macintosh. Extensions off. release the 
Shift key. 

Afte
exte

Pre-
nam
Exte
item

2Rest
See 

If th
culp

Pre-
awa
Exte
cont
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3Run the software to see if the problem 
still occurs.



                                        

 The new version is most likely free 
 usually be downloaded from a 
board or online service.

 

s 95

  

e 

 

Start menu> Settings

 

/

 

Control 

 

.

  

e click 

 

Display

 

 and select the 

 

gs tab

 

.

   

Change Display Type /Record 
er Type

 

.

   

Change under Monitor Type

 

 and 
 

 

Show All Devices

 

.

  

a note of the current setting so you 
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half and restart again. Keep cutting the 
group in half until you zero in on the 
extension that causes the problem.

System 7.5 If the problem goes away, 
you know that the extension is turned 
off. Turn half of the extensions back on. If 
a problem still occurs, turn off half of the 
remaining extensions. Keep turning 
extensions on or off until you zero in on 
the extension that causes the problem.

3If you get all the way through the 
Extensions folder without locating the 
item that causes the problem, it is 
possible that the culprit is in the Control 
Panels folder. 

5If the problem is identified as an Apple 
Control Panel, contact Fractal Design 
Technical Support at (408) 430-4200.

Windows 
If you are running Windows, sometimes 
there is a video driver incompatibility. The 
solution is easy so try this test to see if 
your problem is caused by a video driver.

Windows 3.1 and Windows NT

1Close all applications except Windows.

2In your Main directory, locate and 
double-click the icon labeled Windows 
Setup. 

months.
and can
bulletin 

Window

1Choos
Panel

2Doubl
Settin

3Click 
Adapt

4Click 
select

5Make 

turn to it after this test. Scroll to 
ard Monitor Types and select 
ard Display Adapter (VGA).

OK.

g under VGA does not solve the 
 or if the manufacturer verifies that 
running the most current driver, 
Fractal Design Technical Support 
430-4200.
Follow the same procedure with the 
Control Panels folder, starting by 
removing all items that are not included 
in Apple's standard system. 

4If you identify the problem as an 
Extension or a third-party Control Panel 
device, contact the developer of that 
software to verify that you have the most 
current version. 

If you have the most current version, 
contact Fractal Design Technical Support 
at (408) 430-4200. We will want to have 
the name and phone number of the 
developer’s technician you spoke with so 
we can work with them to create a 

3Write down the current Display setting 
so you can return to it after this test.

4Choose Options menu> Change 
System Setting. 

5Where it shows Display, scroll down and 
select plain vanilla VGA. 

6You will need to restart Windows. 

7Run Ray Dream Studio 5 to see if the 
problem persists. 

If the problems are gone, you know the 
cause was the video driver. Contact the 
manufacturer of your video card to get the 
most current video driver. Some 

can re
Stand
Stand

6Click 

If runnin
problem
you are 
contact 
at (408) 
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permanent solution. manufacturers change drivers every few 



   

Set up

                                 

Macintosh:

 

lect the Ray Dream Studio 5 
ication by clicking once on its icon.

ose 

 

File menu> Get Info

 

 from 

 

inder

 

 or press 

 

Command-I

 

.

 the lower right corner of the Get Info 
 type the amount of RAM you want 
Dream Studio 5 to use in the 
erred Size box.

se the Get Info box.

 

endation:

 

 Always leave enough RAM for 
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Q.The Ray Dream Studio 5 installer does 
not install Ray Dream Studio 5 on my 
machine. What can I do?

To install the complete Ray Dream 
Studio 5 including the tutorial files, you 
need to have 20 MB of hard drive space 
reserved for program files, plus 20 MB 
free disk space available on your hard 
drive.

Macintosh: If you have enough hard 
drive space and are still having 
problems, try restarting the Macintosh 

See TSR Programs (Windows) later in this appendix for 
instructions on how to turn off TSR's.

Then reinstall Ray Dream Studio 5. If 
installation is still unsuccessful, contact 
Fractal Design Technical Support.

Memory

Q.Is there a limit to the size of image that 
Ray Dream Studio 5 can produce?

1.Se
appl

2Cho
the F

3. In
box,
Ray 
Pref

4.Clo

Recomm

em. Do not assign an application more RAM 
 have available. Check Apple menu> 
 This Macintosh before changing RAM 
ns.

dows:

se down any running applications 
 you really don’t need. 

lete the contents of the clipboard. 

 can be done by selecting the 
board Viewer from the Main Group 
tart menu. When the Clipboard 
er appears, Choose Edit menu> 
while holding down the Shift key to turn 
all extensions off. Then reinstall Ray 
Dream Studio 5. 

Windows: If you have enough hard drive 
space and are still having problems, try 
rebooting the computer with the 
following turned off:

• Any virus protection software.

• If you are using disk compression, try 
installing to an uncompressed volume.

• Any TSR (Terminate and Stay Resident) 
application not required to run 
Windows.

A.If there is enough RAM or scratch disk 
space available to open the file, Ray 
Dream Studio 5 renders images of up to 
16,000 x 16,000 pixels.

Q.How do I select the scratch drive for Ray 
Dream Studio 5?

A.Choose File menu> Preferences: 
Imaging: Scratch Drives.

Q.How can I increase the memory allocated 
to Ray Dream Studio 5?

A.To change the total amount of RAM 
allocated to Ray Dream Studio:

Quit Ray Dream Studio 5 if it is already 
running.

the Syst
than you
About

allocatio

Win

1.Clo
that

2.De

This
Clip
or S
View
te.
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 computer prompts you before 
ting each line in the config.sys file 
utoexec.bat file. This allows you to 
ively not load TSR’s that are not 
ed to run Windows.

load HIMEM.SYS in order to run Windows in 
mode. Also, if you have a SCSI drive, make 
ou load your SCSI drivers. (You may also 
iles and Buffers and Path commands in 
.BAT.)

e the computer restarts, start 
ws then start Ray Dream Studio 5. 
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3.Windows 3.1 and Windows NT Release 
System Resources. To display the 
percentage of system resources 
available, choose Help menu> About 
Program Manager from the Program 
Manager. If the percentage of free system 
resources is less than 20MB, problems 
may occur. 

Windows 95 Click My Computer: 
Properties: Performance tab.

To increase available system 
resources:

• Close all windows that you don’t need 
open (do this in the Program Manager for 

texture maps. It is not actually working 
faster, it just doesn’t have to go to the 
disk as often.

Q.Will adding an FPU increase Ray Dream 
Studio 5’s speed?

A.No. Ray Dream Studio 5 does not use the 
FPU.

TSR Programs (Windows)

Q.What is a TSR (Terminate and Stay 
Resident) application?

A.A TSR or memory resident application is 

2.The
execu
and a
select
requir

You must 
enhanced 
sure that y
need the F
AUTOEXEC

3.Onc
Windo
e problem persists, even with TSR’s 
ntact Fractal Design Technical 
rt.

SR’s cause conflicts and how can I 
e them?

 conflict occurs when a specific 
onflicts with another TSR, 
ation, or a function within an 
ation. You can resolve a possible 
onflict by:

arting the computer with only 
 TSR’s turned on that are required 
 Windows.
Windows and Windows NT).

• Reduce the number of Program Groups 
(Windows/Windows NT).

• Close all unnecessary application 
windows.

• If you are running Wallpaper, turn it off.

• Windows 95 Ensure you are using the 
most current version of Windows.

Q.If I upgrade my computer by adding more 
memory will it render faster?

A.Adding more memory might allow the 
computer to render some images 
without using the scratch disk so you 

a program or driver that stays in memory 
once it is loaded and works in the 
background. The program normally 
responds only to a specific command or 
event (such as the deletion of a file or a 
specific key stroke combination). 

Q.How can I turn some or all TSR’s off?

A.To turn off TSR’s:

Using DOS 6 and higher:

1.Reboot the computer and press the F8 
key as soon as you see “Starting MS-
DOS.”

4.If th
off, co
Suppo

Q.Can T
resolv

A.A TSR
TSR c
applic
applic
TSR c

1.Rest
those
to run
endix C • Technical Tips 401

y the operation. If the conflict does 
cur, the problem is probably 
d by a TSR conflict.
App

may see a significant improvement in the 
speed, especially if your image includes 

2.Retr
not re
cause



A.To convert your square to Bézier curves, Translation. With Translation (the 
ult) the cross section remains 
llel to the drawing plane. With 
line, the cross section remains 
endicular to the sweep path, so the 
e of the cross section rotates as the 
p path curves.

n I imported my 3D DXF file, all I got 
an empty bounding box, or so many 
cts that I could not make any sense 
of it. How can I fix this problem?

Dream Studio 5 imports files based 
he DXF standard created by 
Desk, the manufacturer of AutoCAD. 
re you export from your DXF 
ication, ensure that objects are 
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If restarting with TSR’s off resolves the problem, a TSR 
conflict is probably the cause of the original problem. 
Try to identify the specific TSR or combination of TSR’s 
that cause the problem. Once identified, verify with 
the manufacturer that the version is up-to-date. Then 
contact Fractal Design Technical Support for additional 
instructions.

Modeling

Q.Can I use Adobe Illustrator or Corel Draw 

so you can edit the shape, choose 
Arrange menu> Ungroup. Then use 
the Add Point or Convert Point tool to 
edit the shape.

Q.How do I create an object with holes in 
it?

A.Draw the cross section and the hole(s). 
With the cross section selected hold 
down the Shift key and select the hole(s). 
Choose Arrange menu> Combine as 
Compound.

Q.The object I made using the Modeling 
Wizard is not exactly what I want. How 
do I edit it? Can I use the Modeling 
Wizard to modify an object made in the 

defa
para
Pipe
perp
plan
swee

Q.Whe
was 
obje
out 

A.Ray 
on t
Auto
Befo
appl
d as 3D faces. Then your file should 
rt correctly in Ray Dream Studio 5. 

ing

hat resolution should I save my 
ap image in order to use it as a 
re map in Ray Dream Studio 5?

 will get the best results if the 
inal image is saved at the size and 
lution required for the final output. 
 your final image is rendered at 300 
nd the texture map is about one 

 square in the final image (300 x 300 
line art to create 3D objects? 

A.Yes, you can use Adobe Illustrator or 
Corel Draw line art as cross sections, 
sweep paths, and scaling envelopes. 
Refer to Chapter 7, “Free Form 
Modeling.” (Macromedia FreeHand is not 
supported in Ray Dream Studio 5.)

Q.After I use the Rectangle tool to draw a 
square (by holding down the Shift key to 
constrain it.) I want to edit the shape. 
How can I convert this shape to a Bézier 
shape? Previous versions of Ray Dream 
Studio could convert to Bézier. How do I 
do that in this version?

Modeler?

A.The Modeling Wizard is only for creating 
objects. Objects created with the 
Modeling Wizard can be edited like other 
free form objects. Double-click the object 
in the Perspective window to launch the 
Modeler. Edit the object then exit the 
Modeler by clicking Done. Remember, 
any Wizard object can be recreated with 
eight mouse clicks or fewer, so it’s not 
too inconvenient to start over again.

Q.How can I rotate the plane of the cross 
section like the Modeling Wizard does 
when it makes the banana?

A.No magic here. Simply choose 

save
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Geometry/Extrusion Method 
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square at 300 dpi). The closer you are to 
a one-to-one ratio between the original 
artwork and the final output, the better 
your texture map will look. Making the 
texture map larger (or higher resolution) 
increases the rendering time but will not 
increase the quality of the final image!

Q.Does Ray Dream Studio 5 support 
PANTONE colors?

A.Ray Dream Studio 5 supports the RGB 
and CYMK color models for selecting 
colors. PANTONE colors are not 
supported directly, but you can use the 
CMYK equivalent to select your original 
color. Remember that colors are 
manipulated in order to create a 3D 

A.Use the Properties palette: Shading 
tab to change the order of paint layers. 
Use the Move Forward and Send 
Backward commands to prioritize the 
paint layers. 

Q.If I change the shape of my paint region 
will the texture map tile or stretch?

A.It will stretch. Remember that you can 
use the Properties palette: Shading 
tab to change the size of your paint 
region. Set the size to a size that is 
proportionate to your artwork to avoid 
distortion. If you want to increase tiling, 
click the paint region with the 
Eyedropper tool. Adjust the tiling in the 
Shader Editor and reapply the shader.

A.You n
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Prefe

Reme
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Q.Some
Photo
be use

Printi

Q.I crea

figure out how to print it. Help!

 cameras and lights. Render your 
. Open the rendered image and 
e File menu> Print. For more 
ation, refer to Chapter 14, “Setting 
 & Cameras.”

ed my rendered image but the 
tion is very poor. On screen it 
pretty good. What’s going wrong?

p to you to select the size and 
tion you desire for your printed 
. The default is 72 dpi (screen 
tion), which is very poor quality 

inting but great for previewing your 
 on screen. Set the resolution for 
image. If you start with a specified color, 
you don’t necessarily end up with it after 
you have added lights, reflection and 
transparency, and allowed for the 
shading that indicates the curvature of 
your objects. The final artwork rendered 
from Ray Dream Studio 5 will always be 
in the RGB mode. Of course, you can do 
post production work in an image 
manipulation program, such as Adobe 
Photoshop, to specify PANTONE colors.

Q.What is the priority order for solid 
textures on objects? Say I have a 
transparent object with a bank of wood 
texture and part of the wood has a gold 
band “inlaid” in it. What will I see? How 

Q.If I have a long thin object how can I get 
my texture to tile correctly?

A.In the Shader Editor you can set the 
number of tiles you want in the vertical 
and horizontal planes to get the effect 
you are looking for. 

Q.How can I make bumps show up better? I 
want them to appear higher or I want the 
indents to appear deeper.

A.Experiment with your lighting. Try not to 
have any light directly aimed at the 
bump or it will wash out. Indirect lighting 
shows the bump map shadows.

Q.I want to use some filters on my object 

can’t 
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the Scene Settings dialog: Image 
Size tab. 

Arranging

Q.Even using various views, I have a hard 
time lining things up precisely.

A.Use the Numerical and Alignment tools, 
described in “Positioning Objects” on 
page 234, to place objects precisely. You 
may also want to adjust the hot point on 
specific objects in order to get the exact 
placement you need.

to place my objects exactly where I want 
them but they don’t seem to align as I 
would expect. They don’t seem to rotate 
correctly either.

A.Make sure the Hot Points are set 
correctly. To return the hot point to the 
default setting: Select the hot point and 
click Send to Center in the Numerical 
dialog, and click Apply.

Q.I really like the Virtual Trackball tool but 
sometimes I have a hard time 
understanding how it is rotating the 
object. Can you help?

A.Be sure to start your rotation with the 
cursor inside the circle (otherwise, 

cam
light
obje
do t

A.Crea
the s
cam
poin
Poin
obje
com
light
obje
cont
need

If yo

can use the Point At behavior as a 
 to keep one object directed at 
her through all or part of the 
ation. The Point At behavior can be 
ied to objects, as well as cameras 
lights.
Q.When I drag a new object into the 
Perspective window, sometimes I cannot 
find its projections. I have the feeling 
that the object is not where I think it is.

A.It does make a difference where you drop 
your object. Experiment with it. 
Generally, you should aim for the center 
of the Universe. However, should you 
really have a problem, you can always 
send your object to the center yourself. 
Select the object in the Perspective 
window, then choose Arrange menu> 
Send To Origin. Better yet, create your 
object in the center of the universe by 
dragging and dropping the Free Form 
tool or one of the primitive tools into the 

rotation is constrained to one plane). If 
you need more control, hold down the 
Shift key and your rotation will be 
constrained to 15° increments. Your 
object rotates around its Hot Point. (If 
you start your rotation outside the 
circle, rotation is constrained to the 
active plane.)

Q.Why doesn’t the Hierarchy window 
scroll automatically?

A.If you want to have the Hierarchy 
window scroll while you drag, hold down 
the Option/Alt key. Otherwise, it 
behaves just like a window on the Finder 
(Macintosh) or Program Manager 
(Windows) behaves.

you 
way
anot
anim
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Hierarchy window.



d Fog to my scene but it doesn’t 
to do anything. I don’t see any fog.

ce-based fog only shows if it is in 
f something. Is your object in front 

 fog? You may need to adjust the 
here the fog starts or move your 

t into the fog. For information on 
o determine where fog begins and 
refer to “Atmosphere” on page 344.

ject looks foggy now, but shouldn’t 
fect the whole scene? 

er to see the fog in the rest of the 
, you will need to provide a 
round. The same is true of Ambient 
 Select a Reflected Background 
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Lights and Cameras

Q.How can I create a new camera and move 
it in the Perspective window?

A.When you create a new camera using the 
Edit/Insert command, you can set the 
camera’s position to Reference, or to any 
other of the preset positions under the 
View menu; to the same as position as 
the current camera; or at the center of 
the Universe (0,0,0). 

You can also select a camera in the 
Hierarchy window and choose Windows 

menu> Numerical or press 

A.Double-click the light in the Hierarchy 
window and use the Shadow Intensity 
slider bar to adjust the intensity of the 
shadow. You can also try increasing the 
ambient light (just a little), but 
remember that ambient light affects the 
whole scene. (You may also want to use 
the Production Z-Buffer renderer, which 
renders soft shadows.)

Q.I set the ambient light to a nice clear 
white, but I am not getting the results I 
expected. What’s wrong?

A.Ambient light refers to the light that is 
simply there in the room during the day. 
If you set the light to white it will 
probably wash out all the color and 

Q.I adde
seem 
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front o
of the
area w
objec
how t
ends, 

Q.My ob
fog af

A.In ord
scene
backg
Light.
he Reflected Background tab 
er/Effects), or create an object and 
on it behind the scene.
Command-I/Ctrl+I) to open the 
Numerical dialog. Set the x, y and z 
coordinates to 0, 0, and 0. Click Apply. 
The camera now appears in the center of 
the universe and you can move it as you 
would any other object in your scene. 
Remember you can also move a camera 
using the camera tools or the controls in 
the Camera Properties palette 
(Windows menu> Camera 

Properties). Yet another way to move 
the camera is to select it in the 
Perspective window and drag it as you 
would move any other object.

Q.How can I control the intensity of 
shadows?

texture of your objects. Usually you will 
want to leave it set to the default neutral 
gray. Sometimes you may want a colored 
light for special effects but don’t make it 
too bright!

Q.I set up my scene by placing the objects 
and adjusting the lights, but when I 
render the scene, everything appears to 
be washed out. Why is that happening?

A.Be sure you do not to set the lights too 
bright. If you adjusted the lights by 
assigning a very light yellow or white 
color, you are probably flooding the 
scene with too much light. Try rendering 
the scene with the lights set to a lower 
intensity.

from t
(Rend
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Rendering Q.What kind of image will I get if I choose to 
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Q.Can I interrupt a rendering once it has 
started? If so, how do I resume or do I 
need to start over again?

A.If you are using the Batch Queue, you can 
pause a rendering by clicking Pause in 
the Batch Queue dialog. Resume 
rendering by clicking Resume in the 
Batch Queue dialog. The contents of the 
Batch Queue are saved so you can 
resume a paused rendering later. 
However, once you clear the Batch 
Queue dialog, you will not be able to 
resume the rendering. Of course, you can 

have the computer give me the best 
image possible in the time available 
instead of doing a full rendering? How 
will it relate to the Render Settings 
format I have set? Will it keep the dpi 
constant and change the size or keep the 
size I set and change the dpi?

A.It will keep the image size and adjust the 
resolution to the best quality available in 
the time you have specified.

Q.How long will it take to render my image? 

A.Image processing time depends on a 
variety of factors including: computer 
speed, rendering resolution, scene 
complexity, lights, transparencies and 
abort a rendering by typing Command-
Period/ESC, but an aborted rendering 
cannot be resumed.

Q.When using the Batch Queue, my 
rendering did not show the latest 
changes I made to my scene.

A.The Batch Queue renders the scene from 
the last version saved to your hard drive. 
(It’s a good idea to save frequently!) The 
Render command renders your scene as 
currently shown, working from the copy 
held in RAM, showing the latest changes 
even if not yet saved to the hard drive. If 
you’re happy with the output, remember 
to save it!

reflections, types and complexity of 
textures. Generally, more complex 
images take longer to process than 
simpler images. Use the Estimate Render 
Time command in the Scene Settings 
dialog: Image Size tab for 
information specific to your image.
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Index

Adobe Photoshop
AutoCAD file format (*.DXF)
BMP file format
Complex objects
Hot Points

vertices 153
Oscillate tweener 310
Preferences
Render Filters

adding to Browser palette 30
overview 108

Symmetry

Numerics
2D images

importing 124, 380
importing as brush shapes 188

2D object projections 404
2D Plane link 261
2D Primitive tools 120
2D Rotation tool 123, 163
2D shapes 110
2D Text tool 121
2D, defined 395
3D objects

cameras and 12
creating 402
grouping 11
importing 33
lighting 11
Mapping modes 193
primitives 98
rendering and 12
shading 11

3D Paint tools 182, 186
Brush tool 187
Ellipse tool 187
Paint Shape Selection tool 190
Polygon tool 187
Rectangle tool 186

3D, defined 394

3DFACE option 383

A
Absolute position 393
Action Modifier tools 149
Action Modifiers tab 150, 169
Active plane 39
Actual size, viewing 34
Acuris, Inc. xiii
Adaptive Oversampling rendering 

option 343
Adaptive renderer 342
Add Key Event tool 307
Add operator 207
Add Point tool 56, 120, 126
Add Thickness command 158
Add Vertex tool 148, 154
Adding

an object from another 
scene 252

cross sections 55, 126
files to a Batch Queue 368
objects from the scene 252
objects to Browser palette 40
objects to group 258
objects to the selection 241
one scene to another 252
points 120
thickness 157
vertices 154

Adjust command 157
Adobe Illustrator file format (*.AI)

importing 2, 4, 124
Adobe Illustrator, using to create 

cross sections 402
Adobe Photoshop

compatible acquire plug-in 380
compatible export plug-in 380

Adobe Photoshop file format
 see PhotoShop file format 

(#.PSD)

Adobe Type Manager 2
AI file format

see Adobe Illustrator file format 
(*.AI)

Aiming
cameras 244
lights 244
lights and cameras 244
spot lights 276

Align command
Align on Working Box 243
On Gravity 228, 244
On Universe 244
Reset Orientation 244

Align Objects command 44
Align On Gravity command 291
Align On Universe command 244
Align option, anchor object 245
Align Working Box command 228
Aligning

drawing plane 142
gravity option 244
objects 44
on gravity 244
on working box 243
polymesh objects 157
resetting 244
text 390

Alignment 244, 245
Align option 245
anchor object 246
axis pop-up menu 245
Box Max option 246
Box Min option 246
Center option 246
contact option 246
Distribute option 245
Hot Points 246
None option 245
operation 224
relative 244, 390
Sides option 246
Space option 245

Alpha channel, defined 390



   

Articulations, building using 

                                                                               

Apply Physical Effects

 

320

                                  

Boolean operations 167 view 29
Brush palette 187
Brush shape

adding 189
erasing 189
importing 189

Brush tool 187
angle 188
brush stroke 188
Eraser brush 187
flatness 188
hardness 188
imported shape 189
options 187
painting with 188
size 188

Building a hierarchical 
structure 254

Building chains of links 265
Bulb Light

creating 272
option 273
setting characteristics 273

Bump
channel 201, 214
mapping 214

Bumps
improving quality of 403

C
Camera command 34
Camera Dolly tool 75, 146
Camera Pan tool 75
Camera Properties command 34
Camera Track tool 75
Cameras 271

3D objects, and 12
aiming 244
conical 287
creating 405
creating new 286
deleting position 292
field of view 285
isometric 287
lens 286
move 289
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links 265
Aspect Ratio, defined 390
Atmosphere 296

cloudy fog 344, 345
defined 390
distance fog 344
rendering 344

Atomize deformer 172
Attitude

defined 390
yaw, pitch and roll 240

Auto apply option 243
AutoCAD 382
AutoCAD file format (*.DXF)

importing 381, 402
Autorun window 3
AVI movies

compressor options 365
Render file format 14
rendered animations, and 14
rotoscoping with 16

Axis 261
defined 390
indicators 243
link 261, 262
of constraint 245
pop-up menu, alignment 245

B
Backdrop

defined 390
using 346

Background 296
objects 371
reflected 390
rendering 345

Ball Joint link 261
using 262

Basic components 198
Batch Queue 368, 406

adding files 368
render 368

Behaviors 16
adding to Browser palette 30
animation order 314

applying 79, 314
applying multiple 314
Bounce 16, 316
Damping Force 324
Directional Force 322
Flow Force 323
Initial Velocity 321
Inverse Kinematics 16, 18, 317
physically-based 79, 318
Point At 16, 70, 315, 404
Point Force 323
record behaviors 326
Rotational Force 323
Spin 16, 317
tab 9
Track 16, 317
using physics 319

Bend and Twist deformers 173
Better Preview command 115
Better Preview mode 8, 270, 335
Bézier curves 402

2D shapes and paths 116
control points 116
corner points 117
curve points 117
defined 390
handles 116
vertices 116

Bézier shape
converting to 402

Bézier tweener 18, 311
control settings 311
introduction to 15
smoothing motion 333

Bézier-based animation 16
Bit Depth, defined 390
Bitmap images, saving 402
Bitmap, defined 390
Black Hole deformer 173
Blending slider 209
Blinds gel

introduction 280
setting controls 281

Blinking lights, creating 313
BMP file format

see Windows Bitmap file format 
(*.BMP)

Boolean Operation command 169

Bounce behavior
applying 316
understanding 16

Bounce wave shape 313
Bounding box 228, 231, 239, 258

defined 390
group 258
mode 8

Box Max, alignment 246
Box Min, alignment 246
Branches 254
Break Apart Compound 

command 124
Brightness 273
Browser command 29
Browser palette 9, 28, 183

a lesson in 39
adding behaviors to 30
adding deformers to 30
adding directory 40
adding links to 30
adding objects to 40
adding render filters to 30
adding shaders to 30
Behaviors tab 9
Cameras tab 9
create directory 32
creating items 31
Deformer tab 9
displaying 29
documents

creating 31
duplicating 31
editing 31

duplicating items 31
editing items 31
introduction to 6
Lights tab 9
Links tab 9
Objects tab 9, 30
preferences 29
remove directory 32
Render Filters tab 9
retrieving from 30
saving scenes to 30
saving to 29
Shaders tab 9
update directory 32



Index 409

multiple 292 Class Combine as Compound Copy and Paste 252
Copy command 35, 252
Copying objects 35
CorelDRAW! file format (*.CDR)

importing 4, 124
in modeling 402

Corner points 117
Crease angle 159
Create command 53
Creating 151

3D primitives 58
a new camera 286
Browser palette directory 32
Browser palette documents 31
cross sections 126
Formula objects 106
multiple cross sections 52
new light source 272
object class 266
objects 99
scenes 27
sweep objects 165
Text objects 105

Cross sections 125–128
adding 55, 126
animating 328
centering 128
compound 123
creating 126
defined 109, 391
disconnecting 128
grouping 123
importing 124
intermediate 126
moving between 127
multiple 52
multiple shapes in 48
numbering 127
options 128
overview 111
polygon 166
polyline 166
properties 122
removing 126
rotate shapes 122
rotating 402
scaling 124
shape correspondence 127
uncentered 131
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normal lens 287
point at object 244, 287
preset position 290
retrieving 30
rotating 333
save position 292
saving 29
selecting 34
tab 9
telephoto lens 287
using 285
view 17
wide angle lens 287
zoom lens 287

Caps Lock 233
Cartesian coordinate system 224
CDR file format

see CorelDRAW! file format 
(*.CDR)

Cellular function 208
Center alignment 246
Center Hot Point command 233
Centering cross sections 128
CGM file format

see Computer Graphics Metafile 
file format (*.CGM)

Changing
camera lens 286
hierarchy structure 256
scene perspective 289

Channels
applying 185
Bump 201, 214
Color 213
Glow 216
Highlight 214
non-color 201
Reflection 215
Refraction 216
shader 198
Shininess 214
Transparency 215

Checkers function 210
Child objects

defined 390
selecting 252

Child-parent objects 252
Cinepak codec 364, 365

creating master object 266
objects 9

Clip Art 252
Cloaking

objects 297, 334
Cloaking objects

property 370
Close command 36
Close Group 259
Closing

Free Form modeler 113
Closing files 36
Closing, groups 258
Cloud primitives 100
Cloud tool 101
Cloudy Fog, atmosphere 344, 345
CMYK defined 391
Codecs

animation 364
Cinepak 364, 365
Component Video 364
compression/decompression 

algorithms 363
Full Frames 365
Graphic 364
Intel Indeo Video R3.2 365
Intel Indeo Video Raw 365
Microsoft RLE codec 365
Microsoft Video 1 365
None 364
Photo-JPEG 364
Video 365

Color channel
Composite shader 220
defined 213

Color chip 271
Color component 215
Color depth, defined 391
Color separations 378
Color, CMYK defined 391
Color, RGB defined 391
Colors

component 201
depth 22
multi-color pattern 213
preferences 24
support for 403

command 48, 124
Combining deformers 172
Compact installation 3
Complex extrusions 165
Complex objects

defined 391
example 98

Component Video codec 364
Components

basic 198
copying to channels 222
function 199
operators 199
shader 391

Components, shaders 198
Composite 366, 374

mask 375
Composite shaders 217

color channel 220
defined 200

Compounds, cross section 
shapes 123

Compression
and frame size 365
applying 363
options 364
programs 2
rendering without 17

Compression Settings dialog 364
Computer Graphics Metafile file 

format (*.CGM), importing 4
Computer system, optimizing 371
Concentric, defined 391
Configurations, workspace 26
Conical

Camera 287
Constrain, defined 391
Constraining, envelopes 134
Contact, alignment 246
Control points

Bézier curves 116
defined 391

Controlling shadow strength 273
Conventions, user guide ix
Convert Point tool 56, 119
Converting, corner points 119
Coordinate System 383
Co-planar, defined 391



Cross-Section Options Warp deformers 178 Distance 344 DXF Options 382

E
Easy installation 2
Edges, smoothing 159
Editing

Browser documents 31
curves 119
mesh form models 140
object mesh 58
scaling envelope 134
Text objects 106

Effects tab 9, 298
Ellipse tool 121, 152
Empty Polygon command 158
Envelopes

adjusting 56
constraint options 134
description lines 114
editing 134
Free 134
lathing 135
Symmetrical 134
Symmetrical In Plane 134

Environment map 345
Environmental primitives 99
Eraser brush 187
Exaggeration, animations and 19
Explode deformer 174
Exporting

*.BMP file format 4
*.PCX file format 4
*.PSD file format 2, 4
*.TGA file format 4
*.TIF file format 3, 4
images 380

Extensions
conflict with 398
for Ray Dream Studio 23

Extrude command 165
Extrude tool 149
Extrusion 110

defined 138, 391
Pipeline method 131
Presets 136
Translation method 131
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command 128
Cube tool 152
Current camera, aiming 244
Current root 255, 257
Current time 14, 301

changing 297, 302
Current Time Bar 14, 19, 301, 302
Curve points, converting 119
Curves

adjusting 119
Bézier 117

Custom installation 2, 3
Custom link 262
Custom links 261, 262
Customizing, toolbars 26
Cut command 35
Cutting, objects 35

D
Damping Force behavior 324
Damping Oscillate tweener 313
Decimate command 160
Decimating objects 160
Default preferences 24
Deformer tab 9, 172, 179
Deformers 171–180, 391

a lesson with 60
adding to Browser palette 30
animating 16
animating with 332
applying 61, 172
Atomize deformer 172
Bend and Twist deformers 173
Black Hole deformer 173
combining multiple 172
Dissolve deformer 174
Explode deformer 174
Formula deformers 175
Punch deformer 175
rules for 332
Shatter deformer 176
Spherical Morph deformer 177
Spike deformer 177
Stretch deformers 178
using 171

Wave deformer 179
Delete command 36, 252
Delete Point tool 119
Delete Vertex tool 148, 154
Deleting

cross sections 126
objects 35, 252
position, camera 292
segments 120
vertices 154

Depth, color 22
Description lines, envelopes 114
Device resolution 360
DFace entities 383
Direct Manipulation controls

a lesson in 70
deformers and 172

Direct3D Hardware renderer 25
Direct3D Software renderer 25
Direction of a distant light

setting 273
Directional Force behavior 322
Directory, adding to Browser 

palette 40
Disconnecting, cross sections 128
Discrete tweener 15, 311
Display modes

Better Preview 8, 230, 335
Bounding Box 8, 229
changing object preview 230
No Preview 8, 229
Preview 8, 230
Shaded Preview 8, 230
Wireframe 8, 230

Display Plane tool 7
Display planes, displaying 39
Displaying

a working box plane 226
Browser palette 29
grid planes 26
objects 8
palettes 26
planes 39
the Production Frame 361
tool tips xi
toolbars 26
windows 26

Dissolve deformer 174

artwork settings 366
fall-off 274, 275

Distance Fall Off option 273
Distant light 272, 273, 279
Distribute, alignment 245
Dithering, defined 391
Dolly, defined 391
Done button, modeling window 8
DPI, Artwork Settings 360
Draft Z Buffer renderer 342
Draft Z-Buffer 370
Dragging objects 235
Drawing plane

aligning 142
change 114
grid 122
Mesh Form modeler 141
moving 142
polygon 143
rotating 142
vertex and 143
view 114
working on 116–124

Drawing tools 117–121
2D Primitives 120
2D Text tool 121
Add Point tool 120
Convert Point tool 119
Delete Point tool 119
Ellipse tool 121
Pen tool 117
Polygon tool 121
Rectangle tool 120
Rounded Rectangle tool 121
Selection tool 118

Duplicate command 45, 152, 248
Duplicate with Symmetry 

command 152, 249
Duplicating

Browser palette documents 31
object 247
objects 45, 248, 333
polymesh objects 152
preferences 45
with symmetry 249

DXF files
defined 391
importing 402
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twisting 123 Distance 344 surface fidelity 116 setting controls 282
Graphic codec 364
Gravity, aligning on 244
Grayscale

defined 392
images as gels 280
texture maps 203

Grid command 122, 226
Grid planes, hiding/displaying 26
Grids

Draw Line Every 227
drawing plane 122
Mesh Form modeler 150
options 226
preferences 150
setting up 26
settings 226

Group 233
adding objects 258
animating objects within 333
animating shapes of 332
as class 267
bounding box 258

re-calculating 259
close 259
defined 392
duplicating 333
how to 256
new 257
objects 256
remove objects 258

Group command 46, 123, 257
Group coordinate system

defined 393
Grouping 256

3D objects 11
objects 46, 256
shapes 123
vertices 156

Groups
closing 258
opening 258

H
Half angle 273, 274
Hand tool 33, 147, 225, 285
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Extrusion Envelope command 49, 
125, 134

Extrusion Method command
Pipeline 47
Translation 131, 135

Extrusion path
complex 165
defined 394
preset 131
see also Sweep path
straight 165

Extrusion Preset command
Spiral 132
Straight 131
Torus 136

F
Fall-off 274, 275
Field of view 285
File formats

artwork settings 362
movie 363

Files
closing 36
importing and exporting 2, 4
opening 28, 38
saving 36

Fill Polygon command 158
Filtering, artwork 375
Filters

accessing 403
choosing 205
in the Shader Editor 376
plug-ins 23
Reflected Backgrounds or 

Backdrops 376
Find, object 232
Fire primitive 103
Fire tool 103
Flatten command 162
Flip command 249
Flow Force behavior 323
Fog 344

color 344, 345
Density 345

distance based 405
Global Scale 345
Lumpiness 345
primitives 101

Fonts
changing 106
size in workspace 25

Form and Function xiv
Formula deformers 175
Formula objects, creating 106
Formula tool 106
Formula tweener 313
Formulas

using as deformers 175
using as gels 281
using as tweeners 313

Fountain primitive 99
Fountain tool 99
Fractal Design Technical 

Support 398
Frame rates 296

changing 304
options 302
setting 302
specifying 297

Frames
advancing one 304
backing up one 304
limiting 370

Free envelopes 134
Free Form modeler 109–136

a lesson in 47
animating, and 16, 328
closing 113
defined 392
described 112
lagging and 18
opening 112
principles 18
Properties palette, and 10
rendering and 370
Shatter deformer 176

Free Form modeling
2D shapes 110
cross sections 111
extrusion 110
modeling box 113
skin objects 111

sweep path 110
techniques 111
with multiple cross 

sections 125
Free Form modeling window 7, 112
Free Form object 253
Free resizing 239
Front of the scene 273
Full Frames codec 365
Function components 199
Functions

defined 199
other components as 213
using 207

G
G-Buffer

channels 381
defined 392
rendering 340

Gels 280
Blinds 280

setting controls 281
Formula 281
Gradient 282

setting controls 282
image map 283
Movie 280
movie 284
Texture map 280

General preferences 24, 28
Geometric primitives 98
Get Info command 23
GIF file format 4
Glass, refraction value for 216
Global Mix

defined 392
option 336
shader 200, 218

Global Mix shader 200
Global Scale slider 209, 210
Global Universe 224, 392

command 229
Glow channel 216, 392
Gradient gel 280, 282



Handles, object 116 I controlling directly 321 K
Keep Proportions option 360
KETIV Technologies, Inc. xiv
Key event markers 14, 299, 300

nudging 307
overlapping 301
selecting 306

Key events 15, 295
adding 307
changing timing of 307
copying and pasting 308
defined 300
defining 306
duplicating 307, 333
stretching over time 308

Key frames
animation and 76
defined 76

L
Lag movement 18
Lathe tool 149
Lathing 134–136

lathe axis 134
lathe profile 134
Mesh Form modeler 139
overview 110
polygon cross sections 166
with a circular path 136
with the envelope 135

Launching Ray Dream Studio 22
Layering primers & paint 

shapes 190
Leading, defined 392
Lens, camera 286
Letter Spacing 392
Light command 272
Lighting Through Transparent 

Objects 343
Lights 270

aiming 244
ambient 405
angular fall-off 275
blinking 313
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Height, image size 360
Help, using x
Hiding

grid planes 26
palettes 26
selections 153
tool tips xi
toolbars 26
windows 26

Hierarchy 14, 298, 392
description 254
expanding/collapsing 298
fixed animation 297
navigating 255
resizing 299
scrolling 299
working with 298

Hierarchy area 266
Masters tab 266
Objects tab 266
resizing 299
scrolling 299

Hierarchy mode
displaying 32
preferences 33
Time Line window 8, 14

Highlight channel 214
Highlights

defined 392
Holes

creating 216, 402
creating with compounds 123
filling 158

Horizontal command 38
Hot Points

adjusting 43
alignment 246
automatically center 233
centering 234, 238
defined 392
description 233
lock to object 234, 237
move 233
moving numerically 234
point at 244
rotating around 333
troubleshooting 404

Icons, defined 392
Image

area 361
formats 340
importing 380

Image Map
as gel 283

Image size
height 360
resolution 360
standard 370
width 360

Image Size tab 404, 406
Image window 371
Imaging preferences 23
Import command 124
Imported Shape brush 188
Importing

*.AI file format 2, 4, 124
*.BMP file format 4
*.CDR file format 4, 124
*.CGM file format 4
*.DXF file format 381, 402
*.PCX file format 4
*.PSD file format 2, 4
*.TGA file format 4
*.TIF file format 3, 4
*.WMF file format 4
2D art 380
2D images 124
2D objects 382
3D objects 33
cross section shapes 124
file types 2, 4
images 380
objects from other file 

formats 381
scaling envelope 125
sweep paths 125

Indoor Step-by-Step wizard 27
Indoor Templates 27
Infinite plane

primitive 104
shading 104
tiling 105

Infinite Plane tool 104
Initial Velocity behavior 321

Insert command
Camera 286
Light 272

Installation
Compact 3
compression programs and 2
Macintosh 2
problems with 400
troubleshooting 4
virus protection and 2
Windows 3

Intel Indeo Video
R3.2 codec 365
Raw codec 365

Intermediate cross sections 126
Intersection, objects 169
Inverse Kinematics 317

behavior 16, 18
links and 256, 261, 318

Invert command 153
Invisible objects 41
Isometric camera 287
IVRM Spherical camera 287

J
Jaggies 343, 392
Joining objects 169
Joint link 261
JPEG file format 4
Jump In 255, 259, 290

modeling windows 7
object 112, 254
subshader 220

Jump In Another Modeler 
command 140, 254

Jump In command 253
Jump In New Window 

command 253, 259, 267
Jump Out 259

objects 113
subshader 220

Jumping In and Out 259
Jumping into an Object 253
Just Textures xiv
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brightness 273 toolbars 27 lathing 139 Movie file formats
choosing 363
Macintosh 14
Windows 14

Movies
applying within shaders 205
as gel 280, 284
as paint shapes 334
as texture maps 334
looping 313

Moving
between cross sections 127
drawing plane 142
Hot Points 234
points 49, 118
polymesh objects 161
Production frames 361
vertices 155
Working Box 227, 228

MPEG compression 363
Multiple

deformers 172
shapes in cross section 48

Multiply operator 207

N
Natural-Media renderer 342
Nesting groups 256
New command 27, 28
New features xi
New Group 257
New Perspective command 35
Next command 54
No Preview command 48, 115
No Preview mode 8
No shaders option 342
None codec 364
None, Alignment 245
Normal vector, artwork 

settings 366
Nudge

arrow keys 237
increment 226
objects 236
perpendicular 237

Numbering
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bulb 273
color 273
creating 272
distance fall-off 274, 275
distant 272, 273, 279
gels 280
half angle 274
limiting 17, 370
Point At 244
range 274, 275
retrieving 30
saving 29
shadow 273
sources 11
spot 273, 274
tab 9

Linear tweener 310
adjusting threshold time 311
default 310, 312
Ease-In/Ease-Out slider 310, 

312
introduction to 15

Linking
child to parent 260
objects 259
to change structure 256
vertices 154, 155

Links
2D Plane 261
adding to Browser palette 30
Axis 262
Ball Joint 262
creating a custom 262
custom 261, 262
defined 392
Lock 262
properties 261
setting controls 263
Shaft 262
Slider 262
tab 9, 261
unlinking 260

Local Root Universe 259
Local universe 290
Local Universe command 229
Lock link 261, 262
Locking

Hot Points 234, 237

Loft tool 149
Lofting

Mesh Form modeler 139
polygon cross sections 166
polyline cross sections 166

Logo Templates 27

M
Macintosh

compressor options 364
extensions 398
installation 2
movie file formats 14
software support 2
system requirements 2

Mapping mode tab 170
Mapping modes 193

changing 193, 194
polymesh objects and 169
Projection mapping 193

Marble function 210
Marquee tool 60, 146
Marquee, creating 256
Mask

artwork settings 366
defined 392
option 366

Master group 267
Master objects 247

defined 393
Master shading layer 194, 195

editing 195
Masters tab 9, 266
Memory

additional 401
allocation 22
requirements 400

Mesh Form modeler 137–170
a lesson in 57
animating, and 16
defined 137
drawing plane 141
editing 140
grids 150
groups and 145

lofting 139
objects 140
opening 57
preferences 141
preview modes 144
principles 18
Properties palette, and 10
selecting in 144
selections 153
tools 144
viewpoint 144

Mesh Form modeling window
controls 144
described 140
introduction to 7

Mesh tool 152
Mesh, editing 58
Metamorphosis, objects 16
MetaTools xiv
Microsoft

RLE codec 365
Video 1 codec 365

Minus sign 255
Mirroring, object 243
Mix operator 199, 206

value component 213
Modeler toolbar 7
Modelers, defined 392
Modeling Box

scale 115
using 113

Modeling Box Size command 115
Modeling windows

jumping in 7
using 7

Modeling Wizard
defined 395
editing using 402
modifying shapes 402
using 107

Modeling Wizard tool 107
Models, animating shapes 328, 329
Modifier keys x
Modify, object class 267
Motion

animating 333
Motion, animating 333
Move command 155, 161



adjusting 53 find 232 Time Line window 9

7

P
Paint region, changing shape 403
Paint Shape Selection tool 190
Paint shapes

3D 182
a lesson in 64
and primers 190
creating 192
cropping 190
deleting 190, 192
editing 192
layering 190, 192
layering order 191
moving 190
opacity 191
resizing 190
selecting 190
working with 190
wrapping 187

Palettes
Browser palette 9, 28, 39
displaying 26
hiding 26
Properties palette 10, 122

Pan 225, 290
defined 393

Pan, defined 391
Parent-child objects 252
Paste command 35, 253, 267
Pasting, objects 35
Path Description line 129
Paths, defined 394
PCX file format

see Windows PaintBrush file 
format (*.PCX)

Pen tool 117
Perspective

Better Preview 230
Bounding Box 229
No Preview 229
preferences 26
Preview 230
preview 229
Shaded Preview 230
Wireframe 230

Perspective window
features of 14
interface element 6

rds5IX  Page 414  Wednesday, July 2, 1997  4:39 PM
414 Ray Dream Studio User Guide

cross sections 111, 127
preferences 54

Numerical
positioning 237
resize 240
tab 152

O
Object

scaling 394
Object class

modify 267
replace 267

Object Face
defined 391

Object index, artwork settings 366
Object instances 267
Object Invisible command 230
Object Preview 226, 229
Object shading layers 194
Object Visible command 230
Objects 266

3D Primitives 98
adding to a group 258
Align on gravity 244
Align on Universe 244
align on working box 243
aligning 44, 245
aligning on universe 244
arranging 232, 404
class 9, 266
complex 98
control points 116
coordinate system

defined 393
copying 35
creating 99
cutting 35
decimating 160
defined 393
deleting 35
displaying 8
dragging 235
duplicating 45, 247, 248, 333
filling holes 158

flipping 249
free resizing 239
free rotating 241
geometric primitive 99
grouping 46
height, width, and depth 240
individual properties 296
intersection 169
invisible 41
joining 169
jumping in 112, 253, 254
jumping out of 113
keep proportions 240
limiting number 17
link 263
locking Hot Point 234, 237
mapping modes 169
Mesh Form modeler 140
metamorphosis 16
mirroring 243
nudging 236, 237
numerical orienting 242
numerical resizing 240
orienting 232, 240
pasting 35
polymesh 151, 156
position 232
previewing 8
reflective 371
relative alignment 244
remove from group 258
replace 252
resetting alignment 244
resizing 238
retrieving 30
rotating 43
saving 29
selecting 231
shading 169
sharpen 159
smoothing 158
subdividing 160
subtracting 169
sweep 165
symmetry 249
tab

Browser palette 9, 30
Hierarchy area 266

thickness 157
transparent 371
triangulating 160
twisting 123
viewing all 34

Offset command 161
Offsetting, surfaces 161
On Gravity command 228, 244
On Universe command 244
On Working Box command 243
On-line help x
Opacity, of paint shape 191
Open command 28
Opening

files 2, 4, 28, 38
Free Form modeler 112
groups 258
Mesh Form modeler window 5

Operations, repeating 36
Operator

components 199
Operator, defined 393
Operators 199

Mix 199
shader 199

Orientation 224
defined 393
resetting 244

Orienting
numerically 242
object 240

Oscillate tweener 312
applying 84
Bounce wave shape 313
damping 313
introduction to 15
Saw/Loop wave shape 313
Sine wave 312
Square wave 312
Triangular wave shape 313

Outdoor templates 27
Outline mode 255
Overlap movement 18
Oversampling, defined 393
Overview 5, 340
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moving around 33 Points general 24 fog 101
Fountain 99
Geometric 98
Infinite plane 104

Printing 378, 403
Production Frame 285, 361

defined 394
using 361

Projection mapping 193
modes 383

Projections
defined 394
on working box 231

Proofing 340
Properties 286

animatable 14, 296
defined 394
hierarchy of 299
individual object 296
object-specific 296
of lights 296

Properties palette 10, 122
Action Modifiers tab 150, 169
Deformer tab 172, 179
Free Form modeler and 10
Links tab 261
Mapping mode tab 170
Mesh Form modeler and 10
Numerical tab 152
Shading tab 191, 403
Tool Options tab 58, 155
Transform tab 42

Proportions 239
keep while resize 240

PSD file format
see PhotoShop file format (*.PSD)

Punch deformer 175

Q
Quality display preview 25
QuickTime movies

frame size 370
rendering, and 14
rotoscoping with 16
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Time Line window and 38
using 7
viewpoint 271

Perturbation slider 209, 210
Photo Studio wizard 27
PhotoDisc xiv
Photo-JPEG codec 364
PhotoShop file format (*.PSD)

exporting 2, 4
importing 2, 4, 380

Physical Forces 318
Apply Physical Effects 320
Damping Force 324
Directional Force 322
Initial Velocity 321
Point Force 323
preferences 325
Rotational Force 323
using 319

Physically-based behaviors 79
Pipeline extrusion method 131

defined 393
Pitch 228, 240, 243

defined 393
Pixel color 366

artwork settings 366
Pixels

defined 393
resolution and 360

Pixmap, defined 393
Plane Display tool 147, 226
Planes

defined 393
displaying 39

Plug-ins
filters 375
using 23

Plus sign 255
Point At behavior 16, 70, 315, 404

applying 315
Point At command 244, 276, 287, 

315
Point Force behavior 323

setting options 323
Point of view 235

defined 393
Pointing

cameras 244

adding 120
converting 119
curve 119
defined 393
deleting 119
moving 49, 118
selecting 118
viewing 118

Polygon
cross sections and lofting 166

Polygon tool 121
Polygons

cross sections and lathing 166
drawing plane and 143

Polyline
cross sections and lofting 166
defined 138

Polyline cross sections
lofting 166

Polyline tool 148, 151, 166
Polymesh objects 151

aligning 157
Boolean objects and 167
creating 151
duplicating 152
mapping modes 169
moving 161
scaling 162
shading 169
sizing 163
transforming 161
working with 156

Polymesh Primitive tools 148
Position

absolute 393
artwork settings 366

Positioning 224
numerically 237
objects, a lesson 41
relative 393
spot lights 276
working box numerically 228

Preferences
Browser palette 29
color 24
duplicating 45
for scratch disk 23
General 36

grids 26, 150
Hierarchy 33
Imaging 23
Mesh Form modeler 141
numbering 54
Perspective 26
preferred plane 227
Scene Wizard 28
Shaded Preview 24
undo levels 36
workspace 10

Preferred plane
moving objects 235
preferences 227

Preset command 289
Preset Position command 34, 35, 

50
Drawing Plane 47, 143, 163

Preset Render Settings 367
Preview command 115
Preview modes 8

Better Preview 8, 183
Bounding Box 8
Box 183
Mesh Form modeler 144
No Preview 8
Preview 8, 183
Shaded Preview 8
Wireframe 8, 183

Preview quality 25
Preview, defined 393
Previewing

an animation 304
current display quality 304

Previous command 54
Primers 182, 184

and paint shapes 190
apply all channels 185
apply shader to 184
editing 219
replacing channels 185

Primitives
3D objects 98
Cloud 100
creating 58
defined 97, 394
Environmental 99
Fire 103



R vertices 154 batch queue 368

3

RGB
defined 391
troubleshooting and 403

RIF file format 4
Roll

defined 394
numerical option 243
orientation option 228, 240

Root 254, 258
current 255, 257
defined 394

Rotate command 123
Rotate Drawing Plane 

command 142
Rotating

cross section shapes 122
drawing plane 142
objects 43, 241
shapes 122
twist 123

Rotation tool 224, 242
Rotation, constrain 242
Rotational Force behavior 323
Rotoscoping 16, 337

a lesson in 89
AVI movies and 16
paint shapes 334
QuickTime movies and 16
texture maps 334

Rounded Rectangle tool 121

S
Sample project ix
Save As command 30, 36
Save command 36
Save Position command 292
Save Selection command 153
Saving

a position as a preset 292
cameras 29
files 36
lights 29
objects 29
selections 153
to Browser palette 29

Saw/Loop wave shape 313
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RAM
additional 401
requirements 2, 3, 22, 400

Range, light source 274, 275
RAVE Hardware renderer 25
RAVE Software renderer 24
Ray Dream Designer 3 file format 3
Ray Dream Studio, launching 22
Ray Dream Z Buffer renderer 24
Ray Tracer 270, 371

defined 394
renderer 342, 371
rendering 343

RDI Ray Tracer 92
Re-calculate, group bounding 

box 259
Rectangle tool 120, 152, 402
Redo command 36
Reference, defined 394
Reflected Background

defined 390
tab 405

Reflected Background tab 405
Reflected color 342
Reflection 342, 343

channel 215
defined 394
removing 371
rendering 342, 343

Reflective objects, limiting 371
Refraction 216, 343

channel 216
defined 394
removing 371
rendering 343

Relative
alignment 390
position 393

Remove command 127
Removing

Browser palette directory 32
cross sections 126
objects from group 258
position preset from the 

list 292
preset render settings 367
selected objects 241

Render Effects dialog 405
Render file formats

AVI movies, and 14
QuickTime movies, and 14
sequential bitmap files 14

Render Filters
adding to Browser palette 30
tab 9

Render Preview tool 76, 184, 271
Render range 297, 301, 303
Render Settings dialog

Image Size tab 404, 406
Rendered artwork settings

adaptive oversampling 343
distance 366
dpi 360
estimate 360, 361
file format panel 362
height 360
image size 360
mask 366
normal vector 366
object index 366
pixel color 366
position 366
ray tracing options 343
reflection 342, 343
refraction 343
resolution 360
shadows 342, 343
silhouette quality 343
surface coordinate 366
width 360

Renderers
Adaptive 342
Direct3D Hardware, shading 25
Direct3D Software, shading 25
Draft Z-Buffer 342, 370
Natural-Media 342
RAVE Hardware, shading 25
RAVE Software, shading 24
Ray Dream Z Buffer, shading 24
Ray Tracer 342, 371

Rendering 340
3D objects and 12
a lesson in 92
adaptive oversampling 343
atmosphere 344

camera 362
defined 394
description 339
Effects 296
environment 345
estimate time required 360, 

361
final animation 14
fog 344
G-Buffer 340
image size 360
image window 371
interrupting 406
ray tracing options 343
reducing time 370
reflection 342, 343
refraction 343
Render Artwork 368
shadows 342, 343
silhouette quality 343
time 360, 406
without compression 17

Repeating operations 36
Replacing

object class 267
objects 252

Reset Drawing Plane command 14
Reset Orientation command 244
Resetting, orientation 244
Resize command 162
Resizing 238

free 239
height, width, and depth 240
numerically 240
objects that touch 239
proportional 240
the Production Frame 361

Resolution
artwork settings 360
defined 394
rendered image 403
texture 25

Restore Selection command 153
Retrieving

cameras 30
from the Browser palette 30
lights 30
objects 30
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Scale Selections Multiply operator 207 polymesh objects 169
process 182
tab 191, 403

Shading layers 194
Instance layer 194
Master 195
Master and object 194
Object layer 194

Shading tab 191, 403
Shadow Intensity 405
Shadows 273, 342, 343, 370

controlling strength 273
intensity of 405
light 273
Phong rendering 405
rendering 342, 343

Shaft link 261, 262
Shapes

defined 394
grouping 123
numbering 111, 127
numbers 53
rotating 122
scaling 124

Sharpen Edges command 159
Sharpen, objects 159
Shatter deformer 176
Shine the light from behind 

option 273
Shininess channel 214
Show command 55
Show Grid 227
Show Shape Numbers 

command 54, 127
Shuffle button 209, 210
Sides, alignment 246
Silhouette Quality

rendering 343
Simultaneous viewing 35
Sizing

modeling box 115
polymesh objects 163
Text objects 106

Skinning modeling technique 111
Slider link 261, 262
Smooth Edges command 60, 159
Smooth Surfaces 383
Smoothing

edges 159

rds5IX  Page 417  Wednesday, July 2, 1997  4:39 PM
changing time scale 302
command 124
objects 239

Scaling
along sweep path 110
cross section shapes 124
modeling box 115
objects 394
polymesh objects 162
shapes 124
text 394

Scaling Conversion Factor 383
Scaling envelope 132–134

animating 16
description lines 114
edit 134
importing 125
overview 110
scaling reference point 134

Scene templates 27
Scene Wizard 252, 395

preferences 28
using 27

Scenes
adding an entire scene 252
creating 27
defined 6
simplifying for animation 17
simultaneous viewing 35
viewing 34
zooming 33

Scratch disk
preferences 23
selecting 23

Scroll bars 285
Secondary motion 19
Segments, deleting 120
Selecting

cameras 34
G-Buffer channels 366
groups, in Mesh Form 

modeler 145
in Mesh Form modeler 144
objects 231
points 118
scratch disk 23

Selection command 229
Selection tool 43, 118, 145

adding objects 241
hiding 153
saving 153
working with 153

Send Drawing Plane To 
command 142

Send Working Box To 
command 229

Sending, working box 228
Sequential bitmap files 14
Set Crease Angle command 159
Setting

a link slider control 263
Axis Rotation controls 263
light brightness 273
light color 273
light properties 272

Setting up
working box 26
workspace 25

Shaded Preview
command 115
mode 8, 63
preferences 24

Shader channels 213
animating components of 337
Bump 214
Color 213
defined 392
Glow 216
Highlight 214
Reflection 215
Refraction 216
Shader Editor 183
Shininess 214
Transparency 215
understanding 198

Shader components 198, 201
Add operator 207
animatable 336
Basic 198, 201
Cellular function 208
Checkers function 210
Color 201
defined 391
Functions 198, 199, 207
Marble function 210
Mix operator 206

Operators 198, 199
placing on tree 221
removing 222
Spots function 209
Subtract operator 207
texture map 202
Value component 202
Wires function 211
Wood function 209

Shader Editor 183, 336
Channel tabs 217
components 392
contents 217
Display modes 220
Preview 183
previewing 217

Shader Mapping command 170
Shader Tree

Build 221
defined 198
Edit 221
Multi-level 219
navigating 219

Shaders
a lesson in 62
adding to Browser palette 30
animating 336
building animatable 336
channels 198
components 198
Composite 200, 217, 221
creating 218
defined 198
editing 219
external image files 196
Global Mix 200, 218, 221
Glow 216
in the Browser 183
introduction to 182
operators 199
specifying shader type 221
Subshaders 199
tab 9

Shading
3D objects 11
entire object 184
imported objects 383
infinite plane 104



objects 158 animating 16 black and white 203, 213, 216

)
, 

introducing 6, 8
Masters tab 9
Objects tab 9
scrolling 404
setting up 38
Time Line area 299
Time Line mode 8, 14, 32
using 32

Time Scale button 301
Time tracks 14, 298, 299
Time unit divisions

changing 302
Timeline command 33
Timing, animations and 19
Tool Options tab 58, 155
Tool tips, using xi
Toolbars 10

command 26, 38
customizing 26
hiding/displaying 26
locking/unlocking 27
Mesh Form modeler 144
Modeler 7
setting up 38

Torus
distance to axis 136
lathing and 136

Track 291
defined 395

Track behavior 16, 317
applying 317

Track, defined 391
Trackball Rotation tool 163
Tracking

a rotating object 317
an object 317

Transform tab 42
Transformation 299
Transforming polymesh 

objects 161
Transition Options dialog 310
Transitions 295
Translation extrusion method 131
Translation, defined 395
Translucence, defined 395
Transparencies 280

removing 371
Transparency

channel 215
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Snap to Grid 227
Software support

Macintosh 2
Windows 4

Space, alignment 245
Specific light source 271
Sphere of Attraction tool 148, 155
Sphere tool 152
Spherical Morph deformer 177
Spike deformer 177
Spin behavior 16, 317

applying 317
cycles per second 317

Spiral sweep paths 132
cross section scaling 132
distance to axis 132
spiral scaling 132

Spot light 272, 273, 274
Spots function 209
Squash, principles 18
Startup screen 22
Storyboarding 16
Straight extrusions 165
Stretch deformer 178
Stretch, principles 18
Sub branch 258
Sub-branches 254
Subdivide command 58, 160
Subdividing objects 160
Subshaders

copying to channels 222
defined 199
Jump into 220
Jump out of 220
placing on tree 221
removing 222

Subtract operator 207
Subtracting objects 169
Sunlight filtering 280
Surface coordinate, artwork 

settings 366
Surface fidelity 116
Surface, offsetting 161
Sweep command 165
Sweep objects, creating 165
Sweep path

preset 131
Sweep paths 110, 129–132

defined 394
description 113
draw in 3D 129
importing 125
overview 111
Path description lines 129
scaling 110
spiral preset 132
straighten 131

Sweep tool 149
Switching between cameras 292
Symmetrical envelopes 134
Symmetrical In Plane 

envelopes 134
Symmetry

duplicating with 249
object 249

System memory 400
System requirements

Macintosh 2
Windows 3

System resources, increasing 401

T
Tag Image File Format (*.TIF)

defined 394
exporting 3, 4
importing 3, 4, 380

Targa file format (*.TGA)
exporting 4
importing 4

Technical Support xiii
before calling 398

Temporary object 276
Text alignment 390
Text objects

creating 105
editing 106
scaling 394
size 106

Texture Map components 215
Glow channel 217

Texture Map gel 280
Texture maps 193, 202, 370, 402

bit size of 371

component 202
defined 394
external 196
filtering an image 205
grayscale 203, 213
importing 205
limiting size 371
mapping modes 193
rendering 370
saving externally 203
saving internally 203
tile 203, 204

Textures
resolution 25
solid 403

TGA file format
see Targa file format (*.TGA)

Thickness, objects and 157
Three-dimensional, defined 394
TIF file format

see Tag Image File Format (*.TIF
Tighten In/Out tweener control 18

312
Tile 206, 283, 284
Tiling 203, 204, 395

infinite plane 105
seamless 205
textures 403

Time
changing 297
changing current 302
current 14, 301
increment markers 14

Time Axis 14, 77, 298, 301
Time Controller toolbar 77, 303

displaying 15, 304
Time Edit Controller 301, 303
Time Line

area 299
editing 306

Time Line mode 254
displaying 32
Time Line window 8, 14

Time Line window 297
changing mode 32
Effects tab 9
Hierarchy area 298
Hierarchy mode 8, 14, 32
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channel, and rotoscoping 337 Unlocking, toolbars 27 Virus protection 2 direction 209
Word spacing 395
Working Box 224, 225, 395

align objects with 228, 243
attitude and position 227
defined 39
grid settings 226
grids 26
introduction to 7
move 227
orientation 228
Plane Display tool 226
Preferred plane 

preferences 227
resize 228
using the 227

Working box
coordinate system 395
setting up 26
viewing 34

Workspace 7, 224
command 25
configurations 26
font size 25
preferences 10
setting up 25, 38

WORLD system 383

Y
Yaw 228, 240, 243

defined 395

Z
Z-Buffer 395
Zoom

in Perspective window 33
ratio 7, 372

Zoom pop-up 225
Zoom To Actual Size tool 34
Zoom To All Objects tool 34
Zoom To Working Box tool 34
Zoom tool 33, 147, 224, 285
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option 343
Transparent

color 342
objects, limiting 371

Transparent color 342
Tree of elements 254
Triangular wave shape 313
Triangulate Polygon command 160
Triangulating object 160
Troubleshooting, installation 4
TrueType fonts 2, 3
TSR applications

conflicts 401
turning off 401

Tweeners
a lesson in 78
adding key event 307
animation and 16
applying 310
Bézier 15, 18, 311
controls 312
Discrete 15, 311
Formula 313
Linear 15, 310, 312
Oscillate 15, 312
understanding 15

Twist and Bend deformers 173
Twisting objects 123
Two-dimensional, defined 395
Type 1 PostScript fonts 2
Typical installation 3

U
Uncentered cross sections 131
Uncloaked objects 297
Undo command 36, 246
Undo levels, setting 36
Undulation slider 209, 210
Ungroup command 123
Universe 232, 254, 395

aligning on 244
as workspace 7
coordinate system 224

Unlink command 155
Unlinking a child object 260

Updating, Browser palette 32
User Coordinate System 383
User guide

about ix
conventions ix

Using Ray Dream Studio with other 
applications 379

V
Value component 202

blending 213
Vein Blending slider 209, 210
Vein count slider 209, 210
Vertex

defined 138
drawing plane and 143

Vertices
adding 154
Bézier curves and 116
defined 58, 395
grouping 156
linking 154, 155
moving 155
removing 154
welding 156
working with 154

Video codec 365
Video drivers, incompatibility 399
Viewing

actual size 34
all objects 34
Browser palette 29
camera 17
points 118
scenes 34
simultaneous 35
tools 224
working box 34
your scene 12

Viewpoint 285
defined 393, 395
Mesh Form modeler and 144

Viewpoint Datalabs xiv
Virtual Trackball tool 115, 224, 

227, 241, 404

W
Warp deformer 178
Wave deformer 179
Web site

connecting to x
help x

Welding, vertices 156
White is invisible option 205
Width, image size 360
Windows

compatible graphics card 3
displaying 26
hiding 26
installation 3
modeling 7
movie formats 14
software support 4
system requirements 3
Time Line window 8

Windows Bitmap file format (*.BMP)
exporting 4
importing 4, 380

Windows Metafile file format 
(*.WMF), importing 4

Windows PaintBrush file format 
(*.PCX)

exporting 4
importing 4

Wireframe
command 115
effect, creating 216
mode 8

Wires function 211
Wizards 395

applying 28
Indoor Step by Step 27
modeling 107
Photo Studio 27
preferences 28

WMF file format
see Windows Metafile file format 

(*.WMF)
Wood function 209
Wood grain pattern
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arising out of the use or inability to use 
the software or documentation, even if 
Fractal Design Corporation has been 
advised of the possibility of such 
damages.

The warranties and remedies set forth 
above are exclusive and in lieu of all 
others, oral or written, express or implied.

Fractal Design Corporation is not 
responsible for any costs including, but 
not limited to, those incurred as a result 
of lost profits or revenue, loss of time or 
use of the software, loss of data, the costs 
of recovering such software or data, the 
cost of substitute software, claims by third 
parties, of other similar costs. In no case 
will Fractal Design Corporation’s liability 
exceed the amount of the license fee.

The warranties provided give you specific 
legal rights. You may have other rights 
which vary from state to state. Some states 
do not allow the exclusion of incidental 
or consequential damages, or the 
limitation of how long an implied 
warranty lasts, so some of the above may 
not apply to you.

 

7) U.S. Government Restricted Rights 

 

Fractal Design Ray Dream Studio and 
documentation thereto are provided with 
RESTRICTED RIGHTS. Use, duplication or 
disclosure by the Government is subject 
to restrictions as set forth in subparagraph 
(c)(1)(ii) of the Rights in Technical Data 
and Computer Software clause at 52.227-
7013. The contractor/manufacturer of 
Ray Dream Studio and documentation 
thereto is Fractal Design Corporation, P.O. 
Box 66959, Scotts Valley, CA 95067-6959, 
(408) 430-4000.
THIS LICENSE AGREEMENT IS A LEGAL 
AGREEMENT BETWEEN YOU, THE END 
USER, AND Fractal Design Corporation. IT 
IS A LICENSE AGREEMENT AND NOT AN 
AGREEMENT FOR SALE. PLEASE READ 
THIS LICENSE AGREEMENT CAREFULLY 
BEFORE OPENING THIS SEALED 
PACKAGE. IF YOU DO NOT AGREE WITH 
THE TERMS AND CONDITIONS OF THIS 
LICENSE AGREEMENT, PROMPTLY 
RETURN THE PACKAGE UNOPENED TO 
THE PLACE YOU OBTAINED IT AND 
YOUR MONEY WILL BE REFUNDED.

Fractal Design Software License

1) License 

This software can only be used on a 
single computer at any one time. This 
means that the software should be 
loaded on only one hard drive at a time. If 
you wish to use this software on more 
than one computer, you must either erase 
the software from the first hard drive 
when you move the software to a second 
hard drive, or else purchase two copies of 
the software. You may not under any 
circumstances have this program loaded 
onto the hard drives of two or more 
computers at the same time. You also may 
not copy this software onto a hard drive 
and then use the disks on another 
computer. The software may be executed 
from a common disk shared by multiple 
computers provided that one authorized 
copy of the software has been licensed 
for each computer executing the 
software.

2) Copyright 

This software is owned by Fractal Design 
and is protected by United States 
copyright laws and international treaty. By 
law, you, the end user, may do the 
following:

a) make a copy of the software solely for 
backup or archival purposes; or

b) transfer the software to a single hard 
disk, provided you keep the original 
solely for backup or archival purposes.

United States copyright laws prohibits you 
from making any other copy of the 
software for any reason without our 
permission. These federal copyright laws 
also prohibit you from copying the 
written materials accompanying the 
software without first obtaining our 
permission. 

3) Restrictions 

You may not rent, lend, lease, or assign 
this software. You may, however, transfer 
the software and the accompanying 
written materials on a permanent basis. 
When you transfer the software on a 
permanent basis, you may not keep any 
copies, and you must remove the 
software from your hard disk. Also, the 
person to whom you transfer the software 
must agree to the terms of this License.

You may not alter, modify or adapt the 
software or accompanying materials. In 
addition, you may not translate, 
decompile, disassemble or reverse 
engineer the software. You also may not 
create any derivative works based on this 
software. A derivative work is defined as a 
translation or other form in which the 
software may be recast, transformed or 
adapted.

4) Limited Warranty 

Fractal Design Corporation warrants t
this program will perform in substant
compliance with the published 
specifications and documentation 
supplied in this package, provided it i
used on the computer hardware and 
the operating system for which it was
designed. This warranty is limited to a
period of 90 days from the date of the
original purchase. 

Fractal Design Corporation warrants t
the original disks and documentation
free from defects in material and 
workmanship, assuming normal use, f
period of 90 days from the date of 
purchase. 

5) Remedies 

If you report a significant defect in 
performance of the software in writin
within 90 days of purchase, Fractal De
Corporation will attempt to correct it 
its option, authorize a refund of your 
license fee.

If a defect in the disk or documentati
occurs during this period, you may re
the faulty disk or documentation, alo
with a dated proof of purchase, and 
Fractal Design Corporation will replac
free of charge.

6) No Other Warranties 

Except as specifically provided above
Fractal Design Corporation makes no
other warranty or representation, eith
express or implied, with respect to thi
software, the disks or documentation,
including their quality, merchantabilit
fitness for a particular purpose. In no 
event will Fractal Design Corporation
liable for direct, indirect, special, 
incidental, or consequential damages
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	To duplicate objects:
	1 Click the SeaTerrain in the Time Line 1 window a...
	2 Drag the object labeled Anemone out of 2 the Bro...
	3 Choose Windows menu> Properties. 3 The Propertie...
	4 Click the Transform tab.
	5 In the Position controls, enter X=46, 5 Y=�10 an...
	6 Click the Anemone object in the Time 6 Line wind...
	7 Choose Edit menu> Duplicate.
	8 In the Position controls, enter X= 42.75, 8 Y= �...
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	To group objects:
	1 In the Time Line window, hold down the 1 Shift k...
	2 Choose Arrange menu> Group. A new 2 group object...
	3 Click the group’s title and type Anemone 3 Bed.
	Moving On



	Modeling Objects
	The Story so Far
	What You’ll Need
	Lesson 1: Free Form Modeling
	To create an oval cross section:
	1 Click the Free Form tool and drag it into 1 the ...
	2 Enter a name for your object and 2 click�OK.
	3 Choose View menu> Preset 3 Position> Drawing Pla...
	4 Choose View menu> No Preview.
	5 Choose Geometry menu> Extrusion 5 Method> Pipeli...
	6 Click the Zoom tool and enlarge an area 6 of the...
	7 Press on the Square tool to pop-up and 7 choose ...
	8 Click a point on the cross section plane 8 and d...
	9 Press Command-Shift-C/Ctrl+Shift+C to 9 center t...

	To use multiple shapes in a cross sections:
	1 Choose the Selection tool and click the 1 oval.
	2 Choose Edit menu> Copy.
	3 Choose Edit menu> Paste.
	4 Deselect all shapes.
	5 Hold down the Shift key and drag the 5 oval to t...
	6 Choose Edit menu> Select All to 6 select both sh...
	7 Choose Arrange menu> Combine as 7 Compound.
	8 Press Command-Shift-C/Ctrl+Shift+C to 8 center t...
	9 Choose View menu> Preset 9 Position> Reference.
	º Click the Zoom tool.
	¡ Hold down Option/Alt and click the center of the...

	To add points to the sweep path:
	1 Click the ground plane to make it active.
	2 Choose View menu> No Preview.
	3 Hold down the Shift key and click the 3 sweep pa...
	4 Choose Geometry menu> Extrusion 4 Envelope> Symm...
	5 Double-click the Convert Point tool to 5 choose ...
	6 Click the sweep path. A new point is 6 added.
	7 Add two more points to the sweep path.

	To move points:
	1 Choose the Selection tool.
	2 Click the second point and drag it to the 2 left...
	3 Click the next point and drag it to 3 the�right....
	4 Click the next point and drag it to 4 the�left.
	5 Press on the Add Point tool to pop-up 5 and choo...
	6 Click each point on the sweep path and 6 drag up...
	7 Choose View menu> Preset 7 Position> Right.
	8 Click the Zoom tool and zoom in on the 8 sweep p...
	9 Click the second point on the sweep path 9 with ...
	º Click the next point and move it up.
	¡ Click the next point and move it down.

	To adjust the extrusion envelope:
	1 Click the final point on one of the 1 envelope l...
	2 Choose View menu> Preset 2 Position> Reference.
	3 Click Done.


	Lesson 2: Complex Free Form Modeling
	To create multiple cross sections:
	1 Open the Free Form modeler.
	2 Press to pop-up and select the Draw 2 Oval tool....
	3 Hold down the Shift key and draw a 3 circle abou...
	4 Press Command-Shift-C/Ctrl+Shift+C to 4 center t...
	5 Choose View menu> Preset 5 Position> Reference.
	6 Choose the Add Point tool.
	7 Click the sweep path on the ground 7 plane and a...
	8 Choose Sections menu> Create.
	9 Choose the Selection tool.
	º Click the new cross section and choose View menu...
	¡ Choose View menu> No Preview.
	™ Choose Sections menu> Next. If Next is not avail...
	£ Choose the Oval tool.
	¢ Hold down the Shift key and draw six smaller cir...
	° Choose View menu> Preset Position> Reference.
	§ Choose the Selection tool.
	¶ On the ground plane, click the last point on the...
	• Hold down the Shift key and drag it to the end o...
	ª Choose Sections menu> Create. A new cross sectio...

	To adjust shape numbers:
	1 Click the last cross section on the sweep 1 path...
	2 Choose Sections menu> Show 2 Shape Numbers.
	3 Choose Sections menu> Previous.
	4 Choose Sections menu> Previous 4 again. You shou...
	5 Choose Sections menu> Next.
	6 Click a cross section number. The Shape 6 Number...
	7 Change the number of the cross sections 7 to mat...
	8 Choose Sections menu> Next.
	9 Select shape #1 and delete it. All the 9 numbers...
	º Change the shape numbers to match the diagram sh...
	¡ Click shape #2 with the Selection tool.
	™ Choose Windows menu> Properties.
	£ In the Position controls, enter Width=0.25, Hieg...
	¢ Click Apply.
	° Repeat steps 11 to 14 for each of the remaining ...

	To add more sections:
	1 Click the ground plane to make it active.
	2 Choose the Add Point tool.
	3 Add a point between the second and last 3 cross ...
	4 Choose Sections menu> Create.
	5 Click the new cross section.
	6 Choose View menu> Preset 6 Position> Drawing Pla...
	7 Choose Sections menu> Show> 7 Current.
	8 Drag the circles away from the center as 8 shown...
	9 Choose View menu> Preset 9 Position> Reference.
	º Click the Shaded Preview Quality button.
	¡ Choose Sections menu> Show> All.

	To adjust the object’s envelope:
	1 Choose Geometry menu> Extrusion 1 Envelope> Symm...
	2 Choose the Add Point tool.
	3 Add a point on the envelope as shown.
	4 Choose the Selection tool.
	5 Drag the new point down and to the left 5 as sho...
	6 Choose the Convert Point tool.
	7 Smooth the points as shown.
	8 Click Done.


	Lesson 3: Mesh Form Modeling
	To open the Mesh Form modeler:
	1 Drag the Mesh Form tool into the 1 Perspective w...
	2 Enter a name for your new object and 2 click OK....

	To create a 3D primitive
	1 Choose the Create Sphere tool.
	2 Drag the tool in the Mesh Form modeling 2 window...
	3 Choose the Selection tool.
	4 Click the top right point of the sphere’s 4 boun...

	To edit an object’s mesh:
	1 Choose View menu> Preset 1 Position> Left.
	2 Choose the Marquee tool.
	3 Drag to select the back half of the 3 sphere.
	4 Choose Selection menu> Subdivide.
	5 Click the Sphere of Attraction tool.
	6 Choose Windows menu> Properties. 6 The Propertie...
	7 Click the Tool Options tab.
	8 Select the Spiky radio button.
	9 Set the Radius of Sphere to 4.00.
	º Click outside the sphere to deselect it.
	¡ Select the left-most point on the sphere and dra...

	To create the fish’s tail:
	1 Click the Zoom tool.
	2 Zoom in on the extended section.
	3 Click the second point from the left on 3 the to...
	4 Drag the point up and towards the left as 4 show...
	5 Click the second point from the left on 5 the bo...
	6 Drag the point down and to the left.
	7 Choose the Sphere of Attraction tool.
	8 In the Properties palette: Tool 8 Options tab, e...
	9 Click a point on the top edge of the 9 object an...

	To smooth object edges:
	1 Choose the Marquee tool and select the 1 entire ...
	2 Choose Poly Mesh menu> Smooth 2 Edges.
	3 Click Done.


	Lesson 4: Deformers
	To apply a deformer:
	1 If you haven’t done so already, add the 1 Modeli...
	2 Drag the Mesh Form Fish object from the 2 Browse...
	3 Choose Windows menu> Properties.
	4 Click the Deformers tab.
	5 Choose Wave from the Defomers pop-up.
	6 If it is not already enabled, enable the 6 Auto ...
	7 Set Phase to 0.
	8 Orientation to X Axis.
	9 Set Number of Wave cycles=1.5.
	º Set Height of waves =08%.
	¡ Click the Direct Manipulation button.
	™ Click the center point and drag it to the left. ...
	£ Close the dialog.
	Moving On



	Shading Objects
	The Story so Far
	What You’ll Need
	To add lesson files to the Browser palette:
	1 Click the Objects tab and choose 1 Browser palet...
	2 Locate and open the Tutorial folder on 2 the Ray...
	3 Click Select Current Directory.
	4 Click the Shaders tab and choose 4 Browser palet...
	5 Locate the Tutorial folder on the Ray 5 Dream St...
	6 Click Select Current Directory.

	Lesson 1: Creating Shaders
	To change the preview mode:
	To create new shader:
	1 Drag the Shell object from the Browser 1 palette...
	2 Choose the Eyedropper tool.
	3 Click the Shell.
	4 Click the Color tab.
	5 Choose Shader Editor: Insert 5 menu> Texture Map...
	6 Locate the file Tutorial: Shading 6 Objects: SHE...
	7 Click the Highlight tab.
	8 Set the value to 50.
	9 Click the Shininess tab and set the value 9 to 5...
	º Click the Bump tab.
	¡ Choose Shader Editor: Insert menu> Texture Map.
	™ Locate the file Tutorial: Shading Objects: SHELL...
	£ Set Brightness to 30%.
	¢ Click Apply.

	To save a shader in the Browser palette:
	1 Click the Browser palette: Shader 1 tab.
	2 In the Current Shader Editor, click the 2 shader...
	3 Enter a name for the shader.


	Lesson 2: Applying Shaders
	To apply a shader uniformly:
	1 Drag the object labeled Angel Fish from 1 the Br...
	2 Click the Shaders tab.
	3 Locate the drag the Angel Fish Skin 3 shader fro...

	To a place a paint shape on an object:
	1 Click the Angel Fish Stripes shader in the 1 Bro...
	2 Choose the Rectangular Paint Shape 2 tool.
	3 Choose View menu> Preset 3 Position> Left.
	4 Drag a large square over the body of the 4 fish....
	5 Choose View menu> Preset 5 Position> Right.
	6 Draw a large square on this side as well.

	To apply a shader using the 3D Paintbrush:
	1 In the Browser palette, click the Fish 1 Skin sh...
	2 Choose the 3D Paintbrush tool.
	3 Set the Size value to 99.
	4 If the palette is not extended, click the 4 Exte...
	5 Set the following:
	6 Choose View menu> Preset 6 Position> Right.
	7 Drag the brush over the top and bottom 7 edges o...
	8 Choose View menu> Preset 8 Position> Left.
	9 Paint over the edges of the fish on this 9 side ...
	º Choose View menu> Reference.
	Moving On



	Setting up Lights
	The Story So Far
	What You’ll need
	To begin setting up lights:
	1 Open the scene file Tutorial: Setting Up 1 Light...
	2 Click the Lights tab.
	3 Choose Browser palette: File 3 menu> Add Directo...
	4 Locate Tutorial: Setting Up Lights folder 4 and ...

	To switch to Shaded Preview mode:
	To render an area of a scene:
	1 Choose the Render Area tool.
	2 Drag the tool over the area you want to 2 render...

	Lesson 1: Adding Lights
	To set ambient light:
	1 Choose Windows menu> Scene 1 Settings. The Scene...
	2 Click the Effects tab.
	3 Display the Ambient Light controls.
	4 Click the color chip and choose a dark 4 blue co...
	5 Set Brightness to 30%.
	6 Close the palette.

	To add a light:
	1 Drag the Create Light tool into the Time 1 Line ...
	2 Choose Windows menu> Properties. 2 The Propertie...
	3 Click Auto.
	4 Choose Bulb Light from the pop-up.
	5 Disable the Shadows checkbox to save 5 on render...
	6 Click the Direct Manipulations button.
	7 Click the control handle that extends 7 from the...

	To add lights from the Browser palette:
	1 Choose Browser palette: Lights tab.
	2 Drag the light labeled Light Tutor to 2 Time Lin...


	Lesson 2: Positioning Lights
	To position lights using Transform controls:
	1 Click the Bulb light in the Time Line 1 window.
	2 Choose Windows menu> Properties. 2 The Propertie...
	3 Click the Transform tab.
	4 Set Position values to X=0, Y=65, and 4 Z=80.
	5 Click Apply.

	To add the Point At behavior to a light:
	1 In the Time Line window, click the light 1 label...
	2 Choose Windows menu> Properties if 2 the Propert...
	3 Click the Behaviors tab.
	4 Click the Add Component button.
	5 Choose Point At from the list and 5 click�OK.
	6 Type the name Conch Shell in the Point 6 At box....
	7 Make sure the Enabled checkbox is 7 checked.
	8 Click Apply.
	9 To see the results of the pointed light, 9 enabl...


	Lesson 3: Lighting Effects
	To add a gel:
	1 Click the light labeled Key light in the 1 Time ...
	2 Choose Windows menu> Properties. 2 The Propertie...
	3 Click the Gel tab.
	4 Choose Map from the pop-up.
	5 Click the disk icon and choose Open.
	6 Locate the file: Tutorial: Setting Up 6 Lights: ...
	7 Click Apply.
	Moving On



	Setting up Cameras
	The Story so Far
	What You’ll Need
	To begin setting up cameras:
	1 Open the file Tutorial: Setting Up 1 Cameras: CA...
	2 Choose Browser palette: Cameras 2 tab.
	3 Choose Browser palette: File menu> 3 Add Directo...
	4 Locate the Tutorial: Setting Up Cameras 4 folder...

	Lesson 1: Adding Cameras
	To add cameras from the Browser palette:
	1 If the Browser palette is not visible, 1 choose ...
	2 Choose the Cameras tab.
	3 Drag the Camera Set camera from the 3 Browser pa...

	To add cameras using the Create Camera tool:
	1 Choose the Create Camera tool and drag 1 it into...
	2 Choose Windows menu> Properties. 2 The Propertie...
	3 Click the Camera tab.
	4 Choose Conical from the pop-up.
	5 Enable the Normal radio button.
	6 Enable the Auto box.
	7 Click the Direct Manipulation button.
	8 Drag the zoom controls (the triangle 8 extending...
	9 Drag the control handle that extends 9 from behi...
	º On the right plane, click the control handle tha...


	Lesson 2: Viewing your Scene from Different Camera...
	To switch between cameras:
	1 Choose Windows menu> Camera 1 Properties. The Ca...
	2 Choose Camera 2 from the Camera 2 pop�up.
	3 Choose Reference from the Position 3 pop�up. The...
	4 Choose Camera 1 from the Camera 4 pop�up. The vi...


	Lesson 3: Positioning Cameras
	To numerically position a camera:
	1 Select Camera Set in the Time Line 1 window.
	2 Choose Properties palette: 2 Transform tab. If t...
	3 In the Position Controls enter X=23, Y=50 3 and ...
	4 Click Apply.

	To position a camera manually:
	1 Choose Windows menu> Camera 1 Properties. The Ca...
	2 Choose Cameras menu> Camera 2 Tutor.
	3 Choose Position menu> Reference.
	4 Click the Shell object in the Perspective 4 wind...
	5 Choose the Dolly tool from the toolbar.
	6 Drag the pointer down and to the left. 6 The vie...

	To adjust the Production Frame:
	1 Select the Camera Tutor camera in the 1 Perspect...
	2 Choose View menu> Production 2 Frame. A green fr...
	3 Shift-drag one of the points on the 3 production...

	To move the production frame:
	Moving On



	Animating Objects
	The Story So Far
	What You’ll Need
	To begin animating objects:
	1 Open the file Tutorial:Animating 1 Objects: ANIM...
	2 Choose Browser palette: Objects tab.
	3 Choose Browser palette: File menu> 3 Add Directo...
	4 Locate the folder Tutorial: Animating 4 Objects ...

	To set animation time limit:
	1 Make sure the Time Line window is 1 visible. If ...
	2 Click the Time Axis at 00:02:00 and drag 2 it to...

	To display the Time Controller:
	1 Choose View menu> Toolbars. The 1 Toolbars dialo...
	2 Enable Time Controller. A toolbar is 2 visible w...

	Lesson 1: Creating Key Frames
	To create a key frame:
	1 Make sure you’re at the first frame of 1 your an...
	2 Click the Last Frame button on the Time 2 Contro...
	3 Click the Angel Fish object in the Time 3 Line w...
	4 Click Command-T/Ctrl+T to display the 4 Object P...
	5 Click the Transform tab.
	6 Enter the Position values X=34, Y= -16, 6 Z=20 a...
	7 Click the First Frame button.
	8 Click the Perspective window to make it 8 the ac...
	9 Click the Interactivity button. This 9 button sh...
	º Click the Play button to preview your animation....


	Lesson 2: Applying Tweeners
	To apply a Tweener:
	1 In the Time Line window, double-click 1 the time...
	2 Choose Bézier from the pop-up.
	3 Set the Ease-in /out values to 40% and 3 40%.
	4 Set the Tighten-in /out values to 50% and 4 50%....
	5 Click the First Frame button then click 5 Play t...


	Lesson 3: Applying Behaviors
	To apply physically-based behaviors:
	1 Drag the Mesh Form Fish object out of 1 the Brow...
	2 Choose Windows menu> Properties. 2 The Propertie...
	3 Enable the Auto checkbox.
	4 Click the Behaviors tab. If the tab is not 4 vis...
	5 Click the Add button. The Add dialog 5 appears.
	6 Select Apply Physical Effects and 6 click�OK.
	7 Enable the Movable by impact checkbox.
	8 Click the Add button again.
	9 Choose Flow Force from the list and click 9 OK. ...
	º Set the Turn Density to 70%.
	¡ Enable the Rotate with flow checkbox.

	To duplicate objects:
	1 Select the School Fish in the Perspective 1 wind...
	2 Drag School Fish up and to the left.
	3 Press Command-D/Ctrl+D again. A new 3 fish appea...
	4 Continue duplicating and repositioning 4 the fis...

	To preview behaviors:
	1 Click the Interactivity button.
	2 In the Time Line window, drag the end of 2 the a...
	3 Click the First Frame button and then 3 click Pl...
	Moving On



	Animating Shapes
	The Story So Far
	What You’ll Need
	To begin animating shapes:
	1 Make sure the Browser palette is visible. 1 If i...
	2 Click the Objects tab.
	3 Choose Browser palette: File menu> 3 Add Directo...
	4 Locate the folder Tutorial: Animating 4 Shapes a...

	Lesson 1: Animating the Extrusion Path
	To animate an object using the sweep path:
	1 Drag the Seaweed object from the 1 Browser palet...
	2 Click the Last Frame button.
	3 Double-click the seaweed in the 3 Perspective wi...
	4 Select the Zoom tool and zoom in on the 4 sweep ...
	5 Choose the Selection tool.
	6 Click the second point on the sweep path 6 and d...
	7 Click the third point and drag it to the 7 oppos...
	8 Click the fourth point and repeat step 7.
	9 Choose View menu> Preset 9 Position> Left.
	º Zoom in on the horizontal sweep path.
	¡ Click on the second point on the sweep path and ...
	™ Click the third point and drag it down.
	£ Click the fourth point and drag it up.

	To apply the Oscillate tweener:
	1 Double-click between the first and last 1 frame ...
	2 Choose Oscillate from the Tweener 2 pop�up.
	3 Set the Nbr Oscillation slider to 2 and 3 click�...
	4 Click the First Frame button on the Time 4 Contr...
	5 Click Play.


	Lesson 2: Animating the Mesh Form Modeler
	To animate an object by repositioning its vertices...
	1 Make sure the Objects tab is selected on 1 the B...
	2 Click the First Frame button. If the 2 button is...
	3 Double-click the fish to open the Mesh 3 Form mo...
	4 Choose the Zoom tool.
	5 Zoom in on the fish’s tail.
	6 Choose the Marquee tool.
	7 Select the rear of the tail.
	8 Choose the Sphere of Attraction tool.
	9 Choose Windows menu> Properties 9 and then click...
	º Enable Spiky.
	¡ Set the Radius of Sphere to 30.
	™ Click the center point of the three selected poi...
	£ Click the Last Frame button.
	¢ Drag the center point to the right.
	° In the Time Line window, double-click the time l...
	§ Click Done.
	¶ Click the First Frame button on the Time Control...


	Lesson 3: Animating Deformers
	To animate a deformer:
	1 Make sure you’re on the first key frame 1 of you...
	2 Drag the Mesh Form Fish object from the 2 Browse...
	3 Choose Windows menu> Properties. 3 The Propertie...
	4 Click the Deformer tab.
	5 Enable the Auto checkbox.
	6 Make sure the Phase slider is set to 0%
	7 Click the Last Frame button. The current 7 time ...
	8 Set the Phase slider to 100%
	9 Click the First Frame button and then 9 click Pl...

	To duplicate the deformed fish:
	1 Click the First Frame button.
	2 Click the Mesh Form Fish in the 2 Perspective wi...
	3 Press Command-D/Ctrl+D to duplicate 3 the fish.
	4 Drag the Mesh Form Fish up and to the 4 left.
	5 Click the duplicate fish and press 5 Command-D/C...
	6 Continue moving and duplicating fish 6 until you...
	7 Click the First Frame button and then 7 click Pl...
	Moving On



	Animating Effects
	The Story So Far
	What You’ll Need
	To begin animating effects:
	1 Locate the Tutorial: Animating Effects 1 folder ...
	2 Choose Browser palette: Shaders 2 tab.
	3 Choose Browser palette: File 3 menu> Add Directo...
	4 Locate the folder Tutorial: Animating 4 Effects ...

	Lesson 1: Rotoscoping
	To apply rotoscoping to a light:
	1 Click the Key Light in the Time Line 1 window to...
	2 Click the First Frame button to move to 2 the fi...
	3 If necessary choose Windows menu> 3 Properties t...
	4 Click the Gel tab.
	5 Enable the Auto button.
	6 Choose Movie from the Gels pop-up.
	7 Click the disk icon.
	8 Use the dialog to locate the file 8 Tutorial:Ani...
	9 In the Time Line window drag the key 9 frame ind...
	º In the Properties palette, enable Tile.
	¡ Move the Horizontal slider to 3 times.

	To preview a rendered animation:

	Lesson 2: Animating Shaders
	To animate a shader:
	1 Click the First Frame button to move to 1 the be...
	2 Drag the Shaded Fish from the Browser 2 palette ...
	3 Choose the Eyedropper tool.
	4 Click the Shaded Fish in the Perspective 4 windo...
	5 Click the Last Frame button to move to 5 the end...
	6 In the Current Shader Editor, double- 6 click th...
	7 Click the Color palette button.
	8 Select a green color, then click OK.
	9 Double-click the right color chip, then 9 click ...
	º Choose a light gray color, then click�OK.
	¡ Click Apply.
	™ Choose Render menu> Best Animation Preview. to c...
	Moving On



	Rendering
	The Story so Far
	What You’ll Need
	To open preset files for the rendering lessons:
	1 Locate the folder Tutorial: Rendering 1 and open...
	2 Choose Browser palette: Cameras 2 tab and add th...
	3 Choose Browser palette: Lights tab 3 and add the...
	4 Drag the objects Camera Tutor and Light 4 Tutor ...

	Lesson 1: Rendering an Image
	To choose a renderer:
	1 Choose Render menu> Current 1 Scene Settings. Th...
	2 Click the Renderer tab.
	3 Choose RDI Ray Tracer from the pop-up.
	4 Make sure that all the rendering options 4 are e...

	To set the atmosphere:
	1 Choose Scene Settings palette: 1 Effects tab.
	2 Choose Distance Fog from the 2 Atmosphere pop-up...
	3 Click the plus/arrow icon next to the 3 Atmosphe...
	4 Double-click the Fog Color chip.
	5 Choose a light blue color and then 5 click�OK.
	6 Enter Fog starts= 120
	7 Enter Visibility = 300

	To set Output options:
	1 Choose Scene Settings palette: 1 Output File tab...
	2 Click the plus/arrow icon next to Image 2 Size. ...
	3 Set Width=300 and Height=400.
	4 Set the Resolution to 72 dpi.
	5 Click the plus/arrow icon next to 5 Camera. The ...
	6 Choose Render Camera from the 6 Rendering Camera...
	7 Click the File Format plus/arrow icon. 7 The For...
	8 Choose BMP (RD) from the pop-up.
	9 Click the Save button to save your 9 rendering s...

	To start a rendering:

	Lesson 2: Rendering an Animation
	To render a movie:
	1 Choose Render menu> Current 1 Scene Settings.
	2 Click the Renderer tab and choose a 2 renderer f...
	3 Click the Effects tab.
	4 Choose Distance Fog from the 4 Atmosphere pop-up...
	5 Expand the Atmosphere controls by 5 clicking the...
	6 Click the Fog Color chip and choose a 6 blue col...
	7 Enter Fog starts=300, Visibility=200.
	8 Click the Output tab.
	9 Choose QuickTime/AVI from the pop-up.
	º Set the frame rate to 6fps (frames per second).
	¡ Click Save to save your settings.
	™ Choose Render menu> Use Current Settings. The re...
	Moving On
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	Creating Geometric Primitives
	To create a Geometric Primitive object:
	1 Choose a Geometric Primitive tool from 1 the too...
	2 In the Perspective window, click a point 2 in th...


	Creating Environmental Primitives
	Fountain Primitive
	To create a Fountain object:
	1 Choose the Fountain tool and drag it into 1 the ...
	2 Double-click the new object. The 2 Fountain prim...
	3 Adjust the value of the Completion of 3 Fountain...
	4 Adjust the value of the Start Speed 4 slider.
	5 Adjust the value of the Maximum Angle 5 From Up ...
	6 Adjust the value of the Gravity slider.
	7 Adjust the value of the Maximum Swirl 7 Angle sl...
	8 Adjust the value of the Number of 8 Particles sl...
	9 Adjust the value of the Particle Size 9 slider.
	º Enable or disable the Use particle life for mapp...

	Cloud Primitive
	To create a Cloud object:
	1 Choose the Cloud tool and drag it into 1 the Per...
	2 Double-click the new object. The Cloud 2 primiti...
	3 Click the Color color chip and choose a 3 color ...
	4 Adjust the value of the Quantity of 4 Clouds sli...
	5 Adjust the value of the Cloud Size slider.
	6 Adjust the value of the Density slider.
	7 Adjust the value of the Density slider.
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	To create a Fog object:
	1 Choose the Fog tool and drag it into the 1 Persp...
	2 Double-click the new object. The Fog 2 primitive...
	3 Click the Color color chip and choose a 3 color ...
	4 Adjust the value of the Patchiness slider.
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	¡ Adjust the value of the Completion of Upward Eff...
	™ Adjust the value of the Swirls slider.
	£ Adjust the value of the Swirl Size slider.
	¢ Adjust the value of the Chaos slider.

	Fire Primitive
	To create a Fire object:
	1 Choose the Fire tool and drag it into the 1 Pers...
	2 Double-click the new object. The Fire 2 primitiv...
	3 Click the Tip Color color chip and 3 choose a co...
	4 Click the Base Color color chip and 4 choose a c...
	5 Adjust the value of the Quantity of 5 Flames sli...
	6 Adjust the value of the Pointiness of 6 Flames s...
	7 Adjust the value of the Detail slider.
	8 Adjust the value of the Density slider.
	9 Adjust the value of the Quality slider.
	º Adjust the value of the Edge Falloff Size slider...
	¡Click the Container pop-up and choose a container...
	™ Adjust the value of the Completion of Burning Fi...
	£ Adjust the value of the Upward Speed slider.
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	Shading an Infinite Plane
	To adjust shader tiling:
	1 Double-click the Infinite Plane.
	2 Enable the Tiling option if you want your 2 shad...
	3 Enable either the Mirrored in X axis or 3 Mirror...


	Creating Text Objects
	To create Text objects:
	1 Choose the Text tool and then drag in the 1 Pers...
	2 In the region at the bottom of the dialog 2 (whe...
	3 Choose a font from the font pop-up.
	4 Choose a font style from the style pop- 4 up.
	5 Enter a value in the Font Size entry box. 5 Font...
	6 Use the Depth controls to set the width 6 of the...
	7 Enable the Front Face checkbox to add a 7 bevel ...
	8 Enable the Back Face check box to add a 8 bevel ...
	9 Enter values in the Depth and Height 9 fields to...
	º Click on a bevel type in the Type controls at th...
	¡ Click Done. You can also choose Edit menu> Jump ...

	To edit a Text object:
	The Size of Text Objects in the Universe

	Creating Formula Objects
	To create a Formula object:
	1 Click the Formula tool and drag it into 1 either...
	2 Double-click the object. The Formula 2 controls ...
	3 Enter a formula into the editor.
	4 When you’re finished editing the 4 formula, clic...


	Creating Objects Using the Modeling�Wizard
	To create an object using the Modeling Wizard:
	1 Drag the Modeling Wizard tool into the 1 Perspec...
	2 Follow the instructions provided.
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	Setting Surface Fidelity
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	1 Choose Geometry menu> Surface 1 Fidelity. The Su...
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	Working on the Drawing Plane
	Drawing Tools
	Pen Tool
	To add a corner point:
	1 Choose the Pen tool from within the Free 1 Form ...
	2 Click (do not drag) at a point on the 2 Drawing ...

	To add a curve point:
	1 Choose the Pen tool from within the Free 1 Form ...
	2 Drag the Pen tool at a point on the 2 Drawing pl...

	To close a path:
	1 Choose the Pen tool from within the Free 1 Form ...
	2 Click on the first point you added.

	To draw a new path:
	1 Deselect all paths and points by clicking 1 in a...
	2 Choose the Pen tool.
	3 Click anywhere on the Drawing plane to 3 start t...
	4 Click or drag to add each subsequent 4 point. As...

	To add points to either end of an open path:
	1 Select one of the endpoints of an open 1 path wi...
	2 Choose the Pen tool.
	3 Click or drag to add the next point. A 3 segment...
	4 Continue adding points until you’re 4 satisfied ...

	Selection Tool
	To view points on a path:
	1 Choose the Selection tool from within 1 the Free...
	2 Click on a path in the Free Form 2 modeling wind...

	To select points:
	1 Choose the Selection tool from within 1 the Free...
	2 Click on a point in the Free Form 2 modeling win...

	To move points:
	1 Choose the Selection tool from within 1 the Free...
	2 Drag a selected point to a new location.

	To adjust a curve:
	1 Choose the Selection tool from within 1 the Free...
	2 Drag the point’s handles.

	Convert Point Tool
	To convert a corner point to a curve point:
	1 Choose the Convert Point tool from 1 within the ...
	2 Drag a point in the Free Form modeling 2 window....

	To convert a curve point to a corner point:
	1 Choose the Convert Point tool from 1 within the ...
	2 Click on a curve point in the Free Form 2 modeli...

	Delete Point Tool
	To delete a point:
	1 Choose the Delete Point tool from within 1 the F...
	2 Click on a point in the Free Form 2 modeling win...
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	1 Choose the Rounded Rectangle tool 1 from within ...
	2 In the Free Form modeling window, drag 2 from on...
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	1 Choose the Ellipse tool from within the 1 Free F...
	2 Drag in the Free Form modeling window 2 to draw ...
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	1 Choose the Polygon tool from within the 1 Free F...
	2 Drag the tool in the Free Form modeler 2 Cross s...
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	2D Text Tool
	To draw text on the cross section plane:
	1 Choose the 2D Text tool from within the 1 Free F...
	2 Click in the Free Form modeling window 2 to posi...
	3 Enter text and specify type settings.
	4 Click OK.


	Precision Editing
	The Drawing Plane Grid
	To set up the grid:
	1 Choose View menu> Grid. The Grid 1 dialog appear...
	2 Change the Spacing value to control the 2 amount...
	3 Choose a unit of measure from the 3 pop�up.
	4 Change Draw a line every value to 4 control how ...
	5 Enable Snap to if you want objects to 5 “jump” t...
	6 Disable Show if you want to hide the grid 6 line...
	7 Click OK.

	The Properties Palette
	To change the properties of a cross section:
	1 If the Properties palette is not visible, 1 choo...
	2 Select a cross section group or point.
	3 Adjust the position values.

	Rotating Shapes
	To free rotate a cross section:
	1 Select a shape on the cross section 1 plane.
	2 Choose the 2D Rotation tool from the 2 Free Form...
	3 Drag the shape in a circular path.

	To numerically rotate a cross section:
	1 Select a shape, and choose Geometry 1 menu> Rota...
	2 Select the rotation center—the shape’s 2 center,...
	3 Enter a value for degree of rotation and 3 selec...
	4 Click OK.
	Twisting An Object

	To twist an object:
	Grouping Shapes
	To group shapes:
	1 Select the shape(s) you want to group.
	2 Choose Arrange menu> Group.

	To ungroup:
	1 Select the group you want to ungroup.
	2 Choose Arrange menu> Ungroup.

	Compounding Shapes
	To compound shapes:
	1 Select the shapes you want to 1 compound.
	2 Choose Arrange menu> Combine as 2 Compound.

	To break apart a compound:
	1 Select the compound you want to 1 release.
	2 Choose Arrange menu> Break Apart 2 Compound.

	Scaling Shapes
	To scale shapes:
	1 Group the curves or shape you want to 1 resize.
	2 Drag a corner of the shapes bounding 2 box with ...

	To scale shapes numerically:
	1 Select the shape you want to resize.
	2 Choose Geometry menu> Scale. The 2 Scale dialog ...
	3 Enter horizontal and vertical scale 3 factors.
	4 Click OK.

	Importing Shapes
	To import shapes to a cross section:
	1 Click the cross section you want to work 1 with....
	2 Choose File menu> Import. The 2 Import dialog ap...
	3 In the dialog, select the file you want, 3 then ...
	4 Click OK.

	To import a path as a sweep path or envelope:
	1 Choose Geometry menu> Extrusion 1 Envelope to tu...
	2 Click one of the path sweep path planes 2 to mak...
	3 Choose File menu> Import. The 3 Import dialog ap...
	4 Select the file you want, then click Open.
	5 Specify sweep path or envelope, and 5 click OK.



	Working with Cross Sections
	Modeling with Multiple Cross Sections
	Adding and Removing Cross Sections
	To create a new cross section:
	1 If a sweep path point exists where you 1 want th...
	2 If there is no point:
	3 If you’re working on a cross section 3 plane:

	Generating Intermediate Cross Sections
	To generate intermediate cross sections:
	1 Click on a cross section plane.
	2 Choose Sections menu> Create 2 Multiple. The Cre...
	3 Enter the number of sections you want.
	4 Click OK.

	To remove a cross section:
	1 Click the cross section you want to 1 remove, or...
	2 Choose Sections menu> Remove.

	Moving the Drawing Plane Between Sections
	To move between sections using the keyboard:
	To move to a specific section:
	1 Choose Sections menu> Go to. The 1 Go To Cross S...
	2 Enter the number of the section you 2 want to go...

	Correspondence and Shape Numbering
	To control shape-to-shape correspondence:
	1 Choose Sections menu> Show 1 Shapes Numbers.
	2 Click on the number you want to change. 2 The Sh...
	3 Type in the number for the 3 corresponding shape...
	4 Click OK.

	Cross Section Options
	To set cross section options:
	1 Click on a cross section.
	2 Choose Sections menu> Cross- 2 Section Options. ...
	3 Enable the Fill Cross Section checkbox if 3 you ...
	4 Enable the Disconnect from next Cross 4 Section ...
	5 Enable a Skinning option:
	6 Click OK.

	Centering a Cross Section
	To center a cross section on the sweep path:
	1 Click the section you want to center.
	2 choose Sections menu> Center. The 2 shape(s) on ...



	Working with the sweep path
	Drawing the sweep path in 3D
	To draw a sweep path in 3D:
	1 On the side plane, draw one side of the 1 chair ...
	2 Switch to the ground plane and select 2 the last...
	3 Switch back to the side plane, and trace 3 back ...
	4 Finally, working on the ground plane, 4 close th...


	Cross Sections and the sweep path
	Translation vs. Pipeline
	To choose an extrusion method:
	Extrusion Presets
	To straighten the sweep path:
	To make a spiral:
	1 Draw a 2D shape in the cross section 1 plane.
	2 Choose Geometry menu> Extrusion 2 Preset> Spiral...
	3 Enter the Number of turns you want— 3 one turn e...
	4 Enter the Length of the spiral sweep 4 path. The...
	5 Enter a value in the Distance to axis 5 entry bo...
	6 Enter a percentage in the Cross Section 6 Scalin...
	7 Enter a percentage in the Spiral Scaling 7 entry...
	8 Click OK to close the Spiral dialog. Ray 8 Dream...
	The Torus Extrusion Preset



	Using the Extrusion Envelope
	Understanding the Envelope
	How the Envelope Relates to the sweep path
	How the Envelope Relates to Cross Sections

	Editing the Envelope
	To enable the envelope or change its symmetry cons...
	To modify the extrusion envelope:
	To reset the extrusion envelope:


	Lathing
	Lathing with the Extrusion Envelope
	To create a lathe object with the extrusion envelo...
	1 Click a cross section plane.
	2 Draw a cross section using the Ellipse, 2 Rectan...
	3 Choose Sections menu> Center to 3 center the cro...
	4 Choose Geometry menu> Extrusion 4 Method> Transl...
	5 Choose Geometry menu> 5 Symmetrical> Extrusion E...
	6 Click one of the sweep path planes to 6 make it ...
	7 Click an empty space on the plane, being 7 caref...
	8 Choose View menu> Preset 8 Position> Drawing Pla...
	9 Using the Pen tool, place the second 9 point of ...
	º Continue drawing the lathe profile, placing addi...


	Lathing with a Circular sweep path
	To create a lathe object using a circular sweep pa...
	1 Draw your lathe profile in the cross 1 section p...
	2 Choose Geometry menu> Extrusion 2 Preset> Torus....
	3 Enter a value in the Distance to axis 3 entry bo...
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	The Mesh Form Modeling Window
	To create a Mesh Form object:
	To edit an existing mesh form model:
	To use the Mesh Form modeler to edit an imported m...
	1 Select the model you want to edit.
	2 Choose Edit menu> Jump In Another 2 Modeler. The...
	3 Select Mesh Form modeler from the 3 Available Mo...
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	Features of the Modeling Window
	The Drawing Plane
	Setting Preferences for the Mesh Form�Modeler

	Working in the Mesh Form Modeling Window
	Changing the Drawing Plane
	To move the Drawing plane to a preset position:
	To align the Drawing plane with a selection:
	1 Select the vertex, polygon, or group of 1 vertic...
	2 Choose View menu> Send Drawing 2 Plane To> Selec...

	To move the Drawing plane so that you look directl...
	To move the Drawing plane to a particular position...
	1 Choose View menu> Send Drawing 1 Plane To> Posit...
	2 Specify the X, Y, Z coordinates to which 2 you w...

	To rotate the Drawing plane:
	To move the Drawing plane back to its original pos...
	To move the Drawing plane to a polygon:
	1 Choose the Selection tool, Sphere of 1 Attractio...
	2 Command-click/Ctrl+click the polygon to 2 which ...

	To move the Drawing plane to a vertex:
	1 Choose the Selection tool, Sphere of 1 Attractio...
	2 Command-click/Ctrl+click the vertex to 2 which y...


	Changing your Point of View
	To look directly at the Drawing plane:
	To move your viewpoint back to where it was when t...
	To move your viewpoint to the Top, Bottom, Left, R...
	To return your viewpoint to the previous position:...

	Selecting a Preview Mode
	To switch preview modes:

	Using the Window Controls

	Working on the Mesh Form Drawing Plane
	Mesh Form Modeler Arranging Tools
	Selection Tool
	To select a vertex or edge:
	1 Choose the Selection tool from within 1 the Mesh...
	2 Click the vertex or edge you want to 2 select.

	To select a polygon:
	1 Choose the Selection tool from within 1 the Mesh...
	2 Click in the middle of the polygon you 2 want to...

	To select an edge and all connected edges in the s...
	1 Choose the Selection tool from within 1 the Mesh...
	2 Double-click an edge of the polygon.

	To select a group of objects, edges, and vertices:...
	1 Choose the Selection tool from within 1 the Mesh...
	2 Drag until the marquee encloses the 2 objects yo...

	To select an entire object:
	1 Choose the Selection tool from within 1 the Mesh...
	2 Double-click any vertex or polygon in the 2 obje...

	Marquee Selection Tool
	To use the Marquee Selection tool to select a grou...
	1 Choose the Marquee Selection tool from 1 within ...
	2 Drag until the marquee surrounds the 2 objects, ...

	Camera Dolly Tool
	To change your view point:
	1 Choose the Camera Dolly tool from 1 within the M...
	2 Drag in the Mesh Form modeler until you 2 have t...

	Hand Tool
	To use the Hand tool:
	1 Choose the Hand tool from within the 1 Mesh Form...
	2 Drag within the Mesh Form modeling 2 window to m...

	Zoom Tool
	To use the Zoom tool:
	1 Choose the Zoom tool from within the 1 Mesh Form...
	2 Click in the Mesh Form modeling window 2 to zoom...

	Plane Display Tool
	To use the Plane Display tool:
	1 Choose the Plane Display tool from 1 within the ...
	2 Click on the representation of the plane 2 you w...
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	Setting up the Grid
	To set up the grid for the Mesh Form modeler:
	1 Choose File menu> Preferences or 1 press Command...
	2 Choose Mesh Form Modeler from the 2 pop-up.
	3 In the Grid Settings, specify the grid 3 spacing...
	4 Change the Draw a Line Every value to 4 control ...
	5 Change the Number of Steps to control 5 the size...
	6 If you want to hide the grid lines, disable 6 Sh...
	7 Enable Snap to Grid if you want objects 7 to “ju...


	Modifying the Last Action

	Creating Polymesh Objects
	Drawing with the Polyline Tool
	To draw an open polyline:
	1 Choose the Polyline tool from within the 1 Mesh ...
	2 Click in the Mesh Form modeling window 2 to add ...
	3 Click the last vertex again to finish the 3 poly...

	To draw a closed polyline:
	1 Select the Polyline tool from within the 1 Mesh ...
	2 Click in the Mesh Form modeling window 2 to add ...
	3 Close the polyline by clicking again on 3 the fi...


	Drawing with the Polymesh Primitive�Tools
	To draw an object:
	1 Choose the Sphere, Cube, Mesh, 1 Rectangle or El...
	2 Click the Drawing plane to add the 2 object. You...


	Duplicating Polymesh Objects
	To duplicate an object:
	1 Select the object you want to duplicate.
	2 Choose Edit menu> Duplicate or 2 press Command-D...

	To duplicate an object with symmetry:
	1 Adjust the Drawing plane so that when 1 used as ...
	2 Select the object you want to mirror.
	3 Choose Edit menu> Duplicate with 3 Symmetry or p...


	Specifying Object Properties
	To specify object properties in the Numerical Prop...
	1 Select the object whose properties you 1 want to...
	2 Choose Properties palette: 2 Numerical tab.
	3 Directly edit the displayed values.
	4 Click Apply.



	Working with Selections
	Saving and Restoring Selections
	To save the current selection:
	To restore the saved selection:

	Inverting the Current Selection
	To invert the current selection:

	Hiding Selections
	To hide a selection:
	1 Select the vertices and edges you want to 1 hide...
	2 Choose View menu> Hide Selection.

	To reveal hidden vertices in an object:
	1 Select the object.
	2 Choose View menu> Reveal 2 Vertices.



	Working with Vertices
	Adding and Removing Vertices
	To add a vertex:
	1 Select the Add Vertex tool from within 1 the Mes...
	2 Click an edge where you want to add the 2 vertex...

	To remove a vertex:
	1 Select the Delete tool from within the 1 Mesh Fo...
	2 Click the vertex you want to remove. 2 Removing ...


	Linking and Unlinking Vertices
	To link vertices:
	1 Select the vertices you want to link.
	2 Choose Selection menu> Link.

	To unlink vertices:
	1 Select the vertices you want to unlink.
	2 Choose Selection menu> Unlink.


	Moving Vertices and Edges
	Repositioning Vertices
	To move vertices numerically:
	1 Select the vertex or vertices you want to 1 move...
	2 Choose Selection menu> Move. The 2 Move dialog a...
	3 Enter the amounts you want to move the 3 vertice...

	To move a vertex to an exact location:
	1 Select the vertex you want to move.
	2 Choose Properties palette: 2 Numerical tab.
	3 Specify the X, Y, Z coordinate for the 3 vertex ...

	Moving Vertices with the Sphere of Attraction Tool...
	To move a group of vertices:
	1 Choose the Sphere of Attraction tool 1 from with...
	2 In the Properties palette: Tool 2 Options tab, s...
	3 Specify the radius of the sphere of 3 attraction...
	4 Select an attraction mode by enabling 4 Move sel...
	5 With the Sphere of Attraction tool, select 5 the...
	6 Drag the Sphere of Attraction tool in the 6 dire...

	Welding Vertices
	To weld vertices:
	1 Select the vertices to be welded.
	2 Choose Selection menu> Weld. The 2 Weld dialog a...
	3 Indicate how close the vertices must be 3 to be ...



	Working with Polymesh Objects
	Aligning Polymesh Objects
	To align a vertex in one object with the vertex in...
	1 Select the two vertices you want to align.
	2 Choose Polymesh menu> Adjust. The 2 Adjust dialo...
	3 Specify which vertex is the anchor, the 3 one th...
	4 When you’ve selected the anchor, click 4 OK to a...

	To align an edge in one object with the edge in an...
	1 Select the two edges you want to align.
	2 Choose Polymesh menu> Adjust. The 2 Adjust dialo...
	3 Use the blue Anchor arrows to specify 3 which ed...
	4 When you’ve selected the anchor, click 4 OK to a...

	To align a polygon in one object with the polygon ...
	1 Select the two polygons you want to 1 align.
	2 Choose Polymesh menu> Adjust. The 2 Adjust dialo...
	3 Use the blue Anchor arrows to specify 3 which po...
	4 When you’ve selected the anchor, click 4 OK to a...


	Adding Thickness to an Object
	To add thickness to an object:
	1 Select the part of the object to which you 1 wan...
	2 Choose Selection menu> Add 2 Thickness. The Add ...
	3 Specify how thick you want the surface 3 to be a...


	Creating and Filling Holes in an Object
	To create a hole in an object:
	1 Select the polygons you want to remove 1 to crea...
	2 Choose Selection menu> Empty 2 Polygon.

	To fill a hole in an object:
	1 Select the closed polyline that you want 1 to fi...
	2 Choose Selection menu> Fill 2 Polygon.


	Smoothing and Sharpening Edges in�an�Object
	To adjust the crease angle:
	1 Select the object.
	2 Choose Polymesh menu> Set Crease 2 Angle. The Cr...
	3 Enter a value in degrees for the crease 3 Angle....
	4 Enable the Override edge settings 4 checkbox to ...
	5 Click OK to set the crease angle.

	To smooth edges in an object:
	1 Select the edges you want to smooth.
	2 Choose Polymesh menu> Smooth 2 Edges.

	To sharpen edges in an object:
	1 Select the edges you want to sharpen.
	2 Choose Polymesh menu> Sharpen 2 Edges.

	To determine an edge’s smooth state:

	Controlling the Number of Vertices�and�Edges Used ...
	Triangulating an Object
	To triangulate selected polygons:
	1 Select the polygons you want to 1 triangulate.
	2 Choose Selection menu> Triangulate 2 Polygon.

	Subdividing an Object
	To subdivide selected polygons:
	1 Select the polygons you want to 1 subdivide.
	2 Choose Selection menu> Subdivide.

	Decimating an Object
	To decimate an object:
	1 Select the object or portion of an object 1 that...
	2 Select Selection menu> Decimate. 2 The Decimate ...
	3 Adjust the Threshold slider to specify 3 the per...
	4 Select the decimate technique to be used 4 by en...
	5 Select the decimate criteria by enabling 5 eithe...
	6 Click OK when you’ve finished specifying 6 the D...



	Transforming Polymesh Objects and Selections
	Moving an Object or Selection
	To move an object or selection numerically:
	1 Select the object or portion of an object 1 that...
	2 Choose Selection menu> Move. The 2 Move dialog a...
	3 Specify the amounts you want to move 3 the objec...

	To offset the surface of an object:
	1 Select the polygons that you want to 1 offset fr...
	2 Choose Selection menu> Offset. The 2 Offset dial...
	3 Specify the amount you want to move the 3 select...

	Flattening Selections
	To flatten a group of vertices, edges and polygons...
	1 Select the objects you want to flatten.
	2 Choose Selection menu> Flatten.

	Moving Selections to the Drawing Plane
	To move a group of vertices, edges or polygons to ...
	1 Select the objects you want to move to 1 the Dra...
	2 Choose Selection menu> Move to 2 Drawing Plane.


	Scaling an Object or Selection
	To scale an object:
	1 Select the polymesh you want to scale.
	2 With the Selection tool, drag one of the 2 objec...

	To scale an object or selection numerically:
	1 Select the object or portion of an object 1 that...
	2 Choose Selection menu> Resize. The 2 Resize dial...
	3 Enter the X, Y and Z scale factors and 3 click O...

	To set the size of an object:
	1 Select the object whose size you want to 1 set.
	2 Choose Polymesh menu> Set Size. 2 The Set Polyme...
	3 Enter the new X, Y, and Z dimensions for 3 the o...


	Rotating an Object or Selection
	To free rotate an object in three dimensions:
	1 Choose the Trackball Rotation tool from 1 within...
	2 Drag to rotate the object to a new 2 orientation...

	To free rotate an object relative to the Drawing p...
	1 Choose View menu> Preset 1 Position> Drawing Pla...
	2 Choose the 2D Rotation tool from within 2 the Me...
	3 Drag to rotate the object to a new 3 orientation...

	To rotate an object or selection numerically:
	1 Select the object or portion of an object 1 that...
	2 Choose Selection menu> Rotate. The 2 Rotate Sele...
	3 Select the axis of rotation.
	4 Specify the angle of rotation and click 4 OK.



	Using Standard Modeling Techniques�to�Create Compl...
	Extruding and Sweeping Polygon and�Polyline Cross ...
	To create a straight extrusion:
	1 Create a cross section using the Polyline 1 tool...
	2 With the cross section selected, choose 2 Select...
	3 Specify the depth of the straight 3 extrusion an...

	To create a complex extrusion:
	1 Create a cross section using the Polyline 1 tool...
	2 Draw the extrusion path with the 2 Polyline tool...
	3 Select the cross section and extrusion 3 path.
	4 Choose Selection menu> Extrude.
	5 Use the blue arrows in the Properties 5 palette:...
	6 When the extrusion path is set, click 6 Apply to...

	To create a sweep:
	1 Create a cross section using the Polyline 1 tool...
	2 Draw the sweep path with the Polyline 2 tool or ...
	3 Select the polygon and the polyline.
	4 Choose Selection menu> Sweep.
	5 Use the blue arrows in the Properties 5 palette:...
	6 When the sweep path is set, click Apply 6 to gen...


	Modeling with Polygon and Polyline�Cross Sections
	To loft an object:
	1 Create the cross sections with the 1 Polyline to...
	2 Select the cross sections.
	3 Choose Selection menu> Loft.


	Lathing with Polygon and Polyline�Profiles
	To lathe an object:
	1 Create the lathe profile with the Polyline 1 too...
	2 Create a lathe axis with the Polyline tool 2 or ...
	3 Select the lathe profile and the lathe axis.
	4 Choose Selection menu> Lathe.
	5 Use the blue arrows in the Properties 5 palette:...
	6 Specify the number of steps for the 6 lathed obj...
	7 Click Apply to generate the extrusion.



	Using Boolean Operations to Create Complex Polymes...
	1 Extrude a circle along a path defined by a 1 pol...
	2 Align the sphere and the cylinder object.
	3 Subtract the cylinder object from the 3 sphere.
	To join two objects:
	1 Align and select the objects you want to 1 join....
	2 Choose Polymesh menu> Boolean 2 Operation.
	3 On the Properties palette: Action 3 Modifiers ta...
	4 If Auto is not enabled in the Properties 4 palet...

	To create an object that is the intersection of tw...
	1 Align and select the objects.
	2 Choose Polymesh menu> Boolean 2 Operations.
	3 On the Properties palette: Action 3 Modifiers ta...
	4 If Auto is not enabled in the Properties 4 palet...

	To subtract one object from another:
	1 Align and select the objects.
	2 Choose Polymesh menu> Boolean 2 Operations.
	3 Enable Auto at the bottom of the 3 Properties pa...
	4 On the Properties palette: Action 4 Modifiers ta...


	Shading Polymesh Objects
	Specifying an Object’s Mapping Mode
	To change an object’s mapping mode:
	1 Select the object.
	2 Choose Properties palette: 2 Mapping mode tab.
	3 Choose a mapping mode from the tab 3 pop-up: Cus...


	Defining a Custom Mapping Mode�for�an Object
	To view the UV coordinates that are set for a part...
	1 Select the vertex and choose Polymesh 1 menu> Sh...
	2 In the Properties palette: Mapping 2 mode tab, s...
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	Using Deformers
	Applying Deformers
	To apply a Deformer:
	1 Select the object or group you want to 1 deform....
	2 Open the Properties palette by choosing 2 Window...
	3 Click the Deformers tab. If the tab is not 3 vis...
	4 Select the Deformer you wish to apply 4 from the...
	5 Select the Deformer’s properties 5 parameters by...
	6 Click Apply. The Deformer is applied to 6 the ob...

	To apply multiple Deformers:
	1 Apply the first Deformer.
	2 Put the object in a group by itself using 2 the ...
	3 Apply the second Deformer to the new 3 group.

	Controlling a Deformer Directly
	To display the Direct Manipulation controls on a D...
	1 Select an object.
	2 Display the Properties palette> 2 Deformers tab ...
	3 Click Auto.
	4 Click the Direct Manipulation button. 4 The Defo...


	Using the Atomize Deformer
	To set Atomize deformer attributes:
	1 On the Properties 1 Palette:Deformers tab, adjus...
	2 Adjust the value of the Particle Density 2 slide...
	3 Adjust the value of the Particle Size 3 slider.


	Using the Bend and Twist Deformer
	To directly control the Bend and Twist deformer:
	1 Click the Direct Manipulation button on 1 the Pr...
	2 Enable a Twist axis button. These 2 buttons let ...
	3 On the Twist axis, drag one of the corner 3 poin...
	4 On the twist axis, drag one of the middle 4 poin...


	Using the Black Hole Deformer
	To set Black Hole attributes:
	1 On the Properties 1 Palette:Deformers tab, adjus...
	2 Adjust the value of the Winding slider.
	3 Adjust the value of the Spin Speed slider.
	4 Adjust the value of the Suck Down Point 4 Below ...


	Using the Dissolve Deformer
	To set Dissolve attributes:
	1 On the Properties 1 Palette:Deformers tab, adjus...
	2 Adjust the value of the Size of Pieces 2 slider....


	Using the Explode Deformer
	To set Explode attributes:
	1 On the Properties 1 Palette:Deformers tab, adjus...
	2 Adjust the positions of the controls in 2 the Si...
	3 Adjust the positions of the controls in 3 the Sp...
	4 Adjust the value of the Gravity slider.
	5 Adjust the value of the Slow Down at End 5 slide...
	6 Adjust the positions of the controls in 6 the Ro...
	7 Enable the Large Pieces Move Slower 7 checkbox i...
	8 Enable the Pieces Stop At Bottom 8 checkbox if y...
	9 Enable the Explode from Top Down 9 checkbox if y...


	Using Formula Deformers
	Using the Punch Deformer
	To directly control the Punch deformer:
	1 Click the Direct Manipulation button. A 1 square...
	2 If necessary, click the Orientation menu 2 and c...
	3 If necessary, enable the Punch Other 3 Side chec...
	4 Drag the center point on the square 4 towards th...
	5 Drag one of the corner handles away 5 from the c...


	Using the Shatter Deformer
	To directly control the Shatter deformer:
	1 Click the Direct Manipulation button. A 1 boundi...
	2 Drag a point on the box away from the 2 object t...


	Using the Spherical Morph Deformer
	To set Spherical Morph attributes:
	1 On the Properties 1 Palette:Deformers tab, adjus...


	Using the Spike Deformer
	To set Spike attributes:
	1 On the Properties 1 Palette:Deformers tab, adjus...
	2 Adjust the value of the Length slider.
	3 Adjust the value of the Radius slider.
	4 Adjust the value of the Messiness slider.
	5 Adjust the value of the Flow slider.
	6 Adjust the value of the Gravity slider.
	7 Enable the Keep Original Object 7 checkbox if yo...


	Using the Stretch Deformer
	To directly control the Stretch deformer:
	1 Click the Direct Manipulation button. A 1 boundi...
	2 Select an axis to stretch along.
	3 Drag a point on the box away from the 3 object t...


	Using the Warp Deformer
	To set Warp attributes:
	1 On the Properties 1 Palette:Deformers tab, adjus...


	Using the Wave Deformer
	To directly control the Wave deformer:
	1 Click the Direct Manipulation button. A 1 boundi...
	2 Click the Properties palette> 2 Deformer tab> Or...
	3 Adjust the value of the Number of Wave 3 Cycles ...
	4 Click the Properties palette> 4 Deformer tab> Sh...
	5 Drag one of the corner handles to adjust 5 the h...
	6 Depending on the type wave you 6 selected you ca...
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	Applying Shaders
	Shading Overview
	Shaders
	The Primer

	3D Paint
	The Browser Palette
	The Current Shader Editor
	Previewing Shading
	To use the Render Preview tool:
	1 Choose the Render Preview tool.
	2 In the Perspective or Modeling window, 2 drag a ...


	Shading an Entire Object
	To apply a shader to an object’s primer (drag and ...
	To apply a shader to an object’s primer {Apply but...
	1 Select one or more objects in the 1 Perspective ...
	2 Select a shader in the Browser palette: 2 Shader...
	3 Click Apply in the Browser palette.

	Applying Non-Empty Channels vs. Applying All Chann...
	To replace an object’s primer (apply all channels)...
	1 Select one or more objects in the 1 Perspective ...
	2 Select a shader in the Browser palette: 2 Shader...
	3 Pop-up the Apply button in the Browser 3 palette...



	3D Paint
	3D Paint Tools
	To use a 3D Paint tool:
	1 Select the shader you want to use.
	2 Choose a 3D Paint tool. The behavior of 2 each t...
	3 Paint on the surface of an object in the 3 Persp...

	Rectangle Tool
	Ellipse Tool
	Polygon Tool
	Brush Tool

	The Brush Tool
	Brush Options
	To set brush options (Paint Brush or Eraser):
	1 Click the icon for the brush type you 1 want: Pa...
	2 Drag the Size slider to make the brush 2 smaller...
	3 Adjust the Advance slider to set the 3 frequency...
	4 Drag the Hardness slider to adjust the 4 edge of...
	5 Drag the Flatness slider to adjust the 5 width o...
	6 Drag the Angle slider to adjust the angle 6 of t...

	Painting with the Brush Tool
	To paint with the Brush tool:
	1 Select the shader you want to use.
	2 Choose the Brush tool from the toolbar. 2 The Br...
	3 Choose a brush and set the brush 3 options (see ...
	4 Drag the brush cursor over the surface of 4 an o...

	To add to a brushed shape:
	1 Using the Paint Shape Selection tool, 1 choose a...
	2 Using the Eyedropper tool, grab the 2 shader fro...
	3 Start your first stroke within the 3 boundary of...
	4 Continue in this fashion to add brush 4 strokes....

	To erase part of a brushed shape:
	1 Use the Paint Shape Selection tool to 1 select a...
	2 Choose the Brush tool from the toolbar. 2 The Br...
	3 Select the Eraser icon.
	4 Drag the eraser across the portions of 4 the bru...

	Importing a Brushed Shape
	To import a brushed shape:
	1 Using a 2D art program, prepare the 1 image you ...
	2 Select a shader from the Browser 2 palette: Shad...
	3 Choose the Brush tool from the toolbar. 3 The Br...
	4 Select the Imported Shape Brush icon.
	5 Drag a marquee across the surface of 5 your obje...
	6 Use the file system tools to select and 6 open y...



	Working with Paint Shapes
	To select a paint shape:
	1 Choose the Paint Shape Selection tool.
	2 Click on the paint shape you want to edit.

	To move a paint shape:
	To delete a paint shape:
	1 Select the shape.
	2 Choose Edit menu> Clear or press the 2 Delete/Ba...

	To resize a paint shape:
	To crop a paint shape:
	Layering: How Primer and Paint Shapes�Interact
	To change the layering order of paint shapes:
	1 Select one of the shapes you want to re- 1 order...
	2 Choose Arrange menu> Paint Shape 2 Order> and se...



	Advanced 3D Paint Topics
	Editing Shading in the Properties�Palette
	To display the Shading tab in the Properties palet...
	1 Select an object.
	2 Choose Windows menu> Properties.
	3 Click the Shading tab.

	To remove an object’s primer:
	To change the layering order of an object’s paint ...
	To create a new paint shape:
	To delete a paint shape:
	1 Select an element on the Shading tab.
	2 Click the Minus icon.

	To set paint shape options:
	1 Click the triangle (Macintosh) or plus 1 sign (W...
	2 Adjust the Opacity slider to set a value 2 betwe...
	3 Edit the Position (h and v) values to 3 move the...
	4 Edit the Size (Height and Width) values 4 to alt...
	5 If you want, you can change the paint 5 shape to...
	6 Click Apply.

	3D Paint Preferences
	To set 3D Paint preferences:
	1 Choose File menu > Preferences.
	2 Click the popup menu and choose 3D 2 Paint.
	3 Enable a Shape/Stroke Redraw option:
	4 Enable the Show Transparency/ 4 Reflection optio...
	5 Adjust the Paint Brush Shape resolution 5 slider...
	6 Enable the Beep on creation option if you 6 want...
	7 In the Advice box, enable the alert 7 dialogs th...
	8 Adjust the Rubber Band Fidelity slider. 8 Higher...


	Mapping Modes
	To change an object’s mapping mode:
	1 Select an object.
	2 Display the Properties palette 2 (Windows menu> ...
	3 Choose the Mapping Mode tab.
	4 Use the pop-up to choose a mapping 4 mode—Parame...
	5 Set your options (described below).
	6 Apply your changes.

	To set Box/Face options:
	1 Display the Properties palette: 1 Mapping Mode t...
	2 Choose Box/Face from the pop-up.
	3 Click the icon for the mapping you 3 want—Full B...
	4 To change the orientation, select 4 Custom.
	5 Enter values in the Yaw, Pitch, Roll fields 5 to...
	6 Click Apply.

	To set Cylindrical or Spherical options:
	1 Display the Properties palette: 1 Mapping Mode t...
	2 Choose Cylindrical or Spherical from the 2 pop-u...
	3 Click the icon to choose the alignment 3 you wan...
	4 Click Apply.

	Master and Object Shading Layers
	To work on the Master shading layer:
	1 Click the Masters tab in the Hierarchy 1 window....
	2 Double-click the icon for the Master 2 object yo...
	3 Shade the Master object in the Modeling 3 window...
	4 Click Done to return to the Perspective 4 window...

	To edit the Master shading layer in the Properties...
	1 Click the Masters tab in the Hierarchy 1 window....
	2 Select the Master object whose shading 2 you wan...
	3 Display the Properties palette: 3 Shading tab.
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	To use the Render Preview tool:
	1 Choose the Render Preview tool.
	2 In the Perspective or Modeling window, 2 drag a ...


	Shading an Entire Object
	To apply a shader to an object’s primer (drag and ...
	To apply a shader to an object’s primer {Apply but...
	1 Select one or more objects in the 1 Perspective ...
	2 Select a shader in the Browser palette: 2 Shader...
	3 Click Apply in the Browser palette.

	Applying Non-Empty Channels vs. Applying All Chann...
	To replace an object’s primer (apply all channels)...
	1 Select one or more objects in the 1 Perspective ...
	2 Select a shader in the Browser palette: 2 Shader...
	3 Pop-up the Apply button in the Browser 3 palette...



	3D Paint
	3D Paint Tools
	To use a 3D Paint tool:
	1 Select the shader you want to use.
	2 Choose a 3D Paint tool. The behavior of 2 each t...
	3 Paint on the surface of an object in the 3 Persp...

	Rectangle Tool
	Ellipse Tool
	Polygon Tool
	Brush Tool

	The Brush Tool
	Brush Options
	To set brush options (Paint Brush or Eraser):
	1 Click the icon for the brush type you 1 want: Pa...
	2 Drag the Size slider to make the brush 2 smaller...
	3 Adjust the Advance slider to set the 3 frequency...
	4 Drag the Hardness slider to adjust the 4 edge of...
	5 Drag the Flatness slider to adjust the 5 width o...
	6 Drag the Angle slider to adjust the angle 6 of t...

	Painting with the Brush Tool
	To paint with the Brush tool:
	1 Select the shader you want to use.
	2 Choose the Brush tool from the toolbar. 2 The Br...
	3 Choose a brush and set the brush 3 options (see ...
	4 Drag the brush cursor over the surface of 4 an o...

	To add to a brushed shape:
	1 Using the Paint Shape Selection tool, 1 choose a...
	2 Using the Eyedropper tool, grab the 2 shader fro...
	3 Start your first stroke within the 3 boundary of...
	4 Continue in this fashion to add brush 4 strokes....

	To erase part of a brushed shape:
	1 Use the Paint Shape Selection tool to 1 select a...
	2 Choose the Brush tool from the toolbar. 2 The Br...
	3 Select the Eraser icon.
	4 Drag the eraser across the portions of 4 the bru...

	Importing a Brushed Shape
	To import a brushed shape:
	1 Using a 2D art program, prepare the 1 image you ...
	2 Select a shader from the Browser 2 palette: Shad...
	3 Choose the Brush tool from the toolbar. 3 The Br...
	4 Select the Imported Shape Brush icon.
	5 Drag a marquee across the surface of 5 your obje...
	6 Use the file system tools to select and 6 open y...



	Working with Paint Shapes
	To select a paint shape:
	1 Choose the Paint Shape Selection tool.
	2 Click on the paint shape you want to edit.

	To move a paint shape:
	To delete a paint shape:
	1 Select the shape.
	2 Choose Edit menu> Clear or press the 2 Delete/Ba...

	To resize a paint shape:
	To crop a paint shape:
	Layering: How Primer and Paint Shapes�Interact
	To change the layering order of paint shapes:
	1 Select one of the shapes you want to re- 1 order...
	2 Choose Arrange menu> Paint Shape 2 Order> and se...



	Advanced 3D Paint Topics
	Editing Shading in the Properties�Palette
	To display the Shading tab in the Properties palet...
	1 Select an object.
	2 Choose Windows menu> Properties.
	3 Click the Shading tab.

	To remove an object’s primer:
	To change the layering order of an object’s paint ...
	To create a new paint shape:
	To delete a paint shape:
	1 Select an element on the Shading tab.
	2 Click the Minus icon.

	To set paint shape options:
	1 Click the triangle (Macintosh) or plus 1 sign (W...
	2 Adjust the Opacity slider to set a value 2 betwe...
	3 Edit the Position (h and v) values to 3 move the...
	4 Edit the Size (Height and Width) values 4 to alt...
	5 If you want, you can change the paint 5 shape to...
	6 Click Apply.

	3D Paint Preferences
	To set 3D Paint preferences:
	1 Choose File menu > Preferences.
	2 Click the popup menu and choose 3D 2 Paint.
	3 Enable a Shape/Stroke Redraw option:
	4 Enable the Show Transparency/ 4 Reflection optio...
	5 Adjust the Paint Brush Shape resolution 5 slider...
	6 Enable the Beep on creation option if you 6 want...
	7 In the Advice box, enable the alert 7 dialogs th...
	8 Adjust the Rubber Band Fidelity slider. 8 Higher...


	Mapping Modes
	To change an object’s mapping mode:
	1 Select an object.
	2 Display the Properties palette 2 (Windows menu> ...
	3 Choose the Mapping Mode tab.
	4 Use the pop-up to choose a mapping 4 mode—Parame...
	5 Set your options (described below).
	6 Apply your changes.

	To set Box/Face options:
	1 Display the Properties palette: 1 Mapping Mode t...
	2 Choose Box/Face from the pop-up.
	3 Click the icon for the mapping you 3 want—Full B...
	4 To change the orientation, select 4 Custom.
	5 Enter values in the Yaw, Pitch, Roll fields 5 to...
	6 Click Apply.

	To set Cylindrical or Spherical options:
	1 Display the Properties palette: 1 Mapping Mode t...
	2 Choose Cylindrical or Spherical from the 2 pop-u...
	3 Click the icon to choose the alignment 3 you wan...
	4 Click Apply.

	Master and Object Shading Layers
	To work on the Master shading layer:
	1 Click the Masters tab in the Hierarchy 1 window....
	2 Double-click the icon for the Master 2 object yo...
	3 Shade the Master object in the Modeling 3 window...
	4 Click Done to return to the Perspective 4 window...

	To edit the Master shading layer in the Properties...
	1 Click the Masters tab in the Hierarchy 1 window....
	2 Select the Master object whose shading 2 you wan...
	3 Display the Properties palette: 3 Shading tab.
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	Composite Shaders vs. Global Mix�Shaders

	Shader Components
	Basic Components
	Color
	To set a color:
	1 In the Current Shader Editor, click a 1 channel ...
	2 Choose Insert menu >Color.
	3 Double-click a color chip to edit the 3 color. T...
	4 You can switch between the RGB and 4 CMYK color ...
	5 Drag the RGB or CMYK sliders to set the 5 color ...

	To use the system color picker:
	1 In the Ray Dream Studio color editor, 1 click th...

	Value
	To set a value:
	Texture Map
	Using Color Images as Texture Maps
	Black & White and Grayscale Images as Texture Maps...
	Storing Maps Internally vs. Externally
	Choosing an Image

	To choose an image:
	1 Select an image file from the file list in 1 the...
	2 To specify whether you want a copy of 2 the imag...
	3 Select Internal or External.
	4 Click OK to close the Options dialog.
	5 Click the Open button in the Open 5 dialog, or p...

	To flip or rotate the image:
	To tile the image:
	1 Click the Tile check box to turn tiling on. 1 Ra...
	2 Use the sliders to set the number of 2 repetitio...

	To filter the image:
	1 Click the disk icon in the Texture Map 1 control...
	2 Choose Filter from the pop�up which 2 appears. A...
	3 Select a filter and click OK.

	To replace the image:
	Movie
	To select a movie in the shader component:
	1 Click the disk icon. Studio displays the 1 Open ...
	2 Locate and open a movie file.
	3 You can click the directional buttons to 3 chang...
	4 You can reduce the image’s brightness 4 with the...
	5 Enable the Better (but slower) sampling 5 to vie...
	6 Enable the Invert Color option if you 6 want to ...
	7 If you want the frame to repeat, enable 7 the Ti...
	8 Use the Horizontally and Vertically 8 sliders to...
	9 Enable the Seamlessly option to smooth 9 the tra...
	º You can get more information on this movie by cl...
	¡ Enable the White is Invisible option if you want...


	Operators
	Mix
	Add (+)
	Subtract (–)
	Multiply (*)

	Functions
	2D and 3D Functions
	Cellular
	To set Cellular options:
	1 Use the Shape menu to select the basic 1 shape o...
	2 Drag the Intensity slider to adjust the 2 contra...
	3 Drag the Scale slider to change the size 3 of th...
	4 Drag the markers on the Upper and 4 Lower Limits...
	5 Enable the Fractal Version option to use 5 fract...

	Spots
	To set Spots options:
	1 Adjust the Size slider to control the size 1 of ...
	2 Adjust the Blending slider to control 2 how the ...
	3 Click the Shuffle button to randomize 3 the spot...

	Wood
	To set Wood options:
	1 Adjust the Global Scale slider to set the 1 size...
	2 Adjust the Vein count slider to set vein 2 spaci...
	3 Adjust the Perturbation slider to control 3 the ...
	4 Adjust the Undulation slider to control 4 the fr...
	5 Adjust the Vein Blending slider to 5 determine w...
	6 Use the Direction pop-up to set the 6 orientatio...
	7 Use the Center pop-up to set whether the 7 wood ...
	8 Click the Shuffle button to randomize 8 the wood...

	Marble
	To set Marble options:
	1 Adjust the Global Scale slider to set the 1 size...
	2 Adjust the Vein count slider to set vein 2 spaci...
	3 Adjust the Perturbation slider to control 3 the ...
	4 Adjust the Undulation slider to control 4 the fr...
	5 Adjust the Vein Blending slider to 5 determine w...
	6 Use the Direction pop-up to set the 6 orientatio...
	7 Click the Shuffle button to randomize 7 the marb...

	Checkers (and Stripes)
	To set Checkers options:
	1 Drag the Squares horizontally slider to 1 set th...
	2 Drag the Squares vertically slider to set 2 the ...

	Wires
	To set Wires options:
	1 Drag the Horizontal count slider to set 1 the nu...
	2 Drag the Height slider to set the size of 2 the ...
	3 Drag the Vertical count slider to set the 3 numb...
	4 Drag the Width slider to set the size of 4 the l...
	5 Enable the Gray Scale option if you want 5 to sm...

	Psychedelic
	To set Psychedelic options:
	1 Adjust the three Interference sliders to 1 contr...
	2 Enable the Use Global Coordinates 2 check box to...
	3 Drag the Scaling slider to control the size 3 of...
	4 Adjust the Number of Stripes slider to 4 control...
	5 Adjust the Density slider to control the 5 densi...
	6 Adjust the Phase slider to set the current 6 pos...

	Gradient
	To set Gradient options:
	1 Choose Direction menu> Horizontal 1 or Vertical ...
	2 Adjust the Turbulence slider to mix up 2 the col...

	Formula
	Using Other Components as Functions


	Shader Channels
	Color
	Highlight and Shininess
	Bump
	To change the amount of bump:
	1 In the Bump channel tab, adjust the 1 Amount sli...
	2 Apply your changes to the object.
	3 Use the Render Preview tool to check the 3 resul...


	Reflection
	Transparency
	Refraction
	Glow

	Building and Editing Shaders
	The Current Shader Editor
	To display the Current Shader Editor:
	To switch between spherical and flat preview:
	To switch between shader channels:
	To design a new shader:
	1 Choose Windows menu> Current 1 Shader Editor.
	2 Use the Shader Editor tools and features 2 to de...
	3 When you’re finished designing, either 3 apply y...

	To add the current shader to the Browser:
	1 Drag the shader preview from the 1 Current Shade...
	2 Enter a name and click OK.

	To open/edit a shader from the Browser:
	1 Double-click on the shader you want to 1 edit.
	2 Edit the shader by adjusting sliders and 2 other...
	3 Click Apply to apply the modified shader 3 to a ...
	4 Click Use to move the contents of the 4 document...
	5 You can save the modifications to the 5 shader:
	6 If you want to save the shader under a 6 differe...
	7 Close the shader document window 7 when you’re d...

	To edit an object’s primer or a paint shape’s shad...
	1 Choose the Paint Shape Selection tool.
	2 Display the Current Shader Editor 2 palette.
	3 Click an object to edit its primer—make 3 sure y...
	4 Click on a paint shape to edit its shader.
	5 Edit the shader tree by adding, 5 removing, and ...
	6 When you are satisfied with the changes 6 you’ve...

	Navigating the Shader Tree
	To choose a display mode:
	To jump into a subshader:
	To jump out of a subshader:
	Editing the Shader Tree
	To specify a shader type—Composite or Global Mix:
	To place a shader component or subshader on the sh...
	1 Display the shader channel tab where 1 you want ...
	2 Click on the branch (component or place 2 holder...
	3 Choose the component you want to add 3 from the ...

	To move components by dragging:
	To remove the contents of a branch:
	1 Select a component or subshader.
	2 Choose Edit menu> Clear, or press the 2 Delete/B...

	To copy a component or subshader to another channe...
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	The Viewing Tools
	Zoom tool
	To zoom in and out:
	To magnify a specific area of the scene:
	To set a specific magnification:
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	The Working Box
	Changing Display of the Grid Planes
	To display or hide a working box plane:
	The Active Plane
	To change the active plane:
	Changing Grid Options and Color
	To set grid options:
	1 Choose View menu> Grid or press 1 Command-J/Ctrl...
	2 Enter a Spacing amount to set the grid 2 increme...
	3 Choose a unit from the pop-up.
	4 Change the Draw Line Every value to 4 control ho...
	5 If you want to hide the grid lines, disable 5 Sh...
	6 Enable Snap to Grid if you want objects 6 to “ju...
	Working Box Properties

	To change working box properties:
	1 Choose the Selection tool.
	2 Choose Windows menu> Properties. 2 The the Prope...
	3 Hold down the Command/Ctrl key and 3 click on th...

	Changing the Position and Attitude of the Working ...
	Moving the Working Box

	To move the working box:
	1 Choose the Selection tool.
	2 Hold down the Command/Ctrl key and 2 drag the wo...

	To resize the working box:
	1 Choose the Selection tool.
	2 Hold down the Command/Ctrl key and 2 drag a corn...

	To orient the working box with the Virtual Trackba...
	1 Choose the Virtual Trackball tool.
	2 Hold down the Command/Ctrl key and 2 drag on the...

	To position or orient the working box numerically:...
	1 Choose the Selection tool.
	2 Hold down the Command/Ctrl key and 2 click the w...
	3 Choose Windows menu> Properties.
	4 Choose Properties palette: 4 Transform tab.
	5 Choose the coordinate system you want 5 from the...
	6 Use the Position controls to set the 6 Center x,...
	7 Use the Orientation controls to set the 7 yaw, p...
	8 Use the Size (Scaling) controls to change 8 the ...
	9 Click Apply to make the changes.

	To align the working box to an object or group:
	1 Select an object or group.
	2 Choose Arrange menu> Align 2 Working Box.

	To align the working box on gravity
	1 Hold down the Command/Ctrl key and 1 click the w...
	2 Choose Arrange menu> Align> On 2 Gravity. You’ll...

	To send the working box to a position:
	1 If you want to send the working box to an 1 obje...
	2 Choose Arrange menu> Send 2 Working Box To> and ...


	Objects in the Scene
	Object Preview
	To set the level of preview detail for all the obj...
	To hide an object:
	1 Select the object.
	2 Choose View menu> Object Visible/ 2 Object Invis...

	Bounding Boxes and Projections
	Naming Objects
	To change the name of an object or group:
	1 Select the object or group with the 1 Selection ...
	2 Choose Windows menu> Properties. 2 The Propertie...
	3 Click the General tab.
	4 Enter a new, descriptive name.


	Selecting Objects
	To select objects with the Selection tool:
	1 Click the Selection tool.
	2 In the Perspective window, click on the 2 previe...
	3 If a number of objects overlap, position 3 the c...
	4 Choose the object name followed by XY, 4 ZX or Y...

	To select objects in the hierarchy:
	To Find and select an object:
	1 Choose Edit menu> Find. The Find 1 dialog appear...
	2 Enter the name of the object to locate. 2 You ma...
	3 Click the radio button for the 3 appropriate mat...
	4 Click Find to begin the search.
	5 Click Find again to select the next object 5 tha...



	Arranging Objects
	The Hot Point
	To move a hot point by dragging:
	1 Choose the Selection tool.
	2 Select the object or group whose hot 2 point you...
	3 Drag the hot point in 3D or drag one of its 3 2D...

	To automatically center a hot point:
	1 Select the object or group in the 1 Perspective ...
	2 Choose the Arrange menu> Center 2 Hot Point or p...

	To move a hot point numerically:
	1 Select the object or group.
	2 Choose Windows menu> Properties. 2 The Propertie...
	3 Choose the Transform tab.
	4 Use the System pop-up to select the 4 coordinate...
	5 Enter new position values for the hot 5 point.
	6 Click Apply to move the hot point to that 6 loca...

	To place the hot point back in the center of the o...
	1 Select the object or group.
	2 Display the Properties palette: 2 Transform tab:...
	3 Click the “Send to” arrow (points up 3 between H...



	Positioning Objects
	Dragging Objects
	To move an object parallel to the active plane:
	1 Choose the Selection tool.
	2 Drag the object’s preview where you 2 want it.

	To move an object perpendicular to the active plan...
	1 Choose the Selection tool.
	2 Hold down the Option/Alt key and drag 2 the obje...

	To move an object along a specific plane:
	1 Choose the Selection tool.
	2 Drag the object’s projection in that 2 plane.

	Collision Detection
	To enable or disable Collision Detection:
	1 If necessary, display the Rendering 1 toolbar.
	2 In the Rendering toolbar, click the 2 Collision ...


	Nudging Objects
	To nudge an object:
	1 Select one or more objects
	2 Press one of the Arrow keys.

	To nudge perpendicular to the active plane:
	1 Hold down the Option/Alt key and use 1 the Up or...


	Numerically Positioning Objects
	To position an object or group numerically:
	1 Select the object or group.
	2 Display the Properties palette: 2 Transform tab:...
	3 Use the System pop-up to select the 3 coordinate...
	4 Choose the preferred units, if necessary.
	5 If you want to maintain the relationship 5 betwe...
	6 Enter x, y, z values position values for 6 eithe...
	7 Click Apply to move the object to that 7 locatio...

	To send the object (center) to the hot point:
	1 Select the object or group.
	2 Display the Properties palette: 2 Transform tab:...
	3 Click the Send to arrow (points down 3 between C...


	Measuring and Setting the Distance�of�Objects
	To measure and set distance:
	1 Select two objects. This feature does not 1 work...
	2 Choose Windows menu> Properties. 2 The Propertie...
	3 Choose the units you’d like to use from 3 the po...
	4 From the Lock pop-up, choose which 4 object you ...
	5 Enter a new distance value. You can type 5 in a ...
	6 Click Apply to move the “unlocked” 6 object to t...



	Resizing Objects
	Free Resizing
	To resize an object or group:
	1 Select an object or group.
	2 With the Selection tool, drag one of the 2 corne...
	3 When you are satisfied with the object’s 3 new s...


	Numerical Resizing
	To resize numerically:
	1 Select an object or group.
	2 Display the Properties palette: 2 Transform tab:...
	3 You can choose the units from the Units 3 pop-up...
	4 Enabled the Keep Proportions option to 4 maintai...
	5 Enter values in any Size or Scaling field 5 to d...
	6 Click Apply to move the object to that 6 locatio...



	Orienting Objects
	Free Rotating
	To orient an object with the Virtual Trackball:
	1 Choose the Virtual Trackball tool.]
	2 Click the object or group you want to 2 orient.
	3 Drag in the perspective window to 3 change the o...

	To constrain rotation to a given plane:
	1 If necessary, orient the working box and 1 posit...
	2 Choose the 2D Rotation tool. The 2 Rotation tool...
	3 Drag inside one of the three projections 3 to ro...


	Numerical Orienting
	To orient an object or group numerically:
	1 Select the object or group.
	2 Display the Properties palette: 2 Transform tab:...
	3 Use the System pop-up to select the 3 coordinate...
	4 Enter new values in the Yaw, Pitch and 4 Roll fi...
	5 Click Apply to update your changes to 5 the sele...

	Using the Axis Indicators
	To display the axis indicators:
	1 Choose File menu> Preferences. The 1 Preferences...
	2 Choose Perspective from the pop-up.
	3 Enable the Show Axis Information 3 option.


	Mirroring an Object’s Orientation
	To mirror an object or group’s orientation:
	1 Orient the working box to describe the 1 angle y...
	2 Select an object or group.
	3 If necessary, position the hot point to 3 descri...
	4 In the Properties palette: Transform 4 tab: Orie...
	5 Click Apply to update your changes to 5 the sele...


	Special Orientation Features
	To align objects with the working box:
	1 Select one or more objects.
	2 Choose Arrange menu> Align> On 2 Working Box or ...

	To align an object with the universe:
	1 Select an object.
	2 Choose Arrange menu> Align> On 2 Universe or pre...

	To align on gravity:
	1 Select an object.
	2 Choose Arrange menu> Align> On 2 Gravity or pres...

	To reset orientation:
	1 Select the object.
	2 Choose Arrange menu> Align> Reset 2 Orientation ...


	Aiming Cameras and Lights
	To point a camera or light at an object:
	1 Select the camera or light and the object 1 you ...
	2 Choose Arrange menu> Point At or 2 press Command...



	Aligning Duplicating Objects
	Aligning an Object Relative to Another
	To align objects relative to one another:
	1 Orient the Working Box to set the axes of 1 cons...
	2 Select two or more objects. The first 2 selected...
	3 Choose Arrange menu> Align 3 Objects or press Co...
	4 Choose the axis of constraint from the 4 Axis po...
	5 Select the alignment command you want 5 for this...
	6 Using the red Anchor arrows, select the 6 object...
	7 Select the reference point on the objects.
	8 Click Apply.
	9 When you have achieved the alignment 9 you want ...


	Duplicating Objects
	To duplicate an object:
	1 Select one object.
	2 Choose Edit menu> Duplicate or press 2 Command-D...
	3 Perform any number of position, 3 orientation, a...
	4 Choose Duplicate again.
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	The Symmetry Plane
	To flip an object:
	1 Orient and position the working box to 1 put the...
	2 Select the object you want to flip.
	3 Choose Arrange menu> Flip.

	To duplicate with symmetry:
	1 Orient and position the working box to 1 put the...
	2 Select the object.
	3 Choose Edit menu> Duplicate with 3 Symmetry or p...


	Other Features
	Shadow Casting
	To set shadow casting for one or more objects:
	1 Select one or more objects.
	2 Choose Arrange menu> No Shadow 2 Casting to turn...
	3 Choose Arrange menu> Shadow 3 Casting to turn on...

	Using the Counter
	To use the Counter:
	1 Choose Arrange menu> Counter.
	2 When you’re done viewing the 2 information, clic...
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	To delete an object:
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	2 Choose Edit menu> Delete or press 2 Delete/Backs...


	Replacing Objects
	To replace a single object or group:
	1 Select the object you want to use.
	2 Choose Edit menu> Copy or press 2 Command-C/Ctrl...
	3 Select the object you want to replace.
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	To jump into an object:
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	2 Choose Edit menu> Jump In.

	Jumping into an Object in a Separate Window
	To jump into the object in a separate window:
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	2 Choose Edit menu> Jump In New 2 Window.

	Jumping into an Object in a Different Modeler
	To jump into the object in a different modeler:
	1 Select the object.
	2 Choose Edit menu> Jump In Another 2 Modeler.
	3 Select the modeler you want.
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	To change hierarchy display:
	1 Make sure the Time Line window is 1 displayed.
	2 If necessary, click in the Time Line 2 window to...
	3 Choose View menu> Vertical, 3 Horizontal or Time...


	Navigating the Hierarchy
	To open or close a group
	1 Click the arrow (Macintosh) or plus/ 1 minus sig...

	To collapse the outline and close a group:
	1 Click on the arrow or minus sign.
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	Grouping Objects
	To create a new group:
	1 Select the objects you want to group. 1 You may ...
	2 Choose Arrange menu> Group. You 2 may also click...

	To change the name of a group:
	1 Click on the name of the group in the 1 Hierarch...
	2 Enter the new name and click OK.
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	Opening and Closing Groups
	To open a group:
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	To re-calculate the group bounding box:
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	2 Choose Arrange menu> Ungroup or 2 press Command-...
	3 Choose Arrange menu> Group or 3 press Command-G/...

	Jumping In and Out
	To jump into a group:
	1 Select the group.
	2 Choose Edit menu> Jump In.
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	To link an object to another:
	1 In the Hierarchy window, drag the object 1 or gr...
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	Applying Link Properties
	To apply a link property:
	1 Position the child object where you want 1 it in...
	2 Position the child object’s hot point 2 where yo...
	3 Select the child object or group.
	4 Choose Windows menu> Properties. 4 The Propertie...
	5 Click the Links tab.
	6 Choose the type of link you want to apply 6 from...
	7 Choose your options for the specific Link 7 Prop...
	8 When you are ready to apply your 8 changes, clic...

	Types of Links
	None
	2D Plane
	Axis
	Ball Joint
	Custom
	Shaft
	Lock
	Slider

	Setting Link Controls
	To set a link slider control:
	1 In the Preferences palette: Link tab, 1 choose t...
	2 Drag the slider markers to set position 2 limits...
	3 If the slider range is too large to give you 3 p...
	4 If the slider range is not large enough to 4 let...

	To set axis rotation controls:
	1 In the Preferences palette: Link tab, 1 choose t...
	2 Drag the markers to set position limits 2 and a ...

	Controlling Links Directly
	To use the Direct Manipulation controls for link p...
	1 Follow the previous instructions to apply 1 a Li...
	2 After you’ve chosen the constraint type, 2 click...

	To set slider options directly:
	To set rotation controls:
	Building Chains of Links

	The Links Browser

	Working with Master Objects
	Objects and Masters Tabs in the Hierarchy
	To display Master objects:
	1 Click the Master tab in the Hierarchy 1 window.

	Jumping into an Instance

	Master Object Operations
	To modify a master object:
	1 In the Time Line window, click on the 1 Masters ...
	2 Select the master object you wish to 2 modify.
	3 Choose Edit menu> Jump In to open it 3 for editi...
	4 Use the modeling or shader tools to 4 modify the...
	5 Click Done to jump out of the object and 5 apply...

	To replace a master object:
	1 Select and copy the object that will 1 replace t...
	2 In the Time Line window: Masters tab, 2 select t...
	3 Choose Edit menu> Paste or press 3 Command-V/Ctr...

	To use a group as a master object:
	1 Select the group in the hierarchy.
	2 Drag the group over the Masters tab, 2 then down...


	The Objects Browser
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	1 Choose Windows menu> Scene 1 Settings. The Scene...
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	Pointing a Light at an Object
	To point a spot light at an object:
	1 Hold down Shift and select the light and 1 the o...
	2 Choose Arrange menu> Point At or 2 press Command...

	The Point At Behavior
	To have a light follow an object:
	1 Select the spot light you want to use.
	2 Display the Properties palette: 2 Behavior tab.
	3 Click the Plus sign icon.
	4 Select Point At from the dialog and click 4 OK.
	5 Enter the name of the target object—the 5 one yo...
	6 Leave the axis option as it is. The axis 6 optio...
	7 Click Apply to send your changes to the 7 light....

	Controlling a Spot Light Directly
	To display the Direct Manipulation controls on a s...
	1 Select a spot light.
	2 Make sure this light is visible in the 2 Perspec...
	3 Display the Properties palette: Light 3 tab.
	4 Click the Direct Manipulation button to 4 displa...

	To aim the light:
	To move the light:
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	To change the cone half angle:
	To change the angular fall-off:
	1 Drag in (toward the center of the ring) on 1 the...
	2 Drag the fall-off ring handle to set the fall 2 ...

	To change the light’s brightness:

	Shadow Options
	To set shadow options for a light:
	1 Select the light you want to set.
	2 Display the Properties palette: 2 Shadows tab.
	3 Use the pop-up to choose the type of 3 shadow yo...

	Setting Soft RTD shadow options:
	1 Enter a value in the Diameter field to set 1 the...
	2 Drag the Quality slider to set the number 2 of s...
	3 Enable the Optimize option if you want 3 to spee...


	Using Gels
	To place a gel on a light:
	1 Select a light.
	2 Display the Properties palette: Gel 2 tab.
	3 Choose the type of gel from the pop-up.

	Blinds Controls
	To set blinds options:
	1 Select a light.
	2 Choose Windows menu> Properties 2 palette: Gel t...
	3 Choose Blinds from the pop-up.The blind 3 contro...
	4 Drag the Vertical number slider to set 4 the num...
	5 Drag the Vertical width slider to set the 5 widt...
	6 Drag the Horizontal number slider to set 6 the n...
	7 Drag the Horizontal width slider to set 7 the wi...
	8 Click Apply to apply your selections.

	Formula Controls
	To select a formula for the gel:
	1 Select a light.
	2 Choose Windows menu> Properties 2 palette: Gel t...
	3 Choose Formula from the pop-up. The 3 formula co...
	4 If the current formula uses the 4 Parameter slid...
	5 To load a new formula, click the Disk 5 icon and...
	6 If you want to edit the formula or create 6 your...
	7 When you’re done with the Formula 7 Editor, clic...
	8 To save a formula, click the Disk icon 8 and cho...
	9 Click Apply to apply the selections.

	Gradient Controls
	To set gradient options:
	1 Select a light.
	2 Choose Windows menu> Properties 2 palette: Gel t...
	3 Choose Gradient from the pop-up.The 3 gradient c...
	4 Select a Vertical or Circular gradient 4 pattern...
	5 Click the Start color chip and select a 5 color ...
	6 Click the End color chip and select a 6 color fr...
	7 Click Apply to apply the selections.

	Map Controls
	To create a map image:
	1 Use any 2D art program to create an 1 image for ...
	2 Save the image file in a format that Ray 2 Dream...
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	2 Choose Windows menu> Properties 2 palette: Gel t...
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	5 Use the Open dialog to locate and open 5 the map...
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	5 If you want the image to repeat, enable 5 the Ti...
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	Movie Controls
	To select a movie for the gel:
	1 Select a light.
	2 Choose Windows menu> Properties 2 palette: Gel t...
	3 Choose Movie from the pop-up.The 3 movie control...
	4 Click the Disk icon. Ray Dream Studio 4 displays...
	5 Locate and open a movie file.
	6 Click the directional buttons next to the 6 Disk...
	7 Drag the Brightness slider to adjust the 7 movie...
	8 Enable the Better (but slower) sampling 8 option...
	9 Enable the Invert Color option if you 9 want to ...
	º If you want the frame to repeat, enable the Tile...
	¡ You can get more information on this movie by cl...
	™ When you’re done with the Movie Time Selection w...
	£ Click Apply to apply the selections.

	To preview a movie in the Gel tab:
	1 Click Play at the bottom of the dialog.
	2 Click Stop when you want to stop the 2 movie.



	Using Cameras
	The Camera’s Field of View
	Creating a New Camera
	To create a new camera:
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	To change a camera’s lens:
	1 Select the camera you want to change.
	2 Choose Windows menu> Camera 2 Properties. The Ca...
	3 Use the Type menu to select the camera 3 you wan...


	Positioning and Aiming Cameras in�the�Scene
	Pointing a Camera at an Object
	To point a camera at an object:
	1 If you want to aim the current camera, 1 select ...
	2 Choose Arrange menu> Point At.

	The Point At Behavior
	To have a camera follow an object:
	1 Select the camera you want to use.
	2 Display the Properties palette: 2 Behavior tab.
	3 Click the Plus sign icon.
	4 Select Point At from the dialog and click 4 OK.
	5 Enter the name of the target object—the 5 one yo...
	6 Leave the axis option as it is. The axis 6 optio...
	7 Click Apply to send your changes to the 7 camera...

	Controlling a Camera Directly
	To display the Direct Manipulation controls on a c...
	1 Select a camera.
	2 Make sure this camera is visible in the 2 Perspe...
	3 Display the Properties palette: 3 Camera tab.
	4 Click the Direct Manipulation button to 4 displa...

	To aim the camera:
	To move the camera:
	To change the zoom:

	Changing your Perspective on�the�Scene
	Moving the Current Camera to a Preset Position
	To choose a preset position:
	Navigating the Current Camera
	To rotate around an object:
	1 Select the object you want to rotate 1 around. I...
	2 Click the Dolly tool. The Dolly tool 2 moves the...
	3 Drag in the Perspective window to dolly 3 the ca...

	To pan the camera:
	1 Click the Pan tool. The Pan tool rotates 1 the c...
	2 Drag in the Perspective window to pan 2 the came...

	To track the camera:
	To track in or out:
	Using the Navigational Panel
	To use the Camera Properties palette’s Navigation ...
	1 Choose Windows menu> Camera 1 Properties. The Ca...
	2 If necessary, click the Key icon to expand 2 the...
	3 Click the buttons to move or rotate the 3 camera...
	4 If you like, you can change the distance 4 or ro...
	5 Click the Scale icon to open the 5 Increments di...
	6 In the dialog, set the amount and units 6 for po...

	Saving Position Presets
	To save a position as a preset:
	1 Select the camera with the position and 1 orient...
	2 Display the Camera Properties palette.
	3 Choose Position pop-up> Save 3 Position.
	4 Select whether to save just the Position 4 and O...
	5 Type a name for this camera position 5 and click...

	To remove a preset from the list:
	1 Choose Position pop-up> Delete 1 Position.
	2 Select the position you wish to remove, 2 and cl...

	Working with Multiple Cameras
	To switch the view between cameras:
	To view your scene from two cameras at once:
	1 Open a second Perspective window.
	2 Choose Windows menu> New 2 Perspective. The New ...
	3 Select the camera you want or create a 3 new one...
	4 Click OK.


	Using the RealSpace Spherical Camera
	To use the IVRM Spherical camera:
	1 Create a scene, centered at the origin of 1 the ...
	2 Drag the Create Camera tool into the 2 Hierarchy...
	3 Choose Windows menu> Camera 3 Properties or pres...
	4 Choose Type pop-up> IVRM 4 Spherical.

	To set output options IVRM spherical camera render...
	1 Choose Windows menu> Scene 1 Settings. The Scene...
	2 Click the Output tab.
	3 Click the triangle next to Image Size. The 3 ima...
	4 Define the aspect ratio. The aspect ratio 4 of t...
	5 Click the triangle next to Camera. The 5 the cam...
	6 Choose the IVRM Spherical camera from 6 the list...
	7 Click the triangle next to File Format. 7 The Fi...
	8 Choose JPEG as the file format from the 8 pop-up...
	9 Click the Options button and use the 9 dialog to...
	º Save the scene file and close the document.

	To render with the IVRM spherical camera:
	1 Choose Render menu> Batch Queue.
	2 Click Add.
	3 Use the dialog to locate and select the 3 scene ...
	4 Click Open to add it to the queue.
	5 Click Done to close the dialog.
	6 In the Batch Queue window, click 6 Launch.
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	To change animatable property display in the Time ...
	1 Bring the Time Line window to the front. 1 You c...
	2 Choose View menu> Preset Views> 2 and select the...
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	Expanding and Collapsing the Hierarchy
	Expanding and Collapsing Property Hierarchies
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	1 Click the Time Line window.
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	1 Click the Time Line window.
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	1 Click the Time Scale button at the 1 bottom of t...
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	To change the current time (using the Time Control...
	1 Make sure the Time Controller toolbar is 1 displ...
	2 Type a new value, or use the arrows to 2 scroll ...
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	To change the Render Range start and end times:
	1 Click the Time Line window.
	2 Drag the right edge of the Render Range 2 to set...
	3 Drag the left edge of the render range to 3 set ...



	The Time Controller Toolbar
	To display the Time Controller toolbar:
	1 Choose View menu> Toolbars. The 1 Toolbars dialo...
	2 Click the Time Controller item to enable 2 its d...
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	To change the frame rate using the Time Controller...
	1 Make sure the Time Controller toolbar is 1 displ...
	2 Choose a frame rate from the Frame Rate 2 pop-up...

	Interactive Mode
	To enable or disable Interactive Mode:
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	Viewing Motion Paths
	To show or hide an object’s motion path:
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	2 Click the View Motion Path icon on the 2 Time Co...
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	To set Motion Path preferences:
	1 Choose File menu> Preferences.
	2 Choose Motion Paths from the pop-up.
	3 Enable the Display Frames option if you 3 want t...
	4 Choose a Fidelity level (Low, Medium or 4 High) ...



	Defining Key Events
	To define key events:
	1 Click the Time Line window.
	2 Set the current time to a time where you 2 want ...
	3 Use the standard Ray Dream Studio 3 tools, edito...
	4 Continue creating key events for the 4 several e...


	Editing the Time Line
	Selecting Key Event Markers
	To select a key event marker:
	1 Choose the Selection tool.
	2 Click on the key event marker you want 2 to sele...

	Adding Key Events
	To add a key event:
	1 Click the Time Line window.
	2 Choose the Add Key Event tool from the 2 toolbar...
	3 In the Time Line window, click on the 3 time tra...

	Removing Key Events
	To remove key events:
	1 Click the Time Line window.
	2 Select one or more key event markers.
	3 Press the Delete/Backspace key.

	Changing the Timing of Key Events
	To move one or more selected key events:
	1 Drag the key event marker along the 1 Time Axis ...

	Duplicating Key Events while Dragging
	To duplicate key events while dragging:
	1 Click Time Line window.
	2 Hold down the Option/Alt key, and drag 2 one or ...

	To nudge selected key event markers:
	1 Click the Time Line window.
	2 Select one or more key event markers on 2 the ti...
	3 Press the left or right arrow key to move 3 the ...

	Stretching a Series of Key Events over Time
	To compress or expand the timing between a series ...
	1 Click the Time Line window.
	2 Select three or more key event markers.
	3 Hold down the Command/Ctrl key and 3 drag one of...

	Copying and Pasting Key Events
	To copy key events:
	1 [Click the Time Line window.
	2 Select one or more key event markers.
	3 Choose Edit menu> Copy.

	To paste key events:
	1 In the Hierarchy area of the Time Line 1 window,...
	2 Choose Edit menu> Paste.

	XYZ Key Event Mode
	To choose the XYZ Key Event Mode:
	Mark XYZ Together
	Only Mark Changed

	Key Event Actions
	To use a Key Event Action:
	1 Choose the Selection tool.
	2 In the Time Line window, adjust the 2 display to...
	3 Select each marker in the sequence. You 3 may dr...
	4 Choose Arrange menu> Key Event 4 Action> and sel...


	Using Tweeners
	About Tweeners
	Applying the Tweener
	To apply a Tweener:
	1 Click the Time Line window.
	2 Set up beginning and ending key events.
	3 Double-click the time track segment 3 between th...
	4 Select a tweener type from the pop-up.
	5 Set the appropriate controls for the 5 tweener. ...
	6 Click OK to close the dialog.

	Linear Tweener
	To set Linear tweener options:
	1 Click the Time Line window.
	2 Double-click the time track segment 2 between th...
	3 Select a Linear from the pop-up.
	4 Adjust the two handles on the Ease-In/ 4 Ease-Ou...

	Discrete Tweener
	To set discrete tweener options:
	1 Click the Time Line window.
	2 Double-click the time track segment 2 between th...
	3 Select a Discrete from the pop-up.
	4 Adjust the Threshold slider to specify 4 the exa...

	Bézier Tweener
	To set Bézier tweener options:
	1 Click the Time Line window.
	2 Double-click the time track segment 2 between th...
	3 Select a Bezier from the pop-up.
	4 Drag the left handle to the right to start 4 slo...
	5 Drag the right handle to the left to finish 5 sl...
	6 Drag the left handle to change the initial 6 tra...
	7 Drag the right handle to change the 7 finishing ...

	Oscillate Tweener
	To set Oscillate tweener options:
	1 Click the Time Line window.
	2 Double-click the time track segment 2 between th...
	3 Select a Oscillate from the pop-up.
	4 Click one of the Wave Shape radio 4 buttons to c...
	5 Adjust the Nbr Oscillation slider to set 5 the n...
	6 Adjust the Damping slider to 6 progressively dim...
	7 Adjust the Up Phase slider to control 7 how much...

	Formula Tweener
	To use a formula for the tweener:
	1 Click the Time Line window.
	2 Double-click the time track segment 2 between th...
	3 Select a Formula from the pop-up. The 3 Formula ...
	4 If the current formula uses the 4 Parameter slid...
	5 To load a new formula, click the disk 5 icon.
	6 If you want to edit the formula or create 6 your...
	7 When you’re done with the Formula 7 Editor, clic...
	8 To save a formula, click the disk icon and 8 cho...



	Behaviors
	Applying Behaviors
	To apply a behavior:
	1 Select an object.
	2 Display the Properties palette: 2 Behaviors tab....
	3 Click the Plus icon. A dialog appears with 3 a l...
	4 Choose the behavior you want to apply. 4 Click O...
	5 Set other options for the behavior.
	6 Click Apply to send your changes to the 6 object...

	To remove a behavior from the list:
	1 Select the object or group that carries 1 the be...
	2 Display the Properties palette: 2 Behaviors tab....
	3 On the tab, click the title of the behavior 3 yo...
	4 Click the Minus icon in the Behaviors 4 tab.

	Point At
	To set point at options:
	1 Apply the Point At behavior to an object. 1 The ...
	2 Type the name of the object to be 2 pointed at i...
	3 Use the radio buttons in the Axis area to 3 sele...
	4 You can use the Enable checkbox to turn 4 the be...
	5 Remember to click Apply to update your 5 changes...

	Bounce
	To set bounce options:
	1 Apply the Bounce behavior to an object. 1 The Bo...
	2 In the Floor entry box, enter the lower 2 limit ...
	3 In the Height entry box, enter the height 3 of t...
	4 In the Bounces per Second entry box, 4 enter the...
	5 Enter values in the Start Time and End 5 Time en...
	6 Remember to click Apply to update your 6 changes...

	Spin
	To set spin options:
	1 Apply the Spin behavior to an object. 1 The Spin...
	2 Select the axis of rotation.
	3 In the Cycles per second entry box, enter 3 the ...
	4 Enter values in the Start Time and End 4 Time en...
	5 Remember to click Apply to update your 5 changes...

	Track
	To set track options:
	1 Apply the Track behavior to an object. 1 The Tra...
	2 Type the name of the object to be 2 tracked in t...
	3 Enable the checkboxes for each axis you 3 want t...
	4 Enable Track Rotation if you wan the 4 object to...
	5 Use the Enable checkbox to toggle the 5 behavior...
	6 A key event is created each time you turn 6 the ...
	7 Remember to click Apply to update your 7 changes...


	Inverse Kinematics
	Physical Forces
	Physics and Key Events
	Using Physics
	To apply physical effects:
	1 Rewind your animation to frame 1.
	2 Select the object you want to apply 2 physics to...
	3 Display the Properties palette: 3 Behaviors tab....
	4 Click the Plus icon.
	5 In the dialog, choose Apply Physical 5 Effects.
	6 You can click the Plus icon again and 6 load one...
	7 Adjust the settings for the forces you’ve 7 load...
	8 Click Apply.
	9 Preview the animation to see how the 9 forces in...
	Apply Physical Effects

	To set Apply Physical Effects options:
	1 Apply the Apply Physical Effects 1 behavior.
	2 Disable the Moveable by impact option if 2 you w...
	3 Adjust the Rebound slider to control this 3 obje...
	4 Adjust the Rotational Rebound slider to 4 contro...
	5 Adjust the Friction slider to control this 5 obj...
	6 Click Apply to send your changes to the 6 object...
	Initial Velocity

	To set Initial Velocity options:
	1 Apply the Initial Velocity behavior.
	2 Enter values for velocity in the X, Y and Z 2 di...
	3 Enter values for rotational velocity in 3 terms ...
	4 Click Apply to send your changes to the 4 object...

	To use the Direct Manipulation Controls with Initi...
	1 Apply the Initial Velocity behavior to an 1 obje...
	2 In the Properties palette: Behaviors 2 tab, clic...
	3 Click the Direct Manipulation Controls 3 icon.
	4 Drag the handle at the end of the wire (or 4 one...
	Directional Force

	To set directional force options:
	1 Apply the Directional Force behavior.
	2 Enter values to describe the force in the 2 X, Y...
	3 Click Apply to send your changes to the 3 object...

	To use the Direct Manipulation Controls with Direc...
	1 Apply the Directional Force behavior to 1 an obj...
	2 In the Properties palette: Behaviors 2 tab, clic...
	3 Click the Direct Manipulation Controls 3 icon.
	4 Drag the handle at the end of the wire (or 4 one...
	Point Force

	To set Point Force options:
	1 Apply the Point Force behavior.
	2 Click in the Point to object named field 2 and t...
	3 Use the Strength slider to describe the 3 amount...
	4 Use the Field Decay Rate slider to 4 describe th...
	5 Enable the Repulse option if you want 5 the obje...
	6 Click Apply to send your changes to the 6 object...
	Rotational Force

	To set Rotational Force options:
	1 Apply the Rotational Force behavior.
	2 Enter values for rotational force in terms 2 of ...
	3 Click Apply to send your changes to the 3 object...
	Flow Force

	To set Flow Force options:
	1 Apply the Flow Force behavior.
	2 Enter values for the amount of Flow 2 Force in t...
	3 Use the Turn Density slider to set the 3 frequen...
	4 If you want the object to rotate with the 4 flow...
	Damping Force

	To set Damping Force options:
	1 Apply the Damping Force behavior.
	2 Drag the slider to set the amount of 2 damping.

	About Key Events in Physical Forces
	Physical Effects Preferences
	To set physics accuracy:
	1 Display the Scene Settings window: 1 Misc. Data ...
	2 Click the radio button for the physics 2 simulat...

	To disable/enable physical effects:
	1 Display the Scene Settings window: 1 Misc. Data ...
	2 Enable the Enable Physical Effects 2 checkbox.


	Record Behaviors
	To convert behaviors to key events:
	1 Set up the behavior to animate the 1 object. See...
	2 Choose the frame rate you want for this 2 projec...
	3 Set the render range to extend as far as 3 neces...
	4 Select the object whose behavior you 4 want to c...
	5 Choose Arrange menu> Record 5 Behavior.
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	Animation Techniques
	Animating Object Shape
	Free Form Modeler
	To create free form models whose shapes you want t...
	1 Create all of the control points for the 1 extru...
	2 Create all of the cross sections, with all 2 of ...

	To animate the free form shape:
	1 Set the current time bar to the point 1 where yo...
	2 Display the Hierarchy Masters tab.
	3 In the Masters tab, double-click the name 3 of t...
	4 In the Free Form modeler, adjust the 4 points an...
	5 When you are finished changing the 5 object shap...


	Mesh Form Modeler
	To create mesh form models whose shapes you want t...
	1 Create all of the vertices for the object.
	2 Shape the object into the desired form 2 using a...

	To animate the mesh form shape:
	1 Set the current time bar to the point 1 where yo...
	2 Click the Masters tab in the Time Line 2 window....
	3 In the Masters tab, double-click the name 3 of t...
	4 In the Mesh Form modeler, adjust the 4 position ...
	5 When you’re finished changing the 5 object shape...


	Particle and Volumetric Primitives
	To animate the volumetric primitive shape:
	1 Create the volumetric primitive and 1 adjust its...
	2 When you’re finished setting the 2 attributes, c...
	3 Set the current time bar to the point 3 where yo...
	4 Display the hierarchy Masters tab.
	5 In the Masters tab, double-click the name 5 of t...
	6 In the Attribute dialog, adjust the 6 Completion...
	7 You can adjust other attributes to 7 change the ...
	8 When you are finished changing the 8 object shap...



	Animating with Deformers
	To animate with a Deformer:
	1 Apply the Deformer to the object. For 1 instruct...
	2 Set the Deformer options you want in 2 frame 1.
	3 Set the current time bar to the point 3 where yo...
	4 Use the options in the Properties 4 palette: Def...
	5 If the Deformer has a Completion slider, 5 set i...


	Animating Motion
	Translate versus Rotate
	Duplicating Relative Motion with�Groups
	Cloaking an Object
	To cloak or uncloak an object at a specific point ...
	1 Select the object.
	2 Display the Properties palette: 2 General tab.
	3 Enable or disable the Cloak checkbox.



	Rotoscoping
	Synchronizing Movie Frames with the Animation and ...
	To synchronize a movie with the animation:
	1 Set the current time bar to the moment 1 (frame)...
	2 Select the object or light that has the 2 movie ...
	3 Display the tab or window containing the 3 rotos...
	4 Use the preview controls to advance to 4 the mov...
	5 Apply the change.

	To loop a movie:
	1 Apply the movie at the start of the 1 animation....
	2 Drag the end-of-movie key event marker 2 out as ...
	3 Double-click the track between the two 3 movie k...
	4 Choose the Oscillate tweener.
	5 Select the Saw/Loop Wave Shape.
	6 Set the Up Phase slider to 100%. This 6 rewinds ...
	7 Adjust the Number of Oscillations slider 7 to se...
	8 Close the Transition Options dialog.


	Animating Shaders
	Animating Shaders with the Global�Mix�and Mix Comp...
	Rotoscoping in Non-Color Shader�Channels
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	About Rendering
	The Rendering Procedure
	An Overview
	1 Arrange the objects in the scene. Refer to 1 “Ar...
	2 In the Perspective window, add lights to 2 illum...
	3 Set your rendering options using the tabs 3 in S...
	4 Display the production frame and adjust 4 the po...
	5 Adjust Ambient Light, Background, and 5 Atmosphe...
	6 Once you have verified that all settings 6 are c...


	Setting up to Render
	Rendering Preferences for Individual�Objects
	To set an object’s rendering preferences:
	1 Select an object.
	2 Display the Properties palette: 2 Rendering tab....
	3 Use the Reflection Feature pop-up to set 3 wheth...
	4 If this object does show reflections, set 4 the ...
	5 Use the Refraction Feature pop-up to set 5 wheth...
	6 If this object does refract, set the 6 Refractio...


	Render Preferences
	To set rendering default preferences:
	1 Choose File menu> Preferences.
	2 Choose Render Features from the main 2 pop-up.
	3 Use the pop-ups to choose default 3 settings for...



	Scene Settings
	To display the Scene settings window:
	Renderers
	To choose the renderer you want to use:
	1 Display the Scene Settings window: 1 Renderer ta...
	2 Choose the renderer you want from the 2 pop-up.

	To set Draft Z-Buffer options:
	1 Click on the Reflected color chip to 1 select th...
	2 Click on the Transparent color chip to 2 select ...
	3 Enable the No shaders option if you want 3 to se...

	To set Adaptive renderer options:
	1 Enable the Shadows option to render 1 shadows.
	2 Enable the Reflections option to render 2 reflec...
	3 Enable the Bump option to render bump 3 effects ...
	4 Enable the Transparency option to 4 render trans...
	5 Enable the Refracted transparency 5 option to re...
	6 Enable the Light through transparency 6 option t...
	7 Click a radio button to choose the level 7 of An...
	8 Adjust the Silhouette Quality slider to 8 set th...
	9 Adjust the Maximum Ray Depth slider to 9 set a l...

	To set Ray Tracer options:
	1 Enable the Shadows option to render 1 shadows.
	2 Enable the Reflections option to render 2 reflec...
	3 Enable the Bump option to render bump 3 effects ...
	4 Enable the Transparency option to 4 render trans...
	5 Enable the Refracted transparency 5 option to re...
	6 Enable the Light through transparency 6 option t...
	7 Click a radio button to choose the level 7 of Ad...
	8 Adjust the Silhouette Quality slider to 8 set th...
	9 Adjust the Maximum Ray Depth slider to 9 set a l...

	The Natural-Media Renderer
	To set Natural Media renderer options:
	1 Use the pop-up to choose the rendering 1 style y...
	2 Adjust the sliders and set your other 2 options ...
	3 When you’ve changed object position or 3 geometr...

	Miscellaneous Renderer Settings

	Render Effects
	Atmosphere
	To use the Distance Fog:
	1 Display the Scene Settings window. 1 Choose Wind...
	2 Display the Scene Settings: Effects 2 tab.
	3 Choose Atmosphere pop-up: 3 Distance Fog.
	4 Click the Fog Color chip to set its color. 4 Ray...
	5 Enter the Fog Starts distance.
	6 Enter the visibility distance.

	To use Cloudy Fog:
	1 Display the Scene Settings window. 1 Choose Wind...
	2 Display the Scene Settings: Effects 2 tab.
	3 Choose Atmosphere pop-up: Cloudy 3 Fog.
	4 Click the Fog Color chip to set its color. 4 Ray...
	5 Enter values for Top and Bottom.
	6 Set the Density slider.
	7 Set the Lumpiness slider.
	8 Set the Global Scale slider.

	Backgrounds and Backdrops
	Background

	To use a Reflected Background:
	1 Display the Scene Settings window. 1 Choose Wind...
	2 Display the Scene Settings: Effects 2 tab.
	3 Choose the type of background you want 3 from th...
	Backdrop

	To use a backdrop:
	1 Display the Scene Settings window. 1 Choose Wind...
	2 Display the Scene Settings: Effects 2 tab.
	3 Choose the type of backdrop you want 3 from the ...
	Bi-Gradient Controls

	To use a bi-gradient for the background or backdro...
	1 Choose Bi-Gradient from the pop-up 1 where you w...
	2 Click the plus/arrow icon to display the 2 Bi-Gr...
	3 Select colors for the Top (“Sky”) and 3 Bottom (...
	4 Adjust the Limit between top and bottom 4 slider...

	Formula Controls
	To select a formula for the background or backdrop...
	1 Choose Formula from the pop-up where 1 you want ...
	2 Click the plus/arrow icon to display the 2 Formu...
	3 If the current formula uses the 3 Parameter slid...
	4 To load a new formula, click the disk 4 icon.
	5 If you want to edit the formula or create 5 your...
	6 When you’re done with the Formula 6 Editor, clic...
	7 To save a formula, press on the disk icon 7 and ...
	8 Use the Save dialog to name the file and 8 selec...

	Map Controls
	To select a map for the background or backdrop:
	1 Choose Map from the pop-up where you 1 want to u...
	2 Click the plus/arrow icon to display the 2 Map c...
	3 Click the disk icon. Ray Dream Studio 3 displays...
	4 Locate and open a bitmapped image file.
	5 You can click the directional buttons to 5 chang...
	6 You can reduce the image’s brightness 6 with the...
	7 Enable the Better (but slower) sampling 7 option...
	8 Enable the Invert Color option if you 8 want to ...
	9 If you want the image to repeat, enable 9 the Ti...
	º Use the Horizontally and Vertically sliders to s...
	¡ Enable the Seamlessly option to tile the image w...

	Movie Controls
	To select a movie for the background or backdrop:
	1 Choose Movie from the pop-up where 1 you want to...
	2 Click the plus/arrow icon to display the 2 Movie...
	3 Click the disk icon. Ray Dream Studio 3 displays...
	4 Locate and open a movie file.
	5 You can click the directional buttons to 5 chang...
	6 You can reduce the image’s brightness 6 with the...
	7 Enable the Better (but slower) sampling 7 option...
	8 Enable the Invert color option if you 8 want to ...
	9 If you want the movie to be tiled, enable 9 the ...
	º Use the Horizontally and Vertically sliders to s...
	¡ Enable the Seamlessly option tile the image with...
	™ You can get more information on this movie by cl...

	Render Filters
	To apply a render filter:
	1 Display the Windows menu> Scene 1 Settings windo...
	2 Click the Plus button.
	3 Select the filter you want to apply. 3 Click�OK....
	4 In the Filters tab, set the options for the 4 fi...

	To apply a render filter on a light-by-light basis...
	1 Display the Windows menu> 1 Properties palette: ...
	2 Click the Plus button.
	3 Select either VL LIght Control or PLP 3 Light Co...
	4 In the Miscellaneous tab, use the popup 4 to ena...
	Animating Filters

	Depth of Field
	To set Depth of Field options:
	1 Click one of the radio buttons to chose 1 the pr...
	2 Click Preview to generate a preview of 2 your sc...
	3 Click the red cross button to select the 3 tool ...
	4 Click in the preview on the object that 4 you wa...
	5 Set the range for the depth of field. You 5 have...

	To use the click tools:
	1 Click the green cross button to select the 1 too...
	2 Click in the preview on the foreground 2 object ...
	3 Click the blue cross button to select the 3 tool...
	4 Click in the preview on the background 4 object ...

	To use the Distance sliders:
	1 Drag the blue slider on the Distance bar 1 to se...
	2 Drag the green slider on the Distance bar 2 to s...

	To use a Depth of Field preset:
	1 On the right side of the panel, click the 1 grap...
	2 Use the scroll bar to view more choices.
	Dots Per Inch (DPI) and Depth Of Field

	Example:
	1 Render a preview at 216 x 144 pixels and 1 72 dp...
	2 When you are satisfied with the preview, 2 rende...
	Lens Flare

	To set Lens Flare options:
	1 Apply the Lens Flare filter.
	2 You have two options for previewing the 2 lens f...
	3 If you want to generate a preview of your 3 scen...
	4 On the right side of the panel, click the 4 imag...
	5 Drag the Intensity slider to change lens 5 flare...

	Glow
	To set Glow options:
	1 Apply the Glow filter.
	2 Adjust the Glow Size slider to change the 2 diam...
	3 Adjust the Glow Intensity slider to 3 change the...
	Nebula

	To set Nebula options:
	1 Apply the Nebula filter.
	2 Drag the 1st radius to set the streak’s 2 starti...
	3 Drag the 2nd radius to set the streak’s 3 ending...
	4 Drag the Angle slider to rotate the 4 streaks ar...
	5 Use the Branch number pop-up to 5 choose the num...
	6 Enable the Thick option to makes the 6 streaks t...
	7 Drag the Intensity slider to set the streak 7 in...
	Pulsator

	To set Pulsator options:
	1 Apply the Pulsator filter.
	2 Drag the Thickness slider to set the 2 streak th...
	3 Drag the Size slider to set the streak 3 radius....
	4 Drag the Angle slider to rotate the 4 streaks ar...
	5 Drag the Intensity slider to set the streak 5 in...
	Stars

	To set Stars options:
	1 Apply the Stars filter.
	2 Drag the Thickness slider to set the star 2 thic...
	3 Drag the Size slider to set the star radius.
	4 Drag the Angle slider to rotate the stars 4 arou...
	5 Use the Branch number pop-up to 5 choose the num...
	6 Enable the Diffraction option to split the 6 sta...
	7 Drag the Intensity slider to set the star 7 inte...
	VariCross

	To set VariCross options:
	1 Apply the VariCross filter.
	2 Drag the Thickness slider to set the 2 streak th...
	3 Drag the Size slider to set the streak 3 radius....
	4 Drag the 1st Angle slider to rotate the 4 first ...
	5 Drag the 2nd Angle slider to rotate the 5 second...
	6 Enable the Diffraction option to split the 6 str...
	7 Drag the Intensity slider to set the streak 7 in...
	CrossScreen

	To set CrossScreen options:
	1 Apply the CrossScreen filter.
	2 Adjust the Glow Size slider to change the 2 diam...
	3 Drag the Star Size slider to set the star 3 radi...
	4 Drag the Angle slider to rotate the stars 4 arou...
	5 Drag the Branch number slider to set the 5 numbe...
	6 Drag the Intensity slider to set the effect 6 in...
	3D Light Cone
	About the Warnings

	To set 3D Light Cone options:
	1 Apply the 3D Light Cone filter.
	2 To change the color of the fog, click on 2 the c...
	3 Drag the Intensity slider to change the 3 streng...
	4 Enter a value in the Range entry box to 4 set th...
	5 Enable the Use gel option if you want to 5 use a...
	6 Drag the Gel Buffer Size slider to set the 6 qua...
	7 Enable the Add Turbulence option if you 7 want s...
	8 Drag the Turbulence size slider to set the 8 mea...
	9 Drag the Turbulence lumpiness slider to 9 set th...
	º Drag the Turbulence sampling slider to set the n...
	¡ Enable the Animated option if you want the fog m...
	™ Enable the 3D Shadow option if you want objects ...
	£ Drag the Shadow Buffer Size slider to set the qu...
	3D Light Sphere
	About the Warnings

	To set 3D Light Sphere options:
	1 Apply the 3D Light Sphere filter.
	2 To change the color of the fog, click on 2 the c...
	3 Drag the Intensity slider to change the 3 streng...
	4 Enter a value in the Range entry box to 4 set th...
	5 Enable the Add Turbulence option if you 5 want s...
	6 Drag the Turbulence size slider to set the 6 mea...
	7 Drag the Turbulence lumpiness slider to 7 set th...
	8 Drag the Turbulence sampling slider to 8 set the...
	9 Enable the Animated option if you want 9 the fog...
	Aura

	To identify which objects should have an aura:
	1 Select an object that should have an 1 aura.
	2 Display the Current Shader Editor 2 palette: Glo...
	3 Set the glow color.
	4 Repeat steps 1 through 3 for each object 4 that ...

	To set Aura options:
	1 To change the color of the aura, click on 1 the ...
	2 Enable the Test Z option if you want Ray 2 Dream...
	3 Drag the Intensity slider to change the 3 streng...
	4 Drag the Range slider to set the radius of 4 the...
	5 Enable the Add Turbulence option if you 5 want s...
	6 Drag the Turbulence size slider to set the 6 mea...
	7 Drag the Turbulence lumpiness slider to 7 set th...
	8 Drag the Turbulence sampling slider to 8 set the...
	9 Enable the Animated option if you want 9 the med...


	Output
	Image Size Controls
	To set the image size and resolution:
	1 In the Width and Height entry boxes of 1 the Ren...
	2 In the Resolution entry box, enter the 2 resolut...
	3 Enable the Keep Proportions option if 3 you want...

	To check how long this rendering will take:
	1 Set image dimensions and resolution as 1 describ...
	2 Click Estimate.

	To limit rendering time:
	1 In the Render Time entry boxes, enter 1 the amou...
	2 Click Estimate.

	Framing Your Scene
	To display the Production Frame:
	To move the Production Frame:
	1 Choose the Selection tool.
	2 Click on the outer rectangle to select it.
	3 Move the cursor inside the frame and 3 drag it w...

	To resize the Production Frame:
	1 Choose the Selection tool.
	2 Click on the outer rectangle to select it.
	3 Drag a corner handle to resize in two 3 dimensio...
	4 Drag a side handle to resize in one 4 dimension....

	Camera
	To select the camera to render from:
	1 Display the Scene Settings window: 1 Output tab:...
	2 Use the Rendering Camera pop-up to 2 choose the ...
	3 Save your scene.

	File Name
	To set a file name for rendering this scene:
	1 Display the Scene Settings window: 1 Output tab:...
	2 Click the In Named File radio button.
	3 Click Set.
	4 When you’ve finished with the dialog, 4 click Sa...

	File Format
	To set file format options for rendering the curre...
	1 Display the Scene Settings window: 1 Output tab:...
	2 If necessary, click the radio button for 2 Curre...
	3 Choose the file format you want from the 3 pop-u...
	4 Click Options.
	5 When you’re finished setting options, 5 close th...

	To choose a movie file format:
	1 Click the radio button for Movie 1 (animation).
	2 Choose the movie file format you want 2 from the...
	3 Set the start and end points of the render 3 ran...
	4 Choose a frame rate from the Rate 4 pop�up.
	5 Click Options.
	Choosing Compression Settings

	To select a movie compression option:
	1 Click Options n the Scene Settings 1 window: Out...
	2 Select one of the compressor options 2 from the ...
	Macintosh Compression Options
	AVI Compression Options

	To set compressor options for the QuickTime format...
	1 Choose a color depth from the Color 1 pop-up. Th...
	2 Use the Quality slider to set the level of 2 com...
	3 For a codec that uses key framing, enter 3 a Key...
	4 For a codec that supports the feature, 4 you can...

	G-Buffer
	To select G-Buffer channels:
	1 Display the Scene Settings window: 1 Output tab:...
	2 Enable the checkbox or each feature you 2 want.


	Preset Render Settings
	To create a new render preset:
	1 Set all rendering options to your liking. 1 The ...
	2 Choose Render menu> Save 2 Current Settings.
	3 Ray Dream Studio displays a dialog that 3 lets y...
	4 Enable the Save Camera option if you 4 wan to in...
	5 Enable Save Punch In and Punch Out if 5 you want...
	6 Enable Save Effects, Filters, and Misc 6 data if...
	7 Click OK to close the dialog and create 7 the pr...

	To remove preset render settings:
	1 Choose Render menu> Remove 1 Settings.
	2 Select the render setting to be removed 2 in the...
	3 Click OK.



	Starting a Rendering Job
	To start rendering using the current settings:
	To render with a preset:

	Using the Batch Queue
	To add files to the batch queue:
	1 Set up each scene you wish to include in 1 the b...
	2 Choose Render menu> Batch Queue.
	3 Click Add.
	4 Select a file, then click Add. You may also 4 do...
	5 Repeat step 4 until you’ve added all files 5 you...
	6 Click Close/Done.

	To change settings on a file in the queue:
	1 In the Batch Queue list, select the file or 1 se...
	2 Click Settings.
	3 When you’re finished with the Render 3 Settings ...

	To start the batch process:
	To render a scene more than once from different ca...
	1 Choose Render menu> Batch Queue.
	2 Click Add to add the scene to the Batch 2 Queue....
	3 Without exiting the Batch Queue dialog, 3 click ...
	4 Click Close/Done.
	5 In the Batch Queue dialog, select an 5 instance ...
	6 Click the Output tab.
	7 Expand the File Name controls, and 7 choose a ne...
	8 Expand the Camera controls, and choose 8 a new r...
	9 When your done adjusting the render 9 settings c...
	º Repeat steps 6-9 for each copy of the file in th...
	¡ Click Launch to start the batch queue.

	Speeding up Rendering
	Computer System Optimization


	Viewing Rendered Images
	The Ray Dream Studio�5 Image Window
	The Ray Dream Studio�5 Movie Window
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	18 18 Post Production
	Overview
	Post-Production Applications
	Compositing
	To set up a scene to render with a mask:
	1 When you’re ready to render your scene, 1 displa...
	2 Make sure the selected file format 2 supports sa...
	3 Display the Scene Settings window: 3 Output tab:...
	4 Enable the Mask checkbox.
	5 For best results, render with Adaptive 5 Oversam...

	To composite using Fractal Design Painter:
	1 Render the scene—either directly or 1 through th...
	2 If you rendered directly, save the image 2 to a ...
	3 Open the rendered image in Fractal 3 Design Pain...
	4 Choose Select menu> Load 4 Selection.
	5 In the dialog, make sure the mask is 5 selected ...
	6 Choose Edit menu> Copy.
	7 Open the background image. (The image 7 you are ...
	8 Choose Edit menu> Paste.
	9 Drag the floater where you want it.


	Filtering Images
	To identify the folder containing your plug-in mod...
	1 Choose File menu> Preferences.
	2 Choose Imaging, Scratch Disk from the 2 pop-up.
	3 Click Set Directory.
	4 Use the dialog to locate and select the 4 folder...

	To use filters on the background or backdrop (befo...
	1 Display the Scene Settings window: 1 Effects tab...
	2 Pop-up the disk icon and choose Filter 2 from th...
	3 Select one of the filters.

	To use a filter in the Shader Editor:
	1 Display the Current Shader Editor.
	2 Select the channel containing the texture 2 map ...
	3 Pop-up the disk icon and choose Filter 3 from th...
	4 Select one of the filters.

	Advanced Filter Techniques
	To convert a mask channel to an image in Painter:
	1 Remove the rendered RGB image.
	2 You can choose Select menu> Select 2 All then Ed...
	3 In the Mask List, select the mask for the 3 G-Bu...
	4 Click Load Selection.
	5 Set the current color to black and fill the 5 se...


	Animation Post Production

	Printing Images
	To print an image from Ray Dream Studio�5:



	rds5IX.pdf
	Index
	Adobe Photoshop
	AutoCAD file format (*.DXF)
	BMP file format
	Complex objects
	Hot Points
	vertices�153

	Oscillate tweener�310
	Preferences
	Render Filters
	adding to Browser palette�30
	overview�108

	Symmetry
	Numerics
	A
	B
	C
	D
	E
	F
	G
	H
	I
	J
	K
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V
	W
	Y
	Z


	License.pdf
	Fractal Design License Agreement
	Fractal Design Software License
	1) License
	2) Copyright
	3) Restrictions
	4) Limited Warranty
	5) Remedies
	6) No Other Warranties
	7) U.S. Government Restricted Rights



	AppA.rds5.pdf
	A A Using Ray Dream A Studio with A other A Applic...
	Introduction to the Work Flow
	Working with 2D Programs
	Importing Shapes from a 2D Art Program
	Importing Images
	To import image files using an Adobe Photoshop-com...
	1 Place the Acquire Plug-ins in your plug- 1 ins f...
	2 Display the map controls where you will 2 be usi...
	3 Pop-up the disk icon and choose Import 3 from th...
	4 Select your Acquire plug-in and use it to 4 impo...


	Exporting Images
	To export image files using an Adobe Photoshop-com...
	1 Place the Export Plug-ins in your plug-ins 1 fol...
	2 Make sure that the Image window 2 containing the...
	3 Choose File menu> Export.
	4 Select the Export Plug-in from the list.


	Working with Painter
	G-Buffer Channels


	Working with 3D Programs
	Importing Objects
	To import an object/model file:
	1 Choose File menu> Import. Ray Dream 1 Studio dis...
	2 If you want to narrow the list to a certain 2 fo...
	3 When you have located the file, click 3 Open. Ra...
	4 After setting your options, click OK.

	Detailer Files
	3DMF Files
	To set 3DMF options:
	1 Set the scaling units and conversion 1 factor.
	2 Enable Ungroup as much as possible to 2 reduce t...

	DXF Files
	To set DXF options:
	1 Enable the Import and extrude 2D 1 objects optio...
	2 Enable the Smooth Surfaces option to 2 have smoo...
	3 Enable the Group all 3DFACE in a single 3 object...
	4 Enable the Separate 3DFACE by Layers 4 and Color...
	5 Use the Scaling Conversion Factor to 5 relate th...

	Shading Imported Objects

	Exporting 3D Files
	To export the scene:
	1 Open the scene you want to export.
	2 Choose File menu> Save As. The Save 2 As dialog ...
	3 In the dialog, use the menu to select the 3 expo...
	4 Click Options and set options for the 4 exported...
	5 When you’re done with the Options 5 dialog, clic...
	6 Enter a file name, select the destination, 6 and...

	To export objects:
	1 Select the object or group you want to 1 export....
	2 Choose File menu> Export. The 2 Export dialog ap...
	3 Use the pop-up to select the export file 3 forma...
	4 Click Options to set options specific to 4 this ...
	5 Enter a file name, select the destination, 5 and...

	Detailer Format Options
	DXF Options
	3DMF Options
	1 Enable Force Béziers to Polygons if you 1 want t...
	2 Click a radio button to select the degree 2 of t...
	3 Enable Export UV Colormap if you want 3 to expor...
	4 Use the Colormap UV resolution fields to 4 set t...

	Virtual Reality Modeling Language (VRML)
	Shape Nodes
	Shaders & Textures
	Cameras & Lights
	Miscellaneous

	To set URL properties:
	1 Select an object.
	2 Display the Properties palette: URL 2 tab.
	3 Type in a URL.
	4 Select either Anchor or Inline.

	To set VRML export options:
	1 Use the Maximum resolution field to set 1 the ma...
	2 Enable the External option if you want 2 the tex...
	3 If you are saving texture maps externally, 3 ent...
	4 Click a radio button to select the degree 4 of t...
	5 Set a Size threshold if you want smaller 5 objec...
	6 Set a Distance threshold if you want 6 objects f...
	7 Enable the Tessellate option for any of 7 the pr...
	8 Enable the Remove white space option if 8 you wa...
	9 When you’re finished setting VRML 9 options, cli...

	About Texture Mapping in VRML
	Cube
	Cylinder
	Cone
	Sphere



	Using Ray Dream Studio with Detailer
	Using Ray Dream Studio with Poser
	Exporting Poser Figures for Ray Dream Studio
	Importing a Poser Figure
	Texture Maps on Poser Figures
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	C C Technical Tips
	Introduction
	Before You Call Technical Support
	1 Which Fractal Design product are you 1 using?
	2 Which version?
	3 What is your serial number (see the label 3 atta...
	4 What kind of computer are you using?
	5 How much RAM does your computer 5 have?
	6 What kind of problem are you having?
	7 Do you get an error message? If so, what 7 messa...
	8 Is there anything unusual about your 8 computer ...
	9 Do you have a CD-ROM player? When 9 was it last ...
	10 Are you running virus protection or 10 disk com...
	Macintosh
	To find out if an Extension conflict is causing a ...
	1 Restart the computer while holding 1 down the Sh...
	2 When you see the message Welcome to 2 Macintosh....
	3 Run the software to see if the problem 3 still o...
	4 If the problem goes away when you start 4 the co...

	To identify the item that causes the conflict:
	1 System 7.5�Choose Apple menu> 1 Control Panels> ...
	2 Restart your computer in the usual way. 2 See if...
	3 If you get all the way through the 3 Extensions ...
	4 If you identify the problem as an 4 Extension or...
	5 If the problem is identified as an Apple 5 Contr...


	Windows
	Windows 3.1 and Windows NT
	1 Close all applications except Windows.
	2 In your Main directory, locate and 2 double-clic...
	3 Write down the current Display setting 3 so you ...
	4 Choose Options menu> Change 4 System Setting.
	5 Where it shows Display, scroll down and 5 select...
	6 You will need to restart Windows.
	7 Run Ray Dream Studio�5 to see if the 7 problem p...

	Windows 95
	1 Choose Start menu> Settings/Control 1 Panel.
	2 Double click Display and select the 2 Settings t...
	3 Click Change Display Type /Record 3 Adapter Type...
	4 Click Change under Monitor Type and 4 select Sho...
	5 Make a note of the current setting so you 5 can ...
	6 Click OK.



	Set up
	Memory
	To increase available system resources:�
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